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Introduction 

This document lists the steps you must take to install EMS or upgrade to a more current version of the 
software. If you are upgrading to a newer version of EMS, please encourage users at your facility to read 
the separate What’s New document before they begin working with the new version of the software. 
Doing so will minimize the amount of time it takes them to get “up-to-speed” with the new release and 
help them benefit from new features and functions that they might not otherwise discover.   

Customer Support 

Unlimited toll-free customer support is available to EMS users who have a current Annual Service 
Agreement (ASA).  If you are unable to resolve a problem or answer a question by reading the EMS 
documentation, contact us at: 

Email: 
Web: 
Phone: 
Fax: 

support@emssoftware.com
www.emssoftware.com
(800) 288-4565
(303) 796-7429

Backing Up Your Data 

Once you have installed EMS and begun defining your data, it is extremely important to back up your 
database every night. If your data is damaged and we determine the damage to be irreparable, your only 
alternative will be to restore from the most recent backup.  

Hardware and Software Requirements 

The following components must be installed/enabled on your server in order to run the EMS installation 
files: 

 Windows Installer 4.5 must be installed.

 .NET Framework 3.5 must be installed and enabled.

A list of general EMS system requirements is maintained on our website.

Obtaining the Latest Release of EMS 

The latest release of EMS can be downloaded from the online Support Center. 

1. Go to www.emssoftware.com and enter your Email Address and Password in the Support Center area.

IMPORTANT:  All EMS related components (Virtual EMS, Web Client, EMS for Outlook, EMS Kiosk, 
etc.) must be upgraded with this release.  Please review the Important Considerations before 
Upgrading section. 

IMPORTANT:  Please see the What’s New document for important information regarding the Web 
Client.  Existing versions of the Web Client are not compatible with this release.

o Configuration
o System Administration
o EMS Campus specific functionality or the Academic Import Utility

**Please note that some discrepancies (e.g. differences in behavior and/or exclusions) will
exist.  Configuration and System Administration will be available in a future (approx. 
September) monthly scheduled bug release.

IMPORTANT:  A new product registration process has been implemented for this release.  Primary 
Contacts can obtain the license file from the Support Center area on www.emssoftware.com.  This
license file is required to activate your EMS software and is required for new and existing customers. 

o Configuration
o System Administration
o EMS Campus specific functionality or the Academic Import Utility

**Please note that some discrepancies (e.g. differences in behavior and/or exclusions) will
exist.  Configuration and System Administration will be available in a future (approx. 
September) monthly scheduled bug release.

http://support.microsoft.com/kb/942288
http://blogs.msdn.com/b/sqlblog/archive/2010/01/08/how-to-install-net-framework-3-5-sp1-on-windows-server-2008-r2-environments.aspx
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2. Click the Software downloads link.
3. Download the following files.  (Required for both first time installations and upgrades.)

 EMS License (License.lic) – License file required to activate your EMS software.

 EMS Server Install (EMS.ServerInstall.exe) – File used to install or upgrade the EMS
databases on your Microsoft SQL Server.

 EMS Client (EMSClient.msi) – File used to install or upgrade the EMS desktop application.

 EMS Email Notification (EMSEmailNotificationSetup.msi) – File used to install the EMS
Email Notification service (an optional system component.)  See Installing the EMS Email
Notification Service.

 EMS Campus Auto Sync Service (EMSCampusAutoSyncSetup.msi) – EMS Campus
only.  File used to install the optional EMS Campus Auto Sync Service (an optional system
component.)  See Installing the EMS Campus Auto Sync Service.

First Time Installation Instructions 

The information in this section is for installing EMS for the first time at your facility. If you are already 
using an older version of EMS, please see the appropriate section later in this document. 

In order to install EMS, you must perform two operations. First, you must run EMS.ServerInstall.exe to 
create EMS databases on your database server.   The second operation is to run the EMSClient.msi 
program on each of the client computers to which you want to install the EMS desktop application. 

Installing the EMS Server Components 

The server installation process will create two EMS databases on your MS SQL Server:  An EMS_Master 
database that contains licensing information and a separate EMS database that will ultimately contain 
your reservations data.  

Note:  A Microsoft SQL Server SA level account will be required to execute the database installation 
process. 

1. Verify that the prerequisite software has been installed.
2. Secure the EMS.ServerInstall.exe file.
3. Run EMS.ServerInstall.exe (This .exe can be run from any PC that has access to your database

server.)

4. In the Server textbox, enter the name of the server running MS SQL Server.
5. In the Database textbox, enter the name for your EMS database.  (It is recommended that you

accept the default value of ‘EMS’.)
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6. In the Server Authentication area, specify your MS SQL Server authentication credentials.  If SQL
Server Authentication Mode is selected, you will be required to specify a User Name and
Password.

7. Click the Execute button.  A Create Database dialogue box will appear.
8. Click Yes to initiate the EMS database installation process.

Note:  The time spent on the “Upgrading database…” phase in the installation process is highly
dependent on the size of your database.  Please be patient.

9. Click OK when you receive the “Database Installed Successfully!” message.

You have completed installing the server portion of EMS. Next you will install the software to client 
computers. 

Note: For information on installing the optional Email Notification Service or the EMS Campus Auto Sync 
Service (EMS Campus only), please see Installing or Upgrading the EMS Email Notification Service 
and/or  Installing or Upgrading the EMS Campus Auto Sync Service. 

Installing to Client Computers 

After your EMS databases have been created on your database server, you must install the client 
software on each computer that will access your EMS database.  

1. Verify that the prerequisite software has been installed.
2. Secure the EMSClient.msi.
3. Run EMSClient.msi on the client workstation. Follow the on-screen prompts. It is recommended

that you accept the defaults.
4. Start EMS from the shortcut located on your desktop.
5. In the Provide Server Parameters dialog box, enter the name of your EMS Server and Database.

6. Click OK.
7. The system displays a message asking you to import your registration information. Click OK.
8. The Registration screen appears.  Follow the instructions outlined on the screen to import your

EMS license key.
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9. At the EMS log-in screen, type admin as both the User ID and the Password.
10. Click OK.
11. You are now ready to begin using the system. You can begin defining your data following the

instructions in the EMS Setup Guide or you can install to additional client computers by repeating
steps 1-6 above. (Note: Your license key only needs to be imported once.)

Upgrade Instructions 

In order to upgrade EMS, you must perform two operations. First, you must run EMS.ServerInstall.exe to 
upgrade the EMS databases on your database server.   The second operation is to run the 
EMSClient.msi program on each of the client computers that currently are running the EMS desktop 
application. 

Note:  If you are upgrading from a version of EMS Enterprise that was released prior to version 3.0, 
please contact our Customer Support department for information on upgrading to the latest release. 

Note:  If you are upgrading from EMS Lite or EMS Professional, please contact our Customer Support 
department for information on upgrading to the latest release. 
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Important Considerations before Upgrading 

IMPORTANT:  The following EMS components must be upgraded to the new platform. 

 Product Registration - A new product registration process has been implemented for this 
release.  Primary Contacts can obtain the license file from the Support Center area on
www.emssoftware.com. This license file is required to activate your EMS software.

 Virtual EMS – Please see the Virtual EMS Installation Instructions.

 EMS Web Client – Please see the What’s New document for important information regarding the 
Web Client.  Existing versions of the Web Client are not compatible with this release.

 EMS Campus Planning Interface (EMS Campus only) – Formerly known as the EMS Campus 
Web Client.  Please see the EMS Campus Planning Interface Installation Instructions.

 EMS Campus Web Service (EMS Campus only) – If you are upgrading from EMS Campus 2.0, 
a new version of the EMS Campus Web Service (including the queries.xml and views.sql files) 
may be required.  Please contact your Client Services Consultant to evaluate and discuss any 
potential impacts to your installation.  Please see the EMS Campus Web Service Installation 
Instructions and White Paper for installation instructions.

 EMS Email Notification Service – Please see Installing or Upgrading the EMS Email Notification 
Service.

 EMS Campus Auto Sync Service (EMS Campus only) – Please see Installing or Upgrading the 
EMS Campus Auto Sync Service.

 PAM Web Service – Web service used by the optional Plan-a-Meeting and EMS for Outlook 
modules.  Please see the Plan-a-Meeting Installation Instructions.

 EMS for Outlook –Optional module.  Please see the EMS for Outlook Installation Instructions.

 Custom Report(s) – If a custom report was developed for you by DEA, please contact Customer 
Support to request a new Custom Report DLL that is compatible with this version.  Five business 
days may be required to compile a new DLL, so please plan accordingly.

 EMS Kiosk – Optional module.  Please see the EMS Kiosk Installation Instructions.

 Floor Plan Configuration Utility – Web application used with the optional Floor Plan module. 
Please see the Floor Plan Module Installation Instructions.

 EMS Room Diagramming Service – Web service used by the optional Floor Plan module. 
Please see the Floor Plan Module Installation Instructions.

 HR Toolkit – Customers using the optional HR Toolkit to feed employee and web user data to 
EMS should contact their Client Services Consultant to evaluate and discuss any potential impacts 
to the interface.

 FM Toolkit – Customers using the optional FM Toolkit to feed facility data to EMS should contact 
their Client Services Consultant to evaluate and discuss any potential impacts to the interface.

 EMS – Cisco TMS Interface – Optional interface that feeds videoconferences booked in EMS to 
Cisco TMS.  Please see the EMS – Cisco TMS Interface Installation Instructions.

 EMS API – Version 1.1.12 or newer required.  Please see the EMS API Reference Guide.

http://www.dea.com/
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 Video Display Interface – Customers upgrading from EMS Enterprise 4.0 or below will be
required to re-configure the Scheduled Task to automatically execute the export process.  Please
see the EMS User Manual for instructions.

Upgrading the EMS Server Components 

The server upgrade process will upgrade the EMS databases on your MS SQL Server.  For customers 
upgrading from EMS Enterprise 4.x or below, your existing EMSEnterprise_Master database that 
contains licensing information will be replaced by a new EMS_Master database, and your existing EMS 
database will be upgraded to the current version. 

Note:  A Microsoft SQL Server SA level account will be required to execute the database upgrade 
process. 

1. Review the Important Considerations before Upgrading section.
2. Verify that the prerequisite software is installed.
3. Secure the EMS.ServerInstall.exe file.
4. IMPORTANT:  Using SQL Server Management Studio, back-up your existing EMS databases.
5. Run EMS.ServerInstall.exe. (This .exe can be run from any PC that has access to your

database server.)

6. In the Server textbox, enter the name of the MS SQL Server.
7. In the Database textbox, enter the name for your EMS database that is to be upgraded.
8. In the Server Authentication area, specify your MS SQL Server authentication credentials.  If SQL

Server Authentication Mode is selected, you will be required to specify a User Name and
Password.

9. Click the Execute button.  A Backup Database dialogue box will appear.

10. Click Yes to acknowledge that you have backed-up your EMS databases and it is OK to continue.
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You have completed the upgrade process for the server portion of EMS. Next you will upgrade client 
computers. 

Note: For information on installing the optional Email Notification Service or the EMS Campus Auto Sync 
Service (EMS Campus only), please see Installing or Upgrading the EMS Email Notification Service 
and/or  Installing or Upgrading the EMS Campus Auto Sync Service. 

Upgrading EMS Client Computers 

To upgrade an EMS client computer, take the following steps: 

Note:  Existing versions of EMS must be manually uninstalled. 

1. Verify that the prerequisite software has been installed.
2. Secure the EMSClient.msi.
3. Run EMSClient.msi on the client workstation. Follow the on-screen prompts. It is recommended

that you accept the defaults.
4. Start EMS from the shortcut located on your desktop.
5. The system displays a message asking you to import your registration information. Click OK.
6. The Registration screen appears.  Follow the instructions outlined on the screen to import your

EMS license key.
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7. At the EMS log-in screen, enter your User ID and Password.
8. Click OK.
9. Install to additional client computers by repeating steps 1-4 above. (Note: Your license key only

needs to be imported once.)

Installing or Upgrading the EMS Email Notification Service 

EMS has built-in functionality that alerts users of certain changes in the database.  With the optional EMS 
Email Notification Service users can also be notified via email. If email notification will not be used, there 
is no need to install the Email Notification Service. Standard notifications can still be generated and 
viewed by users who are logged into EMS. 

The EMS Email Notification Service must be installed on a computer that is connected to the network and 
is running 24 hours a day. 

IMPORTANT:  Existing versions of the EMS Email Notification Service must be manually uninstalled. 

IMPORTANT: Install the EMS Email Notification Service on one computer/server only. 

To install the EMS Email Notification Service: 

1. Verify that the prerequisite software is installed.
2. Manually uninstall any existing versions of the EMS Email Notification Service.
3. Download the EMSEmailNotificationSetup.msi onto the server that will be running the service.
4. Double-click EMSEmailNotificationSetup.msi. Follow the on-screen prompts.  It is

recommended that you accept the defaults.
5. Within your Microsoft Windows Start menu, locate EMS Email Notification.  The EMS Email

Notification Configuration screen will appear.

6. Review and complete/change the following settings:
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 Mode – Type of authentication to the SMTP server.
 SMTP Server – SMTP server name or IP address.
 Port Number – SMTP port (default = 25)
 Use SSL – Check this option if your SMTP server runs under SSL.
 User Name/Password – Required if an authentication mode other than Unauthenticated

is selected.
 Email Interval – The frequency with which the system will generate notification emails.

7. In the Databases section of the dialog box, you will see a sample database and server (named
‘server’ and ‘database.’) Select this entry, click Edit, and change the values to your EMS server
and database name.

On the Database tab of the Notification Database dialog box, complete the following: 

 Server/Database – EMS server and database name
 EMS Authentication/Windows Authentication – The method of authentication to this

database.
 Email From – Email address that will be displayed in the From field of notification emails

that are sent.
 Enable Email Notification – Activates email notifications.
 Enable Group Notification – Activates group notifications.
 Enable No Show Notification (Workplace Only) – Activates ‘no show’ notifications.
 Enable Service Event Logging – Activates Windows event logging.

Click the Service Order Settings tab and review/change the following: 

 Paper size – The paper size for the PDF file that is emailed.
 Highlight Days – Number selected here determines the information that is highlighted on

service order PDFs.
 Show Pricing – Check if service orders should display pricing.
 Show Notes – Check if service orders should display resource notes.
 Show Special Instructions – Check if service orders should display resource special

instructions.

8. After making your entries, click OK.
9. Click OK again to save your EMS Email Notification Configuration settings.

Note:  If any issues are encountered starting the service, please visit the EMS Knowledge Base
in the online Support Center for a possible solution or call Customer Support.
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The Email Notification Service is now enabled. See the EMS Setup Guide for information on defining 
Notification Rules. 

Installing or Upgrading the EMS Campus Auto Sync Service (EMS 
Campus Only) 

Functionality exists within EMS Campus that allows Domain Schedulers to manually process post-publish 
course changes made in your SIS to EMS.  The EMS Campus Auto Sync Service automates this 
process. 

The EMS Campus Auto Sync Service must be installed on a computer/server that is connected to the 
network and is running 24 hours a day. 

IMPORTANT:  Existing versions of the EMS Campus Auto Sync Service must be manually uninstalled. 

IMPORTANT: Install the EMS Campus Auto Sync Service on one computer/server only. 

To install the EMS Campus Auto Sync Service: 

1. Verify that the prerequisite software is installed.
2. Manually uninstall any existing versions of the EMS Campus Auto Sync Service.
3. Download the EMSCampusAutoSyncSetup.msi onto the server that will be running the service.
4. Double-click EMSCampusAutoSyncSetup.msi. Follow the on-screen prompts.  It is

recommended that you accept the defaults.
5. Within your Microsoft Windows Start menu, locate EMS Campus Auto Sync.  The EMS Campus

Auto Sync Configuration screen will appear.

6. Set the Auto Sync Interval.  DEA recommends setting this value to at least 30 minutes.  It is
very important that EMS Campus Auto Sync has plenty of time to synchronize with the SIS and
process any changes.
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7. In the Databases section of the dialog box, you will see a sample database and server (named
‘server’ and ‘database.’) Select this entry, click Edit, and change the values to your EMS server
and database name.

On the Database tab of the Database dialog box, complete the following: 

 Server/Database – EMS server and database name
 EMS Authentication/Windows Authentication – The method of authentication to this

database.
 Enable Service Event Logging – Activates Windows event logging.

8. After making your entries, click OK.
9. Click OK again to save your EMS Campus Auto Sync Configuration settings.

Note:  If any issues are encountered starting the service, please visit the EMS Knowledge Base
in the online Support Center for a possible solution or call Customer Support.

The EMS Campus Auto Sync Service is now enabled.  See the To automatically process courses 
post-publish section in the EMS User’s Manual and the EMS System Parameters section within the 
EMS Setup Guide for information on how to configure the auto sync feature. 
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Getting Started with EMS

EMS is user-friendly room scheduling software designed to manage the meetings and events 
that take place in your facility. Standard features, which you use to create, manage, and 
report on events, include the following: 

• The Reservation Wizard room booking tool

• A graphical reservation book

• The Browser and month-at-a-glance Calendar Inquiry

• Numerous daily, sales, and statistical reports

This chapter covers the following topics:

• “Starting EMS” on page 27.

• “The EMS Window” on page 29.

• “An EMS Browser Window” on page 33.
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Starting EMS

After EMS has been installed on your desktop, a shortcut icon for the application is placed 
on your desktop. An option for the application is also available from your Start menu. You 
can double click the desktop icon to launch the EMS application, or you can select the option 
from your Start menu. 

To start EMS

1. Do one of the following:

• On your desktop, double-click the EMS icon .

• Open the Windows start menu, in the Search field, enter EMS and then select the
EMS Enterprise option.

If you are the first person to log in to the EMS application at your organization, a dialog 
box opens in which you enter the information for the login server and database that your 
application is accessing. (These are set up during implementation.) After you enter this 
information, the EMS Login dialog box opens.

Figure 1-1:  EMS Login dialog box

The following procedure is written from the perspective of EMS Enterprise; 
however, it is applicable for any EMS product (EMS Professional, EMS Campus, 
and so on).
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2. As the EMS administrator, enter “admin” in both the User ID and Password fields, and
then click OK.

If this is the first time that your EMS application has been accessed at your organization,
a Registration dialog box opens. You must import the license file (License.lic) that was
provided with your EMS software to register your application. See “Importing
Registration Information” on page 313; otherwise, go to Step 3.

3. Click OK.

The EMS Enterprise application opens. The main menu is open in the application.

Figure 1-2:  EMS Enterprise main window with main menu

For security reasons, after you log in to EMS the first time using “admin” as both 
the username and password, at a minimum, DEA recommends that you change the 
account password. Ideally, you should create an entirely new administrator 
account with a new username and password. See “Configuring User Accounts” 
on page 329.
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The EMS Window

The EMS main window is your starting point for the EMS application. The window provides 
quick access to all the EMS functions (Reservations, Reports, Configuration, and so on) and 
system tools. The EMS Main window has four major components:

• The title bar. See “Title bar.”

• The menu bar. See “Menu bar” on page 30.

• The toolbar. See “Toolbar” on page 30.

• The main menu. See “Main menu” on page 31.

Figure 1-3:  EMS main window with main menu

Title bar

The name “EMS Enterprise” and the version number of the application appear in the title bar 
across the top of the EMS Enterprise main window.

Figure 1-4:  Title bar

The following section is written from the perspective of EMS Enterprise; however, 
it is applicable for any EMS product (EMS Professional, EMS Campus, and so 
on).
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Menu bar

The menu bar is set up in a standard Windows menu format with menu commands grouped 
into menus (File, Settings, Reservations, and so on) across the menu bar. Some of these 
menu commands are also available in the main menu.

Figure 1-5:  Menu bar

Toolbar

The toolbar provides quick access to the most commonly used EMS functions. The toolbar 
buttons that are always displayed by default are the buttons for Book, Calendar, Wizard, 
Navigator, Browser, Web Reservations, Clients, Email, Dashboard, and Manage Services. 
Other buttons for other functions are also displayed by default depending on the version of 
EMS that you are running, for example, EMS Campus or EMS Workplace. Some of the 
functions that are available on the toolbar are also available from the main menu. You can 
customize the appearance of this toolbar to best suit your business needs.

Figure 1-6:  Toolbar

To customize the toolbar

1. Right-click the toolbar and click Customize.

The Customize Toolbar dialog box opens.

Figure 1-7:  Customize Toolbar dialog box
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2. Do one or more of the following:

• To display the toolbar icons as large icons, select Large Icons; otherwise, click Small
Icons.

• To hide an icon from the toolbar display, in the Show Buttons panel, select an icon,
or CTRL-click to select multiple icons, and then click the Hide button (<).
Conversely, to show an icon on the toolbar display, in the Hide Buttons panel, select
an icon, or CTRL-click to select multiple icons, and then click the Show button (>).

• To change the order (from left to right) in which the icons are displayed on the
toolbar, select the icon, and then click Move Up or Move Down as needed.

3. Click OK.

The Customize Toolbar dialog box closes. The toolbar display is updated to reflect the
changes that you made.

Main menu

Every time you open EMS, the main menu opens in the EMS main window. You can access 
the primary EMS system functions—Reservations, Reports, Billing, Configuration, and 
System Administration—from the main menu. 

Figure 1-8:  EMS main menu

You can also move a toolbar icon between the Hide and Show panels by 
double-clicking the icon. To move all icons from one panel to another in a single 
step, you do not have to select any icons. Instead, click the appropriate Hide All 
button (<<) or Show All button (>>).
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The main menu is arranged in a Windows Explorer-style folder structure. The top-level 
folders are the system functions of Reservations, Reports, Billing, Billing, Configuration, 
and System Administration. The available tasks for each top-level folder are further 
organized into subfolders. For example, to carry out a system administration task, you must 
first open the top-level System Administration folder, and then open the correct subfolder to 
view the list of available tasks.

Figure 1-9:  Opening a System Administration subfolder

You can always close the main menu by clicking the Close button (x) in the upper right hand 
corner of the menu. To open the main menu again, on the EMS menu bar, click File > Show 
Main Menu.
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An EMS Browser Window

Many EMS functional areas use a Browser window. For example, the Groups window, the 
Query Builder window, and the Service Order Management window are all EMS Browser 
windows. You use an EMS Browser window to search for data, add new data, and edit and/or 
delete existing data. For example, in the Groups Browser window, you can search for groups 
or contacts, add new groups or contacts, and edit or delete existing groups or contacts. 
Regardless of the EMS functional area, all EMS Browser windows have the following 
features in common:

• A click and drag feature that you can use to group data by a specific column, rearrange
the order of the data columns, or change the width of a column. See “To group data by
columns in an EMS Browser window” on page 34, “To rearrange the columns in an EMS
Browser window” on page 34, and “To change the width of the columns in an EMS
Browser window” on page 35.

• A column context menu that has a multitude of options for sorting data, grouping data,
sizing columns and so on. See “To use the context menu for data columns in an EMS
Browser window” on page 35.

• A filtering feature that you can use to find and work with a subset of data in the window.
See “To filter the data in an EMS Browser window” below.

• A column sorting feature that you can use to sort data by a specific column. See “To
change the sort order of data in an EMS Browser window” on page 38.

This feature is always indicated by the option to drag and group by a column 
header at the top of an EMS Browser window. If a window/window pane does not 
display this option, then the window/window pane is not an EMS Browser window.

The following examples are explained using the Groups window; however, the 
instructions are applicable for any Browser window in EMS.
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To group data by columns in an EMS Browser window
In any browser window, you can drag a column header to the indicated location and group 
the data by the selected column. You can drag multiple column headers to the location. If you 
sort data by multiple columns, then the first column is the parent column. All other columns 
are placed as child columns, and the data is grouped accordingly in the browser window.

Figure 1-10: Grouping data by a column in an EMS Browser window

To rearrange the columns in an EMS Browser window

You can rearrange the column order by dragging a column to a new location using the 
column heading.

Figure 1-11: Rearranging columns in an EMS Browser window

Data grouped by columns.
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To change the width of the columns in an EMS Browser window
You can change the width of a column by resting the mouse pointer on the right side of a 
column heading until the pointer changes to a double-headed arrow, and then dragging the 
boundary until the column is the width that you want.

Figure 1-12: Changing the width of a column in an EMS Browser window

To use the context menu for data columns in an EMS Browser 

window
Right-click in any column in a browser window to open a context menu that has a multitude 
of options for sorting data, grouping data, sizing columns, and so on.

Figure 1-13: Context menu for a column in an EMS Browser window
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To filter the data in an EMS Browser window
1. Open a browser window, for example, the Groups window.

2. Place your cursor in the data column by which you want to filter the data. For example,
to filter data based on the City for group records, place your cursor in the City column.

A Filter icon is displayed in the column.

Figure 1-14: Filter icon displayed in a data column

3. Click the Filter icon to open a list of filter options, and then select the appropriate option
for creating the filter.

Figure 1-15: Example of filtering options in a browser window

Any filter that you create is always displayed in the bottom left corner of the 
browser window.

Filter icon

Filter
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4. Optionally, click Edit Filter in the lower right corner of the browser window to open the
Filter Editor dialog box and edit the current filter.

• To add a new condition to a filter, click the Add/Insert icon.

• To remove a condition from a filter, click the Delete icon at the end of the filter.

• To apply a new filter, click Apply.

• To close the Edit Filter dialog box and return to the browser window, click OK.

Figure 1-16: Edit Filter dialog box

Option Description

Custom Opens the Custom AutoFilter dialog box in which you can construct a 

custom data filter.

Blanks Filters data based on NULL (blank) data for a field. For example, if you 

click on Blanks in the City column in the Groups window, then all group 

records for which the City field has a NULL (blank) value are displayed 

in the Groups window. 

Non blanks Filters data based on Not Null (not blank) data for a field. For example, if 

you click Non blanks in the City column in the Groups window, then all 

group records for which the City field does not have a NULL (blank) 

value are displayed in the Groups window.

<Specific Data Value> A Filter list also displays each unique value that has been entered for 

the field. Select a value on this list to filter the data by the value. For 

example, select “Denver” in the City column of the Groups window to 

display only those group records that have “Denver” specified as the 

group’s city.

Add/Insert icon

Delete icon
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To change the sort order of data in an EMS Browser window
When a browser window first opens, data are sorted in ascending order based on the data in 
the first column of the window. For example, when the Groups window first opens, the group 
records are displayed on the Results tab alphabetically by Group name. To change the sort 
order of the data in a browser window:

1. Click once in any column header to display a Sort Order icon.

The Sort Order icon is an “Up” arrow indicating that the data is sorted in ascending
order.

Figure 1-17: Sorting by columns on the Groups window, Ascending sort

2. Click the Sort Order icon to sort the records in descending order by the data in the
column.

Figure 1-18: Sorting by columns on the Groups window, Descending sort

3. Click the Sort Icon again to sort the records in ascending order.

Ascending sort

Descending sort
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Before you can use EMS to manage your organization’s events, you must configure core data 
items that are specific to your organization. For example, before you can make a reservation 
for a group, you must first configure the group. Likewise, before you can add a comment to 
the group, you must first configure comment types.

This chapter covers the following topics:

• “Overview of Data Configuration” on page 41.

• “Configuring Event Types” on page 43.

• “Configuring Group Types” on page 47.

• “Configuring Reminder Types” on page 49.

• “Configuring Comment Types” on page 52.

• “Configuring Messages” on page 55.

• “Configuring Holidays” on page 58.

• “Configuring User Defined Fields (UDFs)” on page 67.

• “Configuring Reservation Sources” on page 70.

• “Configuring Cancel Reasons” on page 72.

• “Configuring Attachment Types” on page 74.

• “Configuring Word Merge Documents (Optional Module)” on page 76.

• “Configuring Calendar Styles” on page 79.

Event Types, Group Types, Reminder Types, Comment Types, Messages, Holidays, 
User Defined Fields, Reservation Sources, Cancel Reasons, Attachment Types, 
Word Merge documents, and Calendar Styles are collectively referred to as 
“Other” data types in EMS.
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Overview of Data Configuration

You configure data for your EMS database in two major locations:

• Configuration area—You define core data items (facilities, resources, billing, and so on)
in the Configuration area.

• System Administration area—You define system administration data items (global user
settings, security, tools, and so on) in the System Administration area.

To be able to make reservations in EMS, at a minimum, you must configure buildings, 
rooms, statuses, and groups. By default, when you configure any data item, the item is 
configured as an active item, which means that it is available for use in the system. You can 
inactivate the vast majority of data items in the EMS database. When you inactivate a data 
item, it does not delete the item. All information about the item is retained for historical 
purposes; however, the item is no longer available for use in the system. For example, if you 
inactivate a room then the space is no longer available for use in either EMS or Virtual EMS 
(VEMS), but it remains in place anywhere it was used before being inactivated. If needed, 
you can delete a data item, but only if the item has not been used in some way in your EMS 
system. For example, you can delete a room only if no bookings or web requests reference 
the room. You can delete a resource only if no service order items reference the resource. 
Also, the procedure to edit existing data is identical to the procedure for configuring data 
with one difference—instead of clicking New in the <Data> window, you select the data that 
is being modified and then click Edit. With the exception of groups, this approach works for 
editing all data items in your EMS database.

For any Core or System Administration data configuration window:

• On some of the configuration windows, if you click Print, a list of reports that you can
generate and print for the applicable configuration item opens. On other configuration
windows, a list of reports is not available. Instead, an onscreen report opens in a Print
Preview window. This report simply lists the items you have configured. You can also
print a hard copy of the report from this window. See Figure 2-1 on page 42.

• The Audit tab lists the date that the item was added to your EMS database and the name
of the user who added the item. It also lists the date that the item was last modified in your
EMS database and the name of the user who modified the item. See Figure 2-2 on page 42.

The procedures for editing groups is discussed in detail in  ,“Core 
Configuration - Groups and Contacts,” on page 275.
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Figure 2-1:  Example of a data configuration window with a Print button

Figure 2-2:  Example of a data configuration window with Audit tab
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Configuring Event Types

You can configure event types, which you use to classify or categorize the different events 
that your organization has. For example, you might configure lectures, meetings, and 
conferences, and so on as some of your event types. 

To configure event types

1. On the EMS menu bar, click Configuration > Other > Event Types.

The Event Types window opens. This window lists all the event types that are currently
configured in your EMS database and that have a status of Active.

Figure 2-3:  Event Types window

Optionally, to view all event types in your EMS database, regardless of status, 
under Show, click Inactive.
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2. Click New.

The Event Type dialog box opens. The Event Type tab is the active tab.

Figure 2-4:  Event Type dialog box, Event Type tab

3. Enter the information for the new event type.

Field Description

Event Type The name or classification for the event.

Note: The event type can be a maximum of 30 characters, including 

spaces.

Internal Indicates that the event type is internal to your organization. 

Note: Used for internal reporting purposes only. The event type is not 

printed on external documents such as confirmations and 

invoices, and it is not hidden in any area of your EMS 

application.

Reserved Color Select the color that is to be used in the Reservation Book to indicate 

when the reserved time extends past the event time.

Event Color Select the color that is to be used in the Navigator and in the 

Reservation Book to indicate this type of event. 

Note: Lighter colors are a better choice so as not to obscure the 

reservation/booking name.

Virtual EMS Settings

Display on the Web Indicates that events of this type are to be displayed when a user 

browses for events in VEMS.

Note: If an event is labeled with a type for which this option has been 

cleared, then the event is not displayed when a user browses for 

the event in VEMS. 

Allow Web Request Indicates that this event type is an available option in VEMS when 

requesting a room.

Available to All Web 

Process Templates

Select this option to assign this event type to all web process templates.
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4. Open the Comment Types tab, and on the Available list, select the comment type, or
CTRL-click to select the multiple comments types that are to be automatically applied
when you create a new reservation with this event type, and then click the Move button
(>) to move the selected comment types to the Selected list.

Figure 2-5:  Event Type dialog box, Comment Types tab

5. Open the Reminder Types tab, and on the Available list, select the reminder type, or
CTRL-click to select the multiple reminder types that are to be automatically applied
when you create a new reservation that uses this event type, and then click the Move
button (>) to move the selected reminder types to the Selected list.

Figure 2-6:  Event Type dialog box, Reminder Types tab

Inactive Leave this option blank to add the event type as an active event type. 

Select this option to inactivate the event type.

If the appropriate comment type is not available, you can configure it. See 
“Configuring Comment Types” on page 52.

Field Description
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6. Click OK.

The Event Type dialog box closes. You return to the Event Types window with the newly
configured event type automatically selected.

If the appropriate reminder type is not available, you can configure it. See 
“Configuring Reminder Types” on page 49.
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Configuring Group Types

You can configure group types, which you use to classify or categorize the different groups 
that sponsor or hold events at your facilities. For example, if your organization is an 
academic organization, you might configure student groups, alumni groups, and so on for 
some of your group types.

To configure group types

1. On the EMS menu bar, click Configuration > Other > Group Types.

The Group Types window opens. This window lists all the group types that are currently
configured in your EMS database.

Figure 2-7:  Group Types window

2. Click New.

The Group Type dialog box opens. The Group Type tab is the active tab.

Figure 2-8:  Group Type dialog box, Group Type tab
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3. Enter the information for the new group type.

4. Optionally, open the Calculations tab and on the Available list, select the calculation, or
CTRL-click to select the multiple calculations that are to always apply to this group
type, and then click the Move button (>) to move the selected calculations to the
Selected list.

Figure 2-9:  Group Type dialog box, Calculations tab

5. Click OK.

The Group Type dialog box closes. You return to the Group Types window with the
newly configured group type automatically selected.

Field Description

Group Type The name or classification for the group type.

Note: The group type can be a maximum of 50 characters, including 

spaces.

Default Pricing Plan Select the default pricing plan that is to be applied when creating a new 

group.

Note: If you select or edit a pricing plan for a group type, the 

information is not updated for existing groups of this group type. 

Instead, it applies only to new groups of this group type.

Note: If the appropriate pricing plan is not available, you can configure 

it. See “Configuring Pricing Plans” on page 255.

Available on the Web Select this option if VEMS users are to be able to filter events by this 

group type when they are browsing for events. 

If the appropriate calculation is not available, then you can configure it. See 
“Configuring Calculations” on page 258.
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Configuring Reminder Types

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a 
booking detail that is a service order. A reminder is a comment that has a due date associated 
with it. You can configure reminder types, which you use to classify or categorize the 
different reminders that are applicable for your organization’s business needs. For example, 
if your organization requires a deposit before a tentative reservation can be confirmed, then 
you might configure a reminder type of “Deposit Due.”

To configure a reminder type

1. On the EMS menu bar, click Configuration > Other > Reminder Types.

The Reminder Types window opens. This window lists all the reminder types that are
currently configured in your EMS database and that have a status of Active.

Figure 2-10: Reminder Types window

Optionally, to view all reminder types in your EMS database, regardless of status, 
under Show, click Inactive.
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2. Click New.

The Reminder Type dialog box opens.

Figure 2-11: Reminder Type dialog box

3. Enter the information for the new reminder type.

Field Description

Reminder Type The name or classification for the reminder.

Note: The reminder type can be a maximum of 30 characters, 

including spaces.

Days Allowed Enter a value, or leave the default value of zero to use the current day’s 

date as the basis for calculating the due date for the reminder. 

Due Date Based On Used in conjunction with the value that is specified in the Days Allowed 

field. 

• Reminder Added Date—Indicates that the reminder is due within the

specified number of days after the date on which the reminder was

applied.

• Event Date—If the reminder is attached to a booking or to a service

order, then the reminder is due within the specified number of days

prior to the booking date. If the reminder is attached to a reservation,

then the reminder is due within the specified number of days prior to
the first booking date in the reservation.

Notes Text entry that further defines or explains the reminder type. For 

example, a reminder called “Final Count for Catering” might have a 

default note that provides the name and phone number for the contact 

at the catering company. 

Note: The text that you enter here is displayed by default when you 

apply the reminder, but you can always edit it or delete it if 

needed.

Internal Indicates that the reminder type is internal to your organization. 

Note: Used for internal reporting purposes only. The reminder type is 

not printed on external documents such as confirmations and 

invoices, and it is not hidden in any area of your EMS 

application.

Inactive Leave this option blank to add the reminder type as an active reminder 

type. Select this option to inactivate the reminder type.
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4. Click OK.

The Reminder Type dialog box closes. You return to the Reminder Types window with
the newly configured reminder type automatically selected.
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Configuring Comment Types

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a 
booking detail that is a service order. You can configure comment types, which you use to 
classify or categorize the different comments that are applicable for your organization’s 
business needs. For example, if your organization’s facilities are regularly scheduled for 
outside conferences, then applicable comment types could include Event Directions, 
Admission Cost and Requirements, Event Recap, and so on.

To configure comment types

1. On the EMS menu bar, click Configuration > Other > Comment Types.

The Comment Types window opens. This window lists all the comment types that are
currently configured in your EMS database and that have a status of Active.

Figure 2-12: Comment Types window

Optionally, to view all comment types in your EMS database, regardless of status, 
under Show, click Inactive.
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2. Click New.

The Comment Type dialog box opens.

Figure 2-13: Comment Type dialog box

3. Enter the information for the new comment type.

Field Description

Comment Type The name or classification for the comment type.

Note: The comment type can be a maximum of 30 characters, 

including spaces.

Comments Free form text that is appropriate for the selected comment type.

Note: The information that you enter here is displayed by default when 

you apply the comment, but you can always edit it or delete it if 

needed.

Internal Indicates that the comment type is internal to your organization. 

Note: Used for internal reporting purposes only. The comment type is 

not printed on external documents such as confirmations and 

invoices, and it is not hidden in any area of your EMS 

application.

Print in Confirmation 

Footer

Select this option if the comment type is to be printed in the footer of 

reservation-level confirmations.

Virtual EMS Settings

Display on Web Select this option if the comment is to be displayed in VEMS when it is 

attached to a reservation or booking.

Web Description Provides an expanded description of the comment type in VEMS when 

users are browsing events.

Inactive Leave this option blank to add the comment type as an active comment 

type. Select this option to inactivate the comment type.
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4. Click OK.

The Comment Type dialog box closes. You return to the Comment Types window with
the newly configured comment type automatically selected.
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Configuring Messages

A message is a block of text that your users can add to the headers and footers of 
confirmations, emails, and invoices. One header message, one footer message, or both can be 
added. Messages can be used for a variety of purposes, such as providing a simple greeting 
to a group who is making a reservation, providing event instructions and contact 
information, and so on. For example, a Greeting message might be something such as 
“Thank you for reserving...” You can configure and store a variety of messages and then your 
users can select whichever is most appropriate for a given situation. 

To configure messages

1. On the EMS menu bar, click Configuration > Other > Messages.

The Messages window opens. This window lists all the messages that are currently
configured in your EMS database.

Figure 2-14: Messages window
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2. Click New.

The Message dialog box opens. The Message tab is the active tab.

Figure 2-15: Message dialog box, Message tab

3. Enter the information for the new message.

4. Open the Confirmation HTML tab and do one of the following:

• Design is selected by default. Use the standard Windows plain text formatting
options to format the message (spacing, number of lines, capitalization, and so on)
so that it is displayed the way that you want in the headers and footers.

• Select HTML and enter the necessary HTML code to format the message (spacing,
number of lines, capitalization, and so on) so that it is displayed the way that you
want in the headers and footers.

Figure 2-16: Message dialog box, Confirmation HTML tab

Field Description

Message The name for the message. 

Note: The message name can be a maximum of 50 characters, 

including spaces.

Message Text The unformatted message in its entirety. 
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5. Optionally, click Spelling to spell check the message before you save it.

6. Click OK.

The Message dialog box closes. You return to the Messages window with the newly
configured message automatically selected.
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Configuring Holidays

Holidays are days that have special significance for your organization, for example, New 
Year’s Day, Spring Break, Staff Retreat, and so on. Holidays are displayed in various places 
throughout your EMS system. The holiday designation is for informational purposes only 
and unless you specifically close the date to your users, your users are not prevented from 
making reservations or booking rooms on a holiday. You must configure your organization’s 
holidays each calendar year. EMS does not assume that a day that is a holiday for the current 
calendar year is also a holiday for the next calendar year. You can configure holidays on an 
individual basis, you can configure multiple holidays, or you can use a wizard to import a list 
of holidays in a single step. Optionally, after you configure or import a list of holidays, you 
can configure the hours for the buildings that are affected by the holiday. By default, 
buildings are configured to be “Open All Day.” You can configure the hours for a building so 
that the building is open for only a specific time period on the holiday, or the building is 
closed for the entire holiday.

To configure holidays

1. On the EMS menu bar, click Configuration > Other > Holidays.

The Holidays window opens. This window lists all the holidays that are currently
configured for all buildings in your EMS database and that have a date greater than or
equal to the current day’s date.

Figure 2-17: Holidays window
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2. Optionally, do one or both of the following:

• To view all holidays in your EMS database, regardless of date, under Show, click
Old.

• To view all holidays for a specific building, select the building on the Building
dropdown list.

3. Continue to one of the following:

• “To configure a single holiday” below.

• “To configure multiple holidays” on page 60.

• “To import a list of holidays” on page 63.

To configure a single holiday

1. Click New.

The Holiday dialog box opens.

Figure 2-18: Holiday dialog box

2. Enter the information for the holiday.

Field Description

Date The date for the holiday.

Description The description or name of the holiday.

Note: The description can be a maximum of 50 characters, including 

spaces.

Building Select the building to which the holiday applies. (The default value is all 

buildings.)

Notes Any special notes or information about the holiday.
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3. Optionally, click Spelling to spell check the holiday description before you save it.

4. Click OK.

The Holiday dialog box closes. You return to the Holidays window with the newly
configured holiday automatically selected.

5. Optionally, continue to “To configure building hours for a holiday” on page 65.

To configure multiple holidays

1. Click Wizard.

The Holiday Wizard opens.

Figure 2-19: Holiday Wizard

Calendar Style Select the print characteristics for the holiday on the event schedule.

Note: See “Configuring Calendar Styles” on page 79.

Virtual EMS Settings

Display on Web Clear this option if you do not want the holiday description to be displayed in 

VEMS.

Field Description



61

 
Core Configuration - Other Data Types

2. Click Add.

The Add Holiday dialog box opens.

Figure 2-20: Add Holiday dialog box

3. Enter the information for the holiday.

4. Click OK.

The Add Holiday dialog box closes. You return to the Holiday Wizard window with the
newly added holiday selected in the window.

5. Repeat Step 2 through Step 4 until you have added all the needed holidays.

Field Description

Date The date for the holiday.

Description The description or name of the holiday.

Note: The description can be a maximum of 50 characters, including 

spaces.

Calendar Style Select the print characteristics for the holiday on the event schedule.

Note: See “Configuring Calendar Styles” on page 79.

Notes Any special notes or information about the holiday.
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6. Click Next.

The Holiday Wizard window is updated with a list of all the buildings that are currently
configured in your EMS database.

Figure 2-21: Holiday Wizard

7. Select the building, or CTRL-click to select the multiple buildings for which the holiday
is to apply, and then click Finish.

You return to the Holidays window with the newly configured holidays displayed in the
window.

8. Optionally, continue to “To configure building hours for a holiday” on page 65.
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To import a list of holidays

1. Create a tab-delimited file that contains the information (in the order listed) for the
holidays that are being imported.

• Date of holiday (Required. Format is mm-dd-yy.)

• Description of holiday (Required. 50 characters maximum, including spaces.)

• Notes (Optional. No maximum.)

2. Click Wizard.

The Holiday Wizard opens.

Figure 2-22: Holiday Wizard

If you use the wizard to import a list of multiple holidays, you can set the values 
only for the holiday date, description, and notes. You cannot specify the calendar 
style, enter notes for the holiday, or indicate that the holiday is not to be displayed 
in VEMS. To configure any of the latter information for a holiday, you must edit 
the holiday. 

Each holiday must be a separate line entry. To see the required format for the 
tab-delimited file, on the Holidays window, click Print > Import Format or 
Appendix E, “Import File Specifications,” on page 539.
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3. Click Import, and in the Open File dialog box, browse to and select the tab-delimited text
file that contains that holidays that you are importing, and then click Open.

The Holiday Wizard window is updated with a list of all the buildings that are currently
configured in your EMS database.

Figure 2-23: Holiday Wizard

4. Select the building, or CTRL-click to select the multiple buildings for which the
holidays are to apply, and then click Finish.

You return to the Holidays window with the newly imported holidays displayed in the
window.

5. Optionally, select a newly imported holiday, and then do one or both of the following:

• Click Edit to edit the Notes, Calendar Style, and/or VEMS Settings for the holiday.

• Configure the building hours for the holiday. See “To configure building hours for a
holiday” on page 65.
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To configure building hours for a holiday

1. If you have not already done so, on the EMS menu bar, click Configuration > Other >
Holiday to open the Holidays window.

2. Select a holiday, and then click Hours.

The Building Hours window opens. The date and title of the holiday are displayed at the
top of the window. A list of all the buildings for which the holiday applies as well as the
hours of operation for each building are displayed in the window.

Figure 2-24: Building Hours window

3. Select the building, or CTRL-click to select the multiple buildings for which you are
modifying the hours of operation, and then click Change.

The Building Hours dialog box opens.

Figure 2-25: Building Hours dialog box
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4. Select the appropriate option on the Building Hours dialog box.

5. Click OK.

The Building Hours dialog box closes. You return to the Building Hours window.

6. Repeat Step 3 through Step 5 until you have configured the building hours for all the
buildings as needed.

7. Click Close.

You return to the Holidays window.

Option Description

Set Building Hours Select this option to specify the time period (Open and Close) during 

which the building is to remain open for the holiday. Your EMS users can 

make reservations on this date in the selected buildings even if the 

events are scheduled outside the indicated time period. They merely 

receive a warning that the reservation time exceeds building hours.

Note: VEMS users cannot make reservations outside of building hours.

Closed All Day Select this option to close the building for the entire holiday period. 

When you select this option, then a Web Only option is displayed on the 

Building Hours dialog box.

• If you do not select Web Only, then none of your users (EMS or

VEMS) can make reservations on this date in the selected buildings.

• If you do select Web Only, then your EMS users can make

reservations on this date in the selected buildings; however, your

VEMS users cannot.

Open All Day The default value. Leave this option selected to have the building 

remain open for the entire holiday.
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Configuring User Defined Fields (UDFs)

You can configure user defined fields, or UDFs, which are custom fields that store additional 
information or data for a building, a group, a group with a reservation, a reservation, a room, 
a service order, a web request, or a web user. For example, for a reservation, you might want 
to note the date that the contract for the event was received and if the event was approved by 
a supervisor. For a web request, you might want to inquire if alcohol will be served at the 
event. User defined fields are displayed on the User Defined Fields tab in the Reservation 
Wizard and on the User Defined Fields tab in the Navigator. If user defined fields have been 
completed for a reservation, then these fields can be displayed on any confirmations and 
invoices that are generated for the reservation.

To configure user defined fields

1. On the EMS menu bar, click Configuration > Other > User Defined Fields.

The User Defined Fields window opens. This window lists all the user defined fields of
any type that are currently configured in your EMS database and that have a status of
Active.

Figure 2-26: User Defined Fields window

2. Optionally, do one or both of the following; otherwise, continue to Step 3.

• To view inactive user defined fields in your EMS database, under Show, click
Inactive.

• To view only a specific type of user defined field, on the Type dropdown list, select a
different type (Booking, Building, Group, Group/Reservation (which is a group for
which a reservation has been made), Reservation, Room, Service Order, Web
Request, or Web User).



68

 
Core Configuration - Other Data Types

3. Click New.

The User Defined Field dialog box opens.

Figure 2-27: User Defined Field dialog box

4. Enter the information for the new user defined field.

Field Description

Field Description A name or description for the field.

Note: The description can be a maximum of 30 characters, including spaces.

Field Type Select the type of data that the field is to hold (Text, Date, List, or Numeric).

Note: If you select Text, then an option for displaying a multi-line textbox in 

EMS and VEMS is available. If you select List, then an Items tab is 

displayed on the User Defined Field dialog box. You must define the 

items that are to be displayed in the list. (See Step 5 below.) 

Field Applies To Select the item to which the field applies.

• Building or Room—Provides the ability to define custom building or room

properties for reporting in Query Builder.

• Course—EMS Campus only.

• Group/Reservation—The UDF that is assigned to a group when a new

reservation is created for the group.

Category Available only if you select Service Order for Field Applies To. Select the service 

order category for which the field applies.

Note: If the appropriate category is not available, you can configure it. See 

“Configuring Categories” on page 155.

Default Value Optional field. You can enter a default value for the user defined field. This value 

is displayed in the field but a user can edit it if needed.

Note: If you assign a default value to a UDF, then the UDF is always added to 

the item. For example, if you assign a default value to a UDF that applies 

to reservations, then the UDF is always added to any reservation that 

any user makes in your EMS system.
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5. If you selected any field type other than List, go Step 6; otherwise, an Items tab is
displayed on the dialog box. Open the Items tab, and for each list item for the UDF, do
the following:

• In the Sequence field, enter the sequence for the list item.

• In the Description field, enter a name or description for the item.

6. Optionally, click Spelling to spell check the user defined field before you save it.

7. Click OK.

The User Defined Field dialog box closes. You return to the User Defined Fields window
with the newly configured field automatically selected.

Internal Indicates that the UDF is internal to your organization. 

Note: Used for internal reporting purposes only. The UDF is not printed on 

external documents such as confirmations and invoices, and it is not 

hidden in any area of your EMS application.

Sequence If a booking, building, group, a group with a reservation, a reservation, a room, a 

service order, a web request, or a web user is to have multiple user defined 

fields, then specify the display order of these fields. Fields are ordered from 

lowest to highest sequence number, with the field with the lowest sequence 

number being displayed first.

Note: If you leave the sequence set to the default value of zero for all fields, 

then by default, the fields are displayed alphabetically. 

Value

Required in 

EMS client

Select this option if a user must enter a value in the field when making a 

reservation in the EMS client.

Virtual EMS Settings

Display on Web Select this option if you want the user defined field to be displayed when users 

are making a reservation in VEMS.

Display Text Enter the text that is to be displayed for the field in VEMS.

Inactive Leave this option blank to add the user defined field an active field. Select this 

option to inactivate the field.

Items are ordered in a list from lowest to highest sequence number, with the item 
with the lowest sequence number being displayed first. If you set the sequence for 
all items to zero, then the items are displayed in the list alphabetically. 

The description can be a maximum of 50 characters, including spaces.

Field Description
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Configuring Reservation Sources

A reservation source indicates the origination of a reservation request, for example, walk-up, 
email, VEMS, and so on. You can specify a reservation source at the time that the reservation 
is being made in the Reservation Wizard, or at a later date. You can also specify the 
reservation source as part of the search criteria when searching for a reservation in the 
Browser. Configuring a reservation source simply consists of naming or describing the 
source.

To configure a reservation source

1. On the EMS menu bar, click Configuration > Other > Reservation Sources.

The Reservation Sources window opens. This window lists all the reservations sources
that are currently configured in your EMS database and that have a status of Active.

Figure 2-28: Reservation Sources window

Optionally, to view all reservation sources in your EMS database, regardless of 
status, under Show, click Inactive.
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2. Click New.

The Reservation Source dialog box opens.

Figure 2-29: Reservation Source dialog box

3. In the Reservation Source field, enter a name or description for the new source, for
example, Phoned In.

4. Leave Inactive blank to add the reservation source as an active source. Optionally, select
Inactive to inactivate the source.

5. Click OK.

The Reservation Source dialog box closes. You return to the Reservation Source window
with the newly configured source automatically selected.

The reservation source can be a maximum of 50 characters, including spaces.
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Configuring Cancel Reasons

When you are canceling a reservation in your EMS system, you can indicate a reason for the 
cancellation. You can configure a cancel reason that is as simple as a single word or phrase 
(for example, Event Postponed, Other, Will Reschedule), or you can configure it so that the 
user who is canceling the reservation must enter additional information about the 
cancellation.

To configure a cancel reason

1. On the EMS menu bar, click Configuration > Other > Cancel Reasons.

The Cancel Reasons window opens. This window lists all the cancel reasons that are
currently configured in your EMS database and that have a status of Active.

Figure 2-30: Cancel Reasons window

Optionally, to view all cancel reasons in your EMS database, regardless of status, 
under Show, click Inactive.
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2. Click New.

The Cancel Reason dialog box opens.

Figure 2-31: Cancel Reason dialog box

3. In the Cancel Reason field, enter a name or description for the new cancel reason, for
example, Customer Postponed.

4. Optionally, do one or more of the following:

• If you want the user who is canceling the reservation to enter supporting information
for this cancel reason, select Require Notes.

• If you want the cancel reason to be listed as an option for a user who is canceling the
event in VEMS, then select Display on Web.

• By default, a cancel reason is added as an active reason. Select Inactive to inactivate
the reason.

5. Click OK.

The Cancel Reason dialog box closes. You return to the Cancel Reasons window with
the newly added reason automatically selected.

The cancel reason can be a maximum of 50 characters, including spaces.
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Configuring Attachment Types

The term attachment is used to describe any file that you can add to or store on a reservation 
or booking. (Unlike a drawing, which is simply referenced, an attachment is actually stored 
in the EMS database with the reservation or booking record.) Attachments can be used for a 
variety of purposes, such as providing information about your company’s alcohol policies, 
any special food concerns for the event’s attendees, and so on. You can configure and store a 
variety of attachment types and then your users can select whichever type is most 
appropriate when working with attachments for a reservation or booking. 

To configure an attachment type

1. On the EMS menu bar, click Configuration > Other > Attachment Type.

The Attachment Types window opens. This window lists all the attachment types that are
currently configured in your EMS database and that have a status of Active.

Figure 2-32: Attachment Types window

An attachment can also be a file that is saved with the room record or a group 
record. You do not specify an attachment type for a room record. For information 
about adding an attachment to a room record, see “To add attachments to a 
room” on page 123. For information about adding an attachment to a group, see 
the EMS User’s Manual.

Optionally, to view all attachment types in your EMS database, regardless of 
status, under Show, click Inactive.
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2. Click New.

The Attachment Type box opens.

Figure 2-33: Attachment Type dialog box

3. In the Description field, enter a name or description for the new attachment type, for
example, Alcohol Policy.

4. By default, an attachment type is added as an active type. Select Inactive to inactivate the
attachment type.

5. Click OK.

The Attachment Type dialog box closes. You return to the Attachment Types window
with the newly added attachment type automatically selected.

The description can be a maximum of 30 characters, including spaces.
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Configuring Word Merge Documents (Optional 

Module)

EMS provides options for producing pre-formatted documents that contain reservation 
information such as confirmations. Your organization, however, might have 
organization-specific information that must be included in these documents. Using the 
optional Word Merge module, you can configure Word Merge documents to produce 
confirmations, contracts, and so on that contain not only selected reservation information 
from EMS, but also, any information that is required by your organization. To configure a 
Word Merge document, you must first create the Word document and apply the appropriate 
tags to indicate the information in EMS that is to be pulled into the document. You can then 
add this document to your EMS database and use it to generate confirmations, contracts, and 
so on.

To create and tag the Word document

1. Create the necessary document in Microsoft Word.

2. Tag the text that is to be replaced with EMS field values accordingly. For example, if you
want the Reservation Status in the Word document to be replaced with the EMS field
value for Reservation Status, then any reference to Reservation Status in the Word
document should be tagged as <<Reservation Status>>.

3. Continue to “To add the tagged Word document to your EMS database” on page 77.

To view a complete list of the text that can be replaced in the Word document with 
EMS field values and the correct tags for this text, on the EMS menu bar, click 
Configuration > Other > Word Merge Documents, and on the Word Merge 
Documents window that opens, click Print > Word Merge Format. If you want to 
save this document for easier access and reference, then after opening the 
document, click Export on the document toolbar, and export the document as a 
Rich Text Format (.rtf) document to a location of your choosing. You can then use 
Microsoft Word to open the document at any time.
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To add the tagged Word document to your EMS database

1. On the EMS menu bar, click Configuration > Other > Word Merge Documents.

The Word Merge Documents window opens. This window lists all the Word Merge
documents that are currently configured in your EMS database and that have a status of
Active.

Figure 2-34: Word Merge Documents window

2. Click New.

The Word Merge Document dialog box opens.

Figure 2-35: Word Merge Document dialog box

Optionally, to view all Word Merge documents in your EMS database regardless 
of status, under Show, click Inactive.
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3. In the Description field, enter the name or description for the Word Merge document.

4. Click the Search icon  to open the Find Microsoft Word Document dialog box, and
then browse to and select the Word document.

The Find Microsoft Word Document dialog box closes. You remain on the Word Merge
Document dialog box tab with an entry for the document displayed in the Document
field.

5. Optionally, do one or more of the following:

• Select a default attachment type for the document.

• Click Spelling to spell check the attachment notes before you save the document.

• By default, a Word Merge document is added as an active document. Click Inactive
to inactivate the document.

6. Click OK.

The Word Merge Document dialog box closes. You return to the Word Merge
Documents window with the newly configured document automatically selected.

The description can be a maximum of 50 characters, including spaces.

If the appropriate attachment type is not available, you can configure it. See 
“Configuring Attachment Types” on page 74.
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Configuring Calendar Styles

You can configure calendar styles, which determine the font, font size, and color (for 
example, Arial, 9 pt., Black) that are used when event information is printed on the Event 
Schedule report and on the Event Calendar report. 

To configure calendar styles

1. On the EMS menu bar, click Configuration > Other > Calendar Styles.

The Calendar Styles window opens. This window lists all the calendar styles that are
currently configured in your EMS database and that have a status of Active.

Figure 2-36: Calendar Styles window

For both reports, you must select the Use Calendar Styles option on the Options 
tab. You set the calendar style that is to be used for an event when making the 
reservation for the event in the Reservation Wizard. See the EMS User’s Manual.

Optionally, to view all calendar styles in your EMS database, regardless of status, 
under Show, click Inactive.
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2. Click New.

The Calendar Style dialog box opens.

Figure 2-37: Calendar Style dialog box

3. Enter the information for the new calendar style.

• In the Calendar Style field, enter name or description for the calendar style.

• In the Font field, the default calendar style is listed. You can leave this value as is, or

you can click the Browse button  to open the Font dialog box, and specify the

font, font size, and font color for the new calendar style.

4. Leave Inactive blank to add the calendar style as an active style. Optionally, select
Inactive to inactive this calendar style.

5. Click OK.

The Calendar Style dialog box closes. You return to the Calendar Styles window with the
newly configured calendar style automatically selected.

The calendar style can be a maximum of 50 characters, including spaces.

To reset the font characteristics to their default values, click Reset.
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Before you can use EMS to manage your organization’s events, you must configure core data 
items that are specific to your organization. For example, before you can reserve a room, you 
must first configure the room in EMS.

This chapter covers the following topics:

• “Configuring Floors” on page 83.

• “Configuring Features” on page 85.

• “Configuring Setup Types” on page 87.

• “Configuring Room Types” on page 89.

• “Configuring Buildings” on page 91.

• “Configuring Areas” on page 99.

• “Configuring Building Hours” on page 102.

• “Overview of Configuring Rooms” on page 107.

• “Configuring Rooms” on page 109.

• “Importing Rooms” on page 135.

• “Configuring Room Pricing on the Edit Pricing window” on page 137.

• “Configuring Public Views” on page 144.

• “Configuring Floor Plans” on page 147.

If your organization has purchased and installed EMS Campus, then you can 
synchronize data from your Student Information System (SIS) such as your campus 
buildings, rooms., and room types. As a result, before you carry out any 
configuration of your facilities data, see  , “EMS Campus,” on page 
461.
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Configuring Floors

A floor is optional information when you are defining a room and when you are searching 
for a room. A room can be assigned to only a single floor. Example of floors include First 
Floor, Basement, and Garden Level. When you configure a floor, you must provide a floor 
name and a sequence.

To configure a floor

1. On the EMS menu bar, click Configuration > Facilities > Floors.

The Floors window opens. The window displays all the floors that are currently
configured in your EMS database.

Figure 3-1:  Floors window

2. Click New.

The Floor dialog box opens.

Figure 3-2:  Floor dialog box
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3. In the Floor field, enter a name or description for the new floor.

4. Optionally, in the Sequence field, enter a sequence for the new floor.

5. Click OK.

The Floor dialog box closes. You return to the Floors window with the newly added floor
automatically selected.

The floor can be maximum of 50 characters, including spaces.

The sequence determines the order in which the floors are displayed in the Floor 
dropdown list. The lower the sequence number, the higher in the list that the floor 
is displayed. If the sequence is set to the default value of zero for all floors, then 
the floors are first sorted numerically, and then alphabetically, in the Floor 
dropdown list.
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Configuring Features

A feature is built-in or permanent attribute of a room, such as a network connection, a 
built-in plasma TV, window, and so on. Your users can use features as criteria when they are 
searching for a room. They can also filter the available rooms that can be reserved for an 
event by room features. After you configure the different room features for your 
organization, you must indicate which rooms have these features.

To configure features

1. On the EMS menu bar, click Configuration > Facilities > Features.

The Features window opens. This window lists all the features that are currently
configured in your EMS database.

Figure 3-3:  Features window

2. Click New.

The Feature dialog box opens.

Figure 3-4:  Feature dialog box
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3. In the Feature field, enter name or description for the feature.

4. If this feature is a video conferencing feature, then select Tied to Resource; otherwise go
to Step 5.

5. If you want VEMS users to see this feature when they are searching for available space,
leave Available on Web selected.

6. Click OK.

The Feature dialog box closes. You return to the Features window with the newly
configured feature automatically selected.

The feature can be a maximum of 50 characters, including spaces.

This option is available only in EMS Enterprise. It is not available in EMS 
Professional. See Appendix B, “Video Conferencing,” on page 511 for detailed 
information about the additional configuration required to use the video 
conferencing feature.
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Configuring Setup Types

Setup type is the physical layout or arrangement of a room, for example, classroom, 
conference, theater-style, rounds of 6, as-is, and so on. Although configuring setup types is 
not required, setup type is used for defining the capacity for a room, which is helpful 
information for the staff at your organization who prepare rooms for an event. Also, when 
you configure a room, you can note, by setup type, the capacity for the room. When 
searching for available space, your users can use setup types and capacities to filter their 
search results. 

To configure setup types

1. On the EMS menu bar, click Configuration > Facilities > Setup Types.

The Setup Types window opens. This window lists all the setup types that are currently
configured in your EMS database and that have a status of Active.

Figure 3-5:  Setup Types window

Optionally, to view all setup types in your EMS database, regardless of status, 
under Show, click Inactive.
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2. Click New.

The Setup Type dialog box opens.

Figure 3-6:  Setup Type dialog box

3. In the Setup Type field, enter a name or description for the new setup type.

4. If you want VEMS users to be able to see and request this setup type when they are
searching for available space, leave Available on Web selected.

5. Leave Inactive blank to add the setup type as an active type. Optionally, select Inactive
to inactive the setup type.

6. Click OK.

The Setup Type dialog box closes. You return to the Setup Types window with the newly
configured setup type automatically selected.

The setup type can be a maximum of 30 characters, including spaces.
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Configuring Room Types

A room type is the class or category of the room, for example a meeting room, an auditorium, 
a workspace, a multi-purpose room, and so on. Your users can use the room types that you 
configure to filter results when searching for a specific type of room.

To configure room types

1. On the EMS menu bar, click Configuration > Facilities > Room Types.

The Room Types window opens. This window lists all the room types that are currently
configured in your EMS database.

Figure 3-7:  Room Types window

2. Click New.

The Room Type dialog box opens.

Figure 3-8:  Room Type dialog box
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3. In the Room Type field, enter a name or description for the new room type.

4. If you want VEMS users to see this room type when they are searching for available
space, leave Available on Web selected.

5. Click OK.

The Room Type dialog box closes. You return to the Room Types window with the
newly configured room type automatically selected.

The room type can be a maximum of 50 characters, including spaces.
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Configuring Buildings

A building is a physical location that contains one or more spaces (rooms, open areas, and so 
on) that your users can reserve for an event. Buildings are one of the core data items that you 
must configure so that your users can make reservations in EMS. 

To configure buildings

1. On the EMS menu bar, click Configuration > Facilities > Buildings.

The Buildings window opens. This window lists all the buildings that are currently
configured in your EMS database.

Figure 3-9:  Buildings window

2. Click New.

The Building dialog box opens. The Building tab is the active tab. See Figure 3-10 on
page 92.
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Figure 3-10: Building dialog box, Building tab

3. Enter the information as appropriate for the building. See:

• “To enter the building summary information” on page 93.

• “To assign categories to a building” on page 94.

• “To associate an image with a building” on page 95.

• “To set values for the user defined fields (UDFs)” on page 96.

• “To specify the unregistered attendee/visitor information” on page 97.

4. Optionally, click Spelling to spell check the information for the building before you save
it.

5. Click OK.

The Building dialog box closes. You return to the Buildings window with the newly
configured building automatically selected.

By default, when you configure a building, the building hours are set to Open All 
Day. To change these hours, see “Configuring Building Hours” on page 102.
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To enter the building summary information

1. If needed, open the Building dialog box (see “To configure buildings” on page 91), and
then open the Building tab.

Figure 3-11: Building dialog box, Building tab

2. Enter the information for the new building.

Only the building name, the building code, and the time zone are required fields. 
All other fields on all other tabs are optional and can be configured at a later date 
if needed.

Field Description

Building Required field. The name of the building.

Note: The building name can be a maximum of 50 characters, 

including spaces.

Building Code Required field. Abbreviated text that conveys the building name or 

description. For example, if a building is named the Conference 

Building, then a code for the building could be CONF.

Note: The building code can be a maximum of 20 characters, including 

spaces.

Notes Free form text that provides any additional information or description 

about the building.

URL The URL (website address) for a web page that provides more 

information about the building (for example, MapQuest).

Print Notes on 

Confirmation

Include the building notes in any confirmations that are printed for 

events that are scheduled in the building.



94

 
Core Configuration - Facilities

3. Continue with any other configuration for the building as needed; otherwise, click OK to
close the Building dialog box and return to the Buildings window. The newly configured
building is displayed in the window.

To assign categories to a building

1. If needed, open the Building dialog box (see “To configure buildings” on page 91), and
then open the Categories tab.

Figure 3-12: Building dialog box, Categories tab

Time Zone Required field. Select the time zone in which the building resides.

Note: If you are configuring buildings in EMS Enterprise, then you can 

select a unique time zone for each building. If you are 

configuring buildings in EMS Professional, then all buildings 

must belong to the same time zone.

Currency Select the currency that is to be used for pricing all rooms in the 

building.

Note: If the appropriate currency is not available, you can configure it. 

See “Configuring Currencies” on page 272.

External Reference Links the building to an outside program, if needed.

Cost Per Sq. Ft./Meter 

Per Yr.

Building cost. Used on the Room Utilization report.

Annual Operating Hours Total number of hours that the building is open during a calendar year. 

Used on the Room Utilization report.

You can restrict specific categories to specific buildings only in EMS Enterprise. 
All categories are available to all buildings in EMS Professional.

Field Description
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2. On the Available list, select the category, or CTRL-click to select the multiple categories
that are to be available for use in the building, and then click the Move button (>) to
move the selected categories to the Selected list.

3. Continue with any other configuration for the building as needed; otherwise, click OK to
close the Building dialog box and return to the Buildings window. The newly configured
building is displayed in the window.

To associate an image with a building

Images are displayed as thumbnails in both EMS and VEMS when a user views details about 
a building. You can associate an image with a building if the image is in one of the following 
formats—.gif, .jpeg, .jpg, .bmp, .wmf, or .png and ideally, it should not be larger than 615 x 
350 pixels. If you attach an image larger than this, you might not be able to view the image 
without scrolling.

1. If needed, open the Building dialog box (see “To configure buildings” on page 91), and
then open the Images tab.

Figure 3-13: Building dialog box, Images tab

2. To have an image of the building displayed in EMS and VEMS when a user is viewing
building details, click New to open the Find Image dialog box, and then browse to and
select the image.

The Find Image dialog box closes. You remain on the Images tab with an entry for the
image displayed on the tab.

The Available to All Buildings list displays all the categories that are always 
available to all buildings and you cannot edit this list. You can also link buildings 
and categories when you are configuring categories. See “Configuring 
Categories” on page 155.
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3. Optionally, click in the Web Long Description field and enter a description of the
building.

4. Continue with any other configuration for the building as needed; otherwise, click OK to
close the Building dialog box and return to the Buildings window. The newly configured
building is displayed in the window.

To set values for the user defined fields (UDFs)

1. If needed, open the Building dialog box (see “To configure buildings” on page 91), and
then open the UDFs tab.

Figure 3-14: Building dialog box, User Defined Fields tab

2. For each UDF that has been defined for the building, select the UDF, and then click the
Set Value button to open a dialog box in which you can set the value for the UDF.

3. Continue with any other configuration for the building as needed; otherwise, click OK to
close the Building dialog box and return to the Buildings window. The newly configured
building is displayed in the window.

The value that you enter here defines the “long desc” attribute for web content 
accessibility.



97

 
Core Configuration - Facilities

To specify the unregistered attendee/visitor information

1. If needed, open the Building dialog box (see “To configure buildings” on page 91), and
then open the Visitor Management tab.

Figure 3-15: Building dialog box, Visitor Management tab

2. Enter the information for the new unregistered visitor/attendee.

The Visitor Management tab is displayed only if your organization has purchased 
and installed the optional Visitor Management module. The values that you 
specify on this tab are used when a new visitor record is created for an 
unregistered attendee/visitor. See the EMS User’s Manual for detailed information 
about creating a record for an unregistered attendee/visitor.

Option Description

Category Select an Attendee type category. 

Note: If the Attendees category is not available, you can configure it. 

See “Configuring Categories” on page 155.

Room The Override room that is booked for the unregistered visitor’s/

attendee’s reservation.

Note: Typically, you would want to book an Override room named 

something such as Other Space, Unregistered Space, or so on. If 

the appropriate room is not available, you can configure it. See 

“Configuring Rooms” on page 109.

Status The status that is used for an unregistered visitor’s/attendee’s 

reservation.

Note: If the appropriate status is not available, you can configure it. 

See “Configuring Statuses” on page 164.
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3. Continue with any other configuration for the building as needed; otherwise, click OK to
close the Building dialog box and return to the Buildings window. The newly configured
building is displayed in the window.

Event Type The event type that is used for the unregistered visitor’s/attendee’s 

reservation.

Note: Typically, you would want to use an event type named something 

such as Unregistered Visitor, Unregistered Attendee or so on. If 

the appropriate event type is not available, you can configure it. 

See “Configuring Event Types” on page 43.

Event Name The event name that is used for the unregistered visitor’s/attendee’s 

reservation.

Note: You can include the variable for Group Name (the name of the 

group that the visitor/attendee is seeing) in the subject line as 

described in the Legend. For example, “Unregistered Visitor 

for%1%” would result in “Unregistered Visitor for Academic 

Affairs” being displayed in the subject line.

End Time The booking for the unregistered visitor/attendee is created from the 

current time until the end time that you specify.

Option Description
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Configuring Areas

An area is a particular region of indefinite boundary that is used to group buildings, for 
example, Southeast Region, Campus Wide, Training Sites, and so on. You can use an area as 
search criteria in EMS and VEMS, in reporting, and so on. When you configure an area, you 
must specify the buildings that are to be included in the area.

To configure an area

1. On the EMS menu bar, click Configuration > Facilities > Areas.

The Areas window opens. This window lists all the areas that are currently configured in
your EMS database.

Figure 3-16: Areas window

2. Click New.

The Area dialog box opens. The Area tab is the active tab. See Figure 3-17 on page 100.

You can configure areas only in EMS Enterprise. You cannot configure areas in 
EMS Professional.
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Figure 3-17: Area dialog box, Area tab

3. In the Area field, enter a name or description for the new area, for example, Southeast
Region.

4. Optionally, do one or both of the following:

• In the Notes field, enter additional information that is pertinent for the area.

• For VEMS users to be able to see and filter by this area, select Display on Web.

5. Open the Buildings tab, and on the Available list, select the building, or CTRL-click to
select the multiple buildings that are to be included in the area, and then click the Move
button (>) to move the selected buildings to the Selected list. See Figure 3-18 on page
101.

The area can be a maximum of 50 characters, including spaces.
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Figure 3-18: Area dialog box, Buildings tab

6. Optionally, click Spelling to spell check the area description before you save the area.

7. Click OK.

The Area dialog box closes. You return to the Areas window with the newly configured
area automatically selected.
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Configuring Building Hours

By default, when you configure a building, the building hours are set to Open All Day, which 
means that the building is open 24 hours a day, 7 days a week, 365 days a year. If needed, 
you can configure the hours for a building so that a building is open only for a specified time 
period on a particular date or for a given date range. You can also configure the hours so that 
a building is closed all day. You can configure the hours for a building for a single date, or 
you can configure the hours for multiple dates in a single step.

To configure building hours for a single date

1. On the EMS menu bar, click Configuration > Facilities > Building Hours.

The Building Hours window opens. This window lists all the buildings and their
operating hours that are configured in your EMS database.

Figure 3-19: Building Hours window

2. In the Date field, leave the default value of the current day’s date, or select a different
date.

In the EMS client, configured building hours do not prevent a user from 
scheduling events outside these hours. A user is merely warned that the event is 
being scheduled outside normal operating hours. In VEMS, users cannot schedule 
events outside the configured building hours. Setup and teardown hours must also 
fall within the configured building hours for an event that is scheduled in VEMS.
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3. Select the building, or CTRL-click to select the multiple buildings for which you are
changing the hours, and then click Change.

The Building Hours dialog box opens.

Figure 3-20: Building Hours dialog box

4. Set the new hours for the buildings as appropriate.

5. Click OK.

The Building Hours dialog box closes. You return to the Building Hours window.

If you select multiple buildings, then the Building Hours dialog box reflects the 
hours for the building that is last in the list of selected buildings. 

Option Description

Set Building Hours Select this option to specify the time period (Open and Close) during 

which the building is to remain open for the date. Your EMS users can 

make reservations on this date in the selected buildings even if the 

events are scheduled outside the indicated time period. They merely 

receive a warning that the reservation time exceeds building hours.

Note: VEMS users cannot make reservations outside of building hours.

Closed All Day Select this option to close the building for the entire day. When you 

select this option, then a Web Only option is displayed on the Building 

Hours dialog box.

• If you do not select Web Only, then none of your users (EMS or

VEMS) can make reservations on this date in the selected buildings.

• If you do you select Web Only, then your EMS users can make

reservations on this date in the selected buildings; however, your

VEMS users cannot.

Open All Day The default value. Leave this option selected to have the building 

remain open for the entire holiday.
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To configure building hours for multiple dates

1. On the EMS menu bar, click Configuration > Facilities > Building Hours.

The Building Hours window opens. This window lists all the buildings and their
operating hours that are configured in your EMS database.

Figure 3-21: Building Hours window

2. Click Wizard.

The Building Hours Wizard opens.

Figure 3-22: Building Hours Wizard
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3. Click Add Dates.

The Date Pattern dialog box opens.

Figure 3-23: Date Pattern dialog box

4. Enter the appropriate date pattern, and then click OK. (Both the Start Date and End Date
are required values.)

The Date Pattern dialog box closes. You return to the Building Hours Wizard. The dates
that meet the pattern that you specified are displayed in the Building Hours Wizard. If
any of the dates that meet the pattern are holidays, then the name of the holiday is
displayed next to the date.

5. Optionally, do one or both of the following:

• To view information about a date that is marked as a holiday, select the date, and
then click Holidays.

• To remove any dates from the list, select the date, or CTRL-click to select multiple
dates, and then click Remove.

6. Click Next.

The Building Hours Wizard is updated with a list of all the buildings that have been
configured in your EMS database.

Figure 3-24: Building Hours Wizard with a list of configured buildings
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7. Select the building, or CTRL-click to select the multiple buildings for which you are
configuring the hours, and then click the Move button (>) to move the buildings to the
Selected list.

8. Click Next.

The Building Hours Wizard is updated with options for configuring the building hours
for the selected buildings.

9. Set the new hours for the buildings as appropriate.

10. Click Finish.

The Building Hours Wizard closes. You return to the Building Hours window.

Option Description

Set Building Hours Select this option to specify the time period (Open and Close) during 

which the building is to remain open for the date. Your EMS users can 

make reservations on this date in the selected buildings even if the 

events are scheduled outside the indicated time period. They merely 

receive a warning that the reservation time exceeds building hours.

Note: VEMS users cannot make reservations outside of building hours.

Closed All Day Select this option to close the building for the entire day. When you 

select this option, then a Web Only option is displayed on the Building 

Hours dialog box.

• If you do not select Web Only, then none of your users (EMS or

VEMS) can make reservations on this date in the selected buildings.

• If you do you select Web Only, then your EMS users can make

reservations on this date in the selected buildings; however, your

VEMS users cannot.

Open All Day The default value. Leave this option selected to have the building 

remain open for the entire holiday.
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Overview of Configuring Rooms

A room is a physical location that you reserve for an event. You can configure any physical 
location or space (meeting room, athletic field, lobby, and so on) as a room. The following 
list is an example of how you might configure rooms for your organization:

• Grand Ballroom

• Conference Room A

• Harris Hall Room 200

• South Soccer Field

EMS uses three classifications of rooms—a standard room, a combination (or “combo”) 
room, and an override room. 

Room classifications

A standard room is any physical space that can be booked at your facility. You can use 
standard rooms as components when you configure a combination room. You can configure 
a combination room from two or more standard rooms, or you can configure it based on a 
logical relationship among multiple rooms. For example, if your organization is a student 
union, it might have a space that is designated as the Grand Ballroom, which is actually 
made of three standard rooms—Ballroom A, Ballroom B, and Ballroom C—and you can 
literally combine or divide these rooms using movable partitions. In another example, you 
could configure a combination room that is called the West End and this room includes all 
rooms in the West End of a given building, whether the rooms are contiguous. 

To configure a combination room, you must first configure the component rooms as standard 
rooms. You can then configure the combination room and indicate that its components are 
the previously defined standard rooms. Consider the ballroom example cited above: First, 
define the standard rooms—Ballroom A, Ballroom B, and Ballroom C. You then configure a 
room called the Grand Ballroom, give it a classification of “combo room” and indicate that it 
is made up of three standard rooms—Ballroom A, Ballroom B, and Ballroom C. If you want, 
you can also configure subsets of the Grand Ballroom, such as Ballroom AB, Ballroom AC, 
and Ballroom BC. As a result, when the Grand Ballroom is scheduled for an event, the three 
standard rooms—Ballroom A, Ballroom B, and Ballroom C—are unavailable in EMS. 
Conversely, if you schedule one of the three standard rooms, for example, Ballroom A, then 
the Grand Ballroom, Ballroom AB, and Ballroom AC, are unavailable in EMS. Table 3-1 
summarizes this example.

Your organization might use a different term to identify the spaces or locations 
that are booked for reservations at your facilities. If you want to change the term 
from “room” to your organization-specific term throughout your EMS system 
(menus, window and dialog box titles, confirmation headings, and so on), you 
must change the values for the Room Title Plural and Room Title Singular 
parameters. See Appendix A, “System Parameters,” on page 491. 
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An override room is used to book an event in a space that is not managed in EMS. When you 
configure an override room, you not only name it in a manner that indicates that the room is 
an override room (for example, “Override Area”), but also, you classify the room as 
“Override Description.” When a user is searching for a specific room in the Reservation 
Wizard, and selects the option of “Override Area,” a Location field is enabled in which they 
must enter the specific location of this override room. By using an override room, the user 
can schedule a meeting (for example, Dr. Wilson’s Research Group meeting) without having 
“Dr. Wilson’s Office” configured as a room in EMS. 

Events that are scheduled in rooms that are classified as “Override Description” are 
displayed in Daily reports as taking place in the location name specified, in the building in 
which the room is configured. Sales and Statistical reports simply report on the use of a room 
as you defined it, for example as “Override Area.”

Table 3-1: Example of standard rooms and combo rooms

Room Classification Components Comments

Ballroom A Standard N/A Available for booking only if Ballroom AB, 

Ballroom AC, or the Grand Ballroom are not 

already booked.

Ballroom B Standard N/A Available for booking only if Ballroom AB, 

Ballroom BC, or the Grand Ballroom are not 

already booked.

Ballroom C Standard N/A Available for booking only if Ballroom BC, 

Ballroom AC, or the Grand Ballroom are not 

already booked.

Ballroom AB Combo Ballroom A, 

Ballroom B

Available for booking only if Ballroom A, 

Ballroom B, or the Grand Ballroom are not 

already booked.

Ballroom AC Combo Ballroom A, 

Ballroom C

Available for booking only if Ballroom A, 

Ballroom C, or the Grand Ballroom are not 

already booked.

Ballroom BC Combo Ballroom B, 

Ballroom C

Available for booking only if Ballroom B, 

Ballroom C, or the Grand Ballroom are not 

already booked.

Grand 

Ballroom

Combo Ballroom A, 

Ballroom B, 

Ballroom C

Available for booking only if none of the 

standard rooms or none of the subset 

ballrooms are not already booked.
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Configuring Rooms

You can configure one room at a time, or if multiple standard rooms are to have the same 
configuration (room type, setup hours, teardown hours, features, and setup types), then you 
can use the Room Configuration Wizard to configure these attributes for all these rooms at 
the same time. You can also specify the pricing for a room at the time that you are 
configuring the room, or you can price it at a later date. Optionally, if you want to first 
confirm that a room has not already been configured, then you can search for the room.

To search for a room

1. On the EMS menu bar, click Configuration > Facilities > Rooms.

The Rooms window opens.

Figure 3-25: Rooms window

2. Enter any combination of the following search criteria:

• On the Building dropdown list, select one of the following—(all) buildings, a
specific building, a specific area, or a specific view.

• On the Classification dropdown list, leave the default value of (all), or select a
specific room classification.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

• Under Show, select one or both room statuses.

As you select your search criteria, the list of rooms that meet the search criteria is 
dynamically updated.
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3. Optionally, to further filter the displayed search results based on the Room Name, in the
Filter field, enter a search string.

To configure one room at a time

To configure one room at a time, at a minimum, you must specify the room code, the room 
name, the room classification, and the building that contains the room. All other information 
is optional, and you can configure it at a later date if needed.

1. On the EMS menu bar, click Configuration > Facilities > Rooms.

The Rooms window opens.

Figure 3-26: Rooms window

2. On the Building dropdown list, select one of the following to add the room to—(all)
buildings, a specific building, a specific area, or a specific view.

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of mee returns Meeting room, but not 
Science Meeting room.

Optionally, if you want to first confirm that a room has not already been 
configured, then you can search for the room. See “To search for a room” on page 
109.

If the appropriate building, area, or view is not available, you can configure it. 
See “Configuring Room Types” on page 89, “Configuring Areas” on page 99, or 
“Configuring Public Views” on page 144.

The remainder of this procedure describes how to configure a room “from 
scratch.” You can also configure a room by copying an existing room. Search for 
and select the room that you are copying, click Copy, and then go to Step 4. 
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3. Click New.

The Room dialog box opens. The Room tab is the active tab.

Figure 3-27: Room dialog box, Room tab

4. Enter the information for the new room.

Field Description

Room Code Required field. Abbreviated text that conveys the room name or 

description. For example, if a room is named Conference Room 100, 

then a code for the room could be CONF100.

Note: The room code can be a maximum of 20 characters, including 

spaces.

Room Name Required field. The name of the room.

Note: The room name can be a maximum of 50 characters, including 

spaces.

Classification Select the appropriate classification for the room. See “Room 

classifications” on page 107 for detailed information.

Default Setup Type Leave the default as (none), or select a setup type from the list. 

Note: A user can override this value when reserving the room, or when 

editing the event. If the appropriate setup type is not available, 

you can configure it. See “Configuring Setup Types” on page 87.
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Setup Hours

Teardown Hours

These settings establish the default setup and teardown hours for the 

room, which are automatically added to the beginning and end of the 

event time that the user specifies in the Reservation Wizard or in VEMS. 

A user can override these default values in the Reservation Wizard.

Book Sequence This value determines the order in which the rooms are listed in the 

Reservation Wizard for a standard or best fit room search and in the 

Reservation Book as well. Enter a zero for the first room that is to be 

listed. Rooms are ordered from lowest to highest sequence number, 

with the room with the lowest sequence number being displayed first.

Note: If you leave the book sequence set to the default value of zero 

for all rooms, then rooms that are sorted first numerically by 

room code, and then alphabetically by room code. 

Type Room type. Leave the default as (none), or select a room type from the 

list. 

Note: If the appropriate room type is not available, you can configure it. 

See “Configuring Room Types” on page 89.

Building Required field. If you selected a single building in Step 2, then this field 

is automatically populated but you can select a different building if 

needed. If you selected (all) buildings in Step 2, then you must select a 

building.

Account Enter the internal account that should be credited with the room rental 

revenue.

Note: If the appropriate account is not available, you can configure it. 

See “Configuring Accounts” on page 263.

Phone The phone number for the room.

HVAC Zone Optional field that is used for integrating EMS with an HVAC system.

URL The URL (website address) for a web page that provides more 

information about the room (for example, MapQuest).

Size Typically used to enter the square footage of the room.

No. of Room Cards Indicates how many copies of the Room Cards report should be printed 

for this room when the report is run. (Typically, you want one copy for 

each entry door). If you do not want a room card to print, enter a zero.

Academic Available only in EMS Campus. Set an “academic” property on the 

room. 

External Reference Links the room to an outside program, if needed.

Virtual EMS Settings

Display on the Web Leave this option selected if events that are scheduled in the room are 

to be displayed in VEMS.

Hide Group Select this option to hide the name of the group that booked an event in 

the room in the Browse Event tooltip.

Display Alert on Web Select this option to display any alerts that have been configured for the 

room when a VEMS user schedules an event in the room.

Inactive Leave this option blank to add the room as an active room. Select this 

option to inactivate the room.

Field Description
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5. If the room is a Combo room, then you must at least continue to “To specify the
components for a combination room” on page 120; otherwise, optionally, continue to
one or more of the following for the room.

• “To enter notes or alerts for a room” on page 115.

• “To configure the calculations for a room” on page 116.

• “To configure the pricing for a room” on page 117.

• “To specify the setup types for the room” on page 119.

• “To specify the features for a room” on page 121.

• “To specify the excluded resources for a room” on page 122.

• “To add attachments to a room” on page 123.

• “To associate an image with a room” on page 124.

• “To attach drawings to a room” on page 125.

• “To set values for the user defined fields (UDFs)” on page 126.

• “To assign the room to web process templates” on page 127.

6. Optionally, click Spelling to spell check the information that you entered for the room
before you save the room.

7. Click OK.

The Room dialog box closes and you return to the Rooms window. The newly
configured room is displayed in the window.
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To enter notes or alerts for a room

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Notes tab.

Figure 3-28: Room dialog box, Notes tab

2. Enter one or more of the following for the room:

3. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

Option Description

Notes Free form text that provides any additional information or description 

about the room. 

Note: These notes are not included in confirmations that are printed for 

events that are scheduled in the room. See “Confirmation Notes” 

below.

Confirmation Notes These notes are included in any confirmations that are printed for 

events that are scheduled in the room.

Alert Free form text that provides any additional information or description 

about the room. This text is displayed when an EMS user schedules an 

event in the room, and if Display Alert on Web is selected for the room, 

when a VEMS user schedules an event in the room as well.
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To configure the calculations for a room

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Calculations tab.

Figure 3-29: Room dialog box, Calculations tab

2. On the Available list, select the calculation, or CTRL-click to select the multiple
calculations that are to always apply to this room, and then click the Move button (>) to
move the selected calculations to the Selected list.

3. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

If the appropriate calculation is not available, you can configure it. See 
“Configuring Calculations” on page 258.
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To configure the pricing for a room

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Pricing tab.

Figure 3-30: Room dialog box, Pricing tab

2. For each rate schedule, select the Pricing method, which determines the cost for
reserving the room.

You can also configure the room price on the Edit Pricing window (see 
“Configuring Room Pricing on the Edit Pricing window” on page 137) or when 
you are configuring rate schedules (see “Configuring Rate Schedules” on page 
247).

If the appropriate rate schedule is not available, then you can configure it. See 
“Configuring Rate Schedules” on page 247.

Pricing Method Description

Half Day/Full Day 

(Event Time)

The total number of hours for the event is counted and then compared to 

the number of hours that is indicated in the Hours column. If the total 

number of hours for the event is less than or equal to the hours that are 

indicated in the Hours column, then the Half Day price is charged for the 

room. If the total number of hours for the event is greater than the hours 

that are indicated in the Hours column, then the Full Day price is charged 

for the room.
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3. After you select a pricing method, click in the appropriate fields to select the currently
displayed amount, and then edit the amount as needed.

Half Day/Full Day 

(Reserved Time)

The total number of hours for the reservation (event time and reserved 

time) is counted and then compared to the number of hours that is indicated 

in the Hours column. If the total number of hours for the reservation is less 

than or equal to the hours that are indicated in the Hours column, then the 

Half Day price is charged for the room. If the total number of hours for the 

reservation is greater than the hours that are indicated in the Hours column, 

then the Full Day price is charged for the room.

Hourly (Event Time) The price that is indicated in the Price column is multiplied by the event time 

(in hours) for the booking. This price can be used in conjunction with an 

initial “flat” fee, as well as minimum and maximum fees. 

Hourly (Reserved 

Time)

The price that is indicated in the Price column is multiplied by the reserved 

time (in hours) for the booking. This price can be used in conjunction with 

an initial “flat” fee, as well as minimum and maximum fees. 

Hourly (Specific) The price that is indicated in the Price column is multiplied by the number of 

hours indicated when adding a room to a booking.

Unit The price that is indicated in the Price column is applied to the room, 

regardless of the event time or reserved time for the booking.

Field Description

Price The dollar amount that is used in calculating the room price for a booking. If 

the pricing method is Unit, then this value is applied in total to a room, 

regardless of the event time or reserved time for the booking.

Discount You can use a discount with any pricing method. If you specify a discount for 

a room, then the actual price, the discount percentage, and the discounted 

amount are all displayed on confirmations and invoices.

Min. Charge

Max. Charge

Used in conjunction with the Hourly pricing methods. If you specify a 

minimum charge for a room, then the system compares this value to the 

calculated hourly rate and applies the greater of the two charges. Likewise, 

if you specify a maximum charge for a room, then the system compares this 

value to the calculated hourly rate and applies the lesser of the two charges.

Flat Price A room price that remains constant regardless of the total number of hours 

booked for a room. Used in conjunction with Hourly (Event Time) and Hourly 

(Reserved Time).

Half Day Price The dollar amount that is used in calculating the room price for a booking if 

the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day 

(Reservation Time).

Full Day Price The dollar amount that is used in calculating the room price for a booking if 

the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day 

(Reservation Time).

Hours Multiplier used in calculating the room price for a booking if the pricing unit is 

Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation Time).

Pricing Method Description
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4. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

To specify the setup types for the room

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Setup Types tab.

Figure 3-31: Room dialog box, Setup Types tab

2. For each setup type that is applicable for the room, select In Use, and then click in the
Min Capacity and/or Max. Capacity fields and enter the minimum capacity, maximum
capacity, or both for the setup type.

3. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

If the appropriate setup type is not available, you can configure it. See 
“Configuring Setup Types” on page 87.
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To specify the components for a combination room

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Components tab.

Figure 3-32: Room dialog box, Components tab

2. Do one or both of the following:

• On the Building dropdown list, select one of the following—(all) buildings, a
specific building, a specific area, or a specific view.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

As you select your search criteria, the list of rooms that meet the search criteria is 
dynamically updated.

This tab is available only if you selected Combo for the room classification.

If the appropriate building, area, or view is not available, you can configure it. 
See “Configuring Buildings” on page 91, “Configuring Areas” on page 99, or 
“Configuring Public Views” on page 144.

If the appropriate room type is not available, you can configure it. See 
“Configuring Room Types” on page 89.
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3. On the Available list, CTRL-click to select the multiple standard rooms that are to make
up the Combo room, and then click the Move button (>) to move the selected rooms to
the Selected list.

4. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

To specify the features for a room

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Features tab.

Figure 3-33: Room dialog box, Features tab

2. On the Available list, select the feature, or CTRL-click to select the multiple features that
the room has, and then click the Move button (>) to move the selected features to the
Selected list.

3. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

If the appropriate feature is not available, you can configure it. See “Configuring 
Features” on page 85.
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To specify the excluded resources for a room

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Excluded Resources tab.

Figure 3-34: Room dialog box, Excluded Resources tab

2. On the Category dropdown list, select the category that contains the resources that are to
be excluded from the room.

The resources for the selected category are displayed in the Available list.

3. Select the resource, or CTRL-click to select the multiple resources that are to be
excluded from the room, and then click the Move button (>) to move the resources to the
Selected list.

4. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

VEMS users are prohibited from selecting a resource that has been excluded from 
a particular room. EMS client users receive just a warning, but they can still select 
the resources for the room.

If the appropriate category and/or resource is not available, then you can 
configure it. See “Configuring Categories” on page 155 and “Configuring 
Resources for a Category” on page 206.
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To add attachments to a room

An attachment is a file that is saved with the room record. For example, you might want to 
add an attachment to a room record that details any special considerations about the room 
setup. EMS users can see the attachments when they are viewing details about the room.

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Attachments tab.

Figure 3-35: Room dialog box, Attachments tab

2. Click New to open the Find Attachment dialog box, and then browse to and select the
attachment.

The Find Attachment dialog box closes. You remain on the Attachments tab with an
entry for the attachment displayed on the tab.

3. Optionally, do one or more of the following:

• In the Notes field, enter a description and/or additional information about the
attachment.

• Click Spelling to spell check the attachment notes before you save the room.

• Optionally, to view an attachment, select the attachment, and then click View.

Your EMS client must have the appropriate program installed to view the 
attachment. For example, to view a Microsoft Excel spreadsheet, you must have 
Microsoft Excel installed on your EMS client.
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4. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

To associate an image with a room

Images are displayed as thumbnails in both EMS and VEMS when a user views details about 
a room. You can associate an image with a room if the image is in one of the following 
formats—.gif, .jpeg, .jpg, .bmp, .wmf, .pdf or .png and ideally, it should not be larger than 
615 x 350 pixels. If you attach an image larger than this, you might not be able to view the 
image without scrolling.

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Images tab.

Figure 3-36: Room dialog box, Images tab

2. Click New to open the Find Image dialog box, and then browse to and select the image.

The Find Image dialog box closes. You remain on the Images tab with an entry for the
image displayed on the tab.

3. Optionally, click in the Web Long Description field and enter a description of the image.

The value that you enter here defines the “long desc” attribute for web content 
accessibility.
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4. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

To attach drawings to a room

The term drawing is used to describe a file (text-based or image file) that is stored on your 
organization’s network that you can reference in a booking. Typically, a drawing is a setup 
diagram of the booking room. 

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Drawings tab.

Figure 3-37: Room dialog box, Drawings tab

2. Click Attach to open the Find Drawing dialog box, and then browse to and select the
drawing

The Find Drawing dialog box closes. You remain on the Drawing tabs with an entry for
the drawing displayed on the tab.

3. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.

If the drawing is an image file, and you want your users to be able to view the 
image in EMS and VEMS when making a reservation, then you should associate 
the image with the room on the Images tab. 
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To set values for the user defined fields (UDFs)

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the User Defined Fields tab.

Figure 3-38: Room dialog box, User Defined Fields tab

2. For each UDF that has been defined for the room, select the UDF, and then click the Set
Value button to open a dialog box in which you can set the value for the UDF.

3. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.
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To assign the room to web process templates

1. If needed, open the Room dialog box (see “To configure one room at a time” on page
110), and then open the Web Process Template tab.

Figure 3-39: Room dialog box, Web Process Template tab

2. On the Available list, select the web process template, or CTRL-click to select the
multiple templates for which the attached users can book the room, and then click the
Move button (>) to move the selected templates to the correct Selected list.

• Move templates for which the attached users can reserve the room without approval
(booked into the Reserve status in VEMS) into the Reserve pane.

• Move templates for which the attached users must get approval to reserve the room
(booked into the Request status in VEMS) into the Request pane.

3. Continue with any other optional configuration for the room as needed; otherwise, click
OK to close the Room dialog box and return to the Rooms window. The newly
configured room is displayed in the window.
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To use the Room Configuration Wizard

You use the Room Configuration Wizard to configure multiple standard rooms that have the 
following properties in common—room type, setup hours, teardown hours, features, and 
setup types.

1. On the EMS menu bar, click Configuration > Facilities > Rooms.

The Rooms window opens.

Figure 3-40: Rooms window

2. Click Wizard.

The Room Configuration Wizard opens. The Features tab (in the Items pane) is opened
by default. See Figure 3-41 on page 129.

Optionally, if you want to first confirm that a room has not already been 
configured, then you can search for the room. See “To search for a room” on page 
109.
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Figure 3-41: Room Configuration Wizard

3. Select the common properties for all the rooms that you are configuring and enter the
appropriate values.

4. If the events that are scheduled in the room are to be displayed in VEMS, select Display
on the Web.

Option Comment

Room Type If the appropriate room type is not available, you can configure it. See 

“Configuring Room Types” on page 89.

Floor If the appropriate floor is not available, you can configure it. See 

“Configuring Floors” on page 83.

Account If the appropriate account is not available, you can configure it. See 

“Configuring Accounts” on page 263.

Default Setup Type If the appropriate setup type is not available, you can configure it. See 

“Configuring Setup Types” on page 87.

Note: A user can override this value when reserving the room, or when 

editing the event. 

Setup Hours

Teardown Hours

These settings establish the default setup and teardown hours for the 

room, which are automatically added to the beginning and end of the 

event time that user specifies in the Reservation Wizard or in VEMS. A 

user can override these default values in the Reservation Wizard.

If you are configuring a room in EMS Campus, then Academic Space is also a 
common property that you can configure.
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5. If these rooms are to be active rooms (available immediately for booking events), then
select Active. (Yes is selected by default). Otherwise, select No.

6. Optionally, continue to one or more of the following; otherwise, continue to Step 7.

• “To configure common features for multiple rooms” on page 131.

• “To configure common excluded resources for multiple rooms” on page 132.

• “To configure common setup types for multiple rooms” on page 133.

• “To configure common UDFs for multiple rooms” on page 134.

7. Click Next.

The Room Configuration Wizard is updated with options for searching for the rooms that
are to be configured.

Figure 3-42: Rooms Configuration Wizard

8. Enter any combination of the following search criteria:

• On the Building dropdown list, select one of the following—(all) buildings, a
specific building, a specific area, or a specific view.

• On the Room Type dropdown list, select a specific room type.

If the appropriate building, area, or view is not available, you can configure it. 
See “Configuring Buildings” on page 91, “Configuring Areas” on page 99, or 
“Configuring Public Views” on page 144.

If the appropriate room type is not available, you can configure it. See 
“Configuring Room Types” on page 89.
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9. On the Available list, select the room or CTRL-click to select the multiple rooms that are
to be configured, and then click the Move button (>) to move the selected rooms to the
Selected list.

10. Click Finish.

The Room Configuration Wizard closes. A message opens indicating that the room
properties were set successfully.

11. Click OK.

The message closes. You return to the Rooms window. The newly configured rooms are
displayed in the window.

To configure common features for multiple rooms

1. If all the rooms are to have the same features, then under Items, select Features.

2. On the Available list, select the feature, or CTRL-click to select the multiple features that
the rooms are to have.

3. If any of the rooms that you select for configuration have existing features and you want
to drop these existing features and apply only the new features, select Overwrite
Existing; otherwise, the new features are simply appended to the list of existing features.

4. Continue with any other optional configuration for the room as needed; otherwise, click
Next to continue in the Room Configuration wizard. See Step 7 of “To use the Room
Configuration Wizard” on page 128.

If the appropriate features are not available, you can configure them. See 
“Configuring Features” on page 85.
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To configure common excluded resources for multiple rooms

1. Under Items, select Excluded Resources.

The Excluded Resources tab opens.

Figure 3-43: Room Configuration Wizard, Excluded Resources tab

2. Select the category that contains the resources that are to be excluded.

The category’s resources are displayed in the Available list.

3. On the Available list, select the resource, or CTRL-click to select the multiple resources
that are to be excluded from the rooms.

4. If any of the rooms that you select for configuration have existing resources and you
want to drop these existing resources and apply only the new resources, select Overwrite
Existing; otherwise, the new resources are simply appended to the list of existing
resources.

5. Click the Move button (>) to move the selected resources to the Selected list.

If the appropriate categories are not available, you can configure them. See 
“Configuring Categories” on page 155.

If the appropriate resources are not available, you can configure them. See 
“Configuring Resources for a Category” on page 206.
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6. Continue with any other optional configuration for the room as needed; otherwise, click
Next to continue in the Room Configuration wizard. See Step 7 of “To use the Room
Configuration Wizard” on page 128.

To configure common setup types for multiple rooms

1. Under Items, select Setup Types.

The Setup Types tab opens.

Figure 3-44: Room Configuration Wizard, Setup Types tab

2. If any of the rooms that you select for configuration have existing setup types and you
want to drop these existing setup types and apply only the new setup types, select
Overwrite Existing; otherwise, the new setup types are simply appended to the list of
existing setup types.

3. For each applicable setup type, select In Use, and then click in the Min. Capacity and/or
Max. Capacity field and enter the minimum capacity, maximum capacity, or both for the
setup type.

4. Continue with any other optional configuration for the room as needed; otherwise, click
Next to continue in the Room Configuration Wizard. See Step 7 of “To use the Room
Configuration Wizard” on page 128.
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To configure common UDFs for multiple rooms

1. Click User Defined Fields.

The User Defined Fields tab opens. All the UDFs that have a type of Room are displayed
on the tab.

Figure 3-45: Room Configuration Wizard, User Defined Fields tab

2. If any of the rooms that you select for configuration have existing UDFs with set values
and you want to drop these existing values and apply only the new values, select
Overwrite Existing; otherwise, the new values are simply appended to the list of existing
values.

3. For each UDF that you are configuring for the room, do the following:

• Select the UDF.

• Click Set Value to open a Value dialog box.

• Enter the value for the UDF in the Value field, and then click OK to close the dialog
box and return to the User Defined Fields tab.

4. Continue with any other optional configuration for the room as needed; otherwise, click
Next to continue in the Room Configuration Wizard. See Step 7 of “To use the Room
Configuration Wizard” on page 128.



135

 
Core Configuration - Facilities

Importing Rooms

You can import rooms from a tab-delimited file into a building, area, or view that you select. 
(See Appendix E, “Import File Specifications,” on page 539 for the room import file 
specifications.) After you import rooms, you must edit the configuration (setup type, 
features, images, and so on) for each room.

To import rooms

1. On the EMS menu bar, click Configuration > Facilities > Rooms.

The Rooms window opens.

Figure 3-46: Rooms window

2. On the Building dropdown list, select a specific building, a specific area, or a specific
view to import the rooms into.

3. Click Import.

A dialog box opens, indicating the number of rooms that you are about to import, and
asking you if you want to continue.

4. Click Yes.

A message opens indicating that the import was successful.

5. Click OK to close the message and return to the Rooms window.

6. For each room that was imported, select the room on the Rooms window, and then click
Edit to open the Room in the Room dialog box.

If the appropriate building, area, or view is not available, you can configure it. 
See “Configuring Buildings” on page 91, “Configuring Areas” on page 99, or 
“Configuring Public Views” on page 144.
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7. Edit the room configuration as needed. See “To configure one room at a time” on page
110.
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Configuring Room Pricing on the Edit Pricing 

window

You can configure the pricing for a room on the Pricing tab of the Room dialog box, or you 
can configure the room, and then configure the pricing for it at a later date on the Edit Pricing 
window.

To configure room pricing on the Edit Pricing window

1. On the EMS menu bar, click Configuration > Facilities > Rooms.

The Rooms window opens.

Figure 3-47: Rooms window

2. On the Building dropdown list, select the building, area, or view that contains the rooms
that you are pricing.

You can also configure the room price at the time that you are configuring the 
room on the Room dialog box (see “To configure the pricing for a room” on page 
117), or at the time that you are configuring rate schedules (see “Configuring 
Rate Schedules” on page 247).
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3. Click Pricing.

The Edit Pricing window opens.

Figure 3-48: Edit Pricing window

4. On the Rate Schedule dropdown list, select the rate schedule for which you are pricing
the rooms.

5. Do one of the following:

• Leave the Room Type set to the default value of (all), and then click Display to
display a list of all active rooms for all room types that have been configured in your
EMS database.

• On the Room Type dropdown list, select a specific room type, and then click Display
to display a list of all active rooms for the selected room type.

6. For each room, select the pricing method, which determines the cost for reserving the
room.

If the appropriate rate schedule is not available, you can configure it. See 
“Configuring Rate Schedules” on page 247.

Pricing Method Description

Half Day/Full Day 

(Event Time)

The total number of hours for the event is counted and then compared 

to the number of hours that is indicated in the Hours column. If the total 

number of hours for the event is less than or equal to the hours that are 

indicated in the Hours column, then the Half Day price is charged for the 

room. If the total number of hours for the event is greater than the hours 

that are indicated in the Hours column, then the Full Day price is 

charged for the room.
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7. After you select a pricing method, click in the appropriate fields to select the currently
displayed amount, and then edit the amount as needed.

Half Day/Full Day 

(Reserved Time)

The total number of hours for the reservation (event time and reserved 

time) is counted and then compared to the number of hours that is 

indicated in the Hours column. If the total number of hours for the 

reservation is less than or equal to the hours that are indicated in the 

Hours column, then the Half Day price is charged for the room. If the 

total number of hours for the reservation is greater than the hours that 

are indicated in the Hours column, then the Full Day price is charged for 

the room.

Hourly (Event Time) The price that is indicated in the Price column is multiplied by the event 

time (in hours) for the booking. This price can be used in conjunction 

with an initial “flat” fee, as well as minimum and maximum fees. 

Hourly (Reserved Time) The price that is indicated in the Price column is multiplied by the 

reserved time (in hours) for the booking. This price can be used in 

conjunction with an initial “flat” fee, as well as minimum and maximum 

fees. 

Hourly (Service Time) The price that is indicated in the Price column is multiplied by the 

reserved time (in hours) for the service (resource). This price can be 

used in conjunction with an initial “flat” fee, as well as minimum and 

maximum fees. 

Hourly (Specific) The price that is indicated in the Price column is multiplied by the 

number of hours indicated when adding the room to a booking.

Unit The price that is indicated in the Price column is applied to the room, 

regardless of the event time or reserved time for the booking.

Field Description

Price The dollar amount that is used in calculating the room price for a 

booking. If the pricing method is Unit, then this value is applied in total to 

a room, regardless of the event time or reserved time for the booking.

Discount You can use a discount with any pricing method. If you specify a 

discount for a room, then the actual price, the discount percentage, and 

the discounted amount are displayed on confirmations and invoices.

Min. Charge

Max. Charge

The values that are indicated in these columns are used in conjunction 

with the Hourly pricing methods. If you specify a minimum charge for a 

room, then the system compares this value to the calculated hourly rate 

and applies the greater of the two charges. Likewise, if you specify a 

maximum charge for a room, then the system compares this value to 

the calculated hourly rate and applies the lesser of the two charges.

Flat Price A resource price that remains constant regardless of the total number of 

hours booked for the room. Used in conjunction with Hourly (Event 

Time) and Hourly (Reserved Time).

Half Day Price The dollar amount that is used in calculating the room price for a 

booking if the pricing unit is Half Day/Full Day (Event Time) or Half Day/

Full Day (Reservation Time).

Pricing Method Description
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8. Repeat Step 4 through Step 7 for each rate schedule and/or grouping as needed.

9. Click Close.

The Edit Pricing window closes. The pricing information is saved for the room.

Full Day Price The dollar amount that is used in calculating the room price for a 

booking if the pricing unit is Half Day/Full Day (Event Time) or Half Day/

Full Day (Reservation Time).

Hours Multiplier used in calculating the room price for a booking if the pricing 

unit is Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation 

Time).

Field Description
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Exporting Pricing Information for a Room

You can export any pricing information that you configure for a room on a per rate schedule 
basis on the Edit Pricing window. The information is exported to a Microsoft Excel file. 

To export pricing information for a room

1. On the EMS menu bar, click Configuration > Facilities > Rooms.

The Rooms window opens.

Figure 3-49: Rooms window

2. On the Building dropdown list, select the building, area, or view that contains the rooms
that you are pricing.

You do not need Microsoft Excel on your EMS client to export the information to 
the file; however, you must have Microsoft Excel on your EMS client to view the 
file.

You can also export pricing information for a room at the time that you are 
configuring rate schedules. See “Exporting Pricing Information for Billable Items 
(Rooms or Resources)” on page 252.
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3. Click Pricing.

The Edit Pricing window opens.

Figure 3-50: Edit Pricing window

4. On the Rate Schedule dropdown list, select the rate schedule for which you are exporting
the room pricing information.

5. Do one of the following:

• Leave the Room Type set to the default value of (all), and then click Display to
display a list of all active rooms for all room types that have been configured in your
EMS database.

• On the Room Type dropdown list, select a specific room type, and then click Display
to display a list of all active rooms for the selected room type.

6. Click Export.

A Save As dialog box opens. The export file is named Pricing.xls by default.

7. Optionally, edit the name of the export file, and then save the file to a location of your
choice.

An Export Report message opens indicating that the export was successful and asks you
if you want to preview the exported file.

8. Do one of the following:

• Click Yes to open the export file in Microsoft Excel. After viewing the file, you can
close it to return to the Edit Pricing window.

• Click No to close the message and return to the Edit Pricing window.

9. Repeat Step 5 through Step 8 for each rate schedule and/or grouping for which you are
exporting the information.
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10. After you have exported all the necessary pricing information for a room, click Close.

The Edit Pricing window closes. The Rooms window remains opens.
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Configuring Public Views

A public view, or simply a view, is a grouping of specific rooms that you configure. You use 
views to organize rooms within one building or across multiple buildings in a manner that 
makes sense for your organization. For example, you might create a view that includes only 
the training rooms across all your locations, or you might create a view to manage heavily 
used conference rooms within a building. A room can be part of multiple views. A user can 
select a view for changing the information that is displayed in the Reservation Book or for 
searching for rooms in the Reservation Wizard. A view can also be particularly useful for 
running reports.

To configure public views

1. On the EMS menu bar, click Configuration > Facilities > Public Views.

The Public Views window opens. This window lists all the views that are currently
configured in your EMS database.

Figure 3-51: Public Views window
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2. Click New.

The View dialog box opens. The View tab is the active tab.

Figure 3-52: View dialog box, View tab

3. In the Description field, enter a name or description for the new view.

4. Optionally, do one or both of the following:

• In the Notes field, enter any other pertinent information about the view.

• If VEMS users are to have read-only access to the view, select Display on Web.

5. Open the Rooms tab.

Figure 3-53: View dialog box, Rooms tab

The description can be a maximum of 50 characters, including spaces.
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6. Enter any combination of the following search criteria:

• On the Building dropdown list, select one of the following—(all) buildings, a
specific building, a specific area, or a specific view.

• On the Room Type dropdown list, select a specific room type.

7. On the Available list, select the room, or CTRL-click to select the multiple rooms that
are to make up the view, and then click the Move button (>) to move the selected rooms
to the Selected list.

8. Optionally, click Spelling to spell check the view description before you save the view.

9. Click OK.

The View dialog box closes. You return to the Public Views window. The newly
configured view is displayed in the window.

If the appropriate building, area, or view is not available, you can configure it. 
See “Configuring Buildings” on page 91, “Configuring Areas” on page 99, or 
“Configuring Public Views” on page 144.

If the appropriate room type is not available, you can configure it. See 
“Configuring Room Types” on page 89.
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Configuring Floor Plans

The Floor Plan Configuration module is an optional, add-on module which allows users to 
view available rooms and book a space directly from a floor plan in VEMS or the EMS 
Kiosk. Configuring floor plans to use in the Floor Plan module is a three step process. First 
you must configure the floor plan indicators, which are the images that are used indicate 
whether a room is available or unavailable for a floor plan. For example, you might use 
something as simple as a green square to indicate that a room on a floor is available and a red 
square to indicate that a room on a floor is unavailable. Second, you must configure a floor 
plan diagram for each floor of each building for which a floor plan applies. A floor plan 
diagram is a drawing, or outline, usually to scale, that shows the relationships between 
rooms, spaces, and other physical features for one floor of a building. Third, you must use 
the Floor Plan Configuration utility to map your floor plan indicators to specific rooms on 
your floor plan diagram. The actual availability of each reservable space ultimately 
determines the indicator (available or unavailable) that is displayed on a floor plan in VEMS 
or EMS Kiosk.

To configure the floor plan indicators

1. On the EMS menu bar, click Configuration > Facilities > Floor Plan Indicators.

The Floor Plan Indicators window opens. This window lists all the indicator sets that are
currently configured in your EMS database and that have a status of Active.

Figure 3-54: Floor Plan Indicators window

Optionally, to view all indicator sets in your EMS database, regardless of status, 
under Show, click Inactive.
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2. Click New.

The Floor Plan Indicator dialog box opens.

Figure 3-55: Floor Plan Indicator dialog box

3. In the Description field, enter a name or description for the new floor plan indicators.

4. Next to the Image field, click the Search icon  to open the Find Image dialog box, 

and then browse to and select the image that is to be used for the available indicator. 

5. Next to the Secondary Image field, click the Search icon  to open the Find Image

dialog box, and then browse to and select the image that is to be used for the unavailable
indicator.

6. By default, the floor plan indicators are added as an active set. Optionally, select Inactive
to inactivate the set.

7. Click OK.

The Floor Plan Indicator dialog box closes. You return to the Floor Plan Indicators
window with the newly configured indicator set automatically selected.

8. Continue to “To configure a floor plan diagram” on page 149.

The description can be a maximum of 50 characters, including spaces. You can 
name indicators something as simply as Indicator Set 1, or if you are using 
different indicators for different floor plans in different buildings, you could 
identify them by building, for example, Memorial Student Union indicators, Fifth 
Floor Conference Room indicators, and so on. 

The image must be in one of the following formats—.gif, .jpeg, .jpg, .bmp, .wmf, or 
.png.
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To configure a floor plan diagram

You must configure one floor plan diagram for each floor that is to be available for booking 
in VEMS and the EMS Kiosk.

1. On the EMS menu bar, click Configuration > Facilities > Floor Plan Diagrams.

A blank Floor Plan Diagrams window opens.

Figure 3-56: Floor Plan Diagrams window

2. Optionally, in the Building dropdown list, select (all), or select a specific building to
display a list of floor plans for all buildings or for the selected building in the window.

3. Click New.

The Floor Plan Diagram dialog box opens. The Floor Plan Diagram tab is the active tab.

Figure 3-57: Floor Plan Diagram dialog box, Floor Plan Diagram tab
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4. In the Description field, enter a name or description for the new floor plan diagram.

5. On the Building dropdown list, select the building for which you are configuring the
floor plan diagram.

6. Next to the Image field, click the Search icon  to open the Find Image dialog box, 

and then browse to and select the image of the floor plan diagram. 

7. Open the Floor Plan Indicators tab, and on the Available list, select the floor plan
indicator, or CTRL-click to select the multiple floor plan indicators that are to be used
for this diagram, and then click the Move (>) button to move the selected indicators to
the Selected list.

8. Click OK.

The Floor Plan Diagram dialog box closes. You return to the Floor Plan Diagrams
window with the newly configured floor plan diagram automatically selected.

9. Continue to “To map a floor plan” below.

To map a floor plan

1. Log in to the Floor Plan Configuration module using your EMS username and password.

After you successfully log in to the Floor Plan Configuration module, the Configure 
Rooms option is displayed above the Login fields on the main window.

Figure 3-58: Floor Plan Configuration module, main window with Configure Rooms option

The description can be a maximum of 50 characters, including spaces.

The image must be in one of the following formats—.gif, .jpeg, .jpg, .bmp, .wmf, or 
.png. The optimal image size is 1024 x 768.

If needed, contact your EMS administrator for the correct URL.
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2. Click Configure Rooms.

The Configure Rooms page opens.

Figure 3-59: Floor Plan Configuration module, Configure Rooms page

3. On the Floor Plan dropdown list, select a floor plan diagram.

The available indicators that are associated with the floor plan diagram are displayed
below the selected diagram.

4. Drag an available indicator and place it as needed to indicate where a room (reservable
space) is located on the floor.

5. Repeat Step 4 until you have identified all the reservable spaces that are located on the
floor.

6. For each indicator, do the following:

• Click on the indicator to open a Room Details dialog box.

• On the Rooms dropdown list, select the room for the indicator, and then click Save.

7. Close the Floor Plan Configuration module.

To filter the list of available rooms, under Filter Options, select a specific floor 
and/or room type. An indicator is not saved to a floor plan diagram until you 
select a room for it. 
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Before you can use EMS to manage your organization’s events, you must configure core data 
items that are specific to your organization. For example, before you can add resources 
(equipment, catering information, and so on) to a booking, you must first configure the 
categories for these resources.

This chapter covers the following topics:

• “Configuring Categories” on page 155.

• “Configuring Departments” on page 161.

• “Configuring Statuses” on page 164.

• “Configuring Notification Rules” on page 167.

• “Configuring Group Notification Rules” on page 175.

• “Configuring No Show Notification Rules (EMS Workplace Only)” on page 182.

• “Configuring Room Card Formats” on page 187.

• “Configuring Calendar Formats” on page 189.

• “Configuring Reservation Wizard Templates” on page 192.
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Configuring Categories

Categories (also called booking details) are the activities, attendees, notes, services, and 
room charges that you can add to a booking. For example, your organization can create a 
category called A/V Equipment that contains resources such as flip charts, projectors, and so 
on. Although you can use categories to track setup notes, meeting attendees, and activities 
for a booking, you do not configure resources for these categories. You need to configure 
categories only for services. Configuring a category is a two step process. First, you must 
create the category. Second, after you create the category, you must define its resources.

To configure categories

1. On the EMS menu bar, click Configuration > Administration > Categories.

The Categories window opens. This window lists all the categories and their types that
are currently configured in your EMS database and that have a status of Active.

Figure 4-1:  Categories window

2. Click New.

The Category dialog box opens. The Category tab is the active tab. See Figure 4-2 on
page 156.

Optionally, to view all categories in your EMS database, regardless of status, 
under Show, click Inactive.
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Figure 4-2:  Category dialog box, Category tab

3. Enter the information for the new category.

Field Description

Category The name or description for the category, for example, A/V Equipment 

or Furniture.

Note: The category can be a maximum of 30 characters, including 

spaces.

Print Sequence If items from multiple categories have been reserved for an event, then 

the Print Sequence determines the order in which this information is 

printed on the confirmation. Categories are ordered from lowest to 

highest sequence number, with the category with the lowest sequence 

number being displayed first.

Note: If you leave the print sequence set to the default value of zero for 

all items, then by default, the items are displayed alphabetically. 
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Category Type Select a category type that is appropriate for the new category. 

Typically, the determining factor is how the category is to be used.

• Activities—Agenda-type entries that describe what is to occur during

an event, for example: 8:30 a.m. - 9:00 a.m., Registration; 9:00 a.m. -

10:00 a.m, Keynote Speaker, and so on.

• Attendees—Individuals who are attending an event. You can use this

category for attendees such as VIPs or guest speakers, or to serve

as an attendee checklist for smaller meetings.

• Notes—A free-form block of text that is used to enter clarifying or

miscellaneous information about the event. For example, your users

can use this booking detail to describe room setup for an event such

as “Set room temp. at 70 degrees one hour prior to event” or “Please

unlock doors at 7 a.m.”

• Resources, w/o Service Orders—Resources that are assigned to a

booking from a Resources, w/o Service Orders category are

assigned for the entire event time. Typically used to manage Audio/

Visual Equipment and Furniture categories.

• Resources, w Service Orders—Similar to Resources, w/o Service

Orders categories with one exception—you must indicate the specific

time that the items that are assigned to a booking from this category

are needed. The end result is one or multiple service orders with

specific services times before, during or after the event.

• Catering—Used to manage catering categories. Provides capability

similar to the Resources, w Service Order category in addition to the

catering specific fields of Estimated Count, Guaranteed Count, and

Actual Count.

Default Service Services are defined at the resource level. (See “Configuring Resources 

for a Category” on page 206.) After you define your resources and 

services, then you can edit this category if needed and define a default 

service. 

Default Time in Use Available only if Catering, Resources, w Service Orders, or Resources, 

w/o Service Orders is selected as the Category Type. Indicates the time 

that the items in the selected category should be in use—for the 

Reserved Time or for the Event Time.

Default Quantity Depending the category that was selected, one or more of the following 

options are available:

• 1

• Setup Count

• Estimated Count

Currency Select the currency that is to be used for pricing all the resources in the 

category.

Note: If the appropriate currency is not available, you can configure it. 

See “Configuring Currencies” on page 272.

Available to All 

Buildings

Select this option if resources from this category are to be available to 

all buildings.

Note: If you do not select this option, then on the Buildings tab, you 

must specify the buildings for which resources from this category 

are to be available.

Field Description
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4. Open the Virtual EMS tab and enter the appropriate VEMS information.

Allow Resources Notes 

Edit

If selected, EMS users can edit the Notes field for the resource.

Exclude from Services 

Indicator

In various EMS locations (the Reservation Book, the Navigator, the Edit 

Booking form, and so on) EMS provides an indication that services exist 

for a booking. Select this option to exclude a category from displaying 

as a service on the booking. 

Use Production Items Select this option to define production items for the category. 

Note: Production items are defined at the resource level. See 

“Configuring Resources for a Category” on page 206.

Use States Select this option if you want to define process phases, or states, for the 

category, for example, “Assigned,” “Out for Delivery,” “Delivered,” and 

so on. 

Note: After you define your states, then you can edit this category if 

needed and specify a default state.

BEO Column Indicates in which column the category is to be displayed when the 

Banquet Event Order report is printed in its standard two column format. 

Select Column 1 to display the category in the left column. Select 

Column 2 to display the category in the right column. See the EMS 
User’s Manual for details about the BEO report.

External Service Select this option if the provider of the resources for this category is 

external to your organization, and then select the provider on the 

Provider dropdown list. 

Note: Available only for a Category Type of Notes and if the EMS 

system parameter “Show External Service Orders on 

Categories” is set to “Yes.” See “EMS System Parameters” on 

page 492. 

Note: If the appropriate service provider is not available, contact 

support@emssoftware.com for assistance in configuring the provider.

Attendees are Visitors Select this option to automatically mark all attendees who are added to 

a booking as a Visitor. (The Visitor option is automatically selected on 

the Attendee dialog box.)

Field Description

Display on Web If selected, VEMS users can view this category if it has been added as a 

booking detail to one of their bookings.

Expand Groupings If selected, the resource items for a grouping are displayed immediately 

when a VEMS user makes a reservation. If cleared, only the grouping is 

displayed and a user must expand the grouping to view the resource 

items.

Use Specific Cutoff 

Time

Indicates how far in advance of a booking a VEMS user can add, edit, or 

cancel this category. For example, if you select the Cutoff Time/Number 

of Days option, and you specify 11:00 a.m. and one day, then VEMS 

users cannot assign, edit, or cancel categories or resources after 11:00 

a.m. on the day before the event.

Field Description

mailto:support@dea.com?subject=Customer Support Inquiry
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5. If you did not select Available to All Buildings then go to Step 6; otherwise, open the
Buildings tab, and on the Available list, select the building, or CTRL-click to select the
multiple buildings for which the category is to be available, and then click the Move
button (>) to move the selected buildings to the Selected list.

6. Optionally, do one or more of the following:

• Open the Calculations tab and on the Available list, select the calculation, or
CTRL-click to select the multiple calculations that are to always apply to this
category, and then click the Move button (>) to move the selected calculations to the
Selected list.

Cutoff Hours Available only if you do not select the Use Specific Cutoff Time option. 

With this option, the restriction is imposed based on the number of 

hours before the event occurs rather than time of day.

Default Quantity The default quantity (either 1, Attendance, or Blank) that is automatically 

filled in by the system when a VEMS user selects an item. 

Available at Checkout Select this option if this category is to be displayed on the “checkout” 

page (the last page in the Room Request process) in VEMS. 

Prompt for Billing 

Reference

Prompt for PO Number

Select this option if VEMS users are to be prompted to enter a billing 

reference and/or PO number when they select a resource from the 

category.

Allow Add On Weekend Select this option to allow a VEMS user to add a service order to a 

weekend booking. 

Sequence Determines the order in which the category is displayed in a list of 

categories in VEMS. Categories are ordered from lowest to highest 

sequence number, with the category with the lowest sequence number 

being displayed first.

Note: If you leave the sequence set to the default value of zero for all 

categories, then by default, the categories are displayed 

alphabetically. 

Minimum Amount The minimum purchase amount that is required for a user to submit a 

new service order in VEMS for this category.

Inactive Leave this option blank to add the category as an active category. 

Select this option to inactivate the category.

These calculations apply to all new resources that are added to the category. If the 
appropriate calculations are not available, you can configure them. See 
“Configuring Calculations” on page 258. You can also define calculations at the 
resource item level. See “Configuring Resources for a Category” on page 206.

Field Description
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• Open the Provider tab and enter the contact information for the provider of the items
or services in the category.

• Open the Terms and Conditions tab and format a Terms and Conditions message that
is displayed in VEMS when a VEMS user selects the category.

7. If you did not select Use States, go to Step 8; otherwise, open the States tab, and then do
the following:

• In the Description field, enter a name or description for each state or phase that is to
be used for managing this category.

• Optionally, to define a color for each state, select the state, and then click Set Color
to open the Select Color dialog box and select a color for the state.

8. Click OK.

The Category dialog box closes. You return to the Categories window with the newly
added category automatically selected. You can now define the resource items for the
categories. See “Configuring Resources for a Category” on page 206.

Select International to drop the State and Zip fields for an international provider. 
None of the provider information is displayed or printed anywhere outside of 
EMS.

Design is selected by default. Use the standard Windows plain text formatting 
options to format the message (spacing, number of lines, capitalization, and so on) 
so that it is displayed the way that you want; otherwise, you can select HTML and 
enter the necessary HTML code to format the message.

The description can be a maximum of 50 characters, including spaces.

 After you have defined the states for a category, you can select a default state on 
the Category tab. See “Use States” on page 158.
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Configuring Departments

A department is a specialized functional area within an organization or a division, such as 
accounting, marketing, conference services, event planning, catering services, and so on. All 
financial transactions in EMS are batched by department. Groups and customers make 
payments to one or more departments for the events that they schedule at your organization’s 
facilities. As the EMS administrator, you must configure the departments for your 
organization.

To configure departments

1. On the EMS menu bar, click Configuration > Administration > Departments.

The Departments window opens. The window displays all departments that are currently
configured in your EMS database and that have a status of Active.

Figure 4-3:  Departments window

2. Click New.

The Department dialog box opens. The Department tab is the active tab. See Figure 4-4
on page 162.

Optionally, to view all departments in your EMS database, regardless of status, 
under Show, click Inactive.
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Figure 4-4:  Department dialog box, Department tab

3. Enter the information for the new department.

Field Description

Department The name of the department.

Note: The department can be a maximum of 50 characters, including 

spaces.

Address

City

ST

Zip

The address for the department. 

Country The country for the department.

Phone

Fax

The phone and fax number for the department.

International Select this option to drop the State and Zip fields for an international 

department.

Note: The name, address, phone, and fax that you define here are printed at the top of 

confirmations and invoices. 

Email Address The email address for the department.

Notes Any descriptive or clarifying information that is pertinent for the 

department.

Invoice Prefix

Invoice Suffix

Not required for the first department that you configure. Required if 

multiple departments have been configured. This information clarifies 

which department generated an invoice. 

Next Invoice No. Required field. The value must be a number between 1 and 999999. 

The invoice number entered here is the number of the first invoice that is 

generated by a user in the department. This number is automatically 

incremented by one each time a user in the department generates an 

invoice.
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4. Optionally, do one or more of the following:

• Open the Logo tab and do the following:

• In the Description field, enter a name or description for the logo that is to be
printed on the confirmations and invoices generated by the department.

• Click Browse to browse to open the Find Logo dialog box, and then browse to
and select the logo.

• Open the Confirmation Header Fields tab, and on the Available list, select the field,
or CTRL-click to select the multiple fields that are to be included in the header of
every confirmation that is generated by the department.

• Open the Invoice Header Fields tab, and on the Available list, select the field, or
CTRL-click to select the multiple fields that are to be included in the header of every
invoice that is generated by the department.

• Click Spelling to spell check the information that you entered before you save it.

5. Click OK.

The Department dialog box closes. You return to the Departments window with the
newly configured department automatically selected.

Transaction Lock Days The number of days after a transaction is generated that it can still be 

modified. For example, if the field is set to 30, an invoice generated by 

this department can be voided only within 30 days of its creation. 

Inactive Leave this option blank to add the department as an active department. 

Select this option to inactivate the department.

The description can be a maximum of 50 characters, including spaces.

The logo must be one of the following file types—.gif, .jpg, .jpeg, .bmp, .wmf, and 
.png. By default, the logo is printed at the top left of confirmations and invoices. 
You can select Align Right to align the logo at the top right instead of the top left.

Field Description
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Configuring Statuses

A status indicates the likelihood that a booking will occur. You can apply a status to both 
bookings and reservations, but only booking-level statuses affects room availability. Every 
booking must have a status. Examples of statuses include “Confirmed,” “Tentative,” “Wait 
List,” and “Canceled.” A status is one of four core data items that you must configure so that 
your users can make reservations. You can configure as many statuses as you need and give 
them any names you want; however, you must always assign one of the four following status 
types to a status:

• Book Space

• Wait

• Info Only

• Cancel

The name that you assign to a status is just a convenient label that assists you in managing 
your organization’s business. The status type is what is actually used by EMS to determine if 
a room must be taken out of inventory. 

To configure statuses

1. On the EMS menu bar, click Configuration > Administration > Statuses.

The Statuses window opens. This window lists all the statuses that are currently
configured in your EMS database and that have a status of Active.

Figure 4-5:  Statuses window

Optionally, to view all statuses in your EMS database, regardless of status, under 
Show, click Inactive.
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2. Click New.

The Status dialog box opens.

Figure 4-6:  Status dialog box

3. Enter the information for the new status.

Field Description

Status The name of the status.

Note: The status can be a maximum of 30 characters, including 

spaces.

Status Type Required. You must select one of the following four values:

• Book Space—The room is taken out of inventory and cannot be

reserved by another booking. (The system prevents the space from

being double-booked.)

• Cancel—Booking information is retained, but the room is released

back into inventory.

• Info Only—Booking information is retained, but the space is not taken

out of inventory.

• Wait—Booking information is retained in case the space becomes

available prior to the event date. Wait bookings show up on the Wait

List Report and in the Dashboard.

Note: If you are configuring a conflict status, then it must Status Type 

Info Only or Wait.

Reserved Color The color that is used by this status in the Reservation Book to indicate 

reserved time. When the reserved time extends before or after event 

time, thin bars of this color extend out from the beginning and/or end of 

the event. To use the system default colors, click Default.
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4. Click OK.

The Status dialog box closes. You return to the Statuses window with the newly
configured status automatically selected.

Event Color The color for events of this status in the Navigator and Reservation 

Book. To use the system default colors, click Default. 

Note: Lighter colors are the better colors to use for events because 

they make it easier to read the event name in the Reservation 

Book, which is in black text.

Reconfirm Date Select this option if you want the system to require a reconfirm date 

when a reservation is made in EMS. When a user gives a booking a 

status that requires a reconfirm date, the system displays an additional 

field, prompting the user to enter the date. You can identify bookings 

with a reconfirm date in the Dashboard.

Commits Inventory Select this option if the status should remove resources from inventory.

Note: Typically, you would select this option for a status with a Book 

Space type whereas you would not select this option for a status 

with a Cancel type. 

Inactive Leave this option blank to add the status as an active status. Select this 

option to inactivate the status.

Virtual EMS Settings

Display on Web Select this option to display the event details for bookings with this 

status in VEMS.

Allow Booking Edit Select this option to allow the editing of bookings with this status in 

VEMS.

Allow Service Edit Select this option to allow the editing of services for bookings with this 

status in VEMS.

Allow Booking 

Cancellation

Select this option to allow the canceling of bookings with this status in 

VEMS.

Field Description
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Configuring Notification Rules

Notification rules determine which EMS users are notified via email when certain additions 
or modifications are made in the EMS database. You can configure notification rules for the 
creation or modification of a booking or service order, a modification to a VIP event, the 
creation of new web user account, or the selection of a specific value for a UDF. These rules 
are based on rooms, statuses, event types, group types, and/or categories. For a notification 
to be generated, all the criteria that you specified must be met. Typically, notifications are an 
internal function for reservationists and service providers, but when you are configuring a 
notification rule, you can specify the email address for whomever you think is appropriate to 
receive an email notification. (Users do not receive notifications of their own actions. They 
receive notifications only for actions carried out by other users.) The determination of the 
time frame during which a notification should be generated is affected by three Notification 
system parameters—Exclude Building Closures on Notifications, Exclude Weekends on 
Notifications, and Ignore Building Closure/Weekend Notification Settings Beyond xx Days. 
(See Appendix A, “System Parameters,” on page 491.)

To configure notification rules

1. On the EMS menu bar, click Configuration > Administration > Notification Rules.

The Rules window opens. This window lists all the notification rules that are currently
configured in your EMS database and that have a status of Active.

Figure 4-7:  Rules window

For email notifications to be sent, the EMS Email Notification Service must be 
installed and configured. Refer to the EMS Installation instructions for details.

Optionally, to view all notification rules in your EMS database, regardless of 
status, under Show, click Inactive.
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2. Click New.

The Notification Rule Wizard opens.

Figure 4-8:  Notification Rule Wizard

3. In the Description field, enter a name or description for the new notification.

4. Leave Inactive blank to add the notification rule as an active rule. Optionally, select
Inactive to inactivate the notification rule.

5. Select the notification type.

The type that you select determines the options that are available. See the table on the
next page.

The remainder of this procedure describes how to configure an email notification 
rule “from scratch.” You can also configure an email notification rule by copying 
an existing rule. Select the notification rule that you want to copy, click Copy, and 
then go to Step 3.

The description can be a maximum of 50 characters, including spaces.
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Notification Type Description

Bookings • Indicate if the notification must be generated for one or more or all the

following—New Bookings, Changes to Date/Time (for an existing

booking), Room Changes (for an existing booking), and/or Status

Changes (for existing bookings).

• In the Days Prior to Booking Date field, enter a value for the

timeframe during which a booking action (a new or modified booking)

results in a notification being generated.

• For Display New Booking As, indicate whether the notification is to be

displayed in the form of Booking Information or Reservation

Information. For example, for new reservations that contain multiple

bookings (recurring meetings), if Booking Information is selected,

then a notification is displayed for every individual booking. If

Reservation Information is selected, then a single notification is

displayed for the entire reservation.

• For Source, indicate whether additions and/or modifications from the

EMS Client, VEMS, or both are to trigger a notification.

Service Orders • On the Category dropdown list, select the category for which the

service order notification is to be generated.

Note: It the appropriate category is not available, you can configure it. 

See “Configuring Categories” on page 155.

• Indicate if the notification must be generated for one or more or all the

following—New Service Orders, Changes to Service Orders, and/or

Deletion/Cancellation of Service Orders.

• In the Days Prior to Booking Date field, enter a value for the

timeframe during which a booking action (a new or modified service

order for the booking) results in a notification being generated.

• For Source, indicate whether additions and/or modifications from the

EMS Client, VEMS, or both are to trigger a notification.

Note: The Bookings options that are displayed in this table are applicable only for EMS Enterprise. 

In EMS Professional, only one global Booking notification can be configured at any time in 

your EMS database and the option is available only if a Booking notification is not currently 

configured in your EMS database. Also, the Service Order options that are displayed are 

applicable only for EMS Enterprise. In EMS Professional, only one service order notification 

per category can be configured at any time in your EMS database.

Anything on a VIP Event No additional settings are required for this type of notification.

New Web Users Select this option to trigger a notification from EMS and/or VEMS when 

a new web user account is created.
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6. If you selected New Web Users, then go to Step 7; otherwise, optionally, open the Email
tab at the bottom of the wizard, and do the following:

• In the Email From field, enter the Email From address for the notification and/or a
subject line for the notification.

• Select the format for the email—HTML (the default value), or Plain Text.

User Defined Field • On the Type dropdown list, select the UDF type for which the

notification is to be generated—Booking, Group/Reservation,

Reservation, or Service Order.

Note: If the appropriate UDF is not available, you can configure it. See 

“Configuring User Defined Fields (UDFs)” on page 67.

• Select the specific UDF for which the notification is to be generated.

(The available UDFs have a field type of List. UDFs with other field

types are not displayed on the User Defined Field dropdown list.)

• Select the UDF value for which the notification is to be generated.

• In the Days Prior to Booking Date field, enter a value for the

timeframe during which a booking action (the indicated value is

selected for the UDF that is associated with the booking) results in a

notification being generated.

If you leave the Email From field blank, then the Email From address that was 
defined during the installation and configuration of the EMS Email Notification 
Service is used. If you selected New Web User as the notification type, then the 
Email From Field is automatically populated with EMS Client, and/or Virtual 
EMS depending on the sources that you selected. 

Variables pull in selected data from the event for which the notification is being 
emailed. You can include variables in the subject line as described in the Legend. 
For example,%2% is the code for the group name, so “Notification for %2%” 
would result in “Notification for Academic Affairs” being displayed in the subject 
line. By default, email notifications for booking-level notifications also display the 
actual booking date in the subject line of the email. 

From this point forward, the Summary tab displays the notification rule as you 
continue to configure it. You can open the Summary tab at any time to view the 
notification rule as you are configuring it.

Notification Type Description
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7. Click Next.

The Users/Email Notifications window opens.

Figure 4-9:  Notification Rule Wizard, Users/Email Notifications window

8. Do one or more of the following:

• On the Available list, select the EMS user, or CTRL-click to select the multiple users
who are to receive the email notification, and then click the Move button (>) to move
the selected users to the Selected list.

• In the Email Address field, for each user and/or group that is to receive the email
notification, enter the appropriate email address, and then click Add.

• Leave the Email Address field blank, and then click Add to open the Select Names
dialog box in which you can search for and add the necessary email addresses from
your Groups/Contacts lists, your Global Address List, or your Outlook address book.

If the appropriate user is not available, you can configure it. See “Configuring 
User Accounts” on page 329.

To search for all addresses, leave the Search field blank, and then click Display. To 
search for a specific address, enter a search string. The string is not 
case-sensitive, but your search is limited to the exact order of the characters in the 
string and it must begin with the information for which you are searching. For 
example, a search string of Campus returns Campus Recreation, but not North 
Campus.
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9. If you selected New Web Users, then go to Step 16; otherwise, click Next.

The Rooms window opens.

Figure 4-10: Notification Rule Wizard, Rooms window

10. To search for the rooms for which the notification is to apply, do the following:

• On the Building dropdown list, select one of the following—(all) buildings, a
specific building, a specific area, or a specific view.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

• Optionally, to search for both active and inactive rooms, select Show Inactive.

If the correct group and/or contact is not available, you can configure it. See 
“Configuring Groups” on page 277 and “Configuring Contacts” on page 295.

If the appropriate building, area, or view is not available, you can configure it. 
See “Configuring Buildings” on page 91, “Configuring Areas” on page 99, and/
or “Configuring Public Views” on page 144.

If the appropriate room type is not available, you can configure it. See 
“Configuring Room Types” on page 89.
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11. On the Available list, select the room, or CTRL-click to select the multiple rooms, and
then click the Move button (>) to move the selected rooms to the Selected list.

12. Click Next.

The Statuses window opens.

Figure 4-11: Notification Rule Wizard, Statuses window

13. On the Available list, select the booking status, or CTRL-click to select the multiple
statuses for which the notification is to apply, and then click the Move button (>) to
move the selected statuses to the Selected list.

If the appropriate room is not available, you can configure it. See “Configuring 
Room Types” on page 89.

If the appropriate status is not available, you can configure it. See “Configuring 
Statuses” on page 164.



174

 
Core Configuration - Administration

14. Click Next.

The Event Types window opens.

Figure 4-12: Notification Rule Wizard, Event Types window

15. On the Available list, select the event type, or CTRL-click to select the multiple event
types for which the notification is to apply, and then click the Move button (>) to move
the selected event types to the Selected list.

16. Click Finish.

The Notification Rule Wizard closes. You return to the Rules window with the newly
configured notification rule automatically selected.

If the appropriate event type is not available, you can configure it. See 
“Configuring Event Types” on page 43.
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Configuring Group Notification Rules

Group notification rules determine the conditions under which groups that are holding events 
at your facility are reminded through an email notification about their events. You configure 
group notifications based on rooms, statuses, event types, group types, and/or categories. A 
group notification is generated only if all the criteria that you specified is met. For example, 
if you specify Room 100, Confirmed status with catering, then a Confirmed meeting in 
Room 100 without a catering service order does not result in a notification being generated. 
Group notification emails contain a summary of the group's events. For example, if a group 
has a weekly Friday meeting (a booking) that continues for several months, and you define a 
group notification rule with a monthly frequency, then the group receives a notification email 
once a month that lists all the Friday meetings for the month. 

To configure a group notification

1. On the EMS menu bar, click Configuration > Administration > Group Notification
Rules.

The Group Notification Rules window opens. This window lists all the group
notification rules that are currently configured in your EMS database and that have a
status of Active.

Figure 4-13: Group Notification Rules window

You can configure multiple group notifications in EMS Enterprise. You can 
configure only a single group notification in EMS Professional. For notification 
emails to be sent, the EMS Email Notification Service must be installed and 
configured. Refer to the EMS Installation instructions for details.

Optionally, to view all group email notification rules in your EMS database, 
regardless of status, under Show, click Inactive.
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2. Click New.

The Group Notification Rule dialog box opens. The Group Notification Rule tab is the
active tab.

Figure 4-14: Group Notification Rule dialog box, Group Notification Rule tab

3. Enter the information for the new group notification rule.

The remainder of this procedure describes how to configure a group email 
notification rule “from scratch.” You can also configure a group email 
notification rule by copying an existing rule. Select the notification rule that you 
want to copy, click Copy, and then go to Step 3.

Option Description

Description The name or description for the group notification rule.

Note: The description can be a maximum of 50 characters, including 

spaces.

Header Message

Footer Message

Select a header and/or footer message that is to be displayed on every 

notification that is sent to the group.

Note: If the appropriate message is not available, you can configure it. See 

“Configuring Messages” on page 55.

Email Format Select the format (HTML or Plain Text) for the email.
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Frequency Select the frequency with which the notification is to be sent.

• Daily—You must indicate how many days prior to/after the Booking Date/

Last Booking Date that the notification is to be sent.

• Weekly—You must select the day on which the notification is to be sent

and for which bookings. (For example, every Friday for bookings that

start on the following Monday).

• Monthly—You must indicate how many days prior to the end of the month

that the notification is to be sent.

Multiple Bookings 

Only

Available only in EMS Workplace. Select this option to notify users if they 

have multiple bookings on a particular day.

Send Confirmation Select this option to attach a full detailed confirmation to the group email; 

otherwise, leave this option blank to have the group email contain only a 

simple listing of bookings. 

Note: The contents of the full confirmation email are determined by the 

confirmation settings that you specify. See “To specify the 

confirmation settings for a group notification email” on page 180.

Email Notification At/

Time Zone

Select the time of day (based on the time zone) at which the email 

notification is to be sent.

Include Cancel Link Available only if Send Confirmation is not selected. Provides a link in the 

notification email so that a user can cancel the booking directly from the 

notification email.

Include Reconfirm 

Link/Reconfirm 

Status

Available only if Send Confirmation is not selected. Provides a link in the 

notification email so that a user can reconfirm the booking directly from the 

notification email. If you select this option, then you must also select a 

Reconfirm Status that is to be applied to the booking. 

Note: If the appropriate status is not available, you can configure it. See 

“Configuring Statuses” on page 164.

Email Group

Email 1st Contact

Email 2nd Contact

Email Web User

Select the appropriate options to indicate to whom the group notification is 

to be sent.

Note: If the appropriate group, contact, and/or web user is not available, 

you can configure it. See “Configuring Groups” on page 277, 

“Configuring Contacts” on page 295, and/or “Configuring Web 

Users” on page 419.

Email From Enter the email address that is to be displayed in the Email From field for 

the group notification. 

Note: If you leave the Email From field blank, then the Email From address 

that was defined during the installation and configuration of the EMS 

Email Notification Service is used. 

Email Subject Line Enter the text that is to be displayed in the email subject line. Variables pull 

in selected data from the event for which the notification is being emailed. 

You can include variables as described in the Legend. For example,%2% is 

the code for the group name, so “Notification for %2%” would result in 

“Notification for Consumer Electronics Association” being displayed in the 

subject line. By default, email notifications for booking-level notifications 

also display the actual booking date (and not just the first booking date of 

the reservation) in the subject line of the email.

Option Description
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4. Do one or more or all the following to set the criteria that triggers the generation of the
notification:

• Open the Rooms tab and do the following to search for the rooms for which the
notification is to apply:

• On the Building dropdown list, select one of the following—(all) buildings, a
specific building, a specific area, or a specific view.

• On the Room Type dropdown list, leave the default value of (all), or select a
specific room type.

• On the Available list, select the room, or CTRL-click to select multiple rooms,
and then click the Move button (>) to move the selected rooms to the Selected
list.

• Open the Statuses tab, and on the Available list, select the status, or CTRL-click to
select the multiple statuses, and then click the Move button (>) to move the selected
statuses to the Selected list.

• Open the Event Types tab, and on the Available list, select the event type, or
CTRL-click to select multiple event types, and then click the Move button (>) to
move the selected event types to the Selected list.

Inactive Leave this option blank to add a group email notification rule as an active 

rule. Select this option to Inactivate the group notification rule.

If the appropriate building, area, or view is not available, you can configure it. 
See “Configuring Buildings” on page 91, “Configuring Areas” on page 99, or 
“Configuring Public Views” on page 144.

If the appropriate room type is not available, you can configure it. See 
“Configuring Room Types” on page 89.

If the appropriate room is not available, you can configure it. See “Configuring 
Rooms” on page 109.

If the appropriate status is not available, you can configure it. See “Configuring 
Statuses” on page 164.

If the appropriate event type is not available, you can configure it. See 
“Configuring Event Types” on page 43.

Option Description
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• Open the Group Types tab, and on the Available list, select the group type, or
CTRL-click to select multiple group types, and then click the Move button (>) to
move the selected group types to the Selected list.

• Open the Categories tab, and on the Available list, select the category, or
CTRL-click to select multiple categories, and then click the Move button (>) to
move the selected categories to the Selected list.

5. Click OK.

The Group Notification Rule dialog box closes. You return to the Group Notification
Rules window with the newly configured notification rule automatically selected.

6. If you selected Send Confirmation for the notification rule, then continue to “To specify
the confirmation settings for a group notification email” on page 180.

If the appropriate group type is not available, you can configure it. See 
“Configuring Group Types” on page 47.

If the appropriate category is not available, you can configure it. See 
“Configuring Categories” on page 155.
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To specify the confirmation settings for a group notification email

1. If you have not already done so, on the EMS menu bar, click Configuration >
Administration > Group Notification Rules to open the Group Notification Rules
window.

2. Select the rule for which you are specifying the confirmation settings, and then click
Confirmation.

The Confirmation Settings dialog box opens. The Date Range tab is the active tab.

Figure 4-15: Confirmation Settings dialog box

3. Specify the settings for the confirmation.

At a minimum, you must specify buildings and statuses. All other information is 
optional.

Field Description

Date Range tab—The department name that appears at the top of a printed confirmation.

Buildings tab—Select the specific buildings, areas, and/or views that are to be included in the 

confirmation. 

Note: If the appropriate building, area, and/or views is not available, you can configure it. See 

“Configuring Buildings” on page 91, “Configuring Areas” on page 99, and/or “Configuring 

Public Views” on page 144.
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4. Click OK.

The Confirmation Settings dialog box closes. You return to the Group Notification Rules
window with the notification rule still selected.

Categories tab—Select the specific booking details that are to be included in the confirmation.

Note: If the appropriate category is not available, you can configure it. See “Configuring 

Categories” on page 155.

Statuses tab—Select the specific statuses that are to be included in the confirmation. 

Note: If the appropriate status is not available, you can configure it. See “Configuring Statuses” on 

page 164.

Options tab—Format settings for a printed confirmation.

Confirmation Title Appears bold and centered at the top of the confirmation.

Header Message

Footer Message

Pre-configured blocks of text that appear in the header and footer of the 

confirmation. 

Note: If the appropriate message is not available, you can configure it. 

See “Configuring Messages” on page 55.

Paper Size The size of the paper on which the confirmation is printed. Values are 

Letter, Legal, and A4.

Print Comments Include the reservation’s comments in the printed confirmation.

Print Reminders Include the reservation’s reminders in the printed confirmation.

Print Cancel Reasons Include reasons for cancellation in the printed confirmation.

Print User Defined 

Fields

Include user defined fields and their values in the printed confirmation. 

Suppress Reserved 

Time

Hide the reserved time for the booking and show only the event time.

Suppress Location Hide the location for the reservation. 

Suppress Pricing Do not show the reservation’s room charges or resource charges in the 

printed confirmation.

Suppress Logo Do not show your organization’s logo in the printed confirmation.

Suppress Item Notes Do not show resource notes for any booking items in the printed 

confirmation.

Suppress Item Special 

Instructions

Do not show special instructions for any booking items in the printed 

confirmation.

Limit Bookings to Those 

With Details in Selected 

Categories

Show only those bookings in the printed confirmation that contain details 

for the categories that are selected on the Categories tab.

Web Options

Display Web Link Select this option to include a link (URL) to the reservation in VEMS.

Web Link Message The message that is to be included with the link.

Field Description
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Configuring No Show Notification Rules (EMS 

Workplace Only)

You can manually manage your No Show process using the Check-in Status tool, or you can 
automate the process by configuring No Show Notification Rules. You configure No Show 
Notification rules based on rooms, statuses, event types, and/or group types. When you 
configure a No Show Notification rule, you can configure it so that not only are the bookings 
for a group automatically canceled or “no-showed,” but also, so that an email is 
automatically generated and sent to the group indicating that their bookings have been 
“no-showed.” For group bookings to be no-showed and/or an email generated and sent to the 
group, all the criteria you specified must be met. For example, if you specify Room 100, 
Confirmed status, Analyst group type, then a Confirmed meeting for a Partner group type in 
Room 100 does not result in a notification being generated.

To configure No Show notification rules

1. On the EMS menu bar, click Configuration > Administration > No Show Notification
Rules.

The No Show Notification Rules window opens. This window lists all the No Show
notification rules that are currently configured in your EMS database and that have a
status of Active.

Figure 4-16: No Show Notification Rules window

For notification emails to be sent, the EMS Email Notification Service must be 
installed and configured. Refer to the EMS Installation instructions for details.

Optionally, to view all No Show notification rules in your EMS database, 
regardless of status, under Show, click Inactive.
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2. Click New.

The No Show Notification Rule dialog box opens. The No Show Notification Rule tab is
the active tab.

Figure 4-17: No Show Notification Rule dialog box, No Show Notification Rule tab

3. Enter the information for the new No Show Notification rule.

The remainder of this procedure describes how to configure a No Show 
notification rule “from scratch.” You can also configure a No Show notification 
rule by copying an existing rule. Select the notification rule that you want to copy, 
click Copy, and then go to Step 3.

Option Description

Description The name or the description for the notification rule.

Note: The description can be a maximum of 50 characters, including 

spaces.

Header Message

Footer Message

Select a header and/or footer message that is to be displayed on every 

No Show notification that is sent to the group.

Note: If the appropriate message is not available, you can configure it. 

See “Configuring Messages” on page 55.

Email Format Select the format (HTML or Plain Text) of the email notification that is to 

be sent to the group.

Email No Show Select this option to email the group members who are to be 

“no-showed.”
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Change Status Select this option if the group’s bookings are to be changed to the status 

selected on the No Show Status dropdown list.

Note: If the appropriate status is not available, you can configure it. 

See “Configuring Statuses” on page 164.

No Show Status The status to which the group’s bookings are changed if the group 

“no-shows.”

Cancel Reason Available only if the No Show Status is a Cancel Status type. Select a 

reason for cancelling the “no-show” group.

Note: If the appropriate cancel reason is not available, you can 

configure it. See “Configuring Cancel Reasons” on page 72.

Grace Period Specify the number of minutes that a group can be late for their booking 

before any action is taken. For instance, if the Grace Period is set to 30 

minutes and the Process Rule At is set to 9:30 AM, only groups that 

have not checked into bookings with a reserved start time of 9:00 AM or 

earlier receive an email and/or are no-showed.

Process Rules At

Time Zone

Indicate the time of day and the time zone which determine when the No 

Show rules are processed.

Include Cancel Link Available only if Change Status is not selected. Provides a link in the 

notification email so that a user can cancel the booking directly from the 

notification email. 

Include Reconfirm Link/

Reconfirm Status

Available only if Change Status is not selected. Provides a link in the 

notification email so that a user can reconfirm the booking directly from 

the notification email. Optionally, if you select this option, you can also 

select a Reconfirm Status that is to be applied to the booking. 

Note: If the appropriate status is not available, you can configure it. 

See “Configuring Statuses” on page 164.

Email Group

Email 1st Contact

Email 2nd Contact

Email Web User

Select the appropriate options to indicate to whom the group notification 

is to be sent.

Note: If the appropriate group, contact, and/or web user is not 

available, you can configure it. See “Configuring Groups” on 

page 277, “Configuring Contacts” on page 295, and/or 

“Configuring Web Users” on page 419.

Email From Enter the email address that is to be displayed in the Email From field 

for the group notification. 

Note: If you leave the Email From field blank, then the Email From 

address that was defined during the installation and 

configuration of the EMS Email Notification Service is used. 

Email Subject Line Enter the text that is to be displayed in the email subject line. Variables 

pull in selected data from the event for which the notification is being 

emailed. You can include variables as described in the Legend. For 

example,%2% is the code for the group name, so “Notification for %2%” 

would result in “Notification for Consumer Electronics Association” being 

displayed in the subject line.

Option Description
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4. Do one or more or all the following to set the criteria that triggers the generation of the
notification:

• Open the Rooms tab and do the following to search for the rooms for which the
notification is to apply:

• On the Building dropdown list, select one of the following—(all) buildings, a
specific building, a specific area, or a specific view.

• On the Room Type dropdown list, leave the default value of (all), or select a
specific room type.

• On the Available list, select the room, or CTRL-click to select multiple rooms,
and then click the Move button (>) to move the selected rooms to the Selected
list.

• Open the Statuses tab, and on the Available list, select the status, or CTRL-click to
select the multiple statuses, and then click the Move button (>) to move the selected
statuses to the Selected list.

• Open the Event Types tab, and on the Available list, select the event type, or
CTRL-click to select the multiple event types, and then click the Move button (>) to
move the selected event types to the Selected list.

• Open the Group Types tab, and on the Available list, select the group type, or
CTRL-click to select multiple group types, and then click the Move button (>) to
move the selected group types to the Selected list.

If the appropriate building, area, or view is not available, you can configure it. 
See “Configuring Buildings” on page 91, “Configuring Areas” on page 99, and/
or “Configuring Public Views” on page 144.

If the appropriate room type is not available, you can configure it. See 
“Configuring Room Types” on page 89.

If the appropriate room is not available, you can configure it. See “Configuring 
Rooms” on page 109.

If the appropriate status is not available, you can configure it. See “Configuring 
Statuses” on page 164.

If the appropriate event type is not available, you can configure it. See 
“Configuring Event Types” on page 43.

If the appropriate group type is not available, you can configure it. See 
“Configuring Group Types” on page 47.
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5. Click OK.

The No Show Notification Rule dialog box closes. You return to the No Show
Notification Rules window with the newly configured notification rule automatically
selected.
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Configuring Room Card Formats

A room card format is a user-configured layout that can be selected in lieu of the default By 
Date formats (By Date or By Date (Landscape)) when printing the Room Cards report. 

To configure room card formats

1. On the EMS menu bar, click Configuration > Administration > Room Card Formats.

The Room Card Formats window opens. This window lists all the Room Card formats
that are currently configured in your EMS database. The two default By Date formats are
displayed as a single entry (By Date Formats (Standard)).

Figure 4-18: Room Card Formats window

2. Click New.

The Room Card Format dialog box opens.

Figure 4-19: Room Card Format dialog box
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3. Enter the information for the new room card format.

4. Click OK.

The Room Card Format dialog box closes. You return to the Room Card Formats
window with the newly configured room card format automatically selected.

Field Description

Description The name or description for the room card format.

Note: The description can be a maximum of 30 characters, including 

spaces.

Print Landscape Select this option if the Room Card report is to be printed in a landscape 

orientation; otherwise, the report is printed in a portrait orientation.

Header • Top Margin (inches)—Specify a top margin for the report in inches.

• Show Room—If the name of the event room is to be printed on the

report, select this option, and then on the Font dropdown list, select

the font in which the name is to be printed.

• Show Date—If the date of the event is to be printed on the report,

select this option, and then on the Font dropdown list, select the font

in which the date is to be printed.

Fields • Top Margin (inches)—Specify the top margin in inches between the

room and/or date field and the first field in the report.

• First Field/Second Field/Third Field—Specify the fields that are to be

displayed on the report as well as the font in which the fields are to be

displayed.
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Configuring Calendar Formats

You can configure calendar formats, which determine the data items that are printed for an 
event on the Event Calendar report, for example, Group, Event Time, and Event Location.

To configure calendar formats

1. On the EMS menu bar, click Configuration > Administration > Calendar Formats.

The Calendar Formats window opens. This window lists all the calendar formats that are
currently configured in your EMS database.

Figure 4-20: Calendar Formats window

2. Click New.

The Calendar Format dialog box opens. The Calendar Format tab is the active tab.

Figure 4-21: Calendar Format dialog box, Calendar Format tab
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3. In the Description field, enter a name or description for the new calendar format.

4. Optionally, to filter events so that the information for only those events that meet one or
more filter criteria are printed on the Event Calendar report, select Set Filter to open four
additional tabs—Building, Statuses, Event Types, and Group Types—and then do the
following:

Figure 4-22: Calendar Format dialog box with Set Filter selected

• Open the Buildings tab, and on the Available list, select the building, area or view, or
CTRL-click to select multiple buildings, areas, and/or views, and then click the
Move button (>) to move the selected statuses to the Selected list.

• Open the Statuses tab, and on the Available list, select the status, or CTRL-click to
select multiple statuses, and then click the Move button (>) to move the selected
statuses to the Selected list.

The description can be a maximum of 30 characters, including spaces.

If the appropriate building, area, and/or view is not available, you can configure 
it. See “Configuring Buildings” on page 91, “Configuring Areas” on page 99, 
and/or “Configuring Public Views” on page 144.

If the appropriate status is not available, you can configure it. See “Configuring 
Statuses” on page 164.
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• Open the Event Types tab, and on the Available list, select the event type, or
CTRL-click to select multiple event types, and then click the Move button (>) to
move the selected event types to the Selected list.

• Open the Group Types tab, and on the Available list, select the group type, or
CTRL-click to select multiple group types, and then click the Move button (>) to
move the selected group types to the Selected list.

5. Open the Fields tab, and on the Available list, select the field, or CTRL-click to select the
multiple fields that are to make up the calendar format, and then click the Move button
(>) to move the selected fields to the Selected list.

6. Click OK.

The Calendar Format dialog box closes. You return to the Calendar Formats window,
with the newly configured calendar format automatically selected.

If the appropriate event type is not available, you can configure it. See 
“Configuring Event Types” on page 43.

If the appropriate group type is not available, you can configure it. See 
“Configuring Group Types” on page 47.

The information is printed in the order in which the fields are listed from top to 
bottom in the Selected list. If needed, select a field and change its order by clicking 
Move Up or Move Down.
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Configuring Reservation Wizard Templates

You configure reservation wizard templates to simplify the reservation making process for 
your users. A reservation wizard template sets the default values for many of the fields in the 
Reservation Wizard. For example, you could configure a video conference reservation 
wizard template such that the default values for status, room type, event name, and event 
type are all set to “Video Conference.”

To configure a reservation wizard template

1. On the EMS Workplace menu bar, click Configuration > Administration > Reservation
Wizard Templates.

The Reservation Wizard Templates window opens. This window lists all the reservation
wizard templates that are currently configured in your EMS database and that have a
status of Active.

Figure 4-23: Reservation Wizard Templates window

Your users can always override any default values that are set in the Reservation 
Wizard when they use a reservation wizard template.

Optionally, to view all reservation wizard templates in your EMS database, 
regardless of status, under Show, click Inactive.
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2. Click New.

The Reservation Wizard Template dialog box opens. The Reservation Wizard Template
tab is the active tab.

Figure 4-24: Reservation Wizard Template dialog box, Reservation Wizard tab

3. Enter the summary information for the new reservation wizard template.

The only required information is the template description. All other information 
on all tabs is optional and can be added at a later date when needed.

Field Description

Description Required field. The name or description of the reservation wizard template.

Note: The description can be a maximum of 50 characters, including 

spaces.

Prompt for Date

Number of Days to 

Select

Select this option if a reservationist/user is to be prompted with a start date 

for the reservation in the Reservation Wizard, and then in the Number of 

Days to Select field, enter the number of days that are to be automatically 

selected in the Reservation Wizard after the reservationist/user enters a start 

date for the event.

Video Conference Select this option to apply the Video Conference option as a default field on 

the last page of the Reservation Wizard when this template is used.

Note: This option is not available in EMS Professional. 
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4. Optionally, continue to one or more or all of the following; otherwise, go to Step 5.

• “To set the default event values for a reservation wizard template” below.

• “To select the default room features for a reservation wizard template” on page 195.

• “To select the default user defined fields for a reservation wizard template” on page
196.

5. Click OK to close the Reservation Wizard Template dialog box and return to the
Reservation Wizard Templates window with the newly configured template
automatically selected.

To set the default event values for a reservation wizard template

1. If needed, open the Reservation Wizard Template dialog box for the reservation wizard
template that you are configuring. (See “To configure a reservation wizard template” on
page 192.)

2. Open the Defaults tab, and do the following for each reservation variable for which you
want to specify a default value:

• Select the variable, and then click edit to open a Set Default Value dialog box.

• Enter the default value for the variable, and then click OK to close the Set Default
Value dialog box and return to the Defaults tab.

Figure 4-25: Reservation Wizard Template dialog box, Defaults tab

3. Continue with any other optional configuration for the template as needed; otherwise,
click OK to close the Reservation Wizard Template dialog box and return to the
Reservation Wizard Templates window with the newly configured template
automatically selected.

For information about creating a reservation using a reservation wizard template, 
see the EMS User’s Manual.
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To select the default room features for a reservation wizard 

template

A feature is built-in or permanent attribute of a room, such as a network connection, a 
built-in plasma TV, window, and so on. You can configure a reservation wizard template so 
that the initial list of rooms that are available to a user who is making a reservation using the 
template is limited to only those rooms with these default features.

1. If needed, open the Reservation Wizard Template dialog box for the reservation wizard
template that you are configuring. (See “To configure a reservation wizard template” on
page 192.)

2. Open the Features tab, and on the Available list, select the feature, or CTRL-click to
select the multiple features that the rooms are to have, and then click the Move button
(>) to move the selected features to the Selected list.

Figure 4-26: Reservation Wizard Template dialog box, Features tab

3. Continue with any other optional configuration for the template as needed; otherwise,
click OK to close the Reservation Wizard Template dialog box and return to the
Reservation Wizard Templates window with the newly configured template
automatically selected.
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To select the default user defined fields for a reservation wizard 

template

User defined fields, or UDFs, are custom fields that store additional information or data for a 
a reservation. For example, for a reservation, you might want to note the date that the 
contract for the event was received and if the event was approved by a supervisor. You can 
select the default user defined fields that are to always apply to a reservation wizard 
template. These fields are displayed on the User Defined Fields tab in the Reservation 
Wizard.

1. If needed, open the Reservation Wizard Template dialog box for the reservation wizard
template that you are configuring. (See “To configure a reservation wizard template” on
page 192.)

2. Open the User Defined Fields tab, and on the Available list, select the UDF, or
CTRL-click to select the multiple UDFs that are to always apply to the template, and
then click the Move button (>) to move the selected fields to the Selected list.

Figure 4-27: Reservation Wizard Template dialog box, Features tab

3. Continue with any other optional configuration for the template as needed; otherwise,
click OK to close the Reservation Wizard Template dialog box and return to the
Reservation Wizard Templates window with the newly configured template
automatically selected.
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Before you can use EMS to manage your organization’s events, you must configure core data 
items that are specific to your organization. For example, before you can configure 
production items for a resource, you must first configure the resource.

This chapter covers the following topics:

• “Overview of Configuring Resources” on page 199.

• “Configuring Services for a Category” on page 200.

• “Configuring Groupings for a Resource” on page 203.

• “Configuring Resources for a Category” on page 206.

• “Importing Resources for a Category” on page 219.

• “Configuring Multiple Resources (Resource Configuration Wizard)” on page 221.

• “Defining Production Areas and Production Items for a Resource” on page 225.

• “Defining Resource Selections and Selection Items” on page 230.

• “Configuring the Pricing for a Resource on the Edit Pricing window” on page 234.

• “Exporting Pricing Information for a Resource” on page 238.
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Overview of Configuring Resources

Resources (also called booking detail items) are the individual items or services that your 
users can reserve for an event. Resources are grouped by category. For example, a furniture 
category might contain tables and chairs as the resources. Within a category, you can 
organize resources by groupings. For example, you might configure Beverages, Entrees, and 
Desserts groupings for a Food Service category. The Beverage grouping might contain 
resources such as soda and coffee, the Entrees grouping might contain resources such as fish 
and beef, and so on. You can configure a resource “from scratch,” or you can copy an 
existing resource, and then edit the configuration as needed. You can also import resources 
for a category from a tab-delimited file. If you are configuring resources for either a Catering 
category or Resources, w Service Order category, the first time that you configure resources 
for the category, you must configure at least one default service. A service indicates how the 
resource is to be used or offered. For example, Delivery and Setup, Cleanup, Plated, Buffet, 
and so on are possible services for a resource in a Catering category. 

You can combine a list of related resources into a package to facilitate the process of adding 
multiple resources to a booking. Instead of making multiple repeated selections, a user can 
simply select a single resource package. For example, an Instructor A/V package might 
include a laser pointer, a mobile microphone, and a flip chart. You can set the price for a 
package to be the sum total of the prices of the individual resources that make up the 
package, or you can set a completely different price for the package, for example, if you 
want to discount the package.

You use production items to define the quantity of components that make up a single 
resource. For example, a resource called Box Lunch has the following description—a box 
lunch contains a sandwich, a bag of chips, two cookies, and bottled water. The productions 
items for the Box Lunch resource therefore are the sandwich (quantity =1), chips (quantity 
=1), cookie (quantity = 2), and bottled water (quantity =1). This means that if an order for 20 
boxed lunches is placed, then the kitchen would need to produce 20 sandwiches, 20 bags of 
chips, 40 cookies, and 20 bottled waters. To further define the areas of the kitchen that 
produce each item, you can define production areas. For example, the Delicatessen area 
might produce the sandwich, chips, and bottled water, and the Bakery area might produce the 
cookies. 

After you configure a resource for a category, you can also define selections and selection 
items for the resource. A selection is used when you offer choices with a resource. For 
example, a resource named Catered Breakfast might have the following description—
Catered breakfast includes the choice of one standard entree, two sides, and assorted 
mini-muffins, juice, and coffee. The standard entree selection might include the selection 
items of french toast, pancakes, or scrambled eggs. The side selection might include the 
selection items of bacon, sausage, and sliced fruit. If selection items have been defined for a 
resource, then an EMS user or a VEMS user must make a selection for the resource.
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Configuring Services for a Category

When your users are adding details to a booking, if they select a Catering or Resource, w/ 
Service Order category, they must specify a service. A service indicates how the resource is 
to be used or offered. For example, Delivery and Setup, Cleanup, Plated, Buffet, and so on 
are possible services for a resource in a Catering category. If you are configuring resources 
for either Catering category or Resources, w/ Service Order category, the first time that you 
configure resources for the category, you must configure at least one default service. You can 
also configure additional services for a category.

To configure a service for a category

1. On the EMS menu bar, click Configuration > Resources.

A list of all the categories that are currently configured in your EMS database and for
which you can configure resources opens.

2. Select the category for which you are configuring the service type.

The Resources window opens. This window lists all the resources that are currently
configured in your EMS database for the selected category and that have a status of
Active.

Figure 5-1:  Example of a Resources window

If the appropriate category is not available, you can configure it. See “Overview 
of Configuring Resources” on page 199.
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3. Optionally, do one or both of the following:

• To view all resources for the category in your EMS database, regardless of status,
under Show, click Inactive.

• To filter the displayed resources based on the Resource name, in the Filter field,
enter a search string.

4. Click Services.

The Services window opens. This window lists all the services that are currently
configured for the resource in your EMS database and that have a status of Active.

Figure 5-2:  Services window

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).

Optionally, to view all services in your EMS database, regardless of status, under 
Show, click Inactive.
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5. Click New.

The Service dialog box opens.

Figure 5-3:  Service dialog box

6. Enter the information for the new service type.

7. Click OK.

The Services dialog box closes. You return to the Services window with the newly
configured service automatically selected.

8. Click OK.

The Services window closes. The Resources window remains opens.

9. Optionally, continue to one or both of the following:

• “Configuring Groupings for a Resource” on page 203.

• “Configuring Resources for a Category” on page 206.

Field Description

Service The description or name for the service.

Note: The service can be a maximum of 30 characters, including 

spaces.

Sequence Enter a number that determines the order in which the service is 

displayed in a list with other services. Services are ordered from lowest 

to highest sequence number, with the service with the lowest sequence 

number being displayed first.

Note: If you leave the sequence set to the default value of zero for all 

services, then by default, the services are displayed 

alphabetically.

Available On Web If this service is to be an available option for VEMS users who select this 

category, leave Available on Web selected.

Inactive Leave this option blank to add the service as an active service. Select 

this option to inactivate the service.
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Configuring Groupings for a Resource

Within a category, you can organize resources by groupings. For example, you might 
configure Beverages, Entrees, and Desserts groupings for a Food Service category. The 
Beverage grouping might contain resources such as soda and coffee, the Entrees grouping 
might contain resources such as fish and beef, and so on. You can configure groupings for a 
category at the time that you are configuring resources for the category, or you can carry out 
the configuration as a separate activity.

To configure groupings for a category

1. On the EMS menu bar, click Configuration > Resources.

A list of all the categories that are currently configured in your EMS database and for
which you can configure resources opens.

2. Select the category for which you are configuring the grouping.

The Resources window opens. This window lists all the resources that are currently
configured in your EMS database for the selected category and that have a status of
Active.

Figure 5-4:  Example of a Resources window

If the appropriate category is not available, you can configure it. See “Overview 
of Configuring Resources” on page 199.
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3. Optionally, do one or both of the following:

• To view all resources for the category in your EMS database, regardless of status,
under Show, click Inactive.

• To filter the displayed resources based on the Resource name, in the Filter field,
enter a search string.

4. Click Groupings.

The Groupings window opens. This window lists all the groupings that are currently 
configured in your EMS database for the selected category.

Figure 5-5:  Groupings window

5. Click New.

The Grouping dialog box opens.

Figure 5-6:  Grouping dialog box

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).
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6. In the Grouping field, enter a name or description for the new grouping.

7. In the Sequence field, enter a number that determines the order in which the groupings
are displayed in VEMS.

8. Click OK.

The Grouping dialog box closes. You return to the Grouping window with the newly
configured grouping automatically selected.

9. Click Close.

The Grouping dialog box closes. The Resources dialog box remains open.

10. Optionally, continue to “Configuring Resources for a Category” on page 206.

The grouping can be a maximum of 50 characters, including spaces.

Groupings are ordered from lowest to highest sequence number, with the grouping 
with the lowest sequence number being displayed first. If you leave the sequence 
set to the default value of zero for all groupings, then by default, the groupings are 
displayed alphabetically. 
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Configuring Resources for a Category

Resources (also called booking detail items) are the individual items or services that your 
users can reserve for an event. Resources are grouped by category. For example, a furniture 
category might contain tables and chairs as the resources. Although you can use categories to 
track setup notes, meeting attendees, and activities for a booking, you do not configure 
resources for these categories. You must configure resources only for service categories. 

To configure resources for a category

1. On the EMS menu bar, click Configuration > Resources.

A list of all the categories that are currently configured in your EMS database and for
which you can configure resources opens.

2. Select the category for which you are configuring the resources.

The Resources window opens. This window lists all the resources that are currently
configured in your EMS database for the selected category and that have a status of
Active.

Figure 5-7:  Example of a Resources window

If the appropriate category is not available, you can configure it. See “Overview 
of Configuring Resources” on page 199.
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3. Optionally, do one or both of the following:

• To view all resources for the category in your EMS database, regardless of status,
under Show, click Inactive.

• To filter the displayed resources based on the Resource name, in the Filter field,
enter a search string.

4. On the Resources dialog box, click New.

The Resource dialog box opens. The Resource tab is the active tab.

Figure 5-8:  Resource dialog box, Resource tab

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).

The remainder of this procedure describes how to configure a resource “from 
scratch.” You can also configure a resource by copying an existing resource. 
Select the resource that you want to copy, click Copy, and then continue to Step 5 
of this procedure.
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5. Enter the information for the new resource.

Field Description

Description The name or description of the resource. 

Note: The description can be a maximum of 50 characters, including 

spaces. Resource items are displayed alphabetically in EMS. As a 

result, when you are configuring a group of similar items, you might 

want to start the name of each with a common feature. For 

example, if you have black, white, and blue linens, a good way to 

name them would be “Linens, black,” “Linens, white,” and so on.

Grouping If needed, select a grouping. 

Note: If no groupings are available, or if the appropriate grouping is not 

available, you can always configure a grouping, and then edit the 

resource at a later date to place it in a grouping. See “Configuring 

Groupings for a Resource” on page 203.

Account Select the internal account which is to receive the revenue from the use of 

the resource.

Note: If the appropriate account is not available, you can configure it. See 

“Configuring Accounts” on page 263.

Sequence Enter a number that determines the order in which the resource is 

displayed in a list with other resources in either EMS or VEMS. Resources 

are ordered from lowest to highest sequence number, with the resource 

with the lowest sequence number being displayed first.

Note: If you leave the sequence set to the default value of zero for all 

resources, then by default, the resources are displayed 

alphabetically.

Package Select this option if the resource is to be a package.

Note: A package is a collection of related resources. See “To create a 

package for a resource” on page 217.

Use Package Item 

Prices

Available only if Package is selected. Select this option if the package price 

is to be the sum total of the prices for the individual resources that make up 

the package; otherwise, you can define a different price for the package on 

the Pricing tab. 

Override Description Select this option to allow your EMS users to edit the resource description 

when they are adding the resource to a booking. 

Note: A common use for this feature is to configure a resource called 

“Other” for each of your resource categories which users can 

rename to whatever non-inventory item is needed when they select 

it.

Maintain Inventory Select this option if you have a limited number of this item and you want 

EMS to notify your users if they attempt to overbook it. 

Quantity Available Available only if you select Maintain Inventory. Enter the number of 

resource items of this type that your organization has in its inventory.

External Reference Links the resource to an outside program if needed.

Internal Indicates that the resource is internal to your organization. 

Note: Used for internal reporting purposes only. The resource is not 

printed on external documents such as confirmations and invoices, 

and it is not hidden in any area of your EMS application.
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6. Optionally, click Spelling to spell check the information that you entered for the resource
before you save it.

7. Optionally, continue to one or more of the following for the resource; otherwise, click
OK to close the Resource dialog box and return to the Resources window. The newly
configured resource is automatically selected in the window.

• “To assign the calculations to a resource at the resource level” on page 210.

• “To configure the pricing for a resource” on page 211.

• “To associate an image with a resource” on page 213.

• “To view and edit the production items for a resource” on page 214.

• “To specify the excluded rooms for a resource” on page 216.

• “To create a package for a resource” on page 217.

Production Item Available only if the category to which you are adding the resource has 

been designated as using production items. (See “Overview of Configuring 

Resources” on page 199.) Select this option if this resource item is to be a 

production item.

Serves The number of users that can be served by the resource. For example, one 

lunch buffet might serve ten people.

Min. Quantity The minimum quantity required when selecting the resource.

Alert Enter a message that is to be displayed when a user adds the resource to 

a booking in the EMS client. 

Notes Any other additional information that is pertinent to the item itself, the use 

of the item, and so on. Notes displayed in EMS and VEMS are printed on 

confirmations and the Setup Worksheet report.

Virtual EMS Settings

Available on the Web To have this resource be an available option for VEMS users who select 

this category, leave Available on Web selected.

Note: Not available if Override Description is selected.

Available at Checkout Select this option if you want this resource to be displayed on the 

“checkout” page (the last page in the Room Request process) in VEMS. 

Note: Not available if Available on the Web is not selected.

Hide Special 

Instructions

Do not show any special instructions for the resource in VEMS.

Display Alert on Web If an alert has been configured for the resource, then display this alert 

when a user adds this resource to a booking in VEMS.

Field Description
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8. After you have configured the resource:

• If this is the first time that you have configured resources for the category, and the
category is Catering or Resources, w Service Orders, you must also configure at
least one default service type. See “Configuring Services for a Category” on page
200.

• You can define production items for the resource and/or define selections for the
resource. See “Defining Production Areas and Production Items for a Resource” on
page 225 and “Defining Resource Selections and Selection Items” on page 230.

To assign the calculations to a resource at the resource level

1. If needed, open the Resource dialog box (see “To configure resources for a category” on
page 206), and then open the Calculations tab.

Figure 5-9:  Resource dialog box, Calculations tab

2. On the Available list, select the calculation, or CTRL-click to select the multiple
calculations that are to apply to this resource, and then click the Move button (>) to
move the selected calculations to the Selected list.

Remember, you can also assign calculations at the category level as well. (See 
“Overview of Configuring Resources” on page 199.) If you have already assigned 
calculations to a resource’s category, then these calculations are automatically 
applied to new resources for the category. These calculations are displayed in the 
Selected list after you click OK and save the resource.

If the appropriate calculation is not available, you can configure it. See 
“Configuring Calculations” on page 258.
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3. Continue with any other optional configuration for the resource as needed; otherwise,
click OK to close the Resource dialog box and return to the Resources window. The
newly configured resource is automatically selected in the window.

To configure the pricing for a resource

1. If needed, open the Resource dialog box (see “To configure resources for a category” on
page 206), and then open the Pricing tab.

Figure 5-10: Resource dialog box, Pricing tab

2. For each rate schedule, select the pricing method, which determines the cost for
reserving the resource. (See the table on the next page.)

You can also configure the resource price on the Edit Pricing window (see 
“Configuring the Pricing for a Resource on the Edit Pricing window” on page 
234) or when you are configuring rate schedules (see “Configuring Rate
Schedules” on page 247).

If the appropriate rate schedule is not available, you can configure it. See 
“Configuring Rate Schedules” on page 247.
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3. After you select a pricing method, click in the appropriate fields to select the currently
displayed amount, and edit the amount as needed.

Pricing Method Description

Half Day/Full Day 

(Event Time)

The total number of hours for the event is counted and then compared 

to the number of hours that is indicated in the Hours column. If the total 

number of hours for the event is less than or equal to the hours that are 

indicated in the Hours column, then the Half Day price is charged for the 

resource. If the total number of hours for the event is greater than the 

hours that are indicated in the Hours column, then the Full Day price is 

charged for the resource.

Half Day/Full Day 

(Reserved Time)

The total number of hours for the reservation (event time and reserved 

time) is counted and then compared to the number of hours that is 

indicated in the Hours column. If the total number of hours for the 

reservation is less than or equal to the hours that are indicated in the 

Hours column, then the Half Day price is charged for the resource. If the 

total number of hours for the reservation is greater than the hours that 

are indicated in the Hours column, then the Full Day price is charged for 

the resource.

Hourly (Event Time) The price that is indicated in the Price column is multiplied by the event 

time (in hours) for the booking. This price can be used in conjunction 

with an initial “flat” fee, as well as minimum and maximum fees. 

Hourly (Reserved Time) The price that is indicated in the Price column is multiplied by the 

reserved time (in hours) for the booking. This price can be used in 

conjunction with an initial “flat” fee, as well as minimum and maximum 

fees. 

Hourly (Service Time) The price that is indicated in the Price column is multiplied by the 

reserved time (in hours) for the service (resource). This price can be 

used in conjunction with an initial “flat” fee, as well as minimum and 

maximum fees. 

Hourly (Specific) The price that is indicated in the Price column is multiplied by the 

number of hours indicated when adding the resource to a booking.

Unit The price that is indicated in the Price column is applied to the resource, 

regardless of the event time or reserved time for the booking.

Field Description

Price The dollar amount that is used in calculating the resource price for a booking. If the 

pricing method is Unit, then this value is applied in total to a resource, regardless of 

the event time or reserved time for the booking.

Discount You can use a discount with any pricing method. If you specify a discount for a 

resource, then the actual price, the discount percentage, and the discounted 

amount are displayed on confirmations and invoices.

Min. Charge

Max. Charge

The values that are indicated in these columns are used in conjunction with the 

Hourly pricing methods. If you specify a minimum charge for a resource, then the 

system compares this value to the calculated hourly rate and applies the greater of 

the two charges. Likewise, if you specify a maximum charge for a resource, then 

the system compares this value to the calculated hourly rate and applies the lesser 

of the two charges.
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4. Continue with any other optional configuration for the resource as needed; otherwise,
click OK to close the Resource dialog box and return to the Resources window. The
newly configured resource is automatically selected in the window.

To associate an image with a resource

You can associate an image with a resource if the image is in one of the following formats—
.gif, .jpeg, .jpg, .bmp, .wmf, or .png and ideally, it should not be larger than 615 x 350 pixels. 
If you attach an image larger than this, you might not be able to view the image without 
scrolling. Any images that you associate with the resource are displayed only in VEMS. 
They are not displayed in the EMS client.

1. If needed, open the Resource dialog box (see “To configure resources for a category” on
page 206), and then open the Images tab.

Figure 5-11: Resource dialog box, Images tab

Flat Price A resource price that remains constant regardless of the total number of hours 

booked for the resource. Used in conjunction with Hourly (Event Time) and Hourly 

(Reserved Time).

Half Day 

Price

The dollar amount that is used in calculating the resource price for a booking if the 

pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation 

Time).

Full Day 

Price

The dollar amount that is used in calculating the resource price for a booking if the 

pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation 

Time).

Hours Multiplier used in calculating the resource price for a booking if the pricing unit is 

Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation Time).

Field Description



214

 
Core Configuration - Resources

2. To have an image of the resource displayed in the VEMS interface, click New to open
the Find Image dialog box, and then browse to and select the image.

The Find Image dialog box closes. You remain on the Images tab with an entry for the
image displayed on the tab.

3. Optionally, after selecting the image, click in the Web Long Description field and enter a
description of the resource.

4. Continue with any other optional configuration for the resource as needed; otherwise,
click OK to close the Resource dialog box and return to the Resources window. The
newly configured resource is automatically selected in the window.

To view and edit the production items for a resource

The Production Items tab lists all the production items that have been defined in your EMS 
database. (See “To define production areas and production items for a resource” on page 
225.) 

1. If needed, open the Resource dialog box (see “To configure resources for a category” on
page 206), and then open the Production Items tab.

Figure 5-12: Resource dialog box, Production Items tab

The value that you enter here defines the “long desc” attribute for web content 
accessibility.

The Production Items tab is available only if you did not select Production Item on 
the Resource tab when you are configuring the resource.
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2. Optionally, do one or more of the following to filter the production items that are
displayed:

• Select a production area. (The default value is (all)).

• To filter the displayed production items based on the Item name, in the Filter field,
enter a search string.

• Select Show Selected Only.

3. Select a production item and change the quantity for the item.

4. Continue with any other optional configuration for the resource as needed; otherwise,
click OK to close the Resource dialog box and return to the Resources window. The
newly configured resource is automatically selected in the window.

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).

Only those production items that have previously been selected for the resource 
are displayed.

If you do not want a production item to be assigned to the resource, make sure that 
the quantity for the item is set to zero.
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To specify the excluded rooms for a resource

Excluded rooms are those rooms for which the resource is not to be available.

1. If needed, open the Resource dialog box (see “To configure resources for a category” on
page 206), and then open the Excluded Rooms tab.

Figure 5-13: Resource dialog box, Excluded Rooms tab

2. Select the search criteria by which to search for the excluded rooms.

• On the Building dropdown list, select one of the following—(all) buildings, a
specific building, a specific area, or a specific view.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

3. On the Available list, select the room, or CTRL-click to select the multiple rooms from
which the resource item is to be excluded, and then click the Move button (>) to move
the selected rooms to the Selected list.

If the appropriate building, area, or view is not available, you can configure it. 
See “Configuring Buildings” on page 91, “Configuring Areas” on page 99, and/
or “Configuring Public Views” on page 144.

If the appropriate room type is not available, you can configure it. See 
“Configuring Room Types” on page 89.
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4. Continue with any other optional configuration for the resource as needed; otherwise,
click OK to close the Resource dialog box and return to the Resources window. The
newly configured resource is automatically selected in the window.

To create a package for a resource

You can combine a list of related resources into a package to facilitate the process of adding 
multiple resources to a booking. Instead of making multiple repeated selections, a user can 
simply select a single resource package. For example, an Instructor A/V package might 
include a laser pointer, a mobile microphone, and a flip chart. You select the items for a 
resource package on the Package Items tab of the Resource dialog box. You can set the price 
for a package to be the sum total of the individual resources that make up the package, or you 
can set an independent price for the package. 

1. If needed, open the Resource dialog box (see “To configure resources for a category” on
page 206), and then open the Packaged Items tab.

The tab displays all the resources that have been configured for the selected category.

Figure 5-14: Resource dialog box, Package Items tab

2. Optionally, to filter the display, click Show Selected Only.

Only those resource items that have previously been selected to be part of the resource
package are displayed.

3. For each resource item that is to be included in the package, double-click in the Quantity
field, and then enter the appropriate quantity for the resource item.

The Package Items tab is available only if you select Package on the Resource tab 
when you are configuring the resource. 
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4. Continue with any other optional configuration for the resource as needed; otherwise,
click OK to close the Resource dialog box and return to the Resources window. The
newly configured resource is automatically selected in the window.
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Importing Resources for a Category

You can import resources for a category from a tab-delimited file. (See Appendix E, “Import 
File Specifications,” on page 539 for the import file specifications.) After you import the 
resources, you can edit their configurations as necessary.

To import resources for a category

1. On the EMS menu bar, click Configuration > Resources.

A list of all the categories that are currently configured in your EMS database and for
which you can configure resources opens.

2. Select the category for which you are importing the resources.

The Resources window opens. This window lists all the resources that are currently
configured in your EMS database for the selected category and that have a status of
Active.

Figure 5-15: Example of a Resources window



220

 
Core Configuration - Resources

3. Optionally, do one or both of the following:

• To view all resources for the category in your EMS database, regardless of status,
under Show, click Inactive.

• To filter the displayed resources based on the Resource name, in the Filter field,
enter a search string.

4. Click Import.

The Import Resources dialog box opens.

Figure 5-16: Import Resources dialog box

5. Click the Search icon  to open the Find Resource Import File dialog, and then 

browse to and select the resource file that is to be imported.

6. On the Rate Schedule dropdown list, select the rate schedule that applies to the resource.
(See “Rate schedules” on page 243.)

7. Click Import.

A dialog box opens, indicating the number of resources that you are about to import, and
asking you if you want to continue.

8. Click Yes.

A message opens indicating that the import was successful.

9. Click OK to close the message and return to the Resources window.

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).
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Configuring Multiple Resources (Resource 

Configuration Wizard)

When you configure resources for a category, you have the option of configuring a single 
resource at a time through the Resources window, or you can use the Resource Configuration 
Wizard to configure multiple resources. You typically use the Resource Configuration 
Wizard to configure multiple resources that have common properties such as the grouping, 
the account, and the VEMS settings. Instead of configuring these resources individually with 
these same properties, you can use the Resource Configuration Wizard to configure these 
resources in a single step.

To configure multiple resources

1. On the EMS menu bar, click Configuration > Resources.

A list of all the categories that are currently configured in your EMS database and for
which you can configure resources opens.

2. Select the category for which you are configuring the resources.

The Resources window opens. This window lists all the resources that are currently
configured in your EMS database for the selected category and that have a status of
Active.

Figure 5-17: Example of a Resources window
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3. Optionally, do one or both of the following:

• To view all resources for the category in your EMS database, regardless of status,
under Show, click Inactive.

• To filter the displayed resources based on the Resource name, in the Filter field,
enter a search string.

4. Click Wizard.

The Resource Configuration Wizard opens.

Figure 5-18: Resource Configuration Wizard

5. Configure the properties as needed for the new resources.

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).

Field Description

Grouping Select the grouping for the resources.

Note: If the appropriate grouping is not available, you can configure it. 

See “Configuring Groupings for a Resource” on page 203.

Account Select the internal account which is to receive the revenue from the use 

of the resource.

Note: If the appropriate account is not available, you can configure it. 

See “Configuring Accounts” on page 263.
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6. Click Next.

The second page of the Resource Configuration Wizard opens. All the resources that are
currently configured in your EMS database for the selected category and that have a
status of Active are displayed on the page.

Figure 5-19: Resource Configuration Wizard, Second page

Serves The number of users that can be served by the resource. For example, 

one lunch buffet might serve ten people.

Min. Quantity The minimum quantity of the resource that a user must order.

Internal Select this option and leave Yes selected to indicate that the resource is 

internal to your organization. 

Note: Used for internal reporting purposes only. The resource is not 

printed on external documents such as confirmations and 

invoices, and it is not hidden in any area of your EMS 

application.

Available on the Web If these resources must be available for VEMS users who select this 

category, select this option, and then leave Yes selected. To remove 

these resources as an option for VEMS, select No.

Note: Not available if Override Description is selected.

Available at Checkout If these resources are to be displayed on the “checkout” page (the last 

page in the Room Request process) in VEMS, then select this option, 

and then leave Yes selected. Tor remove these resources from the 

“checkout” page, select No.

Note: Not available if Available on the Web is not selected.

Active To add the resources as active resources to the EMS database, select 

this option, and then leave Yes selected. To inactivate these resources, 

select No.

Field Description
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7. On the Available list, select the resource, or CTRL-click to select the multiple resources
that you are configuring with these properties, and then click the Move button (>) to
move the selected resources to the Selected list.

8. Click Finish.

A message opens indicating that the resource properties were set successfully.

9. Click OK.

The message and the Resource Configuration Wizard close.

Optionally, to show all resources for the category that are in your EMS database 
regardless of status, under Show, click Inactive.

You must configure the other properties for the resources, such as the pricing, 
individually. See “Configuring Resources for a Category” on page 206.
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Defining Production Areas and Production Items 

for a Resource

You use production items to define the quantity of components that make up a resource. For 
example, a resource called Box Lunch contains the following productions items—sandwich 
(quantity =1), chips (quantity =1), cookie (quantity = 2), and bottled water (quantity =1). If 
an order for 20 boxed lunches is placed, then the kitchen must produce 20 sandwiches, 20 
bags of chips, 40 cookies, and 20 bottled waters. To identify the areas of the kitchen that 
produce each item, you can define production areas. For example, the Delicatessen area 
might produce the sandwich, chips, and bottled water, and the Bakery area might produce the 
cookies. If a category has been defined as using production items, then at the time that you 
are configuring a resource for the category, you can define the resource as a production item, 
or you can manually define resources as production items for the category at a later date.

To define production areas and production items for a resource

1. On the EMS menu bar, click Configuration > Resources.

A list of all the categories that are currently configured in your EMS database and for
which you can configure resources opens.

2. Select the category for which you are configuring the resources.

The Resources window opens. This window lists all the resources that are currently
configured in your EMS database for the selected category and that have a status of
Active.

Figure 5-20: Example of a Resources window
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3. Click Prod. Items.

The Production Item window opens. This dialog box displays all the production items
that have been defined for a category and that have a status of Active.

Figure 5-21: Production Items window

4. Optionally, do one or more of the following:

• To filter the displayed production items based on the Production Area, on the
Production Area dropdown list, select an area.

• To view all production items that have been defined for the category regardless of
status, under Show, click Inactive.

• To filter the displayed production items based on the item name, in the Filter field,
enter a search string.

5. Continue to one of the following:

• “To define a new production area for a resource” on page 227.

• “To define new production items for a resource” on page 228.

Optionally, to view all resources that have been configured for a category, 
regardless of status, under Show, click Inactive.

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).
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To define a new production area for a resource

1. Click Prod. Areas.

The Production Areas window opens. This window lists all the production areas that
have been configured for the selected category and that have a status of Active.

Figure 5-22: Production Areas window

2. Click New.

The Production Area dialog box opens.

Figure 5-23: Production Area dialog box

3. Enter a description or name for the production area.

Optionally, to show all production areas for the category that are in your EMS 
database regardless of status, under Show, click Inactive.

The description can be a maximum of 50 characters, including spaces.



228

 
Core Configuration - Resources

4. Leave Inactive blank to add the production area as an active area. Select Inactivate to
inactivate the production area.

5. Optionally, click Spelling to spell check the description before you save the production
area.

6. Click OK.

The Production Area dialog box closes. You return to the Production Areas window with
the newly configured production area automatically selected.

To define new production items for a resource

1. On the Production Items window, click New.

The Production Item dialog box opens.

Figure 5-24: Production Item dialog box

2. In the Description field, enter description or name for the production item.

3. Optionally, on the Production Area dropdown list, select a production area for the item.

4. Click OK.

You return to the Production Items window with the newly configured production item
automatically selected.

5. Click Close on the Production Items window to close the window and return to the
Resources window.

The description can be a maximum of 50 characters, including spaces.
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6. On the Resources window, select the resource for which you are configuring the
production items, and then click Edit.

The Resource dialog box opens.

7. Open the Production Items tab for the resource, and for each appropriate production
item, enter the quantity.

8. Click OK to close the Resource dialog box and save the resource with its production
items.
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Defining Resource Selections and Selection 

Items

After you configure a resource for a category, you can define selections and selection items 
for the resource. A selection is used when you offer choices with a resource. For example, a 
resource named Catered Breakfast might have the following description—Catered breakfast 
includes the choice of one standard entree, two sides, and assorted mini-muffins, juice, and 
coffee. The selection of standard entree might include the selection items of french toast, 
pancakes, or scrambled eggs. The side selection items might include bacon, sausage, and 
sliced fruit. If selection items have been defined for a resource, then an EMS user or a VEMS 
user must make a selection for the resource.

To define resource selections and selection items

1. On the EMS menu bar, click Configuration > Resources.

A list of all the categories that are currently configured in your EMS database and for
which you can configure resources opens.

2. Select the category for which you are configuring the resources.

The Resources window opens. This window lists all the resources that are currently
configured in your EMS database for the selected category and that have a status of
Active.

Figure 5-25: Example of a Resources window
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3. Optionally, do one or both of the following:

• To view all resources for the category in your EMS database, regardless of status,
under Show, click Inactive.

• To filter the displayed resources based on the Resource name, in the Filter field,
enter a search string.

4. Select the resource for which you are configuring the selections, and then click
Selections.

The Selections window opens. This window lists all the selections that have been
configured for the selected resource and that have a status of Active.

Figure 5-26: Selections window

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).

Optionally, to show all selections for the resource, regardless of status, under 
Show, click Inactive.



232

 
Core Configuration - Resources

5. Click New.

The Selection dialog box opens. The Selection tab is the active tab.

Figure 5-27: Selection dialog box, Selection tab

6. In the Description field, enter a description or name for the selection, for example,
Breakfast Entrees.

7. Optionally, do one or more or all the following:

• In the Sequence field, enter a number that determines the order in which the
selection is displayed in a list with other selections.

• In the Min Pick field, enter the minimum number of selection items that a user is
required to pick.

• In the Max Pick field, enter the maximum number of selections items that a user is
allowed to pick.

The description can be a maximum of 255 characters, including spaces.

Selections are ordered from lowest to highest sequence number, with the selection 
with the lowest sequence number being displayed first. If you leave the sequence 
set to the default value of zero for all selections, then by default, the selections are 
displayed alphabetically. 

The maximum pick must be less than or equal to the number of selection items that 
are configured for the selection.
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8. Open the Items tab, and in the Description field, enter a description or name for each
selection item.

Figure 5-28: Selection dialog box, Items tab

9. Optionally, for each selection item, do one or both of the following:

• In the Sequence field, enter a number to sort the selection items on the tab.

• In the Notes field, enter any optional information that is pertinent for the item.

10. Click OK.

You return to the Selections window with the newly configured resource selection
automatically selected.

The description can be a maximum of 255 characters, including spaces.

Selection items are ordered from lowest to highest sequence number, with the 
selection item with the lowest sequence number being displayed first. If you leave 
the sequence set to the default value of zero for all selection items, then by default, 
the selection items are displayed alphabetically. 
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Configuring the Pricing for a Resource on the 

Edit Pricing window

You can configure the pricing for a resource on the Pricing tab of the Resource dialog box, or 
you can configure the resource, and then configure the pricing for it at a later date on the Edit 
Pricing window.

To configure the pricing for a resource from the Edit Pricing 

window

1. On the EMS menu bar, click Configuration > Resources.

A list of all the categories that are currently configured in your EMS database and for
which you can configure resources opens.

2. Select the category for which you are pricing the resources.

The Resources window opens. This window lists all the resources that are currently
configured in your EMS database for the selected category and that have a status of
Active.

Figure 5-29: Example of a Resources window

You can also configure the resource price at the time that you are configuring the 
resource on the Resource dialog box (see “To configure the pricing for a 
resource” on page 211), or at the time that you are configuring rate schedules (see 
“Configuring Rate Schedules” on page 247).
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3. Optionally, do one or both of the following:

• To view all resources for the category in your EMS database, regardless of status,
under Show, click Inactive.

• To filter the displayed resources based on the Resource name, in the Filter field,
enter a search string.

4. Click Pricing.

The Edit Pricing window opens.

Figure 5-30: Edit Pricing window

5. On the Rate Schedule dropdown list, select the rate schedule for which you are pricing
the resources.

6. Do one of the following:

• Leave the Grouping set to the default value of (all), and then click Display to display
a list of all active resources in all the groupings that have been configured for the
selected category.

• On the Grouping dropdown list, select a specific grouping, and then click Display to
display a list of all active resources in the grouping.

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).
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7. For each resource, select the pricing method, which determines the cost for reserving the
resource.

8. After you select a pricing method, click in the appropriate fields to select the currently
displayed amount, and then edit the amount as needed.

If the appropriate rate schedule is not available, you can configure it. See 
“Configuring Rate Schedules” on page 247.

Pricing Method Description

Half Day/Full Day 

(Event Time)

The total number of hours for the event is counted and then compared 

to the number of hours that is indicated in the Hours column. If the total 

number of hours for the event is less than or equal to the hours that are 

indicated in the Hours column, then the Half Day price is charged for the 

resource. If the total number of hours for the event is greater than the 

hours that are indicated in the Hours column, then the Full Day price is 

charged for the resource.

Half Day/Full Day 

(Reserved Time)

The total number of hours for the reservation (event time and reserved 

time) is counted and then compared to the number of hours that is 

indicated in the Hours column. If the total number of hours for the 

reservation is less than or equal to the hours that are indicated in the 

Hours column, then the Half Day price is charged for the resource. If the 

total number of hours for the reservation is greater than the hours that 

are indicated in the Hours column, then the Full Day price is charged for 

the resource.

Hourly (Event Time) The price that is indicated in the Price column is multiplied by the event 

time (in hours) for the booking. This price can be used in conjunction 

with an initial “flat” fee, as well as minimum and maximum fees. 

Hourly (Reserved Time) The price that is indicated in the Price column is multiplied by the 

reserved time (in hours) for the booking. This price can be used in 

conjunction with an initial “flat” fee, as well as minimum and maximum 

fees. 

Hourly (Service Time) The price that is indicated in the Price column is multiplied by the 

reserved time (in hours) for the service (resource). This price can be 

used in conjunction with an initial “flat” fee, as well as minimum and 

maximum fees. 

Hourly (Specific) The price that is indicated in the Price column is multiplied by the 

number of hours indicated when adding the resource to a booking.

Unit The price that is indicated in the Price column is applied to the resource, 

regardless of the event time or reserved time for the booking.

Field Description

Price The dollar amount that is used in calculating the resource price for a 

booking. If the pricing method is Unit, then this value is applied in total to 

a resource, regardless of the event time or reserved time for the 

booking.
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9. Repeat Step 5 through Step 8 for each rate schedule and/or grouping as needed.

10. Click Close.

The Edit Pricing window closes. The pricing information is saved for the resource.

Discount You can use a discount with any pricing method. If you specify a 

discount for a resource, then the actual price, the discount percentage, 

and the discounted amount are displayed on confirmations and 

invoices.

Min. Charge

Max. Charge

The values that are indicated in these columns are used in conjunction 

with the Hourly pricing methods. If you specify a minimum charge for a 

resource, then the system compares this value to the calculated hourly 

rate and applies the greater of the two charges. Likewise, if you specify 

a maximum charge for a resource, then the system compares this value 

to the calculated hourly rate and applies the lesser of the two charges.

Flat Price A resource price that remains constant regardless of the total number of 

hours booked for the resource. Used in conjunction with Hourly (Event 

Time) and Hourly (Reserved Time).

Half Day Price The dollar amount that is used in calculating the resource price for a 

booking if the pricing unit is Half Day/Full Day (Event Time) or Half Day/

Full Day (Reservation Time).

Full Day Price The dollar amount that is used in calculating the resource price for a 

booking if the pricing unit is Half Day/Full Day (Event Time) or Half Day/

Full Day (Reservation Time).

Hours Multiplier used in calculating the resource price for a booking if the 

pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day 

(Reservation Time).

Field Description
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Exporting Pricing Information for a Resource

You can export any pricing information that you configure for a resource on a per rate 
schedule basis on the Edit Pricing window. The information is exported to a Microsoft Excel 
file.

To export pricing information for a resource

1. On the EMS menu bar, click Configuration > Resources.

A list of all the categories that are currently configured in your EMS database and for
which you can configure resources opens.

2. Select the category for which you are pricing the resources.

The Resources window opens. This window lists all the resources that are currently
configured in your EMS database for the selected category and that have a status of
Active.

Figure 5-31: Example of a Resources window

You do not need Microsoft Excel on your EMS client to export the information to 
the file; however, you must have Microsoft Excel on your EMS client to view the 
file.

You can also export pricing information for a resource at the time that you are 
configuring rate schedules. See “Exporting Pricing Information for Billable Items 
(Rooms or Resources)” on page 252.
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3. Optionally, do one or both of the following:

• To view all resources for the category in your EMS database, regardless of status,
under Show, click Inactive.

• To filter the displayed resources based on the Resource name, in the Filter field,
enter a search string.

4. Click Pricing.

The Edit Pricing window opens.

Figure 5-32: Edit Pricing window

5. On the Rate Schedule dropdown list, select the rate schedule for which you are exporting
the pricing information.

6. Do one of the following:

• Leave the Grouping set to the default value of (all), and then click Display to display
a list of all active resources and their prices in all the groupings that have been
configured for the selected category.

• On the Grouping dropdown list, select a specific grouping, and then click Display to
display a list of all active resources and their pricing in the grouping.

7. Click Export.

A Save As dialog box opens. The export file is named Pricing.xls by default.

8. Optionally, edit the name of the export file, and then save the file to a location of your

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Cold returns Cold Boxed Lunches, 
but not Sandwiches (Cold).
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choice.

An Export Report message opens indicating that the export was successful and asks you 
if you want to preview the exported file.

9. Do one of the following:

• Click Yes to open the export file in Microsoft Excel. After viewing the file, you can
close it to return to the Edit Pricing window.

• Click No to close the message and return to the Edit Pricing window.

10. Repeat Step 5 through Step 9 for each rate schedule and/or grouping for which you are
exporting the information.

11. After you have exported all the necessary pricing information for a resource, click Close.

The Edit Pricing window closes. The Resources window remains opens.
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Before you can use EMS to manage your organization’s events, you must configure core data 
items that are specific to your organization. For example, before you can automatically price 
items in a reservation, you must first configure rate schedules and pricing plans.

This chapter covers the following topics:

• “Overview of Billing in EMS” on page 243.

• “Configuring Rate Schedules” on page 247.

• “Configuring Pricing Plans” on page 255.

• “Configuring Calculations” on page 258.

• “Configuring Accounts” on page 263.

• “Configuring Payment Types” on page 265.

• “Configuring Sales Categories” on page 267.

• “Configuring Billing Reference and PO Numbers” on page 269.

• “Configuring Currencies” on page 272.



243

 
Core Configuration - Billing

Overview of Billing in EMS

In EMS, rate schedules and pricing plans allow you to define the pricing for your resources 
and rooms so that the pricing is automatically applied to the resources or rooms when a 
reservation is made. 

Rate schedules

A rate schedule correlates to a pricing sheet that details all the prices for the billable items in 
your EMS database. For example, if your organization is an academic organization, then at 
the most basic of levels, you might configure three different rate schedules for the three 
primary groups that book events at your facilities—an Internal group (students, faculty, staff, 
and so on), an External group (outside organizations that are not affiliated with your 
organization in any way), and an Alumni group. These rate schedules could detail the prices 
for such things as the room charge, A/V equipment charges, catering charges, and so on.

Figure 6-1:  Rate Schedule example

Four factors affect how pricing is applied for a rate schedule—the pricing method (flat rate, 
hourly rate, and so on), calculations (taxes, gratuities, and so on), discount percentage, and 
minimum/maximum charge. You specify the pricing method, and if applicable, the discount 
percentage, and the minimum and maximum charges when you assign the prices to billable 
items based on your rate schedules. (See “Rate schedules and billable items (rooms and 
resources)” below.) You can assign calculations directly to a category, a group, a group type, 
a resource, or a room or you can assign calculations through pricing plans. (See 
“Calculations” on page 244.)

Rate schedules and billable items (rooms and resources)

After you define your organization’s rate schedules, you have three options for manually 
assigning the prices to billable items (rooms and resources) based on these schedules:

• During the configuration of a room or resource. When you are configuring a room or
resource, the configuration dialog box contains a Pricing tab. This tab lists all the rate
schedules that are currently configured in your EMS database. You can specify the
pricing method for the billable item that you are configuring for each rate schedule. You
can also specify a discount percentage for the item, a minimum charge for the item, a
maximum charge for the item, or any combination of these options. (See “Configuring
Rooms” on page 109 and “Configuring Resources for a Category” on page 206.)
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• After all necessary rooms and resources are configured. Both the Rooms window and the
Resources window contain a Pricing button. You can click Pricing to open an Edit Pricing
window. You can use the options on this window to specify the pricing method for the
billable items (rooms and resources) for a selected rate schedule. You can also specify a
discount percentage for the item, a minimum charge for the item, a maximum charge for
the item, or any combination of these options. (See “Configuring Rooms” on page 109 or
“Configuring Resources for a Category” on page 206.)

• Where rate schedules are defined. The Rate Schedules window has a Pricing button. After
you have defined a rate schedule, you can select a rate schedule in the Rate Schedules
window and click Pricing to open an Edit Pricing window. You can use the options on
this window to specify the pricing method for every billable item for the rate schedule.
You can also specify a discount percentage for the item, a minimum charge for the item,
a maximum charge for the item, or any combination of these options. (See “Configuring
Rate Schedules” on page 247.)

Calculations

Calculations are additional charges that can be applied to billable items (a category, a group, 
a group type, a resource, or a room) such as gratuity or sales tax. A calculation can be applied 
to a resource item every time a group uses the item, or the calculation can be applied only 
when a particular pricing plan is used for a group’s reservation. For a calculation to be 
applied every time a group uses a resource item, the calculation must be defined not only for 
the resource item, but also, for the group that is using the item. For a calculation to be applied 
to a resource item on as-needed basis, then you must use pricing plans. (See “Pricing Plans” 
below. below.)

Pricing Plans

A pricing plan bundles rate schedules. When your users apply a preconfigured pricing plan 
to a reservation, EMS automatically calculates the pricing for the billable items that are 
reserved for an event. You can use a pricing plan to customize the pricing for a specific group 
type or even a specific group. When you configure a group type or group, you can assign a 
default pricing plan to the group type or group. When your users book a reservation for the 
group type or group, then the default pricing plan is applied to the reservation and EMS 
automatically calculates the pricing for the billable items that are reserved for the group’s 
reservation. For example, consider the following rate schedules:

Rate Schedule Charges

Internal • Room Charge - $10/hour (event time). 100% discount.

• A/V (for example, overhead projector) - $20/unit. 100% discount.

External • Room Charge - $10/hour (event time). $50 minimum.

• A/V (for example, overhead projector) - $20/unit.
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Based on the rate schedules that are defined above, you might configure your pricing plans 
as shown in Figure 6-2 below.

Figure 6-2:  Pricing Plans example

Note that these three pricing plans do not make a distinction between External for Profit 
groups and External for Non-Profit groups; however, if you want to customize the pricing so 
that External for Profit groups pay sales tax, but External Not For Profit groups do not, you 
could configure the following pricing plans:

A pricing plan is also required to apply calculations correctly to invoiced items. A 
calculation can be applied to a resource item every time a group uses the item, or the 
calculation can be applied only when particular pricing plan is used for a group’s reservation. 
For a calculation to be applied every time a group uses a resource item, the calculation must 

Alumni • Room Charge - $10/hour (event time). $50 minimum. 25% discount.

• A/V (for example, overhead projector) - $20/unit. 25% discount.

Standard • Catering (for example, coffee) - $5/unit. 5% sales tax.

Pricing Plan Billable Item Rate Schedule

Internal • Room Charge

• A/V

• Catering

• Internal

• Internal

• Standard

External for Profit • Room Charge

• A/V

• Catering

• External

• External

• Standard

External Not For Profit • Room Charge

• A/V

• Catering

• Alumni

• Internal

• Standard (No Tax)

Alumni • Room Charge

• A/V

• Catering

• Alumni

• Internal

• Standard

Rate Schedule Charges
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be defined not only for the resource item, but also for the group that is using the item. For a 
calculation to be applied to a resource item on as needed basis, then you must use pricing 
plans. When you are configuring a pricing plan, you have the option to:

• Have no calculations associated with the pricing plan.

• Add charges in addition to what a group already pays.

• Override a group’s set charges with different charges.

Also, the pricing for a billable item is determined at the time that the item is reserved for an 
event. If your users do not select a pricing plan at the time they are making a reservation, no 
pricing information is retrieved. If your users select a pricing plan after the fact, or if they 
change the pricing plan for a reservation, then they can update the prices of the billable items 
that are reserved for the event only by using the Update Pricing function in the Navigator. 
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Configuring Rate Schedules

When you configure a rate schedule, you can configure one “from scratch,” or you can copy 
an existing rate schedule and edit the name and any configured pricing as needed to make a 
new rate schedule. Optionally, after you configure a rate schedule, you can define the pricing 
for the billable items (rooms and resources) in the rate schedule.

To configure a rate schedule

1. On the EMS menu bar, click Configuration > Billing > Rate Schedules.

The Rate Schedules window opens. This window lists all the rate schedules that are
currently configured in your EMS database.

Figure 6-3:  Rate Schedules window

You can also configure the price for a room or resource at the time that you are 
configuring the room or resource (see “To configure the pricing for a room” on 
page 117 or “To configure the pricing for a resource” on page 211) or after you 
configure the room or resource (see “Configuring Room Pricing on the Edit 
Pricing window” on page 137 or “Configuring Room Pricing on the Edit Pricing 
window” on page 137).
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2. Click New.

The Rate Schedule dialog box opens.

Figure 6-4:  Rate Schedule dialog box

3. In the Rate Schedule field, enter a name or description for the new rate schedule.

4. Click OK.

The Rate Schedule dialog box closes. You return to the Rate Schedules window with the
newly configured rate schedule automatically selected.

5. Optionally, continue to “To configure pricing for the billable items in a rate schedule” on
page 249.

The rate schedule can be a maximum of 30 characters, including spaces.
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To configure pricing for the billable items in a rate schedule

1. If you have not already done so, open the Rate Schedule window (see “To configure a
rate schedule” on page 247) and then select the rate schedule for which you are
configuring the pricing for the billable items.

2. Click Pricing.

The Edit Pricing window opens.

Figure 6-5:  Edit Pricing window

3. Do one of the following:

• To configure the pricing for a resource category, on the Category dropdown list:

• Select the category, and then click Display.

• Optionally, on the Grouping dropdown list, select a resource grouping to filter
the search results.

• To configure the pricing for rooms, on the Category dropdown list:

• Select Room Charge.

All rooms in all buildings that are currently configured in your EMS database
are displayed in the lower pane of the dialog box.

• Optionally, on the Building dropdown list, select a specific building, area, or
view to filter the search results.

• Optionally, on the Grouping dropdown list, select a room type to filter the search
results.
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4. For each billable item (resource or room), select the pricing method, which determines
the cost for reserving the item.

5. After you select a pricing method, click in the appropriate fields to select the currently
displayed amount, and edit the amount as needed.

Pricing Method Description

Half Day/Full Day 

(Event Time)

The total number of hours for the event is counted and then compared 

to the number of hours that is indicated in the Hours column. If the total 

number of hours for the event is less than or equal to the hours that are 

indicated in the Hours column, then the Half Day price is charged for the 

billable item. If the total number of hours for the event is greater than the 

hours that are indicated in the Hours column, then the Full Day price is 

charged for the billable item.

Half Day/Full Day 

(Reserved Time)

The total number of hours for the reservation (event time and reserved 

time) is counted and then compared to the number of hours that is 

indicated in the Hours column. If the total number of hours for the 

reservation is less than or equal to the hours that are indicated in the 

Hours column, then the Half Day price is charged for the billable item. If 

the total number of hours for the reservation is greater than the hours 

that are indicated in the Hours column, then the Full Day price is 

charged for the billable item.

Hourly (Event Time) The price that is indicated in the Price column is multiplied by the event 

time (in hours) for the booking. This price can be used in conjunction 

with an initial “flat” fee, as well as minimum and maximum fees. 

Hourly (Reserved Time) The price that is indicated in the Price column is multiplied by the 

reserved time (in hours) for the booking. This price can be used in 

conjunction with an initial “flat” fee, as well as minimum and maximum 

fees. 

Hourly (Service Time) The price that is indicated in the Price column is multiplied by the 

reserved time (in hours) for the service. This price can be used in 

conjunction with an initial “flat” fee, as well as minimum and maximum 

fees. 

Hourly (Specific) The price that is indicated in the Price column is multiplied by the 

number of hours indicated when adding a billable item to a booking.

Unit The price that is indicated in the Price column is applied to the billable 

item, regardless of the event time or reserved time for the booking.

Field Description

Price The dollar amount that is used in calculating the room or resource price 

for a booking. If the pricing method is Unit, then this value is applied in 

total to the resource or room, regardless of the event time or reserved 

time for the booking.

Discount You can use a discount with any pricing method. If you specify a 

discount for a room or resource, then the actual price, the discount 

percentage, and the discounted amount are all displayed on 

confirmations and invoices.
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6. Click Close.

The Edit Pricing window closes. You return to the Rate Schedules window with the rate
schedule automatically selected.

Min. Charge

Max. Charge

The values that are indicated in these columns are used in conjunction 

with the Hourly pricing methods. If you specify a minimum charge for a 

room or resource, then the system compares this value to the calculated 

hourly rate and applies the greater of the two charges. Likewise, if you 

specify a maximum charge for a room or resource, then the system 

compares this value to the calculated hourly rate and applies the lesser 

of the two charges.

Flat Price A resource or room price that remains constant regardless of the total 

number of hours booked for a room or resource. Used in conjunction 

with Hourly (Event Time) and Hourly (Reserved Time).

Half Day Price The dollar amount that is used in calculating room or resource price for 

a booking if the pricing unit is Half Day/Full Day (Event Time) or Half 

Day/Full Day (Reservation Time).

Full Day Price The dollar amount that is used in calculating the room or resource price 

for a booking if the pricing unit is Half Day/Full Day (Event Time) or Half 

Day/Full Day (Reservation Time).

Hours Multiplier used in calculating the room or resource price for a booking if 

the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day 

(Reservation Time).

Field Description
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Exporting Pricing Information for Billable Items 

(Rooms or Resources)

After you configure a rate schedule and define the pricing for the billable items (rooms and 
resources) in the rate schedule, you can export the pricing information on the Edit Pricing 
window. The information is exported to a Microsoft Excel file.

To export pricing information for rooms and resources

1. On the EMS menu bar, click Configuration > Billing > Rate Schedules.

The Rate Schedules window opens. This window lists all the rate schedules that are
currently configured in your EMS database.

Figure 6-6:  Rate Schedules window

You do not need Microsoft Excel on your EMS client to export the information to 
the file; however, you must have Microsoft Excel on your EMS client to view the 
file.

You can also export the pricing information for rooms and resources after you 
have configured the information for the room or resource. See “Exporting Pricing 
Information for a Room” on page 141 and “Exporting Pricing Information for a 
Resource” on page 238.
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2. Click Pricing.

The Edit Pricing window opens.

Figure 6-7:  Edit Pricing window

3. Do one of the following:

• To export the pricing information for a room or rooms, on the Category dropdown
list:

• Select Room Charge.

All active rooms in all buildings that are currently configured in your EMS
database are displayed in the lower pane of the dialog box.

• Optionally, on the Building dropdown list, select a specific building, area, or
view to filter the search results.

• Optionally, on the Grouping dropdown list, select a room type to filter the search
results.

• To export the pricing information for all the resources in a category, on the Category
dropdown list:

• Select the category, and then click Display.

• Optionally, on the Grouping dropdown list, select a resource grouping to filter
the search results.

4. Click Export.

A Save As dialog box opens. The export file is named Pricing.xls by default.
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5. Optionally, edit the name of the export file, and then save the file to a location of your
choice.

An Export Report message opens indicating that the export was successful and asks you
if you want to preview the exported file.

6. Do one of the following:

• Click Yes to open the export file in Microsoft Excel. After viewing the file, you can
close it to return to the Edit Pricing window.

• Click No to close the message and return to the Edit Pricing window.

7. Repeat Step 3 through Step 6 for each room or resource for which you are exporting the
pricing information.

8. After you have exported all the necessary pricing information, click Close.

The Edit Pricing window closes. The Rate Schedule dialog box remains opens.
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Configuring Pricing Plans

A pricing plan bundles different rate schedules. When you configure a pricing plan, you can 
not only specify different rates schedules for the billable items in the plan, but also you can 
specify the calculation that is to be applied to a billable item when the plan is used for a 
group’s reservation. After you configure pricing plans, you can assign a default plan to a 
group’s record. Whenever a user makes a reservation for the group, the default pricing plan 
is displayed automatically in the Pricing Plan field on the Billing tab of the Reservation 
Wizard. 

To configure pricing plans

1. On the EMS menu bar, click Configuration > Billing > Pricing Plans.

The Pricing Plans window opens. This window lists all the pricing plans that are
currently configured in your EMS database and that have a status of Active.

Figure 6-8:  Pricing Plans window

2. Click New.

The Pricing Plan dialog box opens. The Pricing Plan tab is the active tab. See Figure 6-9
on page 256.

Optionally, to view all pricing plans, regardless of status, under Show, click 
Inactive.
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Figure 6-9:  Pricing Plan dialog box, Pricing Plan tab

3. In the Pricing Plan field, enter a name or description for the new plan.

4. Optionally, on the Calculation Type dropdown list, select the type of calculation that is to
be applied to a resource when the plan is used for a group’s reservation and then go to
Step 5; otherwise, go to Step 6.

• In Addition to Group—The group must pay the calculations that are set for the
billable items in the pricing plan in addition to any calculations that it must always
pay.

• Override Group—Override any calculations that are defined at the Group level and
pay what is defined for the billable items in the pricing plan.

5. Open the Calculations tab, and on the Available list select the calculation, or CTRL-click
to select the multiple calculations that are to always apply to this pricing plan, and then
click the Move button (>) to move the selected calculations to the Selected list.

6. Open the Rate Schedules tab, and for each resource category (including Room Charge)
that is to have its price set by this pricing plan, double-click in the Rate Schedule field,
and then select the appropriate rate schedule from the dropdown list.

The pricing plan can be a maximum of 30 characters, including spaces.

If the appropriate calculation is not available, you can configure it. “Configuring 
Calculations” on page 258.

If you do not select a rate schedule for a resource category, or for the Room 
Charge, then the pricing for these items is set to zero in the pricing plan.
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7. Click OK.

The Pricing Plan dialog box closes. You return to the Pricing Plans window with the
newly configured pricing plan automatically selected.
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Configuring Calculations

Calculations are additional charges that can be applied to billable items (a category, a group, 
a group type, a resource, or a room) such as gratuity or sales tax. Both pricing methods and 
calculations determine the final cost for a billable item; however, unlike pricing, which is 
applied when a billable item is reserved (and retained, even if the price for the item later 
changes), calculations are figured each time a confirmation or an invoice is generated. When 
you configure a calculation, you must specify the rate for the calculation, the calculation 
sequence (the order in which the calculation is carried out relative to other calculations), and 
if applicable, the minimum charge for the calculation. You must also indicate whether the 
calculation should be carried out on the base amount or on a running total, and whether the 
result of the calculation should be added to the base amount and then considered in 
subsequent calculations. For example, consider the following four calculations for a base 
amount of $1,000.00:

After you configure calculations, you can assign the calculations to a category, group, group 
type, resource, or room. 

Item Calculated on Calculation Result Running Total

• Gratuity 10%

• Calc Sequence = 1

• Calc on Base = Yes

• Calc Incl in Tot = Yes

$1000 $100 $1100

• Sales Tax 5%

• Calc Sequence = 2

• Calc on Base = No

• Calc Incl in Tot = Yes

$1100 $55 $1155

• State Tax 5%

• Calc Sequence = 3

• Calc on Base = Yes

• Calc Incl in Tot = No

$1000 $50 $1155

• Federal Tax 10%

• Calc Sequence = 4

• Calc on Base = No

• Calc Incl in Tot = No

$1155 $115.50 $1155

Total Calculations: $320.50 

Grand Total (Base + Calculations): $1320.50 
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To configure calculations

1. On the EMS menu bar, click Configuration > Billing > Calculations.

The Calculations window opens. This window lists all the calculations that are currently
configured in your EMS database and that have a status of Active.

Figure 6-10: Calculations window

2. Click New.

The Calculation dialog box opens.

Figure 6-11: Calculation dialog box

Optionally, to show all calculations, regardless of status, under Show, click 
Inactive.
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3. Enter the information for the new calculation.

4. Click OK.

The Calculation dialog box closes. You return to the Calculations window with the
newly configured calculation automatically selected.

5. Optionally, continue to “To assign calculations” on page 261.

Field Description

Calculation The name or description for the calculation.

Note: The calculation can be a maximum of 30 characters, including 

spaces.

Account Optional field. The account within your internal accounting system that 

should be credited with the revenue.

Note: If the appropriate account is not available, you can configure it. 

See “Configuring Accounts” on page 263.

Currency The currency symbol that is used to display the results of the 

calculation.

Rate The percentage for the calculation rate, for example 5%.

Sequence The order in which multiple calculations are to be carried out. 

Note: This value is critical when multiple calculations are to be carried 

out and the order of the calculations affects the resulting value.

Minimum Charge Optional field. The minimum charge that is to applied to a billable item 

for which this calculation applies.

Base

Include in Total

• Both Base and Include in Total selected—The calculation is carried

out on the original base amount. The result of the calculation is

added to the current running total to make a new running total. The

result is also added to the grand total (Base + All Calculations) that is

current at the time that the calculation is carried out.

• Only Include in Total selected—The calculation is carried out on the

current running total and the result of the calculation is added to the

current running total to make a new running total. The result of the

calculation is also added to the grand total (Base + All Calculations)

that is current at the time that the calculation is carried out.

• Only Base selected—The calculation is carried out on the original
base amount. The result of the calculation is added to the grand total

(Base + All Calculations) that is current at the time that the calculation

is carried out.

• Neither Base nor Include in Total selected—The calculation is carried

out on the current running total. The result of the calculation is added

to the grand total (Base + All Calculations) that is current at the time

that the calculation is carried out.

Inactive Leave this option blank to add the calculation as an active calculation. 

Select this option to inactivate the calculation.
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To assign calculations

After you configure a calculation, you can assign the calculation to a category, group, group 
type, resource, or room from the Calculations window.

1. If needed, click Configuration > Billing > Calculations to open the Calculations window.

2. Click Assign.

The Assign Calculations dialog box opens.

Figure 6-12: Assign Calculations dialog box

3. On the Calculation dropdown list, select the calculation that you are assigning.

4. On the Assign To dropdown list, select the item (category, group, group type, resource,
or room) to which you are assigning the calculation.

Remember, you also have the option of assigning calculations to a category, 
group, group type, resource, or room at the time that you are configuring the 
category, group, group type, resource, or room. The advantage to assigning a 
calculation after you configure it is that you can assign the calculation to multiple 
items in a single step. 

Item Selected Comments

Category A list of all categories that are currently configured in your EMS 

database is displayed. If you assign a calculation at the category level, 

then the calculation is assigned to all resources that are configured for 

the category. To assign a calculation to a specific resource in a category, 

then select Resource on the Assign To dropdown list.
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5. On the Available list, select the item, or CTRL-click to select the multiple items to which
the calculation is being assigned, and then click the Move button (>) to move the
selected items to the Selected list.

6. Click Close.

The Assign Calculations dialog box closes. You return to the Calculations window.

Group A list of all groups that are currently configured in your EMS database is 

displayed. Two additional fields are displayed—Group Type and Starts 

with. Optionally, select a Group Type and/or enter a search string in the 

Starts with Field to filter the list of groups that are displayed.

Group Type A list of all group types that are currently configured in your EMS 

database is displayed.

Resource A Category dropdown list opens. Select the appropriate category for the 

resource. A list of all resources that are currently configured for the 

selected category in your EMS database is displayed.

Room A Building dropdown list opens. Select the appropriate building. A list of 

all the rooms that are currently configured for the selected building in 

your EMS database is displayed. 

Item Selected Comments
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Configuring Accounts

EMS uses accounts to indicate where the monies that your organization receives for billable 
items should be deposited, based on your internal accounting system. 

Examples of accounts include the following:

• Facilities Account

• Catering Fees Account

• Miscellaneous Charges Accounts

Income for each resource or room is recorded into only one account. The account that is 
credited typically corresponds to the operational department that receives the income credit 
for the sale of the resource or room. For instance, in this model, room charges might be 
credited to the Facilities Account and food and beverage resources would be credited to the 
Catering Account. When you configure an account, you must specify both an account name 
and an account code. After you configure accounts, you can use them to label billable items 
(rooms, equipment items, and so on). If you invoice out of EMS, then you can run the 
General Ledger Distribution report to group your receivables by account. 

To configure accounts

1. On the EMS menu bar, click Configuration > Billing > Accounts.

The Accounts window opens. This window lists all the accounts that are currently
configured in your EMS database.

Figure 6-13: Accounts window

Accounts in EMS are used for reporting purposes only. EMS does not provide any 
functions for physically moving funds.



264

 
Core Configuration - Billing

2. Click New.

The Account dialog box opens.

Figure 6-14: Account dialog box

3. Enter the information for the new account.

4. Click OK.

The Account dialog box closes. You return to the Accounts window with the newly
configured account automatically selected.

Field Description

Description The name or description for the account.

Note: The description can be a maximum of 50 characters, including 

spaces.

Account The code for the account. Typically, this is numerical, but it can be 

abbreviated text that conveys the account name or description.

Note: The code can be a maximum of 50 characters, including spaces.
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Configuring Payment Types

A payment type indicates the forms of payment that your organization accepts. Payment 
types are also used to track the forms of payment that your groups are using. Examples of 
payment types include checks, credit card, and cash. Because payment types are for 
informational purposes only and do not affect the pricing or billing of an event, configuration 
of payment types is not required; however, after you configure payment types, you can 
assign a default payment type to a group’s record. Whenever a user makes a reservation for 
the group, the default payment type is displayed automatically in the Payment Type field on 
the Billing tab of the Reservation Wizard. 

To configure payment types

1. On the EMS menu bar, click Configuration > Billing > Payment Types.

The Payment Types window opens. This window lists all the payment types that are
currently configured in your EMS database and that have a status of Active.

Figure 6-15: Payment Types window

Optionally, to show all payment types, regardless of status, under Show, click 
Inactive.
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2. Click New.

The Payment Type dialog box opens.

Figure 6-16: Payment Type dialog box

3. In the Payment Type field, enter a name or description for the new payment type.

4. Leave Inactive blank to add the payment type as an active payment type. Optionally,
select Inactive to inactivate the payment type.

5. Click OK.

The Payment Type dialog box closes. You return to the Payment Types window with the
newly configured payment type automatically selected.

The payment type can be a maximum of 30 characters, including spaces.
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Configuring Sales Categories

You can configure sales categories to sort your groups for the purposes of tracking sales 
figures. For example, you could sort your groups based on local, regional, and national sales 
figures. Because sales categories are for informational purposes only and do not affect the 
pricing or billing of an event, configuration of sales categories is not required; however, after 
you configure sales categories, you can assign a default category to a group’s record. 
Whenever a user makes a reservation for the group, the default sales category is displayed 
automatically in the Sales Category field on the Billing tab of the Reservation Wizard. 

To configure sales categories

1. On the EMS menu bar, click Configuration > Billing > Sales Categories.

The Sales Categories window opens. This window lists all the sales categories that are
currently configured in your EMS database and that have a status of Active.

Figure 6-17: Sales Categories window

Optionally, to show all sales categories regardless of status, under Show, click 
Inactive.
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2. Click New.

The Sales Category dialog box opens.

Figure 6-18: Sales Category dialog box

3. In the Sales Category field, enter a name or description for the new sales category.

4. Leave Inactive blank to add the sales category as an active category. Optionally, select
Inactive to inactivate the sales category.

5. Click OK.

The Sales Category dialog box closes. You return to the Sales Categories window with
the newly configured sales category automatically selected.

The sales category can be a maximum of 30 characters, including spaces.
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Configuring Billing Reference and PO Numbers

When you configure billing reference numbers and PO numbers, they are assigned to a 
“master list.” When reservationists or web users are making a reservation or submitting a 
reservation request through the EMS client or VEMS, respectively, then they can look up the 
available billing references or PO numbers on this master list and assign the appropriate 
value to the reservation or request. Because billing references and PO numbers are for 
informational purposes only and do not affect the pricing or billing of an event, configuration 
of these items is not required; however, after you configure billing references and PO 
numbers, you can assign a default value to a group’s record. Whenever a user makes a 
reservation for the group, the default value is displayed automatically in the Billing 
Reference field and/or PO number field on the Billing tab of the Reservation Wizard, but a 
user can change the values if needed.

To configure billing reference numbers and PO numbers

1. On the EMS menu bar, click Configuration > Billing > Billing Reference Numbers.

The Billing Reference Numbers window opens. This window lists a specific number of
billing references that are currently configured in your EMS database and that have a
status of Active.

Figure 6-19: Billing Reference Numbers window

The following procedure is written from the perspective of billing reference 
numbers; however, by analogy, you can follow this procedure to configure PO 
numbers. 

You can set the specific number of records that are to be returned under Options in 
the top right corner of the Billing References window.
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2. Optionally, do one or more of the following:

• Click Options, and then select a different number of records that are to be returned in
the window.

• To filter the list based on the Billing Reference, enter a search string in the Find
field, and then click Display.

• To show both active and inactive billing references, under Show, click Inactive.

3. Click New.

The Billing Reference Number dialog box opens.

Figure 6-20: Billing Reference Number dialog box

4. Enter information for the billing reference number.

5. Leave Inactive blank to add the item as an active billing reference. Select Inactive to
inactivate the billing reference.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, a search string of Alu returns AlumniNE, but not 
NEAlumni.

Field Description

Billing Reference 

Number

Required field. Alphanumeric data allowed.

Note: The number can be a maximum of 100 characters, including 

spaces.

Description A name or description for the billing reference number.

Note: The description can be a maximum of 50 characters, including 

spaces.

Notes Any additional information that is pertinent for the billing reference.

Note: This field is available for reporting in the Query Builder. See the 

EMS User’s Manual.
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6. Optionally, to check the spelling for the billing reference before you save it, click
Spelling.

7. Click OK.

The Billing Reference Number dialog box closes. You return to the Billing Reference
Numbers window with the newly configured reference automatically selected.
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Configuring Currencies

A currency in EMS is either an abbreviation or symbol that indicates how a room or 
resources in a category should be charged. For example, the currency for the US dollar could 
be either USD or $. Because currencies are for informational purposes only and do not affect 
the pricing or billing of an event, configuration of these items is not required; however, after 
you configure currencies, you can assign a default value to a room’s record or a service 
category’s record. If a reservation is made with multiple currencies, then the billable items, 
the items’ prices, and the currencies used for items’ charges are broken out by currency in 
sales reports, in confirmations, in VEMS, and so on.

To configure currencies

1. On the EMS menu bar, click Configuration > Billing > Currencies.

The Currencies window opens. This window lists all the currencies that are currently
configured in your EMS database and that have a status of Active.

Figure 6-21: Currencies window

Optionally, to show all currencies, regardless of status, under Show, click Inactive.
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2. Click New.

The Currency dialog box opens.

Figure 6-22: Currency dialog box

3. Enter the information for the new currency.

4. Leave Inactive blank to add the currency as an active currency. Select Inactive to
inactivate the currency.

5. Click OK.

The Currency dialog box closes. You return to the Currencies window with the newly
configured currency automatically selected.

Field Description

Description The name or description for the currency.

Note: The description can be a maximum of 50 characters, including 

spaces.

Symbol Required field. The abbreviation or symbol for the currency, for 

example, USD or $ for US dollars.

Trailing Symbol Leave this option blank if the currency symbol is to be displayed in a 

leading position, for example, $45.00. Select this option if the symbol is 

to be displayed as the far right hand character. 

Note: As you enter the information for the currency, an example currency entry is displayed in the 

Sample field.
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A group is an entity for which reservations are made at your facilities. A group is one of the 
four core data items that you must configure in EMS so that your users can make 
reservations. A contact is a person who serves as the coordinator or focal point for a group. 

This chapter covers the following topics:

• “Configuring Groups” on page 277.

• “Configuring Additional Information for a Group” on page 285.

• “Configuring Contacts” on page 295.

• “Editing Group Information” on page 303.

• “Importing Groups” on page 308.
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Configuring Groups

A group is an entity for which reservations are made at your facilities. A group is one of the 
four core data items that you must configure so that your users can make reservations. A 
group can be an internal or external entity and it can be an organization or an individual. 
Optionally, if you want to first confirm that a group has not already been configured, then 
you can search for the group.

To search for a group and/or contact

1. On the toolbar, click the Groups icon .

The Groups window opens. The Results tab is the active tab. By default, when the
Results tab first opens, it lists the first 1000 groups that are currently configured in your
EMS database and that have a status of Active.

Figure 7-1:  Groups window, Results tab

Your organization might use a different term (such as client, customer, and so on) 
to identify the entities for which reservations are made at your facilities. To 
change the term from “group” to your organization-specific term throughout your 
EMS system (menus, window and dialog box titles, confirmation headings, and so 
on), you must edit the Group Title Plural and Group Title Singular parameters. 
See “Editing System Parameters” on page 311.
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2. Open the Filter tab and set your search criteria.

3. Click Get Data.

The Results tab opens with a list of search results that meet all your search criteria.

4. To further filter the display on the Results tab, in the Search field, enter a search string.

The list of groups is dynamically updated as you enter your search string.

Optionally, to change the number of records that are displayed in the Groups 
window, click Options, and then on the Group Options dialog box, select a 
different number of records to return.

Option Description

Display • Group—Display all groups that meet your search criteria on the Results tab.

• Contact—Display all contacts that meet your search criteria on the Results tab.

Note: When a list of contacts is displayed, the contact’s group is also displayed.

Search Fields • Starts with—The string is not case-sensitive, but your search is limited to the

exact order of the characters in the string, and the string must begin with the

information for which you are searching. For example, Assoc returns

Association of Broadcasters but not Biomedical Student Association.

• Contains—Your search is limited to the exact order of the characters in the

string, but the string is not case-sensitive, and the string can be found

anywhere in your search results. For example, Assoc returns both Association

of Broadcasters and Biomedical Student Association.

Group Fields are available if you select Groups for Display. Enter values as needed in 

any or all fields.

Contact Fields are available only if you select Contacts for Display. Leave all fields set to 

their default search values to search for all active contacts that are currently 

configured in your EMS database, or enter values as needed in any or all fields.

Note: If you select Contact, then both the Group fields and the Contact fields are 

available for searching. If you enter data in both sets of fields when you are 

searching for a contact, then your search criteria must be met for both the 

contact and the contact’s group for the contact to be displayed on the 

Results tab.

Note: To reset the Filter at any time to its default settings, click Reset Filter.

Your search is limited to the exact order of the characters in the string, but the 
string is not case-sensitive, and it can appear anywhere in your search results. For 
example, a search string of Assoc returns both Association of Broadcasters and 
Biomedical Student Association.
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To configure groups

The following procedure describes the basic information that an EMS administrator typically 
configures for a group. Groups configured this way are generally a satisfactory starting point 
for the reservationists at your organization, and they always have the option of configuring 
additional information for a group if needed. For example, they can configure comments or 
reminders for a group. Your reservationists can also configure and/or edit a groups “on the 
fly” during the reservation process. See the EMS User’s Manual for details.

1. On the toolbar, click the Groups icon .

The Groups window. The Results tab is the active tab. By default, when the Results tab
first opens, it lists up the first 1000 groups that are currently configured in your EMS
database and that have a status of Active.

Figure 7-2:  Groups window, Results tab

Remember that before you configure a group, you might want to search for the 
group to verify that it has not already been configured. See “To search for a group 
and/or contact” on page 277.
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2. Click New.

The Group dialog box opens. The Group tab is the active tab.

Figure 7-3:  Group dialog box, Group tab

3. Enter the summary information for the new group.

The only required information is the group name. All other information on all tabs 
is optional and can be added at a later date when needed.

Field Description

Name Required field. The name of the group.

Note: The name can be a maximum of 50 characters, including spaces.

Address

City

ST

Country

Zip

The street or mailing address for the group.

International Select this option to drop the State and Zip fields for an international group.

Group Type If the appropriate group type is not available, you can configure it. See 

“Configuring Group Types” on page 47.
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4. Optionally, do one or both of the following; otherwise, go to Step 5.

• Open the Billing Information tab and add the default billing information for the
group.

Figure 7-4:  Group dialog box, Billing Information tab

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a dropdown list available from which 

you can select a different value (Fax, Mobile, Other, or Phone) for the 

field label, or you can enter a user-defined value. To enter a 

user-defined value, double-click the current field label to select it, and 

then enter the user-defined value over the selected label. 

Email Address The email address for the group.

Note: If your computer is connected to a network, click the Search icon 

to open a Global Address Lookup dialog box and search for the email 

address.

URL The URL for the group’s website.

Note: Web users can link to this group's web site on VEMS.

Default Contact Populated with the name of the default contact for the group after you have 

defined default contacts for the group.

Require Contacts Select this option if the group is to always require a contact when a 

reservation is being made for the group.

VIP Select this option if the group is to be designated as a VIP group.

Available to Web 

Users

Select this option if users are to be able to select the group on the Group 

Lookup page in VEMS.

Inactive Leave this option blank to add the group as an active group. Select this 

option to inactivate the group.

Field Description
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The values that you specify here are the default values that are applied when a 
new reservation is made for the group. An EMS user can change these values if 
needed.

Option Description

Pricing Plan If the appropriate pricing plan is not available, you can configure it. See 

“Configuring Pricing Plans” on page 255.

Payment Type If the appropriate payment type is not available, you can configure it. 

See “Configuring Payment Types” on page 265.

Salesperson The salesperson for the event. 

Note: An EMS user is designated as a Salesperson at the time that the 

user’s account is configured. If you do not see the appropriate 

user in the list, you can edit an existing user account, or create a 

new user account as needed. See “Configuring User Accounts” 

on page 329.

Event Coordinator The event coordinator for the group.

Note: An EMS user is designated as an Event Coordinator at the time 

that the user’s account is configured. If you do not see the 

appropriate user in the list, you can edit an existing user account, 

or create a new user account as needed. See “Configuring User 

Accounts” on page 329.

Sales Category If the appropriate sales category is not available, you can configure it. 

See “Configuring Sales Categories” on page 267.

Status The status is a way to indicate the standing or ranking of the group. The 

default values are the following:

• OK—A reservation can be made for the group. (In your organization,

this status could indicate that the group is current in payments due.)

• Warning—If a group status is set to Warning, then a Warning

message opens when you make a reservation for the group. It does

not, however, prevent a reservation from being made for the group.

• Bad—If a group status is set to Bad, then reservations cannot be

made for the group.

Note: You can always change the default values for these group 

statuses. See “Editing System Parameters” on page 311.

Billing Reference 

Number

You can manually enter data into the field, or you can click the Search 

icon  to open a master list of billing reference numbers and select a 

reference.

Note: To define a list of eligible billing references that are specific to the 

group, see “Configuring Additional Information for a Group” on 

page 285.

PO Number You can manually enter data into the field, or you can click the Search 

icon  to open a master list of PO Numbers and select a PO number.

Note: To define a list of eligible PO numbers that are specific to the 

group, see “Configuring Additional Information for a Group” on 

page 285.

External Reference Links the group to an outside program, if needed.
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• Open the Other tab and add any other identifying information for the group as
needed.

Figure 7-5:  Group dialog box, Other tab

5. Click OK.

The Group dialog box closes and a group-specific window opens with the newly
configured group automatically selected. (See Figure 7-6 on page 284.) You can use the
options on this window to carry out additional configuration for the group. See
“Configuring Additional Information for a Group” on page 285.

Account If the appropriate account is not available, you can configure it. See 

“Configuring Accounts” on page 263.

Note: This field is displayed only if the EMS system parameter “Show 

Account Field on Group” is set to “Yes.” See “EMS System 

Parameters” on page 492.

Option Description

Network ID The Windows login for the group.

Personnel Number Organization number for the group.

Badge Number Badge number for the group.

Other ID Any secondary ID for the group.

Option Description
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Figure 7-6:  Example of a group-specific window
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Configuring Additional Information for a Group

After you have configured a new group in your EMS database with the basic group 
information (group identifying information, billing information and/or other information), 
you have the option of configuring additional information for the group. You can:

• Create a web user from the group. See “To create a web user from a group” below.

• Assign the group to a web user. See “To assign the group to a web user” on page 289.

• Assign calculations to the group. See “To assign calculations to a group” on page 290.

• Configure a master list of group-specific billing reference numbers. See “To configure a
list of billing reference numbers” on page 292.

• Configure a master list of group-specific PO numbers. See “To configure a list of PO
numbers” on page 293.

To create a web user from a group

A web user is a registered user who can submit requests for reservations or schedule 
reservations in VEMS. When you add a new group in your EMS database, you decide the 
“level” of the group that you are adding. For a group that is added at the individual 
(personnel/employee) level, you might also need to create a web user from the group. This 
user can then create and view reservations on behalf of a group or groups in VEMS. You can 
create only one web user from a group. When you create a web user, you can also specify one 
or more delegates for the web user. A delegate is a web user who can create and view 
reservations on behalf of another web user. 

1. Open the Groups window and search for the group for which you are creating the web
user. See “To search for a group and/or contact” on page 277.

When you select a configuration item (contacts, reminders, and so on) for a group 
in the group-specific window, the right pane for the window is an EMS browser 
window. See “An EMS Browser Window” on page 33.

For information about configuring a contact for a group, including creating a web 
user for a contact, see “Configuring Contacts” on page 295. For information 
about editing or deleting a contact for a group, see “Editing Group Information” 
on page 303.

The following procedure addresses the creation of a web user at the time that you 
are configuring a group in EMS. Configuration of web users as part of the 
overall configuration of your VEMS module is discussed in  , “Virtual EMS 
(VEMS) Configuration,” on page 397. 
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2. On the Groups window, select the group, and then click Tools > Create Web User.

A group-specific dialog box opens. The Web User tab is the active tab.

Figure 7-7:  Group-specific dialog box, Web User tab

3. Enter the information for the new web user.

The User Defined Fields tab displays the questions that a web user was required 
to answer when the user requested to create an account through VEMS and it is 
not relevant to the procedure that is described below.

Ideally, you should enter all the necessary information for your web user before 
you save the web user; however, at any time if you need to access your web user, 
on the EMS menu bar, click Configuration > Web > Web Users.

Field Description

Name Automatically populated after you select the group from the Groups 

window.

Password The password that a web user must enter to log in to VEMS.

Email address If this information has been entered in the Groups window for the group, 

then this field is automatically populated after you select the group from 

the Groups window. If the field is blank, you must enter the full email 

address for the user. (The user must enter this address to log in to 

VEMS.)
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4. Open the Process Templates tab and on the Available list, select the web process
template, or CTRL-click to select the multiple templates to which you are assigning the
user, and then click the Move button (>) to move the selected templates to the Selected
list.

Phone/Fax Optional fields. If this information has been entered for the group, then 

these fields are automatically populated after you select the group from 

the Groups window. If the fields are blank, you can enter values if 

needed.

Notes Optional field.

External Reference Optional field. Links the web user to an outside program if needed.

Network ID Optional field. The web user’s network ID.

Email Opt Out Select this option if the web user is not to receive automatic emails 

(such as reservation summary emails) from VEMS. The user will still 

receive manually sent emails.

Status Required field. Select the status for the web user:

• Active—The web user can log in to VEMS.

• Inactive—The user cannot log in to VEMS and is instructed to contact

the EMS administrator.

• Pending—The web user cannot log in to VEMS and is informed that

he/she must check back at a later time.

Security Template Required field. This determines the web user's access to the system—

the menu items that the user can see and the information that the user 

can view in a tooltip when 'rolling-over' an event in VEMS.

Note: For detailed information about web security templates, see 

“Configuring Web Templates” on page 399.

Time Zone Required field. Select the time zone for the user.

A web process template defines the functions that are available to each type of web 
user in VEMS when the user is submitting a request for a reservation. For detailed 
information about web process templates, see “Configuring Web Templates” on 
page 399.

Field Description
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5. Open the Groups tab and do one of the following to specify the groups on whose behalf
the web user can view and make reservations in VEMS.

• The group (web user) is selected by default. You can leave this group in the Selected
list, or you can select the group and click the Remove button (<).

• Specify any combination of search criteria for the Find field and Group Type, and
then click Display to produce a list of all groups that meet the criteria. In the
Available list, select a group, or CTRL-click to select multiple groups, and then click
the Move button (>) to move the selected groups to the Selected list.

6. Open the Delegates tab, and on the Search by dropdown list, do one of the following to
specify the delegates for the web user:

• Leave the Find field blank, and then click Display to open a list of all currently
available web users. Select a user, or CTRL-click to select multiple web users, and
then click the Move button (>) to move the selected web users to the Selected list.

• On the Search By dropdown list, select the option by which to search (Email
Address or User Name), and in the Find field, enter the string by which to filter your
search, and then click Display. Select a web user, or CTRL-click to select web
multiple users, and then click the Move button (>) to move the selected users to the
Selected list.

7. Optionally, click Spelling to spell check any information that you manually entered for
the web user.

8. Click OK.

The dialog box for creating a web user closes and a message opens indicating that the
web user was created successfully.

9. Click OK to close the message and return to the Groups window.

If you leave the Find field blank, then a list of all currently active groups for the 
selected group type is displayed. If you enter a search string in the Find field, the 
string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, And returns Anderson, Scott, but not Cooper, Anderson. 

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, if searching by Email Address, a search string of bob 
returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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To assign the group to a web user

When you add a new group in your EMS database, you should also assign the group to a web 
user. This web user can then create and view reservations on behalf of the group in VEMS. 
You can assign a group to one or more web users.

1. Open the Groups window and search for the group to which you are assigning the web
user. See “To search for a group and/or contact” on page 277.

2. On the Groups window, select the group, and then click Tools > Assign to Web Users.

The Assign Group dialog box opens.

Figure 7-8:  Assign Group dialog box

3. Do one of the following to select the web users whom you are assigning to the group:

• Leave the Find field blank, and then click Display to open a list of all currently
active web users. Select the web user, or CTRL-click to select multiple web users,
and then click the Move button (>) to move the selected web users to the Selected
list.

• In the Search By dropdown list, select the option by which to search (Email Address
or User Name) and then in the Find field, enter the string by which to filter your
search, and then click Display. Select the web user, or CTRL-click to select multiple
web users, and then click the Move button (>) to move the selected users to the
Selected list.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and the string must begin with the information for which 
you are searching. For example, if searching by Email Address, a search string 
of bob returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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4. Click Finish.

A message opens indicating that the group was assigned successfully.

5. Click OK to close the message and return to the Groups window.

To assign calculations to a group

Calculations are additional charges that can be applied to billable items (a category, a group, 
a group type, a resource, or a room) such as gratuity or sales tax. When you configure a 
group, you can assign the calculations that are to always apply to the group.

1. Open the Groups window and search for the group to which you are assigning the
calculations. See “To search for a group and/or contact” on page 277.

2. On the Groups window, select the group, and then click Open.

A group-specific window opens. The group is automatically selected in the window.

Figure 7-9:  Group-specific window

3. In the left pane of the group-specific window, select Calculations.

The right pane of the group-specific window displays any calculations that have already
been assigned to the group.
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4. Click Edit.

The Calculations dialog box opens.

Figure 7-10: Calculations dialog box

5. On the Available list, select the calculation, or CTRL-click to select the multiple
calculations that are to always apply to this group, and then click the Move button (>) to
move the selected calculations to the Selected list.

6. Continue with any other optional configuration for the group as needed; otherwise, click
OK to close the Calculations dialog box and return to the group-specific window.

If the appropriate calculation is not available, you can configure it. See 
“Configuring Calculations” on page 258.

Remember, you can also assign calculations to a group type. (See “Configuring 
Group Types” on page 47.) If you have already assigned calculations for this 
group’s type, then these calculations are automatically applied to the group. The 
calculations are displayed in the Selected list after you click OK and save the 
group.
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To configure a list of billing reference numbers

You can configure a master list of billing reference numbers that are specific to the group. 

1. Open the Groups window and search for the group for which you are configuring the
master billing reference numbers list. See “To search for a group and/or contact” on page
277.

2. On the Groups window, select the group, and then click Open.

A group-specific window opens. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select Billing References.

A list of all currently active billing reference numbers for the group is displayed in the
right pane of the group-specific window.

4. Optionally, to display all billing reference numbers regardless of status, click Show
Inactive.

Any inactive billing reference numbers are displayed in italics in the right pane.

5. Click New.

The Billing Reference dialog box opens.

Figure 7-11: Billing Reference dialog box

For an example of a group-specific window, see Figure 7-6 on page 284.
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6. Enter the information for the new billing reference number.

7. Optionally, click Spelling to spell check the information for the billing reference number
before you save it.

8. Continue with any other optional configuration for the group as needed; otherwise, click
OK to close the Billing Reference Number dialog box and return to the group-specific
window.

To configure a list of PO numbers

You can configure a master list of PO numbers that are specific to the group. That way, if you 
need to edit the group information, instead of having to manually enter a new or different PO 
number, you can simply select it from this master list.

1. Open the Groups window and search for the group for which you are configuring the
master PO numbers list. See “To search for a group and/or contact” on page 277.

2. On the Groups window, select the group, and then click Open.

A group-specific window open. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select PO Numbers.

A list of all currently active PO numbers for the group is displayed in the right pane of
the group-specific window.

4. Optionally, to display all PO numbers regardless of status, click Show Inactive.

Any inactive PO numbers are displayed in italics in the right pane.

Option Description

Billing Reference 

Number

The billing reference number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the billing reference number.

Notes Any other comments or statements that are applicable for the billing 

reference number.

Inactive Leave this option blank to add the reference as an active reference (the 

billing reference number is to be available when a reservation is made 

for the group). Select this option to inactivate the billing reference 

number.

For an example of a group-specific window, see Figure 7-6 on page 284.
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5. Click New.

The PO Number dialog box opens.

Figure 7-12: PO Number dialog box

6. Enter the information for the new PO number.

7. Optionally, click Spelling to spell check the information for the PO number before you
save it.

8. Continue with any other optional configuration for the group as needed; otherwise, click
OK to close the PO Number dialog box and return to the group-specific window.

Option Description

PO Number The PO number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the PO number.

Notes Any other comments or statements that are applicable for the PO 

number.

Inactive Leave this option blank to add the PO number as an active number (the 

PO number is to be available when a reservation is made for the group). 

Select this option to inactivate the PO number.
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Configuring Contacts

A contact is a person who serves as the coordinator or focal point for a group. You have two 
options for configuring a contact for a group. You can configure a” free form” contact, which 
requires you to manually enter the contact information, or you can configure a contact from 
another group, which means that you do not have to manually enter the contact information. 
Instead, the group information is automatically used for the contact. 

To configure contacts

1. Open the Groups window and search for the group for which you are configuring the
contact. See “To search for a group and/or contact” on page 277.

2. Select the group, and then click Open.

A group-specific window open. The group is automatically selected in the window.

Figure 7-13: Group-specific window

3. In the left pane of the group-specific window, select Contacts.

A list of all currently active contacts for the group is displayed in the right pane of the
group-specific window.

You can also configure and edit a contact “on the fly” during the reservation 
process. See the EMS User’s Manual for details.

Optionally, to display all group contacts regardless of status, click Show Inactive. 
Any inactive contacts are displayed in red italics in the right pane.
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4. Continue to one of the following:

• “To configure a contact manually” below.

• “To configure a contact from a group” on page 298.

To configure a contact manually

1. Click New.

The Contact dialog box opens.

Figure 7-14: Contact dialog box

2. Enter the information for the new contact.

Field Description

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including 

spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected. You cannot 

change this value.

Address Populated with the address of the group that you selected. If the contact 

address is not the same as the group address, then clear Use Group 

Address and enter the appropriate values in the Address fields.

International Select this option to drop the State and Zip fields for an international 

group.
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3. Optionally, do one or both of the following:

• Click Spelling to spell check the information for the contact before you save it.

• Create a web user from the contact. See “To create a web user from a contact” on
page 300.

4. Click OK.

The Contact dialog box closes. The contact is added to the group. The group-specific
window remains open.

Phone 

Fax

The phone number and fax number for the contact. By default, they are 

set to the phone number and fax number for the group, but you can 

always edit these values. 

Note: The Phone and Fax fields have a dropdown list available from 

which you can select a different value (Fax, Mobile, Other, or 

Phone) for the field label, or you can enter a user-defined value. 

To enter a user-defined value, double-click the current field label 

to select it, and then enter the user-defined value over the 

selected label. 

Email Address The email address for the contact.

Note: If your computer is connected to a network, click the Search icon 

 to open a Global Address Lookup dialog box and search for 

the email address.

External Reference Links the contact to an outside program if needed.

Notes Any other information that is pertinent for the contact.

Set as Default Select this option if the contact is to be the default contact for the 

selected group. 

Note: If a default contact has been defined for a group, then when you 

specify the group information for a reservation, the Contact field 

is automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a 

selected group at a later date. To do so, select the contact in the 

right pane of the group-specific window, click Set Default, and 

then click Yes at the prompt to set the selected user as the 

default contact. 

Inactive Leave this option blank to add the contact as an active contact. Select 

this option to inactivate the contact.

Field Description
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To configure a contact from a group

1. Click Tools > Click Create Contact from Another Group.

A second Groups window opens.

2. Search for the group that is to be the source of the contact, and then click Select. (See
“To search for a group and/or contact” on page 277.)

The Contact dialog box opens. The name of the group that you just selected is displayed
in the Group field and you cannot edit this value. The remainder of the fields display the
information for the selected group or user (Contact Name, Address, Phone, and so on.)

Figure 7-15: Contact dialog box

3. If needed, edit the information for the new contact.

Field Description

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including 

spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected first (the group 

for which you are configuring the contact). You cannot change this 

value.

Address Populated with the address of the contact. If the contact address is the 

same as the group address, then select Use Group Address to 

populated the address fields with the group address; otherwise, you can 

edit these values.
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4. Optionally, do one or both of the following:

• Click Spelling to spell check the information for the contact before you save it.

• Create a web user from the contact. See “To create a web user from a contact” on
page 300.

5. Click OK.

The Contact dialog box closes. The contact is added to the group. The group-specific
window remains open.

International Not applicable if Use Group Address is selected. Select this option to 

drop the State and Zip fields from the address for an international 

contact.

Phone 

Fax

The phone number and fax number for the group. 

Note: The Phone and Fax fields have a dropdown list available from 

which you can select a different value (Fax, Mobile, Other, or 

Phone) for the field label, or you can enter a user-defined value. 

To enter a user-defined value, double-click the current field label 

to select it, and then enter the user-defined value over the 

selected label. 

Email Address The email address for the contact.

Note: If your computer is connected to a network, click the Search icon 

 to open a Global Address Lookup dialog box and search for 

the email address.

External Reference Links the contact to an outside program if needed.

Notes Any other information that is pertinent for the contact.

Set as Default Select this option if the contact is to be the default contact for the 

selected group. 

Note: If a default contact has been defined for a group, then when you 

specify the group information for a reservation, the Contact field 

is automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a 

selected group at a later date. See “To edit the contacts for a 

group” on page 304.

Inactive Leave this option blank to add the contact as an active contact. Select 

this option to inactivate the contact.

Field Description
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To create a web user from a contact

A web user is a registered user who can submit requests for reservations or schedule 
reservations in VEMS. When you add a contact to a group in your EMS database, you might 
also need to create a web user from the contact. This web user can then create and view 
reservations on behalf of the contact in VEMS. You can create only one web user from a 
contact. When you create a web user, you can also specify one or more delegates for the web 
user. A delegate is a web user who can create and view reservations on behalf of another web 
user. 

1. If needed, open the group that contains the contact in the group’s specific window. See
“To configure contacts” on page 295.

2. In the left pane of the group-specific window, make sure that Contacts is selected.

3. In the right pane of the window, select the contact from which you are creating the web
user.

4. Click Tools > Create Web User from Contact.

A contact-specific dialog box opens. The Web User tab is the active tab.

Figure 7-16: Contact-specific dialog box, Web User tab

The User Defined Fields tab displays the questions that a web user was required 
to answer when the user requested to create an account through VEMS and it is 
not relevant to the procedure that is described below.
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5. Enter the information for the new web user.

6. Open the Process Templates tab and on the Available list, select the web process
template or CTRL-click to select the multiple templates to which to which you are
assigning the user, and then click the Move button (>) to move the selected templates to
the Selected list.

Ideally, you should enter all the necessary information for your web user before 
you save the web user; however, at any time if you need to access your web user, 
on the EMS menu bar, click Configuration > Web > Web Users.

Field Description

Name Automatically populated after you select the contact.

Password The password that a web user must enter to log in to VEMS.

Email address If this information has been entered for the contact, then this field is 

automatically populated after you select the contact. If the field is blank, 

you must enter the full email address for the user. (The user must enter 

this address to log in to VEMS.)

Phone/Fax Optional fields. If this information has been entered for the contact, then 

these fields are automatically populated after you select the contact. If 

the fields are blank, you can enter values if needed.

Notes Optional field.

External Reference Optional field. Links the web user to an outside program if needed.

Network ID Optional field. The web user’s network ID.

Email Opt Out Select this option if the web user is not to receive automatic emails 

(such as reservation summary emails) from VEMS. The user will still 

receive manually sent emails.

Status Required field. Select the status for the web user:

• Active—The web user can log in to VEMS.

• Inactive—The user cannot log in to VEMS and is instructed to contact

the EMS administrator.

• Pending—The web user cannot log in to VEMS and is informed that

he/she must check back at a later time.

Security Template Required field. This determines the web user's access to the system—

the menu items that the user can see and the information that the user 

can view in a tooltip when 'rolling-over' an event in VEMS.

Note: For detailed information about web security templates, see 

“Configuring Web Templates” on page 399.

Time Zone Required field. Select the time zone for the user.

A web process template defines the functions that are available to each type of web 
user in VEMS when the user is submitting a request for a reservation. For detailed 
information about web process templates, see “Configuring Web Templates” on 
page 399.
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7. Open the Groups tab and do one of the following to specify the groups on whose behalf
the web user can view and make reservations in VEMS.

• The contact’s group is selected by default. You can leave this group in the Selected
list, or you can select the group and click the Remove button (<).

• Specify any combination of search criteria for the Find field and Group Type, and
then click Display to produce a list of all groups that meet the criteria. In the
Available list, select a group, or CTRL-click to select multiple groups, and then click
the Move button (>) to move the selected groups to the Selected list.

8. Open the Delegates tab, and on the Search by dropdown list, do one of the following to
specify the delegates for the web user:

• Leave the Find field blank, and then click Display to open a list of all currently
available web users. Select a web user, or CTRL-click to select multiple web users,
and then click the Move button (>) to move the selected web users to the Selected
list.

• On the Search By dropdown list, select the option by which to search (Email
Address or User Name), and in the Find field, enter the string by which to filter your
search, and then click Display. Select a web user, or CTRL-click to select multiple
web users, and then click the Move button (>) to move the selected web users to the
Selected list.

9. Optionally, click Spelling to spell check any information that you manually entered for
the user.

10. Click OK.

The dialog box for creating a web user closes and a message opens indicating that the
web user was created successfully.

11. Click OK to close the message and return to the group-specific window.

If you leave the Find field blank, then a list of all currently active groups for the 
selected group type is displayed. If you enter a search string in the Find field, the 
string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, a search string of AAA returns AAA Colorado, but not 
Colorado AAA.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, if searching by Email Address, a search string of bob 
returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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Editing Group Information

You can edit any and all information for a group. The way that you edit the information 
depends on the information itself. You can edit the Summary information, the Billing 
information, and the Other information through the Edit function on the group-specific 
dialog box. You must edit the group’s contacts, calculations, billing reference numbers, PO 
numbers, and web users on the group-specific window.

To edit group information

1. Open the Groups window and search for the group for which you are editing the
information. See “To search for a group and/or contact” on page 277.

2. Select the group, and then click Open to open the group in the group-specific window.

The group is selected by default. The Summary tab is the active tab.

Figure 7-17: Group-specific window

3. Continue to one of the following:

• “To edit summary, billing, and/or other group information” on page 304.

• “To edit the contacts for a group” on page 304.

• “To edit the calculations for a group” on page 305.

When you select a configuration item (contacts, reminders, and so on) for editing 
in the group-specific window, the right pane for the window is an EMS browser 
window. See “An EMS Browser Window” on page 33.
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• “To edit the billing reference numbers for a group” on page 305.

• “To edit the PO numbers for a group” on page 306.

• “To edit web users for a group” on page 307.

To edit summary, billing, and/or other group information

1. To edit the summary information, billing information, and/or other information for the
group, click Edit.

The group-specific dialog box opens.

2. Open the appropriate tab, and then edit the information as needed.

See Step 3 and Step 4 of “To configure groups” on page 279.

3. After you edit the information, click OK.

The group-specific dialog box closes. You return to the group-specific window with the
group still selected.

To edit the contacts for a group

1. In the left pane of the group-specific window, select Contacts.

2. In the right pane of the window, select the contact that you are editing, and then do one
of the following:

• To set the selected contact as the default contact for the group, click Set Default, and
then click Yes at the prompt.

• To edit the information for the contact, click Edit.

The Contact dialog box opens. The dialog box displays the information for the
selected contact.

3. Edit the information for the contact as needed. See “To configure a contact manually” on
page 296.

4. Click OK.

The Contact dialog box closes. You return to the group-specific window with Contacts
still selected.
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To edit the calculations for a group

1. In the left pane of the group-specific window, select Calculations, and then click Edit.

The Calculations dialog box opens.

2. Do one or both of the following:

• On the Available list, select the calculation, or CTRL-click to select the multiple
calculations that are to always apply to this group, and then click the Move button
(>) to move the selected calculations to the Selected list.

• On the Selected list, select the calculation, or CTRL-click to select the multiple
calculations that are not to apply to this group, and then click the Remove button (<)
to move the selected calculations to the Available list.

3. After you edit the information, click OK.

The Calculations dialog box closes. You return to the group-specific window with
Calculations still selected.

To edit the billing reference numbers for a group

1. In the left pane of the group-specific window, select Billing References.

2. In the right pane of the window, select the billing reference number that you are editing,
and then click Edit.

The Billing Reference dialog box opens. The dialog box displays the information for the
selected billing reference number.

3. Edit the information for the billing reference number as needed.

If the appropriate calculation is not available, you can configure it. See 
“Configuring Calculations” on page 258.

Remember, you can also assign calculations for a group type. If you have already 
assigned calculations for this group’s type, then these calculations are 
automatically applied to the group. To edit group type calculations, you must 
either edit the calculations at the group type level (see “To configure group types” 
on page 47), or you must edit the group type for the group. See “To edit summary, 
billing, and/or other group information” on page 304.

Option Description

Billing Reference The billing reference number that is associated with the group.

Note: The PO number can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the billing reference number.
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4. Optionally, click Spelling to spell check the information for the billing reference number
before you save it.

5. After you edit the information, click OK.

The Billing Reference Number dialog box closes. You return to the group-specific
window with Billing References still selected.

To edit the PO numbers for a group

1. In the left pane of the group-specific window, select PO Numbers.

2. In the right pane of the window, select the PO number that you are editing, and then click
Edit.

The PO Number dialog box opens. The dialog box displays the information for the
selected PO number.

3. Edit the information for the PO number as needed.

4. Optionally, click Spelling to spell check the information for the billing reference number
before you save it.

5. After you edit the information, click OK.

The PO Number dialog box closes. You return to the group-specific window with PO
Numbers still selected.

Notes Any other comments or statements that are applicable for the billing 

reference number.

Inactive Leave this option blank to add the reference as an active reference (the 

billing reference number is to be available when a reservation is made 

for the group). Select this option to inactivate the billing reference 

number.

Option Description

PO Number The PO number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the PO number.

Notes Any other comments or statements that are applicable for the PO 

number.

Inactive Leave this option blank to add the PO number as an active number (the 

PO number is to be available when a reservation is made for the group). 

Select this option to inactivate the PO number.

Option Description
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To edit web users for a group

When you edit the web users for a group, you can select additional web users for the group, 
or you can remove web users for the group. If you need to edit the web user itself or the 
delegates for a web user, you must do so in the web user configuration area. (See 
“Configuring Web Users” on page 419.)

1. In the left pane of the group-specific window, select Web Users.

The Web Users dialog box opens.

2. Do one or both of the following:

• To add a new web user for the group:

• Leave the Find field blank, and then click Display to open a list of all currently
active web users. Select the web user, or CTRL-click to select multiple web
users, and then click the Move button (>) to move the selected web users to the
Selected list.

• In the Search By dropdown list, select the option by which to search (Email
Address or User Name) and then in the Find field, enter the string by which to
filter your search, and then click Display. Select the web user, or CTRL-click to
select multiple web users, and then click the Move button (>) to move the
selected users to the Selected list.

• To remove a web user from a group, in the Selected field, select the user, or
CTRL-click to select the multiple web users that you are removing from the group,
and then click the Remove button (<) to move the selected web users to the
Available list.

3. After you edit the information, click OK.

The Web User dialog box closes. You return to the group-specific window with Web
Users still selected.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and the string must begin with the information for which 
you are searching. For example, if searching by Email Address, a search string 
of bob returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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Importing Groups

You can import groups into your EMS database from a tab-delimited text file. (See Appendix 
E, “Import File Specifications,” on page 539 for the file specifications.)

To import groups

1. On the toolbar, click the Groups icon . 

The Groups window opens.

Figure 7-18: Groups window

2. Click More, and then click Import Groups.

The Open File dialog box opens.

3. Browse to and select the text file that lists the groups that are importing.

A dialog box opens, indicating the number of groups that you are about to import, and
asking you if you want to continue.

4. Click Yes.

A message opens indicating that the import was successful.

5. Click OK to close the message and return to the Groups window.
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In addition to configuring core data items that are specific to your organization, you must 
configure settings that determine a variety of operational factors for your EMS installation, 
such as system-wide parameters, registration information, email settings, and Reservation 
Wizard required fields. 

This chapter covers the following topics:

• “Editing System Parameters” on page 311.

• “Importing Registration Information” on page 313.

• “Configuring the Confirmation Email Subject Line” on page 315.

• “Configuring Email Settings” on page 316.

• “Configuring Required Fields in the Reservation Wizard” on page 317.
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Editing System Parameters

System parameters are global settings that affect all your EMS users, your Virtual EMS 
(VEMS) users, or your EMS Kiosk users. The parameters are grouped first by system (EMS, 
Virtual EMS (VEMS), or EMS Kiosk) and then by the functional areas that they affect 
(Billing, Email, and so on). When any system is first installed, the parameters are set to their 
default value. Although you can edit the value for a system parameter whenever necessary, 
you typically set the value for a system parameter at the time you are configuring your EMS, 
Virtual EMS (VEMS), and EMS Kiosk implementations. 

To edit system parameters

1. On the EMS menu bar, click System Administration > Settings > Parameters.

The Parameters window opens. This window lists all the current global settings for the
parameters that affect all EMS users (EMS tab), all VEMS users (Virtual tab), and all
EMS Kiosk users (Kiosk tab). The EMS tab is the active tab.

Figure 8-1:  Parameters window, EMS tab

See Appendix A, “System Parameters,” on page 491 for detailed definitions of the 
available system parameters and their default values.
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2. Open the tab that contains the parameter that you are editing.

3. Optionally, filter the list by area, by the parameter description, or both.

4. Select the parameter that you are editing, and then click Edit.

The Parameter dialog box opens. This dialog box displays the information that you can
edit for the selected parameter.

5. Edit the parameter as needed, and then click OK.

The Parameter dialog box closes. You return to the Parameters window with the edited
parameter automatically selected.

6. Confirm in the Value column that you have correctly edited the value for the parameter.

7. Click Close.

• If you edited EMS parameters, you might have to log out and then log back in to
EMS to have the changes take effect.

• If you edited Virtual EMS (VEMS) parameters, a message opens indicating that
virtual parameters have changed, and that you must clear the VEMS cache for the
changes to take affect. Click OK to close the message, and then clear the VEMS
cache by logging in to VEMS, clicking Admin > Admin Functions, and then
clicking Clear Cache.

• If you edited EMS Kiosk parameters, a message opens indicating that kiosk
parameters have changed, and that you must clear the kiosk cache for the changes to
take affect. Click OK to close the message, and then clear the kiosk cache by
opening the EMS Kiosk config.aspx page.

To filter by the parameter description, enter a search string in the Filter field. The 
search string is limited to the exact order of the characters in the string, but the 
string is not case-sensitive, and it can appear anywhere in the search results. For 
example, a search string of Security both Security Status for a User and Default 
Security Template for a User.

See Appendix A, “System Parameters,” on page 491 for detailed definitions of the 
available system parameters and their default values.
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Importing Registration Information

The first time that your EMS application is accessed at your organization, a Registration 
dialog box opens. You must import the license file (License.lic) that was received with the 
software to register your software. You can change the database that your EMS system is 
using.

To import registration information

1. On the EMS menu bar, click System Administration > Settings > Registration.

The Registration dialog box opens. This dialog box displays the registration information 
that is contained in the license file—your organization’s name and address, the EMS 
edition (Enterprise, Professional, and so on), the license expiration date, the limits for 
your software edition, and any additional packages for which your organization is 
licensed (for example, VEMS).

2. If the registration information is correct, then continue to Step 3; otherwise, if the 
information is incorrect, contact sales@emssoftware.com or call 1-800-440-3994 to 
have a corrected license file sent to you.

Figure 8-2:  Registration dialog box

If you need to make any corrections to your registration information, contact 
sales@emssoftware.com or 800-440-3994, ext. 863 to have a license file with the 
corrected registration information sent to you. You can then import this license 
file to update the registration information.
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3. Click Import, and in the Open File dialog box, browse to and select the license file
(License.lic) that you are importing, and then click Open.

The License file is imported.

4. If you need to change the database that your EMS application is using, go to Step 5;
otherwise, click OK.

The Registration dialog box closes. Your EMS application is now registered and is ready
for use.

5. Click Change Database.

The Provide Server Parameters dialog box opens.

Figure 8-3:  Provide Server Parameters dialog box

6. Edit the server name and/or database name, and then click OK.

EMS closes and the EMS Login window opens. You can now log in to EMS using the
newly specified database.
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Configuring the Confirmation Email Subject Line

In EMS, users can produce printed confirmations for events. They can also email 
confirmations directly to the contact person. To make the emailing of confirmations efficient, 
EMS automatically fills in the subject line on the email with text that you configure in the 
Confirmation Email Subject Line dialog box. Examples of confirmation email subject lines 
include the following: 

• Reservation 5421 for Acme, Inc., beginning 3/15/2012

• Confirmation for your event in Smith Hall on 3/22/2012

To configure the confirmation email subject line

1. On the EMS menu bar, click System Administration > Settings > Confirmation Email
Subject Line.

The Confirmation Email Subject Line dialog box opens. This dialog box displays the
confirmation subject line currently in use.

Figure 8-4:  Confirmation Email Subject Line dialog box

2. Enter the text and variables that are to make up the default subject line for every
confirmation that is emailed.

3. Click OK.

Variables pull in selected data from the event for which the confirmation is being 
emailed. You can include variables in the subject line as described in the Legend. 
For example, %2% is the code for the group name, so “Reservation for %2%” 
would result in “Reservation for Academic Affairs” being displayed in the subject 
line. Available variables include the following: Reservation ID, Group Name, 
Event Name, Date of First Booking, Building Code, Room Code, and Location.
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Configuring Email Settings

The system administration email settings determine how your EMS implementation interacts 
with your organization’s email standard—will it interact with Microsoft Outlook or must you 
configure it to use a simple mail transfer protocol (SMTP), which is the default value? After 
installation of your EMS system, you must configure these settings. 

To configure email settings

1. On the EMS menu bar, click System Administration > Settings > Email Settings.

The Email Settings dialog box opens.

Figure 8-5:  Email Settings dialog box

2. Do one of the following:

• Leave the default value of Use SMTP as-is, and then enter the appropriate values for
Mode, Server, and Port in the SMTP Email panel.

• Select Use Microsoft Outlook Only.

• Select SMTP for Mass Email Only Otherwise Use Microsoft Outlook, and then enter
the appropriate values for Mode, Server, and Port in the SMTP Email panel.

• Select Use Lotus Notes. (Available only if Lotus Notes is installed on your
computer.)

3. Click OK.

Select this third option if you want to use Outlook or Lotus Notes for all of your 
individual emails but use the mass email function found in the Browser and the 
Calendar. If you select this option and you use Lotus Notes, then individual emails 
open in the mass email window, but they are still sent via Lotus Notes.
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Configuring Required Fields in the Reservation 

Wizard

To ensure that your users supply the information that is critical for your organization when 
making a reservation, you can configure required fields in the Reservation Wizard. Required 
fields are marked with a red dot in the Reservation Wizard.

To configure required fields in the Reservation Wizard

1. On the EMS menu bar, click System Administration > Settings > Reservation Wizard
Required Fields.

The Reservation Wizard Required Fields dialog box opens. This dialog box lists all the
fields that are available on the Reservation Wizard.

Figure 8-6:  Reservation Wizard Required Fields dialog box

2. On the Available list, select the field or CTRL-click to select the multiple fields that are
to be marked as “Required” in the Wizard, and then click the Move button (>) to move
the selected fields to the Selected list.

3. Click OK.
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In addition to configuring core data items that are specific to your organization, you must 
configure settings that determine a variety of operational factors for your EMS installation, 
including user security settings. These settings determine the functions to which your users 
have access in your EMS installation. 

This chapter covers the following topics:

• “Overview of User Processes” on page 321.

• “Configuring User Accounts” on page 329.

• “Configuring User Templates” on page 343.

• “Configuring Academic User Templates” on page 352.

• “Configuring User Security for Multiple User Accounts” on page 354.
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Overview of User Processes

When you configure a user template or a user account, you must assign one or more 
processes to the template or account. Each process grants a specific permission to the user. 
The following sections detail the event processes or academic event processes that you can 
assign to a user template or account, or an academic user template or account, respectively, 
and the permissions that are granted to the user by each process. 

Event processes

Event processes are categorized according to the following:

• “Billing processes”

• “Configuration processes”

• “Inquiry processes”

• “Report processes”

• “Reservation processes”

• “Special processes”

• “Hoteling processes” (Available only in EMS Workplace)

Billing processes

Before assigning processes to a user template account, read through all the 
processes and note the implied relationships between certain items. For example, 
if you plan to give a user the right to edit a booking, you must also give the user 
the right to open a booking. 

Process Permission Granted

Ageing Report Run the Ageing report.

Browse Transactions Use the Browse Transaction function.

General Ledger Distribution Run the General Ledger Distribution report. 

Invoice Detail Report Run the Invoice Detail report.

Invoicing Run the Billing Worksheet report and generate invoices.

Payments, Deposits & 

Adjustments

Enter payments, deposits, and adjustments.

Reprint an Invoice Reprint an existing invoice.

Statements Print financial statements for groups.

Transaction Report Print the Transaction report.

Void an Invoice Void an existing invoice.

Voided Transaction Report Print the Voided Transaction report.
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Configuration processes

Inquiry processes

Report processes

Process Permission Granted

Configure Web Template 

LDAP Groups 

Shows the LDAP Groups tab in the Web Process Template settings 

window. 

Warning: This tab reveals the names of your Active Directory or 

other LDAP-type Groups. 

Define and Edit 

[Configuration Item]

Add, change, or delete indicated configuration item. For example, 

Define & Edit Accounts provides add, change, or delete rights to the 

Accounts that are configured in your system.

Resource category items 

[Category Name]

Resource categories that you have defined are also included as 

Configuration processes. Add, change, or delete resources from the 

selected categories.

Web Data Translation Allows a user to provide translations for items on the web.

Process Permission Granted

Browse Reservations Use the Browser to search for existing reservations, bookings, 

service orders, and resources.

Calendar Inquiry View the Calendar Inquiry, which shows the number of bookings on 

each day of a month in a wall calendar-type format. 

Open Reservation Book View the Reservation Book, which displays bookings for a day, 

week, or month as colored bars on a room/timeline grid.

Resource Calendar Inquiry View the Resource Calendar, which shows, on a monthly calendar, 

the number of times an item is reserved.

Visitors Open the Visitors browser, which lists attendees by date and 

identifies visitors as such. 

Report Name Permission Granted

< > Report Run, review, and print the indicated report.

Define and Edit Queries Create and edit the queries that have been created in the Query 

Builder.
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Reservation processes

Special processes

Process Permission Granted

Academic Import 

(Academic Import 

Module) 

Run the Academic Import Utility, which you use to manually import an 

academic course schedule into EMS.

Attendance Entry Use the Attendance Entry function to note the actual attendance for 

bookings that took place on a particular date.

Delete Attachments Give a user the ability to delete attachments for a room record, a 

reservation, a booking, or a group.

Email History Review email history.

Manage Services Give a user access to Manage Services option on the EMS toolbar and 

under the Reservations menu.

Open Navigator Open a reservation in the Navigator window.

Open Reservation 

Wizard 

Create a single-date or series reservation using the Reservation Wizard. 

This process also provides read-only access to groups. 

Reminders Use the Dashboard to add and manage reminders.

Process Permission Granted

Allow Department 

Selection 

Select any of the defined departments when billing. 

Copy Reservation Copy a reservation, including all its bookings and details, from one date 

or date range, to another reservation.

Define Public Memorized 

Reports

Define the settings for public memorized reports.

EMS API Web Service 

Access

Used for optional EMS API.

Explode Combo Room Use the Explode Combination Bookings utility, which takes the booking 

of combination room and breaks it down into bookings for the 

components of the combination room.

Edit Booking Details Add or edit booking detail information.

Edit Critical Booking 

Information

Edit booking information that could cause one booking to be in conflict 

with another. The critical booking data items are date, reserved time, 

room, and status.

Edit Non-Critical Booking 

Information 

Edit booking information that will not cause one booking to be in conflict 

with another (for example, the event name or the setup type and count).

Edit Pricing Change the pricing on a booking detail item that has been reserved.

Edit Reservation 

Information 

Edit reservation information. 
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Web processes (Web Admin and Web Request)

Hoteling processes

View and Book Access 

On All Rooms

Grants rights to an EMS user for all rooms without having to explicitly 

provide access on the Rooms tab.

Note: This overrides any selections that have been made in the Room 

Access area.

Process Permission Granted

Define and Edit Web 

Cultures

Define and edit web cultures (the languages that are available for 

translation) in VEMS.

Define and Edit Web Menus Define and edit web menus, including the creation and modification 

of links from VEMS to other web pages.

Define and Edit Web Process 

Templates 

Define users’ access to process templates that are used in VEMS.

Define and Edit Web Security 

Templates 

Define users’ access to security templates that are used in VEMS.

Define and Edit Web Text Define and edit web help text, page labels, and so on.

Define and Edit Web Users Define and edit the users who have access to VEMS.

Web Reservations Run the Web Reservations Browser, which displays reservations 

entered into your EMS database through VEMS. 

For detailed information about each of the listed reports, see the EMS User’s 
Manual.

Process Permission Granted

Booking Notice Statistics Run, review and print the Booking Notice Statistics report.

Check In Status Run the Check In Status utility, which allows users to 

determine whether a group has checked in (or out) at your 

facility. 

Check In Statistics Run, review and print the Check In Statistics report.

Define and Edit Reservation 

Wizard Templates

Add, change, or delete reservation wizard templates.

Early Check Out Report Run, review and print the Early Check Out Report.

Arrivals and Departures Report Run the Arrivals and Departure report, which lists the 

respective arrival and departure times for each booking.

Groups With Multiple Bookings Run, review and print the Groups With Multiple Bookings 

report.

No Show Report Run, review and print the No Show Report.

Process Permission Granted
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Academic event processes

Academic event processes are categorized according to the following:

• “Administrative processes”

• “Campus Planning Interface processes”

• “Configuration processes”

• “Course processes”

• “Inquiry processes”

• “Report processes”

Administrative processes

No Show Wizard Run the No Show Wizard. 

Room Occupancy Summary Run, review and print the Room Occupancy Summary report.

Transition Report Run, review and print the Transition report.

Visitor Report Run, review and print the Visitor report.

Process Permission Granted

Process Permission Granted

Administrative processes

Allow Domain Selection Allows the user to select from all domains that are configured in the 

Academic planning area.

Copy Term Preferences Allows a user to copy course preferences from one term to 

another.

Define and Edit Domains Create and/or edit domains within the Academic Planning-

Configuration area of EMS Campus.

Define and Edit Final Exam 

Schedule Templates

Allows the user to create or make changes to the Final Exam 

Schedule template.

Define and Edit Final Exam 

Sessions

Allows the user to create and publish final exam sessions.

Define and Edit Optimization 

Scenarios

Allows the user to create and apply an optimization scenario.

Edit Terms Allows the user to edit the mode of a term.

Manually Update SIS Allows the user to manually push location updates back to the SIS, 

assuming that this has not been automated in the system 

parameters.
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Campus Planning Interface processes

Configuration processes

Course processes

Publish/Unpublish Terms Allows the user to publish a term and create room reservations in 

EMS or unpublish a term and delete room reservations in EMS.

Process Permission Granted

Web Administrator Grants access to the administrative functions after the user is 

logged in to the Campus Planning Interface client.

Process Permission Granted

Configuration

Define and Edit Academic 

Units

Allows the user to add or edit academic units.

Define and Edit Course 

Types

Allows the User to assign course types to event types.

Define and Edit Instructors Allows the user to set the importance level of synchronized 

instructors.

Match Course Type/Room 

Types

The user can match a course type to a room type (or vice-versa) 

for course optimization.

Synchronize Academic Unit User can synchronize the specified item from the SIS.

Synchronize Buildings User can synchronize the specified item from the SIS.

Synchronize Course Types User can synchronize the specified item from the SIS.

Synchronize Courses User can synchronize the specified item from the SIS.

Synchronize Instructors User can synchronize the specified item from the SIS.

Synchronize Room Types User can synchronize the specified item from the SIS.

Synchronize Rooms User can synchronize the specified item from the SIS.

Synchronize Subjects User can synchronize the specified item from the SIS.

Synchronize Terms User can synchronize the specified item from the SIS.

Process Permission Granted

Add Courses Allows the user to add new courses during Define & Edit mode or 

Dual mode.

Add Sections Allows the user to create a new section of an existing course (copy 

courses) during Define & Edit mode or Dual mode.

Edit Course Credit Hours User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Process Permission Granted
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Edit Course Days of the 

Week

User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Enrollment User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Instructor User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Notes User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Number User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Seat Fill User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Section User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Start/End Dates User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Start/End Times User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Subject User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Title User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit Course Type User can edit the specified course detail during Define & Edit mode 

or Dual mode.

Edit/Cancel Courses The user edit or cancel existing courses during Define & Edit mode 

or Dual mode.

Override Time Block Patterns The user can edit the Time Block for a term during Define & Edit 

mode or Dual mode.

Preassign Scenarios The user can create and run Preassignment optimization scenarios 

during Set Preferences mode or Dual mode.

Search for Rooms The user can search for rooms during Define & Edit mode or Dual 

mode.

Set Preferences The user can set preferences for the course (for optimization) 

during Set Preferences mode or Dual mode.

Set Specific Room 

Preferences

The user can choose a specific room in Set Preferences mode or 

Dual mode.

Share Space Across 

Domains

The user can share space between two courses on different 

domains during Define & Edit mode or Dual mode.

Share/Unshare Space The user can share space (or unshare space) between two 

courses on the same domain during Define & Edit mode or Dual 

mode.

Process Permission Granted
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Inquiry processes

Report processes

Process Permission Granted

Academic Book The user can access the Academic Book.

Academic Browser The user can access the Academic Browser.

Open Course Navigator The user can open a course in the Navigator window.

Report Name Permission Granted

< > Report User can run and print the indicated report.
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Configuring User Accounts

Users are the people who log in to EMS, whether they are making reservations or just using 
the system in a read-only capacity. When your EMS application is first installed, it is 
installed with a default user admin account with “admin” for both the User ID and password. 
As DEA recommends, for security reasons, after you log in to EMS the first time using 
“admin” as both the username and password, at a minimum, you should change the account 
password. Ideally, you should configure an entirely new administrator account with a new 
username and password. You must also configure all the necessary accounts for your users, 
which includes assigning processes to the user account. You can create user accounts entirely 
from “scratch,” or you can copy an existing user account, and then make the necessary edits 
to the account for another user. You can also export a list of all your user accounts to an 
Excel spreadsheet.

To configure a user account

1. On the EMS menu bar, click System Administration > Security > Users.

The Users window opens. This window lists the names and types for all users who
currently have an account for your EMS installation and that have a status of Active.

Figure 9-1:  Users window

Instead of configuring user accounts individually, you can configure a template 
and then assign all users who are to have the same security settings to a given user 
template. See “Configuring User Templates” on page 343 and “Configuring 
Academic User Templates” on page 352.

Optionally, to show all user accounts, regardless of status, under Show, click 
Inactive.
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2. Click New.

The User dialog box opens.

Figure 9-2:  User dialog box

3. Enter the information for the new user and define the user access for each of the
following—categories, processes, building configuration, room access, statuses and
queries, and for EMS Campus, academic properties and processes as well. See:

• “User information” on page 331.

• “Event Properties” on page 332.

• “Categories” on page 333.

• “Processes” on page 334.

• “Configure Buildings” on page 335.

• “Room Access” on page 336.

• “Statuses” on page 338.

• “Queries” on page 339.

• “Academic Properties (EMS Campus Only)” on page 340.

• “Processes (EMS Campus Only)” on page 341.

The remainder of this procedure describes how to configure a user account “from 
scratch.” You can also configure a user account by copying an existing account. 
Select the user account that you want to copy, click Copy, and then continue to 
Step 3.
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4. Click OK.

The User dialog box closes. You return to the Users window with the newly configured
user automatically selected.

User information

1. If needed, open the User dialog box (see “To configure a user account” on page 329),
and then make sure that User is selected.

2. Enter the user information.

At a minimum, to create a new user account, you must enter the user name, the 
user type, and the user ID and password. All other information is optional and can 
be added at later dates when needed. 

Field Description

Name First and last name for the user.

Administrator Select this option if the user is to be an EMS administrator. 

Note: If you select this option, then only Event Properties remains 

displayed on the User dialog box as an EMS administrative user 

has access to all EMS functions (categories, processes, 

buildings, rooms, statuses, and queries).

Initials The user’s initials, which are printed at the bottom of all reports as well 

as the date and time that the user ran the report.

Login

User ID The ID that the user must use to log in to EMS.

Note: The User ID must be 20 characters or less, including spaces.

Password The password that the user must use to log in to EMS.

Note: The user can change this password. See the EMS User’s 
Manual.

Network ID If you enter a value in this field, the user is automatically logged in to 

EMS based on the user’s Windows credentials without being asked to 

enter a user ID and password. 

Note: Enter the network domain along with the network ID, such as 

DOMAIN\john.doe.

External Reference Links the user account to an outside program, if needed.

Contact Information

Phone The phone number for the user. This value is not printed on any 

correspondence (reports, emails, and so on) from the user.

Fax The fax number for the user. This value is not printed on any 

correspondence (reports, emails, and so on) from the user.

Email Address The email for the user. This value is not printed on any reports that the 

user generates; however, this is a required value if the user wants to 

email reports or confirmations from EMS using the SMTP email option.
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3. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.

Event Properties

1. If needed, open the User dialog box. (See “To configure a user account” on page 329.)

2. Select Event Properties.

The User dialog box is refreshed with options for the event security settings for the user.

Figure 9-3:  User dialog box, Event Properties

Job Information

Title The user’s title, such as Mr., Ms., and so on.

Notes Any additional information that is relevant to the user. 

Note: This information is not printed on any report.

Inactive Leave this option blank to add the user as an active user. Select this 

option to inactive the user’s account. An inactive user cannot log in to 

EMS.

Field Description
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3. Specify the event security settings for the user.

4. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.

Categories

You specify the categories that a user can add to a booking or edit for a booking on the 
Categories tab.

1. If needed, open the User dialog box. (See “To configure a user account” on page 329.)

2. Select Categories.

The User dialog box is refreshed with a list of all the active categories that you can select
for the user.

Figure 9-4:  User dialog box, Categories 

Field Description

Event Properties

Template If you select a template, then only the Event Properties options remain 

available. The categories, processes, buildings, rooms, statuses, and 

queries are automatically assigned to the user based on the selected 

template. See “Configuring User Templates” on page 343.

Defaults—All the values that you select here (Building, Status, Event Type, Event Name, Event 

Time, Reservation Source, and Time Zone) are displayed by default when the user opens the 

Reservation Wizard to make a reservation; however, the user can edit any and all values as 

needed.
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3. On the Available list, select the category or CTRL-click to select the multiple categories
to which a user is to have access, and then click the Move button (>) to move the
selected categories to the Selected list.

4. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.

Processes

1. If needed, open the User dialog box. (See “To configure a user account” on page 329.)

2. Select Processes.

The User dialog box is refreshed with a list of all the processes that you can select for the
user.

Figure 9-5:  User dialog box, Processes 

3. On the Available list, select the process or CTRL-click to select the multiple processes to
which a user is to have access, and then click the Move button (>) to move the selected
processes to the Selected list.

4. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.

 To add these categories to a booking, a user needs access to the Edit Booking 
Details process.

For an explanation of each process, see “Event processes” on page 321.
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Configure Buildings

You specify the building configuration rights for a user on the Buildings tab.

1. If needed, open the User dialog box. (See “To configure a user account” on page 329.)

2. Select Configure Buildings.

The User dialog box is refreshed with a list of all the buildings that you can select for the
user.

Figure 9-6:  User dialog box, Buildings

3. On the Available list, select the building or CTRL-click to select the multiple buildings
to which a user is to have access, and then click the Move button (>) to move the
selected buildings to the Selected list.

4. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.

Define and Edit Buildings and Define and Edit Rooms security processes are 
required for a user to have configuration access to selected buildings. 
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Room Access

You specify the rooms to which a user has access on the Room Access tab.

1. If needed, open the User dialog box. (See “To configure a user account” on page 329.)

2. Select Room Access.

The User dialog box is refreshed a options for searching for the rooms to add to the user
account.

Figure 9-7:  User dialog box, Room Access

3. Search for the rooms to which the user is to have access by doing one or both of the
following:

• On the Building dropdown list, select (all) buildings, a specific building, an area, or
a view.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

The Available list is updated with a list of rooms that meet your search criteria.
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4. On the Available list, select the room or CTRL-click to select the multiple rooms to
which a user is to have access, and then click the Move button (>) to move the selected
rooms to the appropriate Selected list.

• View and Book—A user who has access to the Special - Edit Critical Booking
Information process and who is assigned to this option can reserve the room, move
an event into or out of the room, change the time or status of an event that is
scheduled in the room, and add resources to events in the room.

• View Only—A user who is assigned to this option cannot reserve the room, move an
event into or out of the room, or change the time or status of an event that is
scheduled in the room; however, as long as the user has access to the appropriate
category and to the Special - Edit Booking Details process, the user can view events
in the room and add resources to events in the room.

5. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.

EMS Enterprise has both the View and Book and the View Only access for user 
security. EMS Professional has just the View and Book access for user security.

 The Special - View and Book Access On All Rooms process can be used as an 
alternative to manually assigning all rooms to the View and Book list.
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Statuses

You select the statuses to which a user is to have access on the Statuses tab. A user needs 
access to a status in order to create a reservation with the status or edit a booking with the 
status.

1. If needed, open the User dialog box. (See “To configure a user account” on page 329.)

2. Select Statuses.

The User dialog box is refreshed with a list of all the active event statuses that you can
select for the user.

Figure 9-8:  User dialog box, Statuses 

3. On the Available list, select the status or CTRL-click to select the multiple statuses to
which a user is to have access, and then click the Move button (>) to move the selected
statuses to the Selected list.

4. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.
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Queries

You specify the queries that a user can run on the Queries tab.

1. If needed, open the User dialog box. (See “To configure a user account” on page 329.)

2. Select Queries.

The User dialog box is refreshed with a list of all the defined queries that you can select
for the user account.

Figure 9-9:  User dialog box, Queries

3. On the Available list, select the query or CTRL-click to select the multiple queries to
which a user is to have access, and then click the Move button (>) to move the selected
queries to the Selected list.

4. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.

You can specify the queries to run by user only in EMS Enterprise. All queries are 
available to all users in EMS Professional.
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Academic Properties (EMS Campus Only)

1. If needed, open the User dialog box. (See “To configure a user account” on page 329.)

2. Select Academic Properties.

The User dialog box is refreshed with options for the academic security settings for the
user.

Figure 9-10: User dialog box, Academic Properties (EMS Campus only)

3. Specify the academic security settings for the user.

4. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.

Field Description

Type • Domain—The domain (typically renamed to campus or school) to

which the user belongs.

• Academic Unit—The academic unit (typically renamed to academic

department or division) to which the user belongs.

Domain The domain to which the user belongs.

Academic Unit Available only if the user is assigned the type of “Academic Unit.” The 

academic unit to which the user belongs.

Template The academic template to which the user is assigned. The template 

determines the academic processes to which the user has access. See 

“Configuring Academic User Templates” on page 352.
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Processes (EMS Campus Only)

1. If needed, open the User dialog box. (See “To configure a user account” on page 329.)

2. Select Processes (under Academic Properties).

The User dialog box is refreshed with a list of all the academic processes that you can
select for the user.

Figure 9-11: User dialog box, Academic Processes (EMS Campus only)

3. On the Available list, select the academic process or CTRL-click to select the multiple
academic event processes to which a user is to have access, and then click the Move
button (>) to move the selected processes to the Selected list.

4. Continue with any other configuration for the user as needed; otherwise, click OK to
close the User dialog box and return to the Users window with the newly configured user
automatically selected in the window.

For an explanation of each process, see “Academic event processes” on page 325.
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To export a list of user accounts

1. On the EMS menu bar, click System Administration > Security > Users.

The Users window opens. This window lists the names and types for all users who
currently have an account for your EMS installation.

2. Click Export.

The Save As dialog box opens. The default file name is User List.

3. Optionally, change the file name, and save the file in a location of your choosing.

The default file type is Microsoft Excel Workbook (*.xls) and you cannot change 
this.
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Configuring User Templates

Users are the people who log on to EMS, whether they are making reservations or just using 
the system in a read-only capacity. A user template defines the categories, processes, 
buildings, rooms, statuses, and queries to which a group of EMS users has access. Instead of 
defining users individually and then configuring security for each user, you can configure a 
template and then assign all the users who are to have the same security settings to a given 
template in a single step. You can configure a user template user entirely from “scratch,” or 
you can copy an existing user template, and then make the necessary edits to configure 
another template. 

To configure a user template

1. On the EMS menu bar, click System Administration > Security > User Templates.

The User Templates window opens. This window lists all the user templates that are
currently configured in your EMS database and that have a status of Active.

Figure 9-12: User Templates window

If the EMS users who are to have the same security settings are also EMS Campus 
users, then you must also define academic user templates for these users. See 
“Configuring Academic User Templates” on page 352.

Optionally, to show all templates, regardless of status, under Show, click Inactive.
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2. Click New.

The User Template dialog box opens.

Figure 9-13: User Template dialog box

3. In the Description field, enter a name or description for the new user template.

4. Defining the user access for each of the following—categories, processes, building
configuration, room access, statuses and queries. See:

• “Categories” on page 345.

• “Processes” on page 346.

• “Configure Buildings” on page 347.

• “Room Access” on page 348.

• “Statuses” on page 350.

• “Queries” on page 351.

5. Click OK.

The User Template dialog box closes. You return to the User Templates window with the
newly configured template automatically selected.

The remainder of this procedure describes how to configure a user template “from 
scratch.” You can also configure a user template by copying an existing template. 
Select the user template that you want to copy, click Copy, and then continue to 
Step 3.

The name or description can be a maximum of 50 characters, including spaces.
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Categories

You specify the categories that a user who is assigned to this template can add to a booking 
or edit for a booking on the Categories tab.

1. If needed, open the User Template dialog box. (See “To configure a user template” on
page 343.)

2. Select Categories.

The User Template dialog box is refreshed with a list of all the active categories that you
can select for the user template.

Figure 9-14: User Template dialog box, Categories 

3. On the Available list, select the category or CTRL-click to select the multiple categories
to which a user is to have access, and then click the Move button (>) to move the
selected categories to the Selected list.

4. Continue with any other configuration for the template as needed; otherwise, click OK to
close the User Template dialog box and return to the User Templates window with the
newly configured user template automatically selected in the window.

 To add these categories to a booking, a user needs access to the Edit Booking 
Details process.
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Processes

1. If needed, open the User Template dialog box. (See “To configure a user template” on
page 343.)

2. Select Processes.

The User Template dialog box is refreshed with a list of all the processes that you can
select for the user template.

Figure 9-15: User Template dialog box, Processes 

3. On the Available list, select the process or CTRL-click to select the multiple processes to
which a user is to have access, and then click the Move button (>) to move the selected
processes to the Selected list.

4. Continue with any other configuration for the template as needed; otherwise, click OK to
close the User Template dialog box and return to the User Templates window with the
newly configured user template automatically selected in the window.

For an explanation of each process, see “Event processes” on page 321.
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Configure Buildings

You select the building configuration rights for a user who is assigned to this template on the 
Buildings tab.

1. If needed, open the User Template dialog box. (See “To configure a user template” on
page 343.)

2. Select Buildings.

The User Template dialog box is refreshed with a list of all the buildings that you can
select for the user template.

Figure 9-16: User Template dialog box, Buildings 

3. On the Available list, select the building or CTRL-click to select the multiple buildings
to which a user is to have access, and then click the Move button (>) to move the
selected buildings to the Selected list.

4. Continue with any other configuration for the template as needed; otherwise, click OK to
close the User Template dialog box and return to the User Templates window with the
newly configured user template automatically selected in the window.

Define and Edit Buildings and Define and Edit Rooms security processes are 
required for a user to have configuration access to selected buildings and/or 
rooms. 
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Room Access

You specify the room access for a user who is assigned to this template on the Room Access 
tab.

1. If needed, open the User Template dialog box. (See “To configure a user template” on
page 343.)

2. Select Room Access.

The User Template dialog box is refreshed a options for searching for the rooms to add
to the user template.

Figure 9-17: User Template dialog box, Rooms 

3. Search for the rooms to which to add to the user template by doing one or both of the
following:

• On the Building dropdown list, select (all) buildings, or select a specific building.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

The Available list is updated with a list of rooms that meet your search criteria.
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4. On the Available list, select the room or CTRL-click to select the multiple rooms to
which a user is to have access, and then click the Move button (>) to move the selected
rooms to the appropriate Selected list.

• View and Book—A user who has access to the Special - Edit Critical Booking
Information process and who is assigned to this template can reserve the room,
move an event into or out of the room, change the time or status of an event that is
scheduled in the room, and add resources to events in the room.

• View Only—A user who is assigned to this template cannot reserve the room, move
an event into or out of the room, or change the time or status of an event that is
scheduled in the room; however, as long as the user has access to the appropriate
category and to the Special - Edit Booking Details process, the user can view events
in the room and add resources to events in the room.

5. Continue with any other configuration for the template as needed; otherwise, click OK to
close the User Template dialog box and return to the User Templates window with the
newly configured user template automatically selected in the window.

EMS Enterprise has both the View and Book and the View Only access for user 
security. EMS Professional has just the View and Book access for user security.

 The Special - View and Book Access On All Rooms process can be used as an 
alternative to manually assigning all rooms to the View and Book list.
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Statuses

You specify the statuses to which a user who is assigned to this template is to have access on 
the Statuses tab. A user needs access to a status in order to create a reservation with the status 
or edit a booking with the status.

1. If needed, open the User Template dialog box. (See “To configure a user template” on
page 343.)

2. Select Statuses.

The User Template dialog box is refreshed with a list of all the active event statuses that
you can select for the user template.

Figure 9-18: User Template dialog box, Statuses 

3. On the Available list, select the status or CTRL-click to select the multiple statuses to
which a user is to have access, and then click the Move button (>) to move the selected
statuses to the Selected list.

4. Continue with any other configuration for the template as needed; otherwise, click OK to
close the User Template dialog box and return to the User Templates window with the
newly configured user template automatically selected in the window.
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Queries

You specify the queries that a user who is assigned to this template can run on the Queries 
tab.

1. If needed, open the User Template dialog box. (See “To configure a user template” on
page 343.)

2. Select Queries.

The User Template dialog box is refreshed with a list of all the defined queries that you
can select for the user template.

Figure 9-19: User Template dialog box, Queries

3. On the Available list, select the query or CTRL-click to select the multiple queries to
which a user is to have access, and then click the Move button (>) to move the selected
queries to the Selected list.

4. Continue with any other configuration for the template as needed; otherwise, click OK to
close the User Template dialog box and return to the User Templates window with the
newly configured user template automatically selected in the window.

You can specify the queries to run by user only in EMS Enterprise. All queries are 
available to all users in EMS Professional.
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Configuring Academic User Templates

If the EMS users who are to have the same security settings are also EMS Campus users, 
then you must configure academic user templates for these users. An academic user template 
defines the academic event processes to which a group of EMS Campus users has access. 
Instead of defining campus users individually and then configuring security for each user, 
you can configure a template and then assign all the users who are to have the same security 
settings to a given template in a single step. You can configure an academic user template 
user entirely from “scratch,” or you can copy an existing academic user template, and then 
make the necessary edits to configure another template. 

To configure an academic user template

1. On the EMS menu bar, click System Administration > Security > Academic User
Templates.

The Academic User Templates window opens. This window lists all the academic user
templates that are currently configured in your EMS database and that have a status of
Active.

Figure 9-20: Academic User Templates window

2. Click New.

Optionally, to show all templates, regardless of status, under Show, click Inactive.

The remainder of this procedure describes how to configure an academic user 
template “from scratch.” You can also configure an academic user template by 
copying an existing template. Select the academic user template that you want to 
copy, click Copy, and then go to Step 3.
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The Academic User Template dialog box opens. 

Figure 9-21: Academic User Template dialog box

3. In the Description field, enter a name or description for the new academic user template.

4. Select Processes, and define the user access for the appropriate academic processes.

5. Click OK.

The Academic User Template dialog box closes. You return to the Academic Users
Template window with the newly configured template automatically selected.

The name or description can be a maximum of 30 characters, including spaces.

For an explanation of each process, see “Academic event processes” on page 325.
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Configuring User Security for Multiple User 

Accounts

If you configure users individually (that is, you are not using user templates) and you need to 
mass assign security to multiple users (for example, you have added a new room and many 
of your users need access to the room), then you can use the User Security function. You can 
use the User Security function to mass assign security for categories, processes, rooms, and 
statues for multiple users that have been individually configured.

To configure user security for multiple user accounts

1. On the EMS menu bar, click System Administration > Security > User Security.

The User Security dialog box opens.

Figure 9-22: User Security dialog box

2. On the Type dropdown list, select the item for which you are configuring user security—
Category, Process, Room, or Status, and then continue to one of the following:

• “To configure mass user security for a category” on page 355.

• “To configure mass user security for a process” on page 356.

• “To configure mass user security for a room” on page 357.

• “To configure mass user security for a status” on page 358.

If you need to mass assign security for queries to multiple users, you can do so 
from within the Query Builder itself. See the EMS User’s Manual for detailed 
information.
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To configure mass user security for a category

1. On the Category dropdown list, select the specific category for which you are
configuring user security.

The User Security dialog box is refreshed with a list of all individual users who do not
have access to the selected category (the left Users list), and a list of all individual users
who do have access to the selected category (the right Users list). All administrator users
are displayed as well. (By default, an administrator user has access to all categories in an
EMS database, and therefore, this list is not enabled.)

Figure 9-23: User Security dialog box, Categories

2. On the left Users list, select the user, or CTRL-click to select the multiple users who are
to have access to the selected category, and then click the Move (>) button to move the
selected users to the right Users list.

3. Continue with any other security configuration as needed; otherwise, click Close to close
the User Security dialog box.
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To configure mass user security for a process

1. On the Process dropdown list, select the specific process for which you are configuring
user security.

The User Security dialog box is refreshed with a list of all individual users who do not
have access to the selected process (the left Users list), and a list of all individual users
who do have access to the selected process (the right Users list). All administrator users
are displayed as well. (By default, an administrator user has access to all processes in an
EMS database, and therefore, this list is not enabled.)

Figure 9-24: User Security dialog box, Processes

2. On the left Users list, select the user, or CTRL-click to select the multiple users who are
to have access to the selected process, and then click the Move (>) button to move the
selected users to the right Users list.

3. Continue with any other security configuration as needed; otherwise, click Close to close
the User Security dialog box.
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To configure mass user security for a room

1. On the Building dropdown list, select a building, and then on the Room dropdown list
select the specific room in the building for which you are configuring user security.

The User Security dialog box is refreshed with a list of all individual users who do not
have access to the selected room (the left Users list), a list of all individual users who
have View and Book access to the selected room and a list of all individual users who
have View Only access to the room. All administrator users are displayed as well. (By
default, an administrator user has access to all processes in an EMS database, and
therefore, this list is not enabled.)

Figure 9-25: User Security dialog box, Rooms

2. On the left Users list, select the user, or CTRL-click to select the multiple users who are
to have access to the selected room, and then click the Move (>) button to move the
selected users to the appropriate Users list.

• View and Book—A user who has access to the Special - Edit Critical Booking
Information process and who is assigned to this option can reserve the room, move
an event into or out of the room, change the time or status of an event that is
scheduled in the room, and add resources to events in the room.

• View Only—A user who is assigned to this option cannot reserve the room, move an
event into or out of the room, or change the time or status of an event that is

EMS Enterprise has both the View and Book and the View Only access for user 
security. EMS Professional has just the View and Book access for user security.

 The Special - View and Book Access On All Rooms process can be used as an 
alternative to manually assigning all rooms to the View and Book list.
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scheduled in the room; however, as long as the user has access to the appropriate 
category and to the Special - Edit Booking Details process, the user can view events 
in the room and add resources to events in the room. 

3. Continue with any other security configuration as needed; otherwise, click Close to close
the User Security dialog box.

To configure mass user security for a status

1. On the Status dropdown list, select the specific status for which you are configuring user
security.

The User Security dialog box is refreshed with a list of all individual users who do not
have access to the selected status (the left Users list), and a list of all individual users
who do have access to the selected status (the right Users list). All administrator users
are displayed as well. (By default, an administrative user has access to all statuses in an
EMS database, and therefore, this list is not enabled.)

Figure 9-26: User Security dialog box, Statuses

2. On the left Users list, select the user, or CTRL-click to select the multiple users who are
to have access to the selected status, and then click the Move (>) button to move the
selected users to the right Users list.

3. Continue with any other security configuration as needed; otherwise, click Close to close
the User Security dialog box.
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You have several tools at your disposal in EMS to assist you in your administrative duties. 
These include a tool to update various group attributes such as pricing plans or account 
name, managing memorized reports, viewing logged-in users and if necessary, log these 
users off your EMS system, emailing logged-in users, deleting old data in your EMS 
database, and so on. 

This chapter covers the following topics:

• “Change Group Wizard” on page 361.

• “Change Reservation Wizard” on page 363.

• “Room Administration Wizard” on page 366.

• “Managing Memorized Reports” on page 372.

• “Override Existing Bookings Utility” on page 374.

• “Import Reservations Utility” on page 377.

• “Viewing and Emailing Logged-In Users” on page 383.

• “Currency Configuration Wizard” on page 385.

• “Deleting Old Data” on page 394.

• “Changing Booking Dates and/or Statuses” on page 389.

• “Migrating Data” on page 396.

For detailed information the Video Display Interface tool, see Appendix C, “Video 
Display Interface,” on page 521.
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Change Group Wizard

You use the Change Group Wizard to update various group attributes. You can reassign an 
account, an event coordinator, a group type, a payment type, a pricing plan, a sales category, 
or a salesperson. 

To use the Change Group Wizard

1. On the EMS menu bar, click System Administration > Tools > Change Group Wizard.

The Change Group Wizard opens.

Figure 10-1: Change Group Wizard

2. Select Account (the property to change), and then click Next.

You are prompted to select an account to change.

Figure 10-2: Change Group Wizard

The following procedure is written from the perspective of changing an account, 
but by analogy, you can follow this procedure to change any of the allowed 
properties for your group records.



362

 
System Administration Tools

3. Select the account that you want to change, for example Equipment Charges.

The Change Group Wizard is updated with information that indicates the number of
groups that use the account that you are changing.

Figure 10-3: Change Group Wizard

4. Click Next.

The Change Group Wizard prompts you to select an account to replace all instances of
Equipment Charges.

Figure 10-4: Change Group Wizard

5. Select the appropriate account, for example, Denver A/V, and then click Finish.

A Property Changed message opens, indicating that the property was changed, and the
number of groups that were affected.

6. Click OK to close the message and the Change Group Wizard.
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Change Reservation Wizard

You use the Change Reservation Wizard to change various properties for all reservations or 
all future reservations with bookings after a specific date in a single step. You can change the 
calendar style, the event coordinator, the event type, the sales category, the salesperson, the 
reservation source, or the web user.

To use the Change Reservation Wizard

1. On the EMS menu bar, click System Administration > Tools > Change Reservation
Wizard.

The Change Reservation Wizard opens.

Figure 10-5: Change Reservation Wizard

2. Select Event Type for the property to change, and then do one of the following:

• Select All Reservations.

• Select Future Reservations with Bookings After, and then select a booking date.

The following procedure is written from the perspective of changing the event 
type, but by analogy, you can follow this procedure to change any of the allowed 
properties for your reservations.

The date must be greater than or equal to the current day’s date.
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3. Click Next.

The Change Reservation Wizard prompts you to select an event type to change.

Figure 10-6: Change Reservation Wizard

4. Select an event type, for example, Fundraiser.

The Change Reservation Wizard is updated with information that indicates the number
of reservations that use the selected event type.

Figure 10-7: Change Reservation Wizard

5. Click Next.

The Change Reservation Wizard prompts you to select an event type to replace all
instances of “Fundraiser.”

Figure 10-8: Change Reservation Wizard
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6. Select a different event type, for example, Fundraising Dinner, and then click Finish.

A Property Changed message opens, indicating that the property was changed, and the
number of reservations that were affected.

7. Click OK to close the message and the Change Reservation Wizard.
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Room Administration Wizard

You use the Room Administration Wizard to identify new rooms that have been configured 
in your EMS database and add these rooms to or delete these rooms from public views, 
notification rules, group notification rules, users, user templates, web process templates, and 
if applicable, kiosk profiles. (If you are using the Room Administration Wizard in EMS 
Campus, then you can add specific rooms to or delete specific rooms from domains and/or 
academic units.)

To use the Room Administration Wizard

1. On the EMS menu bar, click System Administration > Tools > Room Administration
Wizard.

The Room Administration Wizard opens.

Figure 10-9: Room Administration Wizard

2. Do one of the following:

• If you are using the wizard to add rooms to a view, rule, or so on, then leave Add On
or After Date selected, if needed, select a date, and then continue to “To use the
Room Administration Wizard to add rooms” on page 367.

• If you are using the wizard to delete rooms from a view, rule, or so on, select
Remove, and then continue to “To use the Room Administration Wizard to delete
rooms” on page 369.

The default value for the date is the current day’s date.
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To use the Room Administration Wizard to add rooms

1. On the Building dropdown list, select all buildings, a specific building, or an area.

All rooms that have been added to the selected building or area on or after the indicated
date are displayed.

2. Optionally, do one or both of the following to filter the rooms that are displayed:

• On the Classification dropdown list, leave the default value of (all), or select a
specific room classification.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

As you select your search criteria, the list of rooms that meet the search criteria is 
dynamically updated.

3. Optionally, to further filter the displayed search results based on the Room Name, in the
Filter field, enter a search string.

4. Select the room or CTRL-click to select the multiple rooms that you are adding, and then
click Next.

The Room Administration Wizard is updated with a list of the public views that are
currently configured in your EMS database.

Figure 10-10: Room Administration Wizard, Public Views

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Mee returns Meeting room, but not 
Science Meeting room.
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5. Do one of the following:

• To keep all public views as is (none of the selected rooms are to be added to any
existing public views), leave Keep Existing Settings selected, and then click Next.

• To add the selected rooms to one or more of the existing public views, click Add to
Existing Settings, and on the Available list, select the view or CTRL-click to select
the multiple views, click the Move (>) button to move the selected views to the
Selected list, and then click Next.

6. Repeat the process detailed in Step 5 to move through the configuration process for each
of the remaining configuration items—Notification Rules, Group Notification Rules,
Users, User Templates, Web Process Templates, and if applicable, Kiosk Profiles.

• For Users, User Templates, and Web Process Templates, a third option, Overwrite
Existing Settings is available. If you select this option, then the current (existing)
room access for the configuration item is replaced by the room access that you
define here. For example, if you select Overwrite Existing Settings for Users, then
any room access that has been previously defined for a selected user is replaced by
the room access that you define here.

7. Do one or more or all of the following as needed:

• For Notification Rules, Group Notification Rules, and Kiosk Profiles, go to Step 8.

• For Users and User Templates, select the appropriate access, and then go to Step 8.

• View and Book—A user who has access to the Special - Edit Critical Booking
Information process and who is assigned to this option can reserve the room,
move an event into or out of the room, change the time or status of an event that
is scheduled in the room, and add resources to events in the room.

• View Only—A user who is assigned to this option cannot reserve the room,
move an event into or out of the room, or change the time or status of an event
that is scheduled in the room; however, as long as the user has access to the
appropriate category and to the Special - Edit Booking Details process, the user
can view events in the room and add resources to events in the room.

EMS Enterprise has both the View and Book and the View Only access for user 
security. EMS Professional has just the View and Book access for user security.

 The Special - View and Book Access On All Rooms process can be used as an 
alternative to manually assigning all rooms to the View and Book list. See 
“Configuring User Security for Multiple User Accounts” on page 354.
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• For Web Process Templates, select the appropriate access, and then go to Step 8.

• Move rooms that can be reserved without approval (that is, booked into the
Reserve Status on the Web Template tab) into the Reserve pane.

• Move rooms that require approval (that is, booked into the Request Status on the
Web Template tab) into the Request pane.

8. Click Finish.

A Process message opens indicating that you are about to process the selected rooms and
possibly overwrite data, and asking you if it is OK to continue.

9. Click Yes.

A message opens indicating that the rooms were processed successfully, and asking you
if you want to select more rooms.

10. Do one of the following:

• Click Yes to close the message and return to the Room Administration Wizard.

• Click No to close the message and the Room Administration Wizard.

To use the Room Administration Wizard to delete rooms

1. On the Building dropdown list, select all building, a specific building, or an area.

All rooms that have been configured for the selected building, area, or view are
displayed.

2. Optionally, do one or both of the following to filter the rooms that are displayed:

• On the Classification dropdown list, leave the default value of (all), or select a
specific room classification.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

As you select your search criteria, the list of rooms that meet the search criteria is 
dynamically updated.

3. Optionally, to further filter the displayed search results based on the Room Name, in the
Filter field, enter a search string.

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Mee returns Meeting room, but not 
Science Meeting room.
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4. Select the room or CTRL-click to select the multiple rooms that you are removing, and
then click Next.

The Room Administration Wizard is updated with a list of the public views that are
currently configured in your EMS database and that contain the selected room or rooms.

Figure 10-11: Room Administration Wizard, Public Views

5. Do one of the following:

• To keep all public views as is (none of the selected rooms are to be removed from
any of these public views), leave Keep Existing Settings selected, and then click
Next.

• To remove the selected rooms from one or more of the public views, on the
Available list, select the view, or CTRL-click to select the multiple views from
which you are removing the rooms, click the Move (>) button to move the selected
views to the Selected list, and then click Next.

6. Repeat the process detailed in Step 5 to move through the configuration process for each
of the remaining configuration items—Notification Rules, Group Notification Rules,
Users, User Templates, Web Process Templates, and if applicable, Kiosk Profiles.

7. Click Finish.

A Process message opens indicating that you are about to process the selected rooms and
possibly overwrite data, and asking you if it is OK to continue.

8. Click Yes.

A message opens indicating that the rooms were processed successfully, and asking you
if you want to select more rooms.
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9. Do one of the following:

• Click Yes to close the message and return to the Room Administration Wizard.

• Click No to close the message and the Room Administration Wizard.
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Managing Memorized Reports

A memorized report is a report for which the filter settings have been saved, or memorized, 
so that you do not have to adjust the filter settings every time you run the report. A 
memorized report always has an owner, and it can be a public report (available to all users in 
your EMS database), or it can be a private report (available only to the owner of the report.) 
You use the Manage Memorized Reports tool to edit or delete a memorized report.

To use the Manage Memorized Reports tool

1. On the EMS menu bar, click System Administration > Tools > Manage Memorized
Reports.

The Memorized Report Setups window opens. By default, this window lists the
memorized reports of all types that are configured in your EMS database.

Figure 10-12: Memorized Report Setups dialog box

2. Optionally, select on the Report Type dropdown list, select a report type to filter the list
of reports that are displayed.

3. Select a memorized report, and then continue to one of the following:

• “To edit a memorized report” on page 373.

• “To delete a memorized report” on page 373.
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To edit a memorized report

1. Click Edit.

A Memorize Report Setup dialog box opens, populated with the information for the
selected report.

Figure 10-13: Memorize Report Setup dialog box

2. Edit one or more of the following for the report—the report description, the availability
of the report (if the report is not to be available to the all users, then clear the Public
option; otherwise, select the Public option), and/or the report owner.

3. Click OK.

The Memorize Report Setup dialog box closes and you return to the Memorize Report
Setups window with the newly edited report automatically selected.

To delete a memorized report

1. Click Delete.

A message opens asking you if you are sure that you want to delete the selected
memorized report.

2. Click Yes.

The message closes. The report is deleted.
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Override Existing Bookings Utility

In some situations, such as a building closure, a scheduled maintenance repair, a priority 
event, and so on, you might need to “bump” one or more bookings from their scheduled 
location. You use the Override Existing Bookings Utility to bump all the bookings that meet 
specific criteria and place them in a Conflict status. A new all day booking that uses the 
settings (Event Name, Event Type, and Group) that you specify is created in place of these 
bumped bookings.

To use the Override Existing Bookings Utility

1. On the EMS menu bar, click System Administration > Tools > Override Existing
Bookings Utility.

The Override Existing Bookings Utility window opens.

Figure 10-14: Override Existing Bookings Utility window
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2. Do the following to search for the rooms that contain the bookings that you are bumping:

• On the Building dropdown list, select a specific building, area, or view.

• On the Room Type dropdown list, leave the Room Type set to the default value of
(all), or select a specific room type.

A list of all the rooms configured for the selected building, area, or view and that are of 
the indicated Room Type are displayed on the Available list.

3. Select the room, or CTRL-click to select the multiple rooms that contain the bookings
that you are bumping, and then click the Move button (>) to move the selected rooms to
the Selected list.

4. Repeat Step 2 and Step 3 until you have selected all the rooms that contain the bookings
that you are bumping.

5. Enter a Start Date and an End Date to filter the list of bookings that you are bumping for
the selected rooms.

6. Optionally, to see a list of the bookings that you are bumping, click View Bookings;
otherwise, go to Step 7.

The View Bookings window opens. A list of all rooms with the bookings that you are
bumping is displayed in the window.

Figure 10-15: View Bookings window

Optionally, you can select a booking in this window, and then click Open to open 
the booking’s reservation in the Navigator for a more detailed examination, and 
you can also click Export to export the list of bookings to an Excel spreadsheet. 
After you have viewed the bookings and/or exported the booking, click Close to 
close the View Bookings window and return to the Override Existing Bookings 
Utility window.
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7. Specify the event type, event name, the status, and the group for the new all day
bookings that are to be created in place of the bumped bookings.

8. Select the Override Existing Bookings Conflict Status (the status to which the bumped
bookings are changed).

9. To update the reservation status to the status for the new all day bookings, leave Update
Reservation Status; otherwise, clear this option to leave the reservation status
unchanged.

10. Click Finish.

A message opens indicating that the existing bookings (which are all the bookings the
meet the search criteria) will be overridden and set to the conflict status that you selected
and asking you if it is OK to continue.

11. Click Yes.

The message closes and the Navigator opens, displaying the new all day bookings with
their new status.

If the appropriate event type is not available, you can configure it. See 
“Configuring Event Types” on page 43. If the appropriate status is not available, 
you can configure it. See “Configuring Statuses” on page 164.You can select a 
group from the Group dropdown list, or you can search for a group. If the 
appropriate group is not available, you can configure it. See “Configuring 
Groups” on page 277.

If the appropriate status is not available, you can configure it. See “Configuring 
Statuses” on page 164. If you select a status with a Cancel type, a Cancel Status 
dialog box opens. You must enter a cancel reason and indicate who cancelled the 
booking for Cancel type status. Optionally, you can also enter notes about the 
booking cancellation.
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Import Reservations Utility

You can import reservations into your EMS database from a tab-delimited text file. (See 
“Reservation Import File Specifications” on page 545 for the import file specifications.) 
Importing reservations is a two-step process. First, you must configure the reservation 
import session. Second, after you configure the import session, you must import the 
reservations into the session. You an can also delete an import session.

To configure the import reservation session

1. On the EMS menu bar, click System Administration > Tools > Import Reservations
Utility.

The Reservation Import Sessions window opens. This window lists all the reservation
sessions that have been imported into your EMS database.

Figure 10-16: Reservation Import Sessions window

This section describes the steps for configuring a new reservation import session. 
If you simply need to load an existing session, then after opening the Reservation 
Import Sessions window, skip to “To import reservations into a session” on page 
379.
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2. Click New.

The Reservation Import Session dialog box opens.

Figure 10-17: Reservation Import Session dialog box

3. Enter the information for the new import session.

Option Description

Description A name or description for the import session.

Note: The name can be a maximum of 50 characters, including 

spaces.

Event Type Select the event type for the imported reservations.

Note: If the appropriate event type is not available, you can configure 

it. See “Configuring Event Types” on page 43.

Setup Type Select the setup type for the imported reservations.

Note: If the appropriate setup type is not available, you can configure 

it. See “Configuring Setup Types” on page 87.

Status Select the status that is to be applied to the imported reservations.

Note: Only statuses that do not have a Reconfirm Date are available.If 

the appropriate status is not available, you can configure it. See 

“Configuring Statuses” on page 164.

Conflict Status Available only if you select a status with a type of Book Space. This 

status is applied only if the status that you selected results in the 

imported bookings being in conflict with existing bookings.

Note: If the appropriate status is not available, you can configure it. 

See “Configuring Statuses” on page 164.

Override Existing 

Bookings

Select this option if the imported bookings are to override existing 

bookings.

Override Conflict Status Available only Override Existing Bookings is selected. If imported 

bookings override existing bookings, then select the conflict status into 

which the overridden bookings are to be placed.

Note: If the appropriate status is not available, you can configure it. 

See “Configuring Statuses” on page 164.
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4. Click OK.

The Reservation Import Session dialog box closes. You return to the Reservation Import
Sessions window. The newly configured import session is displayed in the window.

5. Continue to “To import reservations into a session” below.

To import reservations into a session

1. If you have not already done so, on the EMS menu bar, click System Administration >
Tools > Import Reservations Utility to open the Reservation Import Sessions window.

2. Select the reservation session into which you are importing the reservations, and then
click Load.

The Import Reservations wizard opens.

Figure 10-18: Import Reservations wizard

3. Click the Search icon  to browse to and select the file that you are importing, and

then click Next.

The Import Reservations wizard displays all the reservations in the import file by the
building/room combinations that have been assigned to reservations in the import file.
See Figure 10-19 on page 380.

Reservation Source Select a source if applicable.

Note: If the appropriate reservation source is not available, you can 

configure it. See “Configuring Reservation Sources” on page 70.

Option Description
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Figure 10-19: Import Reservations Wizard

4. Optionally, to filter the list, select a different view on the View dropdown list and/or a
different building on the Building dropdown list.

5. Do one of the following:

• Select a Building/Room Combination, or CTRL-click to select multiple
combinations, and then click Assign to open the Room Selector dialog box and
select the room in your EMS database for which all reservations that are assigned to
this Building/Room combination will be booked.

• Select a Building/Room Combination, or CTRL-click to select multiple
combinations, and then click Do Not Import to exclude all the reservations that are
assigned to this Building/Room combination.

• Select a Building/Room Combination, or CTRL-click to select multiple
combinations, and then click Unassign to undo a Building/Room assignment.

If a Building/Room combination in the import file is identical to a Building Code/
Room code in the EMS database, then the record is automatically assigned; 
otherwise, the record remains unchanged.
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6. Click Next.

The Import Reservations Wizard displays all groups that are assigned to reservations in
the import file.

Figure 10-20: Import Reservations Wizard 

7. Do one of the following:

• Select a group, or CTRL-click to select multiple groups, and then click Assign to
open the Groups window, and select the group in your EMS database for which all
reservations that are assigned to the selected group will be made.

• Select a group, or CTRL-click to select multiple groups, and then click Do Not
Import to exclude all reservations that are assigned to this group.

• Select a group, or CTRL-click to select multiple groups, and then click Unassign to
undo a Group assignment.

8. Click Finish.

A message opens indicating that the reservations were imported successfully.

9. Click OK to close the message and the Import Reservations Wizard and return to the
Reservation Import Sessions window.

If a group name in the import file is identical to a group name in the EMS 
database, then the record is automatically assigned; otherwise, the record remains 
unassigned.
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To delete a reservation import session

If needed, you can delete a reservation import session; however, if you delete an import 
session, all reservations that were created in the session are deleted. Because there is no way 
to recover these reservations other than to repeat the import process, make sure that you do 
indeed want to delete the session.

1. On the EMS menu bar, click System Administration > Tools > Import Reservations
Utility.

The Reservation Import Sessions window opens. This window lists all the reservation
sessions that have been imported into your EMS database.

Figure 10-21: Reservation Import Sessions window

2. Select the import session that you are deleting, and then click Delete.

A message opens informing you that all reservations related to the session will be
deleted and asking you if it is OK to continue.

3. Click Yes.

The message closes. The import session is deleted.
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Viewing and Emailing Logged-In Users

A user who is currently logged in to your EMS system is referred to as an active user. You 
view logged-in users and if necessary, log these users off your EMS system. You can also 
send an email to all users who are currently logged in to EMS. 

To view and email logged-in users

1. On the EMS menu bar, click System Administration > Tools > Active Users.

The Active Users window opens. This window lists all the users who are currently
logged in to your EMS system, the date and time they logged in to the system, and in
multi-EMS database environments, the database that they are logged in to. An asterisk
(*) marks the user account that you used to log in.

Figure 10-22: Active Users window

To receive email, a user must have an email address configured for his/her user 
account. 
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2. Optionally, do one or both of the following:

• To log a user off of the system, select the user, or CTRL-click to select multiple
users, and then click Logout.

• To send an email to a user, select the user and then click Email.

A blank email, pre-addressed to the user, opens. The To field is populated with the
email address that was defined for the user, but you can edit this value if needed.
Create and send the email as you normally would.

Figure 10-23: SMTP Email window

Users who are logged off of the system can complete the process they are currently 
involved in (making a reservation, editing a booking, and so on), but when they 
attempt to start another process, a message opens informing them that they have 
been logged out and must restart EMS.
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Currency Configuration Wizard

After you configure a currency in your EMS database, you can assign the currency to 
buildings, categories, and/or calculations. You can assign the currency to a single building, 
category, or calculation during configuration, or you can use the Currency Configuration 
Wizard to assign the currency to multiple buildings, categories, and/or calculations in a 
single step.

To use the Currency Configuration Wizard

1. On the EMS menu bar, click System Administration > Tools > Currency Configuration
Wizard.

The Currency Configuration Wizard opens. All the active currencies that are currently
configured in your EMS database are displayed on the Currency dropdown list.

Figure 10-24: Currency Configuration Wizard

2. On the Currency dropdown list, select the currency that you are assigning, and then click
Next.

The Currency Configuration Wizard, Buildings page opens. This page lists all the 
buildings that are currently configured in your EMS database. See Figure 10-25 on page 
386.

If the appropriate currency is not available, you can configure it. See 
“Configuring Currencies” on page 272.
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Figure 10-25: Currency Configuration Wizard, Buildings page

3. On the Available list, select the building, or CTRL-click to select the multiple buildings
to which you are assigning the currency, and then click the Move button (>) to move the
selected buildings to the Selected list.

When you assign a currency to a building, the currency is used to price all the 
rooms in the building. If the appropriate building is not available, you can 
configure it. See “Configuring Buildings” on page 91.
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4. Click Next.

The Currency Configuration Wizard, Categories page opens. This page lists all the active
categories that are currently configured in your EMS database.

Figure 10-26: Currency Configuration Wizard, Categories page

5. Select the category, or CTRL-click to select the multiple categories to which you are
assigning the currency, and then click the Move button (>) to move the selected
categories to the Selected list.

When you assign a currency to a category, the currency is used to price all the 
resources in the category. If the appropriate category is not available, you can 
configure it. See “Configuring Categories” on page 155.
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6. Click Next.

The Currency Configuration Wizard, Calculations page opens. This page lists all the
active calculations that are currently configured in your EMS database.

Figure 10-27: Currency Configuration Wizard, Calculations page

7. On the Available list, select the calculation, or CTRL-click to select the multiple
calculations to which you are assigning the currency, and then click the Move button (>)
to move the selected calculations to the Selected list.

8. Click Finish.

A message opens, asking you if you are sure that you want to set the currency on the
selected items to be <selected currency>? For example, are you sure that you want to set
the currency on the selected items to be US Dollars?

9. Click Yes.

The message closes and another message opens indicating that the currency
configuration was successful.

10. Click OK to close the second message and the Currency Configuration Wizard.

When you assign a currency to a calculation, the currency symbol is used to 
display the results of the calculation. If the appropriate calculation is not 
available, you can configure it. See “Configuring Calculations” on page 258.
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Changing Booking Dates and/or Statuses

You can use the The Booking Move/Change Status Wizard to change critical information 
(date and/or status) for multiple bookings across multiple reservations in a single step. 

To use the Move Booking/Change Status Wizard

1. On the EMS main menu, click System Administration > Tools > Booking Move/Change
Status Wizard.

The Booking Move/Change Status Wizard opens.

Figure 10-28: Booking Move/Change Status Wizard
]

2. In the Start Date field, enter the starting date for the bookings for which you are
changing the date and/or status, and in the End Date field, enter the ending date.

3. Leave the default values set to (all) for the other search criteria (Building, Status, and
Event Type), or optionally, select different values as needed.

Your users have access to the Change Booking Date/Time Wizard and the Change 
Booking Status Wizard in the Navigator. They can use these wizards to change 
critical booking information for multiple bookings in a single reservation. 

For Building, you can select (all) buildings, a specific building, a specific area, or 
a specific view.
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4. Click Get Data.

The Select Bookings window opens. This window displays all the bookings that meet
your search criteria.

Figure 10-29: Booking Move/Change Status Wizard, Select Bookings window

5. Continue to one of the following:

• “To move multiple bookings to a different date” below.

• “To change the status for multiple bookings” on page 392.

To move multiple bookings to a different date

1. Select the booking, or CTRL-click to select the multiple bookings for which you are
changing the date.

2. On the Select Bookings window, click Move.

The Move Bookings dialog box opens.

Figure 10-30: Move Bookings dialog box
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3. Select a different value for the date, and then click OK.

The Results window opens. This window displays a list of all the selected bookings, 
whether the date change was successful or not.

Figure 10-31: Change Booking Date Results window

4. Click Close to close the Change Booking Date Results window and return to the Select
Bookings window.

5. Repeat Step 1 through Step 4 until you have moved all the bookings as needed.

6. Do one of the following:

• If you are done moving bookings to a different date, click Close to close the Select
Bookings window.

• If you also want to change the status for any of the bookings, continue “To change
the status for multiple bookings” on page 392.

Value Description

Reschedule Booking Earlier The default value. Reschedule the bookings to an earlier date 

that is based on the number of days that you specify.

Reschedule Booking Later Reschedule the bookings to a later date based on the number 

of days that you specify.

Reschedule Booking to Specific 

Date

Reschedule the bookings to a new date that you specify.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.
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To change the status for multiple bookings

1. Select the booking, or CTRL-click to select the multiple bookings for which you are
changing the status.

2. On the Select Bookings window, click Change Status.

The Change Status dialog box opens.

Figure 10-32: Change Status dialog box

3. On the Status dropdown list, select the new status for the bookings.

4. Enter a Reconfirm Date if it is required for the new status that you selected.

5. Optionally, select Update Reservation Status to have the reservation-level status changed
as well.

If you select any type of Canceled status, then three additional fields—Reason, 
Who Cancelled and Notes—are displayed on the Change Booking Status window. 
You must enter data in all three of these fields before you can continue in the 
Wizard.
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6. Click Finish.

The Results window opens. This window displays a list of all the selected bookings,
whether the status change was successful or not.

Figure 10-33: Change Booking Date Results window

7. Click Close to close the Change Booking Status Results window and return to the Select
Bookings window.

8. Repeat Step 1 through Step 7 until you have changed the status for all the bookings as
needed.

9. Do one of the following:

• If you are done changing the status for the bookings, click Close to close the Select
Bookings window.

• If you also want to move any of the bookings to a new date, continue “To change the
status for multiple bookings” on page 392.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.



394

 
System Administration Tools

Deleting Old Data

As the EMS administrator, you can delete bookings, historical data, email history, holidays, 
building hours, notifications, and if applicable, EMS Kiosk transactions that occur on or 
before a specific date. You can also delete unused groups, contacts and web users (groups, 
contacts, and web users who have no associated records in your EMS database). If you delete 
all the bookings for a reservation, the reservation is also deleted from the EMS database. As 
a safeguard, it is a system requirement that the date that you specify for bookings, historical 
data, email history, holidays, building hours, or notifications be at least three months prior to 
the current day’s date.

To delete old data

1. On the EMS menu bar, click System Administration > Tools > Delete Old Data.

The Delete Old Data dialog box opens.

Figure 10-34: Delete Old Data dialog box

2. Select that data that is being deleted, and then, if applicable enter the on/or before
deletion date.

Before using the Delete Old Data utility, make a backup of your EMS database. 
Deletion of data using this utility is a permanent deletion and you can recover the 
data only by using a backup copy of your EMS database.

The date that you specify for bookings, historical data, email history, holidays, 
building hours, notifications, and /or kiosk transactions must be at least three 
months prior to the current day’s date.
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3. Click OK.

A message opens indicating that deleting this data is a permanent action and asking you
if it is OK to continue.

4. Click Yes.

A message opens when all the data is deleted.

5. Click OK.

Remember, if you delete all the bookings for a reservation, the reservation is also 
deleted from the EMS database; however, no message opens indicating that the 
reservation was also deleted.
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Migrating Data

Older versions of EMS use a Microsoft Access database. You use the Migrating Data tool to 
migrate data from these older databases into the current database version (SQL Server) for 
EMS.

To migrate data

1. On the EMS menu bar, click System Administration > Tools > Data Migration.

The EMS Migration Utility opens.

Figure 10-35: EMS Migration Utility

2. Click Browse to browse to and select the Microsoft Access database that you are
migrating.

3. In the EMS pane, enter the connection information for the new EMS database.

4. In the User Name and Password fields, enter the name and password that you use to log
in to EMS.

5. Click Next.

A message opens indicating that all existing EMS data will be overwritten by the
migration process and asking you if you want to continue.

6. Click Yes.

A dialog box opens, indicating the progress of the migration. When the migration
process is complete, a migration complete message opens.

7. Click OK to close the message, and then restart EMS.
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Virtual EMS (VEMS) is an optional web-based application that EMS users can use to view 
EMS events, and if allowed, to submit and manage reservations. As the EMS administrator, 
you are responsible for setting up and maintaining the necessary components for this 
module, including defining web users, web security templates, web process templates, web 
menus and links, and web text.

This chapter covers the following topics:

• “Configuring Web Templates” on page 399.

• “Configuring Web Users” on page 419.

• “Configuring Additional Information for a Web User” on page 425.

• “Emailing a Web User” on page 430.

• “Assigning Web Templates to Multiple Web Users” on page 431.

• “Configuring Web Menus” on page 437.

• “Configuring Web Text” on page 440.

• “Configuring Web Cultures” on page 445.
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Configuring Web Templates

A web user is a registered user who can submit requests for reservations or schedule 
reservations in VEMS. A web template defines and controls the access that a web user has in 
VEMS. VEMS uses two types of web templates—a web security template and a web process 
template.

• Web Security template—You configure a web security template to specify which menu
items are available to the users who are assigned to the template, which fields can be
viewed in event tooltips, and other information. A single pre-defined web user—
unauthenticated user—is defined by default for any VEMS implementation. You use this
role to manage the settings for an anonymous or “guest” users.

• Web Process template—You configure web process templates to support the various
types of reservations (conference room, workspace, study room, and so on) at your
organization as well as date/time restrictions, room security (reserve, request only, no
access), and service availability (A/V, catering, and so on) at your organization.

To configure a web security template

1. On the EMS menu bar, click Configuration > Web > Web Security Templates.

The Web Security Templates window opens. This window lists the one web user role
(unauthenticated user) that is defined by default for any VEMS implementation as well
as any other web security templates that have been defined for your VEMS
implementation.

Figure 11-1: Web Security Templates window
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2. Click New.

The Web Security Template dialog box opens. The Web Security Template tab is the
active tab.

Figure 11-2: Web Security Template dialog box, Web Security Template tab

3. Enter the information for the new web user role.

The remainder of this procedure describes how to configure a web security 
template “from scratch.” You can also configure a web security template by 
copying an existing rule. Select the web security template that you are copying, 
click Copy, and then go to Step 3.

Option Description

Description The description or name for the web security template.

Note: The description can be a maximum of 50 characters, including 

spaces.

Allow User to Add 

Groups

Selected by default. Users who are attached to this web security 

template can select from a list of existing groups in your EMS database 

when submitting a request or making a reservation.

Allow User to Add 

Contacts

Select this option if you want users who are attached to this web 

security template to be able to select from a list of existing contacts in 

your EMS database when submitting a request or making a reservation.

Allow User to Set 

Default Contact

Available only if Allow User to Add Contacts is selected. Select this 

option if you want users who are attached to this web template to be 

able to specify a default contact for a selected group when submitting a 

request or making a reservation.
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4. Roles are the tasks that a user who is assigned to the selected template can carry out.
Open the Roles tab, and on the Available list, select the role, or CTRL-click to select the
multiple roles for the users who are to be assigned to this template, and then click the
Move button (>) to move the selected roles to the Selected list.

5. Tool Tip Fields is the information that is displayed in grid tooltips when a VEMS user
reserves a room in the Room Request area or browses for space in the Browse for Space
Area. Open the Tool Tip Fields tab, and on the Available list, select what information is
to be displayed in the grid tooltips (CTRL-click to select multiple items), and then click
the Move button (>) to move the selected items to the Selected list.

6. Click OK.

The Web Security Template dialog box closes. The changes are saved to the template.
You return to the Web Security Templates window.

Role Description

Allow Check In/Allow 

Check Out

Allows a VEMS user to check in to/check out of a building from VEMS 

and the EMS Kiosk.

Browse Events Provides access to the Events calendar in VEMS.

Browse Facilities Allows a VEMS user to browse a listing of your organization’s rooms 

and available setup types and minimum/maximum capacities.

Browse for Space Allows a VEMS user to browse for available rooms in a read-only grid 

view.

Create\Edit an Account For the (unauthenticated user) template, allows a new user to create 

his/her own VEMS user account. This new web user account is set to 

active or pending based on your VEMS parameter settings. For the 

authenticated users, this determines if an existing web user can access 

the Edit My Account area within VEMS.

Custom Events Provides access to any custom events calendars created.

Delegation Allows VEMS users to delegate control of their reservations (new and 

existing) to other VEMS web users.

Locate Group Allows a VEMS user to view a specific group's reservations for today.

Location Details Allows a VEMS user to view details (room type, size, phone, features, 

setup types, images and so on) about a room.

Login\Logout Allows an anonymous user or “guest” to log in to VEMS.

View Floor Map Requires the optional Floor Plan module. Allows a VEMS user to view 

and book rooms on a floor plan.

Web Administrator Available only for the authenticated administrator template. Provides 

access to various administrative functions within VEMS such as clearing 

the cache, enabling help text edit model and enabling detailed errors.
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To configure a web process template

1. On the EMS menu bar, click Configuration > Web > Web Process Templates.

The Web Process Templates window opens. The window lists the one web process
template (unauthenticated user) that is defined by default for any VEMS implementation
as well as any other active web process templates that have been defined for your VEMS
implementation. The window also lists the currently defined value for the menu text that
is associated with each template.

Figure 11-3: Web Process Templates window

2. Click New.

The Web Process Template dialog box opens. The Web Template tab is the active tab.
See Figure 11-4 on page 403.

In EMS Enterprise, the (unauthenticated user) web process template is always 
available and you can have an unlimited number of other web process templates. 
In EMS Professional, the (unauthenticated user) web process template is always 
available, but you can have only two additional web process templates. An 
unlimited number of web process templates is not allowed in EMS Professional.

The menu text is the text or link that a VEMS user sees when requesting a room 
using a web process template. This is discussed in detail later in this section.

Optionally, to view all web process templates in your EMS database, regardless of 
status, under Show, click Inactive.
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Figure 11-4: Web Process Template dialog box, Web Template tab

3. Enter the information for the new web process template as needed. See:

• “Web Template tab” on page 404.

• “Booking Rules tab” on page 406.

• “Defaults tab” on page 408.

• “Video Conference tab” on page 409.

• “Rooms tab” on page 410.

• “Categories tab” on page 411.

• “Event Types tab” on page 412.

• “LDAP Groups tab” on page 413.

• “User Defined Fields tab” on page 414.

• “Parameters tab” on page 415.

• “Web Text tab” on page 416.

• “Menu Text Translations tab” on page 417.

• “Terms and Conditions tab” on page 418.

If you are editing a web process template, then the Web Template tab is available 
for all web process templates other than the unauthenticated user template. If you 
selected unauthenticated user, then the Booking Rules tab is the active tab when 
the dialog box opens. 
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4. Click OK.

The changes to the web process template are saved. For a web user to be able to view
and use this template, you must assign the user to the template. See “Configuring Web
Users” on page 419.

Web Template tab

1. Enter the information for the new template.

Field Description

Description Read-only information.

Mode Determines how a user can make a reservation in VEMS.

• Request - Web users can complete a simple online form requesting a

room. Unlike the Self Serve mode, this mode does not provide

options for the web user to view real-time room availability. In

addition, requests must be reviewed, approved, and manually

processed into actual reservations by an EMS client user. The room

is not taken out of inventory until this step has occurred.

• Self Serve - Registered web users can view real-time room

availability (in list or grid views) and create actual reservations in the

EMS database. Rooms can be booked in a confirmed or request

status based on your configuration and business process.

Note: You must select this option if the web users who are attached to 

this web process template must be able to request rooms that 

have a video conferencing feature.

• Service Only Request - Allows web users to request a service (for

example, catering, A/V equipment, and so on) for a location that is

not managed in EMS.

Note: Various settings within the Web Process template are 

enabled/disabled based on the selected mode. 

Menu Text The menu text or link that a VEMS user sees when requesting a room 

using this web process template. 

Available to New Web 

Users

Select this option if this web process template is to be automatically 

assigned to newly registered web users.

Enable for Mobile 

Device

Select this option if this web process template is to be available (in an 

appropriate format) on a mobile device browser. 

Outlook Enables the web process template for use with the EMS for Outlook 

module. 

Parent Menu The parent menu item on the VEMS main menu under which the name 

of this template appears. 

Reserve Status Available only for Self Serve mode. The default status that is applied to 

reservations that are booked in rooms identified as 'reserveable' on the 

Rooms tab. 

Request Status Available only for Self Serve mode. The default status that is applied to 

reservations that are booked in rooms identified as 'requestable' on the 

Rooms tab. 
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2. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.

Conflict Status Available only for Self Serve mode. The default status that is applied to 

bookings made by web users attached to this template that result in a 

conflict (the room is already booked).

Cancel Status Available only for Self Serve mode. The default status that is applied to 

bookings that are canceled by web users who are attached to this 

template.

Rule Violation Status Enabled only if Outlook is selected. Used in conjunction with the EMS 

for Outlook module. If you carry out an action in the EMS for Outlook 

module that violates a category date/time restriction, then the booking is 

changed to this status. 

Default Setup Type The setup type that is selected by default for a room search when a web 

user who is attached to this template is reserving a room in VEMS. The 

web user can always select a different value.

Allow Invitations Enabled only if your organization has purchased the optional Plan a 

Meeting (PAM) module. Select this option if users who are attached to 

this template must be able to see the free/busy schedules of the 

attendees. The web user can choose a date and time that is convenient 

for all attendees and then send invitations through VEMS, which 

attendees receive and can manage through Outlook. 

Allow Web User 

Personalization

Select this option if web users must be able to use the Options feature 

to customize their settings on VEMS pages.

Menu Sequence Enter a number that indicates the order in which this menu option is 

relative to other menu items that fall under the same parent menu. Items 

are ordered from lowest to highest sequence number, with the item with 

the lowest sequence number appearing first.

Note: If you leave the sequence set to the default value of zero for all 

menu items, then by default, the items are displayed 

alphabetically. 

Video Conference Select this option if the web users who are attached to this template 

must be able to request rooms that have a video conferencing feature. 

Note: This option is available only for EMS Enterprise. It is not 

available for EMS Professional. To use the Video Conference 

option correctly with a web process template, the Self Serve 

Mode must be selected for the template.

Available at Checkout Select this option if the web users who are attached to this template 

must be able to select category resource items on the VEMS “checkout 

page” (the last page in the Room Request process) in VEMS.

Field Description
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Booking Rules tab

1. Open the Booking Rules tab.

Figure 11-5: Web Process Template dialog box, Booking Rules tab

2. In the Booking Requirements pane, do the following:

• In the Max. No. Bookings Allowed Per Reservation field, enter the maximum
number of bookings that a new reservation can contain.

• In the Max. No. Minutes Allowed field, enter the maximum number of minutes for
which a new reservation can be created. (This setting is not enforced when a user
edits a booking.)

3. Use the time of day and number of days or the number of hours to dictate how far in
advance of an event a booking can be canceled.

• To use a specific cutoff time, select Use Cancellation Cutoff Time, and in the Cutoff
Time and Number of Days fields, specify a time of day and a number of days.
respectively. For example, if you enter 3 p.m. and one day, then cancellation must
take place before 3 p.m. on the day before the event.

• To use the number of hours instead of a specific time as a cutoff, clear Use
Cancellation Cutoff Time and in the Cancellation Cutoff Hours field, specify a
number of hours. For example, if you enter 24, then bookings cannot be canceled
less than 24 hours before they are to take place, regardless of the time of day.



407

 
Virtual EMS (VEMS) Configuration

4. Optionally, select one or both of the following:

• Cancel Booking in Progress—A web user can cancel a booking that is currently in
progress. If you select this option, then the Cancel Booking in Progress Status option
is enabled. The status that you select here is applied to bookings that a web user
cancels after the booking is already in progress.

• End Booking in Progress—A web user can end a booking that is in progress early,
which makes the room available to other web users.

5. In the fields in the Booking Days panel, indicate how far into the future bookings can be
made and how much lead time is required to make a booking.

• If you select Range of Days from the first dropdown menu, then you must also
specify a value for Only Allow New Bookings within Range of This Many Days. If
you select Specific Date, then you must specify a value for Only Allow New
Bookings Prior to This Date to dictate the future range.

• The second dropdown menu sets the lead time requirement. If you choose Range of
Days, you must indicate a cutoff time or cutoff hours as you did for cancellations.
(See Step 3 above.) If you choose Specific Date, you must select a date in the Only
Allow New Bookings After This Date field.

6. Optionally, to restrict bookings for reservations made in VEMS, enter a value for one or
both of the following:

• Max. No. Bookings Per Day—Restricts the maximum number of bookings that are
allowed per day. The default value of zero indicates that no restrictions are imposed.

• Max. No. Bookings per Date Range—Restricts the maximum number of bookings
that are allowed per date range. The default value of zero indicates that no
restrictions are imposed.

7. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.

If the appropriate status is not available, you can configure it. See “Configuring 
Statuses” on page 164.

These two booking restriction options are enforced only in VEMS on a per Web 
Process template basis (not across Web Process templates).
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Defaults tab

1. Open the Defaults tab.

Figure 11-6: Defaults tab

2. Enter the default values for Event Type, Event Name, Building, Event Time Start/End,
and Time Zone.

These defaults values automatically populate the correct fields on the Room Requests 
page, but a user can edit them as needed.

3. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.

If the appropriate event type is not available, you can configure it. See 
“Configuring Event Types” on page 43. If the appropriate building is not 
available, you can configure it. See “Configuring Buildings” on page 91.
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Video Conference tab

Figure 11-7: Web Process Template, Video Conference tab

This tab is available only in EMS Enterprise and only if the Video Conference 
option was selected on the Web Template tab. For information on how to configure 
the information on this tab correctly so that users who are attached to this web 
process template can request rooms that have a video conferencing features, see 
Appendix B, “Video Conferencing,” on page 511.
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Rooms tab

1. Open the Rooms tab.

Figure 11-8: Web Process Template dialog box, Rooms tab

2. Specify your Building and Room Type search criteria.

3. On the Available list, select the room or CTRL-click to select the multiple rooms that
users who are attached to this web template must be able to book, and then click the
Move button (>) to move the selected rooms to the appropriate Selected list.

• Move rooms that can be reserved without approval (that is, booked into the Reserve
Status on the Web Template tab) into the Reserve pane.

• Move rooms that require approval (that is, booked into the Request Status on the
Web Template tab) into the Request pane.

On the Building dropdown list, you have the option of selecting all buildings, just 
a specific building, an area, or a view. If any of the appropriate items are not 
available, you can configure them. See “Configuring Buildings” on page 91, 
“Configuring Areas” on page 99, “Configuring Public Views” on page 144, or 
“Configuring Room Types” on page 89.
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4. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.

Categories tab

1. Open the Categories tab.

Figure 11-9: Categories tab

2. On the Available list, select the category or CTRL-click to select the multiple categories
that users who are attached to this web template must be able to add to a booking, and
then click the Move button (>) to move the selected categories to the Selected list.

3. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.

If the appropriate category is not available, you can configure it. See 
“Configuring Categories” on page 155.
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Event Types tab

1. Open the Event Types tab.

Figure 11-10: Web Process Template dialog box, Event Types tab

2. On the Available list, select the event type or CTRL-click to select the multiple event
types that users who are attached to this web template must be able to select, and then
click the Move button (>) to move the selected types to the appropriate Selected list.

• Move the event types that apply only to this web process template into the Selected
pane.

• The Available to All Web Process Templates pane displays all the event types that
have the Available to all Web Process Templates option selected. See “Configuring
Event Types” on page 43.

3. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.
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LDAP Groups tab

You use this tab to assign web process templates to VEMS users based on LDAP Groups that 
are defined in your directory service, for example, Active Directory.

1. Open the LDAP Groups tab.

Figure 11-11: Web Process Template dialog box, LDAP Groups tab

2. On the Available list, select the LDAP group or CTRL-click to select the multiple
groups, and then click the Move button (>) to move the selected groups to the Selected
list.

3. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.

Web process templates that are assigned via LDAP do not need to be explicitly 
assigned to web user records. When web users log in to VEMS, they “inherit” the 
web process templates based on the LDAP groups to which they belong.
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User Defined Fields tab

1. Open the User Defined fields tab.

Figure 11-12: Web Process template, User Defined Fields tab

2. On the Available list, select the question or CTRL-click to select the multiple questions
that users who are attached to this web template must answer when reserving space, and
then click the Move button (>) to move the selected questions to the appropriate Selected
list.

• Move questions that require an answer into the Required pane.

• Move questions that are optional into the Optional pane.

3. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.

If the appropriate UDF is not available, you can configure it. See “Configuring 
User Defined Fields (UDFs)” on page 67.
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Parameters tab

1. Open the Parameters tab.

Figure 11-13: Web Process Template dialog box, Parameters tab

2. By default, a web process template inherits its parameter settings from the global list of
VEMS parameters. (See “VEMS System Parameters” on page 500.) You can review the
values for these parameters, and edit the values as needed for the template.

• To edit the value for a parameter, select the parameter, and then click Edit.

• To reset the value for a parameter to its default global value, select the parameter,
and then click Use Global.

3. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.
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Web Text tab

1. Open the Web Text tab.

Figure 11-14: Web Process Template dialog box, Web Text tab

2. By default, web text items inherit their settings from the global Web Text list. (See
“Configuring Web Text” on page 440.) You can use the list of web text items on the Web
Text tab to override the settings for this particular template if needed.

• To edit the value for a web text item, select the item, and then click Edit.

• To reset the value for an item to its default global value, select the item, and then
click Use Global.

3. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.
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Menu Text Translations tab

1. Open the Menu Text Translations tab.

Figure 11-15: Web Process Template dialog box, Menu Text Translations tab

2. For each translation that is displayed on the tab, click in the Text field, and then enter the
appropriate translation for the menu text (the menu text or link that a VEMS user sees
when requesting a room using this web process template).

3. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.

You need to provide information on this tab only if a foreign language translation 
has been defined for web templates. See “Configuring Web Cultures” on page 
445.
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Terms and Conditions tab

Before users can submit reservations through VEMS, they must agree to the Terms and 
Conditions that you specify on this tab.

1. Open the Terms and Conditions tab.

Figure 11-16: Web Process Template dialog box, Terms and Conditions tab

2. Format a Terms and Conditions message that is displayed in VEMS when a web user
selects a room.

• Design is selected by default. Use the standard Windows plain text formatting
options to format the message (spacing, number of lines, capitalization, and so on)
so that it is displayed the way that you want in the Terms and Conditions.

• Select HTML and enter the necessary HTML code to format the message (spacing,
number of lines, capitalization, and so on) so that it is displayed the way that you
want in the Terms and Conditions.

3. Continue with any other configuration for the templates as needed; otherwise, click OK
to save the changes to the template. For a web user to be able to view and use this
template, you must assign the user to the template. See “Configuring Web Users” on
page 419.
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Configuring Web Users

VEMS classifies users into two categories—unauthenticated users or visitors and 
authenticated users or web users. If allowed, visitors can browse a calendar of events or 
view details about your organization’s space; however, to submit and manage reservations, a 
web user account is required. You can configure a web user in one of four ways:

• Anonymous users can register themselves through VEMS and create a user account.

• You can define the web user through the EMS client. See “To create a web user from a
group” on page 285 or “To create a web user from a contact” on page 300.

• Through the optional HR Toolkit module.

• Through the optional LDAP/Integrated Authentication module.

Optionally, before you configure a web user you can search for the user to verify that the user 
has not already been created.

For an anonymous user to register through VEMS and create a user account, the 
appropriate account management parameters must be set (see “VEMS System 
Parameters” on page 500) and the Credit\Edit an Account role be selected for the 
unauthenticated user. (See the Roles tab definition in “To configure a web security 
template” on page 399.)

For more information about using optional HR Toolkit module or the optional 
LDAP/Integrated Authentication module to configure web users, contact your 
account representative at DEA.

The following procedure describes how to configure a single web user at a time 
and assign a single web security template and one or more web process templates 
to the user. To assign multiple web templates to multiple web users in a single step, 
see “Assigning Web Templates to Multiple Web Users” on page 431.
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To search for a web user

1. On the EMS menu bar, click Configuration > Web > Web Users.

The Web Users window opens. In the upper left hand corner, the number of web users
currently in use for VEMS is displayed.

Figure 11-17: Web Users window

2. Enter any combination of the following search criteria:

• On the Group Type dropdown list, leave the group type set to the default value of
(all), or select a specific group type.

• On the Search by dropdown list, select User Name or Email Address.

• On the Status dropdown list, select the user status by which to search.

• On the Process Template dropdown list, leave the default value of (all), or select a
specific web process template.

3. To further filter the displayed search results, do one or both of the following:

• To filter the search results based on the either the User Name or Email Address, in
the Filter field, enter a search string.

• To filter the search results based on city, in the City field, enter a search string.

4. Click Display.

For either field, the string is not case-sensitive, but your search is limited to the 
exact order of the characters in the string and it must begin with the information 
for which you are searching. For example, if searching by Email Address, a 
search string of bob returns bobworth@emssoftware.com but not 
dbobbett@emssoftware.com.
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The web users who meet your search criteria are displayed in the lower pane of the Web 
Users window.

To configure web users in EMS

When you configure a web user, you can also specify one or more delegates for the web user. 
A delegate is a web user who can create and view reservations on behalf of another web user. 

1. On the EMS menu bar, click Configuration > Web > Web Users.

The Web Users window opens. In the upper left corner, the number of web users
currently in use for VEMS is displayed.

Figure 11-18: Web Users window

2. Click New.

The Web User dialog box opens. The Web User tab is the active tab. See Figure 11-19 on
page 422.

Remember, before you configure a web user, you might want to search for the user 
to verify that it has not already been configured. See “To search for a web user” 
on page 420.

If the EMS system parameter Web Users linked to Groups via External Reference 
is set to Yes, then a Group column and a City column are also displayed in the Web 
Users window.
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Figure 11-19: Web User dialog box, Web User tab

3. Optionally, before you configure the new user, if the web user had to answer questions
when requesting to create an account through VEMS, then open the User Defined Fields
tab to view the user’s answers to the questions. You can view the responses that are
displayed on the tab to determine if you want to continue with creating an account for the
user.

4. Enter the information for the new web user.

At a minimum, to create a new web user, you must enter the user name, the user 
password, and the user email address on the Web User tab. All other information 
is optional and can be added at later dates when needed. 

Field Description

Name The name of the web user.

Note: The name can be a maximum of 30 characters, including 

spaces.

Password The password that the user must enter to log in to VEMS.

Email Address Enter the full email address for the user as the user must enter this 

address to log in to VEMS.

Phone/Fax Optional fields. 

Notes Optional field.

External Reference Optional field. Links the web user to an outside program if needed.

Network ID The web user’s network ID.
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5. Open the Web Process templates tab and select the web process templates that are to be
available to this user.

6. Open the Groups tab and do the following to specify the groups on whose behalf the web
user can view and make reservations in VEMS.

• Specify any combination of search criteria for the Find field and Group Type, and
then click Display to produce a list of all groups that meet the criteria.

• In the Available list, select a group, or CTRL-click to select multiple groups, and
then click the Move button (>) to move the selected groups to the Selected list.

Email Opt Out Optional field. Select this option if you do not want the web user to

receive automatic emails (such as reservation summary emails) from 

VEMS. The user can still receive manually sent emails.

Status Required field. Select the status for the user:

• Active—The web user can log in to VEMS.

• Pending—The web user cannot log in to VEMS and is informed that

he/she must check back at a later time.

• Inactive—The user cannot log in to VEMS and is instructed to contact

the EMS administrator.

Security Template Required field. This determines the user's access to the system—the 

menu items the user can see, and the information that the user can view 

when 'rolling-over' an event in VEMS.

Time Zone Optional field. The time zone in which the user is located.

The web process templates appear as menu items in VEMS. 

If you leave the Find field blank, then a list of all currently active groups for the 
selected group type is displayed. If you enter a search string in the Find field, the 
string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, a search string of AAA returns AAA Colorado, but not 
Colorado AAA.

Field Description
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7. Open the Delegates tab, and on the Search by dropdown list, do one of the following to
specify the delegates for the web user:

• Leave the Find field blank, and then click Display to open a list of all currently
available web users. Select a user, or CTRL-click to select multiple web users, and
then click the Move button (>) to move the selected web users to the Selected list.

• On the Search By dropdown list, select the option by which to search (Email
Address or User Name), and in the Find field, enter the string by which to filter your
search, and then click Display. Select a web user, or CTRL-click to select web
multiple users, and then click the Move button (>) to move the selected users to the
Selected list.

8. Optionally, click Spelling to spell check any information that you manually entered for
the web user.

9. Click OK.

The Web Users dialog box closes. You return to the Web Users window with the newly
configured web user automatically selected in the window.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, if searching by Email Address, a search string of bob 
returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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Configuring Additional Information for a Web 

User

After you have configured a new web user in your EMS database with the basic web user 
information, you have the option of configuring additional information for the web user. You 
can create a group from the web user and you can create a contact from the web user. 

To configure additional information for a web user

1. On the EMS menu bar, click Configuration > Web > Web Users.

The Web Users window opens. In the upper left corner, the number of web users
currently in use for VEMS is displayed.

Figure 11-20: Web Users window

2. Specify any combination of search criteria, and then click Display to produce a list of all
web users that meet the criteria.

If you leave the Find field blank, then a list of all currently active web users that 
meet your search criteria is displayed. If you enter a search string in the Find 
field, the string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Bar returns Barry Jones, but not 
Amanda Barry.
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3. Continue to one of the following:

• “To configure a group from a web user” below.

• “To configure a contact from a web user” on page 427.

To configure a group from a web user

1. Select the web user from which you are creating a group, and then click More > Create
Group.

The Group dialog box opens. The Group tab is the active tab. By default, the Name field
is populated with the name of the selected web user, but you can edit this value if
needed.

Figure 11-21: Group dialog box, Group tab

2. Configure the new group as needed. See “To configure groups” on page 279.
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To configure a contact from a web user

1. Select the web user from which you are creating a contact, and then click More > Create
Contact.

The Groups window opens.

Figure 11-22: Groups window

2. Search for the group for which you are creating the contact. See “To search for a group
and/or contact” on page 277.
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3. Select the group on the Results tab, and then click Select.

The Contact dialog box opens.

Figure 11-23: Contact dialog box

4. Enter the information for the new contact.

Field Description

Contact By default, the Contact field is populated with the name of the web user 

that you selected, but you can edit this value if needed.

Note: The name can be a maximum of 50 characters, including 

spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected. You cannot 

change this value.

Address Populated with the address of the group that you selected. If the contact 

address is not the same as the group address, then clear Use Group 

Address and enter the appropriate values in the Address fields.

International Select this option to drop the State and Zip fields for an international 

group.

Phone 

Fax

The phone number and fax number for the group. 

Note: The Phone and Fax fields have a dropdown list available on 

which you can select a different value (Fax, Mobile, Other, or 

Phone) for the field label, or you can enter a user-defined value. 

To enter a user-defined value, double-click the current field label 

to select it, and then enter the user-defined value over the 

selected label. 
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5. Optionally, click Spelling to spell check the information for the contact before you save
it.

6. Click OK.

The Contact dialog box closes. The contact is created from the web user and added to the
group. The group-specific window opens, and Contacts is selected by default.

Email Address The email address for the contact.

Note: If your computer is connected to a network, click the Search icon 

 to open a Global Address Lookup dialog box and search for 

the email address.

External Reference Links the contact to an outside program if needed.

Notes Any other information that is pertinent for the contact.

Set as Default Select this option if the contact is to be the default contact for the 

selected group. 

Note: If a default contact has been defined for a group, then when you 

specify the group information for a reservation, the Contact field 

is automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a 

selected group at a later date. To do so, select the contact in the 

right pane of the group-specific window, click Set Default, and 

then click Yes at the prompt to set the selected user as the 

default contact. 

Inactive Leave this option blank to add the contact as an active contact. Select 

this option to inactivate the contact.

Field Description
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Emailing a Web User

Whether your organization uses Microsoft Outlook or SMTP, you can always email a web 
user.

To email a web user

1. Search for the web user whom you are emailing. See “To search for a web user” on page
420.

2. On the Web Users window, make sure that the web user is selected in the lower pane,
and then click More > Email.

Depending on how your system is configured, either a pre-addressed Outlook email form
or a pre-addressed SMTP email form opens. The To field is populated with the email
address that is defined for the web user, but you can edit this value if needed.

3. Complete and send the email as you normally would.

If your organization uses Microsoft Outlook, you can continue to use this email 
system to send emails to web users; otherwise, to email a web user using the 
SMTP option, your user account must have an email address
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Assigning Web Templates to Multiple Web 

Users

When you configure a web user, you have the option of assigning a web security template 
and a web process template to the web user. Instead of assigning web templates one at a time 
to individual users, you can assign multiple web templates to multiple users in a single step. 
You can assign any web security template other than the unauthenticated user template to 
multiple users who have the same status, and you can assign multiple web process templates 
to multiple web users who have database access.

To assign a web security template to multiple web users

1. On the EMS menu bar, click Configuration > Web > Web Security Templates.

The Web Security Templates window opens. The window lists the one web user role
(unauthenticated user) that is defined by default for any VEMS implementation as well
as any other web security templates that have been defined for your VEMS
implementation.

Figure 11-24: Web Security Templates window

2. Select the web security template that you are assigning to multiple users, and then click
Assign.

The Assign Web Template window opens. See Figure 11-25 on page 432.

You can select any web security template other than the unauthenticated user 
template.
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Figure 11-25: Assign Web Template window

3. Select the web user status, and then click Next.

The Assign Web Template window is updated with options for selecting the users to
whom you are assigning the web template.

Figure 11-26: Assign Web Template window
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4. Do one of the following:

• To assign the selected web security template to all the users that you selected in Step
3, click Apply to All Web Users, and then go to Step 7.

• To assign the web security template to only specific users that you selected in Step 3,
search for the users by doing one or both of the following, and go to Step 5.

• In the Search By field, leave the default of User Name or select Email Address.

• To further filter the displayed search results based on either the User Name or
Email Address, in the Find field, enter a search string.

5. Click Display.

The web users who meet your search criteria are displayed in the Available list.

6. On the Available list, select the user, or CTRL-click to select the multiple users to whom
you are assigning the template, and then click the Move button (>) to move the selected
users to the Selected list.

7. Click Finish.

A message opens indicating that the web template was assigned successfully.

8. Click OK to close the message and return to the Web Security Templates window.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, if searching by Email Address, a search string of bob 
returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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To assign multiple web process templates to multiple users

1. On the EMS menu bar, click Configuration > Web > Web Process Templates.

The Web Process Templates window opens. The window lists the one web process
template (unauthenticated user) that is defined by default for any VEMS implementation
as well as any other web process templates that have been defined for your VEMS
implementation and that have a status of Active.

Figure 11-27: Web Process Templates window

2. Click Assign.

The Assign Web Process Templates window opens. All the available web process
templates for your VEMS implementation are displayed in the Available list. See Figure
11-28 on page 435.

Optionally, to view all web process templates in your EMS database, regardless of 
status, under Show, click Inactive.
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Figure 11-28: Assign Web Process Templates dialog box

3. On the Available list, select the template or CTRL-click to select the multiple templates
that are to be assigned to multiple web users, and then click the Move button (>) to move
the selected templates to the Selected list.

4. Click Next.

The Assign Web Process Template window is refreshed with options for selecting users
to whom you are assigning the web templates.

Figure 11-29: Assign Web Process Templates window
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5. Do one of the following:

• To assign the selected web process templates to all web users, click Apply to All
Web Users, and then go to Step 8.

• To assign the selected web process templates to only specific users search for the
users by doing one or both of the following, and then go to Step 6.

• In the Search By field, leave the default of User Name or select Email Address.

• To further filter the displayed search results based on either the User Name or
Email Address, in the Find field, enter a search string.

6. Click Display.

The web users who meet your search criteria are displayed in the Available list.

7. On the Available list, select the user or CTRL-click to select the multiple users to whom
you are assigning the web process templates, and then click the Move button (>) to move
the selected users to the Selected list.

8. Optionally, to replace any web process templates that are currently assigned to the users
with the web process templates that you selected in Step 3, click Overwrite Existing
Templates.

9. Click Finish.

A message opens indicating that the web template was assigned successfully.

10. Click OK to close the message and return to the Web Process Templates window.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, if searching by Email Address, a search string of bob 
returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.

If you do not select Overwrite Existing Templates, then the templates that you 
selected in Step 3 are appended to the list of templates that are already assigned to 
the users.



437

 
Virtual EMS (VEMS) Configuration

Configuring Web Menus 

When VEMS is first installed, the main menu has a default layout that determines the 
following:

• The default parent menu options

• The order of the parent options in the main menu

• The child options that appear under each parent menu option

• The order of the child options under each parent menu option

You can add your own user-defined options to the main menu or child options to a parent 
menu. These items can be links to VEMS pages or to websites outside VEMS. 

To configure web menus

1. On the EMS menu bar, click Configuration > Web > Web Menus.

The Web Menus window opens. This window lists all the current parent menu items and
child options in alphabetical order.

Figure 11-30: Web Menus window
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2. Click New.

The Web Menu dialog box opens. The Web Menu tab is the active tab.

Figure 11-31: Web Menu dialog box, Web Menu tab

3. Enter the information for the new web menu item.

4. If translations have been defined for web templates (see “Configuring Web Cultures” on
page 445), then open the Translations tab, and for each translation, click in the Text field,
and enter the appropriate translation for the menu item.

Field Description

Menu Text The text for the item as it is to appear on the VEMS menu.

Sequence Enter a number that indicates the order in which this menu option is to 

appear relative to other parent menu items or relative to other menu 

items that fall under the same parent menu. Items are ordered from 

lowest to highest sequence number, with the item with the lowest 

sequence number appearing first.

Note: If you leave the sequence set to the default value of zero for all 

menu items, then by default, the items are displayed 

alphabetically. 

Link Enter the URL, or web address, for the link, for example, 

www. myorganization.com.

Parent Menu Select the parent menu (the menu under which the item is found) for the 

item. If this item is to be a new parent menu item, then select (none).

New Window Select this option if the destination for this new menu item is to open in a 

new browser window (with VEMS remaining open behind the new 

window).

Authenticated Users 

Only

Select this option if access to this new menu item is to be restricted to 

only those users who have logged in to VEMS.
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5. Click OK.

The Web Menu dialog box closes. You return to the Web Menus window with the newly
configured menu option displayed in the window.

If you have VEMS open, you might have to log out and then log back in to see the 
new menu item.
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Configuring Web Text

Web text is custom help text or policies and procedures that are specific to your organization 
that is displayed on various pages in VEMS and EMS Kiosk. As the EMS administrator, you 
can configure this web text in EMS, or if you are assigned to an appropriate web security 
template (one that has web administrator access), you can configure it directly in VEMS.

To configure web text in EMS

1. On the EMS menu bar, click Configuration > Web > Web Text.

The Web Text window opens. This window lists the name or description for all types of
web text that is currently in use in your VEMS and EMS Kiosk installations and the
VEMS or EMS Kiosk page on which it appears.

Figure 11-32: Web Text window

To show only a specific type of web text, select a type on the Type dropdown list. 

Optionally, to view all web text, whether in use or not, click Obsolete. Obsolete 
web text is displayed in red and italics in the Web Text window.
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2. Select the web text that you are configuring, and then click Edit.

The Web Text dialog box opens. The Web Text tab is the active tab. The tab contains
options for entering and configuring the web text.

Figure 11-33: Web Text dialog box, Web Text tab 

3. Configure the needed web text.

• Design is selected by default. Use the standard Windows plain text formatting
options to format the message (spacing, number of lines, capitalization, and so on)
so that it is displayed the way that you want in the web text.

• Select HTML and enter the necessary HTML code to format the message (spacing,
number of lines, capitalization, and so on) so that it is displayed the way that you
want in the web text.

4. If translations have been defined for web templates (see “Configuring Web Cultures” on
page 445), then open the Translations tab, and for each translation, click in the Text field,
and enter the appropriate translation for the web text item.

5. Click OK.

The Web Text dialog box closes. You return to the Web Text window with the newly
configured web text item automatically selected in the window.
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To configure web text in VEMS

1. Log in to VEMS.

2. Under Admin, click Admin Functions.

The VEMS Admin Function page opens.

Figure 11-34: VEMS Admin Functions page

3. Click Enable Help Text Edit.

A popup window opens indicating that Help Text Mode is now enabled.

4. Close the popup window.

The Help Text toggle on the Admin Functions page now reads Disable Help Text Edit.

Figure 11-35: VEMS Admin Functions page
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5. Open the VEMS page where you are configuring the Help text.

An Edit option is displayed at the top of the page.

Figure 11-36: VEMS page

6. Click Edit.

The page is refreshed with options for entering and configuring the Help text.

Figure 11-37: VEMS page with options for configuring Help text

7. After entering and configuring the Help text, click Save to apply the text to the selected
page.
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8. After you click Save, click Back to Page to view the Help text on its selected page.
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Configuring Web Cultures

If you need to add language translation capability for your web templates or kiosk pages 
(menu text, menu items, and web text items), then you must configure web cultures. Each 
web culture represents a foreign language for which translations must be provided in VEMS 
or EMS Kiosk. 

To configure web cultures

1. On the EMS menu bar, click Configuration > Web > Web Cultures.

The Web Cultures window opens. This window displays all the web cultures that are
currently configured in your EMS database.

Figure 11-38: Web Cultures window

2. Click New.

The Web Culture dialog box opens. By default, the culture is set to English (United
States).

Figure 11-39: Web Culture dialog box
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3. In the Description field, enter a name or description for the new web culture.

4. On the Culture dropdown list, select the appropriate culture (the language into which the
menu text, menu items, and web text items will be translated).

5. Click OK.

The Web Culture dialog box closes. You return to the Web Cultures window with the
newly configured web culture automatically selected.

The description can be a maximum of 50 characters, including spaces.

After you configure a web culture, it is displayed on the Translations tab in 
various configuration areas in EMS.
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Kiosk

EMS Kiosk an optional, web-based module that allows users to access information about 
their reservations or make new reservations from touch screen devices. It can also be used to 
determine the location of an event or a person's location. This chapter details the 
configuration of EMS Kiosk.

This chapter covers the following topics:

• “Configuring EMS Kiosk Profiles” on page 449.

• “Configuring EMS Kiosk Menus” on page 459.
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Configuring EMS Kiosk Profiles

When you configure an EMS Kiosk on a specific touch-screen device, a Kiosk profile is 
specified to control the functionality that is to be available on the device. You configure an 
EMS Kiosk profile through the EMS client.

To configure an EMS Kiosk Profile

1. On the EMS menu bar, click Configuration > Kiosk > Kiosk Profiles.

The Kiosk Profiles window opens. This window lists all the kiosk profiles that are
currently configured in your EMS database and that have a status of Active.

Figure 12-1: Kiosk Profiles window

Optionally, to view all kiosk profiles in your EMS database, regardless of status, 
under Show, click Inactive.

The remainder of this procedure describes how to configure a kiosk profile “from 
scratch.” You can also configure a kiosk profile by copying an existing profile. 
Select the kiosk profile that you want to copy, click Copy, and then go to Step 3.
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2. Click New.

The Kiosk Profile dialog box opens. The Kiosk Profile tab is the active tab.

Figure 12-2: Kiosk Profile dialog box, Kiosk Profile tab

3. Enter the information for the new profile. See:

• “Kiosk Profile tab” on page 451.

• “Rooms tab” on page 452.

• “Menu Items tab” on page 453.

• “Translations tab” on page 454.

• “Images tab” on page 455.

• “Parameters tab” on page 456.

• “Web Text tab” on page 457.

4. Click OK.

You return to the Kiosk Profiles window with the newly configured profile automatically
selected.
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Kiosk Profile tab

1. Enter the information for the new profile.

Figure 12-3: Kiosk Profile dialog box, Kiosk Profile tab

Option Description

Description The name or description for the kiosk profile.

Note: The description can be a maximum of 50 characters, including 

spaces.

Building

Floor

Area

Select the default building, and floor, for the current day’s events. The 

area is used to define the scope of the event display on the Today’s 

Events page. EMS Kiosk users will be able to see events across all the 

buildings that are included in the selected area.

Note: Building is a required value.

Default Translation A translation is the language in which the menu items, menu text, and 

web text are displayed on a kiosk page. Translations are available only 

after you select the pertinent translations on the Translations tab. (See 

“Translations tab” on page 454.) If you do not select a translation, then 

by default, the items and text are displayed in US English. If you need to 

select a different translation, then after you select the pertinent 

translations on the Translations tab, return to this tab and select a 

different default translation.

Note: For translations to be available for selection, the web culture 

must be defined. See “Configuring Web Cultures” on page 445.

Default Floor Plan Select the default floor plan that is to be displayed for the current day’s 

events.

Note: If the needed floor plan is not available, you can configure it. See 

“Configuring Floor Plans” on page 147.
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2. Continue with any other configuration for the profile as needed; otherwise, click OK to
close the Kiosk Profile dialog box and return to the Kiosk Profiles window. The newly
configured profile is displayed in the window.

Rooms tab

You use the Rooms tab to select the rooms that a user can book from the Make Reservation 
page in EMS Kiosk.

Figure 12-4: Kiosk Profile dialog box, Rooms tab

1. On the Building dropdown list, select the applicable building.

2. On the Room Type dropdown list, leave the default value of (all), or select the
appropriate room type.

The Available list displays all the rooms that meet your search criteria.

3. On the Available list, select the room, or CTRL-click to select the multiple rooms that a
user can book from the Make Reservation page, and then click the Move (>) button to
move the selected rooms to the Selected list.

4. Continue with any other configuration for the profile as needed; otherwise, click OK to
close the Kiosk Profile dialog box and return to the Kiosk Profiles window. The newly
configured profile is displayed in the window.

Inactive Leave this option blank to add the kiosk profile as an active profile. 

Select this option to inactivate the profile.

Option Description
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Menu Items tab

You use the Menu Items tab to select the menu items that are to be available to the users of 
EMS Kiosk. Menus are displayed as buttons at the top of EMS Kiosk pages.

Figure 12-5: Kiosk Profile dialog box, Menu Items tab

1. On the Available list, select the menu item, or CTRL-click to select the multiple menu
items that are to be available to an EMS Kiosk user, and then click the Move (>) button
to move the selected items to the Selected list.

2. Continue with any other configuration for the profile as needed; otherwise, click OK to
close the Kiosk Profile dialog box and return to the Kiosk Profiles window. The newly
configured profile is displayed in the window.

You can configure these items to display different text. See “Configuring EMS 
Kiosk Menus” on page 459.
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Translations tab

A translation is the language in which the kiosk displays the menu items, menu text, and web 
text. If a translation is not selected on the Kiosk Profile for EMS Kiosk, then by default, the 
information is displayed in US English. If the appropriate translation is not available on the 
Translations tab, then you can define it. See “Configuring Web Cultures” on page 445.

Figure 12-6: Kiosk Profile dialog box, Translations tab

1. On the Available list, select the language, or CTRL-click to select the multiple languages
that are to be available for displaying information in EMS Kiosk user, and then click the
Move (>) button to move the selected items to the Selected list.

2. If you need to select a default translation, then return to the EMS Kiosk Profile tab, and
select the default translation as appropriate.

3. Continue with any other configuration for the profile as needed; otherwise, click OK to
close the Kiosk Profile dialog box and return to the Kiosk Profiles window. The newly
configured profile is displayed in the window.

Although you can select multiple languages, only one language can be set as the 
default language on the Kiosk Profile tab. If you select multiple languages on the 
Translations tab, an EMS Kiosk user can always select a different language for 
displaying the menu text, menu items, and web text.
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Images tab

Use the Images tab to select images (map of area, image of building, and so on) that are to be 
displayed in the Information area of EMS Kiosk.

Figure 12-7: Kiosk Profile dialog box, Images tab

1. Click New to open the Find Image dialog box, and then browse to and select the image
that is to be displayed in the Images area of EMS Kiosk.

The Find Image dialog box closes. You remain on the Images tab with an entry for the
image displayed on the tab.

2. Optionally, do one or both of the following:

• Edit the description for the image.

• In the Web Long Description field, enter a description of the image.

3. Continue with any other configuration for the profile as needed; otherwise, click OK to
close the Kiosk Profile dialog box and return to the Kiosk Profiles window. The newly
configured profile is displayed in the window.

The image must be in one of the following formats—.gif, .jpeg, .jpg, .bmp, .wmf, or 
.png.

The value that you enter here defines the “long desc” attribute for web content 
accessibility.
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Parameters tab

System parameters are global settings that affect all users on your on EMS Kiosk. The 
parameters are grouped based on the functional areas that they affect. 

1. Edit the parameters as needed on this tab.

Figure 12-8: Kiosk Profile dialog box, Parameters tab

2. Continue with any other configuration for the profile as needed; otherwise, click OK to
close the Kiosk Profile dialog box and return to the Kiosk Profiles window. The newly
configured profile is displayed in the window.

You can also edit the parameters under System Administration > Configuration > 
System Parameters. For a detailed explanation about editing system parameters, 
see “Editing System Parameters” on page 311. For a detailed description of EMS 
Kiosk system parameters, see “EMS Kiosk System Parameters” on page 507.
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Web Text tab

Web text is custom help text or policies and procedures that are specific to your organization 
that is displayed on various pages in VEMS and EMS Kiosk. Web text is defined at the 
global level under Configurations > Web > Web Text. (See “Configuring Web Text” on page 
440.) You use the Web Text tab to override the global setting for a help text and customize 
the help text for a specific kiosk profile.

Figure 12-9: Kiosk Profile dialog box, Web Text tab

1. Select the web text that you are customizing, and then click Edit.

The Web Text dialog box opens. The Web Text tab is the active tab. (See Figure 12-10 on
page 458.) The tab contains options for entering and configuring the web text.

• Design is selected by default. Use the standard Windows plain text formatting
options to format the message (spacing, number of lines, capitalization, and so on)
so that it is displayed the way that you want in the headers and footers.

• Select HTML and enter the necessary HTML code to format the message (spacing,
number of lines, capitalization, and so on) so that it is displayed the way that you
want in the headers and footers.
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Figure 12-10: .Web Text dialog box

2. If translations have been defined for web templates or kiosk pages (see “Configuring
Web Cultures” on page 445), then open the Translations tab, and for each translation,
click in the Text field, and enter the appropriate translation for the web text item.

3. Click OK.

The Web Text dialog box closes. You return to the Web Text tab with the newly
configured web text item automatically selected in the tab.

4. Continue with any other configuration for the profile as needed; otherwise, click OK to
close the Kiosk Profile dialog box and return to the Kiosk Profiles window. The newly
configured profile is displayed in the window.
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Configuring EMS Kiosk Menus

EMS Kiosk menus are displayed as buttons at the top of EMS Kiosk pages. The text that is 
displayed on each button is predefined, but you can edit it if needed. You configure EMS 
Kiosk menus through the EMS client.

To configure EMS Kiosk menus

1. On the EMS menu bar, click Configuration > Kiosk > Kiosk Menus.

The Kiosk Menus window opens. This window lists all the EMS Kiosk menus by name
as well as the description for the menu (the text that appears on the menu button at the
top of EMS Kiosk pages).

Figure 12-11: Kiosk Menus window

2. Select the menu that you are editing, and the click Edit.

The Kiosk Menu dialog box opens. The dialog box displays the menu name for the kiosk
menu and its current description. You cannot edit the menu name.

Figure 12-12: Kiosk Menu dialog box
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3. In the Description field, edit the description for the kiosk menu.

4. If translations have been defined for kiosk information, then open the Translations tab,
and for each translation, enter the appropriate description that is to be translated.

5. Click OK.

The Kiosk Menu dialog box closes and you return to the Kiosk Menus window with the
newly configured menu automatically selected.

The description can be a maximum of 50 characters, including spaces.
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Academic Planning is an optional component of the EMS software that provides all the 
functionality that is necessary for Domain Schedulers to ensure that every class meets in a 
location and at a time that is acceptable to departments and professors. The system provides 
automatic room assignment within user-supplied parameters, integration with your SIS/ERP 
software, and efficient online collaboration tools. It also simplifies final exam scheduling 
and offers a selection of reports to streamline and analyze the room scheduling process. 
When added to the functionality that meeting and event staff already have access to, it 
provides a complete campus-wide space management package referred to as EMS Campus. 
This chapter details the synchronization of the information in your Student Information 
System, or SIS, with the information in your EMS database as well as the configuration of 
campus-specific data items for EMS Campus.

This chapter covers the following topics:

• “Overview of Synchronization” on page 463.

• “Synchronizing Campus-Specific Data” on page 466.

• “Synchronizing Facility Data” on page 468.

• “Configuring Domains” on page 471.

• “Configuring Academic Units” on page 474.

• “Configuring Instructors” on page 477.

• “Configuring the Primary Academic Unit for a Subject” on page 479.

• “Configuring Course Types” on page 481.

• “Configuring Course Types/Room Types Matches” on page 483.

• “Working with Time Block Templates” on page 485.
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Overview of Synchronization

Your Student Information System, or SIS, contains a wealth of information about your 
buildings, room types, rooms, instructors, course types, subjects, and terms. The process of 
importing this SIS data into your EMS database is referred to as synchronization. When you 
import campus-specific data (instructors, course types, subjects, and terms), you create the 
data items in your EMS database. When you import facility data (buildings, room types, and 
rooms), you must either create the data items in your EMS database, or if the facility data 
already exists in your EMS database, then you must link the SIS facility data to the 
corresponding facility data in your EMS database. 

Campus-specific data synchronization

When you import your campus-specific SIS data, all the SIS data items are flagged with a 
status of New. To create these items in your EMS database, you select the items, click Create, 
and then Process. After you create these items in your EMS database, the status of the items 
is set to Synchronized to indicate that the SIS data has been synchronized. If you do not want 
to create the SIS data item in your EMS database (for example, you are importing an 
Instructors list and an instructor is on sabbatical and unavailable to teach classes), then you 
can select the item and click Do Not Import. Previously synchronized items can be 
unsynchronized by selecting the item or items, and then clicking Unsynch. 

Figure 13-1: EMS Campus Instructors window showing SIS data

Before you can carry out synchronization, the Campus Planning Interface must be 
installed and configured. Refer to the EMS Installation instructions for details.

You can select a single data item at a time for processing, you can select multiple 
items for processing using the CTRL-click or SHIFT-click functions, or you can 
select all items in a single step by clicking Select All.



464

 
EMS Campus

Facility data synchronization

When you import facility SIS data, the actions that you must carry out are different if you do 
not have the facility data (building, room type, or room) already configured in your EMS 
database versus if you do have the data already configured. 

• If you have not configured the necessary data items in your EMS database, then all data
items that are imported from your SIS are flagged with a status of New. To configure
these items in your EMS database, you must select the item and then click Create.
(Depending on the item that you select, another window might open with additional
configuration options that are required to completely configure the item in your EMS
database.) For example, in Figure 13-2 below, the PAC-Pacific building, the PKE-Pike
building, the ROCK-Rockies building, and the LNG-Long building exist in the SIS, but
not in the EMS database. The status of the PAC-Pacific building, the PKE-Pike building,
the ROCK-Rockies building is therefore set to New. The status of the of the Long
building was set to Create by selecting the building, and then clicking Create.

Figure 13-2: EMS Campus Buildings window showing SIS data

• If you have configured the necessary data items in your EMS database, and you have
named and/or coded them consistently between your EMS database and your SIS, then
these data items are automatically matched and flagged with a status of New—Auto
Matched. For example, in Figure 13-2 above, the Evans building and the Broncos
building were configured in the EMS database prior to synchronization. Because the
Evans building was named and coded identically as the same building in the SIS, EMS
auto-matched the record for this building. Even though the Broncos building was named
differently, it was coded identically as the same building in the SIS, and therefore, it was
auto-matched as well.

Auto-matching can occur only if each SIS facility data item can be matched to one and
only one EMS data item. For example, if Softball Field and Soccer Field are separate
buildings in the SIS, they cannot both be synchronized with Fields in the EMS database.
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Likewise, if Discussion Room and Conference Room are separate room types in the SIS, 
then the both cannot be synchronized to Meeting Room in the EMS database. In this 
case, the data items that are imported are with a status of New, and you must select each 
New item and assign it to the appropriate corresponding item in your EMS database. 
(See the bullet below.)

• If you have configured the necessary data items in your EMS database, but you have not
named or coded these items consistently between your EMS database and your SIS, then
the data items in your SIS are imported and also flagged with a status of New. You must
select each New item and assign it to the appropriate corresponding item in your EMS
database to set the status to Matched. For example, in Figure 13-2 on page 464, the
Avalanche building was imported from an SIS. The corresponding building in the EMS
database was neither named nor coded identically. As a result, when it was imported, its
status was set to New. After the record was selected and Assign clicked, and the building
matched to an existing building in the EMS database, the status was set to Matched. When
you manually match items, as is the case with Auto-Matching, each SIS facility data item
can be matched to one and only one EMS data item.

• Just as with campus-specific data, you can also flag items from the SIS with a status of
Do Not Import if you do not want the item to be configured in your EMS database, for
example, a building on campus that has been permanently closed or a dormitory building
that does not have space that can be scheduled. For example, in Figure 13-2 on page 464,
the RAP (CLOSED) - Rapids building has been permanently closed, so its status was set
to Do Not Import. After a status has been set for all facility data, (New - Auto Matched,
Matched, Create, or Do Not Import), you must click Process to complete synchronization.
If you do not click Process, then the data items are not configured in your EMS database.
After you create these items in your EMS database, the status of the items is set to
Synchronized to indicate that the SIS data has been synchronized.

You must synchronize your facility data in the following order—Buildings, Room Types, 
and Rooms. The synchronization process does not update existing facility records after they 
have been imported and linked. For example, if a room’s code, description, or capacity is 
changed in the SIS after it has been imported and linked, this information is not changed in 
the EMS database. Previously synchronized items can be unsynchronized by selecting the 
item or items, and then clicking Unsynch. You must unsynchronize items in the reverse order 
in which they were synchronized. For example, you cannot unsynchronize buildings if the 
buildings have rooms that are still synchronized. You must first unsynchronize the rooms, 
and then you can unsynchronize the buildings. Likewise, you cannot unsynchronize room 
type if rooms are still synchronized with the room type. You must first unsynchronize the 
rooms, and then you can unsynchronize the room types. In addition, you cannot 
unsynchronize any facility data if courses that are synchronized use the buildings or rooms. 
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Synchronizing Campus-Specific Data

When you synchronize your campus specific SIS data (Instructors, Course Types, Subjects, 
and Terms), all the SIS data items are flagged with a status of New. To create these items in 
your EMS database, you select the items, click Create, and then click Process.

To synchronize campus-specific data

1. On the EMS Campus menu bar, click Academic Planning > Configuration >
Synchronize Instructors.

The EMS Campus Instructors window opens.

Figure 13-3: EMS Campus Instructors window

2. Select the SIS data item, or CTRL-click to select the multiple data items that you are
creating in your EMS database, click Create, and then click Process.

A message opens indicating that the data items were successfully processed.

The following procedure is written from the perspective of synchronizing 
Instructors, but, by analogy, you can follow this procedure to synchronize course 
types, subjects, and terms.

If you do not want to create an SIS data item in your EMS database, select the 
item, and then click Do Not Import.
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3. Click OK to close the message and return to the EMS Campus Instructors window.

The status of the data items is set to Synchronized to indicate that the SIS data has been
synchronized.

4. Click Cancel or Close (x) to close the window.



468

 
EMS Campus

Synchronizing Facility Data

You must synchronize your facility data in the following order—Buildings, Room Types, 
and Rooms. The synchronization process does not update existing facility records after they 
have been imported and linked. For example, if a room’s code, description, or capacity is 
changed in the SIS after it has been imported and linked, this information is not changed in 
the EMS database.

To synchronize buildings

When you synchronize buildings, the values for Building Code and Description in the SIS 
are used for any new buildings that are configured in your EMS database. You can edit these 
values if needed in EMS. (See “Configuring Buildings” on page 91.)

1. On the EMS Campus menu bar, click Academic Planning > Configuration >
Synchronize Buildings.

The EMS Campus Building window opens.

Figure 13-4: EMS Campus Buildings window

2. Set the status of the imported buildings (New - Auto Matched, Matched, Create, or Do
Not Import) as described in “Facility data synchronization” on page 464.

A window opens that requires you to select a time zone for the referenced buildings.

3. Select the correct time zone, and then click Close to return to the EMS Campus
Buildings window.

4. Click Process.

A message opens indicating that the buildings were successfully processed.

5. Click OK to close the message and return to the EMS Campus Buildings window.

6. Click Cancel or Close (x) to close the window.
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To synchronize room types

1. On the EMS Campus menu bar, click Academic Planning > Configuration >
Synchronize Room Types.

The EMS Campus Room Types window opens.

Figure 13-5: EMS Campus Room Types window

2. Set the status of the imported room types (New - Auto Matched, Matched, Create, or Do
Not Import) as described in “Facility data synchronization” on page 464.

3. Click Process.

A message opens indicating that the room types were successfully processed.

4. Click OK to close the message and return to the EMS Campus Room Types window.

5. Click Cancel or Close (x) to close the window.

After you have synchronized the room types, you can edit the names as needed. See 
“Configuring Room Types” on page 89.
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To synchronize rooms

Before you can synchronize room data, at least one setup type must be configured in your 
EMS database (for example, academic setup), or the synchronization process cannot 
correctly import the room capacity. To configure a setup type, or confirm that one already 
has been configured in your EMS database, see “Configuring Setup Types” on page 87. After 
you have configured or confirmed this setup type, set the value for the following EMS 
system parameter (Area: Campus, Description: Default Setup Type) to this setup type. See 
“Editing System Parameters” on page 311.

1. On the EMS Campus menu bar, click Academic Planning > Configuration >
Synchronize Rooms.

The EMS Campus Rooms window opens.

Figure 13-6: EMS Campus Rooms window

2. Set the status of the imported rooms (New - Auto Matched, Matched, Create, or Do Not
Import) as described in “Facility data synchronization” on page 464.

3. Click Process.

A message opens indicating that the rooms were successfully processed.

4. Click OK to close the message and return to the EMS Campus Rooms window.

5. Click Cancel or Close (x) to close the window.

After you synchronize the rooms, you can edit the names as needed. See “To 
configure one room at a time” on page 110.
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Configuring Domains

A domain is a level of organization within an institution that defines scheduling 
responsibility. Functions such as synchronizing, optimizing, and running reports are carried 
out on a per domain basis. When you configure your domain, you must identify the subjects 
that are offered in the domain and you must also specify the rooms that are controlled by the 
domain. The subjects that are defined within a domain determine the courses listed for the 
domain. The rooms that are defined within a domain determine all spaces that are potentially 
scheduled by the courses. Subjects can belong to only one domain. Rooms can belong to 
multiple domains.

To configure a domain

1. On the EMS Campus menu bar, click Academic Planning > Configuration > Domains.

The Domains window opens. This window lists all the domains that are currently
configured in your EMS database.

Figure 13-7: Domains window

The term “domain” is controlled by an EMS system parameter (Campus: Domain 
Title Singular and Campus: Domain Title Plural), and it is often changed to 
Campus or School to better describe how course scheduling is divided. See 
“Editing System Parameters” on page 311.
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2. Click New.

The Domain dialog box opens. The Domain tab is the active tab.

Figure 13-8: Domain dialog box, Domain tab

3. In the Description field, enter a name or description for the new domain.

4. On the Cancel Status dropdown list, select the status that is to be used for canceling the
room bookings in EMS when a course date is canceled in the SIS after publishing.

5. On the Cancel Reason dropdown list, select the reason that is to be used for cancellations
after publishing.

6. Open the Rooms tab, and optionally do one or both of the following:

• On the Building dropdown list, select (all) buildings, or select a specific building.

• On the Room type dropdown list, leave the value set to (all), or select a specific
room type.

All rooms that meet your search criteria are displayed in the Available list.

7. On the Available list, select the room, or CTRL-click to select the multiple rooms that
are controlled by the campus, and then click the Move (>) button to move the selected
rooms to the Selected list.

8. Open the Subjects tab, and on the Available list, select the subject, or CTRL-click to
select the multiple subjects that are offered by the campus, and then click the Move (>)
button to move the selected subjects to the Selected list.

9. Optionally, click Spelling to spell check the domain before you save it.

The description can be a maximum of 50 characters, including spaces.
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10. Click OK.

The Campus dialog box closes. You return to the Domains window the newly configured
domain automatically selected.
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Configuring Academic Units

An academic unit is a level of organization within an institution that defines responsibility 
for making schedule requests for a portion of a domain. Academic units are used when 
assigning permissions to academic users and when filtering reports. When you configure 
your academic units, you must specify the event type that is to be used when you publish 
your courses in EMS, the group for which the course reservation is to be made, the rooms 
that the units control, and the subjects that are associated with the units. The rooms that are 
defined within an academic unit give the unit the ability to require these spaces during 
optimization. The subjects that are defined within an academic unit determine the courses 
that are listed when filtering by the unit. Both subjects and rooms can belong to more than 
one academic unit.

To configure academic units

1. On the EMS Campus menu bar, click Academic Planning > Configuration > Academic
Units.

The Academic Units window opens. This window lists the units that are associated with
a specific domain.

Figure 13-9: Academic Units window

The term “domain” is controlled by an EMS system parameter (Campus: 
Academic Unit Title Singular and Campus: Academic Unit Title Plural), and 
typically, it is changed to Department or Division to better describe how course 
scheduling requests are divided. See “Editing System Parameters” on page 311.
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2. On the Domain dropdown list, select the domain for which you are configuring the units,
and then click New.

The Academic Unit dialog box opens. The Academic Unit tab is the active tab.

Figure 13-10: Academic Unit dialog box, Academic Unit tab

3. Enter the information for the new academic unit.

Option Description

Academic Unit Code Required field. Abbreviated text that conveys the unit name or 

description. For example, if a unit is named Department of Life Science, 

then a code for the unit could be LIFESCI.

Note: The code can be a maximum of 10 characters, including spaces.

Academic Unit Required field. The name of the unit.

Note: The name can be a maximum of 30 characters, including 

spaces.

Domain The domain with which the units are associated.

Note: The value that is displayed here is the value that you selected in 

Step 2 but you can select a different value if needed.

Building Preference You can leave the building preference set to the default value of (no 

preference), or you can select a specific building, area, or view. If you 

select a specific building, area, or view, then this specific building, area, 

or view is set to the default value for all courses that are held in this 

academic unit during Set Preferences mode, but a user can select a 

different value if needed. If you select Required, then the specific 

building, area, or view is the only value that is allowed for all courses 

that are held in this academic unit during Set Preference modes.
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4. Open the Rooms tab, and optionally do one or both of the following:

• On the Building dropdown list, select (all) buildings, or select a specific building.

• On the Room type dropdown list, leave the value set to (all), or select a specific
room type.

All rooms that meet your search criteria are displayed in the Available list.

5. On the Available list, select the room, or CTRL-click to select the multiple rooms to
which the academic unit should have access, and then click the Move (>) button to move
the selected rooms to the Selected list.

6. Open the Subjects tab, and on the Available list, select the subject, or CTRL-click to
select the multiple subjects that are associated with the academic unit’s schedule, and
then click the Move (>) button to move the selected subjects to the Selected list.

The Academic Unit dialog box closes. You return to the Academic Units window the
newly configured academic unit automatically selected.

Event Type The event type that is to be used for the room bookings when publishing 

your courses in EMS for the unit.

Note: You can also specify the event type at the course type level. The 

event type specified here is used if you choose not to associate 

course types with event types. See “Configuring Course Types” 

on page 481.

Virtual

Web User

Web Process Template

Optionally, you can select a web user for this academic unit and a 

default web process template. After the term is published, this web user 

will see the courses that are associated with this academic unit in the 

View My Requests section of VEMS. To select a web user, click the 

Search icon  to open the Web Users dialog box and search from a 

list of registered web users. 

• You can search by User Name or Email Address.

• To search a list of all available web users, leave the Search field in

the Web Users dialog box blank, and then click Display.

• To search for a specific web user, enter a search string in the Search

field, and then click Display.

Note: The string is not case-sensitive, but your search is limited to the 

exact order of characters in the string and it must begin with the 

information for which you are searching. For example, if searching 

by Email Address, a search string of bob returns 

bob.worth@emssoftware.com but not 

dbobbett@emssoftwarew.com.
To return these fields to their default values at any time, click Reset.

Option Description



477

  EMS 

Campus

Configuring Instructors

When you configure the instructors for your courses, you have the option of designating an 
instructor as one of “High Importance.”

To configure instructors

1. On the EMS Campus menu bar, click Academic Planning > Configuration > Instructors.

The EMS Campus Instructors window opens.

Figure 13-11: EMS Campus Instructors window

2. Optionally, do one or more of the following:

• To display a list of all your synchronized instructors, click Display.

• To filter the list by instructor name (last name, then first name), in the Find field,
enter a search string.

• To filter the list by instructor status, select High Importance Only.

The search string is not case-sensitive, but your search is limited to the exact order 
of the characters in the string and it must begin with the information for which you 
are searching. For example, a search string of Scott returns Scott, Todd, but not 
Bowman, Scott.

The optional “High Importance” designation is used during optimization. 
Courses that are taught by instructors with this designation have the potential to 
be given room preference priority.
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3. Select the instructor whom you are configuring, and then click Edit.

The Instructor dialog box opens. The Instructor field displays the name of the selected
instructor and you cannot edit this value.

Figure 13-12: Instructor dialog box

4. Select or clear the High Importance option for the instructor as appropriate, and then
click OK.

The Instructor dialog box closes. You return to the EMS Campus Instructors window
with the newly configured instructor automatically selected.
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Configuring the Primary Academic Unit for a 

Subject

Typically, a subject is associated with a single academic unit; however, there might be times 
when you must assign a subject to multiple academic units, or departments. For example, 
you might need to assign a History class to a department in the College of Arts and Sciences 
and to a department in the College of Liberal Arts. In this case, you must configure a primary 
academic unit for the subject. A primary academic unit for a subject ensures the following:

• When EMS assigns a building preference to a course that belongs to a shared subject, it
uses the building preference for the primary academic unit.

• When EMS publishes a course that belongs to a shared subject, it uses the Group, Event
Type, and Reservation Source for the primary academic unit.

• When a course that belongs to a shared subject is displayed in the Navigator or Course
Navigator, the primary academic unit for the course is displayed on the Course Info tab.

To configure a primary academic unit for a subject

1. On the EMS Campus menu bar, click Academic Planning > Configuration > Subjects.

The Subjects window opens. This window lists all the subjects that are currently
configured in your EMS database for the indicated domain.

Figure 13-13: Subjects window
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2. On the Domain dropdown list, select the domain for which you are configuring the
subject, select the appropriate subject, and then click Edit.

The Subject dialog box opens. This dialog box lists the code and description for the
selected subject and the code for the selected domain.

Figure 13-14: Subject dialog box

3. Select the primary academic unit for the subject. (The default value is None.)

4. Click OK.

The Subject dialog box closes. You return to the Subjects window with the newly
configured subject automatically selected.

This information was imported from your SIS and you cannot edit it.



481

  EMS 

Campus

Configuring Course Types

When you configure your course types, you have the option of assigning an event type at the 
course type level. If you do not select an event type at the course type level, then the event 
type that you selected at the academic unit level will be assigned to room bookings that are 
created for courses scheduled in EMS.

To configure course types

1. On the EMS Campus menu bar, click Academic Planning > Configuration > Course
Types.

The Course Types window opens. This window lists all your synchronized course types.

Figure 13-15: Course Types window

2. Select the course type that you are configuring, and then click Edit.

The Course Type dialog box opens. The Description field displays the description for the
selected course type, and you cannot edit this value. See Figure 13-16 on page 482.

For information about event types at the academic unit level, see “Configuring 
Academic Units” on page 474.
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Figure 13-16: Course Type dialog box

3. On the Event Type dropdown list, select the event type for the course type, and then click
OK.

The Course Type dialog box closes. You return to the Course Types window with the
newly configured course type automatically selected.

If the appropriate event type is not available, you can configure it. See 
“Configuring Event Types” on page 43. 
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Configuring Course Types/Room Types 

Matches

When you configure course types/room types matches, you are indicating what room types 
are appropriate for what course types. For example, a laboratory room type is appropriate for 
a laboratory class, but not for a general lecture class. The matches that you configure are 
used for the optimization process. When you are configuring course type/room type matches, 
you can approach it from either end—that is, you can select a specific course type and then 
select the room types that are appropriate for the course type, or you can select a specific 
room type and then select the course types that are appropriate for the room type.

To configure course types/room types matches

1. On the EMS Campus menu bar, click Academic Planning > Configuration > Match
Course Types/Rooms Types.

The Match Course Types/Room Types dialog box opens. By default, Course Type is
selected and all the active room types that are currently configured in your EMS
database are displayed in the Room Type list.

Figure 13-17: Match Course Types/Room Types dialog box

If the appropriate room type is not available, you can configure it. See 
“Configuring Room Types” on page 89.
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2. Do one of the following:

• To match a course type to one or more room types:

• Select the course type on the Course Type dropdown list.

• On the Room Types list, select the room type, or CTRL-click to select the
multiple rooms types that are appropriate for the selected course type.

• Click the Move (>) button to move the selected room types to the Selected list.
For example, if you select Discussion/Recitation for the Course Type, then
appropriate room types could be Classroom or Conference Room.

• To match a room type to one or more course types:

• Click Room Type, and on the Room Type dropdown list, select the room type.

• On the Course Types list, select the course type, or CTRL-click to select the
multiple course types that are appropriate for the selected room type.

• Click the Move (>) button to move the selected course types to the Selected list.
For example, if you select Classroom as the room type, then appropriate course
types could be Discussion/Recitation, Lecture, or Independent Study.

3. Click Close.
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Working with Time Block Templates

A time block template is an aggregate of individual, unique meeting patterns for a course, for 
example, MWF from 2:00 to 2:50 pm, TR from 1:30 to 2:50 pm, and M from 1 to 3:50 pm. 
You can use time block templates to limit the meeting patterns that are available during 
Define & Edit mode or Dual mode, to add weight to courses that comply with the template 
during optimization, and in academic reporting. You can manually configure time block 
templates, or if time block patterns from a previously configured term meet your needs, then 
you can import these time patterns and make a new template. During the configuration of 
time block patterns, or after importing time block patterns, if any of these patterns are the 
ones that are the most frequently requested and/or used for courses, then you can designate 
these patterns as prime time. 

To work with time block templates

1. On the EMS Campus menu bar, click Academic Planning > Configuration > Time Block
Templates.

The Time Block Templates window opens. This window lists all the time block
templates that are currently configured in your EMS database. The window also shows
the total number of class meetings possible for each template according to the time block
(day and time) pattern for the template.

Figure 13-18: Time Block Templates window
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2. Click New.

The Time Block Template dialog box opens. The Time Block Template tab is the active
tab.

Figure 13-19: Time Block Template dialog box, Time Block Template tab

3. In the Description field, enter a name or description for the new time block template.

4. Continue to one of the following:

• “To configure time block templates” below.

• “To import time block patterns for a template” on page 488.

To configure time block templates

1. Open the Day Patterns tab, and then on the tab, click New.

The Time Block Days dialog box opens.

Figure 13-20: Time Block Days dialog box

The description can be a maximum of 50 characters, including spaces.
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2. On the Time Block Days dialog box, select the day pattern for the course, and then select
a start time and an end time.

3. Optionally, if the day and time pattern that you are configuring is one that is the most
commonly requested and/or used for courses, then select Prime Time.

4. Click OK.

The Time Block Days dialog box closes. You return to the Day Patterns tab with the
newly configured pattern automatically selected.

Figure 13-21: Time Block Template dialog box, Day Patterns tab

5. Repeat Step 1 through Step 4 until you have configured all the needed time block
patterns.

6. Optionally, if multiple patterns that are displayed on the Day Patterns tab are ones that
are the most commonly requested and/or used for courses, and you want to set these
courses as Prime Time, go to Step 7; otherwise, go to Step 9.

7. CTRL-click to select these patterns, and then select Set Prime Time.

A message opens, asking you if it is OK to set the selected days as Prime Time.

8. Click OK.

The message closes and you return to the Day Patterns tab.

9. Click OK.

The Time Block Template dialog box closes. You return to the Time Block Templates
window with the newly configured time block template automatically selected.

As described here, you can individually specify a day and time pattern as Prime 
Time, or after you configure multiple patterns for a course, you can select them on 
the Day Patterns tab and mark them all as Prime Time in a single step. See Step 6.
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To import time block patterns for a template

1. Open the Day Patterns tab, and on the tab, click Import.

The Term Picker dialog box opens. This dialog box lists all active terms by domain.

Figure 13-22: Term Picker dialog box

2. On the Domain dropdown list, select the appropriate domain, select the term for the
domain that contains the time block patterns that you are importing, and then click OK.

A message opens indicating that the import was successful.

3. Click OK to close the message and return to the Day Patterns tab.

The time block template is created. All the imported time patterns for the template are
displayed on the tab.

Figure 13-23: Time Block Template dialog box, Day Patterns tab
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4. Optionally, do one or both of the following:

• If any of the patterns that are displayed on the Day Patterns tab are ones that are not
needed for the template that you configuring (for example, a non-standard pattern),
and you want to delete these patterns, then do the following:

• Select the pattern, or CTRL-click to select multiple patterns, and then click
Delete.

A message opens asking you if it is OK to delete the selected patterns.

• Click Yes to delete the selected patterns.

The message closes and you remain on the Day Patterns tab.

• If any of the patterns that are displayed on the Day Patterns tab are ones that are the
most commonly requested and/or used for courses, and you want to set these courses
as Prime Time, then do the following:

• Select the pattern, or CTRL-click to select multiple patterns, and then click Set
Prime Time.

A message opens, asking you if it is OK to set the selected days as Prime Time.

• Click Yes to set the selected patterns as Prime Time.

The message closes and you remain on the Day Patterns tab.

5. Click OK.

The Time Block Template dialog box closes. You return to the Time Block Templates
window with the newly configured time block template automatically selected.
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System Parameters

This appendix details the EMS system parameters, the VEMS system parameters, and the 
EMS Kiosk system parameters that you can configure as the EMS administrator.

This appendix covers the following topics:

• “EMS System Parameters” on page 492.

• “VEMS System Parameters” on page 500.

• “EMS Kiosk System Parameters” on page 507.
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EMS System Parameters

Table A-1: EMS System Parameters

Area Description

Academic Import 

(Academic Import 

Module)

Academic Import Days of the Week: Indicates how EMS determines the 

days of the week in import data. 

Note: If a positional option is selected, then the system does not recognize 

standard day of the week abbreviations. For example, if Positional, 

Monday First is selected and the import data file contains MWF as the 

indicator for days of the week for a class, then the system interprets 

this as a Monday/Tuesday/ Wednesday class because there are no 

spaces between the characters. A Monday/Wednesday/Friday class 

is correctly indicated, in Positional, Monday First format as M_W_F, 

where the underscores represent spaces. 

Billing Default Rounding Method for Hourly Pricing: Allows you to specify the 

time increment, from one minute to sixty minutes, by which to round the time 

for hourly pricing.

Billing Determine Invoice Due Date by Adding “xx” Days: Sets the number of 

days specified to determine the invoice due date, for example, 30 days. 

Billing Service Order End Time if None Specified: Select Event Time or Reserved 

Time as the Service Order End Time, unless otherwise specified.

Campus Academic Book Course Color: Color used for courses displayed in the 

Academic Book.

Campus Academic Book Crosslisted Course Color: Color used for cross-listed 

courses displayed in the Academic Book.

Campus Academic Unit Title Plural: System-defined label for Academic Units. 

(Typically renamed to “Departments.”)

Campus Academic Unit Title Singular: System defined label for Academic Unit. 

(Typically renamed to “Department.”)

Campus Accumulate Enrollment On Shared Space Courses (non-crosslisted 

only): Accumulate enrollment on courses that share space instead of using 

the largest enrollment (which is the approach for crosslisted courses).

Campus Allow Cross-Domain Cross Listings: If set to “Yes,” this indicates that 

courses can be cross-listed across multiple domains. 

Campus Allow Sync of Academic Units from SIS: If set to “Yes,” the Synchronize 

Academic Units option is enabled in Academic > Configuration.

Campus Auto Sync - Automatically Process Cancellations: If auto-sync is 

enabled, then course cancellations in your SIS are automatically processed 

in EMS.

Campus Auto Sync - Automatically Process New Courses not assigned to a 

Room: If auto-synch is set to “Yes,” then new courses without a room in your 

SIS are automatically processed in EMS. 

Campus Auto Sync - Automatically Process Room Capacity Violations: If 

auto-synch is set to “Yes,” if a new course is added in your SIS that violates 

room capacity, then the course is automatically processed in EMS.
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Campus Auto Sync User: The EMS user account that is used by the auto-sync 

service for authentication.

Campus Course User Defined Field 01: Maps an EMS user-defined field to a custom 

field in your SIS. 

Campus Course User Defined Field 02: Maps an EMS user-defined field to a custom 

field in your SIS.

Campus Course User Defined Field 03: Maps an EMS user-defined field to a custom 

field in your SIS.

Campus Course User Defined Field 04: Maps an EMS user-defined field to a custom 

field in your SIS.

Campus Course User Defined Field 05: Maps an EMS user-defined field to a custom 

field in your SIS.

Campus Course User Defined Field 06: Maps an EMS user-defined field to a custom 

field in your SIS.

Campus Course User Defined Field 07: Maps an EMS user-defined field to a custom 

field in your SIS.

Campus Course User Defined Field 08: Maps an EMS user-defined field to a custom 

field in your SIS.

Campus Course User Defined Field 09: Maps an EMS user-defined field to a custom 

field in your SIS.

Campus Course User Defined Field 10: Maps an EMS user-defined field to a custom 

field in your SIS.

Campus Day Label - First Day of the Week: The default value is Sunday. 

Determines which day of the week is designated as the first day in various 

areas of EMS Campus such as the Academic Book. The other allowed value 

is Monday. 

Campus Day Label 1 - Sunday: Determines the label that indicates Sunday in 

various areas of EMS Campus such as the Time Block Template 

configuration area. The default value is U.

Campus Day Label 2 - Monday: Determines the label that indicates Monday in 

various areas of EMS Campus such as the Time Block Template 

configuration area. The default value is M.

Campus Day Label 3 - Tuesday: Determines the label that indicates Tuesday in 

various areas of EMS Campus such as the Time Block Template 

configuration area. The default value is T.

Campus Day Label 4 - Wednesday: Determines the label that indicates Wednesday 

in various areas of EMS Campus such as the Time Block Template 

configuration area. Default value is W.

Campus Day Label 5 - Thursday: Determines the label that indicates Thursday in 

various areas of EMS Campus such as the Time Block Template 

configuration area. Default value is R.

Campus Day Label 6 - Friday: Determines the label that indicates Friday in various 

areas of EMS Campus such as the Time Block Template configuration area. 

Default value is F.

Table A-1: EMS System Parameters (continued)

Area Description
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Campus Day Label 7 - Saturday: Determines the label that indicates Saturday in 

various areas of EMS Campus such as the Time Block Template 

configuration area. Default value is S.

Campus Default Cancel Reason: Used for courses when publishing a term.

Campus Default Event Type: Used for courses when publishing a term.

Campus Default Group: Used for courses when publishing a term.

Campus Default Reservation Source: Used for courses when publishing a term.

Campus Default Seat Fill Percentage: Used to determine an appropriate room size 

for a class of a specific estimated enrollment (typically 100%). 

Campus Default Setup Type: Used to build a setup type and capacity (from the SIS) 

when synchronizing rooms (typically “classroom”).

Campus Domain Title Plural: System defined label for Domains (typically renamed to 

“Campuses”).

Campus Domain Title Singular: System defined label for Domain (typically renamed 

to “Campus”).

Campus Final Exam Event Type: Used when creating a final exam booking.

Campus Include CRN in Reservation Event Name: Include the Course Reservation 

Number (CRN) in front of the event name post-publish in all areas of EMS 

Campus where the event name is used.

Campus Keep Sibling Crosslisting Room Assignments in Sync: A sibling 

cross-list describes a crosslist that has at least three courses and the two 

child courses have a meeting pattern that is not shared with the parent 

course. If set to “Yes,” then these sibling crosslist courses become a matched 

set and are placed in Crosslist status and not Conflict.

Campus Large Class Size (If More Than XX Students): Used to determine what 

constitutes a “large” class for weighting by enrollment in the room 

optimization process. Explained in detail in the Room Optimization section of 

the EMS User’s Manual.

Campus Large Class Size Weight Adjustment: Used to adjust the optimization 

weighting for a “large” class. Explained in detail in the Room Optimization 

section of the EMS User’s Manual.

Campus Lock Academic Unit Room Access: Used during optimization process. If 

set to Yes, a room will be assigned to an Academic Unit' (i.e. Department) 

course only if that Academic Unit owns the room.

Campus Manually Update SIS/ERP System After Publishing: If set to “No”, course 

location in the SIS will be automatically updated during the publishing 

process.

Campus SIS/ERP Title: System defined label for SIS/ERP (typically “SIS”).

Campus Small Class Size (If Less Than XX Students): Used to determine what 

constitutes a “small” class for weighting by enrollment in the room 

optimization process. Explained in detail in the Room Optimization section of 

the EMS User’s Manual.

Table A-1: EMS System Parameters (continued)

Area Description



495

Appendix A

System Parameters

Campus Small Class Size Weight Adjustment: Used to adjust the optimization 

weighting for a “small” class. Explained in detail in the Room Optimization 

section of the EMS User’s Manual.

Campus Subject Title Plural: System defined label for Subjects (typically “Subjects”).

Campus Subject Title Singular: System defined label for Subject (typically 

“Subject”).

Campus Sync Course Dates Without Start/End Times: If set to No, Courses with 

incomplete course date records (i.e. missing start/end times or dates) will not 

be imported into EMS Campus.

Campus Web Service URL: The URL to the Campus Planning Interface service.

Email Enable Email Support: When set to “Yes,” you can, directly from EMS, 

email a Confirmation to the contact person for the group that is making a 

reservation. 

Email SMTP — Save Email Attachments (Database Size Will Increase): When 

set to “Yes,” an option is available to save all attachments (invoices, 

confirmations, and so on) when emailing a group and/or contact.

Email SMTP – Use SSL: Used if your SMTP Server is enabled for SSL

Groups & Contacts Allow Change to External Reference: When set to “Yes,” allows users to 

change external reference on groups and contacts.

Groups & Contacts Allow Search by External Reference: When set to “Yes,” allows users to 

search groups and contacts by external reference.

Groups & Contacts Default Address Format as International: Defaults the International 

checkbox to true when adding a new group or contact.

Groups & Contacts Default Country: Defaults the Country field to the value that is specified 

when adding a new group or contact.

Groups & Contacts Default Pricing Plan For New Groups: Used when a creating a new group 

record.

Groups & Contacts Default Require Contact: Used when creating a new group record.

Groups & Contacts Group Bad Status Title: Label used for “Bad” value on the Group Status 

dropdown list.

Groups & Contacts Group OK Status Title: Label used for “OK” value on the Group Status 

dropdown list.

Groups & Contacts Group Warning Status Title: Label used for “Warning” value on the Group 

Status dropdown list.

Groups & Contacts Offer Dropdown Selection of Groups: When set to “Yes,” the system 

automatically populates the Group window with all active groups in your EMS 

database. A user can enter a search string in the Starts with field to and the 

list of groups that meet the search criteria is dynamically updated as the user 

enters the string. When set to “No,” users must manually search for groups. 

Groups & Contacts Pricing Plan Required For Groups: When set to “Yes,” users must specify 

a pricing plan for new groups and contacts.

Groups & Contacts Show Account Field on Group: When set to “Yes,” an Account field is 

displayed on Group/Contact records.

Table A-1: EMS System Parameters (continued)

Area Description
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Groups & Contacts Web Users Linked to Groups via External Reference: Links group and 

web user records if group records are defined as individual employees (i.e., 

not departments) in your system. When making a new reservation in EMS, 

the web user field is automatically populated based on the group selected. 

Hoteling (EMS 

Workplace)

Reservation Book “Checked-In” Color: The color used when a group/

employee has checked in for the day. 

Hoteling (EMS 

Workplace)

Reservation Book “Checked-Out” Color: The color used when a group/

employee has checked out for the day.

Hoteling (EMS 

Workplace)

Reservation Book “Not-Checked-In” Color: The color used when a group/

employee has not yet checked in for the day. 

Labels 1st Contact Title: The label for the 1st Contact field.

Labels 2nd Contact Title: The label for the 2nd Contact field.

Labels Area Title Plural: The plural label for the Area field.

Labels Area Title Singular: The singular label for the Area field.

Labels Billing Reference Title Plural: The plural label for the Billing Reference 

field.

Labels Billing Reference Title Singular: The singular label for the Billing 

Reference field.

Labels Building Title Plural: The plural label for the Building field.

Labels Building Title Singular: The singular label for the Building field.

Labels Check Number Title: The label for the Check No. field.

Labels Confirmation Grand Total Title: The label for the Confirmation Grand Total 

field.

Labels Confirmation Subtotal Title: The label for the Confirmation Subtotal field.

Labels Default Phone 1 Label: The default label for the first phone-type number 

field.

Labels Default Phone 2 Label: The default label for the second phone-type number 

field.

Labels Event Coordinator Title: The label for the Event Coordinator field.

Labels External Reference Title: The label for the External Reference field.

Labels Group Title Plural: Plural of the term that is used in your organization’s EMS 

system to refer to people who hold events in your facility (for example, 

employees, groups, clients, customers, and so on). 

Labels Group Title Singular: Singular of the term that is used in your organization’s 

EMS system to refer to people who hold events in your facility (for example, 

employees, groups, clients, customers, and so on). 

Labels Payment Type Title Plural: The plural label for the Payment Type field. 

Labels Payment Type Title Singular: The singular label for the Payment Type field. 

Labels Phone/Fax Labels List: Specifies the options that are available in fields 

shown for phone numbers. Enter the text items, separated by semicolons, 

that you want to appear in the dropdown menu for phone-type numbers. The 

default is “Phone; Fax; Mobile; Pager; Other”. 

Table A-1: EMS System Parameters (continued)

Area Description
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Labels PO Number Title Plural: The plural label for the PO Number field.

Labels PO Number Title Singular: The singular label for the PO Number field.

Labels Room Size Title: The label for the Room Size field.

Labels Room Title Plural: Plural of the term that is used in your organization’s EMS 

system refer to reservable spaces (e.g., rooms, fields, and so on). 

Labels Room Title Singular: Singular of the term that is used in your organization’s 

EMS system refer to reservable spaces (e.g., rooms, fields, and so on). 

Labels Sales Category Title Plural: The plural label for the Sales Category field.

Labels Sales Category Title Singular: The singular label for the Sales Category 

field.

Labels Salesperson Title: The label for the Salesperson field.

Notifications Allow Users To Delete Notifications: When set to “Yes,” allows users to 

delete notifications.

Notifications Exclude Building Closures On Notifications: When set to “No,” building 

closures are not excluded from notification date calculations.

Notifications Exclude Weekends On Notifications: When set to “No,” weekends are not 

excluded from notification date calculations.

Notifications Ignore Building Closure/Weekend Notification Settings Beyond xx 

Days: Specifies the number of days after which building closures and/or 

weekends are ignored for notification date calculations.

PAM Allow date/time changes on PAM Bookings in EMS Client: If set to “No,” 

then EMS users are prevented from making any changes to bookings 

created on VEMS using the PAM module. 

Note: Before enabling, please contact your DEA consultant to discuss.

PAM PAM Web Service URL: The URL to the optional Plan A Meeting (PAM) 

module. Specify only if the optional PAM module is enabled in your 

environment.

Reports Calendar Inquiry Print Format: The format that is automatically selected 

when the Print button is clicked for the Event Calendar report. 

Note: You select the format for the Event Schedule report as you run the 

report.

Reports Include Activities on Service Order Forms: If set to “No,” activities are not 

included on service order forms.

Reports Include Catering Details on Setup Worksheet: If set to “Yes,” catering 

details are displayed on the Setup Worksheet report.

Reports Include this Notes Category on Service Order Forms: Allows you to 

select the notes category on service order forms.

Reports Reset Page Numbers by SO on Service Order Forms: If set to “Yes,” page 

numbers are reset by the service order on service order forms.

Reports Room Description Format: Determines how room information is displayed 

in reports: as a code or as a description, with or without building code. 

Table A-1: EMS System Parameters (continued)

Area Description
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Reservations Allow Bookings to Be Added to Outlook Personal Calendar: If set to 

“Yes,” then EMS users can click an Outlook option to add bookings to their 

personal calendars. 

Reservations Book Building Closed Color: The color that is used in the Reservation 

Book to indicate building closures.

Reservations Book Holiday Color: The color that used in the Reservation Book to 

designate holidays.

Reservations Book Weekend Color: The color that is used in the Reservation Book to 

designate weekends.

Reservations Building Display: Indicates how building information is to be displayed in 

reservations—by building code or building description.

Reservations Default Event Coordinator: When set to “No,’ no default value is provided 

when a user is making a reservation in the Reservation Wizard. 

Reservations Exclude Room Charge from Services Indicator: In various EMS locations 

(the Reservation Book, the Navigator, the Edit Booking form, and so on) EMS 

provides an indication that services exist for a booking. If set to “Yes,” then a 

room charge category is excluded from displaying as a service on the 

booking. 

Reservations Group Bookings by UTC times and keep together on Video 

Conferencing Reservations: When set to “Yes,” then any changes that are 

made to a booking that belongs to video conference occurrence cascade to 

the other related bookings within the occurrence.

Reservations Lock Booking Details if Booking Is Locked: If set to “No,” the booking 

details remain editable even when the booking is locked because of invoicing 

or its age.

Reservations Lock Bookings Older Than “xx” Days: The number of days after a booking 

has occurred that is automatically locked and cannot be edited. 

Reservations Lock Occurring/Past Reservations For Non-Administrators: If set to 

“Yes,” then a reservation is locked for editing by non-administrator users after 

one booking in the reservation has occurred. EMS administrators have full 

editing capability.

Reservations Max Length for Event Name: The maximum number of characters, 

including spaces, that a user can enter in the Event Name field when creating 

a new reservation.

Reservations Room Display: Indicates how room information is to be displayed in 

reservations—by room code or room description.

Reservations Update Billing Information When Changing Group: If set to “Yes,” 

automatically updates the billing information when a user selects a different 

group for a reservation.

Reservations Update Room Charge When Room Changes: If set to “Yes,” automatically 

updates the room charge when a user selects a different room for a 

reservation.

Reservation Use Billing Reference Allocation: Enables an EMS user to allocate 

reservation, booking, or service order charges across multiple Billing 

Reference numbers by percentage.

Table A-1: EMS System Parameters (continued)

Area Description
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Reservations Use Calendar Styles: Select Yes or No to enable the use of calendar styles 

on the Event Schedule report and on the Event Calendar report.

Reservation Use PO Number Allocation: Enables an EMS user to allocate reservation, 

booking, or service order charges across multiple PO Numbers by 

percentage.

Reservation Validate Billing Reference: Validates the Billing Reference entered against 

the Billing Reference table. Specify No Validation, Valid Only, or Warning for 

Invalid (Blanks Are Invalid), or Warning for Invalid (Blanks are Valid).

Reservation Validate PO Number: Validates PO Numbers entered against the PO 

Number table. Specify No Validation, Valid Only, or Warning for Invalid 

(Blanks Are Invalid), or Warning for Invalid (Blanks are Valid).

Reservations Validation of Building Hours: Specify On Reserved Time or On Event 

Time.

Reservations Warn When Booking More Than “xx” Months in Future: System warns 

user if they attempt to create a reservation that has bookings that will take 

place x number of months in the future. 

Resources Check Inventory When Using Reservation Tools: If set to “Yes,” the 

system automatically verifies resource availability when you copy details, 

copy reservations or change the date, time or room for multiple bookings. 

Resources Use Resource Selector: If set to “Yes,” a special resource selector window 

is used when adding detail to bookings. 

Service Orders Auto Adjust Service Order Times: If set to “Yes,” then Service Order Times 

are automatically adjusted when a booking is edited.

Service Orders Default Service Order Times and Count from Booking: When creating a 

new service, sets the default service order times to the event/reserved time. 

If set to (none), no default service order times are set.

Service Orders Show External Service Option on Categories: When Set to “Yes,” an 

External Service field is displayed on the Category dialog box for a Catering 

category or a Resource w/ Service Orders category.

System Dashboard Check Interval: Indicates how frequently the Dashboard should 

check for updates. 

Note: Setting this for more frequent updates might impact application 

performance.

System Disable Online Help: If set to “Yes,” then Online Help is not available for the 

EMS system. (The link Help > Contents is not displayed on the EMS main 

menu.)

System Hide Currency Indicator: Hides the currency symbol (for example, $) on 

confirmations and invoices.

System Server Time Zone: Sets the time zone for the server to the indicated value.

System Use Integrated Authentication Only: If set to “Yes,” then EMS users are 

required to manually log-in and authenticate against LDAP.

System Virtual EMS URL: The VEMS URL that is displayed in VEMS emails and 

EMS group notifications.

Table A-1: EMS System Parameters (continued)
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VEMS System Parameters

The default values for VEMS parameters are also applied as the default values for new web 
process templates; however, you can edit these values for the template. 

Table A-2: VEMS System Parameters

Area Description

Account 

Management

Allow Web User to Opt Out of Automatic Emails: Allows web users to 

specify if they want to receive any automatic emails (for example, 

confirmation, reminders, and so on) from VEMS.

Account 

Management

Auto Create Web User Account (for Integrated Authentication): A web 

user account is automatically created via the integrated authentication 

process if a new user “hits” the VEMS site.

Account 

Management

Default Security Template for User: The default VEMS Web Security 

template that is assigned to new web users.

Account 

Management

Field Used to Authenticate Web User: Indicates the field—Email Address, 

Network ID, or External Reference—that is used to authenticate a web user 

that logs in to VEMS.

Account 

Management

Note Label on Account Management: Label for the large text field on the 

Account Management window.

Account 

Management

Security Status for User: This entry becomes the default status (Active, 

Inactive, Pending) for new web users.

Account 

Management

On Login Automatically Set Web User Time Zone to First Building’s 

Time Zone: After a VEMS user logs in, the time zone for the user is set to the 

time zone for the first building that is stored in the EMS database. If this 

building, however, is not listed on the Facilities dropdown list, then the time 

zone is set to the first available time zone on the Time Zone dropdown list, but 

the user can always select a different value if one is available.

Authentication Portal Authentication Cookie Key: See the Virtual EMS (VEMS) Integrated 

Authentication Configuration instructions.

Authentication Portal Authentication Method: See the Virtual EMS (VEMS) Integrated 

Authentication Configuration instructions.

Authentication Portal Authentication Variable: See the Virtual EMS (VEMS) Integrated 

Authentication Configuration instructions.

Book Display Setup/Teardown Times: If enabled, setup/teardown bars are visible 

on reservations in the Reservation Book.

Book Ignore Room Display on Web Flag: Ignores the Room Display on Web 

setting to determine if an event should be marked as ‘Private’.

Book Room Description Format in Book: Determines how room information is 

formatted. Options are Room Description or Room Code.

Booking Details Make Add to Personal Calendar Link Appear: If this option is set to Yes, 

the Add to Personal Calendar link is displayed when a web user views the 

details of an event.

Booking Details Show Social Networking Options: If set to “Yes,” then displays links to 

various social networking sites when a user views the details of a booking.



501

Appendix A

System Parameters

Browse Events Browse Event Default Display Format: Determines the initial format in 

which the Browse Events function displays information. Options are: Day, 

Week List, Month List, Week Calendar, and Month Calendar.

Browse Events Collapse Bookings into Reservations in Browse Events: Specify No or 

Yes to collapse bookings into reservations.

Browse Events Drop Events from Daily View After They Occur: Specify No or Yes to drop 

events from the daily view after the event occurs.

Browse Events Location Format: Determines how location information is displayed in the list 

views of the Browse Events function.

Browse Events Maximum Number of Events/Day to Display: Controls the number of 

events that are available for display, per day, in the daily views of the Browse 

Events function. 

Note: In some circumstances, you must click a link to see additional events.

Browse Events Maximum Number of Events/Day to Display in Monthly View: Controls the 

number of events that are available for display, per day, in the monthly views 

of the Browse Events function.

Note: In some circumstances, you must click a link to see additional events.

Browse Events Maximum Number of Events/Day to Display in Weekly View: Controls the 

number of events that are available for display, per day, in the weekly views of 

the Browse Events function.

Note: In some circumstances, you must click a link to see additional events.

Browse Events Secondary Event Sort (After Date/Time): If date and time information for 

multiple events are identical, Location or Event Name is used to sort events 

on the calendar.

Browse Events Show End Time in Browse Events: If this option is set to No, only start time 

is shown in Browse Events.

Browse Events Show Group Name in Browse Events: If set to “Yes,” then the name of the 

group that is holding an event is shown in Browse Events.

Browse Events Show Group Type Filter in Browse Events: If set to “Yes,” then the group 

type filter is an option in Browse Events.

Browse Events Show Location on Browse Events: If set to “Yes,” then the event location is 

displayed in the calendar view on the Browse Events page.

Browse Events Show Room Type Filter in Browse Events: If set to “Yes,” then a Room 

Type filter is displayed on the Browse Events page.

Browse for Space Description in Event Bar on Browse for Space: Determines what 

information should show in the free/busy bar in the Book. Options include: 

None, Event Name or Group Name.

Browse for Space Number of Hours to Show on Browse for Space: Determines the number 

of hours that are displayed on the grid. Options include: 12 Hours (optimized 

for a 800x600 display) and 16 Hours (optimized for a 1024 x768 display).

Browse for Space Start Time on Browse for Space: Determines the start time for the grid.

Email Account to Use for Sending Email: This is the email account against which 

outgoing email from VEMS is authenticated.

Table A-2: VEMS System Parameters (continued)

Area Description
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Email Allow Email My Password: Allows web users to email their passwords to 

themselves.

Email Default Subject for Email: This entry appears in the Subject line of email the 

reservation summary email that is generated when a web user submits a 

reservation.

Email Email Address of Sender: This entry indicates the “From” email address in 

the reservation summary email that is generated when a web user submits a 

reservation.

Email Format for Request Summary: Specify a detailed or summarized report for 

the reservation summary email that is generated when a web user submits a 

reservation.

Email Name of Email Sender: This entry indicates the “From” name in the 

reservation summary email generated when a web user submits a 

reservation.

Email Name or IP Address of SMTP Server: SMTP server used solely for VEMS.

Email Password of Email Account: This entry indicates the password for the email 

account.

Email Send Request Summary upon Submit: Determines whether reservation 

summary information is emailed to the web users when a reservation is 

submitted.

Email SMTP Server Port: The default email port for your SMTP server.

EMS for Outlook Outlook Book Bookings Color: Used for the EMS for Outlook module. 

Color used to designate “busy” times for rooms.

EMS for Outlook Outlook Book Bookings Conflict Color: Used for the EMS for Outlook 

module. Color used to identify a conflict for a room selection.

EMS for Outlook Outlook Book Selected Booking Color: Used for the EMS for Outlook 

module. Color used to designate room selection.

EMS for Outlook Show Attendees in Book: If set to “Yes,” then the attendees for an event are 

displayed in the Grid view for the event.

EMS for Outlook Text to display under icon in for EMS for Outlook: The text that is 

displayed for the EMS for Outlook desktop icon.

Floor Plans Floor Mapping Web Service URL: Used for the Floor Plan module. URL 

address for the floor mapping web service.

Labels Event Title Plural: This is the plural version of the label for “events.”

Labels Event Title Singular: This is the singular version of the label for “event.”

Labels Label for Login box: The label for the User ID field on the Login page.

Labels Label for “Private” in Book: The default label for a private event entry in 

various windows, for example, Browse for Space page.

Reservations - 

Checkout

Allow Billing Reference Lookup: If set to “Yes,” then a user can look up pre-

configured billing references when making a reservation in the Reservation 

Wizard.

Table A-2: VEMS System Parameters (continued)

Area Description
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Reservations - 

Checkout

Allow PO Number Lookup: If set to “Yes,” then a user can look up pre-

configured PO numbers when making a reservation in the Reservation 

Wizard.

Reservations - 

Checkout

Allow Temporary Contacts: If set to “Yes,” then a user can specify a 

temporary contact for a group when making a reservation in the Reservation 

Wizard.

Reservations - 

Checkout

Attachments Allowed Extensions: The allowed attachment types for room 

requests.

Reservations - 

Checkout

Billing Reference Validation: Select from No Validation, Required But Not 

Validated, or Required and Validated.

Reservations - 

Checkout

PO Number Validation: Select from No Validation, Required But Not 

Validated, or Required and Validated.

Reservations - 

Checkout

Require Contact Email: Specify No or Yes to require contact email at 

checkout.

Reservations - 

Checkout

Require Contact Phone: Specify No or Yes to require a contact phone 

number at checkout.

Reservations - 

Checkout

Reservation Comment Type on Checkout: Select the reservation comment 

type that is to be displayed upon checkout.

Reservations - 

Checkout

Show 2nd Contact: If set to “Yes,” then the 2nd contact fields are displayed 

on the reservation upon checkout.

Reservations - 

Checkout

Show Billing Reference on Reservation: If set to “Yes,” then the billing 

reference is displayed on the reservation upon checkout.

Reservations - 

Checkout

Show PO Number on Reservation: If set to “Yes,” then the PO number is 

displayed on the reservation upon checkout.

Reservations - 

Checkout

Attachments Allowed on Room Request: If set to “Yes,” then a user can 

add attachments to a room request.

Reservations – 

Room Request

Allow User to Change Setup Count in Selected Locations Area: If set to 

“Yes,” then a user can change the setup count in the “cart” after adding a 

room. 

Reservations – 

Room Request

By Default, Enable Add to Calendar Checkbox (for PAM): Defaults the 

Add to Calendar checkbox to Yes in the optional Plan-a-Meeting module.

Reservations – 

Room Request

Default Pricing Plan: Indicates the default pricing plan that is used to display 

pricing in VEMS.

Reservation – 

Room Request

Default Room Availability View: When a user searches for available rooms, 

this parameter drives the default display. Options are Grid, List or Floor Map.

Reservations – 

Room Request

Default Value for Attendance: A default value for attendance when users 

make a room request.

Reservations – 

Room Request

Display Areas as Filter: If set to “Yes,” areas are available as a filter. (Shown 

as a dropdown list.)

Reservations – 

Room Request

Exclude Closures from Date Calculations: If set to Yes, closures are not 

taken into account on booking rule date calculations.

Reservations – 

Room Request

Exclude Weekends from Date Calculations: If set to Yes, weekends are 

not taken into account on booking date calculations.

Table A-2: VEMS System Parameters (continued)
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Reservations – 

Room Request

Allow Single Day Requests for Unavailable Rooms (for PAM): If set to 

“Yes,” then a PAM user making a one day booking request can book an 

unavailable room.

Reservations – 

Room Request

Hide Daily Recurrence Option: Hide the daily recurrence option on the 

Room Request page.

Reservations – 

Room Request

Hide Monthly Recurrence Option: Hide the monthly recurrence option on 

the Room Request page.

Reservations – 

Room Request

Hide Random Recurrence Option: Hide the random recurrence option on 

the Room Request page.

Reservations – 

Room Request

Hide Weekly Recurrence Option: Hide the weekly recurrence option on the 

Room Request page.

Reservations – 

Room Request

Number of Available Rooms upon Search: Specify the number of available 

rooms that are displayed.

Reservations – 

Room Request

Override Default Room Setup/Teardown Times: If set to “Yes,” the default 

setup/teardown times defined for a room are ignored and the Setup Time in 

Minutes for All Rooms and Teardown Time in Minutes for All Rooms 

parameters are used instead.

Reservations – 

Room Request

Reservation Source for New Reservation: Specify the only reservation 

source that a user can select for a reservation.

Reservations – 

Room Request

Sequence of Available Rooms upon Search: Select from Room 

Description or Book Sequence.

Reservations - 

Room Request

Setup Time in Minutes for All Rooms: If the Override Default Room Setup/

Teardown Times parameter is set to “Yes,” this value is used for the setup 

time. 

Reservations – 

Room Request

Setup Type Validation Rule: Determines how VEMS deals with the 

attendance specified in a request as compared to the capacity for a room. 

Four options are available:

• No Setup and No Validation: Do not show the Setup Type field in the 

reservation process and do not validate the number in the Attendance field 

against room capacities (i.e., show all available rooms). 

• Validate But Don't Show: Do not show the Setup Type field but validate 

the number in the Attendance field against the default capacity (regardless 

of setup type) for each room. 

• Show and Validate: Show the Setup Type field and validate the 

attendance and setup type against setup type/capacity pairings for the 

rooms. 

• Show But Don't Validate: Show the Setup Type field but do not validate 

setup type or attendance.

Reservations – 

Room Request

Show Additional Filters Initially: If set to “Yes,” then by default, the 

Availability Filters section is expanded.

Reservations – 

Room Request

Show Attendance on Room Request: Specify No or Yes to display the 

Attendance field in a Room Request.

Reservations – 

Room Request

Show Check Availability on Classic Request: If this option is set to Yes, 

the Check Availability option is displayed on the Room Request page (web 

process template mode = Request).

Table A-2: VEMS System Parameters (continued)
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Reservations – 

Room Request

Show Feature Filter: Set to “Yes” to show the Feature list as a room request 

search option.

Reservations – 

Room Request

Show Floor Filter: Set to “Yes” to show the Floor list as a room request 

search option.

Reservations – 

Room Request

Show Room Pricing: Set to “Yes” to show the room’s price in a Room 

Request.

Reservations – 

Room Request

Show Room Type Filter: Set to “Yes” to show the Room Type list as room 

request search option.

Reservations – 

Room Request

Show Room Drop Down on Classic Request: If set to “Yes,” then the 

Rooms dropdown list is displayed on the Room Request page if the web 

process template mode = Request.

Reservations – 

Room Request

Teardown Time in Minutes for All Rooms: If the Override Default Room 

Setup/Teardown Times parameter is set to “Yes,” this value is used for the 

setup time.

Reservations – 

Room Request

Validation of Building Hours: Specify on Reserved Time or on Event Time.

Reservation – 

Room Request

Warn User if Room Selected is Not Available for All Dates: Specify Yes if 

you want a user to be notified if a selected room is not available for all 

requested dates.

Reservations – 

Summary

Allow Add Booking to Reservation: If set to “Yes,” users can add bookings 

to reservations.

Reservations – 

Summary

Allow Edit UDFs on Reservation: If set to “Yes,” users can edit their UDFs 

on the Reservation Summary page.

Reservations – 

Summary

Allow Reservation Edits: Specify Yes to allow a web user to edit his/her 

reservation information (group, contact, event name, and so on).

Reservations - 

Summary

ICS File (Calendar Appointment) Status: Specify Busy or Tentative as the 

default calendar appointment status.

Reservation 

Summary

Require Cancellation Reason: If set to “Yes,” then if a user cancels a 

reservation/booking, the user is required to supply a cancellation reason.

Reservations – 

Summary

Show Service Availability: Displays Service Availability link on the 

Reservation Summary page.

Services Adjust Service Order Times upon Booking Edit: If set to “Yes,” then 

Service Order Times are automatically adjusted if the booking time is 

modified.

Services Allow Edit of Services: If this option is set to “Yes,” users can edit the 

services they have added to events.

Services Maintain Inventory: If this option is set to “Yes,” the system notifies the user 

if an attempt to reserve a resource would cause the resource to be 

overbooked. The user must then select a new quantity.

Services Populate Service Setup with Attendance: If set to “Yes,” populates the 

service setup with the expected attendance number.

Services Restrict Service Order Times Within Event Times: If set to “Yes,” then 

VEMS users cannot specify service order start/end times that fall outside the 

event start/end times.

Table A-2: VEMS System Parameters (continued)
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Services Set Service Time Default from the Event Time: If set to “Yes,” then the 

service start/end times are set by default to the event start/end times.

Services Show Resource Pricing: Set to “Yes” to display the prices of resources.

Unauthenticated 

Requests

Access to Classic Request for Unauthenticated Users: Specify No or Yes 

to allow access to the Room Request page when the web process template 

mode = Request.

View My Requests Show Group Column on View My Requests: Specify No or Yes to display 

the Group column in View My Requests.

Table A-2: VEMS System Parameters (continued)

Area Description
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EMS Kiosk System Parameters

Table A-3: Kiosk system parameters

Area Description

Floor Plans Floor Plan Web Service URL: The full URL for the web service used by 

the optional Floor Plan Configuration module. See “Configuring Floor 

Plans” on page 147.

Hoteling Allow Check In From Kiosk (EMS Workplace): If set to “Yes,” allows 

a user to check in to a workspace from EMS Workplace.

Hoteling Enable Group Type Filtering on Make Reservation (EMS 

Workplace): If set to “Yes,” enables feature filtering and/or room type 

filtering by group type on the Make a Reservation page.

Hoteling Group Type Filtering Space Label on Make Reservation (EMS 

Workplace): The label used if group type filtering is enabled.

Make Reservation Conflict Status for New Reservation: The status that is applied to 

bookings that are in conflict with an existing booking.

Make Reservation Default End Time for New Reservation: The daily end time for new 

reservations. This setting is only used if the parameter Allow Start/End 

Time Editing is set to “No,” or if multi-day bookings are allowed.

Make Reservation Default Event Name for New Reservation: The default name for new 

reservations that are created through EMS Kiosk The %USER% text is 

a variable that is replaced with the group name. You can remove this 

variable.

Make Reservation Default Search=Floor Map on Make Reservation: If set to “Yes,” then 

when an EMS Kiosk user searches for available rooms, the floor plan 

view is used for the default results.

Make Reservation Default Start Time for New Reservation: The default start time for new 

reservations that are created through EMS Kiosk. This setting is only 

used if the parameter Allow Start/End Time Editing is set to “No,” or if 

multi-day bookings are allowed.

Make Reservation Display Start/End Time Drop Downs: If set to “Yes,” the Start Time 

and End Time dropdown lists are displayed on the Make Reservation 

page. If set to “No,” the default start and end times are used for 

bookings.

Make Reservation Enable Web Process Security Template: If set to “Yes,” the user's 

web process templates in addition to the rooms that are configured in 

the kiosk profile are used to determine which rooms are displayed on 

the Make Reservation page.

Make Reservation Event Type for New Reservation: The event type that is applied to 

reservations created through EMS Kiosk. 

Make Reservation Number of Future Concurrent Days Allowed for New Reservations: 

The number of days in the future that bookings can be made.

Make Reservation Reservation Source for New Reservation: The reservation source 

that is applied to reservations created through EMS Kiosk.
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Make Reservation Start Date Allowed for New Reservation (days): The number of days 

after the current day’s date that a reservation can be made through EMS 

Kiosk.

Make Reservation Status for new Reservation: The status that is applied to reservations 

created through the EMS Kiosk. 

Make Reservation Time Drop Down Increment: The time increment that is used on Time 

dropdown menus.

Miscellaneous Browser Title: The text that is displayed in the title bar of the Kiosk 

browser.

Miscellaneous Default Page: The first page that first opens in EMS Kiosk or that is 

displayed when EMS Kiosk times-out.

Miscellaneous Disable Stand-by Mode on Timeout: If set to “No,” then EMS Kiosk 

goes into Standby-by Mode (a Stand By button is displayed) after timing 

out.

Miscellaneous Display Cancel Button for Group Searches: If set to “Yes,” the 

Cancel button is displayed for group searches, allowing the user to 

cancel a search.

Miscellaneous Location Format: Select from Building Code, Room or Room 

Description or Building Description, Room or Room Description.

Miscellaneous Max Records Returned for Group Searches: The maximum number 

of records returned when searching for a group. 

Miscellaneous Max Booking/Availability Records Returned: The maximum number 

of rooms that are displayed when making a reservation.

Miscellaneous Page Timeout (seconds): The period of inactivity in EMS Kiosk, after 

which the default page is displayed.

My Reservations: Allow User to Cancel Bookings: If set to “Yes,” then users can cancel 

bookings from the Reservations page. 

My Reservations: Allow User to End Bookings: If set to “Yes,” then users can end their 

bookings from the My Reservations page.

My Reservations: Cancel Status: The status that is applied to canceled bookings.

My Reservations: Future Booking Cancellation Cutoff (days): The number of days prior 

to a future booking that the booking can be canceled.

My Reservations: Same Day Booking Cancellation Cutoff (minutes): Used in 

conjunction with the Allow User to Cancel Bookings parameter. A user 

can cancel an in-progress booking up to the number of indicated 

minutes before the booking occurs.

Security Group Field used for “Exact Match” Authentication: The field that is 

compared with the ID that the user enters: External Reference, Badge 

Number, Personnel Number (all of these are group settings). This 

parameter is used in conjunction with the Primary User Authentication 

Type parameter, which must be set to Exact Match.

Table A-3: Kiosk system parameters (continued)
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Security Primary User Authentication Types: The options are as follows:

• Standard - Partial names are enough for a match, and all groups that 

match are listed. 

• Exact Match - The ID entered must exactly match what is set in the 

parameter Group Field Used for “Exact Match” Authentication. 

• LDAP - Both the user's network ID and password must be entered. 

Security Require Authentication for all Kiosk Functions: Requires users to 

identify themselves before using EMS Kiosk. Used for kiosks in a public 

location where an exact user ID match is needed.

Security Require Timeout/Logoff to Terminate User Session: If set to “Yes,” 

then a user must “hit” the Log Off button to end their EMS Kiosk 

session.

Security Secondary User Authentication Types for Badge Authentication: 

(Used only if “Badge” is primary security). Alternate authentication 

method that is used when a user doesn't have his/her badge.

Security Show 10 Key as Modal: Used with the Use 10-Key Keyboard for 

Authentication parameter. Displays 10-key keyboard as a modal popup 

on the page.

Security Use 10-Key Keyboard for Authentication: Uses a numeric 10-key 

numeric keyboard instead of the full keyboard.

Today’s Events Display Building Drop Down: If set to “Yes,” users can filter by building 

on the Today's Events page. 

Today’s Events Display Event Name Search: If set to “Yes,” then the Search for Events 

button is displayed on the Today’s Events page.

Today’s Events Display Floor Drop Down: If set to “Yes,” users can filter by floor on the 

Today's Events page. 

Today’s Events Display Room Type Drop Down: If set to “Yes,” users can filter by 

room type on the Today's Events page. 

Today’s Events Drop Events in Past: If set to “Yes,” then events that occurred before 

the current day’s time are not displayed on the Today's Events page.

Table A-3: Kiosk system parameters (continued)

Area Description
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This appendix details the configuration of the necessary features, resources, rooms, and web 
process templates to accommodate reservations or room requests that require video 
conferencing capability.

This appendix covers the following topics:

• “Overview of Video Conferencing Configuration” on page 513.

• “Configuring Video Conferencing Capabilities” on page 515.

  

Video conferencing capabilities are available only in EMS Enterprise. They are 
not available in EMS Professional.
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Overview of Video Conferencing Configuration

Standard EMS room configuration is suitable for organizations that use only built-in/fixed 
video conference rooms for video conferences. For environments that use video conference 
mobile carts, however, additional configuration options are available to simplify the video 
conference room/mobile cart request process. When configured properly, EMS searches for 
all rooms that have a built-in video conferencing feature and it searches for all rooms that 
can accommodate a mobile video conferencing cart. A room that has a built-in video 
conferencing feature is displayed in the search results only if the room is available. A room 
that can accommodate a mobile video conferencing cart is displayed in the search results 
only if the room is available and at least one mobile video conferencing cart is available for 
selection. The end result of this configuration is that after a reservation is complete, booking 
details are automatically created for a user. The user does not have to add them manually. If a 
user selects a room that has a built-in conferencing feature, then the feature is indicated for 
the room. If the user selects a room that uses a mobile video conferencing cart, then the 
mobile cart is automatically added to the booking. This information can be viewed like any 
other booking detail in the Navigator and on reports like the Setup Worksheet report.

Figure B-1:  Reservation with video conferencing features automatically added to bookings

You must configure the following three types of rooms to provide enhanced searching 
capability for rooms that have a video conferencing feature:

• Meeting rooms with built-in video conference capability. Room availability for this type 
of room is based on the true availability of the room for the time slot selected. If a user 
selects one of these rooms, a booking detail (for example, “Built-in Video Conference 
Equipment”) is automatically created after the reservation is submitted. This provides 
indication that a user is requesting use of the video conferencing equipment in the room. 

• Standard meeting rooms that can accommodate a mobile video conferencing cart. Room 
availability for this scenario is based on the availability of the room and on the availability 
of the mobile video conferencing cart resource pool. For a room to be displayed as 
available, at least one mobile video conferencing cart must be available for the time slot 
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selected. If a user selects one of these rooms, a booking detail for a mobile video 
conferencing cart is automatically added to the booking after the reservation is submitted.

• A room or other location that is not managed in EMS that can accommodate a mobile 
video conferencing cart. The room is configured as an Override Description room type. 
Room availability for this scenario is based only on the availability of the mobile video 
conferencing cart resource pool. If a user selects this room, the user is provided an option 
for entering a location. After the reservation is submitted, a booking detail for a mobile 
video conferencing cart is automatically added to the booking.

This behavior is driven in the EMS client by the selection of the video conferencing feature 
in the Reservation Wizard. In VEMS, after you correctly configure a web process template 
that has the Video Conference option selected, a VEMS user is not required to make any 
selections—the search for the feature is carried out automatically and the user can select 
from a list of available rooms that meet the search criteria.
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Configuring Video Conferencing Capabilities

When you are configuring video conferencing capabilities you must first configure the 
necessary features and resources. After you configure the necessary features and resources, 
you can then configure the rooms, the override rooms, and the web process templates that are 
needed to accommodate reservations or room requests that require video conferencing 
capability. When you configure the rooms, one room type must use the built-in video 
conferencing resource and one room type must use the mobile video conferencing cart 
resource.

To configure features and resources

1. Configure a video conferencing feature, for example, one named as simply as Video 
Conferencing. When you configure this feature, you must select Tied to Resource. See 
“Configuring Features” on page 85.

2. Configure a category in which the video conferencing resources will be placed, 
for example, A/V, A/V Equipment, Video Conferencing, or so on. See “Configuring 
Categories” on page 155.

3. Configure two distinct video conferencing resources for the category that you just 
created. See “Configuring Resources for a Category” on page 206.

• A resource for built-in video conferencing equipment, for example, Built-in Video 
Conference Equipment. 

• A resource for a mobile video conferencing cart, for example, Mobile Video 
Conferencing Cart.

To configure a built-in video conference room

1. Search for a room for which the video conferencing feature that you defined in Step 1 of 
“To configure features and resources” is applicable. (See “To search for a room” on page 
109.)

2. Select the room, and then click Edit. 

The Room dialog box opens.

  

Do not select the Maintain Inventory option when you are configuring this 
resource. 

You must select the Maintain Inventory option when you are configuring this 
resource and you must enter a value in the Quantity Available field.
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3. Open the Features tab on the Room dialog box, and on the Available list, select this 
video conferencing feature.

The Resource Selector dialog box opens. 

Figure B-2:  Resource Selector dialog box

4. Select the resource that you designated for built-in video conferencing equipment.

The Selected list on the Features tab is updated with the selected feature/resource 
combination.

5. Click OK to save your changes.

6. Repeat this procedure for every room in your organization that has built-in video 
conferencing features.

  

The feature is designated as being “tied to a resource.”

Remember, you can use the Room Configuration Wizard to mass assign a feature 
to multiple rooms in a single step. See “Room Administration Wizard” on page 
366.



517

Appendix B

Video Conferencing

To configure a room that can accommodate a mobile video 

conferencing cart

1. Search for a room for which the video conferencing feature that you defined in Step 1 of 
“To configure features and resources” is applicable. (See “To search for a room” on page 
109.)

2. Select the room, and then click Edit. 

The Room dialog box opens.

3. Open the Features tab on the Room dialog box, and on the Available list, select this 
video conferencing feature.

The Resource Selector dialog box opens. 

Figure B-3:  Resource Selector dialog box

4. Select the resource that you designated for the mobile video conferencing cart.

The Selected list on the Features tab is updated with the selected feature/resource 
combination.

5. Click OK to save your changes.

6. Repeat this procedure for every room in your organization that can accommodate a 
mobile video conferencing cart.

The feature is designated as being “tied to a resource.”
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To configure an override room that can accommodate a mobile 

video conferencing cart 

1. Configure an override room (for example, “Other”). See “Configuring Rooms” on page 
109.

2. On the Room dialog box, in the Available list, select the video conferencing feature that 
you defined in Step 1 of “To configure features and resources.”

The Resource Selector dialog box opens. 

Figure B-4:  Resource Selector dialog box

3. Select the resource that you designated for the mobile video conferencing cart.

The Selected list on the Features tab is updated with the selected feature/resource 
combination.

4. Click OK to save your changes.

Remember, you can use the Room Configuration Wizard to mass assign a feature 
to multiple rooms in a single step. See “Room Administration Wizard” on page 
366.

When you configure this room, make sure to select Override Description for the 
room classification.

The feature is designated as being “tied to a resource.”
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5. Repeat this procedure for every override room that can accommodate a mobile video 
conferencing cart at your organization.

To configure a web process template

1. Configure two video conferencing specific event types—one event type that is used to 
designate which of the bookings in the reservation is the host location (for example, 
“Host VC”) and one event type that is applied to all the other bookings in the reservation 
(for example, “VC”). See “Configuring Event Types” on page 43.

2. Configure a web process template (see “To configure a web process template” on page 
402) with the following characteristics:

• The mode is Self Serve.

• The Video Conference option is selected for the template.

• The two Event Types that you created in Step 1 are selected for the template.

• On the Video Conference tab:

• On the Feature dropdown list, select the video conferencing feature that you 
defined in Step 1 of “To configure features and resources.”

• On the Host Event Type dropdown list, select the video conferencing host Event 
Type that you defined in Step 1.

Remember, you can use the Room Configuration Wizard to mass assign a feature 
to multiple rooms in a single step. See “Room Administration Wizard” on page 
366.
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This appendix details the purpose and implementation of the Video Display Interface, which 
is an optional, add-on component for EMS that exports meeting and event information to a 
video display system such as Janus, Target Vision, and so on. 

This appendix covers the following topics:

• “Configuring the Video Display Interface” on page 523.
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Configuring the Video Display Interface 

The Video Display Interface (VDI) is an optional, add-on component for EMS that exports 
meeting and event information to a video display system such as Janus, Target Vision, and so 
on. It does this by periodically saving booking information to a file which the video display 
system then retrieves and displays on video monitors. You use the windows-based Task 
Scheduler to set the frequency at which the EMS Video Display Interface program 
(EMS.exe) runs. This program stores the booking information and creates the export file. 
You set parameters in EMS that define the types of bookings that are to be included in the 
export file (based on buildings, statuses, and so on), where the exported file should reside, 
and other information. You must manually export the booking information once and create 
the export file before you can configure EMS to automatically export the information.

To configure the VDI

1. On the EMS menu bar, click System Administration > Tools > Video Display Interface.

The Video Display Interface dialog box opens. The Date Range tab is the active tab.

Figure C-1:  Video Display Interface dialog box

2. Specify the settings for exporting the booking information:

• The first time you configure the VDI, or if you edit your VDI settings, you must 
specify a date range for the system to save the settings. Going forward, the system 
automatically exports the information only for the bookings that are taking place on 
the current day’s date based on the frequency that you specify.

• To export data for a different date or date range, on a one-time only basis, enter the 
date or range. If the export is to contain only bookings taking place in a particular 
time frame, check the Use Specific Times box and enter the starting and ending 
times. After this manual update, the system reverts to exporting data for the current 
day’s date based on the frequency that you specify.



524

Appendix C

Video Display Interface

• In the Format field, select the pre-defined VDI export format. (If you select 
PowerPoint as the pre-defined VDI export format, then the Bookings for Slide fields 
is enabled. You must also indicate the number of bookings that are to appear on a 
slide.)

• In the Export File Path, click the Search icon  to open Export File Path dialog 

box and browse to and select the file to which you are exporting the data, or you can 
manually enter the full path to the file with the file name and extension. 

• On the Buildings tab, Statuses tab, Event Types tab, and Group Types tab, specify 
the building/room, status, event type, and group criteria by which to filter the 
booking information that you are exporting. 

3. Click Export.

A message opens indicating that the export file was created successfully.

4. Click OK.

After you have manually run the export once, you can set up the system to export events 
automatically. Following the steps outlined in your Windows operating system 
documentation, use the Task Scheduler to define a scheduled task that executes EMS.exe 
on a regular basis (typically once each day). The file is located in the folder in which the 
client portion of the EMS system is installed. (The default is C:\Program Files\ EMS 
[PRODUCT NAME and VERSION NUMBER]). Before existing the Task Scheduler, 
select “Open advanced properties for this task when I click Finish” and append /vdi to 
the end of the EMS path in the “Run” textbox, for example: 
“C:\Program Files\EMS [PRODUCT NAME and VERSION NUMBER]\EMS.exe”/vdi. 

If needed, after you configure your export settings, you can click Memorize to save 
the export settings as a memorized report so that you do not have to specify the 
export settings every time you export your meeting and event information. If you 
save the export settings as a memorized report, you can make the report public 
(available to all users in your EMS database) or private (available only to you.) 
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This appendix details the purpose and implementation of the Academic Import Utility, which 
is an optional, add-on component for EMS that is designed to communicate with academic 
scheduling programs for one-off imports of course schedule data. 

This appendix covers the following topics:

• “Configuring the Academic Import Utility” on page 527.
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Configuring the Academic Import Utility

The Academic Import Utility (AIU) is an optional, add-on component for EMS that is 
designed to manually import from your Student Information System, or SIS. For each 
scheduled class that is being imported, a single reservation with multiple bookings is created. 
One booking is created for each date on which the class meets. All class reservations created 
by the import process are assigned to one Group (customer, client, and so on) that you have 
configured in your EMS database. The imported class data can be one of two formats, tab-
delimited or fixed width.

All fields are required unless noted otherwise.

Table D-1: Tab-delimited format

Field Field 

Sequence

Max 

Width

Type Format Example

Department 1 10 Alpha 

numeric 

Left Justified ACCT 

Course 2 10 Alpha 

numeric 

Left Justified 101 

Section 3 10 Alpha 

numeric 

Left Justified 1 

CourseTitle 4 225 Alpha 

numeric 

Left Justified Intro to Accounting 

Instructor 5 50 Alpha 

numeric 

Left Justified Bob Smith 

Days 6 7 Alpha 

numeric 

Left Justified Parameter

driven.

Positional or

specific text.

e.g. “M W

F” for

Positional,

Monday

First

Building 7 10 Alpha 

numeric 

Left Justified AC 

Room 8 20 Alpha 

numeric 

Left Justified 101 

BegTime 9 4 Numeric Zero Filled 

(Numerics only)

1400 
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EndTime 10 4 Numeric Zero Filled 

(Numerics only)

1450 

StartDate 

(Optional)

11 10 Date Formatted (mm/

dd/yyyy)

8/30/2007 

EndDate

(Optional)

12 10 Date Formatted (mm/

dd/yyyy)

12/17/2007 

Attendance

(Optional)

13 5 Numeric Zero Filled 

(Numerics only)

35 

All fields are required unless noted otherwise.

Table D-2: Fixed width format

Field Column Width Field 

Type

Format Example

Department 1 10 Alpha 

numeric 

Left Justified, 

Trailing Spaces 

ACCT 

Course 11 10 Alpha 

numeric 

Left Justified, 

Trailing Spaces 

101 

Section 21 10 Alpha 

numeric 

Left Justified, 

Trailing Spaces 

1 

CourseTitle 31 225 Alpha 

numeric 

Left Justified, 

Trailing Spaces 

Intro to Accounting 

Instructor 256 50 Alpha 

numeric 

Left Justified, 

Trailing Spaces 

Bob Smith 

Days 306 7 Alpha 

numeric 

Left Justified, 

Trailing Spaces 

Parameter

driven.

Positional

or specific

text. e.g.

“M W F”

for

Positional,

Monday

First

Table D-1: Tab-delimited format (continued)

Field Field 

Sequence

Max 

Width

Type Format Example
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Prior to using the AIU, you should have the following items configured in your EMS 
database:

Building 313 10 Alpha 

numeric 

Left Justified, 

Trailing Spaces 

AC 

Room 323 20 Alpha 

numeric 

Left Justified, 

Trailing Spaces 

101 

BegTime 343 4 Numeric Right Justified, 

Zero Filled 

(numerics only)

0800 

EndTime 347 4 Numeric Right Justified, 

Zero Filled 

(numerics only) 

1450 

StartDate 

(Optional)

351 10 Date Formatted (mm/

dd/yyyy) 

08/30/2007 

EndDate 

(Optional)

361 10 Date Formatted (mm/

dd/yyyy) 

12/17/2007 

Attendance 

(Optional)

371 5 Numeric Right Justified, 

Zero Filled 

(numerics only) 

00035 

Item Description

Group When reservations are created through the import process, one Group 

(client, customer, and so on) is the reservation holder for all 

reservations. You might want to define a group that is used specifically 

for the reservations that are created through the import process, for 

example, Registrar's Office.

New Bookings Status When running the AIU, you must specify a status for the new bookings 

that are created. This status must of the “Book Space” status type. While 

you can use an existing status such as Confirmed, it is generally best to 

create a new status (for example, Academic - Confirmed) to denote the 

imported data. 

Conflict Status You must create a conflict status to give to the new bookings if the room 

they require is already booked. This status should have a status type of 

either “Info Only” or “Wait,” as those types of bookings can be created 

even if there is already a confirmed booking in the room. Academic - 

Conflict is a commonly used name for this status. 

Cross List Status You must create a status to apply to bookings when the system 

encounters conflicts within an import file (i.e., the same class with 

different names). This status should have a status type of either “Info 

Only” or “Wait.”

Table D-2: Fixed width format (continued)

Field Column Width Field 

Type

Format Example
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In addition, you might want to define a unique Event Type and Setup Type that is to be used 
solely for class reservations. 

To import data, you must configure a session for each block of data (i.e., quarter or 
semester). After you have configured a session, AIU saves the settings for use in both the 
initial import and any subsequent re-import. When a session is re-imported, only events in 
the import file that have changed since the last import are recreated in the EMS database. 
This prevents the unnecessary re-import of unchanged events and the associated invalidation 
of large ranges of reservation numbers. After configuring a session, you import the data for 
the session. 

Reservations that were added to the EMS database using the AIU can be removed from the 
database using the AIU as well. Deleting a session removes all reservations created using the 
session. 

  

Override Status You can configure the settings in an AIU session to allow AIU bookings 

to override existing bookings, if appropriate. The status is changed for 

the existing bookings and the room is reserved for the imported 

bookings. You must create an override status to apply to the bookings 

that have been bumped. This status should have a status type of either 

“Info Only” or “Wait.” 

Creating reservations can take an extended time and must be performed when no 
users are logged in to EMS. (To log off active users, see “Viewing and Emailing 
Logged-In Users” on page 383.) The time required to create reservations varies 
depending on the amount of data involved and the processing power of the 
computer making the reservations. After the import process completes, the system 
automatically displays a report listing booking conflicts, if any.

Before you configure an AIU session, you should review the Academic Import 
Days of the Week setting in your system parameters. This setting dictates whether 
the AIU interprets days of the week based on their position within the data (with 
options for Sunday first or Monday first) or based on specific text entries (Su = 
Sunday, M = Monday, and so on). See Appendix A, “System Parameters,” on page 
491.

Item Description



531

Appendix D

Academic Import Utility

To configure an AIU session

1. On the EMS menu bar, click Reservations > Academic Import > Academic Import 
Utility.

The Sessions window opens. This window lists all the sessions that are currently 
configured in your EMS database.

Figure D-1:  Sessions window

2. Click New.

The Session dialog box opens.

Figure D-2:  Session dialog box

This section describes the steps for configuring a new session for the AIU. If you 
simply need to load an existing session, then after opening the Sessions window, 
skip to “To import the data into the session” on page 533.
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3. Enter the information for the new AIU session.

Field Description

Session Code A unique identifier for the session, for example, SPRING08.

Description An expanded definition of the session code, for example, Spring 

Semester 2008.

Note: The description can be a maximum of 50 characters, including 

spaces.

Start Date

End Date

The start date and end date for the session, for example, 1/15/08 and 

5/31/08.

Group The reservation holder for all reservations in the session. For example, 

Registrar's Office. You can select a value from the Group dropdown list, 

or you can click the Search icon  to open the Groups window and 

create the necessary group. See “Configuring Groups” on page 277.

Event Type Select a value from the dropdown list. If none of the event types that are 

currently configured in your EMS database meets your needs, then you 

can configure a type (for example, Academic). See “Configuring Event 

Types” on page 43.

Setup Type Select a value from the dropdown list. If none of the event types that are 

currently configured in your EMS database meets your needs, then you 

can configure a type (for example, Classroom). See “Configuring Setup 

Types” on page 87.

Status The status for the new bookings that are created. 

Note: While you can use an existing status such as Confirmed, it is 

generally best to create a new status (for example, Academic - 

Confirmed) to denote the imported data. See “Configuring 

Statuses” on page 164.

Conflict Status Available after you specify a Status. Select a value from the dropdown 

list. If none of the statuses that are currently configured in your EMS 

database meets your needs, then you can configure a status (for 

example, Academic - Conflict). See “Configuring Statuses” on page 164.

Use Cross List Status Select this option if the system is to apply a special status to classes 

that are cross-listed in the import file. (The class appears twice in the 

file, with each occurrence having a different name.)

Cross List Conflict 

Status

Available if you select Use Cross List Status. The status that is to be 

applied to cross-listed classes. Select a value from the dropdown list. If 

none of the statuses that are currently configured in your EMS database 

meets your needs, then you can configure a status (for example, 

Academic - Cross List). See “Configuring Statuses” on page 164.

Override Existing 

Bookings

Select this option if the system is to give import file events precedence 

over existing events in the EMS database.

Override Conflict Status Available if you select Override Existing Bookings. The status that is to 

be applied to existing events if they are overridden by imported events. 

Select a value from the dropdown list. If none of the statuses that are 

currently configured in your EMS database meets your needs, then you 

can configure a status (for example, Academic - Conflict). See 

“Configuring Statuses” on page 164.
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4. Click OK.

The Session dialog box closes. You return to the Sessions window with the newly 
configured session displayed in the window.

5. Continue to “To import the data into the session.”

To import the data into the session

1. Select the session into which you are importing the course information, and then click 
Load.

The first of three AIU windows opens.

Figure D-3:  AIU window #1

2. Click the Search icon  to browse to and select the file that you are importing.

3. On the Import Format dropdown list, select the format for the file (Fixed Width or Tab 
Delimited).

  

Reservation Source Select a source for the reservation. If none of the sources that are 

currently configured in your EMS database meets your needs, you can 

configure a source. See “Configuring Reservation Sources” on page 70.

Field Description
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4. Click Next. 

Two results are possible:

• If any of the records in the import file have any issues (missing data, data that is not 
in the correct format, data that falls outside the start and/or end dates, and so on) a 
message opens that details the issue and if applicable, the number that cannot be 
imported, and asking if you want to continue. You can click No in the message, and 
then correct the errors in the file before you load the file again, or you can click Yes 
in the message, and then click Next to continue.

• The import file is complete and there are no issues with the file, so no message 
opens. Click Next to continue.

The second of three AIU windows opens. This window lists the academic Building 
and the Room that are currently reserved for all the classes in the import file. For a 
new import file, the Building/Room combinations have a status of Assigned or Do 
not Import. Unassigned classes must be assigned to a room in EMS. Classes with a 
status of “Do Not Import” are not to be assigned to a room in EMS. 

Figure D-4:  AIU window #2

5. Optionally, select a different View option and/or a different Building option to filter the 
information that is displayed in the window. (The default display is all views (Assigned, 
Unassigned, and Do not Import) for all buildings.)

  

Optionally, you can also do one or both of the following:

• You can click View Errors for more information.

• You can click Export Errors to export the errors in the import file an an XML 
format.
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6. Select an unassigned class, or CTRL-click to select the multiple unassigned classes, and 
then click Assign.

The Room Selector dialog box opens.

Figure D-5:  Room Selector dialog box

7. On the Building dropdown list, select the building or view by which to filter the 
available rooms list.

8. On the Available rooms list, select the room to which the classes are to be assigned, and 
then click OK.

Two results are possible:

• If you selected a single class to assign to the room, then the class status is changed to 
Assigned in the AIU window. The EMS Building code and EMS room name are 
displayed for the class in the AIU window.

• If you selected multiple classes to assign to the same room, then a message opens 
asking you if you are sure that you want to assign all the selected items to the same 
room. Click Yes in the message. The class status is changed to Assigned for all the 
selected classes in the AIU window. The EMS Building code and EMS room name 
are displayed for the classes in the AIU window.
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9. Click Next.

The third AIU window opens. In the right pane, the window lists the dates for which 
bookings will be created for the selected classes.

Figure D-6:  AIU window #3

10. Optionally, do one or both of the following:

• To add more booking dates, select the date in the left pane, and then click the Add 
button to open the Date Pattern dialog box and specify the date patterns for the 
bookings that should be created.

• To delete booking dates, select the date in the right pane, and then click Delete.

11. After you have added or deleted the necessary booking dates, click Finish. Two results 
are possible.

• A message opens indicating that the session was successfully imported. The 
reservations are created in the EMS database. Continue to Step 12.

• One more conflicts, cross-listings, and/or duplicated courses exist in the import file. 
The Academic Import Unit Results window opens. Continue to “To resolve 
conflicts, cross-listings and duplicates in an AIU file” on page 537.

12. Click OK to close the message and return to the Sessions window.
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To resolve conflicts, cross-listings and duplicates in an AIU file

If one or more conflicts, cross-listings, and/or duplicates (two identical course records) exist 
in the AIU text file, then after the file is imported, the Academic Import Unit Results 
window opens. The Booking Conflicts tab on the window lists all the courses in the file that 
are in conflict or cross-listed. The Status column displays the Conflict and Cross List statuses 
that you previously configured. The Duplicates tab lists all the duplicated courses.

Figure D-7:  Academic Import Unit Results window

To resolve these issues, and successfully import the session information, do the following:

• To resolve courses that are in conflict, or are cross-listed, select the course on the 
Bookings Conflict tab, and then click Go To to open the reservation in the Course 
Navigator. Review the information for the course, and then decide how to resolve the 
issue either by changing the room for the course, changing the date/time for the course, 
and so on.

• To resolve duplicated courses, open the Duplicates tab to view and note the duplicated 
courses. You must then delete one of the entries for a duplicated course directly from the 
import text file, and then reimport the file. When you reimport the file, only the changes 
that you made, and not the entire file, are imported. (In this case, only the single entry that 
remains for a duplicated course is reimported.)

For detailed information about the steps that you can take to resolve conflict or 
cross-listing issues, see Reviewing Reservations and Resolving Room Assignments 
in the EMS User’s Manual.
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You have the option of importing a variety of data items into your EMS database from 
tab-delimited text files, including holidays, rooms, resources, groups, reservations, and 
course schedule patterns. This appendix details the import file specifications for each of 
these data items. 

This appendix covers the following topics:

• “Holiday Import File Specifications” on page 541.

• “Room Import File Specification” on page 542.

• “Resource Import File Specification” on page 543.

• “Group Import File Specifications” on page 544.

• “Reservation Import File Specifications” on page 545.

• “Course Schedule Import File Specifications” on page 546.
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Holiday Import File Specifications

Field Field 

Sequence

Max Width Data Type Format Optional 

or 

Required

Example

Date 1 10 Date mm/dd/yyyy Required 11/27/2008

Description 2 30 Alphanumeric Left Justified Required Thanksgiving Day

Notes 3 7000 Alphanumeric Left Justified Optional Staff Holiday – No Events 

Allowed
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Room Import File Specification

Field Field 

Sequence

Max 

Width

Data Type Format Optional or 

Required

Example

Room Code 1 16 Alphanumeric Left Justified Required BCR

Room Description 2 50 Alphanumeric Left Justified Required Breckenridge Conference Room
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Resource Import File Specification

Field Field 

Sequence 

Max Width Data Type Format Optional 

or 

Required

Example 

Grouping 1 50 Alphanumeric Left Justified Required Beverages

Description 2 50 Alphanumeric Left Justified. Must be a 

unique value.

Required Coffee

Notes 3 7000 Alphanumeric Optional Decaf provided upon 

request

Price 4 2 decimal 

places

Decimal (##.##) Optional 10.00

Available On 

Web

5 5 Alphanumeric  True or False Optional True

Express 

Checkout

6 5 Alphanumeric  True or False Optional False

Serves 7 2 decimal 

places

Decimal (##.##) Optional 10

Min. Quantity 8 2 decimal 

places

Decimal (##.##) Optional 5
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Group Import File Specifications

Field Field 

Sequence

Max Width Data Type Format Optional or 

Required

Example

Group Name 1 50 Alphanumeric Left Justified Required Accounting Department

Address 1 2 50 Alphanumeric Left Justified Optional 834 Colorado Blvd.

Address 2 3 50 Alphanumeric Left Justified Optional Box 286

City 4 50 Alphanumeric Left Justified Optional Denver 

State 5 2 Alphanumeric Left Justified Optional CO

Zip Code 6 10 Alphanumeric Left Justified Optional 80111

Country 7 50 Alphanumeric Left Justified Optional USA

Email Address 8 75 Alphanumeric Left Justified Optional sales@organization.com

Phone 1 9 30 Alphanumeric Left Justified Optional 303-740-4428

Phone 2 10 30 Alphanumeric Left Justified Optional 303-740-4429

Billing 

Reference

11 50 Alphanumeric Left Justified Optional 10-24670
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Reservation Import File Specifications

Field Field 

Sequence 

Max 

Width 

Data Type Format Optional 

or 

Required

Example 

Date 1 10 Date mm/dd/yyyy Required 11/15/2008

Event Start Time 2 4 Numeric hhmm Required 0800

Event End Time 3 4 Numeric hhmm Required 1300

Building 4 50 Alphanumeric Left Justified Required Adams

Room 5 50 Alphanumeric Left Justified Required Arapahoe Conference 

Room

Event Name 6 255 Alphanumeric Left Justified Required Staff Meeting

Group Name 7 50 Alphanumeric Left Justified Required Accounting Department

Contact Name 8 50 Alphanumeric Left Justified Optional Mindy Braaksma

Setup Count 9 5 Numeric ## Required 8

Reservation Reference 10 20 Alphanumeric Unique identifier 

that is used to 

group bookings 

into one 

reservation

Optional R1
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Course Schedule Import File Specifications

Field Field 

Sequence 

Max 

Width 

Data Type Format Optional 

or 

Required

Example 

Day Pattern 1 7 Alphanumeric UMTWRFS Required MWF

Start Time 2 4 Numeric hhmm Required 0800

End Time 3 4 Numeric hhmm Required 0900

Final Exam Day of 

Week

4 1 Alphanumeric UMTWRFS Required M

Final Exam Start Time 5 4 Numeric hhmm Required 0800

Final Exam End Time 6 4 Numeric hhmm Required 1100
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Introduction 
This document will give instructions on how to configure booking level check in as well as how to install 

the new email notification service associated with this functionality. 

Customer Support 
Unlimited toll-free customer support is available to EMS users who have a current Annual Service 

Agreement (ASA).  If you are unable to resolve a problem or answer a question by reading the EMS 

documentation, contact us at: 

Email: 

Web: 

Phone: 

Fax: 

support@emssoftware.com

www.emssoftware.com

(800) 288-4565

(303) 796-7429

Hardware and Software Requirements 
A list of the system requirements is maintained on www.emssoftware.com

Obtaining the Latest Release of EMS 
The latest release of EMS can be downloaded from the EMS Online Support Center. 

1. Go to www.emssoftware.com and enter your Email Address and Password in the Online

Support Center area.

2. Click the Software downloads link.

3. Download the EMS Patch, Virtual EMS, EMS Web Client and the EMS Client.  Required for

both first time installations and upgrades.

http://www.dea.com/
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Booking Level Check In 
Booking level check in is used to help maintain room utilization levels and find accurate reporting on 

space. Check in at the booking level allows for users to check in to a single booking instead of the entire 

building for the day. Along with checking-in is the ability to have no show notifications trigger and free 

up spaces that aren’t checked into.  

Enabling Check In 
1. On the EMS menu bar, click Configuration > Facilities > Rooms.

2. On the Building dropdown list, select one of the following to configure a room — (all) buildings,

a specific building, a specific area, or a specific view.

3. Select and edit the room that booking level check in needs to be enabled for.

4. Check the box for Allow Check In. The minutes prior to booking event start is the amount of time

before a booking in the specified room will be open for check in.

Note: This option can be added to multiple rooms at the same time using the Wizard on the 

Rooms screen. 

Note: Anyone with access to the desktop client can check in a booking earlier than the alloted 

time assigned to the room. 
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No Show Notification Rules 
No show notification rules are created for bookings in rooms that require Check in. These rules can be 

used to notify users of check in times, allow them to check in and cancel bookings if a user does not 

check in within the appropriate amount of time. 

Configuring No Show Notification Rules 
1. On the EMS menu bar, click Configuration > Administration > No Show Notification Rules

(Bookings)

2. Create a new rule or edit an existing rule.

3. Enter the information for the Now Show Notification Rule.

Option Description 

Description The name or the description for the notification rule. 

Note: The description can be a maximum of 50 characters, including 

spaces. 
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Option Description 

Apply Rule Selecting when to apply the rule determines when the no show 

notification rule will be applied and trigger. This can be either before 

or after the event has started. 

Change Status Select this option if the group’s bookings are to be changed to the 

status selected on the No Show Status dropdown list. 

No Show Status The status to which the group’s bookings are changed if the group 

“no-shows.” 

Cancel Reason Available only if the No Show Status is a Cancel Status type. Select 

a reason for cancelling the “no-show” group. 

Send Email If this box is checked it will send a notification email to the selected 

party/parties. 

Header Message 

Footer Message 

Select a header and/or footer message that is to be displayed on 

every No Show notification that is sent. 

Include Cancel Link 

Include Check In Link 

Available only if Change Status is not selected. Provides links in the 

notification email so that a user can cancel or check into the booking 

directly from the notification email. 

Email Group 

Email 1st Contact 

Email 2nd Contact 

Email Web User 

Select the appropriate options to indicate to whom the no show 

notification is to be sent. 

Email From Enter the email address that is to be displayed in the Email From 

field for the no show notification. 

Email Subject Line Enter the text that is to be displayed in the email subject line. 

Variables pull in selected data from the event for which the 

notification is being emailed. You can include variables as described 

in the Legend. For example, %2% is the code for the group name, so 

“Notification for %2%” would result in “Notification for Consumer 

Electronics Association” being displayed in the subject line. 

Inactive When this box is checked the no show notification will be made 

inactive and no longer send notifications for the selected rule. 

Managing Check In 
When check in is enabled for rooms there are multiple ways to check in to bookings that users can utilize. 

Included with booking level check in is a new booking check in dashboard. The dashboard is a place to 

manage bookings and the check in status for them. This dashboard is separate from the EMS Dashboard 

and the Group Check In Status dashboard that were previously available.  

Booking Check In Dashboard 
1. On the EMS menu bar, click Reservations > Other> Booking Check In to open the Booking

Check In dashboard.

a. Alternately this can be accessed through the Booking Check In icon on the Toolbar.

- To add the Booking Check In icon to the Toolbar right click on the toolbar, select

customize and move the Booking Check In to the Show Buttons side.
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2. This area has multiple options for EMS administrators to help manage booking check in. It also is

used to display bookings that have been checked in or not.

Option Description 

Group Name Allows the user to search for a group to check in 

to their booking. 

Display Shows bookings in rooms that are set up for 

check in and match the filters. 

Check In This will check in a booking for a user that has 

not checked in using another method.  

End Now This will end a selected booking that is in 

progress, which will free the room up for another 

booking. 

Go To This will take the administrator to the navigator 

for the highlighted booking to view further 

information. 

Print This will print the information being displayed 

for the filters that are set above. 
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Check In Methods 

Booking Check In Dashboard 

By going into the Booking Check In dashboard and entering the information into the filters, an 

administrative user can check in a booking by highlighting it and selecting check in. 

Reservation Book 

Bookings in the Reservation Book can be checked in to by right clicking on the booking and selecting 

Check In. 
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Virtual EMS 

To check in through Virtual EMS it requires that the user have a Web Security Template that has the role 

for Check In/Check Out.  

1. To add the role navigate to Configuration > Web > Web Security Templates then edit the

template the role is to be added to.

2. Once the Web User has the role they can check into their bookings in the Reservation Summary

screen.

EMS Glance 

Checking in on EMS Glance can be done at the Glance monitor. 
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Installing EMS No Show Notification Service 
To install the EMS Email Notification Service: 

1. Verify that the prerequisite software is installed.

2. Download the EMSNoShowNotificationSetup.msi onto the server that will be running the

service.

3. Double-click EMSNoShowNotificationSetup.msi. Follow the on-screen prompts. It is
recommended that the defaults are accepted.

4. Within the Microsoft Windows Start menu, locate EMS No Show Notification service. The EMS

No Show Notification Configuration screen will appear.

5. Review and complete/change the following settings:

 Mode – Type of authentication to the SMTP server.

 SMTP Server – SMTP server name or IP address.

 Use Gmail – Check this box if the organization uses Gmail as their mail server.

 Port Number – SMTP port (default = 25)

 Use SSL – Check this option if your SMTP server runs under SSL.

 User Name/Password – Required if an authentication mode other than Unauthenticated is

selected.
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 Email Interval – The frequency with which the system will generate notification emails. If

the interval is set to 0 minutes, the service will not function.

6. In the Databases section of the dialog box, you will see a sample database and server (named

‘server’ and ‘database.’) Select this entry, click Edit, and change the values to your EMS server

and database name.

On the Database tab of the Notification Database dialog box, complete the following: 

 Server/Database – EMS server and database name

 EMS Authentication/Windows Authentication – The method of authentication to this database.

 Email From – Email address that will be displayed in the From field of notification emails that

are sent.

 Enable Service Event Logging – Activates Windows event logging.

8. After making your entries, click OK.

9. Click OK again to save your EMS Email Notification Configuration settings.

Note: If any issues are encountered starting the service, please visit the EMS Knowledge Base in the 

online Support Center for a possible solution or call Customer Support. 



23

Preface

Welcome to the EMS User’s Manual. The purpose of the EMS User’s Manual is to answer 
your questions and guide you through the procedures necessary to use the EMS application 
efficiently and effectively.

Using the manual

You will find the EMS User’s Manual easy to use. You can simply look up the topic that you 
need in the table of contents or the index. Later, in this Preface, you will find a brief 
discussion of each chapter to further assist you in locating the information that you need.

Special information about the manual

The EMS User’s Manual has a dual purpose design. It can be distributed electronically and 
then printed on an as-needed basis, or it can be viewed online in its fully interactive capacity. 
If you print the document, for best results, it is recommended that you print it on a duplex 
printer; however, single-sided printing will also work. If you view the document online, a 
standard set of bookmarks appears in a frame on the left side of the document window for 
navigation through the document. For better viewing, decrease the size of the bookmark 
frame and use the magnification box to increase the magnification of the document to your 
viewing preference.

Conventions used in the manual

The EMS User’s Manual uses the following conventions:

• The tab, field, and menu labels that are described in this User’s manual are those used in 
the standard implementation of EMS. Your EMS administrator might have customized 
some of these labels to better suit your organization’s business needs. Therefore, the 
labels that are referenced in this User’s manual might be different than what you observe 
for your implementation. 

• The colors that are shown in this User’s manual for the windows and their components 
(for example, a reservation in the Reservation Book or the colors for the booking statuses) 
are those used in the standard implementation of EMS. Your EMS administrator might 
have customized some of these colors to better suit your organization’s business needs. 

If you do print the document using a single-sided printer, you might see a single 
blank page at the end of some chapters. This blank page has been added solely to 
ensure that the next chapter begins on an odd-numbered page. This blank page in 
no way indicates that your book is missing information.
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Therefore, the colors that are shown in this User’s manual might be different than what 
you observe for your implementation. 

• The fields (required and optional), categories, and dropdown list values that are described 
in this User’s manual are those used in the standard implementation of EMS. Your EMS 
administrator might have customized some of these values to better suit your 
organization’s business needs. Therefore, the fields, categories, and values that are 
referenced in this User’s manual might be different than what you observe for your 
implementation. 

• The EMS application provides multiple ways of accessing the same EMS functions and 
although this manual does not address all these ways, you can use whatever method best 
suits your working needs. 

• Information that can vary in a command—variable information—is indicated by 
alphanumeric characters enclosed in angle brackets; for example, <Room Type>. Do not 
type the angle brackets when you specify the variable information.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the 
cover and ending on the last page of the index.

• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries 
are also hyperlinks. Click the hyperlink to advance to the referenced information.

Although numbering begins on the cover page, this number is not visible on the 
cover page or front matter pages. Page numbers are visible beginning with the 
first page of the table of contents.
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Assumptions for the manual

The EMS User’s Manual assumes that:

• You are familiar with windows-based applications and basic Windows functions and
navigational elements.

Organization of the manual

In addition to this Preface, the EMS User’s Manual contains the following chapters and 
appendices:

•  “Getting Started with EMS,” on page 27 details the procedures for opening and logging 
on to the EMS application as well as an overview of the major functional areas in the 
application, including the title bar, the main window, the toolbar, and the main menu.

•  “Reservations and Bookings,” on page 41 details the two essential EMS components 
for meeting and event scheduling—reservations and bookings. It explains the structure 
of a reservation in EMS, it explains the concept of an event timeline for a reservation 
booking, and it describes the three ways to make a reservation in EMS.

•  “The Navigator,” on page 77 details the Navigator, which is a window in EMS that you 
use to view and manage all aspects of a reservation including bookings and booking 
details. It also provides detailed procedures for using the Navigator to add one or more 
bookings to a reservation, edit and copy reservations, edit and copy one or more 
bookings, cancel one or more bookings, add comments to reservations and bookings, and 
to manage booking details and items.

•  “Search Tools,” on page 195 details the variety of options that are available to you for 
searching for reservations and bookings in your EMS database, including the Browser, 
the Calendar, the Navigator, Groups, and Web Requests.

•   “EMS Dashboard,” on page 227 details the EMS Dashboard, which is a window that 
centralizes critical information about reservations and web requests in a single location. 
The information that is displayed on this window provides you with the necessary input 
to manage your work in the EMS application.

•   “Groups and Contacts,” on page 253 details the procedures for adding and editing 
groups and contacts in your EMS database. It also details the procedures for sending an 
email to a group or a contact, deleting a group or a contact, and printing and exporting 
group and contact information.

•   “Confirmations,” on page 307 details a confirmation, which is a document that details 
the critical information for a reservation—the date, the time, the location, the scheduled 
resources, and so on. The chapter describes how to specify the settings for confirmations 
and how to generate a confirmation both manually and automatically. It also describes 
the procedures for printing a confirmation and for emailing a confirmation.
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•  “Reports and Queries,” on page 319 details the reports that are available in EMS, 
including daily reports, statistical reports, and exception reports.

•   “Billing,” on page 361 details the functions that are available in EMS for working with 
invoices and transactions for reservations and bookings and for reporting on this 
information.

•  “User Settings,” on page 401 details the preferences that are available to you for 
customizing some of the basic functions of your EMS user account.

•  “Other Reservation Functions,” on page 411 details several miscellaneous standalone 
functions that are available in EMS to assist you in managing and maintaining 
reservations and bookings in your system as well as managing your general work 
requirements.

•  “EMS Workplace,” on page 435 details the EMS Workplace module, which is a facility 
scheduling system for managing hoteling requirements, as well as the booking of 
meeting/event space and resources.

• "Academic Planning (EMS Campus),” on page 443 details the EMS Campus module, 
which is a a complete campus-wide space management package.
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EMS is user-friendly room scheduling software that is designed to manage the meetings and 
events that take place in your facility. Standard features, which you use to create, manage, 
and report on events, include the following:

• The Reservation Wizard room booking tool

• A graphical reservation book

• The Browser and month-at-a-glance Calendar Inquiry

• Numerous daily, sales, and statistical reports

This chapter covers the following topics:

• “Starting EMS” on page 29.

• “The EMS Window” on page 31.

• “An EMS Browser Window” on page 35.
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Starting EMS

After EMS has been installed on your desktop, a shortcut icon for the application is placed 
on your desktop. An option for the application is also available from your Start menu. You 
can double-click the desktop icon to launch the EMS application, or you can select the option 
from your Start menu. 

To start EMS

1. Do one of the following:

• On your desktop, double-click the EMS icon .

• Open the Windows start menu, in the Search field, enter EMS and then select the
EMS Enterprise option.

Figure 1-1:  EMS Login dialog box

2. In the User ID field, enter your User ID.

3. In the Password field, enter your password.

The following procedure is written from the perspective of EMS Enterprise; 
however, it is applicable for any EMS product (EMS Professional, EMS Campus, 
and so on).

If you do not know your User ID or password, contact your EMS administrator. 
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4. Click OK.

The EMS Enterprise application opens. The main menu is open in the application.

Figure 1-2:  EMS Enterprise main window with main menu
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The EMS Window

The EMS main window is your starting point for the EMS application. The window provides 
quick access to all the EMS functions (Reservations, Reports, Configuration, and so on) and 
system tools. The EMS Main window has four major components:

• The title bar. See “Title bar.”

• The menu bar. See “Menu bar” on page 32.

• The toolbar. See “Toolbar” on page 32.

• The main menu. See “Main menu” on page 33.

Figure 1-3:  EMS main window with main menu

Title bar

The name “EMS Enterprise” and the version number of the application appear in the title bar 
across the top of the EMS Enterprise main window.

Figure 1-4:  Title bar

The following section is written from the perspective of EMS Enterprise; however, 
it is applicable for any EMS product (EMS Professional, EMS Campus, and so 
on).
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Menu bar

The menu bar is set up in a standard Windows menu format with menu commands grouped 
into menus (File, Settings, Reservations, and so on) across the menu bar. Some of these 
menu commands are also available in the main menu.

Figure 1-5:  Menu bar

Toolbar

The toolbar provides quick access to the most commonly used EMS functions. The toolbar 
buttons that are always displayed by default are the buttons for Book, Calendar, Wizard, 
Navigator, Browser, Web Reservations, Clients, Email, Dashboard, and Manage Services. 
Other buttons for other functions are also displayed by default depending on the version of 
EMS that you are running, for example, EMS Campus or EMS Workplace. Some of the 
functions that are available on the toolbar are also available from the main menu. You can 
customize the appearance of this toolbar to best suit your business needs.

Figure 1-6:  Toolbar

To customize the toolbar

1. Right-click the toolbar and click Customize.

The Customize Toolbar dialog box opens.

Figure 1-7:  Customize Toolbar dialog box
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2. Do one or more of the following:

• To display the toolbar icons as large icons, select Large Icons; otherwise, click Small
Icons.

• To hide an icon from the toolbar display, in the Show Buttons panel, select an icon,
or CTRL-click to select multiple icons, and then click the Hide button (<).
Conversely, to show an icon on the toolbar display, in the Hide Buttons panel, select
an icon, or CTRL-click to select multiple icons, and then click the Show button (>).

• To change the order (from left to right) in which the icons are displayed on the
toolbar, select the icon, and then click Move Up or Move Down as needed.

3. Click OK.

The Customize Toolbar dialog box closes. The toolbar display is updated to reflect the
changes that you made.

Main menu

Every time you open EMS, the main menu opens in the EMS main window. You can access 
the primary EMS system functions—Reservations, Reports, Billing, Configuration, and 
System Administration—from the main menu. 

Figure 1-8:  EMS main menu

You can also move a toolbar icon between the Hide and Show panels by 
double-clicking the icon. To move all icons from one panel to another in a single 
step, you do not have to select any icons. Instead, click the appropriate Hide All 
button (<<) or Show All button (>>).
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The main menu is arranged in a Windows Explorer-style folder structure. The top-level 
folders are the system functions of Reservations, Reports, Billing, Billing, Configuration, 
and System Administration. The available tasks for each top-level folder are further 
organized into subfolders. For example, to carry out a system administration task, you must 
first open the top-level System Administration folder, and then open the correct subfolder to 
view the list of available tasks.

Figure 1-9:  Opening a System Administration subfolder

You can always close the main menu by clicking the Close button (x) in the upper right hand 
corner of the menu. To open the main menu again, on the menu bar, click File > Show Main 
Menu.
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An EMS Browser Window

Many EMS functional areas use a Browser window. For example, the Groups window, the 
Query Builder window, and the Service Order Management window are all EMS Browser 
windows. You use an EMS Browser window to search for data, add new data, and edit and/or 
delete existing data. For example, in the Groups Browser window, you can search for groups 
or contacts, add new groups or contacts, and edit or delete existing groups or contacts. 
Regardless of the EMS functional area, all EMS Browser windows have the following 
features in common:

• A click and drag feature that you can use to group data by a specific column, rearrange
the order of the data columns, or change the width of a column. See “To group data by
columns in an EMS Browser window” on page 36, “To rearrange the columns in an EMS
Browser window” on page 36, and “To change the width of the columns in an EMS
Browser window” on page 37.

• A column context menu that has a multitude of options for sorting data, grouping data,
sizing columns and so on. See “To use the context menu for data columns in an EMS
Browser window” on page 37.

• A filtering feature that you can use to find and work with a subset of data in the window.
See “To filter the data in an EMS Browser window” below.

• A column sorting feature that you can use to sort data by a specific column. See “To
change the sort order of data in an EMS Browser window” on page 40.

This feature is always indicated by the option to drag and group by a column 
header at the top of an EMS Browser window. If a window/window pane does not 
display this option, then the window/window pane is not an EMS Browser window.

The following examples are explained using the Groups window; however, the 
instructions are applicable for any Browser window in EMS.
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To group data by columns in an EMS Browser window
In any browser window, you can drag a column header to the indicated location and group 
the data by the selected column. You can drag multiple column headers to the location. If you 
sort data by multiple columns, then the first column is the parent column. All other columns 
are placed as child columns, and the data is grouped accordingly in the browser window.

Figure 1-10: Grouping data by a column in an EMS Browser window

To rearrange the columns in an EMS Browser window

You can rearrange the column order by dragging a column to a new location using the 
column heading.

Figure 1-11: Rearranging columns in an EMS Browser window

Data grouped by columns.
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To change the width of the columns in an EMS Browser window
You can change the width of a column by resting the mouse pointer on the right side of a 
column heading until the pointer changes to a double-headed arrow, and then dragging the 
boundary until the column is the width that you want.

Figure 1-12: Changing the width of a column in an EMS Browser window

To use the context menu for data columns in an EMS Browser 

window
Right-click in any column in a browser window to open a context menu that has a multitude 
of options for sorting data, grouping data, sizing columns, and so on.

Figure 1-13: Context menu for a column in an EMS Browser window



38

 
Getting Started with EMS

To filter the data in an EMS Browser window
1. Open a browser window, for example, the Groups window.

2. Place your cursor in the data column by which you want to filter the data. For example,
to filter data based on the City for group records, place your cursor in the City column.

A Filter icon is displayed in the column.

Figure 1-14: Filter icon displayed in a data column

3. Click the Filter icon to open a list of filter options, and then select the appropriate option
for creating the filter.

Figure 1-15: Example of filtering options in a browser window

Any filter that you create is always displayed in the bottom left corner of the 
browser window.

Filter icon

Filter
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4. Optionally, click Edit Filter in the lower right corner of the browser window to open the
Filter Editor dialog box and edit the current filter.

• To add a new condition to a filter, click the Add/Insert icon.

• To remove a condition from a filter, click the Delete icon at the end of the filter.

• To apply a new filter, click Apply.

• To close the Edit Filter dialog box and return to the browser window, click OK.

Figure 1-16: Edit Filter dialog box

Option Description

Custom Opens the Custom AutoFilter dialog box in which you can construct a 

custom data filter.

Blanks Filters data based on NULL (blank) data for a field. For example, if you 

click on Blanks in the City column in the Groups window, then all group 

records for which the City field has a NULL (blank) value are displayed 

in the Groups window. 

Non blanks Filters data based on Not Null (not blank) data for a field. For example, if 

you click Non blanks in the City column in the Groups window, then all 

group records for which the City field does not have a NULL (blank) 

value are displayed in the Groups window.

<Specific Data Value> A Filter list also displays each unique value that has been entered for 

the field. Select a value on this list to filter the data by the value. For 

example, select “Denver” in the City column of the Groups window to 

display only those group records that have “Denver” specified as the 

group’s city.

Add/Insert icon

Delete icon
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To change the sort order of data in an EMS Browser window
When a browser window first opens, data are sorted in ascending order based on the data in 
the first column of the window. For example, when the Groups window first opens, the group 
records are displayed on the Results tab alphabetically by Group name. To change the sort 
order of the data in a browser window:

1. Click once in any column header to display a Sort Order icon.

The Sort Order icon is an “Up” arrow indicating that the data is sorted in ascending
order.

Figure 1-17: Sorting by columns on the Groups window, Ascending sort

2. Click the Sort Order icon to sort the records in descending order by the data in the
column.

Figure 1-18: Sorting by columns on the Groups window, Descending sort

3. Click the Sort Icon again to sort the records in ascending order.

Ascending sort

Descending sort
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The two essential EMS components for meeting and event scheduling are reservations and 
bookings. To use EMS efficiently and effectively, you must understand the structure of a 
reservation in EMS, you must understand the concept of an event timeline for a reservation 
booking, and you must know how to make a reservation.

This chapter covers the following topics:

• “Reservation Structure” on page 43.

• “Event Timeline” on page 44.

• “Making a Reservation Using the Reservation Wizard” on page 45.

• “Viewing and Editing Reservations in the Reservation Book” on page 62.

You can also make a reservation for a group by finding the group in EMS and then 
making a reservation for the group from the Groups window. In EMS Workplace, 
you can make a group reservation from the Group Reservation window. See 
“Working with Reservations for a Group” on page 295.
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Reservation Structure

An event in EMS is comprised of the following:

• A reservation

• One or more bookings

• Booking details

These three components exist in a hierarchy—a reservation contains one or more bookings 
and each booking can have one or more details associated with it. 

Reservation and bookings

A reservation is the who and the what of an event. For example, Group X (the who) can 
reserve some space for an Event Y (the what). A booking is the where and the when of an 
event. For example, Group X can schedule the conference room (the where) for a staff 
meeting on the second Monday in January (the when). Group X now has a single reservation 
with a single booking in EMS. If, however, Group X schedules the conference room (the 
where) for a staff meeting on the second Monday of each month for a calendar year (the 
when), then Group X now has a single reservation with twelve bookings in EMS.

Booking details

A booking can have one or more booking details associated with it. Booking details are the 
resources or services that are needed for an event, the notes for the event, the activities for 
the event, the room charges for the event, or any combination of these. For example, for 
Group X’s staff meeting, the resources could include the requested catering (coffee service, 
bagels and muffins, and so on) and the A/V equipment (a projector, a speaker’s podium, and 
so on).
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Event Timeline

The following time designators are used for an event in EMS:

• Event Time: The time period during which the event actually takes place.

• Setup/Teardown Hours: The hours, or fractions of hours, that you add to the event time
to allow staff to prepare a room for the event or to clean up after the event.

• Reserved Time: The total time for which the space (the where) is reserved. This time is
the event time plus the setup/teardown time.

For example:

Variable Time 

Reserved Start Time 8:00 am

Setup Hours 1 hour

Event Start Time 9:00 am

Event End Time 4:00 pm

Teardown Hours 1.5 hours

Reserved End Time 5:30 pm

Reserved Time 9.5 hours
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Making a Reservation Using the Reservation 

Wizard

You use the Reservation Wizard to check for available space for an event and to make a 
reservation for the event. You can search for rooms that are available for a particular time on 
one day (a simple reservation with one booking) or on multiple days (a series reservation 
with multiple bookings). You can also create a series reservation by selecting one date and 
time, but multiple rooms. To make a reservation using the wizard, you must:

• Specify the event date and time information. See “To specify the event date” on page 46.

• Specify the event time and status. See “To specify the event time and status” on page 49.

• Select the event location. See “To select the event location” on page 50.

• Specify the event information. See “To specify the event information” on page 57.

The following procedure describes how to make a reservation by selecting values 
for the required and optional fields. 

• If your EMS administrator has configured reservation wizard templates, then a
Reservation Wizard Template dropdown list is displayed at the top of the
Reservation Wizard. You can facilitate the making of a reservation in the
Reservation Wizard by selecting the appropriate template from the list, which
automatically sets the default values for many of the fields in the Reservation
Wizard.

• If your job entails making multiple reservations that require the same
information, and you are not using reservation wizard templates, then you can
set your own default values for many of the fields in the Reservation Wizard. See
“Setting User Preferences and Default Values” on page 403.



46

 
Reservations and Bookings

To specify the event date

1. On the toolbar, click the Wizard icon .

The Reservation Wizard opens.

Figure 2-1:  Reservation Wizard

2. If needed, use the scroll features on the top of the Calendar to open the calendar for a
different month (< or >) or for a different year (<< or >>).

All required fields in the wizard are marked with a red dot. Your EMS 
administrator configures the required fields. 

You can also click a month at the top of the calendar to open a dropdown list from 
which you can select a different month and you can also click a year at the top of 
the calendar to open a dropdown list from which you can select a different year.
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3. If the event dates do not follow a pattern, use one or more of the following options for
entering a date; otherwise, go to Step 4.

• Click on the dates on the calendar that the event is to take place.

• To select all five days in a work week, click in the blank space that is to the left of
the week.

• To select all seven days in a week, double-click in the blank space that is to the left
of the week.

Figure 2-2:  Example of selecting the days of the week

• To select every occurrence of a specific day of the week for the displayed month (for
example, all Tuesdays in November, 2012), click the heading (S, M, T, and so on)
for the day.

• To select every occurrence of a specific day of the week that is currently displayed
onscreen (regardless if the day falls within the same month), double-click the
heading (S, M, T, and so on) for the day.

If you need to clear a single selected date, click the date again. To clear multiple 
selected dates in a single step, click Clear Month to clear all currently selected 
dates for the currently displayed month or click Clear All to clear all currently 
selected dates regardless of month or year. 

Click here to select all 
five weekdays for the 
week of 3/11/2012.

Double-click here to 
select all seven 
weekdays for the 
week of 3/11/2012.
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4. If the event dates do follow a pattern, (for example, the third Friday of every month),
click Date Pattern to open the Date Pattern dialog box and enter your event date
information.

Figure 2-3:  Date Pattern dialog box

As you specify the event dates, the following occurs:

• The Selected Dates tab is automatically updated with the selected dates.

• If your EMS administrator has configured any of the dates that you selected as a
holiday or as closed, then messages open indicating this.

• Dates that are closed are displayed in red on the Calendar tab and are linked to
information about the closure. Dates that are holidays are displayed in green on the
Calendar tab and are linked to information about the holiday.

For any date, after you select the date on the Calendar tab, you can:

• Toggle between the Calendar tab and the Selected Date tab. Open the Selected Dates
tab, select the date, and then click Go To Date.

• Remove the date from the list of selected dates. Open the Selected Dates tab, select
the date, or CTRL-click to select multiple dates, and then click Remove.

For dates that are configured as a holiday or as closed, you can click the link on the 
Calendar tab to open a dialog box that displays information about the date.

Figure 2-4:  Viewing information about a holiday or closed date from the Calendar tab

When you make a reservation for multiple dates, the process is easier if you first 
remove all holidays or closed dates from the list of selected dates; however, be 
very careful when selecting dates for removal as you are not prompted to confirm 
your selection before you click Remove.
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In addition, for dates that are configured as holidays, after you select the date on the 
Calendar tab, you can:

• View information about the date from the Selected Dates tab. Open the Selected
Dates tab, scroll to and select the date, and then click Holidays.

5. Continue to “To specify the event time and status” below.

To specify the event time and status

1. Do one of the following to specify the start time and end time for the event:

• Select a time from the dropdown list for each field.

• Manually enter the time in each field.

2. Do one of the following to specify the Setup and Teardown times.

• To use the default setup and teardown times that your EMS administrator has
assigned to the rooms in your system, leave Use Default selected.

• To override the default setup/teardown times, clear Use Default, select Minutes or
Hours, and then enter your own setup and teardown times.

3. Select the status for the event.

4. Continue to “To select the event location” on page 50.

When you manually enter the time, you can use a shortcut. For example, for 9:00 
am, you need to enter only “9a” and for 2:00 pm, you need to enter only “2p,” 
and so on. If you enter an end time that is earlier than the start time, then the 
system assumes that the end time is the next day and the phrase “Next Day” is 
displayed to the right of the End time field.

Remember, setup and teardown times are the hours, or fractions of hours, that you 
add to the event time to allow staff to prepare a room for the event or to clean up 
after the event. For example, for a 30 minute setup time, you can enter 30 minutes 
or 0.5 hours.

Depending on the status that you select, for example, Tentative or Hold, you might 
be required to enter a reconfirm date. You can monitor reservations that must be 
reconfirmed on the Reconfirm Dates tab on the EMS Dashboard. See “EMS 
Dashboard,” on page 227.

Time zone is discussed in “To select the event location” on page 50.
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To select the event location

You have three options for selecting the event location, which are indicated on the first 
window of the Reservation Wizard:

To search for a standard room

1. Select Standard.

2. Leave Building set to the default value of (all), or select a specific building, area, or view
in which to search for a standard room.

3. If applicable, select the appropriate time zone for the event.

Search Method Description

Standard Use this option to display a list of all the available rooms that meet all the 

requested dates. See “To search for a standard room” below.

Note: Standard search is required for Video Conference room assignments.

Best Fit Use this option if no one room can meet all the requested dates. The system 

lists the available rooms along with the number of bookings for which you can 

reserve each room. You can piece together the entire reservation using Best Fit, 

or just part of it. See “To search for a best fit room” on page 53.

Specific Room Use this option to confirm the availability and reserve of one specific room for 

the scheduled event. See “To search for a specific room” on page 55.

By default, EMS looks for an available room or rooms in only the first 50 rooms 
that it finds in the pre-configured Rooms list. To search more than 50 rooms, 
before you begin any search, click Options > Max. Number of Rooms to Search, 
and then select a different number of rooms to search. 

By default, when you search for a standard room, rooms that are available all day 
are marked with an asterisk (*). To set or clear this option, click Options > 
Standard Search > Show Available All Day Indicator.

Your selection on the Building dropdown list determines the options that are 
available on the Time Zone dropdown list. If you select (all) buildings, then you 
can select a time zone. If you select a specific building, then by default, a time zone 
is selected for the building, and you cannot select a different value.
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4. Do one or more or all of the following for room specifications:

• Type is the class or category of the room, for example a meeting room, a workspace,
and so on. Leave Type set to the default of (all) to search for all pre-configured room
types or select a specific room type from the Type dropdown list.

• Floor is optional information when you are searching for a room. Leave Floor set to
the default value of (all) to search for all pre-configured floors or select the floor
from the Floor dropdown list.

• Setup Type is the physical layout or arrangement of a room, for example, rounds of 6
or theater-style. Leave Setup Type set to the default value of (all) to search for all
pre-configured setup types or select the setup type from the Setup Type dropdown
list.

• Setup count is the anticipated attendance for the event. If you selected a specific
setup type, then you must enter the setup count.

5. Optionally, open the Features tab, and then select the feature, or CTRL-click to select the
multiple features that the room must have.

6. Click Next.

Up to two tabs are displayed:

• The Available tab, which is the active tab and is always displayed, lists all the rooms
that meet all your event criteria.

• If you have elected to show the Available All Day Indicator, the rooms that are
available all day are marked with an asterisk (*).

• By default, the available rooms are sorted alphabetically by room code. If your
EMS administrator has configured the rooms for your EMS implementation
with a book sequence, then under Options, select Sort Rooms by Book Sequence
to sort the rooms from lowest to highest book sequence. (If two rooms have the
same sequence, then the rooms are sorted alphabetically by name within the
sequence.)

• The Conflicts tab is displayed only if there are rooms that are not available for the
requested dates/times. Optionally, you can open the Conflicts tab to view the list of
rooms that were not available for scheduling as well as list of the events that are
scheduled for each room.

See Figure 2-5 on page 52.

The selected setup type and setup count are applied to all the bookings that you 
add to this reservation. If any of the bookings require a different setup type or 
count, you can change this information after you complete the reservation. See 
“To edit a booking in the Navigator” on page 110 or “Editing Multiple Bookings 
in the Navigator” on page 112.
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Figure 2-5:  Example of standard room search results

7. Select the room, or CTRL-click to select the multiple rooms that you are scheduling for
the event.

8. Optionally, do one or both of the following; otherwise, go to Step 9.

• Click Room Info to open the Room Info dialog box and view information about any
bookings for the room, the room properties, its pricing, and/or to view an image of
the room.

• Click Building Hours to open the Building Hours dialog box which displays the
hours that the selected room/building is open on the reserved date.

9. Click the Move button (>) to move the rooms to the Selected list.

10. Click Next to continue to “To specify the event information” on page 57.

If the reservation is for a video conferencing meeting, then you must select a 
minimum of two rooms. You must designate one of these rooms as the Host 
Location on the Video Conference tab on the last page of the Reservation Wizard.

If you select more than one room, all the selected rooms are booked for all the 
event dates.
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To search for a best fit room

1. Select Best Fit.

2. Leave Building set to the default value of (all), or select a specific building, area, or view
in which to search for a standard room.

3. If applicable, select the appropriate time zone for the event.

4. Do one or more or all of the following for room specifications:

• Type is the class or category of the room, for example a meeting room, a workspace,
and so on. Leave Type set to the default of (all) to search for all pre-configured room
types or select a specific room type from the Type dropdown list.

• Floor is optional information when you are searching for a room. Leave Floor set to
the default value of (all) to search for all pre-configured floors or select the floor
from the Floor dropdown list.

• Setup Type is the physical layout or arrangement of a room, for example, rounds of 6
or theater-style. Leave Setup Type set to the default value of (all) to search for all
pre-configured setup types or select the setup type from the Setup Type dropdown
list.

• Setup count is the anticipated attendance for the event. If you selected a specific
setup type, then you must enter the setup count.

5. Optionally, open the Features tab, and then select the feature, or CTRL-click to select the
multiple features that the room must have.

Your selection on the Building dropdown list determines the options that are 
available on the Time Zone dropdown list. If you select (all) buildings, then you 
can select a time zone. If you select a specific building, then by default, a time zone 
is selected for the building, and you cannot select a different value.

The selected setup type and setup count are applied to all the bookings that you 
add to this reservation. If any of the bookings require a different setup type or 
count, you can change this information after you complete the reservation. See 
“To edit a booking in the Navigator” on page 110 or “Editing Multiple Bookings 
in the Navigator” on page 112.
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6. Click Next.

Up to two tabs are displayed:

• The Available tab, which is the active tab and is always displayed, has two lists. The
list in the left pane is a list of all the rooms that meet some or all of your event
criteria. The list in the right pane is a list of all the event dates that must be fulfilled.

• The Conflicts tab is displayed only if there are rooms that are not available for the
requested dates. Optionally, you can open the Conflicts tab to view the list of rooms
that were not available for scheduling for the event as well as list of the events that
are scheduled for each room.

Figure 2-6:  Example of best fit room search results

7. Optionally, do one or both of the following; otherwise, go to Step 8.

• Select a room on the Available tab, and then click Room Info to open the Room Info
dialog box and view information about any bookings for the room, the room
properties, its pricing, and/or to view an image of the room.

• Select a room on the Available tab, and then click Building Hours to open the
Building Hours dialog box which displays the hours that the selected room/building
is open on the reserved date.

By default, the available rooms are sorted alphabetically by room code. If your 
EMS administrator has configured the rooms for your EMS implementation with a 
book sequence, then under Options, select Sort Rooms by Book Sequence to sort 
the rooms from lowest to highest book sequence. (If two rooms have the same 
sequence, then the rooms are sorted alphabetically by name within the sequence.)
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8. Do one of the following:

• If one is available, select the single room that is available for all the requested dates,
and then click the Move button (>) to move the room to the Event Dates list.

• If a single room is not available, select a room that is available for some of your
requested dates, and then click the Move button (>) to move the room to the Event
Dates list. Repeat this step as needed to fulfill all the event dates.

9. Click Next to continue to “To specify the event information” on page 57.

To search for a specific room

You can use the specific room search to book a standard EMS room or a room or area that is 
not managed in EMS. An override room, or “override description,” is used to book an event 
in a space that has not been configured in your EMS system. For example, your EMS 
administrator might have configured an override room named “Other Area” in the 
Engineering building. To book an event in Dr. Wilson's office, which is a room that is not 
defined in EMS, in the Engineering building, you can select the “Other Area” room and 
specify “Dr. Wilson's Office” for the location. EMS does not track availability for events 
booked in override rooms; however, EMS reports on events that are scheduled in an override 
room just like any other event scheduled for any other room.

1. Select Specific Room.

The Room Selector dialog box opens.

Figure 2-7:  Room Selector dialog box



56

 
Reservations and Bookings

2. Do one of the following:

• To select a room from a list of all rooms in all available buildings, select (all) on the
Building dropdown list, select a room, and then click OK. If the room is configured
as an override room, go to Step 3; otherwise, go to Step 4.

• To select a room from a list of rooms in a specific building, area, or view, select the
building, area, or view on the Building dropdown list, select the room, and then click
OK. If the room is configured as an override room, go to Step 3; otherwise, go to
Step 4.

3. In the Location field, enter the location of the override room, and then click Next to
continue to “To specify the event information” on page 57.

4. Click Next.

Two results are possible:

• If the event is scheduled for a single date and the room is available, then continue to
“To specify the event information” on page 57.

• In all other cases, (for example, the event is scheduled for a single date but the room
is not available or it is a multiple date event), the Available tab opens. This tab lists
all the event dates for which the specific room is available. Continue to Step 5.

5. Optionally, before you move a date to the Selected list, do one or both of the following;
otherwise, go to Step 6.

• Click Room Info to open the Room Info dialog box and view information about any
bookings for the room, the room properties, its pricing, and/or to view an image of
the room.

• Click Building Hours to open the Building Hours dialog box which displays the
hours that the selected room/building is open on the reserved date.

6. Do one of the following:

• If the specific room is available for all the event dates, then click the Move All
button (>>) to schedule the room for all the event dates.

• If the specific room is not available, try another approach such as reserving a
different specific room, or using the Standard or Best Fit search method.

7. Click Next to continue to continue to “To specify the event information” on page 57.

You can open the Conflicts tab to view the list of dates for which the specific room 
is not available as well as list of the events that are scheduled for the room.
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To specify the event information

After you select an event location or locations, you must specify other information for the 
event. You must enter information in the required fields. 

Figure 2-8:  Event Information window

8. Enter the event information.

Field Description

Event

Event Name A name or description for the event.

Event Type The classification for the event.

VIP Event Select this option to mark the event as a Very Important event.

Source The reservation source.

Video Conference Select this option for a video conference event.

Group/Contact

Group Dropdown list of all groups that are available in your system for hosting/

sponsoring an event. 

Note: If the pre-configured list of groups is too extensive to scroll, then click 

the Search icon  to open the Groups window and search for a 

specific group. See “To search for a group and/or contact” on page 

255. If the group that you want to select for the reservation is not

available on the pre-configured list, then you can add the group. See

“To configure groups” on page 257.

Note: Optionally, after you select a group for the event, you can click Group 

Info to open a dialog box that provides information (Properties, User 

Defined Fields, and Comments) about the group.
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1st Contact

Temp Contact

When you select a group, if a default contact has been defined for the group, 

then this field is automatically populated with the name of the contact; 

otherwise, the field is blank. You have several options for defining the 1st 

Contact for a reservation:

• If the field is blank, but contacts have been configured for the group, you

can select a contact from the pre-configured list.

• If the field is populated with a default value, but other contacts have been

configured for the group, you can select a different contact from the

pre-configured list.

• If the field is blank, and no contacts have been configured for the group, or

the contact that you want to select for the group is not available on the

pre-configured list, you can click the Contact icon  to open the Contact

dialog box and create a permanent contact for the group. See “To configure

contacts” on page 278.

• If you want to create a temporary contact just for this event, then select

(temporary contact), and in the Temp Contact field, enter the name for the

temporary contact.

Note: If a default contact has been configured for the group, then any 

modifications that you make for the contact apply to this reservation 

only. The next time you or anyone else creates a reservation for this 

group, the 1st Contact field is again automatically populated with the 

name of the default contact.

Phone

Fax

Email Address

One more of these fields might be automatically populated depending on how 

a selected contact has been configured. You can manually edit these values if 

needed. 

Note: The Phone and Fax fields have a dropdown list available on which you 

can select a different value (Fax, Mobile, Other, or Phone) for the field 

label, or you can enter a user-defined value. To enter a user-defined 

value, double-click the current field label to select it, and then enter the 

user-defined value over the selected label. 

Note: If default values have been configured for a selected contact, then any 

modifications that you make apply to this reservation only. The next 

time you or anyone else creates a reservation for the same contact, 

these fields are again automatically populated with the default 

information.

2nd Contact

Temp Contact

Define if necessary for the event. 

Room Setup tab

Setup Type If you selected a specific value for the setup type when searching for an event 

location, this value is carried forward to this field; otherwise, the field is set to 

(default). You can edit this value.

Setup Count If you selected a specific value for the setup type when searching for an event 

location, this value is carried forward to this field; otherwise, the field is blank. 

You can enter a value in this field.

Field Description
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Billing tab

Note: Depending on the group that you select, one or more of these fields on this tab might be 

automatically populated with default values. You can edit these default values but any 

modifications that you make apply to this reservation only. The next time you or anyone else 

creates a reservation for the same group, these fields are again automatically populated with 

the default billing information.

Pricing Plan Indicates what type of pricing is to be used for the event.

Billing Reference 

Number

The internal alphanumeric billing code that is associated with the group. You 

can manually enter a value in this field, or if a master list of billing reference 

numbers has been configured for the group, you can click the Search icon 

 to open a Billing Reference Numbers dialog box, and select the 

appropriate value from this list. 

Note: To search for a specific billing reference number, enter a search string 

in the Find field, and then click Display. Your search is limited to the 

exact order of the characters in the string, but the string is not 

case-sensitive and it can appear anywhere in the search results. For 

example, if you enter co as the search string, the search results can 

include CO-123, and 123-CO.

Sales Category How the group is sorted for purposes of tracking sales figures, for example, 

local, regional, national, and so on.

Payment Type Indicates how the group paid for the event (cash, check, charged, and so on).

PO Number The internal alphanumeric purchase order number that is associated with the 

group. You can manually enter a value in this field, or if a master list of PO 

numbers has been configured for the group, you can click the Search icon 

 to open a PO Number dialog box, and select the appropriate value from 

this list. 

Note: To search for a specific billing reference number, enter a search string 

in the Find field, and then click Display. Your search is limited to the 

exact order of the characters in the string, but the string is not 

case-sensitive and it can appear anywhere in the search results. For 

example, if you enter co as the search string, the search results can 

include CO-123, and 123-CO.

Salesperson The user who “sold” the event to the group.

Other tab

Event Coordinator The Event Coordinator who is assigned to the event.

Estimated Event 

Attendance

The estimated number of people who are expected to attend the event.

Calendar Style Dropdown list of all the available formats for printing this event on the Event 

Calendar and Event Schedule reports. 

URL The event URL.

Field Description
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Virtual tab

Web User To specify the web users who can view/manage this reservation in VEMS, 

click the Search icon  to open the Web Users dialog box and search from 

a list of registered web users. 

• You can search by User Name or Email Address.

• To search a list of all available web users, leave the Search field in the Web

Users dialog box blank, and then click Display.

• To search for a specific web user, enter a search string in the Search field,

and then click Display.

Note: The string is not case-sensitive, but your search is limited to the exact 

order of characters in the string and it must begin with the information 

for which you are searching. For example, if searching by Email 

Address, a search string of bob returns 

bob.worth@emssoftware.com but not dbobbett@emssoftware.com.

• To return this field to the (no change) value at any time, click Reset.

Web Process 

Template

The web process template that defines the functions that are available for the 

selected web user.

Note: A web user might be assigned to more than one web process 

template, so make sure to select the template that is applicable for this 

reservation.

User Defined Fields tab

User-defined fields are additional fields that store custom data for a 

reservation. Your EMS administrator configures the types of fields that are 

available as well as the allowed values for these fields. 

• To enter or edit a value for a field, select the field, and then click Set Value.

• To clear a value for a field, select the field, and then click Clear Value.

Note: If a user-defined field is not required here, you can always supply a

value for it at a later date in the Navigator. See “Working with User 

Defined Fields in the Navigator” on page 181.

Video Conference tab

Displayed only if you selected the Video Conference option on this window. 

N/A for a Best Fit room or Specific Room meeting assignment. You identify the 

host endpoint for the video conference on this tab.

Note: Not available in EMS Professional.

Field Description
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9. Click Finish.

The Navigator window opens. The reservation information appears in the window. You 
use this window to add booking details and to make any needed modifications to the 
reservation and its bookings. See  “The Navigator,” on page 77.

A reservation is not complete and rooms are not removed from the Available list 
until you click Finish. Although unlikely, it is possible for another user to select 
and reserve a room during the time period after you have selected the room but 
before you have finalized the reservation. If this occurs, after you click Finish, a 
message opens stating that your reservation conflicts with an existing reservation.

Depending on how your EMS administrator has configured your system, user 
defined questions (UDFs), comments, and/or reminders might be automatically 
displayed for the reservation in the Navigator. Contact your EMS administrator if 
you have any questions about this. 
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Viewing and Editing Reservations in the 

Reservation Book

The Reservation Book provides a graphical view of all the confirmed reservations (the 
reserved time as well as the room for which the reservation is scheduled) for your 
organization. (Cancelled bookings are not shown.) You use the Reservation Book to the view 
information for a reservation, to edit an existing reservation, and to make a new reservation. 
In addition, before you edit or make a reservation, you can change the Reservation Book 
display so that it better suits your working needs.

Reservation Book

To open the Reservation Book, on the EMS toolbar, click the Book icon . The first time 
that you open the Reservation Book for your EMS implementation, by default, the Room 
Filter dialog box opens on top of a blank Reservation Book. You can leave the room filtering 
criteria set to their default values, or you can select different values as needed, and then click 
OK. All reservations that meet the filtering criteria and that are scheduled for the current 
day’s date are displayed in the book in the Daily view. 

The Reservation Book has the following appearance:

• Minimum and maximum capacities are displayed next to room descriptions.

• The current time is shown by a vertical line in the grid, called the Current Time Indicator.

• If building hours have been configured for a building, then this information is displayed
for the building.

• The reservations are displayed with three components:

• A left bar that indicates the setup time.

• A middle bar that indicates, by default, the event name.

• A right bar that indicates the teardown time.

See Figure 2-9 on page 63.

You might need to use the book’s scroll features to scroll through all the 
reservations that are scheduled for the current day’s date.
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Figure 2-9:  Reservation Book, Daily view (default display)
\

If an event is scheduled for a room that is a component of a combination room, then the 
reservation text is displayed in black. A duplicate reservation is also shown for the 
combination room; however, the reservation text is displayed in gray to indicate that a 
component of the combination room is currently booked for the indicated time and therefore, 
the combination room is not available. 

Figure 2-10: Components booked and combination room unavailable

Conversely, if an event is scheduled for a combination room, then the reservation text for the 
combination room is displayed in black and the reservation text for each component is 
displayed in gray. This reversed color coding indicates that the component room is currently 
booked for the selected time and that none of the components is available.

Figure 2-11: Combination room booked and components unavailable
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You can carry out the following actions in the Reservation Book:

• Change the Reservation Book display. See “To change the Reservation Book display”
below.

• View reservation information. See “To view reservation information” on page 70.

• Make a new reservation. See “To make a new reservation” on page 74.

• Edit an existing reservation. See “To edit an existing reservation” on page 74.

To change the Reservation Book display

1. On the toolbar, click the Book icon .

The Reservation Book opens in the Daily view. See Figure 2-9 on page 63.

2. Optionally, you can do one or more of the following to change the Reservation Book
display:

• Change the list of rooms that are displayed in the Reservation Book based on room
properties. See “List of Rooms (Room Properties)” on page 65.

• Change the list of rooms that are displayed in the Reservation Book based on a
specific room or rooms. See “List of Rooms (Specific Rooms)” on page 66.

• Change the Reservation Book view. See “Reservation Book view” on page 66.

• Change multiple display options for a reservation. See “Display Options” on page
67.

• Select which items to include in the tooltip that opens when you place the cursor over
an event in the Reservation Book. See “Tooltips” on page 69.

• Change the display date using the calendar. See “Display Date (Calendar)” on page
69.

• Change the display date using the Reservation Book scroll features. See “Display
Date (Scroll Features)” on page 70.
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List of Rooms (Room Properties)

If the Filter Rooms dialog box is not already open, then above the Rooms list, do the 
following:

1. Click Filter.

The Filter Rooms dialog box opens. The room filtering criteria is set to the following
default values—Filter Type is Room Properties, Room Type is None, and Room
Availability is All Rooms.

Figure 2-12: Filter Rooms dialog box, Room Properties selected

2. Select Room Properties, and then do one or more of the following

• Leave the Building dropdown list set to the default value of (all) buildings, or select
a specific building, area, or view.

• Select a specific floor.

• Select a specific room type.

• Select Capacity and then enter a capacity.

• Select Academic to limit the search to academic rooms. (This option is available
only if you have an EMS Campus.)

• Select a Room Availability option.

3. Click OK.

The Filter Rooms dialog box closes. The room display in the Reservation Book is
changed accordingly.

The Academic option is available only in EMS Campus.
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List of Rooms (Specific Rooms)

If the Filter Rooms dialog box is not already open, then above the Rooms list, click Filter to 
open the dialog box and select Specific Room. Select the room, or CTRL-click to select 
multiple rooms on the Available list, and then click the Move (>) button to move the selected 
rooms to the Selected list. The Reservation Book is updated to show bookings only for the 
selected rooms.

Figure 2-13: Filter Rooms dialog box, Specific Room selected

Reservation Book view

On the View dropdown list, select Daily, Weekly, or Monthly.

Figure 2-14: View dropdown list

After you carry out a search, you can click Reset at the top of the Rooms list to 
reset all room filtering criteria (Filter Type, Room Type, and Room Availability) to 
their default values,

Although you can view currently scheduled reservations in either the daily, weekly, 
or monthly view, you can make a new reservation only in the daily view.
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Display Options

Click Options (upper right hand corner of Reservation Book) to open the Book Options 
dialog box (the General tab is the active tab) and change multiple display options not only 
for the Reservation Book, but also a reservation in the book.

Figure 2-15: Book Options dialog box

Option Description

Start Hour The daily start time for the Reservation Book display.

Automatically Refresh The time interval at which the Reservation Book display is automatically 

refreshed.

Display The information that is displayed in the middle bar for a reservation.

Time Display Interval Changes the granularity of the time display interval.

Maximum No. of Rooms The maximum number of rooms to display in the Reservation Book.

Booking Colors Based 

On

The color of the bookings in the reservation. Select one: Status, Event 

Type, or Check-in Status (for EMS Workplace only.)

Rooms Without 

Bookings

Whether to highlight rooms without bookings and if so, the highlight 

color. If both Highlight Rooms and Booked Space Status Only are 

selected, then only those rooms that do not have a Booked Space 

status are highlighted.

Room Display Display the room code or the room name for a reservation.

Building Display Display the building code or the building name for a reservation.
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Go To Today on Startup If selected, the Reservation Book opens to the current day’s date; 

otherwise, it opens to the last date viewed.

Always Prompt for 

Room Filter on Startup

If Show ‘(all)’ in Building List is also selected, then when you open the 

Reservation Book, the Room Filter dialog box opens on top of the 

Reservation Book. You can select different options on this dialog box to 

display only specific reservations in the book, for example, bookings 

only for selected rooms. If you do not select any options on this dialog 

box, but instead simply close it, then all reservations for all rooms in all 

buildings are displayed in the book.

Hide Current Time 

Indicator

Show or hide the vertical bar that indicates the current time for current 

day.

Note: The Current Time indicator is displayed only if the view is the 

Daily or Weekly view and the view includes the current day’s 

date.

Show ‘(all)’ in Building 

LIst

Show the “all” option on the Building dropdown list; otherwise, a user 

must select a specific building. If this option is selected in conjunction 

with Always Prompt for Room Filter on Startup, then when you open the 

Reservation Book, then the Room Filter dialog box always opens on top 

of the Reservation Book. If you are setting your Reservation Book 

options, and you do not want to the Room Filter dialog box to open on 

top of the Reservation Book when you open the book, then do the 

following:

• Clear Always Prompt for Room Filter on Startup.

• Clear Show (‘all’) in Building List.

• On the Building dropdown list in the Reservation Book, select any

building, area, or view.

Note: The building, area, or view that you select is not important. This 

last step just clears the “all” building option from the Reservation 

Book cache and ensures that the Room Filter dialog box does 

not open on top of the Reservation Book. Going forward, you can 

always select all buildings, or any specific building, area, or view 

as needed when you are working in the Reservation Book.

Show Capacity Show the minimum and maximum capacities next to the room 

description.

Hide Booking Shadow Hide the vertical shadow bar that highlights the reserved and/or event 

start times and end times when a user moves a booking in the 

Reservation Book.

Option Description



69

 
Reservations and Bookings

Tooltips

Click Options (upper right hand corner of Reservation Book) to open the Book Options 
dialog box, and then open the Tooltip Display tab and select which items to include in the 
tooltip that opens when you rest the mouse pointer on an event in the Reservation Book.

Figure 2-16: Book Options dialog box, Tooltip Display tab

Display Date (Calendar)

On the Date field, click the dropdown arrow to open the Calendar. Use the scroll features (< 
and >) at the top of the calendar to change the month or year. To select a different date for a 
month, click the date.

Figure 2-17: Reservation Book calendar
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Display Date (Scroll Features)

Use the scroll features at the top of the reservation book display to scroll to a different day, 
week, month, year, or any different combination of these.

Figure 2-18: Reservation Book calendar scroll features

To view reservation information

1. On the toolbar, click the Book icon .

The Reservation Book opens in the Daily view. See Figure 2-9 on page 63.

2. Optionally, you can do one or more of the following to view the reservation information:

• View the reservation in the Navigator by doing one of the following:

• Double-click the middle bar for the reservation entry.

• Right-click the reservation entry and on the context menu that opens, click
Open.

See  “The Navigator,” on page 77.

• View the bookings for a room. See “Room Bookings” on page 71.

• View the properties for a room. See “Room Properties” on page 71.

• View the pricing for a booked room. See “Room Pricing” on page 72.

• View any images of the room. See “Room Images” on page 72.

• View the user defined fields (UDFs) that are associated with the room. See “Room
UDFs” on page 73.

• View the setup information, event information, or teardown information for a
reservation. See “Room Information” on page 73.

• Change the time zone in which to view all your bookings. See “Time Zone” on page
73.

Optionally, when the Reservation Book first opens, before you view, edit or make a 
reservation, you can change the Reservation Book view so that it better suits your 
working needs. See “To change the Reservation Book display” on page 64.
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Room Bookings

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info 
dialog box. The tab on this dialog box lists all the bookings for the selected room based on 
the current view (Daily, Weekly, Monthly) and on the date that is shown in the Date field. To 
view a booking in the Navigator, select the booking, and then click Open.

Figure 2-19: Room Info dialog box, Bookings tab

Room Properties

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info 
dialog box, and then open the Room tab. The tab on this dialog box lists all the properties for 
the room, such as the room code, the room name, the room classification, and so on. It also 
lists the setup type and capacity for the room, and any notes that have been entered for the 
room.

Figure 2-20: Room Info dialog box, Room tab
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Room Pricing

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info 
dialog box, and then open the Pricing tab. This tab displays any pricing information that was 
defined for the room.

Figure 2-21: Room Info dialog box, Pricing tab

Room Images

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info 
dialog box, and then open the Images tab. This tab displays any uploaded images of the 
room.

Figure 2-22: Room Info dialog box, Images tab
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Room UDFs

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info 
dialog box, and then open the User Defined Fields tab. This tab displays any UDFs that have 
been associated with the room.

Figure 2-23: Room Info dialog box, User Defined Fields tab

Room Information

Rest the mouse pointer on the left bar, middle bar, or right bar for the reservation entry. A 
tooltip showing the respective setup, event, or teardown information opens.

Figure 2-24: Viewing setup information

Time Zone

If buildings that are located in multiple time zones are currently displayed, you can specify 
the time zone in which to view all of your bookings.

Figure 2-25: Changing the time zone
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To make a new reservation

1. On the toolbar, click the Book icon .

The Reservation Book opens in the Daily view. See Figure 2-9 on page 63.

2. Change the display to show the room for which you are making the reservation.

3. Select the date for which you are making the reservation.

4. In the Time Grid next to the room, click and hold the left mouse button, drag the mouse
to schedule the room and time, and then release the mouse button to open the
Reservation Wizard.

Figure 2-26: Making a new reservation in the Reservation Book

5. Continue to “Making a Reservation Using the Reservation Wizard” on page 45.

To edit an existing reservation

1. On the toolbar, click the Book icon .

The Reservation Book opens in the Daily view. See Figure 2-9 on page 63.

You must leave the Date view in the Daily display.

As you drag the mouse, the cursor changes to a double-headed arrow and a blue 
horizontal bar is displayed. 

Optionally, when the Reservation Book first opens, before you view, edit or make a 
reservation, you can change the Reservation Book view so that it better suits your 
working needs. See “To change the Reservation Book display” on page 64.
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2. Optionally, you can do one or more of the following to edit an existing reservation:

3. Optionally, you can right-click on a reservation in the Reservation Book, and on the
context menu that opens, select one of the following:

Step Action

Change the setup time for a 

reservation

• Drag the left bar horizontally to a new time.

• Click Yes in the Confirm Change dialog box.

Change the event time • Drag the middle bar horizontally to a new time.

• Click Yes in the Confirm Change dialog box.

Change the teardown time for a 

reservation

• Drag the right bar horizontally to a new time.

• Click Yes in the Confirm Change dialog box.

Edit the reservation building, room, 

time, or both

• Drag and drop the reservation to a new room that is the

same building or in a different building, and/or to a new

time.

• Click Yes in the Confirm Change dialog box.

Option Description

Open Opens a reservation in the EMS Navigator.

Add to Personal Calendar Adds the reservation to your personal calendar.

Move Forward Move the reservation date forward by one day or one week. 

Move Backward Move the reservation date backward by one day or one week. 

Move to Specific Date Move the reservation to a specific date. 

Change Status Change the status of the reservation. 

Copy Bookings Opens the Copy Bookings wizard. See “Copying Multiple 

Bookings in the Navigator” on page 129.

Swap Rooms With Another 

Booking (EMS)

Swap the room assignments of two events. The swap option 

is applicable only for two events that have identical meeting 

patterns.

To swap rooms:

• Right-click on one of the two reservations that you are

swapping, and on the context menu that opens, click Swap

Rooms.

• Click on the other of the two reservations that you are

swapping.

• Click Yes in the Confirm Change dialog box.

Note: If the rooms that you are swapping have been

configured with a default setup type, and the setup 

count is not within the capacity of one or both rooms, 

a message opens indicating this, but you are not 

prevented from swapping rooms. 

Swap Rooms With Another 

Booking (EMS Campus)

Swaps only the two bookings selected for the indicated day. 

(Just like Swap Rooms With Another Booking in EMS.)
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Swap Rooms With Another Course 

(EMS Campus)

If the meeting patterns of two courses are identical, then the 

swap is allowed and all bookings between the two courses for 

the entire term are swapped.

Highlight Related Bookings Highlights the bookings that belong to the same reservation.

Option Description
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The Navigator is a window in EMS that you use to view and manage all aspects of a 
reservation including bookings and booking details. 

This chapter covers the following topics:

• “Navigator Overview” on page 79.

• “Adding Bookings to a Reservation in the Navigator” on page 97.

• “Editing a Reservation in the Navigator” on page 98.

• “Repricing Categories and Room Charges for a Reservation” on page 100.

• “Changing the Status for a Reservation from the Reservation Summary tab” on page 102.

• “Copying a Reservation in the Navigator” on page 106.

• “Editing a Booking in the Navigator” on page 109.

• “Editing Multiple Bookings in the Navigator” on page 112.

• “Moving Bookings to a Different Reservation” on page 127.

• “Copying Multiple Bookings in the Navigator” on page 129.

• “Booking Details and Items Overview” on page 133.

• “Adding Booking Details and Items to Individual Bookings” on page 138.

• “Adding Booking Details and Items to Multiple Bookings” on page 148.

• “Adding Booking Detail Items to Multiple Bookings” on page 155.

• “Editing Booking Detail Items for Individual Bookings” on page 157.

• “Editing Booking Detail Item Charges for Multiple Items” on page 161.

• “Editing Count Information for a Booking” on page 163.

• “Applying a Reservation Discount” on page 165.

• “Copying Booking Details Between Bookings” on page 167.

• “Deleting Booking Detail Items from Multiple Bookings” on page 170.

• “Deleting Booking Details from Multiple Bookings” on page 173.

• “Working with Comments and Reminders in the Navigator” on page 175.

• “Adding Multiple Comments and Reminders to a Reservation” on page 179.
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• “Working with User Defined Fields in the Navigator” on page 181.

• “Working with Attachments in the Navigator” on page 184.

• “Working with Drawings in the Navigator” on page 188.

• “Running the Resource Utility Conflicts Tool” on page 192.
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Navigator Overview

This section provides an overview of opening a reservation in the Navigator, the Navigator’s 
layout and folder structure, and the commands that are available in the Navigator.

Opening a reservation in the Navigator

After you create a new reservation using the Reservation Wizard, the reservation opens 
automatically in the Navigator. You can also manually open the Navigator by:

• Selecting a reservation, booking, or service order to open directly in the Navigator. See
“Opening a reservation directly in the Navigator” below.

• Opening a reservation through the Reservation Book. See “Opening a reservation through
the Reservation Book” on page 80.

• Opening a reservation through a group. See “Opening a reservation through a group” on
page 80.

• Opening a reservation through a search. See “Opening a reservation through a search” on
page 80.

Opening a reservation directly in the Navigator

1. On the toolbar, click the Navigator icon  to open the Open Navigator dialog box. 

Figure 3-1:  Open Navigator dialog box

2. On the Open dropdown list, select the item that you are opening—reservation, booking,
or service order.
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3. Do one of the following:

• In the No. field, enter the number for the reservation, service order, or booking, and
then click OK.

• To enter the last reservation, booking, or service order that you made during your
current or last EMS session, double-click in the field, and then click OK.

Opening a reservation through the Reservation Book

On the toolbar, click the Book icon  to open the Reservation Book, and then in the 
Reservation Book, double-click a booking for the reservation to open the reservation in the 
Navigator. See “Viewing and Editing Reservations in the Reservation Book” on page 62.

Opening a reservation through a group

You can search for a reservation for a group and open the reservation in the Navigator from 
the group-specific window. See “Working with Reservations for a Group” on page 295.

Opening a reservation through a search

You can search for a reservation using the Browser, the Web Reservation Tool, and/or the 
Calendar, and then double-clicking the search result entry to open the reservation in the 
Navigator. See “Search Tools,” on page 195.

If you do not know the reservation number, you can search for the reservation. On 
the Open Navigator dialog box, click Browse to open the Browser, and then 
continue to “Searching with the Browser or with the Web Reservation Tool” on 
page 197.

You can also click Browse on the Open Navigator dialog box to open the Browser 
search tool.
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Layout and folder structure

The Navigator has three panes—a left pane, a top right pane, and a bottom left pane. The left 
pane displays a selected reservation, all the bookings for the reservation, and the details for 
each booking in a Windows Explorer-style folder structure. The top-level folder is the 
reservation folder. The folders that are located beneath a reservation folder are the booking 
folders. The folders that are located beneath a booking folder are the booking detail folders. 
The top right pane of the Navigator displays different tabs and options depending on the 
folder or item that is selected in the left pane of the Navigator. The bottom right pane of the 
Navigator functions just like a browser window (see “Getting Started with EMS” on page 
27), and it also displays different information and options depending on the folder or item 
that is selected in the left pane.

Figure 3-2:  Navigator window with a reservation folder selected

Reservation folder

A reservation folder contains the who and the what information for the reservation. When 
you select a reservation folder in the left pane of the Navigator, the reservation number is 
displayed in the title bar of the Navigator, and the following tabs are displayed in the upper 
right pane of the Navigator:

• Reservation Summary tab—The Reservation Summary displays information about the
selected reservation, including the event name, the group for which the reservation was
made, the group contact name, the group contact phone number, and the reservation
number.

• Properties tab—The Properties tab displays not only the same information as the
Reservation Summary tab, but also information such as the event type, the second group
contact, the date that the reservation was added, the date that the reservation was changed,
and so on.
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• Billing Reference Allocation tab—By default, the charge for a reservation is allocated to
a single billing reference number. On the Billing Reference Allocation tab, you can
allocate the charge for a reservation to multiple billing reference numbers by percentage.
See “To allocate charges to multiple billing reference numbers and/or PO numbers” on
page 83.

• PO Number Allocation tab—By default, the charge for a reservation is allocated to a
single purchase order (PO) number. On the PO Number Allocation tab, you can allocate
the charge for a reservation to multiple billing PO numbers by percentage. See “To
allocate charges to multiple billing reference numbers and/or PO numbers” on page 83.

• Reminders tab—The Reminders tab displays any reminders that were created for the 
selected reservation. See “Working with Comments and Reminders in the Navigator” on 
page 175.

• Comments—The Comments tab displays any text entries that were made for the selected 
reservation. See “Working with Comments and Reminders in the Navigator” on page 175.

• Attachments tab—The Attachments tab displays any attachments (files) that have been 
saved with the reservation. See “Working with Attachments in the Navigator” on page 
184.

• User Defined Fields—The User Defined Fields tab displays the additional fields that store 
custom data for a reservation. Your EMS administrator configures the types of fields that 
are available as well as the allowed values for these fields. See “Working with User 
Defined Fields in the Navigator” on page 181.

• Transactions—The Transactions tab displays any invoices that were generated for the 
selected reservation or any payments that were applied to the selected reservation. See  
“Billing,” on page 361 for detailed information about invoices and other financial 
transactions in EMS.

• History tab—The History tab displays the history for the reservation—the date that a 
change was made to the reservation, the ID of the user who made the change, the field that 
was changed, the old field value, and the new field value.

• Emails tab—The Emails tab displays any summarizing information for any emails that 
were sent via SMTP to the group for whom the reservation was made. See “Sending 
Email from EMS” on page 414.

Your EMS administrator must enable the Use Billing Reference Allocation 
parameter for this tab to be displayed. See EMS System Parameters in the EMS 
Setup Guide.

Your EMS administrator must enable the Use PO Number Allocation parameter 
for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.



83

  The 

Navigator

Also, when you select a reservation folder:

• All the tabs in the upper pane of the window have some of the basic features of an EMS
browser window. You can change the width of the data columns, you can sort the data
columns on a tab in either ascending or descending sort order, and you can rearrange the
column order by dragging a column to a new location using the column heading. See “An
EMS Browser Window” on page 35.

• The bookings for the selected reservation are displayed in the Bookings pane (the lower
right pane) of the Navigator. The colored rectangle to the left of a booking indicates the
booking’s status. If a booking has been canceled, a Canceled icon  is displayed on the
booking folder in both the Reservation (left) pane and the Bookings pane.

• You can right-click in the upper pane and open a context menu with options for emailing
the group for which the reservation was made, or the first contact for the group.

To allocate charges to multiple billing reference numbers and/or PO numbers

1. For a selected reservation, open the Billing Reference Allocation tab, and then click
Edit.

The Billing Reference Allocation dialog box opens. By default, when this dialog box
first opens, it displays the charge for the reservation allocated 100% to a single billing
reference number placeholder.

Figure 3-3:  Billing Reference Allocation dialog box

The following procedure details how to allocate a reservation charge to multiple 
billing reference numbers; however, by analogy, you can follow this procedure to 
allocate booking charges or booking detail charges to multiple billing reference 
numbers and/or PO numbers.
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2. Select the billing reference number placeholder, and then click Edit.

The Split Billing Add dialog box opens.

Figure 3-4:  Split Billing Add dialog box

3. Do one of the following:

• Enter the billing reference number to which you are allocating the reservation
charges, and then click OK.

The Split Billing Add dialog box closes. You return to the Billing Reference
Allocation dialog box with the newly added billing reference number allocated at
100%. Continue to Step 5.

• Click the Search icon  to open a Billing References dialog box, and then do one 

of the following:

• Select a billing reference number from the list, click Select, and then click OK.

• In the Find field, enter a search string, and then click Display to display a list of
all billing reference numbers that meet your search criteria. Select the
appropriate billing reference number from the search results, click Select, and
then click OK.

The Billing References dialog box closes. You return to the Split Billing Add dialog 
box with the selected billing reference number displayed in the dialog box. Continue 
to Step 4.

4. Click OK.

The Split Billing Add dialog box closes. You return to the Billing Reference Allocation
dialog box with the selected billing reference number allocated at 100%.

Your search is limited to the exact order of the characters in the string, but the 
string is not case-sensitive, and it can appear anywhere in the search results. For 
example, a search string of 445 returns both 123.445.678 and 445.678.123.
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5. Do one of the following:

• To allocate the reservation charges to only this single billing reference number, click
OK.

The Billing Reference Allocation dialog box closes and you return to the Navigator.
The newly added billing reference number, allocated at 100%, is displayed on the
Billing Reference Allocation tab.

• To allocate the reservation charges to multiple billing reference numbers, continue to
Step 6.

6. Click New.

The Split Billing Add dialog box opens.

Figure 3-5:  Split Billing Add dialog box

7. Do one of the following:

• In the Billing Reference field, enter a billing reference number., and then click OK.

• Click the Search icon  to open a Billing References dialog box, and then do one 

of the following:

• Select a billing reference number from the list, click Select, and then click OK.

• In the Find field, enter a search string, and then click Display to display a list of
all billing reference numbers that meet your search criteria. Select the
appropriate billing reference number from the search results, click Select, and
then click OK.

The Split Billing Add dialog box closes. You return to the Billing Reference Allocation 
dialog box with each of the newly added billing reference numbers displayed with a 0% 
allocation.

8. Repeat Step 6 and Step 7 until you have added all the needed billing reference numbers.

Your search is limited to the exact order of the characters in the string, but the 
string is not case-sensitive, and it can appear anywhere in the search results. For 
example, a search string of 445 returns both 123.445.678 and 445.678.123.
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9. For each new billing reference number, double-click in the Percent field to select the
percent, and then change the percent to the appropriate value.

10. Click OK to close the Billing Reference Allocation dialog box and return to the Billing
Reference Allocation tab.

All the billing reference numbers and their percent allocations are displayed on the tab.

Booking folder

Booking folders contain the where and when information for the reservation. If you can 
expand a booking folder, this indicates that details have been added to the booking. The 
booking details for the selected booking are displayed in the Booking Details pane (the lower 
right pane) of the Navigator. A green background for a booking detail folder indicates that 
one or more booking detail items have been invoiced for the booking. 

Figure 3-6:  Navigator window with a booking folder selected

When you select a booking folder in the left pane of the Navigator, the booking number is 
displayed in the title bar of the Navigator, and the following tabs are displayed in the upper 
right pane of the Navigator:

• Booking Summary tab—The Booking Summary displays information about the selected
booking, including the event date, the reserved time, the event time, and so on. If you use
Outlook as your email program, you can do the following from this tab:

• To add the selected booking to your personal calendar, click Outlook > Add to
Personal Calendar.

• To send invitations for the meeting to one or more contacts in your Outlook Address
Book, click Outlook > Send Invitation.

The percentages must add up to 100%.
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• Properties tab—The Properties tab displays not only the same information as the Booking
Summary tab, but also information such as the event type, the setup count, the date that
the booking was added, the date that the booking was changed, and so on.

• Billing Reference Allocation tab—By default, the charge for a booking is allocated to a
single billing reference number. On the Billing Reference Allocation tab, you can allocate
the charge for a booking to multiple billing reference numbers by percentage. See “To
allocate charges to multiple billing reference numbers and/or PO numbers” on page 83.

• PO Number Allocation tab—By default, the charge for a booking is located to a single
purchase order (PO) number. On the PO Number Allocation tab, you can allocate the
charge for a reservation to multiple billing PO numbers by percentage. See “To allocate
charges to multiple billing reference numbers and/or PO numbers” on page 83.

• Reminders tab—The Reminders tab displays any reminders that were created for the
selected booking. See “Working with Comments and Reminders in the Navigator” on
page 175.

• Attachments—The Attachments tab displays any attachments that were saved with the
booking. See “Working with Attachments in the Navigator” on page 184.

• Comments—The Comments tab displays any comments that were made for the selected
booking. See “Working with Comments and Reminders in the Navigator” on page 175.

• Drawings—The Drawings tab displays a list of files that were attached to the selected
booking. See “Working with Drawings in the Navigator” on page 188.

• History—The History tab displays a list of changes made for the selected booking—the
date the change was made to the booking, the user who made the change to the booking,
and information (field) that was changed for the booking.

Also, when you select a booking folder, all the tabs in the upper pane of the window have 
some of the same basic features of an EMS browser window. You can change the width of 
the data columns, you can sort the data columns on a tab in either ascending or descending 
sort order, and you can rearrange the column order by dragging a column to a new location 
using the column heading. See “To group data by columns in an EMS Browser window” on 
page 36 and “” on page 39.

Your EMS administrator must enable the Use Billing Reference Allocation 
parameter for this tab to be displayed. See EMS System Parameters in the EMS 
Setup Guide.

Your EMS administrator must enable the Use PO Number Allocation parameter 
for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.
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Booking detail folder

If you can expand a booking folder, this indicates that details have been added to the 
booking. Booking details, which are also called categories, are the services (catering, A/V 
equipment, and so on), notes, attendees, activities, and room charges that you can add to a 
booking. 

Figure 3-7:  Navigator window with a booking detail folder selected

Booking detail folders and booking detail items are discussed in “Booking Details 
and Items Overview” on page 133.
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Navigator commands

The Navigator has two constant commands in the upper left hand corner—Open Reservation 
and View Alerts and three constant commands in the upper right hand corner—Print, 
Refresh, and Settings.

All other navigator commands are available as buttons in the upper right pane and lower 
right pane of the Navigator. 

Command Description

Open Reservation Allows you to open and work with multiple reservations in the same 

Navigator session. See “Opening a reservation directly in the Navigator” 

on page 79.

View Alerts Open and view any alerts that have been generated for the selected 

reservation, booking, or a booking detail that is a service order or 

catering category.

Print • Printing an invoice or a confirmation at the reservation level. See  
“Confirmations,” on page 307.

• Printing the Setup Worksheet for Reservation report, the Service 
Orders report, and the Banquet Event Order report. See “Reports 

and Queries,” on page 319.

• Printing the Transaction report. See “Generating an EMS Billing 
Report” on page 394.

• Printing the history of a reservation, all its bookings, and all its 
booking detail items.

Refresh For refreshing the Navigator display based on the settings that you have 

specified in the Navigator Options dialog box. See “Navigator Options 

dialog box” on page 90.

Settings • Options—Opens the Navigator Options dialog box in which you can 
specify such things as what is to be displayed in the Navigator, 
mouse actions in the Navigator, and so on. See “Navigator Options 
dialog box” on page 90.

• Confirmation Settings—Opens the Confirmation Settings dialog box 
which provides a variety of options that you can specify for manual 
and automatic generation of a confirmation for a reservation or a 
booking. See  “Confirmations,” on page 307.
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Navigator Options dialog box

The Navigator Options dialog box has three tabs—General, At A Glance, and Highlight 
Categories.

General tab

General tab—On the General tab, you select the options for such things as which types of 
bookings to show in the Navigator (old bookings and/or canceled bookings), the result of 
double-clicking a listed folder (opens the item or expands the folder), the booking time that 
is displayed (reserved time or event time), and the highlight color for invoiced items.

Figure 3-8:  Navigator Options dialog box, General tab

Field Description

General

Show Old Bookings Show bookings in the Navigator that occurred before the current 

day’s date.

Show Cancelled Bookings Selected, show bookings in the Navigator with a canceled status.

Show Wizards in Tools menu Show all on the Tools menu in the Bookings pane. If cleared, 

show only the “Wizards” option, which you must click to open a 

form from which you can select a tool. 

Show Deleted Items Show all deleted items (bookings, deleted resource items, and so 

on) for a reservation in the Navigator.
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Hide Empty Tabs Hide the tabs that do not have any data displayed on them for a 

selected reservation, booking, or booking detail.

Double-Clicking a Listed Folder

Opens the item Opens the item for editing. 

Expands folder Opens the next level of folders.

Wizard Results

Always Show Show a confirmation of all changes, regardless if they were 

successful, on a Wizard Results page.

Show Unchanged Only Show only those changes that were not successful on a Wizard 

Results page. 

Confirmation

Always prompt When you click Confirmation, opens a Confirmation filter which 

you can use to change the default filter options for a confirmation 

before generating it.

Print Preview When you click Confirmation, opens an onscreen preview of the 

confirmation.

Email When you click Confirmation, opens an email of the confirmation.

Print When you click Confirmation, prints an immediate confirmation.

Booking Display Time

Reserved Time Show the total time for which the space is reserved. This time is 

the event time plus the setup/teardown times.

Event Time Show only the event time for which the space is reserved.

Invoiced Items

Highlight Color The color with which invoiced items are highlighted in the 

Navigator window.

Service Orders

Show Pricing Show pricing on a service order.

Show Item Notes Show item notes on a service order.

Show Item Special Instructions Show special instructions for items on a service order.

Highlight Changes Made Within 

(days)

Highlight any changes that have been made to a service order 

within the specified number of days.

Footer Message Show reconfigured blocks of text that appear in footer of a 

service order (for example, a Cancellation policy).

Booking Edit

Auto Adjust Reserved Time 

When Event Time is Changed

If the reservation includes setup and/or teardown times, then 

automatically adjust the total time for the reservation (the event 

time plus the setup/teardown time) when the event time is 

changed.

Field Description
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At A Glance tab

On the At A Glance tab, you specify whether reminders, comments, attachments, and so on 
are to be displayed in the left pane of the Navigator when a reservation folder, booking 
folder, booking detail folder, and/or booking detail item is opened.

Figure 3-9:  Navigator Options dialog box, At A Glance tab
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Highlight Categories

On the Highlight Categories tab, you indicate whether a checkmark is to be displayed on all 
booking detail item folders for the selected booking detail. The default is to Highlight All, 
which means every booking detail item folder for every booking detail is denoted with a 
checkmark.

Figure 3-10: Navigator Options dialog box, Highlight Categories tab
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Other Navigator commands

All other Navigator commands are available as buttons in the upper right pane and lower 
right pane of the Navigator. The buttons that are available are dynamically updated based not 
only on the folder or item that is currently selected in the left pane of the Navigator, but also 
on the tab that is open in the upper right pane of the Navigator. 

Figure 3-11: Buttons available in the Navigator window with a reservation folder selected

Figure 3-12: Buttons available in the Navigator window with a booking folder selected
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Figure 3-13: Buttons available in the Navigator window with a booking detail folder selected

Many of these same commands are also available on a context menu, which is a menu that 
opens when you right-click on a folder or item in the Navigator. All the context menus that 
are available in the Navigator offer a limited set of choices based on the folder or item that is 
selected in the Navigator. See Figure 3-14 below and Figure 3-15 on page 96.

Figure 3-14: Comparing context menus

Reservation context menu

Booking context menu
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Figure 3-15: Comparing context menus

Booking Detail context menu

Booking Detail Item context menu
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Adding Bookings to a Reservation in the 

Navigator

You can use the Navigator to add one or more bookings to an existing reservation.

To add bookings to a reservation

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation to which you are adding the 
bookings, and then in the Bookings pane, click New.

The Reservation Wizard opens. See “Making a Reservation Using the Reservation 
Wizard” on page 45.
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Editing a Reservation in the Navigator

When you edit a reservation in the Navigator, you are working with the who and the what 
information for the event—the event name, the group name, and so on. When you edit a 
reservation, you can edit the reservation information (event name, event coordinator, and so 
on), and you can edit the billing information (pricing plan, payment type, and so on).

To edit a reservation in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In left pane the Navigator, select the reservation that you are editing, and then on the 
Reservation Summary tab or on the Properties tab, click Edit.

The Reservation window opens. The Reservation tab is the active tab.

Figure 3-16: Reservation window, Reservation tab

When you edit a reservation, if you select a different pricing plan, then the pricing 
plan is applied at the reservation level only. Categories and room charges are not 
automatically repriced. To reprice your categories or room charges based on a 
new pricing plan, you must use the Update Pricing Plan wizard. See “Repricing 
Categories and Room Charges for a Reservation” on page 100.



99

  The 

Navigator

3. Do one or both of the following:

• On the Reservation tab, edit any and all the reservation information as needed.

• Open the Billing tab, and then edit any and all the billing information as needed.

Figure 3-17: Reservation window, Billing tab

4. Click OK.

The Reservation window closes and you return to the Navigator, which now shows the
updated information for the reservation.

If you select a different pricing plan, then the pricing plan is applied at the 
reservation level only. Categories and room charges are not automatically 
repriced. To reprice your categories or room charges based on a new pricing plan, 
you must use the Update Pricing Plan Wizard. See “Repricing Categories and 
Room Charges for a Reservation” on page 100.
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Repricing Categories and Room Charges for a 

Reservation

When you edit a reservation, if you select a different pricing plan, then the pricing plan is 
applied at the reservation level only. Categories and room charges are not automatically 
repriced. To reprice your categories or room charges based on a new pricing plan, then you 
must use the Update Pricing Plan Wizard.

To reprice categories and room charges for a reservation

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In left pane of the Navigator, select the reservation that you are repricing, and then on the 
Reservation Summary tab, click Update Pricing.

The Update Pricing Plan Wizard opens. The current pricing plan for the reservation is 
displayed in the Pricing Plan field. The window displays all the categories, including 
room charges, that can be repriced in one or more of the reservation bookings.

Figure 3-18: Update Pricing Plan Wizard
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3. Select the category, or CTRL-click to select the multiple categories that you are repricing
for the reservation.

4. Click Next.

The Select Bookings window opens. This window lists all the bookings with one or
more of the selected categories that can be repriced.

Figure 3-19: Update Pricing Plan Wizard, Select Bookings window

5. Select the booking, or CTRL-click to select the multiple bookings for which you are
repricing the categories and/or room charges, or click Select All to select all the
displayed bookings in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

6. Click OK to close the message and return to the Navigator.

You can reprice a room charge for a booking only if the room charge has not been 
invoiced. To reprice a room charge that has been invoiced, you must first void the 
invoice. See “To void an invoice” on page 372.
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Changing the Status for a Reservation from the 

Reservation Summary tab

Even though the Change Booking Status Wizard is available for changing the status of 
multiple bookings in a reservation, most reservationists who approve reservations that are 
submitted from VEMS do so by using the Change Status function that is available on the 
Reservation Summary tab in the Navigator. This is because unlike the Change Booking 
Status Wizard, when you use the Change Status function in the Navigator to change the 
status of a reservation, an option is available for automatically generating and sending a 
confirmation to the group for whom the reservation was made.

To change the status for a reservation

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In left pane the Navigator, select the reservation that you are editing, and then on the 
Reservation Summary tab, click Change Status.

The Change Booking Status window opens. See Figure 3-20 on page 103.

Your EMS administrator must grant you the appropriate security access to change 
the status of a booking, which includes canceling a booking. If you want to change 
the status of a booking using the Change Booking Status Wizard, see “Editing 
Multiple Bookings in the Navigator” on page 112.

An email can be automatically generated and sent only if Email is selected for the 
Confirmation setting on the General tab of the Navigator Options dialog box, and 
if the group for which the reservation was made has an email address in its record. 
See “Navigator Options dialog box” on page 90 and “Searching for and 
Configuring Groups” on page 255.
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Figure 3-20: Change Booking Status window

3. On the Status dropdown list, select the new status for the bookings.

4. Enter a Reconfirm Date if it is required for the new status that you selected.

5. Optionally, do one or both of the following:

• Leave Update Reservation Status selected to have the reservation-level status
changed as well.

• Select Send Confirmation If Successful to have an email automatically generated
and sent to the group for whom the reservation was made.

If you select any type of Canceled status, then three additional fields—Reason, 
Who Cancelled and Notes—are displayed on the Change Booking Status window. 
You must enter data in all three of these fields before you can continue in the 
Wizard.

The confirmation is generated based on the system confirmation settings that you 
have specified. See “Specifying your Confirmation Settings” on page 308.
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6. Click Next.

The Select Bookings window opens. This window displays all the bookings for the
selected reservation with a date greater than or equal to the current day’s date and that do
not have invoiced items. By default, all the bookings are selected.

Figure 3-21: Select Bookings window

7. Select the booking, or CTRL-click to select the multiple bookings for which you are
changing the status, and then click Finish.

The Change Booking Status Results window opens. This window lists all the bookings
for the reservation, whether the status was successfully changed or not.

Figure 3-22: Change Booking Status Results window

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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8. Click Close to close the Change Status Results window and return to the Navigator.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
report opens onscreen. If you close this report, you can manually run a Resource 
Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > 
Resource Inventory Conflict.
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Copying a Reservation in the Navigator

An easy way for you to make a new reservation in the Navigator is to copy an existing 
reservation and then make any necessary changes to the reservation. When you copy an 
existing reservation, you must provide a new start date and a new status; however, you can 
copy the existing reservation reminders, comments, user-defined fields, and drawings as is, 
and you can copy one or more or all the existing booking details.

To copy a reservation in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation that you are copying, and then in 
the Bookings pane, click Tools, and then click Copy Reservation Wizard.

The Copy Reservation Wizard opens.

Figure 3-23: Copy Reservation Wizard
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3. Enter the information for the new reservation.

4. Click Next.

The Select Bookings window opens. This window displays all the bookings for the
reservation that you are copying.

Figure 3-24: Copy Reservation Wizard, Select Bookings window

Information Description/Comments

New Start Date The date of the first booking for the new reservation.

New Status The status for the new reservation.

Reconfirm Date You must enter a date if it is required for the new status that you selected.

Conflict Status You must enter a conflict status in the event that the new bookings are in 

conflict with any existing bookings.

Reconfirm Date You must enter a date if it is required for the new conflict status that you 

selected.

• Copy Reminders

• Copy Comments

• Copy User

Defined Fields

• Copy Attachments

• Copy Drawings

Leave the appropriate options selected to copy the existing items as is, or 

clear the option for each item that is not to be copied to the new 

reservation.

Copy Booking Details Select the booking details that are being copied (CTRL-click to select 

multiple details) or to select all the details for copying, click Select All.

Note: By default, only active booking details are displayed. To show 

inactive booking details for copying, click Show Inactive.

Copy Inactive 

Resources/Rooms

Selected by default. Copies the inactive resource and/or rooms from the 

existing reservation to the new reservation. Clear this option if you do not 

want to copy the inactive resources and rooms.
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5. Select the booking, or CTRL-click to select the multiple bookings that you are recreating
in the new reservation, or click Select All to select all the displayed bookings in a single
step, and then click Finish.

A message opens indicating that the changes were made successfully.

6. Click OK to close the message and return to the Navigator.

Both the existing reservation and the new reservation are now displayed in the left pane
of the Navigator. The new reservation is assigned a number based on the next available
reservation number in the database. If any of the new bookings are in conflict with
existing bookings, this conflict is indicated in the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.

The start date that you specified becomes the date of the first booking for the new 
reservation. In addition, the copied bookings are scheduled according to the same 
pattern as the existing reservation. For example, if the existing reservation has 
three bookings and each booking was scheduled every seven days (12/14, 12/21, 
and 12/28), and the start date for the new reservation is 12/15, then the new 
reservation has three bookings with dates of 12/15, 12/22, and 12/29.

When you copy multiple bookings, the bookings are simply copied and pasted as 
is—the bookings are not moved to a different location. If you need to move a 
booking to a different location, see “To edit the rooms for bookings” on page 118.
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Editing a Booking in the Navigator

When you edit a booking in the Navigator, you are working with the when and where 
information for the event—the event time, the event location, and so on. To edit a booking, 
you must have the appropriate security access. For example, you cannot move a booking to a 
room if your EMS administrator has not granted you access to the room. Likewise, you 
cannot change the status for a booking from Tentative to Confirmed if your EMS 
administrator has not granted you access to the Confirmed status.

Under certain circumstances, bookings or booking details in EMS can become locked. 
Locked items are displayed in EMS, but you cannot edit or cancel the items. This locking 
can affect the basic booking information (date, time, room, and so on) or the details for the 
booking (catering, equipment, and so on). Locks are typically independent of one another. 
Just because one item is locked does not mean other items in the reservation are locked. 
Bookings can be locked in the following situations: 

• Insufficient security—To edit a booking, you must have access to the room and status and
as well as the correct security processes assigned to your user account.

• Old bookings—A booked event is locked a certain number of days after it has taken place.
Your EMS administrator sets the value for this system parameter. Old bookings are
locked to prevent you and other users from changing the facts for a past event, which
could cause discrepancies between documents printed for the event and the information
in EMS. When a booking is locked because it is old, all of its details are also locked. You
cannot edit or delete existing details, and you cannot add new details.

• Invoiced bookings—When you create an invoice for a booking, you can bill for the entire
booking (the room fee plus all the fees for all the booking details) or for only certain items
that you choose (for example, the room fee and the equipment fees, but not the catering
fees). In either case, if a booking has one or more invoiced items, the booking is locked.
This means that you cannot edit or delete the booking, which includes changing the
booking status, and editing and deleting invoiced resources. You can, however, still add
more details to the bookings. For rooms, this means you cannot edit the room charge. You
also cannot move bookings that are invoiced to a new or existing reservation. You can,
however, still copy these bookings to a new or existing reservation.

Contact your EMS administrator for assistance.

To edit billable information for a booking, see “Editing Booking Detail Item 
Charges for Multiple Items” on page 161.

Remember, you can also edit certain booking information in the Reservation Book. 
See “To edit an existing reservation” on page 74. 
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To edit a booking in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In left pane of the Navigator, expand the folder structure for the reservation until the 
appropriate booking folder is visible.

3. Select the booking that you are editing, and then on the Booking Summary tab or on the 
Properties tab, click Edit.

The Booking window opens. A message is displayed at the top of the window that 
indicates the hours for the building that contains the selected room. If the booking has 
any type of booking detail assigned to it, then “This Booking has Service Orders” is 
displayed at the top of the window.

Figure 3-25: Booking window
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4. On the Booking tab, edit the information for the booking as needed, and then click OK.

Two results are possible:

• If you edited anything other than the date, time, or location for a booking, the
Booking window closes and you return to the Navigator, which now shows the
updated information for the booking.

• If you edited the date, time, or location for a booking, a dialog box opens, warning
you that critical booking information has changed and asking you if you want to
continue. Continue to Step 5.

5. Click Yes.

The Booking window closes and you return to the Navigator, which now shows the
updated information for the booking.

If you have been granted the appropriate security access, you change the status of 
a booking, which includes cancelling a booking. 

If you cancel a booking, a Cancel Status dialog box opens in which you must 
identify the user who canceled the booking and provide notes (for example, a 
cancellation reason) about the cancellation. If you change the status for a 
booking, you can select Update Reservation Status to have the reservation-level 
status changed as well.

If you edit a booking for a video conference event, then any date and time changes 
that you make to the booking automatically cascade to all related bookings.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
report opens onscreen. If you close this report, you can manually run a Resource 
Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > 
Resource Inventory Conflict.
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Editing Multiple Bookings in the Navigator

Four Wizards are available for editing the when and where information for multiple bookings 
in a reservation:

• The Change Booking Date/Time Wizard

• The Change Booking Status Wizard (which includes canceling multiple bookings in a
single step)

• The Change Rooms Wizard

• The Change Miscellaneous Booking Information Wizard (which includes type, setup
type, and setup count)

To edit multiple bookings in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation for which you are editing the 
bookings.

3. Continue to the following as appropriate:

• “To edit the booking date and/or time” on page 113.

• “To edit the booking status” on page 116.

• “To edit the rooms for bookings” on page 118.

• “To edit miscellaneous booking information” on page 125.

To edit billable information for a booking, see “Editing Booking Detail Item 
Charges for Multiple Items” on page 161.

Remember, you can also edit certain booking information in the Reservation Book. 
See “To edit an existing reservation” on page 74. 
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To edit the booking date and/or time

1. In the Bookings pane, click Tools > Change Booking Date/Time Wizard.

The Change Booking Date/Time Wizard opens.

Figure 3-26: Change Booking Date/Time Wizard

2. Select a different value for the date, time, or both.

Value Description

Date

• (no changes) • The default value.

• Reschedule Booking Earlier • Reschedule the bookings to an earlier date that is based on

the number of days that you specify.

• Reschedule Booking Later • Reschedule the bookings to a later date based on the

number of days that you specify.

• Reschedule Booking to

Specific Date

• Reschedule the bookings to a new date that you specify.

Time

• (no changes) • The default value.

• End Booking Earlier • Resets the event end time and the reserved end time to an

earlier time, based on the number of hours that you specify.

• End Booking Later • Resets the event end time and the reserved end time to a

later time, based on the number of hours that you specify.

• Reschedule Booking Earlier • Resets both the event start and end times and the reserved

start and end times to an earlier time, based on the number

of hours that specify.
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3. Click Next.

The Select Bookings window opens. By default, this window displays all the bookings
for the selected reservation with a date greater than or equal to the current day’s date.

Figure 3-27: Change Booking Date/Time Wizard, Select Bookings window

• Reschedule Booking Later • Resets both the event start and end times and the reserved

start and end times to a later time, based on the number of

hours that you specify.

• Reschedule Booking to

Specific Time

• Resets the following values based on the specific times that

you select:

• Reserved Start

• Event Start

• Event End

• Reserved End

• Set Setup/Teardown • Resets the setup or teardown times based on the hours or

minutes that you specify.

• Start Booking Earlier • Resets the event start time and the reserved start time to an

earlier time, based on the number of hours that you specify.

• Start Booking Later • Resets the event start time and the reserved start time to a

later time, based on the number of hours that you specify.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.

Value Description
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4. Select the booking, or CTRL-click to select the multiple bookings that you are editing, or
click Select All to select all the displayed bookings in a single step, and then click Finish.

The Change Booking Date/Time Results window opens. This window displays a list of
all the selected bookings, whether the date/time change was successful or not.

Figure 3-28: Change Booking Date/Time Results window

5. Click Close to close the Change Booking Date/Time Results window and return to the
Navigator.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
report opens onscreen. If you close this report, you can manually run a Resource 
Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > 
Resource Inventory Conflict.
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To edit the booking status

1. In the Bookings pane, click Tools > Change Booking Status Wizard.

The Change Booking Status Wizard opens.

Figure 3-29: Change Booking Status Wizard

2. On the Status dropdown list, select the new status for the bookings.

3. Enter a Reconfirm Date if it is required for the new status that you selected.

4. Optionally, leave Update Reservation Status selected to have the reservation-level status
changed as well.

If your EMS administrator has granted you the appropriate security access, you 
can change the status of a booking, which includes canceling a booking. If you 
change the status for a booking, you can leave the option of Update Reservation 
Status selected to have the reservation-level status changed as well.

This is the same Wizard that opens if you select a reservation in the Navigator, and 
then on the Reservation Summary tab, click Change Status. See “Changing the 
Status for a Reservation from the Reservation Summary tab” on page 102.

If you select any type of Canceled status, then three additional fields—Reason, 
Who Cancelled and Notes—are displayed on the Change Booking Status window. 
You must enter data in all three of these fields before you can continue in the 
Wizard.
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5. Click Next.

The Select Bookings window opens. This window displays all the bookings for the
selected reservation with a date greater than or equal to the current day’s date and that do
not have invoiced items. By default, all the bookings are selected.

Figure 3-30: Change Booking Status Wizard, Select Bookings window

6. Select the booking, or CTRL-click to select the multiple bookings for which you are
changing the status, or click Select All to select all the displayed bookings in a single
step, and then click Finish.

The Change Booking Status Results window opens. This window displays a list of all the
selected bookings, whether the status change was successful or not.

Figure 3-31: Change Booking Status Results window

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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7. Click Close to close the Change Status Results window and return to the Navigator.

To edit the rooms for bookings

1. In the Bookings pane, click Tools > Change Room Wizard.

The Change Room Wizard opens. Search for Rooms is selected by default.

Figure 3-32: Change Room Wizard

2. Do one of the following:

• To search for rooms, continue to “To search for rooms” on page 119.

• To select a specific room, select Specific Room, and then continue to “To select a
specific room” on page 123.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
report opens onscreen. If you close this report, you can manually run a Resource 
Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > 
Resource Inventory Conflict.
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To search for rooms

1. Click Next.

The Change Room Wizard Select Bookings window opens with a list of all the bookings
for the selected reservation with a date greater than or equal to the current day’s date.

Figure 3-33: Change Room Wizard, Select Bookings window

2. Select the time/room combination with which to work, and then click Next. (For
example, an 8 a.m. event and a 2 p.m. event in the same room are displayed as two
separate items; however, multiple 10 a.m. bookings in the same room on different dates
are displayed as a single item with the number of bookings indicated in the Number of
Bookings field.)

The Change Rooms window is refreshed with options for changing the building, the
room, the status, or any combination of these. See Figure 3-34 on page 120.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.



120

  The 

Navigator

Figure 3-34: Change Rooms Wizard with location and status options

3. In the left pane of the Change Rooms window, select the booking, or CTRL-click to
select the multiple bookings that you are moving to a new room, or click Select All to
select all the displayed bookings in a single step.

4. In the right pane, change the building, the room specifications, the status, the room
features, or any combination of these as needed for the selected bookings, and then click
Next.

5. If you did not select a specific Setup Type, then go Step 7; otherwise, in the Setup Count
field, enter a new setup count.

6. Optionally, select one or both of the following to update the selected bookings with the
following information for the new room:

• Update Setup Type on Selected Bookings.

• Update Setup Count On Selected Bookings (use Minimum).

7. Optionally, if you change the booking status, select Update Reservation Status to have
the reservation-level status changed as well.

Make sure that this count is the maximum that you expect the new room to hold.
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8. Click Next.

The Change Room Wizard is refreshed with an Available tab, and if applicable, a
Conflicts tab. The Available tab is always the active tab.

• The Available tab contains two panes. The left pane lists all the rooms that meet
some or all of your event criteria. The right pane lists all the event dates that must be
fulfilled.

• The Conflicts tab lists all the rooms that are not available for the requested dates.
Optionally, you can open the Conflicts tab to view the list of rooms that were not
available for scheduling for the event as well as list of the events that are scheduled
for each room.

Figure 3-35: Change Rooms Wizard, Available tab

9. Select the new room that you are scheduling for the event.

10. Optionally, do one or both of the following; otherwise, go to Step 11.

• Click Room Info to open the Room Info dialog box and view information about the
room properties, setup type, features, and pricing.

• Click Building Hours to open the Building Hours dialog box which displays the
hours that the selected room/building is open on the reserved date.

The Conflicts tab is displayed only if there are any rooms that are not available for 
the requested dates based on your room search specifications. If no rooms are in 
conflict, then the tab is not displayed. 
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11. Click the Move button (>) to move the room to the Selected list.

The selected room is displayed in the Rooms list in the right pane of the Available tab for
every event date for which the room is available.

12. If all the event dates are fulfilled, click Finish; otherwise, repeat Step 9 through Step 11
until all the event dates are fulfilled, and then click Finish.

A message opens, asking you if you want to change any more rooms.

13. Click Yes to repeat this procedure for any other bookings for the selected reservation;
otherwise, click No close the message.

The Change Rooms Results window opens. This window displays a list of all the
selected bookings, whether the room change was successful or not.

Figure 3-36: Change Room Wizard, Results window

14. Click Close to close the Change Room Results window and return to the Navigator.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
report opens onscreen. If you close this report, you can manually run a Resource 
Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > 
Resource Inventory Conflict.
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To select a specific room

When you search for a specific room, you can search for a room within your facilities, or you 
can search for an override room, which is a room that is within your facilities but is not 
typically scheduled for events or it is outside of your facilities. If you specify an override 
room for an event, you must manually specify the location for the event.

1. Click the Search icon .

The Room Selector dialog box opens. This dialog box lists all the rooms in all the 
buildings to which you have been granted access.

Figure 3-37: Room Selector dialog box

2. Do one of the following:

• Open the Building dropdown list and select (all) buildings, or a specific building,
area, or view.

• Select the room, and then click OK.
. 

• If you are selecting a standard room or a combo room, go to Step 4; otherwise, if you
are selecting an override room, go to Step 3.

3. In the Location field, enter the location for/description of the override room.

If you are selecting an override room, make sure to select the appropriate room, 
for example, one named OVR.
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4. Click Next.

The Select Bookings window opens. This window displays all the bookings for the
selected reservation with a date greater than or equal to the current day’s date.

Figure 3-38: Change Room Wizard, Select Bookings window

5. Select the booking, or CTRL-click to select the multiple bookings that you are moving to
a new room, or click Select All to select all the displayed bookings in a single step, and
then click Finish.

The Change Rooms Results window opens. This window displays a list of all the
selected bookings, whether the room change was successful or not.

Figure 3-39: Change Rooms Results window

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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6. Click Close to close the Change Rooms Results window and return to the Navigator.

To edit miscellaneous booking information

Miscellaneous information that you can edit for multiple bookings includes the event name, 
the event type, the setup type, the setup count, and the attendance.

1. In the Bookings pane, click Tools > Change Miscellaneous Booking Information
Wizard.

The Change Miscellaneous Booking Information Wizard opens.

Figure 3-40: Change Miscellaneous Booking Information Wizard

2. Select the information that you are changing, enter the new value for the selected
information, and then click Next.

The Select Bookings window opens. This window displays all the bookings for the
selected reservation with a date greater than or equal to the current day’s date. See Figure
3-41 on page 126.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
report opens onscreen. If you close this report, you can manually run a Resource 
Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > 
Resource Inventory Conflict.
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Figure 3-41: Change Miscellaneous Booking Information Wizard, Select Bookings window

3. Select the booking, or CTRL-click to select the multiple bookings for which you are
changing the information, or click Select All to select all the displayed bookings in a
single step, and then click Finish.

A message opens, indicating that the changes were made successfully.

4. Click OK to close the message and return to the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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Moving Bookings to a Different Reservation

You use the Move Bookings reservation to move one or more bookings that do not have 
invoiced items from a selected reservation to an existing reservation or to an entirely new 
reservation. When you move a booking from a selected reservation, the booking and all its 
associated details are removed entirely from the selected reservation. 

To move bookings to a different reservation

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation from which you are moving the 
bookings.

3. In the Bookings pane, click Tools, and then click Move Bookings Wizard.

The Move Bookings Wizard opens. The option to move the bookings to an Existing 
Reservation is selected by default.

Figure 3-42: Move Bookings Wizard
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4. Do one of the following:

• In the Existing Reservation field, enter the reservation number for the existing
reservation to which you are moving the bookings.

• Click New Reservation.

5. Click Next.

The Select Bookings window opens. This window lists all the bookings for the selected
reservation that do not have invoiced items.

Figure 3-43: Move Bookings Wizard, Select Bookings window

6. Select the booking, or CTRL-click to select the multiple bookings that you are moving to
the new or existing reservation, or click Select All to select all the displayed bookings in
a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

7. Click OK to close the message and return to the Navigator.

Both the old reservation and the new or existing reservation are now displayed in the left
pane of the Navigator. If you moved the bookings to a new reservation, then the new
reservation that is created is assigned the next available reservation number in the
database. If you moved the bookings to an existing reservation and any of the moved
bookings are in conflict with bookings in the existing reservation, then this conflict is
indicated in the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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Copying Multiple Bookings in the Navigator

You use the Copy Bookings Wizard to copy one or more bookings to a new date or to a set of 
dates, either within the same reservation or to a new reservation. 

To copy multiple bookings in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation from which you are copying the 
bookings.

3. In the Bookings pane, click Tools, and then click Copy Bookings Wizard.

The Copy Bookings Wizard opens. Copy to Reservation No. is selected by default and 
the number for the reservation from which you are copying the bookings is displayed in 
the field.

Figure 3-44: Copy Bookings Wizard
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4. Do one of the following:

• To copy the bookings to an existing reservation, click the Search icon  to open 

the Open Navigator dialog box and search for the reservation. (See “Opening a 
reservation in the Navigator” on page 79.)

• To copy the bookings to a new reservation, click Copy to New Reservation.

5. Enter the information for the reservation to which you are copying the bookings.

6. Click Next.

The Select Bookings window opens. This window displays all the bookings for the
copied reservation, regardless of the date or status. See Figure 3-45 on page 131.

Information Description/Comments

New Start Date The date of the first booking for the new reservation.

New Status The status for the new reservation.

Reconfirm Date Enter if required for the new status that you selected.

Conflict Status You must enter a conflict status in the event that the new bookings are in 

conflict with the existing bookings.

Reconfirm Date Enter if required for the new conflict status that you selected.

• Copy Reminders

• Copy Comments

• Copy User Defined

Fields

• Copy Attachments

• Copy Drawings

Leave the appropriate options selected to copy the existing items as is, 

or clear the option for each item that is not to be copied to the new 

reservation.

Copy Booking Details Select the booking details that are being copied (CTRL-click to select 

multiple details) or to select all the details for copying, click Select All.

Note: By default, only active booking details are displayed. To show 

inactive booking details for copying, click Show Inactive.

Copy Inactive 

Resources/Rooms

Selected by default. Copies the inactive resource and/or rooms from the 

existing bookings to the new bookings. Clear this option if you do not 

want to copy the inactive resources and rooms.
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Figure 3-45: Copy Bookings Wizard, Select Bookings window

7. Select the booking, or CTRL-click to select the multiple bookings that you are recreating
in the existing or new reservation, or click Select All to select all the displayed bookings
in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.

The start date that you specified becomes the date of the first new booking. In 
addition, the copied bookings are scheduled according to the same pattern as the 
existing reservation. For example, if the existing reservation has three bookings 
and each booking was scheduled every seven days (12/14, 12/21, and 12/28), and 
the new start date for the first booking is 12/15, then the existing or new 
reservation has three bookings with dates of 12/15, 12/22, and 12/29.

When you copy multiple bookings, the bookings are simply copied and pasted as 
is—the bookings are not moved to different location. If you need to move a 
booking to a different location, see “To edit the rooms for bookings” on page 118.
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8. Click OK to close the message and return to the Navigator.

The reservation from which you copied the bookings and the reservation to which you
copied the bookings are displayed in the left pane of the Navigator. If you moved the
bookings to a new reservation, then the new reservation that is created is assigned the
next available reservation number in the database. If any of the new bookings are in
conflict with bookings in the existing reservation, this conflict is indicated in the
Navigator.
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Booking Details and Items Overview

Booking details, which are also called categories, are the services (catering, A/V equipment, 
and so on), notes, attendees, activities, or room charges that you can add to a booking. 
Booking detail items, also called resources, are the individual items (coffee, sandwich, 
projector, and so on) that you add to a booking detail. When you add a resource to a booking, 
for example, coffee, various selections might be available or required, for example, regular, 
decaf, Italian roast, breakfast blend, and so on. Depending on how your EMS administrator 
has configured your categories, a resource might require service order times to be specified. 

The booking details for a selected booking are displayed in the Booking Details pane (the 
lower right pane) of the Navigator. 

Figure 3-46: The Navigator window with a booking folder selected

Your EMS administrator can configure buildings and categories so that a 
particular category can be used only in a particular building or buildings. This 
means that when you are adding booking details to a reservation, some booking 
details (categories) might not be displayed as an option.

From this point on in the manual, categories that contain resources, but do not 
require service times are referred to as “resource categories.” Categories that 
contain resources and that require service times are referred to as “service order 
categories.” Categories that are used to manage food service are referred to as 
“catering categories.” Categories that are used to manage miscellaneous notes 
(setup notes), agenda items, attendees/visitors, or room charges are referred to as 
“non-resource categories.”
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If you select a booking detail folder that is for a Resource with Service Order category or a 
Catering category, then the service order number is displayed in the title bar of the Navigator. 

Figure 3-47: The Navigator window with a booking detail folder selected

When you select a booking detail folder in the left pane of the Navigator, the tabs that are 
displayed in the upper right pane of the Navigator depend on the type of booking detail that 
you selected.

• <Booking Detail> Summary tab—The Summary displays information about the selected
booking detail, including the event date, the event location, and the event status.

• Properties tab—The Properties tab also displays information about the booking detail,
including the date that it was added to the booking, who added the detail, and, if
applicable, the date that the detail was changed and who made the change.

If the booking detail has a price/charge associated with it, for example, a room charge, then 
the following two tabs are also displayed:

• Billing Reference Allocation tab—By default, the charge for a booking detail can be
allocated to a single billing reference number. On the Billing Reference Allocation tab,
you can allocate the charge for a reservation to multiple billing reference numbers by
percentage. See “To allocate charges to multiple billing reference numbers and/or PO
numbers” on page 83.

Your EMS administrator must enable the Use Billing Reference Allocation 
parameter for this tab to be displayed. See EMS System Parameters in the EMS 
Setup Guide.
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• PO Number Allocation tab—By default, the charge for a booking detail can be allocated
to a single purchase order (PO) number. On the PO Number Allocation tab, you can
allocate the charge for a reservation to multiple billing PO numbers by percentage. See
“To allocate charges to multiple billing reference numbers and/or PO numbers” on page
83.

If the selected booking detail requires a service order or catering category, then the following 
four tabs are also displayed:

• User Defined Fields tab—The User Defined Fields tab displays the additional fields that
store custom data for the booking detail. Your EMS administrator configures the types of
fields that are available as well as the allowed values for these fields. See “Working with
User Defined Fields in the Navigator” on page 181.

• Reminders tab—The Reminders tab displays any reminders that were created for the
selected booking detail. See “Working with Comments and Reminders in the Navigator”
on page 175.

• Comments tab—The Comments tab displays any comments that were made for the
selected booking detail. See “Working with Comments and Reminders in the Navigator”
on page 175.

• History tab—The History tab displays the history for the booking detail—the date that a
change was made to the detail, the ID of the user who made the change, the field that was
changed, the old field value, and the new field value.

Also, when you select a booking detail folder:

• Most of the tabs in the upper pane of the window have some of the basic features of an
EMS Browser window. You can change the width of the data columns, you can rearrange
the column order by dragging a column to a new location using the column heading, and
you can sort the data columns in either ascending or descending sort order. See “An EMS
Browser Window” on page 35.

• The booking detail items for the selected booking detail are displayed in the Items pane
(the lower right pane) of the Navigator. A green check mark appears in front of each
individual item that has been added to a booking. If the item is a package, then a green
checkmark is displayed not only in front of the package, but also, in front of each
individual item in the package. A red “x” is displayed in front of any booking detail and/
or booking detail item that has been deleted from a booking. The Items pane has all the
features of an EMS Browser window. See “An EMS Browser Window” on page 35.

If you select a booking details item in the left pane of the Navigator, then the entire right 
pane of the Navigator is refreshed with three tabs—a Properties tab that displays for the 
selected item, a Selections tab that displays the selections for the booking detail item (if 
applicable), and a History tab that details the history of the item.

Your EMS administrator must enable the Use PO Number Allocation parameter 
for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.
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Figure 3-48: The Navigator window with a booking detail item selected

Service order

A booking detail might include a service order. A service order is a request to use the 
resource for a specified time period as opposed to using the resource for the entire event. For 
example, an event that meets from 10:00 am to 2:00 pm, might have food service from 11:00 
am to noon. A service order consists of the service type, start and end times, and a unique, 
system-generated service order ID. For a catering booking detail, you can also indicate 
estimated count, guaranteed count, and actual count. You can create multiple service orders 
in the same booking. For example, you might have a number of catering services (breakfast, 
lunch, and afternoon refreshments) in the course of a one day training event. In this case, 
multiple folders are displayed under the booking folder on the left side of the Navigator 
window, with each folder representing a unique service order.

Figure 3-49: The Navigator window showing multiple service orders in the same booking
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If you reserve an item from a category that does not require a service order, your only 
choices are to reserve the item for the event time or for the entire reserved time.

Your EMS administrator might have configured a default service type for some or 
all of your system’s categories, but you can always select a different value. In 
addition, your EMS administrator might have configured states to manage your 
service order process. For detailed information about states, see Configuring 
Categories in the EMS Setup Guide.
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Adding Booking Details and Items to Individual 

Bookings 

The steps that you follow to add booking details and items to individual bookings depend on 
the category type. Also, you can add multiple occurrences of a booking detail to a booking 
only if the booking detail is a Resource with Service Order category or a Catering category. 
If the booking detail is not a Resource with Service Order category or a Catering category, 
and the detail is already added to a booking, you cannot add the detail again to the booking. 
You can, however, add more items to the booking detail.

To add booking details and items to individual bookings

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, expand the folder structure for the reservation until the 
appropriate booking folder is visible.

3. Select the booking folder, and then in the Booking Details pane, click New.

The Booking Details list opens.

Figure 3-50: Example of a Booking details List

4. Select the booking detail that you are adding to the booking.

A dialog box opens.
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5. Continue to one of the following:

• “To add a booking detail from a non-resource category” below.

• “To add a booking detail from a resource, service order, or catering category” on
page 144.

To add a booking detail from a non-resource category

A booking detail that is from a non-resource category can be setup notes, attendees, agenda 
(activities), or a room charge. 

To add setup notes

Figure 3-51: Setup Notes dialog box

1. Enter the sequence number for the setup notes.

2. Enter the appropriate notes or comments.

3. Optionally, if these notes are to be printed on internal reports only (the notes would be
excluded from external reports like a confirmation), then select Internal.

The sequence number determines the order in which the notes are displayed in the 
Items pane in the Navigator when the booking detail (Setup Notes) is selected for 
a booking.
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4. Click OK.

The Setup Notes dialog box closes. The booking detail and its items are displayed as
folders under the Booking folder in the Navigator window.

To add attendees

Figure 3-52: Attendees dialog box

1. Enter the information for the attendee. At a minimum, you must enter the attendee name.

2. If the attendee is a visitor (that is, not registered for the event), then select Visitor.

3. Click OK.

The Attendee dialog box remains open.

4. Repeat Step 1 through Step 3 until you have added all the needed attendees/visitors to
the booking.

After you add setup notes for the first time to a booking, Setup Notes is no longer 
an available option on the Booking Details dropdown list. To add more setup notes 
to the booking, select the Setup Notes folder for the booking or click a Setup Note 
in the Items pane, and then click New.
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5. Click Cancel.

The Attendees dialog box closes. The booking detail and its items are displayed as
folders under the Booking folder in the Navigator window.

To add an agenda (activities)

Figure 3-53: Agenda dialog box

1. Enter the start time, the end time, and a description for the agenda.

2. Optionally, in the Description field, enter a name or description for the agenda.

3. Optionally, if these notes are to be printed on internal reports only (the notes would be
excluded from external reports like a confirmation), then select Internal.

4. Click OK.

The Agenda dialog box remains open.

If you close the Attendees dialog box before you have added all the needed 
attendees/visitors to the booking, then Attendees is no longer an available option 
on the Booking Details dropdown list. To add more attendees/visitors to the 
booking, select the Attendees folder for the booking or click an attendee/visitor in 
the Items pane, and then click New.

The description can be a maximum of 50 characters, including spaces.
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5. Repeat Step 1 through Step 4 until you have added all the needed agendas.

6. Click Cancel.

The Agenda dialog box closes. The booking detail and its items are displayed as folders
under the Booking folder in the Navigator window.

To add a room charge

Figure 3-54: Room Charge dialog box

1. Enter the sequence number for the room charge.

2. Optionally, enter notes or comments about the room charge.

3. If needed, edit the quantity.

If you close the Agenda dialog box before you have added all the needed agendas/
activities to the booking, then Agenda is no longer an available option on the 
Booking Details dropdown list. To add more agenda/activities to the booking, 
select the Agenda folder for the booking or click an agenda in the Items pane, and 
then click New.

The sequence number determines the order in which the charges are displayed in 
the Items pane in the Navigator when the booking detail (Room Charge) is 
selected for a booking.



143

  The 

Navigator

4. Select the appropriate pricing method, and then enter any other additional information as
needed after you select a pricing method.

5. Optionally, enter a discount percent and/or a reservation discount.

6. Click OK.

The Room Charge dialog box closes. The booking detail and its items are displayed as
folders under the Booking folder in the Navigator window.

Pricing Method Additional Fields

Unit • Unit Price

Half Day/Full Day (Event Time) • Half Day Price

• Full Day Price

• Hours

Half Day/Full Day (Reserved Time) • Half Day Price

• Full Day Price

• Hours

Hourly (Event Time) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

Hourly (Reserved Time) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

Hourly (Specific) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

If you must add multiple room charges to a booking, then after you add charges 
for the first time to a booking, Room Charge is no longer an available option on 
the Booking Details dropdown list. To add more charges to the booking, select the 
Room Charge folder for the booking or click a room charge in the Items pane, and 
then click New.
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To add a booking detail from a resource, service order, or catering 

category

• If you select a service order or catering category, a Service Order dialog box opens with,
at a minimum, options for Service, Reviewed, Service Start Time, and End Time. If a
catering category is selected, additional fields for Estimated, Guaranteed and Actual
Counts are displayed. Go to Step 1.

Figure 3-55: Example of a Service Order dialog box for a catering category

• If you select a resource category, then a Resource Selection dialog box opens. The
Resources tab is the active tab. Go to Step 4.

Figure 3-56: Example of a Resource Selection dialog box, Resources tab

1. Select the service type.
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2. Enter the start time, and optionally, the end time, estimated count, guaranteed count, and
if applicable, select Reviewed and/or a state.

3. Click OK.

A Resource Selection dialog box. The Resources tab is the active tab.

4. Do one of the following

• To select one or more resources from the pre-configured list of resources, leave the
Resources tab open, and then go to Step 5.

• To add multiple resources to the booking in a single step, open the Packages tab, and
then go to Step 7.

5. Do one of the following on the Grouping dropdown list:

• Leave the default value of (all) as is to search for all items in all groupings.

• Select a specific grouping to search for only those items in the grouping. For
example, if the selected resource category is A/V Equipment, then available
groupings could include Computer, Phone, Video, and so on. To search only for the
available phones to add to a booking detail, select the Phones grouping.

6. Optionally, in the Filter field, enter a search string by which to filter your search.

7. In the Quantity field, leave the default value of 1.00; otherwise, enter a new value.

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 222.

Your search is limited to the exact order of the characters in the string, but the 
search string is not case-sensitive and it can appear anywhere in the search 
results. For example, a search string of co returns coffee service, conference 
phone, and mini-copier.

If you change the quantity for a resource package, then the quantity for each 
individual resource that makes up the package is also changed.
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8. Do one of the following:

• For the Resources tab—On the Items list, select the resource item, or CTRL-click to
select the multiple resource items that you are adding to the booking.

• For the Package tab—Select the package that contains the multiple resources that
you are adding to the booking.

9. Click Select.

• For items on the Resources tab—If your EMS administrator configured selections
for the resource, then either you might be required to make selections for the
resource, or you have the option to make selections for the resource (see Figure 3-57
below); otherwise, go to Step 10.

Figure 3-57: Example of a Resource Selections dialog box

• For packages on the Packages tab—The package is added to the booking. An entry
for the package as well as entry for each item in the package is displayed in the
Booking Detail Items pane of the Navigator.

10. Repeat Step 4 through Step 9 until you have added all the necessary booking detail items
for the selected booking.

Your EMS administrator might have configured an override resource (also known 
as an override description) so that you can book a resource that has not been 
configured in your EMS database. For example, the administrator might have 
configured an override resource named “Other.” If you select the “Other” 
resource, then a Description field is displayed on the Resource Selection dialog 
box. You must enter a description or name for the override resource before you 
can continue. EMS does not track availability of override resource items; however, 
EMS reports on override resource items just like any other resource item.
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11. Click Close.

The Resource Selection dialog box closes. The resource and its items are displayed as
folders under the Booking folder in the Navigator.

If you close the Resource Selection dialog box before you have added all the 
needed resource items to the booking, and the booking detail is not from a catering 
or service order category, then the booking detail is no longer an available option 
on the Booking Details dropdown list. To add more resource items to the booking, 
you can select the Booking Detail folder for the booking or you can click a 
booking detail item in the Items pane, and then click New.
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Adding Booking Details and Items to Multiple 

Bookings

You use the Add Booking Details Wizard to add booking details and items to multiple 
bookings in a single step. The steps that you follow depend on the category type. Also, you 
can add multiple occurrences of a booking detail to bookings only for service order and 
catering categories. If the booking detail is not a service order or catering category, and the 
detail is already added to the bookings, you cannot add the detail again to the bookings. (You 
can, however, add more items to the bookings. See “Adding Booking Detail Items to 
Multiple Bookings” on page 155.)

To add booking details and items to multiple bookings

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation to which you are adding the 
booking details and items.

3. In the Bookings pane, click Tools, and then click Add Booking Details Wizard. 

The Add Booking Details Wizard opens. See Figure 3-58 on page 149.

You can also manually copy booking details and items from one booking to 
another. To copy a booking detail, right-click on the booking detail that is being 
copied, and on the context menu that opens, click Copy. Right-click on the booking 
to which the booking detail is being copied, and on the context menu that opens, 
click Paste.
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Figure 3-58: Add Booking Details Wizard

4. Select the booking detail that you are adding to one or more of the bookings for the
selected reservation, and then continue to one of the following:

• “To add a booking detail from a non-resource category.”

• “To add a booking detail from a resource, service order, or catering category” on
page 151.

To add a booking detail from a non-resource category

If you select a booking detail of any type other than resource, service order, or catering, (for 
example, attendees or setup notes), then to add the detail to the bookings, you follow the 
same general steps:

1. Select the booking detail.

2. Click Next, and then enter the information for the booking detail.

• If you are adding setup notes, see “To add setup notes” on page 139.

• If you are adding attendees/visitors, see “To add attendees” on page 140.

• If you are adding an agenda or activities, see “To add an agenda (activities)” on page
141.

• If you are adding room charges, see “To add a room charge” on page 142.
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3. Click Next.

The Select Bookings window opens. This window displays all the bookings for the
selected reservation with a date greater than or equal to the current day’s date, and that
do not already have the selected booking detail added.

Figure 3-59: Add Booking Details Wizard, Select Bookings window

4. Select the booking, or CTRL-click to select the multiple bookings to which you are
adding the details, or click Select All to select all the displayed bookings in a single step,
and then click Finish.

A message opens asking you if you want to add more booking details.

5. Do one of the following:

• Click Yes to return to the Add Booking Details Wizard.

• Click No.

A message opens indicating that the changes were made successfully.

6. Click OK to close the message and return to the Navigator.

The booking detail and its items are displayed as folders under the Booking folder in the
Navigator window.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings. 
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To add a booking detail from a resource, service order, or catering 

category

• If you select a service order or catering category, then the Add Booking Details Wizard
is updated with, at a minimum, options for Service, Reviewed, Start Time, and End Time.
If you select a catering category, additional fields for Estimated, Guaranteed and Actual
Counts are displayed. In both cases, a State option might also be displayed. Go to Step 1.

Figure 3-60: Example of the Add Booking Details Wizard for a resource with a service order

• If you select a resource category, then two results are possible:

• The Add Booking Details Wizard is updated with options for Reviewed and/or State.
If applicable, select Reviewed and/or select a State, click Next to open the Add
Booking Details Wizard, and then go to Step 3.

• The Add Booking Details Wizard opens with two tabs—Resources and Packages.
The Resources tab is the active tab. This tab displays a pre-configured list from
which you can select one or more resources. Go to Step 3.

1. Select the service type.

2. Enter the start time, and optionally, the end time, estimated count, guaranteed count, and
select Reviewed and/or a state.

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 222.

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 222.
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3. Do one of the following:

• To choose one or more resources from the pre-configured list of resources, leave the
Resources tab open, and then go to Step 4.

• To add multiple resources to the booking in a single step, open the Packages tab, and
then go to Step 6.

Figure 3-61: Add Booking Details Wizard, Resources tab

4. Do one of the following on the Grouping dropdown list:

• Leave the default value of (all) as is to search for all items in all groupings.

• Select a specific grouping to search for only those items in the grouping. (For
example, if the selected resource category is A/V Equipment, then available
groupings could include Computer, Phone, Video, and so on. To search only for the
available phones to add to a booking detail, select the Phones grouping.)

5. Optionally, in the Filter field, enter a search string by which to filter your search.

6. In the Quantity field, leave the default value of 1.00; otherwise, enter a new value.

Your search is limited to the exact order of the characters in the string, but the 
string can is not case-sensitive and it can appear anywhere in the search results. 
For example, a search string of co returns coffee service, conference phone, and 
mini-copier.

If you change the quantity for a resource package, then the quantity for each 
individual resource that makes up the package is also changed.
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7. Do one of the following:

• For the Resources tab—On the Items list, select the resource item, or CTRL-click to
select the multiple resource items that you are adding to the booking.

• For the Package tab—Select the package that contains the multiple resources that
you are adding to the booking.

8. Click Next.

• For items on the Resources tab—If your EMS administrator configured selections
for the resource, then either you might be required to make selections for the
resource, or you have the option to make selections for the resource (see Figure 3-62
below); otherwise, go to Step 9.

Figure 3-62: Example of a Resource Selections dialog box

Your EMS administrator might have configured an override resource (also known 
as an override description) so that you can book a resource that has not been 
configured in your EMS database. For example, the administrator might have 
configured an override resource named “Other.” If you select the “Other” 
resource, then a Description field is displayed on the Resource Selection dialog 
box. You must enter a description or name for the override resource before you 
can continue. EMS does not track availability of override resource items; however, 
EMS reports on override resource items just like any other resource item.

Use the Move Up and Move Down options to order the selected items. To edit a 
selected item before you add it to multiple bookings, select the item, and then click 
Edit.
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• For packages on the Packages tab—The package is added to the booking. An entry
for the package as well as entry for each item in the package is displayed in the
Booking Detail Items pane of the Navigator.

9. Click Next.

The Select Bookings window opens. This window displays all the bookings for the
selected reservation with a date greater than or equal to the current day’s date, and that
do not already have the selected booking detail added.

Figure 3-63: Add Booking Details Wizard, Select Bookings window

10. Select the booking, or CTRL-click to select the multiple bookings to which you are
adding the details, or click Select All to select all the displayed bookings in a single step,
and then click Finish.

A message opens asking you if you want to add more booking details.

11. Do one of the following:

• Click Yes to return to the Add Booking Details Wizard.

• Click No.

A message opens indicating that the changes were made successfully.

12. Click OK to close the message and return to the Navigator.

The booking detail and its items are displayed as folders under the Booking folder in the
Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings. 
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Adding Booking Detail Items to Multiple 

Bookings

You use the Add Item Wizard to add booking detail items to multiple bookings for categories 
that are already added to the bookings. For example, you can use this Wizard to add food 
service items only if any of the bookings already has food service added as a booking detail. 

To add booking detail items to multiple bookings

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation to which you are adding the 
booking detail items.

3. In the Bookings pane, click Tools, and then click Add Item Wizard.

The Add Item Wizard opens. The first window in this Wizard, the Select Category 
window, displays only those categories that are already in use for any of the bookings in 
the reservation. See Figure 3-64 on page 156.

To add booking details and items for categories that are not already in use, see 
“Adding Booking Details and Items to Multiple Bookings” on page 148.



156

  The 

Navigator

Figure 3-64: Add Item Wizard

4. Select the category to which you want to add items.

5. Click Next.

The steps that you now must follow depend on the category type. See:

• “To add a booking detail from a non-resource category” on page 149.

• “To add a booking detail from a resource, service order, or catering category” on
page 151.
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Editing Booking Detail Items for Individual 

Bookings

After you have added booking details and items to bookings for a reservation, you can edit 
any non-invoiced item on an individual basis.

To edit booking detail items for individual bookings

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, expand the folder structure for the reservation until the 
appropriate booking detail items folder is visible, and then do the following:

• Select the booking detail folder that contains the items that you are editing.

• In the Items pane, select the item that you are editing.

3. Continue to one of the following:

• “To edit a booking detail item from a non-resource category” on page 158.

• “To edit a booking detail item from a resource, service order, or catering category”
on page 158.

To edit the pricing information for multiple non-invoiced items in a single 
booking, or for multiple non-invoiced items in multiple bookings, see “Editing 
Booking Detail Item Charges for Multiple Items” on page 161.

The item cannot be invoiced. If the item is invoiced, the Edit button is not 
available. To edit an invoiced item, you must first void the invoice. See “To void an 
invoice” on page 372. 
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To edit a booking detail item from a non-resource category

1. Click Edit.

The <Booking Detail> dialog box opens.

2. Edit the item as necessary, and then click OK to close the <Booking Detail> dialog box
and return to the Navigator.

For detailed information about editing a booking detail item from a non-resource
category, see:

• “To add setup notes” on page 139.

• “To add attendees” on page 140.

• “To add an agenda (activities)” on page 141.

• “To add a room charge” on page 142.

To edit a booking detail item from a resource, service order, or 

catering category

1. Click Edit.

The <Resource> dialog box opens. The Resource tab is the active tab. If selections are
available for the resource, then the dialog box also has a Selections tab.

Figure 3-65: <Resource> dialog box, Resource tab
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2. On the Resource tab, edit the information as necessary.

• If applicable, select a completely different item for the resource.

• The sequence number determines the order in which the items (for example, juice,
muffins, and so on) are displayed in the list in the Items pane in the Navigator when
the booking detail (for example, Catering) is selected for a booking. If needed, edit
the sequence number.

• The Time in Use indicates the time that the resource is to be available for the
booking. If needed, edit the Time in Use.

• If the notes are to be printed on internal reports only (the notes would be excluded
from external reports like a confirmation), then select Internal.

• If you edit the pricing method, then make sure to enter any other additional
information as needed.

For a definition of Event Time or Reserved Time, see “Event Timeline” on page 
44.. You can edit the Time In Use only if the item is not from a resource from a 
service order or catering category. (The Time in Use is applied at the category 
level for these types of resources).

Pricing Method Additional Fields

Unit • Unit Price

Half Day/Full Day (Event Time) • Half Day Price

• Full Day Price

• Hours

Half Day/Full Day (Reserved Time) • Half Day Price

• Full Day Price

• Hours

Half Day/Full Day (Service Time)

Note: Available only for a resource with a service order.

• Half Day Price

• Full Day Price

• Hours

Hourly (Event Time) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

Hourly (Reserved Time) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge
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• If applicable, open the Selection tab, and edit the resource selections as needed.

3. Click OK.

The <Resource> dialog box closes, and you return to the Navigator with the edited item
still selected in the Items pane.

Hourly (Service Time)

Note: Available only for a resource with a service order.

• Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

Hourly (Specific) • Hourly Price

• Minimum Charge

• Maximum Charge

If you need to edit counts and/or times for individual items in a resource, service 
order, or catering, category, see “Editing Count Information for a Booking” on 
page 163.

Pricing Method Additional Fields
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Editing Booking Detail Item Charges for Multiple 

Items

You can edit resource quantities and billing information (price, pricing method, and so on) 
for individual items (see “Editing Booking Detail Items for Individual Bookings” on page 
157) or you can use the Edit Charges tool to edit this information for multiple non-invoiced
items.

To edit booking detail item charges for multiple items

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In left pane of the Navigator, do one of the following:

• To edit all billable items in all the bookings for a reservation, select the reservation.

• To edit only the billable items in a selected booking, expand the reservation folder, 
and under the expanded reservation folder, select the booking that contains the items 
that you are editing.

3. In the Bookings/Booking Details pane, click Tools > Edit Charges.

The Edit Charges window opens. If you selected a reservation, then all non-invoiced 
billable items in all the bookings for the selected reservation are displayed in the 
window; otherwise, only the non-invoiced billable items for the selected booking are 
displayed. See Figure 3-66 on page 162.

To edit the billing information for invoiced items, you must first void the invoice. 
See “To void an invoice” on page 372.
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Figure 3-66: Edit Charges window

4. Optionally, on the Category dropdown list, select a category to narrow the list of items
that are displayed.

5. To edit the quantity, pricing method, price, or discount percentage for an item, click in
the appropriate field for the item and make the necessary edits.

6. Click Close.

Any resulting recalculations are carried out automatically. The Edit Charges window
closes and you return to the Navigator.
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Editing Count Information for a Booking

You use the Edit Counts tool to edit the count information for a booking, including the setup 
count and attendance count, the estimated count, guaranteed count, and actual count for a 
booking detail with a category type of catering, as well as the counts for non-invoiced 
booking detail items. You can edit the counts for all bookings in a reservation or for just a 
selected booking.

To edit count information for a booking

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, do one of the following:

• Select the reservation.

• Expand the reservation folder, and under the reservation folder, select a specific 
booking.

3. In the Bookings pane, click Tools, and then click Edit Counts.

The Edit Counts window opens. If you selected the reservation, then the Bookings (top) 
pane of the window lists all the bookings for the selected reservation; otherwise, the 
pane lists just the selected booking. See Figure 3-67 on page 164.

Much of the information that you can edit using the Edit Counts tool is also 
available for editing in other areas of the application. The purpose of this tool is 
simply to collate all the count information in a single location for editing.
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Figure 3-67: Edit Counts window

4. Select the booking for which you are editing the count information.

5. On the Category dropdown list, select the booking detail (category) for which you are
editing the count information.

The Booking Details (middle) pane is refreshed with the information for the selected
category. If the category is a resource with a service order, then the pane displays the
service type and the start and end times for the category. If the category is catering, then
the pane also displays the estimated count, guaranteed count, and actual count for the
booking detail.

6. In the Booking Details pane, select the booking detail that contains the items for which
you are editing the count information.

The Items (lower) pane is refreshed with a list of all the non-invoiced items for the
selected detail.

7. To Edit the count information for any booking detail or detail item, click in the
appropriate field and make the necessary edits.

8. To edit the count information for multiple bookings, repeat Step 4 through Step 7 as
needed for each booking.

9. Click Close.

The edits are made. You return to the Navigator.
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Applying a Reservation Discount

You use Apply Reservation Discount Wizard to apply a reservation discount to non-invoiced 
details in a booking. The discount is applied as a percentage of the total charge for an item 
and it is added to any existing discounts that have already been applied to the item.

To apply a reservation discount

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation to which you are applying the 
discount.

3. In the Bookings pane, click Tools, and then click Apply Reservation Discount. The 

Apply Reservation Discount window opens. All the bookings for the selected 
reservation with their categories that have not been invoiced are displayed.

Figure 3-68: Apply Reservation Discount window

To apply a discount to invoiced items, you must first void the invoice. See “To void 
an invoice” on page 372.
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4. Leave the Category set to the default value of (all), or optionally, to apply a discount to
all the items in a specific category, on the Category dropdown list, select a category.

The Apply Reservation Discount window is updated with the bookings that have the
selected category.

5. Enter the discount percentage.

6. Optionally, enter any notes that are relevant about the discount.

7. Select the booking, or CTRL-click to select the multiple bookings to which you are
applying the discount, or click Select All to select all the displayed bookings in a single
step, and then click Finish.

A message opens indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.

After you apply a reservation discount, you can view it and/or edit it when you are 
editing the reservation on the Billing Information tab of the Reservation window 
in the Navigator. See “Editing a Reservation in the Navigator” on page 98.
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Copying Booking Details Between Bookings

You use the Copy Booking Details Wizard to copy the details from one booking in a 
reservation and paste them into other bookings for the same reservation.

To copy booking details between bookings

1. Open the reservation to which you are copying the booking details in the Navigator. 
See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation from which you are copying the 
details.

3. In the Bookings pane, click Tools, and then click Copy Booking Details Wizard.

The Copy Booking Details Wizard opens. The first window in this Wizard, the Select 
Booking Details to Copy window, displays all the bookings for the selected reservation, 
regardless of date. By default, the Copy From Reservation No. field displays the 
reservation number for the selected reservation.

Figure 3-69: Copy Booking Details Wizard, Select Booking Details to Copy window
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4. Optionally, in the Copy From Reservation No. field, click the Search icon  to open 

the Open Navigator dialog box and search for and select a different reservation from 
which to copy the booking details.

The Select Booking Details to Copy window is refreshed with all the bookings details 
for the selected reservation.

5. Optionally, do one or both of the following:

• On the Category dropdown list, select a specific category of booking details to
display on the Select Booking Details to Copy window.

• Leave Copy Inactive Resources/Rooms selected to copy this information for the
bookings. Clear this option if you do not want to copy this information.

6. Select the booking, or CTRL-click to select the multiple bookings from which you are
copying the booking details, and then click Next.

The Select Bookings window opens. This window displays all the bookings with a date
greater than or equal to the current day’s date to which you can copy the booking details.

Figure 3-70: Copy Booking Details Wizard, Select Bookings window

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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7. Select the booking, or CTRL-click to select the multiple bookings to which you are
copying the booking details, or click Select All to select all the displayed bookings in a
single step, and then click Finish.

A message opens indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.
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Deleting Booking Detail Items from Multiple 

Bookings

If you add booking detail items to bookings for a reservation in error, or a booking item is no 
longer valid for one or more bookings, and the item has not been invoiced, you can use the 
Delete Item Wizard to delete the item. You can delete each item on an individual basis, or 
you can delete all the items for a booking detail in a single step. If you delete an item at the 
package level, then the deletion cascades down to all the items in the package. You can also 
delete individual items from a package.

To delete booking detail items from multiple bookings

1. Open the reservation from which you are deleting the booking detail items in the 
Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation from which you are deleting the 
booking detail items.

3. In the Bookings pane, click Tools, and then click Delete Item Wizard.

The Delete Item Wizard opens. The first window that opens is the Select Categories 
window.

Figure 3-71: Delete Item Wizard, Select Categories window
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4. Select the category (booking detail) from which you are deleting the items, and then
click Next.

The Select Categories/Items window opens.

Figure 3-72: Delete Item Wizard, Select Categories/Items window

5. Optionally, do one or both of the following:

• Select a specific grouping to limit the display to only those items in the grouping.

• Select Delete Empty Categories to also delete a category after the last item is deleted
from the category.

6. On the Resources list, select the resource item, or CTRL-click to select the multiple
resource items that you are deleting.

7. Click Next.

The Select Bookings window opens. This page lists all the bookings for the selected
reservation with a date greater than or equal to the current day’s date and that have the
resource items that were selected for deletion. See Figure 3-73 on page 172.
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Figure 3-73: Delete Item Wizard, Select Bookings window

8. Select the booking, or CTRL-click to select the multiple bookings from which you are
deleting the resource items, or click Select All to select all the displayed bookings in a
single step, and then click Finish.

A message opens indicating that the changes were made successfully.

9. Click OK to close the message and return to the Navigator.
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Deleting Booking Details from Multiple Bookings

You use the Delete Booking Details Wizard to delete one or more booking details that do not 
have invoiced items from multiple bookings in a single step. When you delete a booking 
detail from a booking, any items that have been added for the detail are also deleted.

To delete booking details from multiple bookings

1. Open the reservation from which you are deleting the booking details in the Navigator. 
See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation from which you are deleting the 
booking details.

3. In the Bookings pane, click Tools, and then click Delete Booking Details Wizard. The 

Delete Booking Details Wizard opens. The first window in this Wizard, the Select 
Categories window, displays all the categories (booking details) that are already in use 
for any of the bookings in the selected reservation.

Figure 3-74: Delete Booking Details Wizard, Select Categories window
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4. Select the category, or CTRL-click to select the multiple categories that you are deleting
from the reservation, or click Select All to select all categories in a single step.

5. Click Next.

The Select Booking Details window opens. This page lists all the bookings for the
selected reservation with a date greater than or equal to the current day’s date that have
the categories (booking details) that were selected for deletion but do not have any
invoiced items.

Figure 3-75: Delete Booking Details Wizard, Select Booking Details window

6. Select the booking, or CTRL-click to select the multiple bookings from which you are
deleting the categories, or click Select All to select all the displayed bookings in a single
step, and then click Finish.

A message opens indicating that the changes were made successfully.

7. Click OK to close the message and return to the Navigator.
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Working with Comments and Reminders in the 

Navigator

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a 
booking detail that is a service order. A reminder is a comment that has a due date associated 
with it, and if it is attached to a reservation, booking, group, or service order, then it is called 
an attached reminder. You can select from a pre-configured list of comment types and 
reminder types, or you can create a user-specified comment type or reminder type if none of 
the pre-configured types meets your working needs. You can add comments/reminders 
directly to a reservation, booking, or service order in the Navigator. You can also edit a 
comment/reminder, delete a comment/reminder, and view the history for a comment/
reminder.

To work with a comment or reminder in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation, booking, or service order, and 
then in the top right pane of the Navigator, open the Comments tab.

3. Continue to one of the following:

• “To add a comment” on page 176.

• “To edit a comment” on page 177.

• “To delete a comment” on page 177.

• “To view the history for a comment” on page 177.

A reminder that you add to a reservation, booking, group, or booking details is 
called an attached reminder. To work with unattached reminders, see “Reminders 
Tab” in “Overview of the EMS Dashboard and Dashboard Options” on page 229.

The following procedures are written from the perspective of working with a single 
comment. By analogy, you can follow these procedures to work with a single 
attached reminder. To add multiple comments and/or reminders to a reservation in 
a single step, see “Adding Multiple Comments and Reminders to a Reservation” 
on page 179.
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To add a comment

1. Click New.

The Comment dialog box opens.

Figure 3-76: Comment dialog box

2. On the Comment Type dropdown list, select the type of comment that you are adding;
otherwise, if none of the pre-configured comment types meets your working needs,
select (user-specified comment), and then in the Description field, enter a description for
the comment type.

3. In the Notes field, enter the comment.

4. Optionally, do one or both of the following:

• To alert any EMS user that opens this reservation, booking, or service order that this
comment has been added, select Alert Users.

• Click Spelling to spell check the comment before you add it to the reservation,
booking, or service order.

5. Click OK.

The Comment dialog box closes. The comment is added to the reservation, booking, or
service order. The Comments tab remains open.
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To edit a comment

1. Select the comment that you are editing, and then click Edit.

The Comment dialog box opens, populated with the information for the selected
comment.

2. Edit the comment as needed, including its type, description (if applicable), its Notes,
and/or its Alert User status.

3. Optionally, click Spelling to spell check the comment before you save the edited
comment.

4. Click OK.

The Comment dialog box closes. The edited comment is saved for the reservation,
booking, or service order. The Comments tab remains open.

To delete a comment

1. Select the comment that is you are deleting, and then click Delete.

A message opens asking you if it is OK to delete the selected comment.

2. Click Yes.

The selected comment is deleted from the reservation, booking, or service order. The
Comments tab remains open.

To view the history for a comment

1. Select the comment for which you viewing the history, and then click Edit.

The Comment dialog box opens populated with the information for the selected
comment.

2. Open the History tab.

The tab displays the following information for each change that was made to the
comment—the date of the change, the login ID for the user who made the change, and
the old and new values for the comment. See Figure 3-77 on page 178.
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Figure 3-77: Comment dialog box, History tab

3. Click OK.

The Comment dialog box closes. The Comments tab remains open.
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Adding Multiple Comments and Reminders to a 

Reservation

When you add a comment or a reminder to a reservation from the Comments tab or 
Reminders tab, respectively, then you can add only a single comment or reminder at a time. 
To add multiple comments or reminders to a reservation in a single step, you must use an 
option on the context menu for reservations in the Navigator. 

To add multiple comments and reminders to a reservation

1. Open the reservation to which you are adding multiple comments and/or reminders in 
the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  "Search Tools,” on page 195.

2. In the left pane of the Navigator, right-click the reservation, and on the context menu that 
opens, click Add Reminders and Comments.

The Add Reminders and Comments window opens. This window lists all the available 
pre-configured reminder and comment types in the Available list. See Figure 3-78 on 
page 180.

When you add multiple reminders and comments to a reservation, your only 
option is to select from a pre-configured list of comment types and reminder types. 
To add a user-specified comment type or reminder type, you must add each 
comment or reminder individually. See “Working with Comments and Reminders 
in the Navigator” on page 175.
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Figure 3-78: Add Reminders and Comments window

3. In the Available list, select the comment/reminder type, or CTRL-click to select the
multiple comment/reminder types that you are adding to the reservation, and then click
the Move ( >) button to move the selected comment/reminder types to the Selected list.

4. To enter the text for the selected comment/reminder types, select a comment/reminder
type in the Selected list, and then click Edit.

A Notes dialog box opens in which you can enter the text for the selected comment/
reminder type.

5. After you have entered the text for a selected comment/reminder type, click OK to close
the Notes dialog box and return to the Add Reminders and Comments window.

6. Repeat Step 4 and Step 5 for each selected comment/reminder type.

7. Click Finish.

A message opens indicating that the comment/reminder types were added successfully.

8. Click OK to close the message and return to the Navigator.
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Working with User Defined Fields in the 

Navigator

The User Defined Fields tab displays the additional fields that store custom data for a 
reservation, booking, or a booking detail that is a service order. Your EMS administrator 
configures the types of fields that are available as well as the allowed values for these fields. 
You can add new user defined fields to a reservation or booking detail, edit the value for a 
user defined field, and delete user defined fields. You can also view the history for a user 
defined field.

To work with user-defined fields in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation or booking detail (remember, the 
booking detail must be a service order), and then in the top right pane of the Navigator, 
open the User Defined Fields tab.

3. Continue to one of the following:

• “To add a user-defined field” on page 182.

• “To edit a user-defined field” on page 182.

• “To delete a user-defined field” on page 182.

• “To the view history for a user-defined field” on page 183.
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To add a user-defined field 

1. Click New.

The User Defined Field dialog box opens.

Figure 3-79: User Defined Field dialog box

2. On the Field dropdown list, select the type of field that you are adding.

3. On the Value dropdown list, select an allowed value for the field.

4. Click OK.

The User Defined Field dialog box closes. The field is added to the reservation and the
User Defined Fields tab remains open.

To edit a user-defined field

1. Select the user defined field that you are editing, and then click Edit.

The User Defined Field dialog box opens. The field type and field value are displayed
for the selected user defined field.

2. Edit the field type, field value, or both as needed.

3. Click OK.

The User Defined Field dialog box closes. The edited field is saved for the reservation or
booking detail and the User Defined Fields tab remains open.

To delete a user-defined field

1. Select the user-defined field that you are deleting, and then click Delete.

A message opens asking you if it is OK to delete the selected field.

2. Click Yes.

The selected field is deleted. The User Defined Fields tab remains open.
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To the view history for a user-defined field

1. Select the user-defined field for which you are viewing the history, and then click Edit.

The User Defined Field dialog box opens. The field type and field value are displayed
for the selected user defined field.

2. Open the History tab.

The tab displays the following information for each change that was made to the field—
the date of the change, the login ID for the user who made the change, and the old and
new values for the field.

Figure 3-80: User Defined Field dialog box, History tab

3. Click OK.

The User Defined Field dialog box closes. The User Defined Fields tab remains open.

You can use the scroll feature at the bottom of the dialog box to view all the history 
for a selected change, or you can click a change, and then click View.
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Working with Attachments in the Navigator

The term attachment is used to describe any file that you can add to or store on a reservation 
or booking. (Unlike a drawing, which is simply referenced, an attachment is actually stored 
in the EMS database with the reservation or booking record.) You can also delete an 
attachment from a reservation or booking, and view and edit an attachment.

To work with attachments in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation or expand the folder structure for 
the reservation until the appropriate booking folder is visible, and then select the 
booking folder.

3. In the top right pane of the Navigator, open the Attachments tab.

4. Continue to one of the following:

• “To add an attachment to a reservation or booking” on page 185.

• “To edit an attachment for a reservation or booking” on page 186.

• “To delete an attachment from a reservation or booking” on page 186.

• “To view an attachment for a reservation or booking” on page 187.

You can also add an attachment to a group record. See “Configuring Additional 
Information for a Group” on page 263.
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To add an attachment to a reservation or booking

1. Click New.

The Attachment dialog box opens.

Figure 3-81: Attachment dialog box

2. In the Description field, enter a name or description for the attachment.

3. On the Type dropdown list, select the attachment type.

4. Click the Search icon  to open the Find Attachment dialog box, and then browse to

and select the attachment.

The Find Attachment dialog box closes. The file name for the attachment is displayed in
the Attachment field.

5. Optionally, do one or more of the following as needed:

• If you left the Description field blank, then the name of the attached file is used by
default for the file description, and you can edit this if needed.

• If the attachment is to be displayed in VEMS when it is attached to a reservation or
booking, then select Display on Web.

• If a VEMS user is to be able to delete this attachment when it is attached to a
reservation or booking, then select Allow Web Delete.

• Enter any pertinent notes for the attachment.

• Click Spelling to spell check the description before you attach the drawing to the
booking.

The description can be a maximum of 50 characters, including spaces. If you 
leave this field blank, then the Description field is populated with the name of the 
file after you attach it to a reservation or booking.
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6. Click OK.

The Attachment dialog box closes. The attachment is added to the booking. The
Attachments tab remains open.

To edit an attachment for a reservation or booking

1. Select the attachment that you are editing, and then click Edit.

The Attachment dialog box opens populated with the information for the selected
attachment.

2. Do any of the following as needed:

• Edit the description.

• Click the Search icon  to open the Find Attachment dialog box and scroll to and 

select a different attachment.

• Edit the notes and/or web options.

• Optionally, click Spelling to spell check the description.

3. Click OK.

The Attachment dialog box closes. The Attachments tab remains open.

To delete an attachment from a reservation or booking

1. Select the drawing or CTRL-click to select the multiple attachments that you are deleting
from the reservation or booking.

2. Click Delete.

A message opens asking you if it is OK to delete the selected attachments.

3. Click Yes.

The selected attachments are deleted from the reservation or booking. The Attachments
tab remains open.

The description can be a maximum of 50 characters, including spaces.
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To view an attachment for a reservation or booking

1. Select the attachment that you are viewing, and then click Open.

The file opens in the appropriate application.

2. Close the application after viewing the attachment, or if the application allows it, edit the
attachment as needed, and then save the attachment.

The next time you open the attachment in the Navigator, you can see the changes that
you made.

Your computer must have the appropriate application installed to view 
attachments of a specific type. For example, to open a .docx that is attached to a 
booking, Microsoft Word must be installed on your computer. 
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Working with Drawings in the Navigator

The term drawing is used to describe a file (text-based or image file) that you can add to a 
booking. The file can stored on your organization’s network, or you can create a drawing “on 
the fly,” in the default drawing program on your EMS client, and then add it to a booking. 
Typically, a drawing is a setup diagram of the booking room. You can also detach a drawing 
from a booking, and view and edit a drawing. 

To work with drawings in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, expand the folder structure for the reservation until the 
appropriate booking folder is visible, and then select the booking.

3. In the right pane of the Navigator, open the Drawings tab.

4. Continue to one of the following:

• “To attach a stored drawing to a booking” on page 189.

• “To create a drawing “on the fly” and attach it to a booking” on page 190.

• “To edit a drawing for a booking” on page 190.

• “To detach a drawing from a booking” on page 190.

• “To view a drawing for a booking” on page 191.
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To attach a stored drawing to a booking 

1. Click New > Attach.

The Drawing dialog box opens.

Figure 3-82: Drawing dialog box

2. In the Description field, enter a name or description for the drawing.

3. Click the Search icon  to open the Find Drawing dialog box, and then browse to and 

select the drawing.

The Find Drawing dialog box closes. The file name for the drawing is displayed in the 
Drawing field.

4. Optionally, do one or both of the following:

• If you left the Description field blank, then the name of the attached file is used by
default for the file description, and you can edit this if needed.

• Click Spelling to spell check the description before you attach the drawing to the
booking.

5. Click OK.

The Drawing dialog box closes. The drawing is attached to the booking. The Drawings
tab remains open.

The description can be a maximum of 50 characters, including spaces. If you 
leave this field blank, then the Description field is populated with the name of the 
file after you attach it to the booking.
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To create a drawing “on the fly” and attach it to a booking

1. Click New > Create.

The application that you have selected as your default drawing application for your EMS
client opens, for example, Microsoft Paint.

2. Create and save the drawing.

3. Continue to “To attach a stored drawing to a booking” on page 189.

To detach a drawing from a booking

1. Select the drawing, or CTRL-click to select the multiple drawings that you are detaching
from the booking.

2. Click Detach.

A message opens asking you if it is OK to detach the selected drawings.

3. Click Yes.

The selected drawings are detached from the booking. The Drawings tab remains open.

To edit a drawing for a booking

1. Select the drawing that you are editing, and then click Edit.

The Drawing dialog box opens.

2. Do one or both of the following as needed:

• Edit the description.

• Click the Search icon  to open the Find Drawing dialog box and scroll to and 

select a different drawing.

3. Optionally, click Spelling to spell check the description before you attach the drawing to
the booking.

4. Click OK.

The Drawing dialog box closes. The Drawing tab remains open.

You specify your default drawing application in your user preferences. See 
“Setting User Preferences and Default Values” on page 403.

Remember, the description can be a maximum of 50 characters, including spaces.
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To view a drawing for a booking

1. Select the drawing that you are opening, and then click Open.

The file opens in the appropriate application.

2. Close the application after viewing the drawing, or if the application allows it, edit the
drawing as needed, and then save the drawing.

The next time you open the drawing in the Navigator, you can see the changes that you
made.

Your computer must have the appropriate application installed to view drawings 
of a specific type. For example, to open a .vsd file that is attached to a booking, 
Microsoft Visio must be installed on your computer. 
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Running the Resource Utility Conflicts Tool

Resource conflicts can occur if bookings for the same date and time require the same 
resource, and there are insufficient quantities of the resource to accommodate all the 
bookings. When you reserve any resource for which the inventory is maintained (for 
example, equipment, personnel, and so on), EMS checks the available quantity and 
automatically notifies you in an Inventory Conflict message if there is an insufficient 
quantity of the selected resource to accommodate your event. 

Figure 3-83: Inventory Conflict message

You have the option of dismissing this message and over-committing the resource; however, 
although you are aware that the resource has been over-committed, other users will not 
necessarily be aware of this fact. If you need to confirm that an over-commitment of 
resources does not exist for a single reservation, then you can manually run the Resource 
Inventory Conflicts tool from the Navigator to generate an onscreen report that lists the 
resources that are in conflict by booking for the reservation.

To run the Resource Utility Conflicts tool

1. Open the reservation in the Navigator. See

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the Bookings pane, click Tools, and then click Resource Inventory Conflicts.

The Resource Inventory Conflicts report opens onscreen. The report lists the resources 
that are in conflict by booking. See Figure 3-84 on page 193.

3. Optionally, edit the booking details for the involved bookings to resolve the conflict.

To confirm that an over-commitment of resources does not exist across multiple 
reservations, run any of the various resource usage reports that are available. See 
“Statistics reports” in “Generating an EMS Report” on page 321.
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Figure 3-84: Resource Inventory Conflicts report

The onscreen preview of the Resource Inventory Conflict report contains options 
for printing a hard copy of the report, for emailing the report, and so on.
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EMS has a variety of options available to you for searching for reservations, bookings, 
service orders, resources, and queries. These options include the Browser, the Web 
Reservation tool, the Calendar, the Navigator, a Group, the Web Request tool, the Resource 
Calendar, and the Service Order Management browser.

This chapter covers the following topics:

• “Searching with the Browser or with the Web Reservation Tool” on page 197.

• “Searching with the Calendar” on page 206.

• “Searching with the Resource Calendar” on page 215.

• “Searching with the Service Order Management Browser” on page 222.

Remember, a fast way to view and edit bookings is through the Reservation Book. 
See “Viewing and Editing Reservations in the Reservation Book” on page 62.

For information about searching with the Navigator, see “The Navigator,” 
on page 77. For information about searching for reservations by group, see 
“Working with Reservations for a Group” on page 295. For information 
about searching with the Web Request tool, see “EMS Dashboard,” on page 
227.
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Searching with the Browser or with the Web 

Reservation Tool

You can use the Browser to search for reservations, bookings, service orders, resources, web 
reservations, and queries. The results are displayed in a list view. When you carry out a 
search in the Browser, you can carry out a basic search or an advanced search. A basic 
search is based on the basic information that you specify for a reservation when you first 
create it, such as the starting date, the end date, the group for which the event was scheduled, 
the group contact name, and so on. An advanced search is a field level search that is carried 
out at the reservation level, the booking level, the booking detail level, the booking detail 
item level, the service order level, or any combination of these. For example, in an advanced 
search, you can specify criteria as granular as who added a specific booking detail item. 

To carry out a search in the Browser

1. On the EMS toolbar, click the Browser icon .

By default, the first time that the Browser window opens, the Filter tab is set to a basic
search; otherwise, the Filter tab is set to the search type (Basic or Advanced) that you
last carried out. See Figure 4-1 on page 198.

A web reservation is any reservation that a user has submitted through VEMS. The 
Web Reservation searching tool is identical to the Browser searching tool with one 
exception—when the Browser opens for the first time, the Browse for function is 
set to Reservations whereas the Web Reservation tool is set to Web Reservations. 
As a result, although this section is written from the perspective of using the 
Browser, all the information can be applied when using the Web Reservation 
searching tool. To open the Web Reservation searching took, click the Web 

Reservations icon  on the EMS toolbar. 
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Figure 4-1:  Browser window, Basic search options

2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and
then continue to one of the following:

• “To carry out a basic search in the Browser” below.

• “To carry out an advanced search in the Browser” on page 201.

To carry out a basic search in the Browser

1. On the Browse For dropdown list, select the item for which to search.

2. Enter the search criteria.

Field Description

• Starting Time

• Ending Time

Both are optional. 

Use Specific Times Available only if the Starting Date is the same as the Ending Date.

Include Cancelled By default, search results are not set to show canceled reservations. 

Select this option to search for canceled reservations as well.

Group If the pre-defined list of groups is too extensive to scroll, then click the 

Search icon  to open the Groups window and search for a specific 

group. See “To search for a group and/or contact” on page 255.

• 1st Contact

• Reservation Event

Name

Enter a search string by which to filter your search. The string is not 

case-sensitive, but your search is limited to the exact order of characters in 

the string and it must begin with the information for which you are 

searching. For example, a search string of ed returns Ed, Edward, Eddie, 

and so on, but not Ted or Fred.
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3. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, When Filtering By Specific
Room, and Show Service Order Items.

4. Click Get Data or Refresh.

The search results are displayed on the Results tab.

Figure 4-2:  Browser window, Results tab

Building The default value is set to (all). You can leave this value as is, or you can 

select a specific building, area, or view.

Building/Room • If you select a specific building, then (all) rooms in the building are

selected by default. You can select a specific room in the building.

• If you select an area, then you can select a specific building that is

contained in the area.

• If you select a view, then Room is left blank; however, you can select a

specific room to search.

Category The default value is set to (all). You can leave this value as is, or you can 

select a specific category (booking detail).

Resource Available only if you select a category that is a resource or service order. 

The default value is set to (all). You can leave this value as is, or you can 

select a specific resource item.

Booking Status The default value is set to (all). You can leave this value as is, or you can 

select a specific booking status.

Field Description
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5. Optionally, do one or more of the following:

• The Results tab is an EMS Browser window. See “An EMS Browser Window” on
page 35 for all the features that are available for this tab.

• Double-click an event entry on the Results tab to open the event in the Navigator.

• Click Print to print the search results.

• In the Reservation view, select a search result entry, and then click Email to open a
pre-addressed SMTP email to the group that is associated with the selected
reservation. Complete and send the email as you would normally. See “Sending
Email from EMS” on page 414.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• In the Bookings view, click Outlook to download the search results to your personal
calendar.

• In the Service Orders view, to mark a service order as Reviewed, select the service
order, or CTRL-click to select multiple service orders, and then click Review >
Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click
Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select
the appropriate booking in the Results list, or CTRL-click to select multiple service
orders of the same category, and then click Change State. A Change State dialog box
opens. The dialog box lists all the available states for the service order. Select the
new state for the service order on the State dropdown list.

• In the Browse For field, select a different item to search for. The Results tab is
refreshed with the search results based on the item that you selected and the search
criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position, width, and so on)
remain in effect for any other searches that you carry out. To reset the columns to their
default values, see “Resetting Column Settings” on page 408.

Your EMS administrator must set a system parameter to enable this function. If 
this function is not available, contact your EMS administrator for assistance.

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 222.
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To carry out an advanced search in the Browser

Figure 4-3:  Browser window, Advanced search options

1. On the Browse For dropdown list, select the item for which to search.

2. Optionally, do one or more or all of the following:

• Enter a Starting Date, an Ending Date, or both.

• If the Starting Date and the Ending Date are the same, select Use Specific Times and
enter specific time periods to search.

• Click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, When Filtering By
Specific Room, and Show Service Order Items.

Use Specific Times is available only if the Starting Date is the same as the Ending 
Date.
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3. For each field level option by which to carry out the search:

• Select the field level option, and then click the Move button (>).

• When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

Figure 4-4:  Viewing a selected field option in the Filter Summary list

To filter the list of available fields, in the Field Search field, enter a search string. 
Your search is limited to the exact order of the characters in the string, but the 
search string is not case-sensitive and it can appear anywhere in the search 
results. For example, a search string of add returns Added by, Date Added, and 
Group Address Line 1. The list of fields that meet your search criteria is 
dynamically updated as you enter your search criteria.

If you have specific fields and/or values by which you always want to carry out a 
search, then you can set up these fields to be your Favorite fields. See “To set up 
favorite fields for a Browser search” on page 205.

To view a selected field option in its entirety in the Filter Summary list, rest the 
mouse pointer on the entry. A tooltip showing the complete field option 
information opens. 
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4. Click Get Data or Refresh.

The search results are displayed on the Results tab.

Figure 4-5:  Browser window, Results tab

5. Optionally, do one or more of the following:

• The Results tab is an EMS Browser window. See “An EMS Browser Window” on
page 35 for all the features that are available for this tab.

• Double-click an event entry on the Results tab to open the event in the Navigator.

• Click Print to print the search results.

• In the Reservation view, select a search result entry, and then click Email to open a
pre-addressed SMTP email to the group that is associated with the selected
reservation. Complete and send the email as you would normally. See “Sending
Email from EMS” on page 414.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• In the Bookings view, click Outlook to download the search results to your personal
calendar.

Your EMS administrator must set a system parameter to enable this function. If 
this function is not available, contact your EMS administrator for assistance.
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• In the Service Orders view, to mark a service order as Reviewed, select the service
order, or CTRL-click to select multiple service orders, and then click Review >
Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click
Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select
the appropriate booking in the Results list, or CTRL-click to select multiple service
orders of the same category, and then click Change State. A Change State dialog box
opens. The dialog box lists all the available states for the service order. Select the
new state for the service order on the State dropdown list.

• In the Browse For field, select a different item to search for. The Results tab is
refreshed with the search results based on the item that you selected and the search
criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position, width, and so on)
remain in effect for any other searches that you carry out. To reset the columns to their
default values, see “Resetting Column Settings” on page 408.

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 222.
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To set up favorite fields for a Browser search

If you have specific fields and/or values by which you always want to carry out a Browser 
search, you do not have to filter the list of fields on the All Fields tab for every search. 
Instead, you can set up each of these fields to be a favorite field with a specific value or limit 
if needed. 

1. Open the Browser, and make sure that the Advanced search features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields
tab, and then click Add to Favorites.

The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on
the Filter dialog box.

The next time that you carry out a search, you can simply open the Favorite Fields tab or
the Saved Values tab to carry out a search based on your customized list of search fields.
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Searching with the Calendar

You use the Calendar to search for reservations, bookings, and service orders in your EMS 
database. The results are displayed in a calendar view. When you carry out a search in the 
Calendar, you can carry out a basic search or an advanced search. A basic search is based on 
the basic information that you specify for a reservation when you first create it, such as the 
starting time, the end time, the group for which the event was scheduled, the group contact 
name, and so on. An advanced search is a field level search that is carried out at the 
reservation level, the booking level, the booking detail level, the booking detail item level, or 
any combination of these. For example, in an advanced search, you can specify criteria as 
granular as who added a specific booking detail item. 

To carry out a search in the Calendar

1. On the EMS toolbar, click the Calendar icon .

The Calendar window opens. By default, the first time that the Calendar window opens,
the Results tab is the active tab and it is set to the current month and year. If you never
edit the Get Data when Calendar Opens option (under Options), then the Results tab is
always the active tab when the Calendar window opens; otherwise, the Filter tab is the
active tab.

Figure 4-6:  Calendar window, Results tab
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2. If needed, click Filter to open the Filter tab.

3. Click the Basic/Advanced toggle to select the type of search that you want to carry out
and then continue to one of the following:

• “To carry out a basic search in the Calendar.”

• “To carry out an advanced search in the Calendar” on page 211.

To carry out a basic search in the Calendar

Figure 4-7:  Calendar window, Filter tab with Basic search options

1. On the Browse For dropdown list, select the item for which to search.

2. Enter the search criteria.

The first time that the Filter tab opens, it is set by default to a Basic search; 
otherwise, the Filter tab displays the search type (Basic or Advanced) that you last 
carried out. 

Field Description

Month

Year

The default value is the current month and year, but you can change 

one or both of these values if needed.

Include Cancelled By default, search results are not set to show canceled bookings. Select 

this option if you want to search for canceled bookings as well.
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3. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, Get Data when Calendar
Opens, When Filtering By Specific Room, and Change Calendar Day Count Color.

4. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The number of
bookings that meet the search criteria is indicated on the dates on which the events occur.
The current day’s date is outlined in black. See Figure 4-8 on page 209.

Group If the pre-defined list of groups is too extensive to scroll, then click the 

Search icon  to open the Groups window and search for a specific 

group. See “To search for a group and/or contact” on page 255.

• 1st Contact

• Reservation Event

Name

Enter a search string by which to filter your search. The search is not 

case-sensitive, but your search is limited to the exact order of 

characters in the string and it must begin with the information for which 

you are searching. For example, a search string of ed returns include 

Ed, Edward, Eddie, and so on, but not Ted or Fred.

Building The default value is set to (all). You can leave this value as is, or you 

can select a specific building, area, or view.

Building/Room • If you select a specific building, then (all) rooms in the building are

selected by default. You can select a specific room in the building.

• If you select an area, then you can select a specific building that is

contained in the area.

• If you select a view, then Room is left blank; however, you can select

a specific room to search.

Category The default value is set to (all). You can leave this value as is, or you 

can select a specific category (booking detail).

Resource Available only if you select a category that is a resource or service order. 

The default value is set to (all). You can leave this value as is, or you 

can select a specific resource item.

Booking Status The default value is set to (all). You can leave this value as is, or you 

can select a specific booking status.

By default, the number of bookings is indicated in red unless you selected a 
different color for the Change Calendar Day Count Color. Any color that you pick 
here is carried over to the same option for the Resource Calendar.

Field Description
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Figure 4-8:  Calendar window, Results tab

5. Optionally, do one or more of the following:

• Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-9:  Calendar window, Results tab with list of events for selected dates
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• The lower pane on the Results tab is an EMS Browser window. See “An EMS
Browser Window” on page 35 for all the features that are available for this pane.

• Double-click the event entry on the Results tab to open an event in the Navigator.

• Click Print to print the search results.

• In the Reservation view, select a search result entry, and then click Email to open a
pre-addressed SMTP email to the group that is associated with the selected
reservation. Complete and send the email as you would normally. See “Sending
Email from EMS” on page 414.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• In the Bookings view, click Outlook to download the search results to your personal
calendar.

• In the Service Orders view, to mark a service order as Reviewed, select the service
order, or CTRL-click to select multiple service orders, and then click Review >
Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click
Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select
the appropriate booking in the Results list, or CTRL-click to select multiple service
orders of the same category, and then click Change State. A Change State dialog box
opens. The dialog box lists all the available states for the service order. Select the
new state for the service order on the State dropdown list.

• In the Browse For field, select a different item to search for. The Results tab is
refreshed with the search results based on the item that you selected and the search
criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. If you want to reset the columns to their
default values, see “Resetting Column Settings” on page 408.

Your EMS administrator must set a system parameter to enable this function. If 
this function is not available, contact your EMS administrator for assistance.

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 222.
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To carry out an advanced search in the Calendar

Figure 4-10: Calendar window, Advanced search options

1. On the Browse For dropdown list, select the item for which to search.

2. Optionally, do one or both of the following:

• The default values for the month and year are the current month and year. You can
enter different values as needed.

• Click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, Get Data when Calendar
Opens, When Filtering By Specific Room, and Change Calendar Day Count Color.

3. For each field level option by which to carry out the search:

• Select the field level option, and then click the Move button (>).

• When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

To filter the list of available fields, in the Field Search field, enter a search string. 
Your search is limited to the exact order of the characters in the string, but the 
search string is not case-sensitive and it can appear anywhere in the search 
results. For example, a search string of add returns Added by, Date Added, and 
Group Address Line 1. The list of fields that meet your search criteria is 
dynamically updated as you enter your search criteria.
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Figure 4-11: Viewing a selected field option in the Filter Summary list

4. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The number of
bookings that meet the search criteria is indicated on the dates on which the events occur.
The current day’s date is outlined in black.

Figure 4-12: Calendar window, Results tab

If you have specific fields and/or values by which you always want to carry out a 
search, then you can set up these fields to be your Favorite fields. See “To set up 
favorite fields for a Calendar search” on page 214.

To view a selected field option in its entirety in the Filter Summary list, rest the 
mouse pointer on the entry. A tooltip showing the complete field option 
information opens. 

By default, the number of bookings is indicated in red unless you selected a 
different color for the Change Calendar Day Count Color.
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5. Optionally, do one or more of the following:

• Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-13: Calendar window, Results tab with list of events for selected dates

• The lower pane on the Results tab is an EMS Browser window. See “An EMS
Browser Window” on page 35 for all the features that are available for this pane.

• To open an event in the Navigator, double-click the event entry on the Results tab.

• Click Print to print the search results.

• In the Reservation view, select a search result entry, and then click Email to open a
pre-addressed SMTP email to the group that is associated with the selected
reservation. Complete and send the email as you would normally. See “Sending
Email from EMS” on page 414.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• In the Bookings view, click Outlook to download the search results to your personal
calendar.

Your EMS administrator must set a system parameter to enable this function. If 
this function is not available, contact your EMS administrator for assistance.
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• In the Service Orders view, to mark a service order as Reviewed, select the service
order, or CTRL-click to select multiple service orders, and then click Review >
Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click
Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select
the appropriate booking in the Results list, or CTRL-click to select multiple service
orders of the same category, and then click Change State. A Change State dialog box
opens. The dialog box lists all the available states for the service order. Select the
new state for the service order on the State dropdown list.

• In the Browse For field, select a different item to search for. The Results tab is
refreshed with the search results based on the item that you selected and the search
criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. If you want to reset the columns to their
default values, see “Resetting Column Settings” on page 408.

To set up favorite fields for a Calendar search

If you have specific fields and/or values by which you always want to carry out a Calendar 
search, you do not have to filter the list of fields on the All Fields tab for every search. 
Instead, you can set up each of these fields to be a favorite field with a specific value or limit 
if needed. 

1. Open the Calendar, and make sure that the Advanced search features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields
tab, and then click Add to Favorites.

The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on
the Filter dialog box.

The next time that you carry out a search, you can simply open the Favorite Fields tab or
the Saved Values tab to carry out a search based on your customized list of search fields.

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 222.
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Searching with the Resource Calendar

You use the Resource Calendar to search for a particular resource and determine how much 
of the resource (that is, how many individual items) is needed for a specific day or month in 
a specific year. For example, how many slices of key lime pie are needed in November, 
2012? You can use the results of the search to assist you in managing the counts of the 
resources that your organization must ensure are available for scheduled events. When you 
carry out a search in the Resource Calendar, you can carry out a basic search or an advanced 
search. A basic search is based on the basic information that you specify for a resource item 
when you first create it, such as its category and status. An advanced search is a field level 
search that is carried out the booking level, the booking detail level, the booking detail item 
level, the reservation level, the service order level, or any combination of these. For example, 
in an advanced search, you can specify criteria as granular the date that the service order 
reminder was added. You can open a resource item that has been returned in the search 
results in the Navigator, and edit the item if needed.

To carry out a search in the Resource Calendar

1. On the EMS menu bar, click Reservations > Reservations > Resource Calendar.

The first time that the Resource Calendar opens, the Filter tab is set by default to a Basic
search; otherwise, the Filter tab is set to the search type (Basic or Advanced) that you
last carried out.

Figure 4-14: Resource Calendar, Basic search
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2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and
then continue to one of the following:

• “To carry out a basic search in the Resource Calendar.”

• “To carry out an advanced search in the Resource Calendar” on page 218.

To carry out a basic search in the Resource Calendar

1. Leave the Month and Year set to the default values (current month and year), or
optionally, enter different values as needed.

2. Enter the search criteria.

3. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, Specific Room Filters, and
Change Calendar Day Count Color.

4. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The total number
of resources in all bookings that meet the search criteria is indicated on the dates on
which the events occur. The current day’s date is outlined in black. See Figure 4-15 on
page 217.

Field Description

Include Cancelled By default, search results are not set to show resource items for 

canceled reservations. Select this option to search for resource items in 

canceled reservations as well.

Category Select a specific category (booking detail).

Resource Available only if you select a category that is a resource or service order. 

Select a specific resource item.

Status The default value is set to (all). You can leave this value as is, or you 

can select a specific booking status.

By default, the number of resources is indicated in red unless you selected a 
different color for the Change Calendar Day Count Color. Any color that you pick 
here is carried over to the same option for the Calendar.
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Figure 4-15: Resource Calendar window, Results tab

5. Optionally, do one or more of the following:

• Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-16: Resource Calendar window, Results tab with list of events for selected dates
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• The lower pane on the Results tab is an EMS Browser window. See “An EMS
Browser Window” on page 35 for all the features that are available for this pane.

• Double-click an event entry on the Results tab to open the event in the Navigator.

• Click Print to print the search results.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. If you want to reset the columns to their
default values, see “Resetting Column Settings” on page 408.

To carry out an advanced search in the Resource Calendar

Figure 4-17: Resource Calendar, Advanced search

1. Optionally, do one or both of the following:

• The default values for the month and year are the current month and year. You can
enter different values as needed.

• Click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, Specific Room Filters,
and Change Calendar Day Count Color.



219

 
Search Tools

2. For each field level option by which to carry out the search:

• Select the field level option, and then click the Move button (>).

• When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

Figure 4-18: Viewing a selected field option in the Filter Summary list

3. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The total number
of resources in all bookings that meet the search criteria is indicated on the dates on
which the events occur. The current day’s date is outlined in black. See Figure 4-19 on
page 220.

To filter the list of available fields, in the Field Search field, enter a search string. 
Your search is limited to the exact order of the characters in the string, but the 
search string is not case-sensitive and it can appear anywhere in the search 
results. For example, a search string of add returns Added by, Date Added, and 
Group Address Line 1. The list of fields that meet your search criteria is 
dynamically updated as you enter your search criteria.

If you have specific fields and/or values by which you always want to carry out a 
search, then you can set up these fields to be your Favorite fields. See “To set up 
favorite fields for a Resource Calendar search” on page 221.

To view a selected field option in its entirety in the Filter Summary list, rest the 
mouse pointer on the entry. A tooltip showing the complete field option 
information opens. 

By default, the number of resources is indicated in red unless you selected a 
different color for the Change Calendar Day Count Color.
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Figure 4-19: Resource Calendar, Results tab

4. Optionally, do one or more of the following:

• Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-20: Resource Calendar window, Results tab with list of events for selected dates
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• The lower pane on the Results tab is an EMS Browser window. See “An EMS
Browser Window” on page 35 for all the features that are available for this pane.

• Double-click an event entry on the Results tab to open the event in the Navigator.

• Click Print to print the search results.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

5. Click Close.

Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. If you want to reset the columns to their
default values, see “Resetting Column Settings” on page 408.

To set up favorite fields for a Resource Calendar search

If you have specific fields and/or values by which you always want to carry out a Resource 
Calendar search, you do not have to filter the list of fields on the All Fields tab for every 
search. Instead, you can set up each of these fields to be a favorite field with a specific value 
or limit if needed. 

1. Open the Resource Calendar, and make sure that the Advanced search features are
displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields
tab, and then click Add to Favorites.

The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on
the Filter dialog box.

The next time that you carry out a search, you can simply open the Favorite Fields tab or
the Saved Values tab to carry out a search based on your customized list of search fields.
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Searching with the Service Order Management 

Browser

You use the Service Order Management browser to search for and view the resources with 
and without service orders for all bookings on a particular day as well as the current state of 
the resources and their Reviewed status. After viewing a resource, if applicable, you can 
change the state for a resource. You can review a resource, or you can mark a resource as 
unreviewed. You can also open a resource in the Navigator, and edit it if necessary.

To search with the Service Order Management browser

1. On the EMS toolbar, click the Manage Services icon.

The Service Order Management window opens. When this window first opens, the
display is static and you must manually refresh it. To set options for automatically
refreshing the window’s display, go to Step 2; otherwise, go to Step 4.

Figure 4-21: Service Order Management window

A category state is a process phase, or state, that describes the movement of a 
resource in the category through your organization’s processes, for example, 
“Unassigned,” “Assigned,” “Out for Delivery,” “In Prep,” and so on. Your EMS 
administrator configures the states that are specific to your organization. Contact 
your EMS administrator for assistance with states.
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2. Click Options.

The Options dialog box opens.

Figure 4-22: Options dialog box

3. Edit the display options as needed for the Manage Services window, and then click OK
to apply these changes.

4. To filter the search results, do one or more of the following:

• Leave the Date set to the default value (the current day’s date), or select a different
date.

• On the Building dropdown list, leave the value set to the default value (all
buildings), or select a specific building, area, or view.

• On the Category dropdown list, select the category by which to search.

• In the Status pane, select one or more specific booking statuses, or select (all)
statuses.

5. Click Refresh.

A list of all bookings that meet your search criteria is displayed in the upper pane of the
window.

• If states are assigned to any of the resources in a booking, then the name of the state
and if applicable, its color, is displayed in the State column for the booking. If a
resource for a booking is of the type to which states can be assigned, but none has
been assigned, then (none) is displayed in the State column for the booking.

• If a resource has been reviewed for a booking, then “Yes” is displayed in the
Reviewed column for the booking.

• If your Options are set to show deleted service orders/items, then an “x” appears
next to the booking for which the orders/items were deleted and a single line through
the booking is displayed.

See Figure 4-23 on page 224.
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Figure 4-23: Service Order Management window with results

6. Optionally, do one or more of the following:

• The upper pane on the Service Order Management window is an EMS Browser 
window. See “An EMS Browser Window” on page 35 for all the features that are 
available for this pane.

• To view the resources (individual items) for a booking, select the booking. The 
resources are displayed on the Items tab in the lower pane of the window. See Figure
4-23 above.

• To open an event in the Navigator and edit the resource item as needed, double-click 
the event entry on the Results tab. See “The Navigator,” on page 77.

Figure 4-24: Booking with Changed icon

• To mark a resource for a booking as reviewed, select the booking, or CTRL-click to
select multiple bookings, and then click Reviewed. A message opens asking you if
you are sure that you want to mark the resource as reviewed. Click Yes to close the
message. “Yes” is displayed in the Reviewed column for the booking.

If you edit any information for a resource (quantity, notes, and so on) or the 
service order (service order time, estimated count, or so on) for a booking, then a 
Changed icon is displayed next to the booking.

Changed icon
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• To reverse the Reviewed status for a resource in a booking, select the appropriate
booking, or CTRL-click to select multiple bookings, and then click Unreviewed. A
message opens asking you if you are sure that you want to mark the selected
resource as unreviewed. Click Yes to close the message. “Yes” is cleared from the
Reviewed column for the booking.

• To change the state of the resources for a booking, select the booking, or
CTRL-click to select multiple service orders of the same category, and then click
Change State. A Change State dialog box opens. The dialog box lists all the
available states for the resource. Select the new state for the resource on the State
dropdown list.

• To view the changes made to the resources for a booking, select the booking, and
then open the Changes tab in the lower pane of the window.

Figure 4-25: Viewing changes to a resource in the Service Order Management window
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• To print the list of service orders that are displayed, click Print. An onscreen preview
of the Service Orders list opens. The preview window contains options for printing a
hard copy of the list, for emailing the list, and so on.

Figure 4-26: Onscreen preview for a printed reminder

• The Items tab and the Changes tab in the lower pane of the Service Order
Management window have some of the same basic features as an EMS browser
window. You can rearrange the column order by dragging a column to a new
location using the column heading, you can change the width of the data columns,
and you can sort the data columns on a tab in either ascending or descending sort
order. See “An EMS Browser Window” on page 33.

• Make any necessary changes to the search criteria, and then click Refresh to repeat
the search based on the new search criteria.

7. Click Close.

Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. If you want to reset the columns to their
default values, see “Resetting Column Settings” on page 408.
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The Dashboard is a window that centralizes critical information about reservations in a 
single location. The information that is displayed on this window, including notifications, 
reminders, web reservations, and so on, provides you with the necessary input to manage 
your work in EMS.

This chapter covers the following topics:

• “Overview of the EMS Dashboard and Dashboard Options” on page 229.

• “Notifications Tab” on page 232.

• “Reminders Tab” on page 234.

• “Web Reservations Tab” on page 240.

• “Web Requests Tab” on page 241.

• “Wait List Tab” on page 245.

• “Reconfirm Dates Tab” on page 246.

• “Building Hours Exceptions Tab” on page 247.

• “Analytics Tab” on page 248.

• “At A Glance Tab” on page 251.
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Overview of the EMS Dashboard and 

Dashboard Options

The Dashboard is a window that centralizes critical information about reservations in a 
single location. The information that is displayed on this window provides you with the 
necessary input to manage your work EMS. By default, when the window first opens, it has 
nine tabs—Notifications, Reminders, Web Reservations, Web Requests, Wait List, 
Reconfirm Dates, Building Hours Exceptions, Analytics, and At A Glance. If any tab on the 
Dashboard window has at least one record displayed on it, then, by default, when you log 
into EMS, the Dashboard window opens and the Dashboard icon on the main toolbar flashes 
briefly. Also, an asterisk (*) is displayed to the right of the tab name. All the tabs in the upper 
pane of the window have some of the basic features of an EMS browser window. You can 
sort the data columns on a tab in either ascending or descending sort order, you can rearrange 
the column order by dragging a column to a new location using the column heading, and you 
can change the width of the data columns. 

Figure 5-1:  Dashboard window

For information about working with data columns on a Dashboard tab, see “To 
group data by columns in an EMS Browser window” on page 36 and “” on page 
39.

You can change the default behavior of the Dashboard in the Dashboard Options 
dialog box. See “Dashboard options” on page 230. You can also click the 
Dashboard icon at any time to open the Dashboard window.
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Dashboard options

The appearance and functioning of your Dashboard window are determined by the values 
that you set for the Dashboard options. To view, and if needed, edit these values, in the upper 
right corner of the Dashboard window, click Options to open the Dashboard Options dialog 
box.

Figure 5-2:  Dashboard options dialog box

Option Description

Open Dashboard At Startup 

If Items Exist

Selected by default. The Dashboard window opens automatically 

after you log into EMS if any tab displays at least one item.

• Show Reminders

• Show Web Reservations

• Show Web Requests

• Show Analytics

• Show Wait List

• Show Reconfirm Dates

• Show Building Hours

Exceptions

• Show At A Glance

Selected by default. Indicates the tabs that are to be displayed on 

the Dashboard window. 
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“Thru Today” includes xx 

Days Prior to Today

Indicates how far into the past that reminders are to be displayed in 

the “Thru Today” view. The default value is seven.

Activate Flashing Indicator 

For:

• Notifications

• Reminders

• Web Reservations

• Web Requests

Set on a per tab basis. Indicates when the Dashboard icon on the 

EMS toolbar is to flash if at least one item is displayed on any tab. 

Values are:

• Automatically—Immediately when there is at least one record

that is displayed on the indicated tab, even when you are

working in EMS.

• At Startup Only

• Never

Activate Flashing Indicator 

For:

• Wait List

• Reconfirm Date

Reminders

• Building Hours

Exceptions

Set on a per tab basis. Indicates when the Dashboard icon on the 

EMS toolbar is to flash if tasks on the tab require your attention. 

Values are:

• At Startup Only

• Never

Option Description
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Notifications Tab

Your EMS administrator can configure notification rules to alert you or groups of which you 
are a member when additions or modifications have been carried out in the EMS database 
such as the creation or modification of a booking, the creation or modification of a service 
order, the creation of a new web account, and so on.

Figure 5-3:  Dashboard window, Notifications tab

When the Notifications tab first opens, all the notification rules that include you are listed in 
the Notification Rule pane (upper left pane) of the tab. Next to each rule, the number of new 
notifications (notifications with the current day’s date) is displayed. The tab is interactive. 
You can:

• Select a rule to view all unreviewed notifications for future bookings.

• Select a rule, and under Show, select Reviewed to view all reviewed notifications for
future bookings.

• Select a rule, and under Show, select Old to view all notifications for past bookings.

• Select a notification to view detailed information about the notification (such as new
bookings, the changes made to a booking, and the users who were notified of the changes)
in a pane at the bottom of the window.

• Select Show New Only to show only new notifications (notifications with the current
day’s date) for the notification rules.

• Select a notification, and then click Reviewed to mark a notification as “Reviewed.”
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• Select a notification and then click Go To to open the item to which the notification refers.

• If the notification is attached to a reservation, booking, or booking detail, then the
reservation opens in the Navigator, and the appropriate folder (Reservation, Booking,
or Booking Detail) is automatically selected.

• If the notification is attached to a group, then the Group window opens with the group
information displayed in the window.

• Click Refresh to check for notifications that have been issued since you opened the
Dashboard.

• Select a notification, or CTRL-click to select multiple notifications, and then click Delete
to delete the notifications from the Notifications tab.
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Reminders Tab

A comment is a text entry that explains or clarifies a reservation, booking, group, or service 
order. A reminder is a comment that has a due date associated with it. The Reminders tab 
displays all the reminders for which you are the responsible user and that, by default, have a 
due date through the current day’s date. 

Figure 5-4:  Dashboard window, Reminders tab

The tab is interactive. You can:

• View a list of reminders for other responsible users and/or set the criteria for which
reminders that you want to view. See “To change the Reminders tab view” on page 235.

• Create an unattached reminder. “To create an unattached reminder” on page 236.

• Edit a reminder. “To edit a reminder” on page 237.

• Delete a reminder. “To delete a reminder” on page 237.

• Print a reminder. “To print a reminder” on page 238.

• Go to the item to which a reminder is attached. See “To go to the item to which a reminder
is attached” on page 238.

• Complete a reminder. See “To complete a reminder” on page 238.

• Reassign multiple reminders from one EMS user to another. See “To reassign multiple
reminders between EMS users” on page 239.
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To change the Reminders tab view

By default, when the Dashboard window first opens, the Reminders tab displays all the 
reminders for which you are the responsible user and that have a due date through the current 
day’s date. You can do one or more of the following to change this view:

• To view the reminders for which other users are responsible, simply select the user or
users in the Responsible User pane.

• To view only a specific group of reminders for which you or others are the responsible
users, change the viewing criteria.

Option Description

View View reminders that have the indicated due date. The default value is 

Thru Today. If a value from the pre-configured list does not meet your 

needs, then select (user specified) and in the Date Due fields, enter at 

least a Starting due date. The Ending due date is optional.

Reminder Type The default value is (all). 

Attached To The default value is (all). To view reminders that are not attached to any 

item (reservation, booking, group, or service order), select (none). See 

“To create an unattached reminder” on page 236.

Search in Text Enter the string by which to search for specific reminders. (The search is 

carried out on the Notes field for the reminder.) Your search is limited to 

the exact order of the characters in the string, but the search string is 

not-case sensitive and it can appear anywhere in the search results. For 

example, a search string of cat returns reminders that have “catering” or 

“Mary’s catering” in the Notes field.

Date Completed Available only if Exclude Complete is not checked.

Exclude Completed Selected by default. Clear this option to display completed reminders in 

the Reminders list. To display completed reminders that meet the other 

viewing criteria, regardless of their completion dates, leave the Date 

Completed fields blank; otherwise, to view completed reminders that 

were completed by a specific date, you can enter a Starting date or a 

date range in the Date Completed fields. 

Hide Cancelled Not selected by default. Select this option to display canceled reminders 

in the Reminders list.
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To create an unattached reminder

When you create reminder on the Navigator, the reminder is attached to a specific 
reservation, booking, or booking detail. Similarly, when you create a reminder on the Groups 
window, the reminder is attached to a specific group. If needed, however, you can create a 
reminder that addresses just your general business needs and is not attached to any specific 
item. For example, you can create a reminder about “preparing for your organization’s yearly 
safety inspection.” Any reminder that you create from the Reminders tab on the Dashboard 
window is an unattached reminder.

1. Click New.

The Reminder dialog box opens.

Figure 5-5:  Reminder dialog box

2. Do one of the following:

• Select a Reminder Type.

• If none of the pre-configured Reminder Types meets your working needs, then select
(user-specified), and in the Description field, enter a description for the reminder
type.

The Responsible User field is populated with your User ID and the Date Due field is 
populated with the current day’s date.

3. Optionally, change the value for the Responsible User, the Date Due, or both.

4. If you are completing the reminder today, select a Date Completed; otherwise, leave this
field blank. (This field is populated automatically when you or another user completes
the reminder. See “To complete a reminder” on page 238.)

5. Optionally, do one or both of the following:

• In the Notes field, enter any further explanation or information about the reminder.

• Click Spelling to spell check the reminder before you save it.
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6. Click OK.

The Reminder dialog box closes. The newly created reminder is not attached to an item.
It might or might not be displayed in the Reminders list depending on the values that you
have set for filtering the display.

To edit a reminder

1. On the Reminders list, select the reminder that you are editing, and then click Edit.

The Reminder dialog box opens. The dialog box is populated with the current
information for the reminder.

2. Edit the reminder as needed.

3. Optionally, click Spelling to spell check the reminder before you save the edited
reminder.

4. Click OK.

The Reminder dialog box closes. If the reminder is attached to an item such as a
reservation, then the reminder remains attached; otherwise, it is saved as an unattached
reminder.

To delete a reminder

You can delete any reminder (attached or unattached) regardless of its due date and 
regardless if it is completed.

1. On the Reminders list, select the reminder that you are deleting, and then click Delete.

A message opens asking you if it is OK to delete the reminder.

2. Click Yes.

The message closes and the reminder is deleted.
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To print a reminder

1. On the Reminders list, select the reminder that you are printing, and then click Print.

An onscreen preview of the reminder opens. The preview window contains options for
printing a hard copy of the reminder, for emailing the reminder, and so on.

Figure 5-6:  Onscreen preview for a printed reminder

2. Select the option or options that best fit your working needs.

To go to the item to which a reminder is attached

On the Reminders list, select a reminder, and then click Go To.

• If the reminder is attached to a reservation, booking, or booking detail, then the
reservation opens in the Navigator, and the appropriate folder (Reservation, Booking, or
Booking Detail) is automatically selected.

• If the reminder is attached to a group, then the Group window opens, with the group
information displayed in the window.

To complete a reminder

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple
reminders that you are completing.

2. Click Completed.

A message opens asking you if it is OK to set the selected reminders as completed.

3. Click Yes.

The message closes. The reminders are completed with a date equal to the current day’s
date. The reminders might or might not be displayed in the Reminders list depending on
the values that you have set for filtering the display.

The Attached To column for the reminder must state anything other than 
“Unattached.”
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To reassign multiple reminders between EMS users

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple
reminders that you are reassigning.

2. Click Reassign.

The Select User dialog box opens. This dialog box lists all the users for your EMS
implementation.

Figure 5-7:  Select User dialog box

3. Select the user to whom you are reassigning the reminder.

4. Click OK.

A message opens, asking you if you are sure that you want to reassign the selected
reminders to the user.

5. Click Yes.

The Select User dialog box and message close and the reminder is reassigned.

To search for a user, enter a search string in the Search field. The search string is 
limited to the exact order of the characters in the string, but the search string is 
not case-sensitive and it can appear anywhere in the search results. For example, 
a search string of Admin returns both Admin users and SysAdmin. The list of 
users that meet your search string is dynamically updated as you enter the string. 
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Web Reservations Tab

The Web Reservation tab displays any reservation that was submitted through VEMS for 
web process templates that are set to Self Serve mode. 

Figure 5-8:  Web Reservations tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You
can view reservations for the indicated due date. The default value is Thru Today. If
a value from the pre-configured list does not meet your needs, then select (user
specified) and in the Date Due fields, enter at least a Starting due date. The Ending
due date is optional.

• Select the reservation in the Reservations list, and then click Go To to open the
reservation in the Navigator.
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Web Requests Tab

The Web Requests tab displays any reservation that was submitted through VEMS for web 
process templates that are set to Request mode. A request that has not yet been processed has 
a status of Pending.

Figure 5-9:  Dashboard window, Web Requests tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Room options are displayed on the Room list at the top of the right pane of the tab.
To enable the Room list, you must select a specific building.

• Edit a web request, including processing it. See “To edit a web request” on page 242.

• Delete a web request. See “To delete a web request” on page 244.

• Print a web request. See “To print a web request” on page 244.
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To edit a web request

1. Select the web request that you are editing, and then click Edit.

The Web Request dialog box opens. All of the information that was submitted for the
request through VEMS is displayed in the dialog box. The dialog box always has a
Description tab, a Web Questions tab, and an Audit tab. If the request included resources
or setup notes, it also has a Services tab.

Figure 5-10: Web Request dialog box

2. Do one of the following:

• Edit the request as necessary without processing it and then click OK. When editing
the request without processing it, optionally, you can do one or more of the
following:

• If you have questions about the request or want to confirm some information
(for example, “Will alcohol be served at the event?”) before you process the
request, you can enter these questions or comments in the Notes field on the
Description tab. A web user can see these notes when viewing the request in
VEMS and you can wait for a response before deciding whether to process the
request.

• In addition, to indicate that you are reviewing the request before you process it,
you can set the status of the request to In Progress on the Description tab. A web
user can see this status when viewing the request in VEMS.
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• If the request required questions to be answered on the web, open the Web
Questions tab to see the questions and the user’s answers.

• If the request includes resources, open the Services tab to see what the request
includes. To view the details for each category, double-click a category to
display its associated details in the right pane.

• To process the request and create a true reservation for the request in your EMS
database, on the Description tab, click Process.

The reservation opens in the Reservation Wizard. Continue to “Making a
Reservation Using the Reservation Wizard” on page 45.

Figure 5-11: Process Web Request Details window

After you create a true reservation using the Wizard and the reservation includes a 
request for services, the Process Web Request Details window opens. (See Figure 
5-11 below.) You can process the services immediately using the options on this
window, or to process the services at a later date, click Cancel to close the
window. You can then open the reservation on the Web Requests tab, and on the
Services tab, click Process.
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To delete a web request

1. Select the web request, or CTRL-click to select the multiple requests that you are
deleting, and then click Delete.

A message opens asking you if it is OK to delete the selected web requests.

2. Click Yes.

The message closes. The selected web requests are deleted.

To print a web request

1. Select the web request, or CTRL-click to select the multiple requests that you are
deleting, and then click Print.

An onscreen preview of the selected requests opens. A variety of options are available
from this preview, including the options to print a hard copy of the requests, to export the
requests to a .pdf, and to email the requests.

Figure 5-12: Print preview for a web request

2. Select the option or options that best fit your working needs.



245

  EMS 

Dashboard

Wait List Tab

The Wait List tab provides you a way of monitoring wait-listed reservations. It also provides 
an indicator when the requested room becomes available.

Figure 5-13: Wait List tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You
can view reservations for the indicated due date. The default value is Thru Today. If
a value from the pre-configured list does not meet your needs, then select (user
specified) and in the Date Due fields, enter at least a Starting due date. The Ending
due date is optional.

• Select the reservation in the Reservations list, and then click Go To to open the
reservation in the Navigator.
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Reconfirm Dates Tab

The Reconfirm Dates tab displays reservations that have been booked in a status that 
requires the Reconfirm Date option (for example, a Tentative or Hold status). The list of 
reservations is automatically sorted in ascending order by Reconfirm Date. You use this tab 
as a reminder to reconfirm such reservations.

Figure 5-14: Reconfirm Dates tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You
can view reservations for the indicated due date. The default value is Thru Today. If
a value from the pre-configured list does not meet your needs, then select (user
specified) and in the Date Due fields, enter at least a Starting due date. The Ending
due date is optional.

• Select the reservation in the Reservations list, and then click Go To to open the
reservation in the Navigator.
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Building Hours Exceptions Tab

The Building Hours Exceptions tab displays reservations that occur outside of configured 
building hours.

Figure 5-15: Building Hours Exceptions tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You
can view reservations for the indicated due date. The default value is Thru Today. If
a value from the pre-configured list does not meet your needs, then select (user
specified) and in the Date Due fields, enter at least a Starting due date. The Ending
due date is optional.

• Select the reservation in the Reservations list, and then click Go To to open the
reservation in the Navigator.
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Analytics Tab

The Analytics tab provides quick access for queries that have been defined using the Query 
builder and to which you have access as a user. You can run these queries from the Analytics 
tab.

Figure 5-16: Dashboard window, Analytics tab

To run a query from the Analytics tab, do the following:

1. In the upper left corner of the Analytics tab, click Select Queries.

The Queries dialog box opens. This dialog box lists the queries that have been defined
using the Query builder and to which you have access.

2. Select the queries that you want to run, and then click OK.

The Queries dialog box closes. The selected queries are displayed in the Queries pane
(upper left) on the Analytics tab.



249

  EMS 

Dashboard

3. In the Queries pane, select the query that you want to run, and then select the date for
which the data in your EMS database is to be queried.

4. Optionally, in the Report Comment field, enter a description or explanation of the query.

5. Click Get Data.

If the query returns data, then the results are displayed in the Results pane on the
Analytics tab.

6. Optionally, do one or more of the following:

• To export the query results to an Excel spreadsheet or to an XML file, click Export,
and then select the appropriate file type. A dialog box opens in which you can
specify the file name (the default file name is the name of the query, but you can
always edit this), and the location to which to save the file.

Option Description

Custom The starting date is set to the first day of the month and the ending date 

is set to the last day of the month but you can edit one or both of these 

dates. 

Note: For some queries, if you select Custom, a Use Specific Times 

option becomes available. If you enter the same date for the 

starting date and ending date, you can select Use Specific 

Times, and then enter a starting time and ending time to query 

the data for in specific time range on the same day.

Last Month The starting date is set to the first day of the previous month and the 

ending date is set to the last day of the previous month. 

Last Quarter

This Quarter

This Quarter To Date

Quarters are based on a calendar year:

• First quarter is 1/1 through 3/31.

• Second quarter is 4/1 through 6/30.

• Third quarter is 7/1 through 9/30.

• Fourth quarter is 10/1 through 12/31.

For example, if the current day’s date is 11/22/2010, and you select Last 

Quarter, then the starting date is set to 7/1/2010 and the ending date is 

set to 9/30/2010.

Last Year The starting date is set to 1/1 of the previous year, and the ending date 

is set to 12/31 of the previous year.

This month The starting date is set to the first day of the current month and the 

ending date is set to the last day of the current month. 

This Year The starting date is set to 1/1 of the current year, and the ending date is 

set to 12/31 of the current year.

This Year to Date The starting date is set to 1/1 of the current year, and the ending date is 

set to the current day’s date.

The file type for an Excel spreadsheet is .xl or .xls and you cannot change this. The 
file type for an XML file is .xml and you cannot change this.
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• To generate an onscreen preview of the printed query results, click Print. The
preview window contains options for printing a hard copy of the query results, for
emailing the results, and so on. Select the option or options that best fit your working
needs.

Figure 5-17: Onscreen preview of a query results

• If the query has been defined with a Chart, the Chart option is enabled. Click Chart
to generate an onscreen preview of the charted data. The preview window contains
options for printing a hard copy of the chart, for emailing the chart, and so on. Select
the option or options that best fit your working needs.

Figure 5-18: Onscreen preview of query results that are charted/graphed
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At A Glance Tab

The At A Glance tab provides quick access to high-level booking statistics for events at your 
organization or facility. You can select to show booking statistics by category, by event type, 
by group type, by reservation source, by room type, or by status. 

Figure 5-19: At A Glance tab

By default, when the tab first opens, the date is set to the current day’s date, and category is 
the selected display type. To view booking statistics for your facility on a given date, do the 
following:

1. Select options (Status and Building) on the left pane of the tab to filter the results that are
displayed on the tab.

2. Change the date and/or the display type as needed to view the bookings statistics for a
selected date.
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A group is an entity for which reservations are made at your facilities. A group is one of the 
four core data items that your EMS administrator must configure so that you can make 
reservations. A group can be an internal or external entity and it can be an organization or an 
individual. A contact is a person who serves as the coordinator or focal point for a group. 

This chapter covers the following topics:

• “Searching for and Configuring Groups” on page 255.

• “Configuring Additional Information for a Group” on page 263.

• “Configuring Contacts for a Group” on page 278.

• “Editing Group Information” on page 286.

• “Importing Groups” on page 294.

• “Working with Reservations for a Group” on page 295.

• “Emailing a Group” on page 300.

• “Printing and Exporting Group Information” on page 301.

• “Printing and Exporting Web User Information” on page 303.
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Searching for and Configuring Groups

A group is an entity for which reservations are made at your facilities. A group can be an 
internal or external entity and it can be an organization or an individual. A group must be 
configured before you can make reservations for it in EMS. Optionally, if you want to first 
confirm that a group has not already been configured, then you can search for the group.

To search for a group and/or contact

1. On the toolbar, click the Groups icon .

The Groups window opens. The Results tab is the active tab. By default, when the
Results tab first opens, it lists the first 1000 groups that are currently configured in your
EMS database and that have a status of Active.

Figure 6-1:  Groups window, Results tab

Typically, your EMS administrator carries out basic configuration of the groups 
for which you need to make reservations. You always have the option of modifying 
any group that your EMS administrator has configured and you always have the 
option of configuring new groups when needed.

Your organization might use a different term (such as client, customer, and so on) 
to identify the entities for which reservations are made at your facilities. Contact 
your EMS administrator if you need assistance in clarifying this term. 
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2. Open the Filter tab and set your search criteria.

3. Click Get Data.

The Results tab opens with a list of search results that meet all your search criteria.

4. To further filter the display on the Results tab, in the Search field, enter a search string.

The list of groups is dynamically updated as you enter your search string.

Optionally, to change the number of records that are displayed in the Groups 
window, click Options, and then on the Group Options dialog box, select a 
different number of records to return.

Option Description

Display • Groups—Display all groups that meet your search criteria on the Results tab.

• Contacts—Display all contacts that meet your search criteria on the Results

tab.

Note: When a list of contacts is displayed, the contact’s group is also displayed.

Search Fields • Starts with—The string is not case-sensitive, but your search is limited to the

exact order of the characters in the string, and the string must begin with the

information for which you are searching. For example, Assoc returns

Association of Broadcasters but not Biomedical Student Association.

• Contains—Your search is limited to the exact order of the characters in the

string, but the string is not case-sensitive, and the string can be found

anywhere in your search results. For example, Assoc returns both Association

of Broadcasters and Biomedical Student Association.

Group Fields are available if you select Groups for Display. Enter values as needed in 

any or all fields.

Contact Fields are available only if you select Contacts for Display. Leave all fields set to 

their default search values to search for all active contacts that are currently 

configured in your EMS database, or enter values as needed in any or all fields.

Note: If you select Contact, then both the Group fields and the Contact fields are 

available for searching. If you enter data in both sets of fields when you are 

searching for a contact, then your search criteria must be met for both the 

contact and the contact’s group to be displayed on the Results tab.

Note: To reset the Filter at any time to its default settings, click Reset Filter.

Your search is limited to the exact order of the characters in the string, but the 
search string is not case-sensitive and it can appear anywhere in the search 
results. For example, a search string of Assoc returns both Association of 
Broadcasters and Biomedical Student Association.
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To configure groups

Typically, your EMS administrator carries out basic configuration of the groups for which 
you need to make reservations. You always have the option of modifying any group that your 
EMS administrator has configured and you always have the option of configuring new 
groups when needed.

1. On the toolbar, click the Groups icon .

The Groups window opens. The Results tab is the active tab. By default, when the
Results tab first opens, it lists up the first 1000 groups that are currently configured in
your EMS database and that have a status of Active.

Figure 6-2:  Groups window, Results tab

Remember that before you configure a group, you might want to search for the 
group to verify that it has not already been configured. See “To search for a group 
and/or contact” on page 255.
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2. Click New.

The Group dialog box opens. The Group tab is the active tab.

Figure 6-3:  Group dialog box, Group tab

3. Enter the summary information for the new group.

The only required information is the group name. All other information on all tabs 
is optional and can be added at a later date when needed.

Field Description

Name Required field. The name of the group.

Note: The name can be a maximum of 50 characters, including spaces.

Address

City

ST

Country

Zip

The street or mailing address for the group.

International Select this option to drop the State and Zip fields for an international group.

Group Type Pick a group type.

Note: If calculations have been assigned to a group type, then these 

calculations are applied only to new groups of this type.
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4. Optionally, do one or both of the following; otherwise, go to Step 5.

• Open the Billing Information tab and add the default billing information for the
group.

Figure 6-4:  Group dialog box, Billing Information tab

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a dropdown list available on which 

you can select a different value (Fax, Mobile, Other, or Phone) for the 

field label, or you can enter a user-defined value. To enter a 

user-defined value, double-click the current field label to select it, and 

then enter the user-defined value over the selected label. 

Email Address The email address for the group.

Note: If your computer is connected to a network, click the Search icon 

to open a Global Address Lookup dialog box and search for the email 

address.

URL The URL for the group’s website.

Note: Web users can link to this group's web site on VEMS.

Default Contact Populated with the name of the default contact for the group after you have 

defined default contacts for the group.

Require Contacts Select this option if the group is to always require a contact when a 

reservation is being made for the group.

VIP Select this option if the group is to be designated as a VIP group.

Available to Web 

Users

Select this option if users are to be able to select the group on the Group 

Lookup page in VEMS.

Inactive Leave this option blank to add the group as an active group. Select this 

option to inactivate the group.

Field Description
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The values that you specify here are the default values that are applied when a 
new reservation is made for the group. Any EMS user can change these values if 
needed.

Option Description

Pricing Plan Pick a pricing plan.

Payment Type Pick a payment type.

Salesperson Pick a salesperson.

Event Coordinator Pick an event coordinator. 

Sales Category Pick a sales category.

Status The status is a way to indicate the standing or ranking of the group. The 

default values are the following:

• OK—A reservation can be made for the group. (In your organization,

this status could indicate that the group is current in payments due.)

• Warning—If a group status is set to Warning, then a Warning

message opens when you make a reservation for the group. It does

not, however, prevent a reservation from being made for the group.

• Bad—If a group status is set to Bad, then reservations cannot be

made for the group.

Billing Reference 

Number

You can manually enter data into the field, or you can click the Search 

icon  to open a master list of billing reference numbers and select a 

reference.

Note: To define a list of eligible billing references that are specific to the 

group, see “Configuring Additional Information for a Group” on 

page 263.

PO Number You can manually enter data into the field, or you can click the Search 

icon  to open a master list of PO Numbers and select a PO number.

Note: To define a list of eligible PO numbers that are specific to the 

group, see “Configuring Additional Information for a Group” on 

page 263.

External Reference Links the group to a web user record and/or HR Toolkit.

Account Pick an account.
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• Open the Other tab and add any other identifying information for the group as
needed.

Figure 6-5:  Group dialog box, Other tab

5. Click OK.

The Group dialog box closes and a group-specific window opens with the newly
configured group automatically selected. (See Figure 6-6 on page 262.) You can use the
options on this window to carry out additional configuration for the group. See
“Configuring Additional Information for a Group” on page 263.

Option Description

Network ID The Windows login for the group.

Personnel Number Organization number for the group.

Badge Number Badge number for the group.

Other ID Any secondary ID for the group.
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Figure 6-6:  Example of a group-specific window
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Configuring Additional Information for a Group

After you have configured a new group in your EMS database with the basic group 
information (group identifying information, billing information and/or other information), 
you have the option of configuring additional information for the group. You can:

• Create a web user from the group. See “To create a web user from a group” on page 263.

• Assign the group to a web user. See “To assign the group to a web user” on page 266.

• Add reminders to the group. See “To add a reminder to a group” on page 268.

• Add comments to the group. See “To add a comment to a group” on page 269.

• Add attachments to the group. See “To add attachments to a group” on page 271.

• Add user defined fields to the group. See “To add user defined fields to a group” on page
272.

• Assign calculations to the group. See “To assign calculations to a group” on page 273.

• Configure a master list of group-specific billing reference numbers. See “To configure a
list of billing reference numbers” on page 275.

• Configure a master list of group-specific PO numbers. See “To configure a list of PO
numbers” on page 276.

To create a web user from a group

A web user is a registered user who can submit requests for reservations or schedule 
reservations in VEMS. When you add a new group in your EMS database, you decide the 
“level” of the group that you are adding. For a group that is added at the individual 
(personnel/employee) level, you might also need to create a web user from the group. This 
user can then create and view reservations on behalf of a group or groups in VEMS. You can 
create only one web user from a group. When you create a web user, you can also specify one 
or more delegates for the web user. A delegate is a web user who can create and view 
reservations on behalf of another web user. 

1. Open the Groups window and search for the group for which you are creating the web
user. See “To search for a group and/or contact” on page 255.

When you select a configuration item (contacts, reminders, and so on) in the left 
pane in the group-specific window, the right pane for the window is an EMS 
browser window. See “An EMS Browser Window” on page 35

For information about adding a contact to a group, including creating a web user 
for a contact, see “Configuring Contacts for a Group” on page 278. For 
information about editing a contact for a group, see “Editing Group Information” 
on page 286.
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2. On the Groups window, select the group, and then click Tools > Create Web User.

A group-specific dialog box opens. The Web User tab is the active tab.

Figure 6-7:  Group-specific dialog box, Web User tab

3. Enter the information for the web user.

The User Defined Fields tab displays the questions that a web user was required 
to answer when the user requested to create an account through VEMS and it is 
not relevant to the procedure that is described below.

Ideally, you should enter all the necessary information for your web user before 
you save the web user; however, at any time if you need to access your web user, 
on the EMS menu bar, click Configuration > Web > Web Users.

Field Description

Name Automatically populated after you select the group from the Groups 

window.

Password The password that a web user must enter to log in to VEMS.

Email address If this information has been entered in the Groups window for the group, 

then this field is automatically populated after you select the group from 

the Groups window. If the field is blank, you must enter the full email 

address for the user. (The user must enter this address to log in to 

VEMS.)
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4. Open the Process Templates tab and on the Available list, select the web process
template, or CTRL-click to select the multiple templates to which you are assigning the
user, and then click the Move button (>) to move the selected templates to the Selected
list.

5. Open the Groups tab and do one of the following to specify the groups on whose behalf
the web user can view and make reservations in VEMS.

• The group (web user) is selected by default. You can leave this group in the Selected
list, or you can select the group and click the Remove button (<).

• Specify any combination of search criteria for the Find field and Group Type, and
then click Display to produce a list of all groups that meet the criteria. In the
Available list, select a group, or CTRL-click to select multiple groups, and then click
the Move button (>) to move the selected groups to the Selected list.

Phone/Fax Optional fields. If this information has been entered for the group, then 

these fields are automatically populated after you select the group from 

the Groups window. If the fields are blank, you can enter values if 

needed.

Notes Optional field.

External Reference Optional field. Links the web user to a group and/or HR Toolkit.

Network ID Optional field. The web user’s network ID.

Email Opt Out Select this option if the web user is not to receive automatic emails 

(such as reservation summary emails) from VEMS. The user will still 

receive manually sent emails.

Status Required field. Select the status for the web user:

• Active—The web user can log in to VEMS.

• Inactive—The user cannot log in to VEMS and is instructed to contact

the EMS administrator.

• Pending—The web user cannot log in to VEMS and is informed that

he/she must check back at a later time.

Security Template Required field. This determines the web user's access to the system—

the menu items that the user can see and the information that the user 

can view in a tooltip when 'rolling-over' an event in VEMS.

Time Zone Required field. Select the time zone for the user.

A web process template defines the functions that are available to each type of web 
user in VEMS when the user is submitting a request for a reservation. 

If you leave the Find field blank, then a list of all currently active groups for the 
selected group type is displayed. If you enter a search string in the Find field, the 
string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, And returns Anderson, Scott, but not Cooper, Anderson. 

Field Description
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6. Open the Delegates tab, and on the Search by dropdown list, do one of the following to
specify the delegates for the web user:

• Leave the Find field blank, and then click Display to open a list of all currently
available web users. Select a user, or CTRL-click to select multiple web users, and
then click the Move button (>) to move the selected web users to the Selected list.

• On the Search By dropdown list, select the option by which to search (Email
Address or User Name), and in the Find field, enter the string by which to filter your
search, and then click Display. Select a web user, or CTRL-click to select web
multiple users, and then click the Move button (>) to move the selected users to the
Selected list.

7. Optionally, click Spelling to spell check any information that you manually entered for
the web user.

8. Click OK.

The dialog box for creating a web user closes and a message opens indicating that the
web user was created successfully.

9. Click OK to close the message and return to the Groups window.

To assign the group to a web user

When you add a new group in your EMS database, you should also assign the group to a web 
user. This web user can then create and view reservations on behalf of the group in VEMS. 
You can assign a group to one or more web users.

1. Open the Groups window and search for the group to which you are assigning the web
user. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Tools > Assign to Web Users.

The Assign Group dialog box opens. See Figure 6-8 on page 267.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, if searching by Email Address, a search string of bob 
returns bob.worth@emssoftwarew.com but not dbobbett@emssoftware.com.
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Figure 6-8:  Assign Group dialog box

3. Do one of the following to select the web users that are being assigned to the group:

• Leave the Find field blank, and then click Display to open a list of all currently
active web users. Select the web user, or CTRL-click to select multiple web users,
and then click the Move button (>) to move the selected web users to the Selected
list.

• In the Search By dropdown list, select the option by which to search (Email Address
or User Name) and then in the Find field, enter the string by which to filter your
search, and then click Display. Select the web user, or CTRL-click to select multiple
web users, and then click the Move button (>) to move the selected users to the
Selected list.

4. Click Finish.

A message opens indicating that the group was assigned successfully.

5. Click OK to close the message and return to the Groups window.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, if searching by Email Address, a search string of bob 
returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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To add a reminder to a group

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a 
booking detail that is a service order. A reminder is a comment that has a due date associated 
with it.

1. Open the Groups window and search for the group to which you are adding the reminder.
See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

A group-specific window opens. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select Reminders.

A list of all reminders that are currently configured for the group is displayed in the right
pane of the window.

4. Click New.

The Reminder dialog box opens. The Responsible User field is populated with the your
User ID.

Figure 6-9:  Reminder dialog box

5. On the Reminder Type dropdown list, select the type of reminder that you are adding;
otherwise, if none of the pre-configured reminder types meets your working needs,
select (user specified comment), and then in the Description field, enter a description for
the reminder type.

The Date Due field is populated with the current day’s date.

For an example of a group-specific window, see Figure 6-6 on page 262.

The description can be a maximum of 30 characters, including spaces.
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6. Optionally, change the value for the Responsible User, the Date Due, or both.

7. If you are completing the reminder today, select a Date Completed; otherwise, leave this
field blank.

8. Optionally, do one or both of the following:

• In the Notes field, enter any further explanation or information about the reminder.

• Click Spelling to spell check the reminder before you save it.

9. Click OK.

The Reminder dialog box closes. The newly added reminder is automatically selected in
the group-specific window.

To add a comment to a group

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a 
booking detail that is a service order.

1. Open the Groups window and search for the group to which you are adding the
comment. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

A group-specific window opens. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select Comments.

A list of all comments that are currently configured for the group is displayed in the right
pane of the window.

If you leave this field blank, then it is automatically populated when you or 
another user completes the reminder on the Reminders tab of the Dashboard 
window. See “To complete a reminder” on page 238.

For an example of a group-specific window, see Figure 6-6 on page 262.
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4. Click New.

The Comment dialog box opens.

Figure 6-10: Comment dialog box

5. On the Comment Type dropdown list, select the type of comment that you are adding;
otherwise, if none of the pre-configured comment types meets your working needs,
select (user specified comment), and then in the Description field, enter a description for
the comment type.

6. In the Notes field, enter the comment.

7. Optionally, do one or both of the following:

• To alert any EMS user who opens this group or a reservation that is assigned to this
group that this comment has been added to the group, select Alert Users.

• Click Spelling to spell check the comment before you add it to the group.

8. Click OK.

The Comment dialog box closes. The newly added comment is automatically selected in
the group-specific window.

The description can be a maximum of 30 characters, including spaces.
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To add attachments to a group

An attachment is used to describe any file that you can add to or store on a reservation, a 
booking, or a group. 

1. Open the Groups window and search for the group to which you are adding the
attachment. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

A group-specific window opens. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select Attachments.

A list of all attachments that have already been added to the group is displayed in the
right pane of the window.

4. Click New.

The Attachment dialog box opens.

Figure 6-11: Attachment dialog box

5. In the Description field, enter a name or description for the attachment.

For an example of a group-specific window, see Figure 6-6 on page 262.

To view any attachment in this list, select it, and then click View.

The description can be a maximum of 50 characters, including spaces. If you 
leave this field blank, then the Description field is populated with the name of the 
file after you attach it to a group.
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6. On the Type dropdown list, select the attachment type.

7. Click the Search icon  to open the Find Attachment dialog box, and then browse to
and select the attachment.

The Find Attachment dialog box closes. The file name for the attachment is displayed in
the Attachment field.

8. Optionally, do one or both of the following as needed:

• If you left the Description field blank, then the name of the attached file is used by
default for the file description, and you can edit this if needed.

• Click Spelling to spell check the description before you attach the drawing to the
group.

9. Click OK.

The Attachment dialog box closes. The newly added attachment is automatically
selected in the group-specific window.

To add user defined fields to a group

A user defined field (UDF) is a custom field that stores additional data for a group. Typically, 
your EMS administrator configures the types of fields that are available as well as the 
allowed values (text, numeric, and so on) for the fields. When you add a user defined field to 
a group, you must specify a value for the field.

1. Open the Groups window and search for the group to which you are adding the UDF. See
“To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

A group-specific window opens. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select User Defined Fields.

A list of all UDFs that have already been added to the group is displayed in the right
pane of the window.

4. Click New.

The User Defined Field dialog box opens. See Figure 6-12 on page 273.

For an example of a group-specific window, see Figure 6-6 on page 262.
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Figure 6-12: User Defined Field dialog box

5. On the Field dropdown list, select the UDF that you are adding to the group.

6. In the Value field, enter a value for the UDF.

7. Click OK.

The User Defined Field dialog box closes. The newly added UDF is automatically
selected in the group-specific window.

To assign calculations to a group

Calculations are additional charges that can be applied to billable items (a category, a group, 
a group type, a resource, or a room) such as gratuity or sales tax. When you configure a 
group, you can assign the calculations that are to always apply to the group.

1. Open the Groups window and search for the group to which you are assigning the
calculations. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

A group-specific window opens. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select Calculations.

The right pane of the group-specific window displays any calculations that have already
been assigned to the group.

For an example of a group-specific window, see Figure 6-6 on page 262.
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4. Click Edit.

The Calculations dialog box opens. The group name is displayed at the top of the dialog
box.

Figure 6-13: Calculations dialog box

5. On the Available list, select the calculation, or CTRL-click to select the multiple
calculations that are to always apply to this group, and then click the Move button (>) to
move the selected calculations to the Selected list.

6. Continue with any other optional configuration for the group as needed; otherwise, click
OK to close the Calculations dialog box and return to the group-specific window.

Your EMS administrator can also assign calculations to a group type. If your EMS 
administrator has already assigned calculations for this group’s type, then these 
calculations are automatically applied to the group. The calculations are 
displayed in the Selected list after you click OK and save the group; however, you 
can always edit these calculations.
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To configure a list of billing reference numbers

You can configure a list of billing reference numbers that are specific to the group.

1. Open the Groups window and search for the group for which you are configuring the
master billing reference numbers list. See “To search for a group and/or contact” on page
255.

2. On the Groups window, select the group, and then click Open.

A group-specific window open. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select Billing Reference.

A list of all currently active billing reference numbers for the group is displayed in the
right pane of the group-specific window.

4. Optionally, to display all billing reference numbers regardless of status, click Show
Inactive.

Any inactive billing reference numbers are displayed in red italics in the right pane.

5. Click New.

The Billing Reference dialog box opens.

Figure 6-14: Billing Reference dialog box

For an example of a group-specific window, see Figure 6-6 on page 262.
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6. Enter the information for the new billing reference number.

7. Optionally, click Spelling to spell check the information for the billing reference number
before you save it.

8. Continue with any other optional configuration for the group as needed; otherwise, click
OK to close the Billing Reference Number dialog box and return to the group-specific
window.

To configure a list of PO numbers

You can configure a list of PO numbers that are specific to the group. 

1. Open the Groups window and search for the group for which you are configuring the
master PO numbers list. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

A group-specific window open. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select PO Numbers.

A list of all currently active PO numbers for the group is displayed in the right pane of
the group-specific window.

4. Optionally, to display all PO numbers regardless of status, click Show Inactive.

Any inactive PO numbers are displayed in red italics in the right pane.

Option Description

Billing Reference 

Number

The billing reference number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the billing reference number.

Notes Any other comments or statements that are applicable for the billing 

reference number.

Inactive Leave this option blank to add the reference as an active reference (the 

billing reference number is to be available when a reservation is made 

for the group). Select this option to inactivate the billing reference 

number.

For an example of a group-specific window, see Figure 6-6 on page 262.
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5. Click New.

The PO Number dialog box opens.

Figure 6-15: PO Number dialog box

6. Enter the information for the new PO number.

7. Optionally, click Spelling to spell check the information for the PO number before you
save it.

8. Continue with any other optional configuration for the group as needed; otherwise, click
OK to close the PO Number dialog box and return to the group-specific window.

Option Description

PO Number The PO number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the PO number.

Notes Any other comments or statements that are applicable for the PO 

number.

Inactive Leave this option blank to add the PO number as an active number (the 

PO number is to be available when a reservation is made for the group). 

Select this option to inactivate the PO number.
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Configuring Contacts for a Group

A contact is a person who serves as the coordinator or focal point for a group. You have two 
options for configuring a contact for a group. You can configure a” free form” contact, which 
requires you to manually enter the contact information, or you can configure a contact from 
another group, which means that you do not have to manually enter the contact information. 
Instead, the group information is automatically used for the contact. 

To configure contacts

1. Open the Groups window and search for the group for which you are configuring the
contact. See “To search for a group and/or contact” on page 255.

2. Select the group, and then click Open.

A group-specific window opens. The group is automatically selected in the window.

Figure 6-16: Group-specific window

3. In the left pane of the group-specific window, select Contacts.

A list of all currently active contacts for the group is displayed in the right pane of the
group-specific window.

You can also configure and edit a contact “on the fly” during the reservation 
process. See “Making a Reservation Using the Reservation Wizard” on page 45 
for details.
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4. Continue to one of the following:

• “To configure a contact manually” below.

• “To configure a contact from a group” on page 281.

To configure a contact manually

1. Click New.

The Contact dialog box opens.

Figure 6-17: Contact dialog box

2. Enter the information for the new contact.

Optionally, to display all group contacts regardless of status, click Show Inactive. 
Any inactive contacts are displayed in red italics in the right pane.

Field Description

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including 

spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected. You cannot 

change this value.

Address Populated with the address of the group that you selected. If the contact 

address is not the same as the group address, then clear Use Group 

Address and enter the appropriate values in the Address fields.
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3. Optionally, do one or both of the following:

• Click Spelling to spell check the information for the contact before you save it.

• Make sure that the newly created contact is selected so that you can create a web
user from the contact. See “To create a web user from a contact” on page 283.

4. Click OK.

The Contact dialog box closes. The contact is added to the group. The group-specific
window remains open.

International Select this option to drop the State and Zip fields for an international 

group.

Phone 

Fax

The phone number and fax number for the contact. By default, they are 

set to the phone number and fax number for the group, but you can 

always edit these values. 

Note: The Phone and Fax fields have a dropdown list available on 

which you can select a different value (Fax, Mobile, Other, or 

Phone) for the field label, or you can enter a user-defined value. 

To enter a user-defined value, double-click the current field label 

to select it, and then enter the user-defined value over the 

selected label. 

Email Address The email address for the contact.

Note: If your computer is connected to a network, click the Search icon 

 to open a Global Address Lookup dialog box and search for 

the email address.

External Reference Links the contact to an outside program, for example, HR Toolkit, if 

needed.

Notes Any other information that is pertinent for the contact.

Set as Default Select this option if the contact is to be the default contact for the 

selected group. 

Note: If a default contact has been defined for a group, then when you 

specify the group information for a reservation, the Contact field 

is automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a 

selected group at a later date. To do so, select the contact in the 

right pane of the group-specific window, click Set Default, and 

then click Yes at the prompt to set the selected user as the 

default contact. 

Inactive Leave this option blank to add the contact as an active contact. Select 

this option to inactivate the contact.

Field Description
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To configure a contact from a group

1. Click Tools > Click Create Contact from Another Group.

A second Groups window opens.

2. Search for the group that is to be the source of the contact, and then click Select.

The Contact dialog box opens. The name of the group (contact source) is displayed in 
the Group field and you cannot edit this value. The remainder of the fields (Contact 
Name, Address, Phone, and so on) display the information for the group that you 
selected in Step 2 of “To configure contacts” on page 278.

Figure 6-18: Contact dialog box

3. If needed, edit the information for the contact.

See “To search for a group and/or contact” on page 255.

Field Description

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including 

spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected first (the group 

for which you are configuring the contact). You cannot change this 

value.
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4. Optionally, do one or both of the following:

• Click Spelling to spell check the information for the contact before you save it.

• Make sure that the newly created contact is selected so that you can create a web
user from the contact. See “To create a web user from a contact” on page 283.

5. Click OK.

The Contact dialog box closes. The contact is added to the group. The group-specific
window remains open.

Address Populated with the address of the contact. If the contact address is the 

same as the group address, then select Use Group Address to 

populated the address fields with the group address; otherwise, you can 

edit these values.

International Not applicable if Use Group Address is selected. Select this option to 

drop the State and Zip fields from the address for an international 

contact.

Phone 

Fax

The phone number and fax number for the group. 

Note: The Phone and Fax fields have a dropdown list available on 

which you can select a different value (Fax, Mobile, Other, or 

Phone) for the field label, or you can enter a user-defined value. 

To enter a user-defined value, double-click the current field label 

to select it, and then enter the user-defined value over the 

selected label. 

Email Address The email address for the contact.

Note: If your computer is connected to a network, click the Search icon 

 to open a Global Address Lookup dialog box and search 

for the email address.

External Reference Links the contact to an outside program, for example, HR Toolkit, if 

needed.

Notes Any other information that is pertinent for the contact.

Set as Default Select this option if the contact is to be the default contact for the 

selected group. 

Note: If a default contact has been defined for a group, then when you 

specify the group information for a reservation, the Contact field 

is automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a 

selected group at a later date. See “To edit the contacts for a 

group” on page 287.

Inactive Leave this option blank to add the contact as an active contact. Select 

this option to inactivate the contact.

Field Description
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To create a web user from a contact

A web user is a registered user who can submit requests for reservations or schedule 
reservations in VEMS. When you add a contact to a group in your EMS database, you might 
also need to create a web user from the contact. This web user can then create and view 
reservations on behalf of the contact’s group in VEMS. You can create only one web user 
from a contact. When you create a web user, you can also specify one or more delegates for 
the web user. A delegate is a web user who can create and view reservations on behalf of 
another web user. 

1. If needed, open the group that contains the contact from which you are creating the web
user in the group-specific window. See “To configure contacts” on page 278.

2. In the left pane of the group-specific window, make sure that Contacts is selected.

3. In the right pane of the window, select the contact from which you are creating the web
user.

4. Click Tools > Create Web User from Contact.

A contact-specific dialog box opens. The Web User tab is the active tab.

Figure 6-19: Contact-specific dialog box, Web User tab

The User Defined Fields tab displays the questions that a web user was required 
to answer when the user requested to create an account through VEMS and it is 
not relevant to the procedure that is described below.



284

 
Groups and Contacts

5. Enter the information for the web user.

6. Open the Process Templates tab and on the Available list, select the web process
template or CTRL-click to select the multiple templates to which this user is to be
assigned, and then click the Move button (>) to move the selected templates to the
Selected list.

Field Description

Name Automatically populated after you select the contact. You can edit this 

information.

Password The password that a web user must enter to log in to VEMS.

Email address If this information has been entered for the contact, then this field is 

automatically populated after you select the contact. If the field is blank, 

you must enter the full email address for the user. (The user must enter 

this address to log in to VEMS.)

Phone/Fax Optional fields. If this information has been entered for the contact, then 

these fields are automatically populated after you select the contact. If 

the fields are blank, you can enter values if needed.

Notes Optional field.

External Reference Optional field. Links the web user to an outside program if needed.

Network ID Optional field. The web user’s network ID.

Email Opt Out Select this option if the web user is not to receive automatic emails 

(such as reservation summary emails) from VEMS. The user will still 

receive manually sent emails.

Status Required field. Select the status for the web user:

• Active—The web user can log in to VEMS.

• Inactive—The user cannot log in to VEMS and is instructed to contact

the EMS administrator.

• Pending—The web user cannot log in to VEMS and is informed that

he/she must check back at a later time.

Security Template Required field. This determines the web user's access to the system—

the menu items that the user can see and the information that the user 

can view in a tooltip when 'rolling-over' an event in VEMS.

Time Zone Required field. Select the time zone for the user.

A web process template defines the functions that are available to each type of web 
user in VEMS when the user is submitting a request for a reservation.
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7. Open the Groups tab and do one of the following to specify the groups on whose behalf
the web user can view and make reservations in VEMS.

• The contact’s group is selected by default. You can leave this group in the Selected
list, or you can select the group and click the Remove button (<).

• Specify any combination of search criteria for the Find field and Group Type, and
then click Display to produce a list of all groups that meets the criteria. In the
Available list, select a group, or CTRL-click to select multiple groups, and then click
the Move button (>) to move the selected groups to the Selected list.

8. Open the Delegates tab, and on the Search by dropdown list, do one of the following to
specify the delegates for the web user:

• Leave the Find field blank, and then click Display to open a list of all currently
available web users. Select a web user, or CTRL-click to select multiple web users,
and then click the Move button (>) to move the selected web users to the Selected
list.

• On the Search By dropdown list, select the option by which to search (Email
Address or User Name), and in the Find field, enter the string by which to filter your
search, and then click Display. Select a web user, or CTRL-click to select multiple
web users, and then click the Move button (>) to move the selected web users to the
Selected list.

9. Optionally, click Spelling to spell check any information that you manually entered for
the user.

10. Click OK.

The dialog box for creating a web user closes and a message opens indicating that the
web user was created successfully.

11. Click OK to close the message and return to the group-specific window.

If you leave the Find field blank, then a list of all currently active groups for the 
selected group type is displayed. If you enter a search string in the Find field, the 
string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and the string must begin with the information for which 
you are searching. For example, AAA returns AAA Colorado, but not Colorado 
AAA.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and the string must begin with the information for which 
you are searching. For example, if searching by Email Address, a search string 
of bob returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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Editing Group Information

You can edit any and all information for a group. The way that you edit the information 
depends on the information itself. You can edit the Summary information, the Billing 
information, and the Other information through the Edit function on the group-specific 
dialog box. You must edit the group’s contacts, reminders, comments, attachments, UDFs, 
calculations, billing reference numbers, PO numbers, and web users on the group-specific 
window.

To edit group information

1. Open the Groups window and search for the group for which you are editing the
information. See “To search for a group and/or contact” on page 255.

2. Select the group, and then click Open to open the group in the group-specific window.

The group is selected by default. The Summary tab is the active tab.

Figure 6-20: Group-specific window

3. Continue to one of the following:

• “To edit summary, billing, and/or other group information” on page 287.

• “To edit the contacts for a group” on page 287.

• “To edit the reminders for a group” on page 288.

• “To edit the comments for a group” on page 288.

• “To edit the attachments for a group” on page 289.
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• “To the edit user defined fields (UDFs) for a group” on page 290.

• “To edit the calculations for a group” on page 290.

• “To edit the billing reference numbers for a group” on page 291.

• “To edit the PO numbers for a group” on page 291.

• “To edit the web users for a group” on page 292.

To edit summary, billing, and/or other group information

1. To edit the summary information, billing information, and/or other information for the
group, click Edit.

The group-specific dialog box opens.

2. Open the appropriate tab, and then edit the information as needed.

See Step 3 and Step 4 of “To configure groups” on page 257.

3. After you edit the information, click OK.

The group-specific dialog box closes. You return to the group-specific window with the
group still selected.

To edit the contacts for a group

1. In the left pane of the group-specific window, select Contacts.

A list of all contacts that are currently configured for the group is displayed in the right
pane of the window.

2. In the right pane of the window, select the contact that you are editing, and then do one
of the following:

• To set the selected contact as the default contact for the group, click Set Default, and
then click Yes at the prompt.

• To edit the information for the contact, click Edit.

The Contact dialog box opens. The dialog box displays the information for the
selected contact.

3. Edit the information for the contact as needed. See “To configure a contact manually” on
page 279.

4. Click OK.

The Contact dialog box closes. You return to the group-specific window with Contacts
still selected.
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To edit the reminders for a group

1. In the left pane of the group-specific window, select Reminders.

A list of all reminders that are currently configured for the group is displayed in the right
pane of the window.

2. In the right pane of the groups-specific window, select the reminder that you are editing,
and then click Edit.

The Reminder dialog box opens. The Reminder tab is the active tab.

3. Do any or all of the following to edit the reminder as needed:

• On the Reminder Type dropdown list, select a different reminder type.

• Optionally, change the value for the Responsible User, the Date Due, or both.

• If you are completing the reminder today, select a Date Completed; otherwise, leave
this field blank.

• In the Notes field, enter any further explanation or information about the reminder.

4. Optionally, click Spelling to spell check the edited reminder before you save it.

5. Click OK.

The Reminder dialog box closes. The newly edited reminder is automatically selected in
the group-specific window.

To edit the comments for a group

1. In the left pane of the group-specific window, select Comments.

A list of all comments that are currently configured for the group is displayed in the right
pane of the window.

2. In the right pane of the group-specific window, select the comment that you are editing,
and then click Edit.

The Comment dialog box opens. The Comment tab is the active tab.

If you leave this field blank, then it is automatically populated when you or 
another user completes the reminder on the Reminders tab of the Dashboard 
window. See “To complete a reminder” on page 238.
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3. Do any or all of the following to edit the comment as needed:

• On the Comment Type dropdown list, select a different comment type.

• In the Notes field, enter or modify the comment.

• To alert any EMS user that opens this group that this comment has been added to the
group, select Alert Users.

4. Optionally, click Spelling to spell check the edited comment before you save it.

5. Click OK.

The Comment dialog box closes. The newly edited comment is automatically selected in
the group-specific window.

To edit the attachments for a group

1. In the left pane of the group-specific window, select Attachments.

A list of all attachments that have been added for the group is displayed in the right pane
of the window.

2. In the right pane of the group-specific window, select the attachment that you are editing,
and then click Edit.

The Attachment dialog box opens.

3. Do any or all of the following to edit the attachment as needed:

• Edit the description for the attachment.

• On the Type dropdown list, select a different attachment type.

• Click the Search icon  to open the Find Attachment dialog box, and then browse 

to and select a different attachment.

• If you left the Description field blank, then the name of the attached file is used by
default for the file description, and you can edit this if needed.

4. Optionally, click Spelling to spell check the edited attachment before you save it.

If none of the pre-configured comment types meets your working needs, select 
(user specified comment), and then in the Description field, enter a description for 
the comment type.The description can be a maximum of 30 characters, including 
spaces.

The description can be a maximum of 50 characters, including spaces. If you 
leave this field blank, then the Description field is populated with the name of the 
file after you attach it to a group.
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5. Click OK.

The Attachment dialog box closes. The newly edited attachment is automatically
selected in the group-specific window.

To the edit user defined fields (UDFs) for a group

1. In the left pane of the group-specific window, select User Defined Fields.

All user defined fields that are currently configured for the group are displayed in the
right pane of the group-specific window.

2. In the right pane of the group-specific window, select the UDF that you are editing, and
then click Edit.

The User Defined Field dialog box opens. The User Defined Field tab is the active tab.

3. Do one or both of the following to edit the UDF:

• On the Field dropdown list, select a different UDF.

• In the value field, edit the value for the UDF.

4. Click OK.

The User Defined Field dialog box closes. The newly edited UDF is automatically
selected in the group-specific window.

To edit the calculations for a group

1. In the left pane of the group-specific window, select Calculations, and then click Edit.

The Calculations dialog box opens.

2. Do one or both of the following:

• On the Available list, select the calculation, or CTRL-click to select the multiple
calculations that are to always apply to this group, and then click the Move button
(>) to move the selected calculations to the Selected list.

• On the Selected list, select the calculation, or CTRL-click to select the multiple
calculations that are not to apply to this group, and then click the Remove button (<)
to move the selected calculations to the Available list.

3. Click OK.

The Calculations dialog box closes. You return to the group-specific window with
Calculations still selected.
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To edit the billing reference numbers for a group

1. In the left pane of the group-specific window, select Billing References.

2. In the right pane of the window, select the billing reference number that you are editing,
and then click Edit.

The Billing Reference dialog box opens. The dialog box displays the information for the
selected billing reference number.

3. Edit the information for the billing reference number as needed.

4. Optionally, click Spelling to spell check the information for the billing reference number
before you save it.

5. Click OK.

The Billing Reference dialog box closes. You return to the group-specific window with
Billing References still selected.

To edit the PO numbers for a group

1. In the left pane of the group-specific window, select PO Numbers.

2. In the right pane of the window, select the PO number that you are editing, and then click
Edit.

The PO Number dialog box opens. The dialog box displays the information for the
selected PO number.

3. Edit the information for the PO number as needed.

Option Description

Billing Reference The billing reference number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the billing reference number.

Notes Any other comments or statements that are applicable for the billing 

reference number.

Inactive Leave this option blank to add the reference as an active reference (the 

billing reference number is to be available when a reservation is made 

for the group). Select this option to inactivate the billing reference 

number.

Option Description

PO Number The PO number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the PO number.
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4. Optionally, click Spelling to spell check the information for the billing reference number
before you save it.

5. Click OK.

The PO Number dialog box closes. You return to the group-specific window with PO
Numbers still selected.

To edit the web users for a group

When you edit the web users for a group, you can select additional web users for the group, 
or you can remove web users for the group. You cannot edit the web user itself, nor can you 
edit the delegates for a web user. 

1. In the left pane of the group-specific window, select Web Users.

2. In the right pane of the group-specific window, select the web user whom you are
editing, and then click Edit.

The Web Users dialog box opens.

3. Do one or both of the following:

• To add a new web user for the group:

• Leave the Find field blank, and then click Display to open a list of all currently
active web users. Select the web user, or CTRL-click to select multiple web
users, and then click the Move button (>) to move the selected web users to the
Selected list.

• In the Search By dropdown list, select the option by which to search (Email
Address or User Name) and then in the Find field, enter the string by which to
filter your search, and then click Display. Select the web user, or CTRL-click to
select multiple web users, and then click the Move button (>) to move the
selected users to the Selected list.

Notes Any other comments or statements that are applicable for the PO 

number.

Inactive Leave this option blank to add the PO number as an active number (the 

PO number is to be available when a reservation is made for the group). 

Select this option to inactivate the PO number.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and the string must begin with the information for which 
you are searching. For example, if searching by Email Address, a search string 
of bob returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.

Option Description
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• To remove a web user from a group, in the Selected field, select the user, or
CTRL-click to select the multiple web users that you are removing from the group,
and then click the Remove button (<) to move the selected web users to the
Available list.

4. After you edit the information, click OK.

The Web User dialog box closes. You return to the group-specific window with Web
Users still selected.
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Importing Groups

You can import groups into your EMS database from a tab-delimited text file. (See Import 
File Specification in the EMS Setup Guide for the file specifications.)

To import groups

1. On the EMS toolbar, click the Groups icon . 

The Groups window opens.

Figure 6-21: Groups window

2. Click Import.

The Open File dialog box opens.

3. Browse to and select the text file that lists the groups that you are importing.

A dialog box opens, indicating the number of groups that you are about to import, and
asking you if you want to continue.

4. Click Yes.

A message opens indicating that the import was successful.

5. Click OK to close the message and return to the Groups window.



295

 
Groups and Contacts

Working with Reservations for a Group

You have a variety of options for working with the reservations for a group. You can:

• Search for and make a reservation for a group from the Groups window.

• Search for and make a reservation for a group from the group-specific window.

• Search for reservations by group, and then open and view any existing reservations in the
Navigator for a group from the group-specific window.

• Reassign the reservations for a group or contact from the group-specific window.

In EMS Workplace, you can also make a group reservation from the Group Reservation 
window.

To work with reservations for a group

1. Open the Groups window and search for the appropriate group. See “To search for a
group and/or contact” on page 255.

2. On the Groups window, select the group, and then do one of the following:

• Click New Reservation at the top of the window to open the Reservation Wizard,
and then continue to “Making a Reservation Using the Reservation Wizard” on page
45.

• Click Open to open the group-specific window (the group is automatically selected
in the window), and then continue to one of the following:

• “To search for and view reservations by group from the  group-specific window”
below.

• “To search for and make a reservation for a group from the  group-specific
window” on page 296.

• “To reassign a reservation for a group from the group-specific window” on page
296.

To search for and view reservations by group from the 

group-specific window

1. In the left pane of the group-specific window, select Reservations.

All reservations that have been made for the group in your EMS database and that have a
date greater than or equal to the current day’s date are displayed in the right pane of the
group-specific window.

Optionally, to show all reservations that have been made for the group, click Show 
Old. 
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2. In the right pane of the group-specific window, select the appropriate reservation, and 
then click Open.

The reservation opens in the Navigator.

3. Continue to “The Navigator,” on page 77.

To search for and make a reservation for a group from the 

group-specific window

1. In the left pane of the group-specific window, select Reservations.

All reservations that have been made for the group in your EMS database and that have a
date greater than or equal to the current day’s date are displayed in the right pane of the
group-specific window.

2. Click New.

The Reservation Wizard opens.

3. Continue to “Making a Reservation Using the Reservation Wizard” on page 45.

To reassign a reservation for a group from the group-specific 

window

1. In the left pane of the group-specific window, select Reservations.

All reservations that have been made for the group in your EMS database and that have a
date greater than or equal to the current day’s date are displayed in the right pane of the
group-specific window.

2. In the right-pane of the group-specific window, select the appropriate reservation, or
CTRL-click to select multiple reservations, and then click Reassign.

The Reassign Group/Contact on Reservations dialog box opens. See Figure 6-22 on page
297.

Optionally, to show all reservations that have been made for the group, click Show 
Old. 

Optionally, to show all reservations that have been made for the group, click Show 
Old. 
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Figure 6-22: Reassign Group/Contact on Reservations dialog box

3. On the Group dropdown list, select the group to which you are reassigning the

reservation, or click the Search icon  to open the Groups window and search for the

group. See “To search for a group and/or contact” on page 255.

4. Optionally, edit any and/or all of the group information as needed.

Option Description

1st Contact

2nd Contact

The contact for the group to which you are reassigning the reservation.

Note: If none of the pre-configured contacts is appropriate, then select 

(temporary contact) and in the Temp Contact field, enter the name of the 

temporary contact.

Phone

Fax

Email Address

The phone, fax, and email address for the contacts for the group to which the 

reservation is being reassigned. If you selected from the list of the pre-configured 

contacts, then some or all of this information might be automatically populated, 

but you can still edit the values. If you selected a (temporary contact), then you 

must enter this information for the contact.

Web User The web user for the group. Initially, this field is set to (no change) which means 

that the web user for the group to which you are reassigning the reservation is to 

remain as is; however, if needed, you can click the Search icon  to open the 

Web Users dialog box and select a different web user.

• You can search by User Name or Email Address.

• To search a list of all available web users, leave the Search field in the Web

Users dialog box blank, and then click Display.

• To search for a specific web user, enter a search string in the Search field, and

then click Display.

Note: The string is not case-sensitive, but your search is limited to the exact 

order of characters in the string and the string must begin with the 

information for which you are searching. For example, if searching by 

Email Address, a search string of bob returns 

bobworth@emssoftware.com but not dbobbett@emssoftware.com.

Note: To return this field to the (no change) value at any time, click Reset.
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5. Click OK.

A Reassign Reservations message opens, asking you if it is OK to reassign the selected
reservations to the group.

6. Click Yes.

The Reassign Reservations message closes and a second Reassign Reservations message
opens, indicating the reservations were successfully reassigned.

7. Click OK.

The message closes, and the reassigned reservations are no longer displayed in the
group-specific window.

To make a group reservation from the Group Reservation window 

(EMS Workplace only)

1. On the EMS Workplace toolbar, click the Group Reservation icon .

The Group Reservation window opens. The Results tab is the active tab.

Figure 6-23: Group Reservation window

You might have to click Reservations in the left-pane of the group-specific window 
to refresh the display.
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2. Open the Filter tab, and search for the group for which you are making a reservation. See
“To search for a group and/or contact” on page 255.

3. Select the group for which you are making the reservation, and then click Reservation.

A dropdown list of the available Reservation Wizard templates opens.

4. Select the appropriate template.

The Reservation Wizard opens. The name of the group for which you are making the
reservation is displayed in the title bar of the Reservation Wizard. The Reservation
Wizard template that you selected is displayed on the Wizard Template dropdown list at
the top of the Reservation Wizard. (You can always select a different template if needed.)

Figure 6-24: Reservation Wizard with Wizard Template option

5. Continue making the reservation as you normally would. See “Making a Reservation
Using the Reservation Wizard” on page 45.

Depending on how your EMS administrator has configured the template that you 
selected, you might be prompted to select a reservation start date before the 
Reservation Wizard opens. 
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Emailing a Group

Whether your organization uses Microsoft Outlook or SMTP, you can always email an EMS 
group.

To email a group

1. Search for the group that you are emailing. See “To search for a group and/or contact” on
page 255.

2. Do one of the following:

• On the Groups window, select the group and then click Email.

Depending on how your system is configured, either a pre-addressed Outlook email
form or a pre-addressed SMTP email form opens. The To field is populated with the
email address that is defined for the group, but you can edit this value if needed. Go
to Step 4.

• On the Groups window, select the group, and then click Open.

The group-specific window opens. Go to Step 3.

3. On the group-specific window, make sure that the group is selected in the left pane, and
then click Email.

Depending on how your system is configured, either a pre-addressed Outlook email form
or a pre-addressed SMTP email form opens. The To field is populated with the email
address that is defined for the group, but you can edit this value if needed.

4. Complete and send the email as you normally would.

If your organization uses Microsoft Outlook, you can continue to use this email 
system to send emails to EMS groups; otherwise, to email an EMS group using the 
SMTP option, your user account must have an email address
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Printing and Exporting Group Information

You can print a variety of information for selected groups such as contact summary 
information, status exceptions, group import format information, and billing information, 
and you can also export a list of selected groups and the summary information for each group 
(type, name, address, and so on) to an Excel spreadsheet. 

To print group information

1. Search for the groups for which you are printing the information. See “To search for a
group and/or contact” on page 255.

2. On the Groups window, click Print.

A list with a variety of options for printing information for the groups that are currently
displayed in the Groups window opens.

Figure 6-25: Group print options

3. Select the information that you want to print for the displayed groups.

Option Description

List Opens an onscreen preview of all groups (group name, address, phone 

number, email address, pricing plan, and status) that are currently 

displayed in the Groups window. The groups are sorted by group type.

Contact Summary Opens an onscreen preview of all the contacts (group name, group 

phone number, contact name, and contact phone number) that have 

been configured for all the groups that are currently displayed in the 

Groups window.

Status Exceptions Opens an onscreen preview of a list of groups that is derived from all the 

groups that are currently displayed in the Groups window that have any 

status other than OK. The groups are sorted by group type.

Import Format Opens an onscreen preview of the required format for the tab-delimited 

file that is to be used when importing groups.
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Figure 6-26: Example of an onscreen preview of printed group information

To export a list of groups to an Excel spreadsheet

1. Search for the groups that are you exporting to an Excel spreadsheet. See “To search for
a group and/or contact” on page 255.

2. On the Groups window, click Export.

A Save As dialog box opens for naming the file and selecting the location in which to
save the file. (The file details the summary information—type, name, address, and so
on—for each group.) By default, the file is named Groups.xls, and the file location is
your Document Library, but you can change the name if needed, and you can also select
a different location in which to save the file. After you name and save the file, you have
the option of previewing the exported file.

Note: A variety of options are available from an onscreen preview, including the options to print a 

hard copy of the information, to export the information to a .pdf, and to email the printed 

information. See Figure 6-26 below.

Transaction Report See “Generating an EMS Billing Report” on page 394.

Statements See “Generating an EMS Billing Report” on page 394.

Voided Transaction 

Report

See “Generating an EMS Billing Report” on page 394.

Ageing Report See “Generating an EMS Billing Report” on page 394.

General Ledger 

Distribution

See “Generating an EMS Billing Report” on page 394.

Option Description

To preview the file, Microsoft Excel must be installed on your EMS client.
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Printing and Exporting Web User Information

You can print a variety of information for selected web users and you can also export a list of 
selected web users (name and email address) to an Excel spreadsheet. 

To print or export web user information

1. On the EMS menu bar, click Configuration > Web > Web Users.

The Web Users window opens. In the upper left hand corner, the number of web users
currently in use for VEMS is displayed.

Figure 6-27: Web Users window

2. Enter any combination of the following search criteria:

• On the Group Type dropdown list, leave the group type set to the default value of
(all), or select a specific group type.

• On the Search by dropdown list, select User Name or Email Address.

• On the Status dropdown list, select the user status by which to search.

• On the Process Template dropdown list, leave the default value of (all), or select a
specific web process template.
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3. To further filter the displayed search results do one or both of the following:

• To filter the search results based on either the User Name or Email Address, in the
Filter field, enter a search string.

• To filter the search results based on city, in the City field, enter a search string.

4. Click Display.

The web users who meet your search criteria are displayed in the lower pane of the Web
Users window.

5. Continue to one of the following:

• “To print web user information” below.

• “To export a list of web users to an Excel spreadsheet” on page 305.

To print web user information

1. On the Web Users window, click Print.

A list with a variety of options for printing information for the web users that are
currently displayed in the Web Users window opens.

Figure 6-28: Web User print options

2. Select the information that you want to print for the displayed web users.

For either field, the string is not case-sensitive, but your search is limited to the 
exact order of the characters in the string and it must begin with the information 
for which you are searching. For example, if searching by Email Address, a 
search string of bob returns bobworth@emssoftware.com but not 
dbobbett@emssoftware.com.

Option Description

List Opens an onscreen preview of a list of all the web users (web user 

name, email address, status, security template, process template, and 

last login) who are currently displayed in the Web Users window. The list 

is sorted alphabetically by web user name.

Web Delegates Opens an onscreen preview of a list of all the web delegates (delegate 

name, delegate email address, delegate status, web user, web user 

email address, and web user status) for all the active web users who are 

currently configured in your EMS database. The list is sorted 

alphabetically by web delegate name and then by web user name for 

web users that have multiple delegates.
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Figure 6-29: Example of an onscreen preview of the Web Delegates by Web User report

To export a list of web users to an Excel spreadsheet

On the Web Users window, click Export.

A Save As dialog box opens for naming the file and selecting the location in which to 
save the file. (The file contains the name and address for each web user that is currently 
displayed in the Web Users window.) By default, the file is named Web User List.xls, 
and the file location is your Document Library, but you can change the name if needed, 
and you can also select a different location in which to save the file. After you name and 
save the file, you have the option of previewing the exported file.

Web Delegates by Web 

User

Opens an onscreen preview of a list of all the web delegates (web user 

name, web user email address, web user status, delegate name, 

delegate email address, and delegate status) for all the active web 

users who are currently configured in your EMS database. The list is 

sorted alphabetically by web user name and if a web user has multiple 

delegates, the delegate is then sorted alphabetically by delegate name.

Note: A variety of options is available from an onscreen preview, including the options to print a 

hard copy of the information, to export the information to a .pdf, and to email the printed 

information. See Figure 6-29 below.

To preview the file, Microsoft Excel must be installed on your EMS client.

Option Description
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In EMS, a confirmation is a document that details the critical information for a reservation—
the date, the time, the location, the scheduled resources, and so on. You send a confirmation 
to the group who is sponsoring or hosting the event as verification that the reservation has 
been correctly set up—the time and location are correct, all the necessary resources have 
been scheduled, and so on. You can also use the confirmation to inform the group of any 
outstanding issues related to the reservation (such as a balance due) and to provide other 
information that is not necessarily reservation-specific such as your organization’s 
cancellation policies, your organization’s alcohol policies, and so on. You can generate a 
confirmation for all the bookings in a reservation, or just for a selected booking in a 
reservation. 

This chapter covers the following topics:

• “Specifying your Confirmation Settings” on page 308.

• “Generating a Single Confirmation at a Time” on page 311.

• “Generating Word Merge Documents for Custom Documentation” on page 316.

Remember, a fast way to view reservations is through the Reservation Book. See 
“Viewing and Editing Reservations in the Reservation Book” on page 62.

This chapter details the generation of a single confirmation at a time. To generate 
confirmations for multiple reservations in a single step, see “Generating Multiple 
Confirmations” on page 420.
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Specifying your Confirmation Settings

The Confirmation Settings dialog box provides a variety of options that you can specify for 
manual and automatic generation of a confirmation for a reservation or a booking. You can 
specify your confirmation settings one time and use these settings for all confirmations that 
you generate, or you can change the settings on as-needed basis and tailor them for each 
confirmation that you generate.

To specify your confirmation settings

1. Open a reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the upper right hand corner of the Navigator, click Settings > Confirmation Settings. 

The Confirmation Settings dialog box opens.

Figure 7-1:  Confirmation Settings dialog box

3. Specify the settings for your system’s confirmations.

Field Description

Date Range tab—The department name that appears at the top of a printed confirmation.

Buildings tab—Select the specific buildings that are to be included in the confirmation. 

Categories tab—Select the specific booking details that are to be included in the confirmation.
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Statuses tab—Select the specific statuses that are to be included in the confirmation. 

Options tab—Format settings for a printed confirmation.

Confirmation Title Appears bold and centered at the top of the printed confirmation.

Header Message

Footer Message

Pre-configured blocks of text that appear in the header and footer of the 

printed confirmation. 

Paper Size The size of the paper on which the confirmation is printed. Values are 

Letter, Legal, and A4.

Print Comments Include the comments for the reservation in the printed confirmation.

Print Reminders Include the reminders for the reservation in the printed confirmation.

Print Cancel Reasons Include the reasons for cancellation in the printed confirmation.

Print User Defined 

Fields

Include user-defined fields and their values in the printed confirmation. 

Print Room Phone Include the phone number for the room in which the event is being held 

in the printed confirmation.

Print Room Notes Include any notes for the room in which the event is being held in the 

printed confirmation.

Print Building Notes Include any notes about the building in the printed confirmation.

Print Billing Reference 

Allocation

Include the billing reference numbers for the event as well as the 

percentage of charges that is allocated to each number in the printed 

confirmation.

Print PO Allocation Include the PO numbers for the event as well as the percentage of 

charges that is allocated to each number in the printed confirmation.

Print Category 

Subtotals

Include the subtotal charges by category in the printed confirmation.

Print Room Type Include the room type for the event in the printed confirmation.

Print Item Selection 

Notes

Include the notes for each resource selection item for the event in the 

printed confirmation.

Suppress Reserved 

Time

Do not show the reserved time for the event in the printed confirmation.

Suppress Location Do not show the location for the reservation in the printed confirmation. 

Suppress Pricing Do not show the reservation’s room charges or resource charges in the 

printed confirmation.

Suppress Logo Do no show your organization’s logo in the printed confirmation.

Suppress Item Notes Do not show notes for any booking items in the printed confirmation.

Suppress Item Special 

Instructions

Do not show special instructions for any booking items in the printed 

confirmation.

Suppress Item 

Selections

Do not show any resource item selections in the printed confirmation.

Always Display Time 

Zone

Always show the time zone for the event in the printed confirmation.

Field Description



310

  
Confirmations

4. You can now generate a confirmation (manually or automatically) based on the settings
that you have specified. See “Generating a Single Confirmation at a Time” on page 311.

Display Messages as 

HTML

If you have defined any HTML messages, then select this option to 

display the HTML version of these messages in the printed 

confirmation; otherwise, the message is displayed in plain text.

Limit Bookings to Those 

With Details in Selected 

Categories

Show only those bookings in the printed confirmation that contain details 

for the categories that are selected on the Categories tab.

Email Options tab—Format settings for the body of an emailed confirmation.

Header Message

Footer Message

Pre-configured blocks of text that appear in the body of the emailed 

confirmation. 

Note: Your EMS administrator configures these values. Contact your 

administrator if you need assistance with adding or editing a 

value.

Email Format • None—Opens a blank email form.

• Detail—The confirmation appears in its entirety in the email body.

• Mobile Friendly—The confirmation appears in a condensed version

that is viewable on a mobile device.

• Summary—Only the booking information appears in the email body.

Attached Detailed 

Confirmation

The entire confirmation is provided as an attachment to the email.

Attach .ics file An .ics file is a file that a recipient can save to create an entry in his/her 

personal calendar. Select this option to attach an .ics file to the email.

Prompt for Res. 

Attachments

Select from a list of reservation-level attachments that you are including 

in the email.

Email To

Email CC

Select the users associated with the reservation who should receive the 

email confirmation.

Copies to Print The number of copies of the confirmation that are automatically printed 

if you print the confirmation. (Not applicable if you email a confirmation.)

Field Description
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Generating a Single Confirmation at a Time

You can generate a confirmation for all the bookings in a reservation, or just for a selected 
booking in a reservation. In the default implementation of EMS, when you request to 
generate a confirmation for a reservation or a booking, the Confirmation dialog box opens. 
The Confirmation dialog box has the same tabs as the Confirmation Settings dialog box. 
(Remember, the values that you specified on the Confirmation Settings dialog box determine 
the information that is included in a confirmation. See “Specifying your Confirmation 
Settings” on page 308.) It also contains options for generating a print preview of the 
confirmation and for manually printing or emailing an EMS-generated confirmation. If you 
want to automatically generate a printed or emailed confirmation according to your 
confirmation settings, then you must edit the Confirmation setting on the General tab of the 
Navigator Options dialog box.

To manually generate a single confirmation at a time

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the left pane of the Navigator, do one of the following:

• Select the reservation for which you are generating the confirmation.

• Select the reservation for which you are generating the confirmation, and then in the 
Bookings (lower right) pane, select the booking for which you are generating the 
confirmation.

3. Do one of the following:

• If you are generating a confirmation for a reservation, then open the Reservation 
Summary tab or Properties tab in the upper right pane of the Navigator, and then 
click Confirmation.

• If you are generating a confirmation for a selected booking, then open the Booking 
Summary tab in the upper right pane of the Navigator, and then click Confirmation.

The Confirmation dialog box opens. The dialog box has the same tabs as the 
Confirmation Settings dialog box with one exception, the Date Range tab. (Additional 
options are available on the Date Range tab that you can use to limit the confirmation to 
specific bookings and/or specific booking times.) It also has options for saving, or 
memorizing, the displayed confirmation settings so that you do not have to adjust the 
settings every time you generate the confirmation. When the dialog box first opens, the 
Setup is set to (user-specified). See Figure 7-2 on page 312.
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Figure 7-2:  Confirmation dialog box, Date Range tab

4. Do one of the following:

• Review the selections on this dialog box, and optionally, make any needed
modifications.

• On the Setup dropdown list, select a saved, or memorized, confirmation.

If you use specific times, then you must also click Options and indicate how the 
confirmation is to be limited—to bookings that start within the range or to 
bookings that occur within the time range. 

If needed, you can always save, or memorize, these settings. See “Working with 
Memorized Reports” on page 323.

If you select a memorized confirmation, then the only changes that you can make 
are to the dates and/or times on the Date Range tab.
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5. Do one of the following:

• To manually generate a printed confirmation, edit the number of copies to print as
needed in the Copies to Print field (the default value is 1), and then click Print.

A Print dialog box opens in which you can specify information such as the printer to
use, the page range, and so on. Click Print in this dialog box to manually generate
the printed confirmation.

• To manually generate an emailed confirmation, click Email.

See “Sending Email from EMS” on page 414.

Figure 7-3:  SMTP email window for a confirmation

Before you print the confirmation, you can click Print Preview to open an 
onscreen preview of the printed confirmation. A variety of options are available 
from this preview, including the options to email the confirmation, to export the 
confirmation to a .pdf, and to print the confirmation.

If you are using SMTP email, then Figure 7-3 below is an example of the SMTP 
email window that opens.



314

 
Confirmations

To automatically generate a confirmation

If you want to always automatically generate a printed or emailed confirmation based on 
your confirmation settings, then you must edit the Confirmation setting on the General tab of 
the Navigator Options dialog box.

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

2. In the upper corner of the Navigator window, click Settings > Options. 

The Navigator Options dialog box opens. The General tab is the active tab.

Figure 7-4:  Navigator Options dialog box, General tab
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3. Under Confirmation, select one of the following:

• Email—To always automatically generate an emailed confirmation based on your
confirmation settings.

• Print—To always automatically generate a printed confirmation based on your
confirmation settings.

4. Click OK to close the dialog box and return to the Navigator.

The next time you select any reservation or booking in the Navigator and click
Confirmation, the following happens:

• If your Navigator Options are set to Print, then a Print dialog box opens in which you
can specify information such as the printer to use, the page range, and so on. Click
Print in this dialog box to generate a printed confirmation that is based on your
confirmation settings.

• If your Navigator Options are set to Email, then see “Sending Email from EMS” on
page 414.

Figure 7-5:  SMTP email window for a confirmation

If you are using SMTP email, then Figure 7-5 below is an example of the SMTP 
email window that opens.
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Generating Word Merge Documents for Custom 

Documentation

EMS provides options for producing pre-formatted documents that contain reservation 
information such as confirmations. Your organization, however, might have 
organization-specific information that must be included in these documents. If your 
organization has purchased and implemented the optional Word Merge module, you can 
generate Word Merge documents to produce custom confirmations, contracts, and so on that 
contain not only selected reservation information from EMS, but also, any information that 
is required by your organization. Because these documents are generated in a Word format 
(.docx), you cannot print them or email them from EMS; however, you can manually print 
them and send them as an attachment in a email just as you would any other Word document.

To generate Word Merge Documents

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

2. In the left pane of the Navigator, do one of the following:

• Select the reservation for which you are generating the confirmation.

• Select the reservation for which you are generating the confirmation, and then in the 
Bookings (lower right) pane, select the booking for which you are generating the 
confirmation.

3. Do one of the following:

• If you are generating a confirmation for a reservation, then open the Reservation 
Summary tab or Properties tab in the upper right pane of the Navigator, and then 
click Confirmation.

• If you are generating a confirmation for a selected booking, then open the Booking 
Summary tab in the upper right pane of the Navigator, and then click Confirmation.

The Confirmation dialog box opens. The Date Range tab is the active tab. See Figure 7-6 
on page 317.
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Figure 7-6:  Confirmation dialog box, Date Range tab

4. At the top of the Confirmation dialog box, click Word Merge.

The Word Merge Documents dialog box opens. This dialog box displays all the Word
Merge documents that your EMS administrator has configured for your
organization-specific documents such as confirmations, contracts, and so on.

Figure 7-7:  Word Merge Documents window
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5. Select the appropriate Word Merge document, and then optionally, do one or both of the
following:

• To attach the document at the reservation-level for the selected reservation, click
Attach to Reservation.

• Select the attachment type.

6. Click Generate.

A message opens, indicating that the Word Merge was successful, and asking you if you
want to view the document.

7. Optionally, click Yes.

The document opens in Microsoft Word. You can now use any of the standard Word
functions to save the document, to print the document, attach the document to email, and
so on.

To save a copy of the document in your EMS database, you must either attach the 
document to the reservation, or you must open and view the document and save it 
as a Word document.
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EMS contains six different categories of general reports to assist you in monitoring and 
maintaining your organization’s reservation records and associated transactions. The 
application also contains a Query Builder function which you can use to define custom 
criteria for searching for information in your organization’s EMS database. 

This chapter covers the following topics:

• “Generating an EMS Report” on page 321.

• “Working with Memorized Reports” on page 323.

• “Report Descriptions and Options” on page 328.

• “Working with a Query” on page 348.

Reports that are specific for the Billing function in EMS are detailed in   
“Billing,” on page 361.
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Generating an EMS Report

All EMS reports are available under the Reports option on the menu bar. For any EMS 
report, you can specify the parameters, options, and format for the report, or you can 
generate the report according to memorized settings. Not all reports require the same 
parameters, nor do they all have the same options available. In addition, you can generate 
different reports in different formats.

To generate a report

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option
for the report that you are generating. For example, to generate the Event Schedule
report, click Reports > Daily > Event Schedule.

2. On the Setup dropdown list, do one of the following:

• To generate the report according to the filter settings that you specify (parameters,
options, and so on), leave (user specified) selected on the Setup list, and then go to
Step 3.

• To run the report with filter settings that have been saved, or memorized, select the
memorized report on the Setup list, and then go to Step 5.

3. On the Options list, select the Date/Time filter by which to generate the report.

4. Specify the report parameters, options, and format. See:

• “Daily reports” on page 329.

• “Sales reports” on page 334.

• “Statistics reports” on page 337.

• “Other reports” on page 340.

• “Exceptions reports” on page 342.

• “Hoteling reports (EMS Workplace only)” on page 345.

For detailed information about memorized reports, see “Working with Memorized 
Reports” on page 323.

For brevity and ease, the parameters and options that are available for each 
report are not discussed here. Instead, the options are discussed in “Report 
Descriptions and Options” on page 328. Billing reports are discussed in  
“Billing,” on page 361. Academic reports are discussed in  , 
“Academic Planning (EMS Campus),” on page 443. Contact your EMS 
administrator if you need assistance in generating any of these reports.
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5. Optionally, do one or more or all of the following:

• In the Report Comment field, enter a comment that is to be printed on the report.

• Click Print Preview.

A preview of the report opens onscreen.

• To print a hard copy of the report, specify the number of copies that you are printing,
and then click Print.

6. Click Close.

Unless you change the filter settings, all subsequent reports are generated and printed
according to the parameters and options that you have specified and in the format that
you specified. If you want to save certain settings so that you do not have to adjust the
filter settings every time you run the report, you can memorize the report. See “Working
with Memorized Reports” on page 323.

The comment can be a maximum of 255 characters, including spaces.
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Working with Memorized Reports

A memorized report is a report for which the filter settings have been saved, or memorized, 
so that you do not have to adjust the filter settings every time you run the report. You can 
create a memorized report “from scratch,” or you can copy an existing memorized report, 
and edit the filter settings as needed to create a new memorized report. If you are the owner 
of a memorized report, you can also edit the name of an existing memorized report and you 
can delete a memorized report.

To create a memorized report “from scratch”

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option
for the report that you are memorizing. For example, to memorize the Event Schedule
report, click Reports > Daily > Event Schedule to open the Event Schedule dialog box.

Figure 8-1:  Event Schedule report dialog box

2. On the <Report> dialog box, click Options, and then select the Date/Time filter by which
to generate the report.

3. Specify the report parameters, options, and format.

Although this topic is written from the perspective of reports, it is also applicable 
for working with memorized confirmations and invoices.
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4. On the <Report> dialog box, click Memorize.

The Memorize Report Setup dialog box opens.

Figure 8-2:  Memorize Report Setup dialog box

5. In the Description field, enter a name or description for the report.

6. If you are an administrative user, and the report is to be available to all users, then select
Public (Available to All Users); otherwise, if the report is to be available only to you (the
owner), then leave this option blank.

7. Click OK.

The Memorize Report Setup dialog box closes. You return to the <Report> dialog box.
The memorized report is now an option on the Setup dropdown list.

The description can be a maximum of 50 characters, including spaces.

If you are not an administrative user, then only your EMS administrator can make 
your memorized reports available to all users. Contact your EMS administrator 
for assistance.
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To create a memorized report by copying

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option
for the report that you are memorizing. For example, to memorize the Event Schedule
report, click Reports > Daily > Event Schedule to open the Event Schedule dialog box.

Figure 8-3:  Event Schedule report dialog box

2. On the Setup dropdown list, select the memorized report from which you are copying the
filter settings, and then click Copy.

The Memorize Report Setup dialog box opens. By default, the Description field
indicates that you are naming a copy of a memorized report.

Figure 8-4:  Memorize Report Setup dialog box

3. In the Description field, enter a name or description for the new memorized report.

The description can be a maximum of 50 characters, including spaces.
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4. If you are an administrative user, and the report is to be available to all users, then select
Public (Available to All Users); otherwise, if the report is to be available only to you (the
owner), then leave this option blank.

5. Click OK.

The Memorize Report Setup dialog box closes. You return to the <Report> dialog box.
The filter settings are populated with the settings for the memorized report.

6. Click Edit, and then edit the filter settings for the report as needed.

7. Click Memorize.

The memorized report is now an option on the Setup dropdown list.

To edit or delete a memorized report

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option
for the memorized report that you are editing. For example, to edit a memorized Event
Schedule report, click Reports > Daily > Event Schedule to open the Event Schedule
dialog box.

Figure 8-5:  Event Schedule report dialog box

If you are not an administrative user, then only your EMS administrator can make 
your memorized reports available to all users. Contact your EMS administrator 
for assistance.
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2. On the <Report> Setup dialog box, click Setups.

The Memorized Report Setups dialog box opens. This dialog box lists all the memorized
report setups for which you are the owner, and therefore can edit the name and/or delete
the report.

Figure 8-6:  Memorized Report Setups dialog box

3. Select a memorized report setup, and then do one of the following:

• To edit the name of the report, click Edit to open the Memorize Report Name dialog
box, and edit the name of the report in the Description field.

• To delete the report, click Delete, and then click Yes in the message that asks you if
you are sure that you want to delete the selected report.

Administrative users can edit and delete all memorized reports in the system. See 
Managing Memorized Reports in the EMS Setup Guide.

The description can be a maximum of 50 characters, including spaces.
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Report Descriptions and Options

This section provides a description of every EMS report in the categories listed below and it 
also defines the options that are available for each report.

See:

• “Daily reports” on page 329.

• “Sales reports” on page 334.

• “Statistics reports” on page 337.

• “Other reports” on page 340.

• “Exceptions reports” on page 342.

• “Hoteling reports (EMS Workplace only)” on page 345.
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Daily reports

Report Description Options

Event Schedule A summary of the events that are scheduled at 

your facility, sorted by date and event start time. 

The report shows event start and end time, group 

name, event name, and location. You typically 

print and post the Event Schedule in a lobby or 

entry way to help visitors find their events.

• Use Page Breaks - If the report is run across multiple days, then

each day starts on a new page.

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

• Show Holidays—Displays any holidays that are configured in the

EMS database on the report.

• Show Building Hours—Displays building hours on the report.

• VIP Events Only—Only the events that are marked as a “VIP” are

displayed in the report.

• Use Calendar Styles: Events are displayed in the font/color of the

Calendar Style that is associated with each event.

Event Calendar A chronological list of scheduled events in a wall 

calendar format. 

• Use Calendar Styles—Events are displayed in the font/color of the

Calendar Style that is associated with each event.

• Weekly Calendar—One week per page is displayed in the report.

• Show Adjacent Calendar Days—Works in conjunction with the

Weekly Calendar option to display events that occur on Saturday and

Sunday in the report.

• Grey Out Adjacent Calendar Days—Works in conjunction with The

“Show Adjacent Calendar Days” option to display events that occur

on adjacent days in gray instead of in black.

• Hide Holidays—By default, holidays are displayed on the Daily

Calendar Report. Select this option to hide holidays in the report.

• By Room—Displays events one room at a time in a calendar view.
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Room Cards A list of events that is designed to be posted 

outside a room or event space. The report notes 

the date, event time, and location for events, as 

well as the group sponsoring each event. The 

report can be a single list of all events that are 

scheduled for the room on a particular date, or it 

can be a single page per event. 

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

• Print Blank Room Cards—Prints a room card for a space that does

not have any events scheduled.

• Print Logo—Prints the facility logo on each room card. You can

specify the logo location on the right or left side of the room card.

• Sort Room Cards By Book Sequence—If Book Sequencing is being

used on Room Configuration, then a facility can print room cards in

the Book Sequence order.

• Print Combo Room Components—Prints an individual room card for

each component of a combo room.

• Suppress End Time—Do not show the end times for bookings in the

report.

Activity Schedule A list of bookings in all rooms in a building, or just 

in a specific room in the building. The report, 

which shows event start and end times, event 

name, group name and room, can be generated 

for a range of dates. The report can generated in 

one of two formats—by Date or by Building.

• Use Page Breaks—A new page is generated for each date or for

each building.

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

Report Description Options
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Setup Worksheet An internal report that sets up crews, custodial, or 

operations personnel use to ensure that each 

room is arranged properly for each event. The 

report displays detailed information about each 

booking, including setup type, setup notes, 

required resources, user defined fields, special 

instructions and resource item notes.

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

• Limit Bookings To Those With Details In Selected Categories—Only

bookings with a booking detail from the specified categories are

displayed in the report.

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

• Keep Detail Together—If an event has booking details, then the

details are kept together on one page instead of being split across

two pages.

• Show Holidays—Holidays are displayed in the report.

• Show Building Hours—Building hours that are associated with each

building are displayed in the report.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

• Show User Defined Fields—Any user defined fields and their

answers for a reservation are displayed in the report.

• Show Booking Changes Only—Bookings that have been edited

within the specified number of days are displayed in the report.

Report Description Options
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Service Order Schedule Lists the service orders that are scheduled for a 

date or date range. Produced by category. 

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

• Show Details—Booking item details that associated with each event

are displayed in the report.

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report

• Show Pricing—Any pricing that is associated with an item is

displayed in the report.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

Service Orders Separate pages for each service order in a date 

range. The report provides information on the 

event and the items or services needed. 

Produced by category. 

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

• Footer Message—Used to specify the Footer message that is

displayed on each page of the report.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

Report Description Options
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Banquet Event Order Separate pages for each booking that occurs on 

a date or within a date range that has the 

“Primary Category” specified. Service orders, 

resource information, notes, and information for 

resource with order type categories are included 

in the report. 

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

• Show Pricing—Any pricing that is associated with an item is

displayed in the report.

• Limit Bookings To Those With Details In Selected Categories—Only

bookings with a booking detail from the specified categories are

displayed in the report.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

• Show Item Selection Notes—Any notes that have been entered for a

booking detail item selection are displayed in the report.

• Show Service User Defined Fields—Any user defined questions and

their answers for any listed category are displayed in the report.

• Set Page Numbers By Booking—Resets page number for every

unique booking.

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

Resource Schedule Lists by category and date, how many of each 

resource item is needed, as well as the event 

time, event name, location, and group. 

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

• Show Overbooked Resources Only—Only those bookings where the

selected resource exceeds the number available in inventory at that

time are displayed in the report.

Report Description Options
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Sales reports

Service Order Change 

Report

List the service orders to which a change has 

been made by Booking/Service Order ID. 

Includes the service order category, a description 

of the change, the old value for the service order, 

the new value for the service order, the date of 

the change, and the ID for the user who made the 

change.

N/A

Attendee Visitor Report Lists the attendees for an event by date or date 

range, and indicates whether they are visitors 

and shows their group name, phone number, 

event name, the room they will be in, and the 

start and end times for their event.

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

Production Report Lists production items and their quantities 

grouped by production area.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

• Show Item Selections—Any selections that have been entered for a

booking detail item are displayed in the report.

Report Description Options

Report Description Options

Sales by Group Type Lists the sales for each group type for a date or 

date range.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.
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Sales by Group Lists the sales for each group, divided by group 

type, for a date or date range.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Sales by Category Lists the revenue generated by each resource 

category for a date or date range.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Sales by Resources Lists the sales for each resource item for a date 

or date range.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Sales by Reservation Lists the reservations that have bookings for a 

specified date or date range and shows the 

charges, by category, for the reservation. Also 

gives a grand total for all reservations. If a 

reservation also has bookings that fall outside the 

specified date or date range, these figures are 

not included in the report.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Sales by Billing 

Reference

Lists the total sales for a date or date range, 

based on the billing reference number on the 

reservations that have bookings in the specified 

range. Sales that are associated with 

reservations that have no billing reference 

number are not included in the report.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Report Description Options
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Sales by Booking Lists the sales for a particular date or for each 

date in a date range, broken down by booking. 

This report displays the following information—

Start/End Times, Group, Event Name, Location, 

Billing Reference#, PO Number, Payment Type, 

Status, Reservation ID, Booking ID, and Sales 

amount.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Status Changes by 

Reservation

Lists the sales that are associated with a 

reservation where the reservation or booking 

status was changed.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Status Changes by 

Booking

Lists the sales that are associated with bookings 

where the bookings status was changed.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Report Description Options



 
Reports and Queries

337

Statistics reports

All Statistics reports, except Hourly Room Utilization and Hourly Resource Inventory Utilization, provide an “Analyze” 
feature to view data. Click Analyze to open a Browser window that displays the queried data. You can group the information 
by column, you can export the raw data to an Excel file, and you can click Details to provide more detailed information about 
the queried data. 

The Room Utilization report, the Hourly Room Utilization report, and the Hourly Room Utilization report are 
available only in EMS Enterprise. They are not available in EMS Professional.

Report Description Options

Room Statistics Lists all rooms by building and for each room, 

indicates the following information—the number 

of bookings for the date range selected, the 

reserved hours, the event hours, the estimated 

attendance (i.e., setup count), and the actual 

attendance.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

Room Utilization Lists the number of bookings, hours used, hours 

available, percent utilization, and hours vacant 

for rooms, by building, for the date range 

specified.

• Day Selection—Specify which day(s) of the week to include in the

report.

• Group By Utilization Category—Groups rooms by utilization (low,

high, unused).

• Include Cost—The cost for vacancies is displayed in the report.

• Include Unused—Include rooms that contain no bookings in the

report.

• Cap Utilization at 100%?—Percent utilization cannot exceed 100%.

• Low Utilization—Specify what percentage equals “Low” utilization.

• High Utilization—Specify what percentage equals “High” utilization.

• Availability Based On—Select to base availability on one of the

following - Building Hours, Hours per Day, or Specific Hours.

• Include Report Criteria—The filter settings for the report are

displayed in the report.
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Hourly Room Utilization Displays room utilization broken down by hours in 

the day, by percentage utilized. 

• Day Selection—Specify which day(s) of the week to include in the

report.

• Display Chart—Includes a chart on the final page of the report that

summarizes the reported data.

Hourly Resource 

Inventory Utilization

Displays resources, and the number of items 

used on an hourly basis for a specified date 

range.

• Day Selection—Specify which day(s) of the week to include in the

report.

• Display Chart—Includes a chart on the final page of the report that

summarizes the reported data.

Group Statistics Displays Number of Bookings, Reserved Hours, 

Event Hours, Estimated Attendance, and Actual 

Attendance by Group Type for a given date or 

date range. The format can be set to “Detail” to 

provide statistics for each specific group.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

Event Type Analysis Provides information by event type on the 

following—the number of reservations, the 

number of bookings, the percentage of total 

reserved hours, the percentage of total event 

hours, the percentage of total estimated 

attendance, the percentage of total attendance, 

the actual attendance, and the percentage of 

total.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Display Chart—Includes a chart on the final page of the report that

summarizes the reported data.

Reservation Source 

Analysis

Displays the number of reservations, the number 

of bookings with percentage, reserved hours with 

percentage, event hours with percentage, 

estimated attendance with percentage, and 

actual attendance with percentage by reservation 

source.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Display Chart—Includes a chart on the final page of the report that

summarizes the reported data.

Resource Statistics Lists the quantity and the hours used by category 

and by resource item.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Quantities—Includes all resources even if the resource is

not used during the date range specified.

• Show Inactive Resources—Includes all inactive resources used

during the date range specified.

Report Description Options
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Room Availability Provides a count of room availability by room 

type for a given date range.

N/A

Setup Count Analysis Lists the total number of bookings by setup count. N/A

Seat Occupancy Displays the capacity for each room, the number 

of bookings for the date range, the seats 

available for the bookings, the total estimated 

attendance based on setup count on each 

booking, the average estimated attendance, and 

the estimated percentage of seats filled for the 

specified date range.Figures are also provided 

for total actual attendance, average actual 

attendance, and actual percentage of seats filled.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

Benchmark Metrics 

Report

Compiles metrics for a number of different areas 

within EMS, for example, Rooms By Number of 

Bookings, Reservations By Source, and so on.

• Days Open Per Week—Indicates the number of days per week your

facility is open per week. The default value is 7.

• Hours Open Per Day—Indicates the number of hours per day that

your facility is open. The default value is 10.

Report Description Options
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Other reports

Report Description Options

Cancellation Report Lists the bookings that have a status that was 

changed to “Cancelled” on the date or dates 

specified, or lists the bookings on the date or 

dates specified that have a status type of 

“Cancelled.” The report also lists the date that the 

booking status was changed, the date the 

bookings were to have taken place, and the 

location of the event, the name of the person who 

canceled the booking, the reason for the 

cancellation, and the booking ID. You can run the 

report in one of two formats—by Booking Date 

(the date that the bookings were to occur) or by 

Cancel Date (the date that the bookings were 

canceled).

N/A

Cancellation Summary Summarizes, by reservation, all charges for 

bookings on a date or in a date range. The report 

shows the first and last bookings canceled within 

the reservation, the Group, the reservation 

number, the group contact, the event name, the 

event type, the total charges, and the reason for 

cancellation of the most recently canceled 

booking.   Reservations that do not have charges 

associated with the bookings are not displayed 

on this report. You can select Use Specific times 

and then enter a range of times to limit the report 

to bookings that occurred within this specified 

time range.

N/A
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Reservation Summary A summary of reservations that occurred within a 

specific date range. The report also lists 

complete reservation information (reservation 

number, event name, group, contact person, and 

so on) and booking dates. User defined fields can 

also be printed in this report. You can select Use 

Specific times and then enter a range of times to 

limit the report to reservations that occurred 

within this specified time range.

N/A

Report Description Options
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Exceptions reports

Report Description Options

Undefined Setups Lists the bookings on the selected date or date 

range for which no setup count has been 

entered. The report lists the following information 

for the bookings—the event name, time and 

location, contact name and phone number, 

booking status, and ID number. You can select 

Use Specific times and then enter a range of 

times to limit the report to bookings that occurred 

within this specified time range. You can enter 

information about the report, or a name or 

description for the report in the Report Comment 

field.

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

Status Reminder Report Lists the bookings that have a status with a 

reconfirm date that falls within the selected date 

range. You typically use the information in this 

report to review tentative bookings. The report 

can be run in one of two formats—by Status Date 

(the date that the event was put in a “Tentative” 

status) or by Booking Date (the actual date of the 

event). You can select Use Specific times and 

then enter a range of times to limit the report to 

bookings that occurred within this specified time 

range. You can enter a report name or 

description or any pertinent information about the 

report in the Comment field.

N/A
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Wait List Report Lists all the bookings with a Wait status for the 

time period that you have requested. Detects 

situations where a booking has been canceled 

and there are one or more bookings with a Wait 

status that can now be changed to Confirmed, 

and indicates if the room is available. You can 

select Use Specific times and then enter a range 

of times to limit the report to bookings that 

occurred within this specified time range. 

N/A

Booking Conflict 

Analysis

Reviews information on all bookings for a date or 

date range and lists any conflicts 

Note: EMS does not allow double-bookings, but 

they might exist because conversion of 

data from systems that do allow them, or 

the result of users failing to restart EMS 

after encountering error messages.

N/A

Building Hours 

Exceptions

Lists events for a date or date range that fall 

outside of the configured building hours. Either 

event time or reserved time is checked based on 

the “Validate Building Hours on Event Time” 

parameter. The report also shows the start and 

end times, group, event name, location, 

reservation number, and booking number. You 

can select Use Specific times and then enter a 

range of times to limit the report to bookings that 

occurred within this specified time range. You can 

enter information about the report, or a name or 

description for the report in the Report Comment 

field.

N/A

Report Description Options
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Inactive Room With 

Bookings

Lists the bookings for a specified date or date 

range that are scheduled in inactive rooms. You 

can select Use Specific times and then enter a 

range of times to limit the report to bookings that 

occurred within this specified time range. You can 

enter information about the report, or a name or 

description for the report in the Report Comment 

field. You can click View to open the booking for 

viewing and editing, changing the status of the 

booking and/or emailing the group.

N/A

Inactive Groups With 

Reservations

Lists the reservations for a specified date or date 

range that are scheduled for inactive groups. You 

can click View to go to the reservation for viewing 

and editing, including changing the status of the 

reservation and/or its bookings.

N/A

Invalid Service Orders Lists the service orders that have a start time 

and/or end time that fall outside the reserved time 

for the room. Lists the category, date, reserved 

and event start and end times, location, group, 

reservation number, booking number, service 

order number and a description of the invalid 

order. You can select Use Specific times and then 

enter a range of times to limit the report to 

bookings that occurred within this specified time 

range. You can enter information about the 

report, or a name or description for the report in 

the Report Comment field.

Note: Service orders that fall outside the 

reserved time are considered invalid even 

if the Validate Service Order Times 

Against Booking parameter is set to “No.”)

N/A

Report Description Options



 
Reports and Queries

345

Hoteling reports (EMS Workplace only)

Invalid Billing 

References

Lists the bookings for a particular date or date 

range that are in reservations that have invalid 

billing reference numbers. You can select Use 

Specific times and then enter a range of times to 

limit the report to bookings that occurred within 

this specified time range. You can enter 

information about the report, or a name or 

description for the report in the Report Comment 

field.

Note: A billing reference number is considered 

invalid if it has not been defined in the 

Billing Reference Configuration area but 

the Validate Billing Reference parameter 

is set to “Valid Only.”

N/A

Inactive Web Process 

Templates

Displays the inactive web process templates that 

are attached to reservations.

N/A

Report Description Options

Report Description Options

Room Occupancy 

Summary

Displays, by building and room type, the number 

and percentage of rooms occupied. 

N/A

No Show Lists the bookings for which the reservation 

holder did not check in. 

Note: A customer can be checked in via the 

EMS Kiosk, the EMS desktop client, or 

VEMS.

N/A
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Early Checkout Lists the bookings for which the reservation 

holder checked out before the end of the 

reserved time. 

Note: A customer can be checked out via the 

EMS Kiosk, the EMS desktop client, or 

VEMS.

N/A

Visitor Lists events for groups that have cities on their 

group record, other than what is specified in the 

Exclude Locations field. If multiple locations are 

to be listed, they should be entered with a comma 

between them (for example, Denver, Houston, 

Tampa, and so on).

N/A

Booking Notice 

Statistics

Lists the total bookings for a date or date range, 

divided into three “Amount of Notice” categories, 

where the Amount of Notice is the time between 

when the booking was scheduled and the date/

time for which it was scheduled. The report can 

be generated in one of two formats— “standard” 

or by room type.

N/A

Transition Tracks the occupants of hoteling spaces during a 

specified date range. Lists by floor and room 

where the occupant was last, what room the 

occupant is moving to, and who was in the space 

the previous day. Typically this report is run for a 

two day range and the days of the week must be 

checked. This report can be used by personnel 

who are responsible for preparing hoteling 

spaces for each occupant. 

• Show Details—Prints the categories that are associated with the

bookings.

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

Arrivals and Departures Lists the departures and arrivals for a particular 

room by building and floor. The report shows the 

time of the departure if the customer is a 

departure and the time of the arrival if the 

customer is an arrival. Typically, this report is run 

for a two day timespan listing the departure date 

first and the arrival date second. 

N/A

Report Description Options
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Groups With Multiple 

Bookings

Lists groups that have multiple bookings for the 

date or date range specified. The information is 

organized by date, and lists the start and end 

times, the room, the room type, and the booking 

status for each booking.

N/A

Check In Statistics Lists the percentage of customers who have 

checked in by building, building-room type, or 

room type.    

Note: A customer can be checked in via the 

EMS Kiosk, the EMS desktop client, or 

VEMS.

N/A

Report Description Options
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Working with a Query

A query is the primary mechanism for retrieving information from a database. A query 
consists of questions that are presented to the database in a predefined format. A Query 
Builder function is available from the Reports menu. You can use this function to create 
queries for retrieving information from your EMS database. When you create a query, you 
can name and save the query so that you can run the query at any time that you choose. You 
can create a query from “scratch,” or you can create a query by copying an existing query 
and editing the copied query as needed. You can also edit a query, delete a query, and view 
and print a query.

To create a query 

1. On the EMS menu bar, click Reports.

The Reports menu opens.

2. On the Reports menu, click Queries.

The Queries menu opens. This menu always contains the Query Builder option. It also
contains options for any queries that have been previously defined in your EMS
database.

3. Click Query Builder.

The Query Definitions dialog box opens. The dialog box displays all the queries that
have been previously defined in your EMS database and that have a status of Active.

Figure 8-7:  Query Definitions dialog box

Optionally, to view all queries in your EMS database, regardless of status, under 
Show, click Inactive.
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4. Do one of the following:

• To create a query from scratch, click New.

• To create a query by editing an existing query, select the query that is to be edited,
and then click Copy.

The Query Builder Filter dialog box opens. The Query Builder Filter tab is the active tab. 
You use the options on this dialog box to name and define the query. 

Figure 8-8:  Query Builder Filter dialog box, Query Builder Filter tab

5. Enter or edit the needed information for the query. See:

• “Query Builder Filter tab” on page 350.

• “Display Fields tab” on page 351.

• “Filter tab” on page 353.

• “Sort tab” on page 354.

• “Chart tab” on page 355.

• “Users tab” on page 356.

6. Do one of the following:

• Click OK to close the Query Builder Filter dialog box and save the named query.
The named query is displayed on the Reports menu under the Queries option. You
can run this query at any later date when needed.

• Open the Results tab, and then click Preview to run the query immediately and view
the results on the tab. You can then click OK to close the Query Builder Filter dialog
box and save the named query. The named query is displayed on the Reports menu
under the Queries option. You can run this query at any later date when needed.
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Query Builder Filter tab

Figure 8-9:  Query Builder Filter dialog box, Query Builder Filter tab

1. On the Query Builder Filter tab, name and define the query.

Option Description

Filter Name Name of the query filter.

Note: The name can be a maximum of 50 characters, including 

spaces.

Filter Type The type of information that the filter is to capture. The Filter Type 

affects the items that are available on the Display Fields tab and the 

Filter tab. A Filter Type of Group allows you to capture address 

information that can be exported and subsequently used by other 

programs to create mailing labels.

Note: Only a single Filter Type, Reservation, is available in EMS 

Professional.

Display in Browser Available only for a Filter Type of Billing or Reservations. Select this 

option if the query that you are creating is to be available in the Browser.

Open in Navigator Available only if the Filter Type is Reservations and Display in Browser 

is selected. Indicate what the system should open in the Navigator when 

a user double-clicks on an item that is retrieved by the query.

Owner Available only to administrative users. 

Return First “xx” 

Number of Records

To limit the number of records that the query returns, select this option, 

and then enter the number of records in the field.

Inactive By default, a query is added as an active query. Select this option to 

inactivate the query.
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2. Continue with any other configuration for the query as needed, or do one of the
following:

• Click OK to close the Query Builder Filter dialog box and save the named query.
The named query is displayed on the Reports menu under the Queries option. You
can run this query at any later date when needed.

• Open the Results tab, and then click Preview to run the query immediately and view
the results on the tab. You can then click OK to close the Query Builder Filter dialog
box and save the named query. The named query is displayed on the Reports menu
under the Queries option. You can run this query at any later date when needed.

Display Fields tab

Figure 8-10: Query Builder Filter dialog box, Display Fields tab

1. Open the Display Fields tab, and then do one of the following:

• Select the field, or CTRL-click to select the multiple fields that are to be displayed in
the query results, and then click the Move button (>) to move the selected fields to
the Selected list.

• In the Field Search field, enter the string by which to filter your search for available
fields. Select the field, or CTRL-click to select multiple fields, and then click the
Move button (>) to move the selected fields to the Selected list.

The search is limited to the exact order of characters in the string, but the string is 
not case-sensitive and it can be found anywhere in the search results. For 
example, a search string of Add returns both Added By and Date Added. As you 
enter the search string, the Available Fields list is dynamically updated with a list 
of fields that meet the search criteria. 
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2. The fields are displayed in the query results in the order in which they are listed in the
Selected list. Optionally, to change the order of the fields, select a field and then click
Move Up/Move Down as needed.

3. Continue with any other configuration for the query as needed, or do one of the
following:

• Click OK to close the Query Builder Filter dialog box and save the named query.
The named query is displayed on the Reports menu under the Queries option. You
can run this query at any later date when needed.

• Open the Results tab, and then click Preview to run the query immediately and view
the results on the tab. You can then click OK to close the Query Builder Filter dialog
box and save the named query. The named query is displayed on the Reports menu
under the Queries option. You can run this query at any later date when needed.

If you are copying an existing query, then when the Display Fields tab opens, the 
Selected list is already populated with a list of fields. You can select one or more of 
these fields, and then click the Remove button (<) to move these fields back to the 
Available list.
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Filter tab

Figure 8-11: Query Builder Filter dialog box, Filter tab

1. Open the Filter Fields tab, and then do one of the following:

• For each field that is to define the query, select the field, and then click the Move
button (>) to move the fields to the Filter Summary list.

• In the Field Search field, enter the string by which to filter your search for available
fields. For each field that is to define the query, select the field, and then click the
Move button (>) to move the fields to the Filter Summary list.

For each field that you select, a dialog box opens in which you must specify the allowed 
values for the field. After you specify the values and click OK, the dialog box closes, and 
the selected field is moved to the Filter Summary list.

The search is limited to the exact order of characters in the strings but the string is 
not case-sensitive and it can be found anywhere in the search results. For 
example, a search string of Contact returns both Contact Name and 1st Contact. 
As you enter the search string, the Available Fields list is dynamically updated 
with a list of fields that meet the search criteria.

If you are copying an existing query, then when the Filter Summary tab opens, the 
Filter Summary list is already populated. You can select one or more of these 
fields and then click the Remove button (<) to move these fields back to the 
Available list. If you want to use the same Filter Summary fields in the “new” 
query, but with different values, you cannot change the values directly. You must 
move the appropriate fields back to the Available list, then select the fields again 
to change their values.
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2. Continue with any other configuration for the query as needed, or do one of the
following:

• Click OK to close the Query Builder Filter dialog box and save the named query.
The named query is displayed on the Reports menu under the Queries option. You
can run this query at any later date when needed.

• Open the Results tab, and then click Preview to run the query immediately and view
the results on the tab. You can then click OK to close the Query Builder Filter dialog
box and save the named query. The named query is displayed on the Reports menu
under the Queries option. You can run this query at any later date when needed.

Sort tab

Figure 8-12: Query Builder Filter dialog box, Sort tab

1. Open the Sort tab, select the field or CTRL-click to select the multiple fields by which
the query results are to be sorted, and then click the Move button (>) to move the fields
to the Selected list.

2. Continue with any other configuration for the query as needed, or do one of the
following:

• Click OK to close the Query Builder Filter dialog box and save the named query.
The named query is displayed on the Reports menu under the Queries option. You
can run this query at any later date when needed.

• Open the Results tab, and then click Preview to run the query immediately and view
the results on the tab. You can then click OK to close the Query Builder Filter dialog
box and save the named query. The named query is displayed on the Reports menu
under the Queries option. You can run this query at any later date when needed.
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Chart tab

Figure 8-13: Query Builder Filter dialog box, Chart tab

1. Open the Chart tab, and specify the type of chart that is to be used to graph the query
results.

2. Manually enter any information for the chart (for example, Chart Title) as needed.

3. Optionally, do one or both of the following:

• To show a legend with the chart, select Show Legend, and then specify the legend
information (alignment, header, footer, and marker style and size).

• To spell check any charting information that you manually entered, click Spelling.

4. Continue with any other configuration for the query as needed, or do one of the
following:

• Click OK to close the Query Builder Filter dialog box and save the named query.
The named query is displayed on the Reports menu under the Queries option. You
can run this query at any later date when needed.

• Open the Results tab, and then click Preview to run the query immediately and view
the results on the tab. You can then click OK to close the Query Builder Filter dialog
box and save the named query. The named query is displayed on the Reports menu
under the Queries option. You can run this query at any later date when needed.
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Users tab

Figure 8-14: Query Builder Filter dialog box, Users tab

1. Open the Users tab, and in the Available list, select the user, or CTRL-click to select the
multiple users who can run this query, and then click the Move (>) button to move the
selected users to the Selected list.

2. Continue with any other configuration for the query as needed, or do one of the
following:

• Click OK to close the Query Builder Filter dialog box and save the named query.
The named query is displayed on the Reports menu under the Queries option. You
can run this query at any later date when needed.

• Open the Results tab, and then click Preview to run the query immediately and view
the results on the tab. You can then click OK to close the Query Builder Filter dialog
box and save the named query. The named query is displayed on the Reports menu
under the Queries option. You can run this query at any later date when needed.

The ability to assign specific queries to specific users is available only in EMS 
Enterprise. It is not available in EMS Professional.

By default, all administrative users can run any query that any user creates. These 
users are listed in the Administrative list. You cannot remove any administrative 
users from this list.
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To edit a query

1. On the EMS menu bar, click Reports.

The Reports menu opens.

2. On the Reports menu, click Queries > Query Builder.

The Query Definitions dialog box opens. The dialog box displays, by name, any queries
that have been previously defined in your EMS application. See Figure 8-7 on page 348.

3. Select the query that you are editing, and then click Edit.

The Query Definitions dialog box opens. All of the tabs are populated with the
information for the selected query.

4. Edit the query as necessary including one or more of the following:

• Renaming the query.

• Changing the fields that are to be displayed in the query results.

• Changing the fields that define the query.

• Changing the order of the fields by which the query results are to be sorted.

• Changing the charting options for the query results.

• Changing the users who can run the query.

5. Do one of the following:

• Click OK to close the Query Builder Filter dialog box and save the edited query. The
edited query is displayed on the Reports menu under the Queries option. You can run
this query at any later date when needed.

• Open the Results tab, and then click Preview to run the query immediately and view
the results on the tab. You can then click OK to close the Query Builder Filter dialog
box and save the edited query. The edited query is displayed on the Reports menu
under the Queries option. You can run this query at any later date when needed.

To delete a query

1. On the EMS menu bar, click Reports.

The Reports menu opens.

2. On the Reports menu, click Queries > Query Builder.

The Query Definitions dialog box opens. The dialog box displays any queries that have
been previously defined in your EMS application. See Figure 8-7 on page 348.

3. Select the query that is to be deleted, and then click Delete.

A message opens, asking you if it is OK to delete the selected query.
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4. Click Yes.

The message closes. The query is deleted.

To view and print a query

1. On the EMS menu bar, click Reports.

The Reports menu opens.

2. On the Reports menu, click Queries > Query Builder.

The Query Definitions dialog box opens. The dialog box displays any queries that have
been previously defined in your EMS application. See Figure 8-7 on page 348.

3. Select the query that is to be printed, and then click Print.

An onscreen preview of the selected query opens. A variety of options are available from
this preview, including the options to print a hard copy of the query, to email the query,
and so on.

Figure 8-15: Print preview for a query

4. Select the option or options that best fit your working needs.
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To run a query

When you run a saved query, you can run the query from the Reports menu, or you can run 
the query from the Query Definitions dialog box.

1. On the EMS menu bar, click Reports and on the Reports menu, click Queries, and then
do one of the following:

• Click the name of the query that you are running.

• Click Queries > Query Builder and on the Query Definitions dialog box, select the
query that you are running, and then click Run.

The query is run and the results are displayed onscreen in the Query Results dialog box.

Figure 8-16: Query Results dialog box example

2. Optionally, on the Query Results dialog box, do one or more of the following, and then
click Get Data to rerun the query according to the edited definition.

• Select the date for which the data in your EMS database is to be queried.

The Results (lower) pane on the Query Results dialog box is an EMS browser 
window. See “An EMS Browser Window” on page 35 for all the features that are 
available for this pane.

Option Description

Custom The starting date is set to the first day of the month and the ending date 

is set to the last day of the month but you can edit one or both of these 

dates. 

Note: For some queries, if you select Custom, a Use Specific Times 

option becomes available. If you enter the same date for the 

starting date and ending date, you can select Use Specific 

Times, and then enter a starting time and ending time to query 

the data in specific time range on the same day.
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• Change the Starting Date, Ending Date, or both.

• In the Report Comment field, enter a comment that is to be printed on the query.

• Click Options and change the settings for specific room filter and/or the number of
records to return.

3. After you have run the query to your satisfaction, you can then do one or both of the
following:

• To print the query results, click Print. An onscreen preview of the query results
opens. A variety of options are available from this preview, including the options to
print a hard copy of the query results, to export the query results to a .pdf, and to
email the query results. Select the option or options that best fit your working needs.

• To export the query results to an Excel spreadsheet, or to an XML file, click Export,
and then click Excel or XML as appropriate.

Last Month The starting date is set to the first day of the previous month and the 

ending date is set to the last day of the previous month. 

Last Quarter

This Quarter

This Quarter To Date

Quarters are based on a calendar year:

• First quarter is 1/1 through 3/31.

• Second quarter is 4/1 through 6/30.

• Third quarter is 7/1 through 9/30.

• Fourth quarter is 10/1 through 12/31.

For example, if the current day’s date is 5/22/2012, and you select Last 

Quarter, then the starting date is set to 1/1/2012 and the ending date is 

set to 3/31/2012.

Last Year The starting date is set to 1/1 of the previous year, and the ending date 

is set to 12/31 of the previous year.

This month The starting date is set to the first day of the current month and the 

ending date is set to the last day of the current month. 

This Year The starting date is set to 1/1 of the current year, and the ending date is 

set to 12/31 of the current year.

This Year to Date The starting date is set to 1/1 of the current year, and the ending date is 

set to the current day’s date.

The comment can be a maximum of 255 characters, including spaces.

Option Description
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Accurate and timely billing is critical to ensuring a successful experience for organizations 
that schedule events at your facilities. EMS provides a variety of functions for working with 
invoices and transactions for reservations and bookings as well as reporting on this 
information. 

This chapter covers the following topics:

• “Overview of Billing in EMS” on page 363.

• “Working with Invoices” on page 364.

• “Searching for Transactions” on page 378.

• “Working with Transactions” on page 385.

• “Generating an EMS Billing Report” on page 394.

• “Report Descriptions and Options” on page 396.
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Overview of Billing in EMS

In EMS, at a high-level, billing is a two-step process:

• The first step is to generate invoices. (See “Working with Invoices” on page 364.) You
can generate invoices based on reservation number, date range, or both. For example, you
could generate invoices for all bookings in Reservation 1829 that occurred last month.
After you have generated the invoices, EMS tracks the amount due and the age of the
invoices.

• The second step to is process received payments using the Payment Entry function. (See
“Searching for Transactions” on page 378.) You can also use this function to enter
deposits made against a reservation before invoicing or booking and to enter adjustments.

Financial transactions in EMS are batched by department. For example, if a user who is a 
member of the Scheduling department applies a deposit to a reservation, then the deposit is 
shown on a confirmation only if the user who applied the deposit or other users in the 
Scheduling department print the confirmation. If a user in another department, for example, 
the Catering department, prints the confirmation, then the deposit is not shown on the 
confirmation. Similarly, invoices that are generated by a department are printed on the 
Ageing report only if the report is generated for the same department. If you invoice a 
reservation or one of its bookings, any deposit that was previously made on the reservation is 
then applied and is no longer shown on the confirmation. If you invoice an event, the event is 
locked and cannot be edited. You can edit the event only after you void the invoice. You 
cannot void an invoice if payments have been made against it. You must first void the 
payments. You can use an adjustment with a negative dollar amount to clean up your 
financial records. For example, you generate an invoice for $102 for a group and the group 
returns a check for $100. If you do not want to ask the group for a $2.00 check, an 
adjustment of “$2.00-” balances your books.

As part of this process, you can generate the Billing Worksheet report. (See 
“Generating an EMS Billing Report” on page 394.) You use this report to review 
the dollar amounts for the bookings for which you intend to create invoices. You 
can correct any discrepancies that you note in the report by editing the bookings 
or booking items in question.
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Working with Invoices

You can generate an invoice in EMS based on a specific booking date or date range, a 
reservation number, or both. For example, you can generate invoices for all bookings from 
May 1 through May 14, for all bookings in reservation number 22, or for all bookings in 
reservation number 22 that occurred between May 1 and May 14. You can generate multiple 
invoices for the same booking, with each invoice showing the charges for a different 
category (such as room charges on one invoice, catering charges on another invoice, and so 
on). This might be necessary in situations in which you must produce multiple invoices for 
the same booking if the departments within your organization bill separately for the services 
they provide. You can also reprint an invoice and void an invoice.

You can work with invoices for a single reservation, or you can batch process multiple 
invoices. If you want to work with invoices for a single reservation, you do so through the 
Transactions tab in the Navigator. If you want to work with a batch of invoices, you do so 
through the EMS Billing menu: Billing > Invoices > Invoicing.

To generate an invoice

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 79), and on the Transactions tab, click New > Invoice.

• On the EMS menu bar, click Billing > Invoices > Invoicing.

The Invoicing window opens.

Figure 9-1:  Invoicing window

Before you generate an invoice, you should generate the Billing Worksheet report. 
See “Generating an EMS Billing Report” on page 394.
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2. Do one of the following:

• Review the selections on this dialog box, and optionally, make any needed
modifications.

Field Description

Date Range tab

Department Select the department that is creating the invoices. The department 

name and address is printed at the top of the invoice. 

Note: This field is automatically populated if you have a default 

department assigned to your user account but you can select a 

different value if needed.

Reservation Number Automatically populated if you are generating an invoice from the 

Transaction tab; otherwise, enter a reservation number.

Starting Date

Ending Date

Automatically populated with the first (starting) booking date and the 

last (ending) booking date for the selected reservation when you are 

generating an invoice from the Transaction tab; otherwise, enter the 

date range of the bookings for which you are generating the invoice.

Use Specific Times If only a specific time for the bookings is to be invoiced (for example, 

the bookings are from 8 am to 5 pm and you want to invoice the 

booking from only 8 am to noon), then click Use Specific Times, and 

then enter a specific time period.

Invoice Date The default value is the current day’s date. You can leave this value as 

is, or enter a different date.

Due Date The system default value is 30 days from the current day’s date. (Your 

EMS administrator might have configured a different default value for 

this field.) You can leave in the field as is, or you can enter a different 

date.

Buildings tab/Categories tab/Statuses tab/Group Types tab

Open the appropriate tab on the window and select the buildings, resource categories, booking 

statuses, and group types that are to be invoiced. This information is displayed on the invoice.

Note: A Show Inactive option is available for both categories and statuses. Select this option to 

show inactive categories and statuses. You can select these inactive items as part of your 

filtering criteria.

Note: To select a building, category, and so on, select the item in the Available list (CTRL-click to 

select multiple items), and then click the Move button (>) to move the items to the Selected 

list. 

Options tab—Format settings for a printed confirmation

Header Message

Footer Message

Select the header message and footer message that is to be printed 

on the invoice. By default, the header and footer messages are 

printed on every page of the invoice. To print the header only on the 

first page of the invoice, clear the Print Header on Each Page option.

Currency Select the currency that indicates how a room or resources in a 

category should be charged.

Print Comments Include the comments for the reservation in the printed invoice.

Print Reminders Include the reminders for the reservation in the printed invoice.

Print User Defined Fields Include user-defined fields and their values in the printed invoice. 
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• On the Setup dropdown list, select a saved, or memorized, invoice.

3. Click Generate.

The generated invoices are displayed in the Invoicing dialog box. By default, invoices
with a zero balance are not shown.

Figure 9-2:  Invoicing dialog box with generated invoices

Suppress Reserved Time Do not show the reserved time on the printed invoice. (Instead, only 

the event time is included on the printed invoice.)

Print Item Notes Include the notes for any booking items in the printed invoice.

Print Zero Priced Items Include resources for which there was no charge in the printed 

invoice.

Print Item Selections Include any resource item selections in the printed invoice.

Print Header On Each 

Page

Include the selected Header message on each page of the printed 

invoice.

Suppress Logo Do not show your department’s/organization’s logo on the printed 

invoice.

Print Billing Reference 

Allocation

Include the billing reference numbers for the event as well as the 

percentage of charges that is allocated to each number in the printed 

invoice.

Print Category Subtotals Include the subtotal charges by category in the printed invoice.

Display Messages as 

HTML

If you have defined any HTML messages, then select this option to 

display the HTML version of these messages in the printed invoice; 

otherwise, the message is displayed in plain text.

If needed, you can always save, or memorize, these settings. See “Working with 
Memorized Reports” on page 323.

If you select a memorized confirmation, then the only changes that you can make 
are to the dates and/or times on the Date Range tab.

Field Description
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4. Optionally, you can do one or more of the following to work with the invoices that are
displayed; otherwise, if you are satisfied with the invoices, you can go to Step 5 to post
the invoice.

• To show zero balance invoices in the window, clear the Hide Zero Balances option.

• To preview an invoice, select the invoice, or CTRL-click to select multiple invoices,
and then click Preview.

An onscreen preview of the selected invoices opens. The preview is titled “Invoice
Preview” to distinguish the invoices from invoices that have been posted. The
invoices also do not have invoice numbers, which are not issued until you post the
invoices. The preview window contains options for printing a hard copy of the
invoices, for emailing the invoices (see “Sending Email from EMS” on page 414),
and so on. Select the option or options that best fit your working needs.

• To change the criteria for the invoices, click Filter to return to the Invoicing window
After changing the criteria, you can generate the invoices again.

Figure 9-3:  Onscreen preview of an in-progress invoice

5. To post an invoice, select the invoice (CTRL-click to select multiple invoices), and then
click Final.

A message opens warning you that you are about to post and print (#) invoices, and
asking you if want to continue.

6. Click Yes.

The message closes and an onscreen preview of the final invoices opens. The preview is
titled “Invoices” and each invoice has been issued an invoice number. The preview
window contains options for printing a hard copy of the invoices, for emailing the
invoices (see “Sending Email from EMS” on page 414), and so on. Select the option or
options that best fit your working needs. See Figure 9-4 on page 368.



368

 
Billing

Figure 9-4:  Onscreen preview of a posted invoice

After you generate and post an invoice, the message “Items have been invoiced” is displayed 
in red text on the Reservation Summary tab, the Booking Summary tab, and the <Booking 
Detail> Summary tab in the Navigator. The booking detail folder in which the invoiced items 
reside now has a green background in the Booking Details pane and the icon for each 
invoiced item also has a green background in the Items pane. Also, the invoice is 
permanently saved, and you cannot edit it. You can make changes to the balance due for a 
reservation only by creating an adjustment or by voiding the invoice and regenerating it after 
you edit the booking information. (Because invoiced bookings are locked and cannot be 
edited, you must void the invoice before you can edit the bookings.) 

To reprint an invoice

You can reprint both non-voided and voided invoices. You can reprint invoices for only one 
department at a time from the Billing area of EMS. Reprinting an invoice does not 
recalculate the invoice. The invoice is simply printed as it appeared when it was first 
generated. You can specify the invoices that you are reprinting, or you can search for 
invoices that meet specific criteria, and then select specific invoices to reprint from the list of 
search results. 

To specify invoices for reprinting

1. On the EMS menu bar, click Billing > Other > Reprint Invoices.

The Reprint Invoices dialog box opens. See Figure 9-5 on page 369.

To reprint invoices for one or more departments, you must select the reservation in 
the Navigator, open the Transactions tab and CTRL-click to select the multiple 
invoices that you are reprinting, and then use the Reprint option on the 
Transactions tab.
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Figure 9-5:  Reprint Invoices dialog box

2. In the Department field, select the department that generated the invoices.

3. In the Invoice No. field, enter the number of the invoice that you are reprinting, and then
click Add.

The invoice is displayed (by number) in the lower right Invoice pane.

4. Repeat Step 3 until you have added all the invoices that you are reprinting.

5. Leave the reprinting criteria set to their default values, or optionally, edit them as needed.

This field is automatically populated if you have a default department assigned to 
your user account but you can select a different value if needed.

Option Description

Invoices The invoice type that you are reprinting—Non Voided (the default value) 

or Voided.

Format Select the sort order for the reprinted invoices. The default value is By 

Reservation.

First Transaction Date

Last Transaction Date

Leave these values blank to reprint the invoice for all bookings; 

otherwise, enter the date range of the bookings for which you are 

reprinting the invoice.

Print Header on Each 

Page

Leave this option selected to print the invoice header on every page of 

the invoice.

Print Transactions Select this option to include any associated transactions (deposits, 

payments, and so on) in the reprinted invoice.
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6. Click OK.

An onscreen preview of the invoices opens. The preview is titled “Invoices.” The
preview window contains options for printing a hard copy of the invoices, for exporting
the invoices to a .pdf, emailing the invoice (see “Sending Email from EMS” on page
414) and so on. Select the option or options that best fits your working needs.

Figure 9-6:  Onscreen preview of an invoice selected for reprinting

To search for invoices to reprint

1. On the EMS menu bar, click Billing > Other > Reprint Invoices.

The Reprint Invoices dialog box opens.

Figure 9-7:  Reprint Invoices dialog box
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2. Enter the criteria to search for the invoices that you are reprinting.

As you enter the search criteria, the lower left Invoice pane is dynamically updated with
the invoices that meet the criteria. The Note column in this pane indicates if payments
have been made against the invoice.

3. Leave the reprinting criteria set to their default values, or optionally, edit them as needed.

4. In the lower left Invoice pane, select the invoice, or CTRL-click to select the multiple
invoices that you are reprinting, and then click the Move button (>) to move the selected
invoices to the lower right Invoice pane.

5. Click OK.

An onscreen preview of the invoices opens. The preview is titled “Invoices.” The
preview window contains options for printing a hard copy of the invoices, for exporting
the invoices to a .pdf, emailing the invoice (see “Sending Email from EMS” on page
414), and so on. Select the option or options that best fits your working needs. See
Figure 9-8 on page 372.

Field Description

Department The department that generated the invoice. You can search for invoices 

for reprinting as long as the invoices were generated by the same 

department. 

Note: This field is automatically populated if you have a default 

department assigned to your user account but you can select a 

different value if needed.

Invoices Select the type of invoice for which to search—Non Voided or Voided.

First Transaction Date

Last Transaction Date

You must enter at least a First Transaction date. By default, the Last 

Transaction date is set to the same date. You can change the Last 

Transaction date if needed.

Show Paid Invoices Leave this option selected to include paid invoices in the search.

Option Description

Format Select the sort order for the reprinted invoices. The default value is By 

Reservation.

Print Header on Each 

Page

Select this option to print the invoice header on every page of the 

reprinted invoice.

Print Transactions Select this option to include any associated transactions (deposits, 

payments, and so on) in the reprinted invoice.
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Figure 9-8:  Onscreen preview of an invoice selected for reprinting

To void an invoice

You can void an invoice only if the invoice has not been paid. If payments have been made 
against an invoice, you must first void the payments.You can void invoices for only one 
department at a time. When you void an invoice, the invoice is removed from the Ageing 
report and its associated bookings are unlocked. You can specify the invoices that you are 
voiding, or you can search for invoices that meet specific criteria, and then select specific 
invoices to void from the list of search results. 

To specify invoices to void

1. On the EMS menu bar, click Billing > Other > Void Invoices.

The Void Invoices dialog box opens. See Figure 9-9 on page 373.

You can also void an invoice from the Transactions tab when a reservation is 
selected in the Navigator. 
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Figure 9-9:  Void Invoices dialog box

2. In the Department field, select the department that generated the invoices.

3. In the Invoice No. field, enter the number of the invoice that you are voiding, and then
click Add.

Two results are possible:

• If payments have not been applied to the invoice, then a Void Reason dialog box
opens. Continue to Step 4.

Figure 9-10: Void Reason 

• If payments have been applied to the invoice, then an error message opens indicating
that payments have been applied to the invoice and it cannot be voided. You must
void the payments first before you can continue with voiding the invoice. See “To
void a transaction” on page 391.

4. Enter a reason for voiding the invoice, and then click OK.

The invoice is displayed (by number) in the lower right Invoice pane.

5. Repeat Step 3 and Step 4 until you have selected all the invoices from the same
department that you are voiding.



374

 
Billing

6. Do one of the following:

• To review an invoice before you void it, go Step 7.

• To void an invoice without reviewing it, go to Step 8.

7. Optionally, before you void a selected invoice, you can review it to ensure that it is
indeed an invoice that you want to void. In the lower right Invoice pane, select the
invoice, or CTRL-click to select multiple invoices, and then click Preview.

An onscreen preview of the selected invoices opens. The preview is titled “Invoices.”
The preview window contains options for printing a hard copy of the invoices, for
exporting the invoices to a .pdf, and so on. (See Figure 9-11 on page 374.) Select the
option or options that best fit your working needs. For example, before you void an
invoice, you might want to email a copy of the invoice to a colleague to confirm that the
invoice should be voided.

Figure 9-11: Onscreen preview of an invoice selected for voiding

8. In the lower right Invoice pane, select the invoice, or CTRL-click to select the multiple
invoices that you are voiding, and then click OK.

A message opens asking you if you are sure that you want to void the selected invoices.

9. Click Yes.

A message opens indicating that the invoices have been voided.

10. Click OK.

The message and the Void Invoices dialog box close. The Void column is set to Yes on
the Transactions tab for each of the voided invoices in the Navigator.
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To search for invoices to void

1. On the EMS menu bar, click Billing > Other > Void Invoices.

The Void Invoices dialog box opens.

Figure 9-12: Void Invoices dialog box

2. Enter the criteria to search for the invoices that you are voiding.

As you enter the search criteria, the lower left Invoice pane is dynamically updated with
the invoices that meet the criteria. The Note column in this pane indicates if payments
have been made against the invoice.

3. Select the invoice, or CTRL-click to select the multiple invoices that you are voiding,
and then click the Move button (>).

A Void Reason dialog box opens. See Figure 9-13 on page 376.

Field Description

Department The department that generated the invoice. You can search for invoices 

for voiding as long as the invoices were generated for the same 

department. You cannot void invoices from different departments.

First Transaction Date

Last Transaction Date

You must enter at least a First transaction date. The Last transaction 

date is optional.

Show Paid Invoices Leave this option selected to include paid invoices in the search. If you 

want to void an invoice against which payments have been made, then 

this reminder serves to prompt to you to first void the payments before 

you void the invoice. See “To void a transaction” on page 391.

Remember, you can select an invoice for voiding only if payments have not been 
applied to the invoice. 
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Figure 9-13: Void Reason 

4. Enter a reason for voiding the invoice, and then click OK.

The Void Reason dialog box closes. The invoices are displayed (by number) in the lower
right Invoice pane.

5. Do one of the following:

• To review an invoice before you void it, go Step 6.

• To void an invoice without reviewing it, go to Step 7.

6. Optionally, before you void a selected invoice, you can review it to ensure that it is
indeed an invoice that you want to void. In the lower right Invoice pane, select the
invoice, or CTRL-click to select multiple invoices, and then click Preview.

An onscreen preview of the selected invoices opens. The preview is titled “Invoices.”
The preview window contains options for printing a hard copy of the invoices, for
exporting the invoices to a .pdf, and so on. Select the option or options that best fit your
working needs. For example, before you void an invoice, you might want to email a
copy of the invoice to a colleague to confirm that the invoice should be voided.

Figure 9-14: Onscreen preview of an invoice selected for voiding
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7. In the lower right Invoice pane, select the invoice, or CTRL-click to select the multiple
invoices that you are voiding, and then click OK.

A message opens asking you if you are sure that you want to void the selected invoices.

8. Click Yes.

A message opens indicating that the invoices have been voided.

9. Click OK

The message and the Void Invoices dialog box close. The Void column is set to Yes on
the Transactions tab for each of the voided invoices in the Navigator.
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Searching for Transactions

A transaction in EMS can be one of four types—a deposit (deposit and damage deposit), a 
payment, an adjustment, or a refund. 

You can use the Browse Transaction function to search for any of these transaction types. 
The results are displayed in a list view. When you carry out a search in the for a transaction, 
you can carry out a basic search or an advanced search. A basic search is based on the basic 
information that you specify for a transaction when you first create it, such as the group to 
which the transaction applies, the department that generated the transaction, and so on. An 
advanced search is a field level search that is carried out the reservation level, the transaction 
level, or a combination of these. For example, in an advanced search, you can specify criteria 
as granular as the Bill To Contact at the reservation level. 

Transaction 

Type

Description

Deposit A deposit is the dollar amount paid in advance of a meeting or event before 

invoicing occurs. 

• A deposit is added to a reservation. After you invoice the reservation, all

outstanding deposits are applied to the invoice to reduce the balance due.

• A damage deposit is used to a collect a deposit that is not applied to an

invoice and therefore, does not reduce the balance due. Instead, if the

customer does not damage the room, any reserved equipment, and so on,

then you must return the damage deposit to the customer by voiding the

damage deposit transaction.

Payment A payment is the dollar amount that is applied to an invoice to reduce the 

balance due. A pre-payment is similar to a deposit and is applied to a 

reservation. 

Adjustment An adjustment is a modification that is made to the amount due on an existing 

invoice. For example, if you send out an invoice to a group for $202.00 and the 

group sends you a check for $200.00, you can make an adjustment of “$2.00-” 

to close out the invoice. 

Refund A refund is the return of funds that have been applied to an invoiced 

reservation. 

You can find all transactions for a reservation on the Transactions tab in the 
Navigator. See “Layout and folder structure” in  “The Navigator,” on page 77.
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To search for a transaction

1. On the EMS menu bar, click Billing > Other > Browse Transactions.

The Browse Transactions window opens. The first time that the Browse Transaction
window opens, the Filter tab is set by default to a basic search; otherwise, the Filter tab is
set to the search type (Basic or Advanced) that you last carried out.

Figure 9-15: Browse Transactions window, Basic search options

2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and
then continue to one of the following:

• “To carry out a basic transaction search.”

• “To carry out an advanced transaction search” on page 381.

To carry out a basic transaction search

1. Enter the search criteria.

Field Description

• Starting Time

• Ending Time

The date range during which the transactions were carried out. Both are 

optional. 

Group
Click the Search icon  to open the Groups window and search for a 

for the group for which the transactions apply. See “To search for a 

group and/or contact” on page 255.

Department Leave the default value set to (all) or select a specific department that 

generated/issued the transaction.
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2. Optionally, click Options and edit the default value the Number of Records to Return
search option.

3. Click Get Data or Refresh.

The search results are displayed on the Results tab.

Figure 9-16: Browse Transactions window, Results tab

Transaction Type Leave the default value set to (all), or select a specific transaction type 

for which to search.

Invoice Number If you are searching for a specific invoice or invoices, enter a search 

string.

Note: The search is not case-sensitive, but your search is limited to the 

exact order of characters in the string and it must begin with the 

information for which you are searching. For example, a search 

string of 10 returns 1000, 1017, but not 910.

Reservation ID Leave the default value set to 0 to search for a transaction regardless of 

reservation ID; otherwise, enter the exact value of the reservation ID.

Amount Leave the default value set to 0.00 to search for transactions regardless 

of the transaction amount; otherwise, enter the exact amount of the 

transaction.

Field Description
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4. Optionally, do one or more of the following:

• The lower pane on the Results tab is an EMS Browser window. See “An EMS
Browser Window” on page 35 for all the features that are available for this pane.

• Click Print to print the search results.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• Select a search result entry for an invoice, and then click Email to open a
pre-addressed SMTP email to the group that is associated with the invoiced
reservation. Complete and send the email as you would normally. (The invoice is
sent as an attachment.) See “Sending Email from EMS” on page 414.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

5. Click Close.

Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. If you want to reset the columns to their
default values, see “Resetting Column Settings” on page 408.

To carry out an advanced transaction search

Figure 9-17: Browse Transaction window, Advanced search options

1. Optionally, enter a Starting Date, an Ending Date, or both.
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2. Optionally, if the Starting Date and the Ending Date are the same, select Use Specific
Times and enter specific time periods to search.

3. For each field level option by which to carry out the search:

• Select the field level option, and then click the Move button (>).

• When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

Figure 9-18: Viewing a selected field option in the Filter Summary list

4. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, and Specific Room Filters.

5. Optionally, click Options and edit the default value the Number of Records to Return
search option.

Use Specific Times is available only if the Starting Date is the same as the Ending 
Date.

To filter the list of available fields, in the Field Search field, enter a search string. 
Your search is limited to the exact order of the characters in the string, but the 
string is not case-sensitive and it can appear anywhere in the search results. For 
example, a search string of type returns Type, Payment Type, and so on. 

If you have specific fields and/or values by which you always want to carry out a 
search, then you can set up these fields to be your Favorite fields. See 

To view a selected field option in its entirety in the Filter Summary list, rest the 
mouse pointer on the entry. A tooltip showing the complete field option 
information opens. 
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6. Click Get Data or Refresh.

The search results are displayed on the Results tab.

Figure 9-19: Browse Transactions window, Results tab

7. Optionally, do one or more of the following:

• The lower pane on the Results tab is an EMS browser window. See “An EMS
Browser Window” on page 35 for all the features that are available for this pane.

• Click Print to print the search results.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• Select a search result entry for an invoice, and then click Email to open a
pre-addressed SMTP email to the group that is associated with the invoiced
reservation. Complete and send the email as you would normally. (The invoice is
sent as an attachment.) See “Sending Email from EMS” on page 414.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

8. Click Close.

Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. If you want to reset the columns to their
default values, see “Resetting Column Settings” on page 408.
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To set up favorite fields for a Transaction search

If you have specific fields and/or values by which you always want to carry out a Transaction 
search, you do not have to filter the list of fields on the All Fields tab for every search. 
Instead, you can set up each of these fields to be a favorite field with a specific value or limit 
if needed. 

1. Open the Browse Transactions window, and make sure that the Advanced search
features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields
tab, and then click Add to Favorites.

The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on
the Filter dialog box.

The next time that you carry out a search, you can simply open the Favorite Fields tab or
the Saved Values tab to carry out a search based on your customized list of search fields.
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Working with Transactions

Working with transactions in EMS consists of entering the transaction correctly, and if 
needed voiding a transaction. You can:

• Enter a deposit and void a deposit.

• Enter a payment and void a payment.

• Enter an adjustment and void an adjustment.

• Enter a refund and void a refund.

The steps for entering the different types of transactions are specific to the transaction. The 
steps for voiding a transaction are identical, regardless of the transaction type.

To enter a deposit or damage deposit for a reservation

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 79), and on the Transactions tab, click New > Payment.

• On the EMS menu bar, click Billing > Payments > Payment Entry, and then on the
Payment Entries window, click New.

The Payment Entry dialog box opens.

Figure 9-20: Payment Entry dialog box

If needed, you can first search for a transaction to ensure that it has not already 
entered or voided. See “To search for a transaction” on page 379.
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2. Enter the deposit information.

3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the
Transactions tab for the reservation.

Field Description

Transaction Date The default value is the current day’s date. You can edit this value if 

needed.

Department Select the department.

Transaction Type Select the transaction type—Damage Deposit, Deposit (Reservation), or 

Deposit (Bookings).

• A Deposit (Reservation) is best suited for reservations with one or

more bookings that are to be invoiced in their entirety upon

completion of the event.

• A Deposit (Bookings) is best suited for reservations with multiple

bookings, for example, an event with multiple occurrences spanning

several months, that is to be billed monthly. A Deposit (Bookings)

allows you to spread the deposit across multiple months so that only

a portion of the deposit is consumed and applied to the invoice that is

generated monthly. In this scenario, a large deposit that is entered as

Deposit (Reservation) would be consumed in its entirety by the first

invoice that is generated.

Payment Type Select the payment type.

Check No. Enter a check number if you selected “Check” as the payment Type.

Amount Enter the amount of the deposit.

Currency Select the currency for the deposit.

Reservation No. Automatically populated if you opened the Payment Entry dialog box 

from the Transaction tab in the Navigator; otherwise, enter a reservation 

number or click the Search icon  to open the Reservations window 

and search for a reservation.

Invoice No. N/A as deposits are applied before an invoice is generated. The 

invoicing process totals the charges for the specified date range, 

consumes any applied reservation deposits, and results in a net balance 

due for the invoice. The invoicing process does not consume any 

Damage deposits. 

Notes Optional. Enter any other comments or statements that explain or clarify 

the deposit.



387

 
Billing

To enter a payment or pre-payment

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 79), and on the Transactions tab, click New > Payment.

• On the EMS menu bar, click Billing > Payments > Payment Entry, and then on the
Payment Entries window, click New.

The Payment Entry dialog box opens.

Figure 9-21: Payment Entry dialog box

2. Enter the payment information.

Field Description

Transaction Date The default value is the current day’s date. You can edit this value if 

needed.

Department Select the department.

Transaction Type Select the transaction type—Payment or Pre-payment.

Note: Remember that pre-payments act just like deposits in that they 

are applied to a reservation and are applied to an invoice 

reducing the balance due. Payments are applied to an invoice.

Payment Type Select the payment type.

Check No. Enter a check number if you selected “Check” as the payment Type.

Amount Enter the amount of the payment.

Currency Select the currency for the payment.
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3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the
Transactions tab for the reservation.

Reservation No. • If you selected Payment as the Transaction Type, then this field is not

available as payments are applied against invoices, not reservations.

• If you selected Pre-payment as the transaction type, then the field is

automatically populated if you opened the Payment Entry dialog box

from the Transaction tab in the Navigator; otherwise, you must enter

a reservation number or click the Search icon  to open the

Reservations window and search for a reservation.

Invoice No. • If you selected Pre-payment as the Transaction Type, then this field is

not available as pre-payments are applied before an invoice is

generated.

• If you selected Payment as the Transaction Type, then you must

enter an invoice number in this field, or click the Search icon  to 

open the Invoices window and search for an invoice.

Notes Optional. Enter any other comments or statements that explain or clarify 

the payment.

Field Description
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To enter an adjustment for an invoice

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 79), and on the Transactions tab, click New > Payment.

• On the EMS menu bar, click Billing > Payments > Payment Entry, and then on the
Payment Entries window, click New.

The Payment Entry dialog box opens.

Figure 9-22: Payment Entry dialog box

2. Enter the adjustment information.

Field Description

Transaction Date The default value is the current day’s date. You can edit this value if 

needed.

Department Select the department.

Transaction Type Select the transaction type—Adjustment.

Payment Type Select the payment type.

Check No. Enter a check number if you selected “Check” for the payment type.

Amount Enter the amount of the adjustment. To decrease the invoice by the 

indicated amount, enter a minus sign (-) before or after the amount.

Currency Select the currency for the adjustment.

Reservation No. N/A as adjustments are applied to invoices.
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3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the
Transactions tab for the reservation.

To enter a refund

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 79), and on the Transactions tab, click New > Payment.

• On the EMS menu bar, click Billing > Payments > Payment Entry, and then on the
Payment Entries window, click New.

The Payment Entry dialog box opens.

Figure 9-23: Payment Entry dialog box

Invoice No.
You must enter an invoice number or click the Search icon  to open 

the Invoices window and search for an invoice

Notes Optional. Enter any other comments or statements that explain or clarify 

the adjustment.

Field Description
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2. Enter the refund information.

3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the
Transactions tab for the reservation.

To void a transaction

You can void a transaction for a reservation from the Transactions tab, or you can void a 
transaction from the Payment Entries window.

To void a transaction from the Transactions tab

1. Open the reservation in the Navigator. (See “Opening a reservation in the Navigator” on
page 79.)

2. Open the Transactions tab, and on the Transactions tab, select the transaction that is to be
voided (CTRL-click to select multiple transactions), and then click Void.

A Void Reason dialog box opens.

Figure 9-24: Void Reason dialog box

Field Description

Transaction Date The default value is the current day’s date. You can edit this value if 

needed.

Department Select the department.

Transaction Type Select the transaction type—Refund.

Payment Type Select the payment type.

Check No. Enter a check number if you selected “Check” as the payment type.

Amount Enter the amount of the refund.

Currency Select the currency for the refund.

Reservation No. N/A as refunds are applied to invoices.

Invoice No.
You must enter an invoice number or click the Search icon  to open 

the Invoices window and search for an invoice

Notes Optional. Enter any other comments or statements that explain or clarify 

the refund.
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3. Enter the reason for voiding the transactions, and then click OK.

The Void Reason dialog box closes and a message opens indicating that the transaction
has been voided.

4. Click OK.

The Void Transaction message closes. The Void column is set to Yes for each of the
voided transactions in the Navigator.

To void a transaction from the Payment Entries window

1. On the EMS menu bar, click Billing > Payments > Payment Entry.

The Payment Entries window opens. This window lists all transactions (voided and
non-voided) that were ever made in your EMS system for a selected department on a
selected date.

Figure 9-25: Payment Entries window

2. Select the date (the default value is the current day’s date) and the department for which
you are voiding the transaction.

The Payment Entries window is updated with the list of payments that meet the date and
department criteria.

3. Select the transaction that is to be voided, and then click Edit.

The Payment Entry dialog box opens. This window details specific information for the
selected transaction. (See Figure 9-20 on page 385.)

4. Click Void, and, then in the Void Comment field, enter a reason for voiding the
transaction.
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5. Click OK.

The Payment Entry dialog box closes. You return to the Payment Entries window. The
Void column is set to Yes for the voided transaction.
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Generating an EMS Billing Report

All EMS Billing reports are available under the Billing option on the menu bar. For any EMS 
report, you can specify the parameters, options, and format for the report, or you can 
generate the report according to memorized settings. (For detailed information about a 
memorized report, see “Working with Memorized Reports” on page 323.) Not all reports 
require the same parameters, nor do they all have the same options available. In addition, you 
can generate different reports in different formats.

To generate a report

1. On the EMS menu bar, click Billing to open the Billing menu, and then do one of the
following:

• To generate the Billing Worksheet report, click Billing > Invoices > Billing
Worksheet.

• To generate any other Billing report, click Billing > Reports, and then click the
option for the report that you are generating. For example, to generate the Ageing
report, click Billing > Reports > Ageing.

2. On the Setup dropdown list, do one of the following:

• To generate the report according to the filter settings that you want (parameters,
options, and so on), leave user-specified selected, then go to Step 3.

• To run the report with filter settings that have been saved, or memorized, select the
memorized report, and then go to Step 4.

3. Specify the report parameters, options, and format. See:

• “Invoice reports” on page 397.

• “Reports” on page 397.

For brevity and ease, the parameters and options that are available for each 
report are not discussed here. Instead, the options are discussed in “Report 
Descriptions and Options” on page 396. Contact your EMS administrator if you 
need assistance in generating any of these report.

All Billing reports other than the Billing Worksheet report are also available from 
Reports > Billing.

For detailed information about memorized reports, see “Working with Memorized 
Reports” on page 323.
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4. Optionally, do one or both of the following:

• Click Print Preview.

A preview of the report opens onscreen.

• To print a hard copy of the confirmation, specify the number of copies that you are
printing, and then click Print.

5. Click Close.

Unless you change the setup, all subsequent reports will be generated and printed
according to the parameters and options that you have specified and in the format that
you specified. If you want to save certain settings so that you do not have to adjust the
filter settings every time you run the report, you can memorize the report. See “Working
with Memorized Reports” on page 323.
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Report Descriptions and Options

This section provides a description of every EMS report in the categories listed below and it 
also defines the options that are available for each report.

See:

• “Invoice reports” on page 397.

• “Reports” on page 397.
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Invoice reports

Reports

Report Description Options

Billing Worksheet Provides information on how bookings are to be 

invoiced. The report can include bookings within 

a date range, bookings within a reservation, or 

bookings within a date range inside a reservation. 

The report breaks down the charges in the same 

way as an invoice. The report also provides 

options for printing heading/footer messages and 

the detail for zero-dollar items.

See “Options tab—Format settings for a printed confirmation” in “To 

generate an invoice” on page 364.

Report Description Options

Ageing Report A list of outstanding invoices. Current invoices 

are listed first, followed by past due invoices 

organized by age. Ageing Reports are based on 

department. 

• Currency—Select the currency for the invoices.

• Show Unapplied Deposits—Deposits that are applied to reservations

that have not been invoiced are displayed on the report.
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Statements A list of outstanding invoices for a selected group. 

Current invoices are listed first, followed by past 

due invoices organized by age.

• Currency—Select the currency for the invoices.

• Report Title—Can create a title that is displayed at the top of the

statement.

• Header Message—Select a message from the pre-configured

messages that is displayed at the top of every page of the statement.

• Include Transactions On Zero Balance Invoices Within [ ]days—

Statements that have a zero balance within the specified number of

days are displayed.

• Show Billing Reference Number—The billing reference number is

displayed under the invoice information.

• Show Purchase Order Number—The purchase order number is

displayed under the invoice information.

• Show Transaction Notes—Any notes entered for the transaction are

displayed under the invoice information.

• Use Current group Address - The current address of the group is

displayed on the statement. (This address might or might not be the

address for the group when the reservation was made.)

Report Description Options
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Transaction Report Shows all the billing transactions during a 

specified period if you generate the report in the 

By Transaction Type by Date format. Simply 

enter the date or date range and click Print. The 

report lists the group, event name, reservation ID, 

transaction date, transaction type, invoice 

number, check number, and amount. 

Note: If the report is generated in Standard 

format, deposits are not shown as 

transactions if they have been absorbed 

by the generation of an invoice. 

Note: You can also generate the Transaction 

Report from within a reservation to see 

only transactions for the selected event 

and you can generate the Transaction 

Report from the Print option on the 

Payment Entries window. Click Billing > 

Payments > Payment Entry, and then on 

the Payment Entries window, click Print.

Currency—Select the currency for the billing transactions.

Voided Transaction 

Report

Lists the payments, deposits, or adjustments that 

were voided on a specific date or within a date 

range. Lists the group, event name, reservation 

ID, transaction date and type, invoice number (if 

applicable), check number, and amount.

Currency—Select the currency for the voided transactions.

Invoice Detail Report Provides detail for all invoices that were 

generated within a given date range.

Note: See “To reprint an invoice” on page 368 

for detailed instructions about the options 

that are available for the Print Invoice 

Detail dialog box.

N/A

Report Description Options
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General Ledger 

Distribution

Shows the totals for invoices that were generated 

within a given date range. Entries are broken 

down by account, invoice, rate plan, or invoice. 

You can also generate this report in a Summary 

format.

• Currency—Select the currency for the invoices.

• Invoices With Payments Only—Only invoices where payment has

been received are posted on the report.

• Show Applied Deposits/Prepayments—Applied deposits and

prepayments are posted on the report. (An applied deposit is a

deposit on a reservation that has been invoiced.)

Report Description Options
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Settings

As an EMS user, you can manage many aspects of your account to better suit your working 
needs.

This chapter covers the following topics:

• “Setting User Preferences and Default Values” on page 403.

• “Changing your Password” on page 406.

• “Resetting Window Coordinates” on page 407.

• “Resetting Column Settings” on page 408.

• “Defining Your Views” on page 409.
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Setting User Preferences and Default Values

Preferences, like system parameters, are settings that affect the basic functioning of your 
EMS system. The difference is that system parameters are global settings that affect all users 
on the system, whereas preferences are applicable only to your user account. You can set the 
values for many preferences for your EMS instance to better suit your working needs. These 
preferences include whether a report window stays opens or closes automatically after you 
run a report, the time interval for Time dropdown fields, the format in which to send emails 
from your computer, the default values for specific fields in the Reservation Wizard and 
other EMS client windows, and the application that is to open all drawings (.png, .jpg, .gif, 
and so on) that are attached to bookings in the Navigator.

To set user preferences and default values

1. On the EMS menu bar, click Settings > Preferences.

The Preferences dialog box opens. The Preferences tab is the active tab.

Figure 10-1: Preferences dialog box, Preferences tab
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2. Edit your user preferences as needed.

Field Description

Close Report Setup 

Form After Running 

Reports

Select this option if the window from which you generate a report is to 

automatically close after you run the report. Do not select this option if 

you want the window to remain open.

Time Drop Down 

Interval

The time interval displayed on a Time dropdown list—i.e., if you select 

30 minutes, then options on the dropdown list are displayed as 1:00 

1:30, 2:00 and so on. All Time dropdown lists are 24 hour lists.

Paper Size The size of the paper on which reports, confirmations, and invoices are 

printed. Values are Letter, Legal, and A4.

Review Notifications 

When Navigator Opens

If this option is selected, then a notification in the Dashboard is 

automatically marked as “Reviewed” if you select the notification, and 

then click Go To. If this option is not selected, then you must select a 

notification, and then click Reviewed to manually mark the notification 

as “Reviewed.”

Do Not Save Window 

Coordinates

All windows in EMS have default coordinates (a position) in EMS. If you 

move a window from its default position when working in EMS, but you 

want the window to open in its default position the next time the window 

opens, then select this option.

Email Format The format in which your emails are sent—HTML or Plain Text.

Send Emails Using 

Department Email 

Address

Select this option if you want the From email address for all the emails 

that you send from EMS to be the email address of the department that 

is associated with your user account.

Use Global Email 

Settings

If you want to use the global email settings that your EMS administrator 

has defined, then select this option.

Use Microsoft Outlook If this option is selected, then EMS uses Microsoft Outlook for your 

default email client. If this option and the Use Global Email Settings 

option are not selected, then EMS uses the SMTP Email settings 

specific to your account. (These settings are specified in the lower pane 

of the Preferences dialog box.)

Use Microsoft Outlook 

Email Signature (HTML)

If the Use Microsoft Outlook option is selected, and your Email Format 

option is set to HTML, then you can select this option to include your 

Microsoft Outlook signature when you send emails from EMS.

SMTP Email Contact your EMS administrator with assistance in specifying these 

values.

Note: If you are using SMTP Email settings that are specific to your 

account, then you also have the option of creating a signature 

that is to be included in all the emails that you send from EMS.
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3. Open the Defaults tab, and set the default values for the indicated items.

Figure 10-2: Preferences dialog box, Defaults tab

4. Click OK to close the Preferences dialog box and apply your edited preferences and
default values.

Field Description

Building You can select all buildings, a specific building, or a specific view or 

area. The value that you select here automatically populates the 

Building dropdown list in the Reservation Wizard and other EMS client 

windows, for example, the Visitors window. 

Status

Event Type

Event Name

Event Time

Reservation Source

Time Zone/ Display 

Audit Times in This 

Time Zone

Payments Currency

The values that you select here automatically populate the appropriate 

fields in the Reservation Wizard, and other EMS client windows.

Note: The event name can be a maximum of 30 characters, including 

spaces.

Default Drawing 

Application
Click the Search icon  to open the Find Drawing Application dialog 

box and select the program that is to open all drawings (.png, .jpg, .gif, 

and so on) that are attached to bookings in the Navigator.
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Changing your Password

When your EMS administrator first sets up your user account, your password is predefined 
for you. You can change this password if you want.

To change your password

1. On the EMS menu bar, click Settings > Change Password.

The Change Password dialog box opens.

Figure 10-3: Change Password dialog box

2. Do the following:

• In the Old Password field, enter your current EMS password.

• In the New Password field, enter the new password.

• In the Re-enter New Password field, enter your new password again, exactly as you
entered it in the New Password field.

3. Click OK to close the Change Password dialog box.

The next time that you log in to EMS, you must use your new password.
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Resetting Window Coordinates

All windows in EMS have default coordinates (a size and position) in EMS. If you have 
moved one or more windows or resized one or more windows during an EMS session, and 
you want the windows to open in their default positions and sizes, you can reset the window 
coordinates to their default values.

To reset window coordinates

1. On the EMS menu bar, click Settings > Reset Window Coordinates.

The Window Coordinates dialog box opens.

Figure 10-4: Window Coordinates dialog box

2. Click OK.

3. If necessary, restart your EMS application.
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Resetting Column Settings

All columns in EMS have default values for their positions and widths in EMS. If you have 
changed the position, width, or both of one more columns during an EMS session, and you 
want the columns to open with their default values, you can reset the columns to their default 
values.

To reset column settings

1. On the EMS menu bar, click Settings > Reset Column Settings.

The Column Settings dialog box opens.

Figure 10-5: Column Settings dialog box

2. Click OK.

3. If necessary, restart your EMS application.
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Defining Your Views

A view is simply a user-defined grouping of specific rooms. When searching for rooms in 
which to schedule events, you can select (all) buildings to search, a specific building, an 
area, or a view. If your job entails making multiple reservations for groups that always book 
events in specific rooms or locations, then to make your room search easier and more 
efficient, you can define the views that best meet your working needs. For example, if you 
are making multiple reservations for your school district’s athletic teams, then you could 
define a view called School District 1 - Athletic, and this view would contain the following 
event locations—Baseball Field 1, Baseball Field 2, Gym 1, Gym 2, Pool, and so on.

To define your views

1. On the EMS menu bar, click Settings > My Views.

The My Views window opens. This window lists all the views that you have defined.

Figure 10-6: My Views window

2. Click New.

The View dialog box opens. The View tab is the active tab. See Figure 10-7 on page 410.
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Figure 10-7: View dialog box, View tab

3. In the Description field, enter a name or description for the view.

4. Optionally, in the Notes field, enter any additional information that is pertinent for the
view.

5. Open the Rooms tab, and do one or both of the following:

• Select (all) buildings, a specific building, a view, or an area for which to search for
rooms to include in the view.

• Leave the Room Type set to the default value of (all), or select a specific room type.

As you select your search criteria, the list of rooms that meet the search criteria is 
dynamically updated.

6. In the Available list, select the room, or CTRL-click to select multiples rooms that you
are including in the view, and then click the Move (>) button to move the available
rooms to the Selected list.

7. Optionally, click Spelling to spell check the view before you save it.

8. Click OK.

The View dialog box closes. You return to the My Views window with the newly defined
view automatically selected.

The description can be a maximum of 50 characters, including spaces.

The views that are available are not only all the views that you have defined for 
this EMS database, but also, all the views that other users have defined for this 
EMS database.
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EMS contains several miscellaneous standalone functions to assist you in managing and 
maintaining reservations and bookings in your system as well as managing your general 
work requirements. 

This chapter covers the following topics:

• “Recording Actual Attendance Numbers for Bookings” on page 413.

• “Sending Email from EMS” on page 414.

• “Viewing a History of Sent Emails” on page 418.

• “Generating Multiple Confirmations” on page 420.

• “Managing Attendees and Visitors” on page 424.
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Recording Actual Attendance Numbers for 

Bookings

You use the Attendance Entry tool to view and record the actual attendance for bookings. 
(The tool does not address reservation-level attendance.) The actual attendance numbers that 
you enter do not replace the setup count (i.e., the estimated attendance) that you entered prior 
to an event. Reports that provide attendance information typically provide both the estimated 
attendance and the actual attendance.

To record actual attendance numbers for bookings

1. On the EMS main menu, click Reservations > Other > Attendance Entry.

The Attendance Entry window opens.

Figure 11-1: Attendance Entry window

2. In the Date field, select a date for which you are recording the booking attendance.

3. Optionally, specify a building and/or a booking status to filter the list of booking results.

4. For each booking as needed, scroll to the Actual Attendance column, double-click in the
column to select the currently displayed value, and then enter the actual attendance
number in the column.

5. Click Close.

The date must occur on or before the current day’s date. 
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Sending Email from EMS

Multiple email options exist within EMS to email confirmations or invoices to groups or 
miscellaneous information to your EMS users or groups. If your organization uses Microsoft 
Outlook, you can continue to use your respective email system within EMS to send 
confirmations and invoices or any other individual emails to EMS users or groups. To send 
bulk emails to groups within an EMS Browser window (basic/advanced, transactions, 
calendar, and so on), however, you must use something called SMTP email. If your 
organization does not use Microsoft Outlook, then SMTP email is used to send all email 
from EMS, including emails to EMS users or groups and confirmations and invoices. EMS 
also provides an emailing function that you can use to send generic emails, which are emails 
that are not “tied” to a confirmation, invoice, reminder, and so on) to any recipient of your 
choice.

To send an email from within an EMS Browser window

1. Select a search result entry, and then click Email to open a pre-addressed SMTP email to
the group that is associated with the selected reservation.

Figure 11-2: SMTP email from an EMS Browser window

2. Enter the necessary information in the From, Subject, Message and other fields.

To send any email, your user account must be configured with an email address. 
To send generic emails, your user email preferences must also be configured. 
Contact your EMS administrator if you need assistance with this. See your EMS 
administrator or internal IT staff for information on how to enable SMTP email.
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3. Optionally, do one or both of the following:

• To attach a file, click Attachments at the top of the window.

• To format the body of the email message, use the options on the Formatting toolbar.

4. Click Send.

To send a confirmation or invoice

1. On the Confirmation dialog box or on the onscreen preview of a new or reprinted
invoice, click Email.

• For a confirmation, an Email window that displays the confirmation in the body
opens. The From field is populated with the user address that is associated with your
user account or, based on your user preferences, the email address of the department
that is associated with your user account. You can select either address. (See “Setting
User Preferences and Default Values” on page 403.) The To field is blank.

• For an invoice, an Email window that contains the invoice as an attachment opens.
The From field is populated with the user address that is associated with your user
account or, based on your user preferences, the email address of the department that
is associated with your user account, and you cannot change this value. (See “Setting
User Preferences and Default Values” on page 403.) The To is populated with the
email address for the associated group, but you change this value if needed.

Figure 11-3: SMTP email window for a confirmation
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2. Select the recipients for the email.

3. Optionally, do one or both of the following:

• To format the body of the email message, use the options on the Formatting toolbar.

• To attach a file, click Attachments at the top of the window.

• The default format for the attached invoice is PDF. You can select a different
format if needed. Other allowed formats are HTML, Microsoft Excel (.xls),
Microsoft Word (.rtf), Picture (.tiff), and Text File (.txt).

• If the emailed confirmation is to include the entire confirmation as an
attachment, then you must also select a file format for the attached confirmation.
The default value is Adobe (.pdf). Other allowed formats are HTML, Microsoft
Excel (.xls), Microsoft Word (.rtf), Picture (.tiff), and Text File (.txt).

• If the emailed confirmation includes one or more attachments, then the
Confirmation Title is also used for the name for all attachments other than an
.ics file. If the confirmation includes an .ics file, then the .ics file is always
named Confirmation.ics.

4. Click Send.

For an invoice, the SMTP email window also has Header Message and Footer 
Message fields for including header and footer messages in the email body. 

To include the entire confirmation as an attachment, or an .ics file in a 
confirmation, see “Specifying your Confirmation Settings” on page 308.
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To send a generic email

1. On the EMS toolbar, click the Email icon .

A generic email form opens. Depending on your preferences, the From field is
automatically populated either with the email address that is specified for your user
account, or the email address of the department that is associated with your user account.
(See “Setting User Preferences and Default Values” on page 403.)

Figure 11-4: Generic email form

2. Enter the necessary information in the To, Subject, Message, and other fields.

3. Optionally, do one or both of the following:

• To attach a file, click Attachments at the top of the window.

• To format the body of the email message, use the options on the Formatting toolbar.

4. Click Send.
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Viewing a History of Sent Emails

You can use the Email History function to review a list of all emails that have been sent from 
within your organization’s EMS system via SMTP (not via Microsoft Outlook), including 
confirmation emails, report emails (which includes invoices, reminders, queries, web 
requests, and group and contact information), and generic emails. You can also view the 
contents of sent emails and print sent emails

To view a history of sent emails

1. On the EMS main menu, click Reservations > Other > Email History.

The Emails window opens. Regardless of your preferences, the From field is
automatically populated with the email address for your user account, but you can
always change this value.

Figure 11-5: Emails window

2. Enter the search criteria for the emails, and then click Display.

All of the emails that meet the search criteria are displayed in the bottom pane of the 
Emails window.

Under Source, the Report option collectively refers to confirmations, invoices, 
reminders, queries, web requests, and group and contact information.
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3. Optionally, do one or more of the following:

• To view an email, select the mail in the search results list, and then click View.

• To print the complete results list, click Print > List.

• To print the contents of one or more emails in the results list, select the mail, or
CTRL-click to select multiple emails, and then click Print > Emails.
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Generating Multiple Confirmations

A confirmation is a document that details the critical information for a reservation—the date, 
the time, the location, the scheduled resources, and so on. Through the Navigator, you have 
the option of generating a single confirmation, either manually or automatically. (See 
“Confirmations,” on page 307.) A miscellaneous reservation function is also available for 
manually generating multiple confirmations at the same time. When you generate multiple 
confirmations, all the confirmations are contained in a single file, but each confirmation 
begins at the top of a new page. All the confirmations are “sent” by the same office, all the 
confirmations use the same format (By Booking Date, By Date Added, or By Date 
Changed) and all the confirmations use the same print options (Confirmation Title, Header 
Message, and so on); however, each confirmation can contain unique information for the 
buildings, statuses, and/or categories that are detailed in the confirmation. Because multiple 
confirmations are for multiple recipients, you cannot mass email these confirmations. 
Instead, you can only print them, and then manually mail them. You can specify the settings 
for multiple confirmations “from scratch,” or you can copy an existing confirmation format, 
and edit it as needed.

To generate multiple confirmations

1. On the EMS menu bar, click Reservations > Other > Confirmations.

The Confirmation dialog box opens. The Date Range tab is the active tab.

Figure 11-6: Confirmation dialog box, Date Range tab
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2. Do one of the following:

• Review the selections on this dialog box, and optionally, make any needed
modifications.

Field Description

Date Range tab

Department The department name that appears at the top the printed confirmation.

Starting Date

Ending Date

The range of dates for which you are generating the confirmations.

Use Specific Times Available only if the Starting Date is the same as the Ending Date. If this 

option is selected, then two fields are displayed on the Date Range tab 

in which you must specify the time range. After you specify the time 

range, click Options > Date/Time Filter, and then indicate how the 

confirmation is to be limited—by bookings that start within the time 

range, or by bookings that occur within the time range.

Format The format/organization of the confirmation—By Booking Date, By Date 

Added, or By Date Changed.

Buildings tab—Select the specific buildings that are to be included in the confirmation. 

Categories tab—Select the specific booking details that are to be included in the confirmation.

Statuses tab—Select the specific statuses that are to be included in the confirmation. 

Options tab—Format settings for a printed confirmation.

Confirmation Title Appears bold and centered at the top of the confirmation.

Header Message

Footer Message

Pre-configured blocks of text that appear in the header and footer of the 

printed confirmation. 

Note: Your EMS administrator configures these values. Contact your 

administrator if you need assistance with adding or editing a 

value.

Paper Size The size of the paper on which the confirmation is printed. Values are 

Letter, Legal, and A4.

Print Comments Include the comments for the reservation in the printed confirmation.

Print Reminders Include the reminders for the reservation in the printed confirmation.

Print Cancel Reasons Include the reasons for cancellation in the printed confirmation.

Print User Defined 

Fields

Include user-defined fields and their values in the printed confirmation. 

Print Room Phone Include the phone number for the room in which the event is being held 

in the printed confirmation.

Print Room Notes Include any notes for the room in which the event is being held in the 

printed confirmation.

Print Building Notes Include any notes about the building in the printed confirmation.

Print Billing Reference 

Allocation

Include the billing reference numbers for the event as well as the 

percentage of charges that is allocated to each number in the printed 

confirmation.
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• On the Setup dropdown list, select a saved, or memorized, confirmation.

Print PO Number 

Allocation

Include the PO numbers for the event as well as the percentage of 

charges that is allocated to each number in the printed confirmation.

Print Category 

Subtotals

Include the subtotal charges by category in the printed confirmation.

Print Room Type Include the room type for the event in the printed confirmation.

Print Item Selection 

Notes

Include the notes for each resource selection item for the event in the 

printed confirmation.

Suppress Reserved 

Time

Do not show the reserved time for the event in the printed confirmation.

Suppress Location Do not show the location for the reservation in the printed confirmation. 

Suppress Pricing Do not show the reservation’s room charges or resource charges in the 

printed confirmation.

Suppress Logo Do no show your organization’s logo in the printed confirmation.

Suppress Item Notes Do not show notes for any booking items in the printed confirmation.

Suppress Item Special 

Instructions

Do not show special instructions for any booking items in the printed 

confirmation.

Suppress Item 

Selections

Do not show any resource item selections in the printed confirmation.

Always Display Time 

Zone

Always show the time zone for the event in the printed confirmation.

Display Messages as 

HTML

If you have defined any HTML messages, then select this option to 

display the HTML version of these messages in the printed 

confirmation; otherwise, the message is displayed in plain text.

Limit Bookings to Those 

With Details in Selected 

Categories

Show only those bookings in the printed confirmation that contain details 

for the categories that are selected on the Categories tab.

If needed, you can always save, or memorize, these settings. See “Working with 
Memorized Reports” on page 323.

If you select a memorized confirmation, then the only changes that you can make 
are to the dates and/or times on the Date Range tab.

Field Description
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3. Do one or both of the following:

• Click Print Preview to open an onscreen preview of the printed confirmation. A
variety of options are available from this preview, including the options to export the
confirmation to a .pdf and to print the confirmation.

Figure 11-7: Print preview of multiple confirmations

• To manually print the confirmations, edit the number of copies to print as needed in
the Copies to Print field (the default value is 1), and then click Print.

A Print dialog box opens in which you can specify information such as the printer to
use, the page range, and so on. Click Print in this dialog box to manually print the
confirmations.
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Managing Attendees and Visitors

EMS provides standard functionality for managing registered attendees and visitors, which 
are attendees and visitors who have been added as an attendee type category to a booking. 
You can search for registered attendees and visitors, and you can check in and check out 
registered attendees and visitors. The optional Visitor Management module provides 
functionality for managing unregistered attendees and visitors. If your organization has 
purchased and installed this module, you can also check in unregistered visitors to an event, 
check out unregistered visitors from an event, print badges for all attendees and visitors 
(registered and unregistered), and import a list of attendees using the Add Booking Details 
Wizard in the Navigator.

To manage registered attendees and visitors

1. On the EMS menu bar, click Reservations > Other > Visitors.

The Visitors window opens. By default, the Visitors tab is the active tab.

Figure 11-8: Visitors window, Visitors tab
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2. Specify one or more of the following for your search criteria:

• Start Date/End Date—The default value is the current day’s date.

• Building—Select (all) buildings, a specific building, an area, or a view to search.

• Show Cancelled—Select this option to search for registered attendees or visitors for
canceled events.

• Group—To search for registered attendees or visitors regardless of group, leave this
field blank; otherwise, to search based on a specific group, enter a search string in
the field.

• Visitor—To search for a specific attendee or visitor, enter a search string in the field.

• Include Checked In—Selected by default. Clear this option to search only for
registered attendees and/or visitors who have not yet been checked in to their events.

3. Click Display.

The list of registered attendees and/or visitors who meet the search criteria are displayed
in the bottom pane of the Visitors window.

4. Optionally, do one or more of the following:

• Select an attendee or visitor from the search results, and then click open to open the
reservation in the Navigator that contains the booking that the attendee/visitor is
attending.

• Select an attendee or visitor from the search results, or CTRL-click to select multiple
attendees/visitors, and then click Check In to “check in” the attendees/visitors to the
event. A date and timestamp is added to each attendee’s/visitor’s record.

• Select an attendee or visitor from the search results, or CTRL-click to select multiple
attendees/visitors, and then click Check Out to “check out” the attendees/visitors
from the event. A date and timestamp is added to each attendee’s/visitor’s record.

For both search fields, your search is limited to the exact order of the characters 
in the string, but the string is not case-sensitive and it can appear anywhere in the 
search results. For example, a search string of aca returns Academic Affairs 
Office, Department of Academic Affairs, and so on.

Check Out is available only if the selected attendees/visitors have been checked 
into the event.
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• Select an attendee or visitor from the search results, or CTRL-click to select multiple
attendees/visitors, and then on the Tools menu, click Undo Check In to reverse the
Checked In status for the attendees/visitors. (The Check In date and timestamp is
removed from each attendee’s/visitor’s record and if needed, you can check in the
attendees/visitors again). Conversely, if an attendee or visitor has been checked out,
click Undo Check Out to reverse the Checked Out status for the attendee/visitor.

• On the Tools menu, click Export to export the list of attendees/visitors to a Microsoft
Excel spreadsheet.

• On the Tools menu, or from the Visitors window, click Print to generate an onscreen
preview of the list of attendees/visitors. A variety of options are available from this
preview, including the options to email the list, to export the list to a .pdf, and so on.

Figure 11-9: Onscreen preview of a registered attendee/visitor list
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To check in/check out unregistered visitors for an event

1. On the EMS menu bar, click Reservations > Other > Visitors.

The Visitors window opens.

2. Open the Groups tab.

Figure 11-10: Visitors window, Groups tab

3. Specify one or more of the following for your search criteria:

• Start Date/End Date—The default value is the current day’s date.

• Building—Select (all) buildings, a specific building, an area, or a view to search.

• Group—Enter some or all of the hosting group’s name.

4. Click Display.

The groups that meet your search criteria are displayed in the middle pane of the Visitors
window.

Your search is limited to the exact order of the characters in the string, but the 
string is not case-sensitive and it can appear anywhere in the search results. For 
example, a search string of aca returns Academic Affairs Office, Department of 
Academic Affairs, and so on.
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5. Select the hosting group from the search results, and then click New Visitor.

The New Visitor dialog box opens.

Figure 11-11: New Visitor dialog box

6. Enter the information for the unregistered visitor, and then click OK.

The Visitor dialog box closes. You return to the Visitors window with the group and
newly configured visitor automatically selected.

7. Repeat Step 5 and Step 6 as needed to add all the unregistered visitors to the event.

The information that is displayed in the Event column for each unregistered visitor that
is added to an event is determined by the settings that your EMS administrator specified
when configuring the event building. For example, “Unregistered Visitor” might be
displayed. The date and time that you add an unregistered visitor to an event is used as
the Check In date and time for the visitor.

Building and Name are required fields. Depending on how your EMS 
administrator configured your system, Company Name, Email Address and/or 
Phone might be required. Notes are always optional. If you selected a specific 
building in Step 3, then the Building field is automatically populated with the 
name of the building in which the event is scheduled and you cannot edit this 
value; however, if you have set your preferences for buildings such that this 
building is not available to you, then the Building field cannot be populated with 
the correct value, and you cannot add the new visitor. See “Setting User 
Preferences and Default Values” on page 403.
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8. Optionally, before you check out or check in an unregistered visitor, do one or more of
the following:

• Select the unregistered visitor in the lower pane of the Visitors window, and then
click Open to open the reservation in the Navigator that contains the booking that the
unregistered visitor is attending.

• On the Tools menu, click Export to export the list of registered attendees/visitors and
unregistered visitors to a Microsoft Excel spreadsheet.

• On the Tools menu, or from the Visitors window, click Print to generate an onscreen
preview of the list of registered attendees/visitors and unregistered visitors. A
variety of options are available from this preview, including the options to email the
list, to export the list to a .pdf, and to list the confirmation.

Figure 11-12: Onscreen preview of a registered and unregistered attendee/visitor list

9. To check out/check in an unregistered visitor, do one of the following:

• Select the unregistered attendee/visitor, or CTRL-click to select multiple
unregistered attendees/visitors, and then click Check Out to “check out” the
attendees/visitors from the event. A date and timestamp is added to the unregistered
visitors’ records.

• Select the unregistered attendee/visitor, or CTRL-click to select multiple
unregistered attendees/visitors, and then on the Tools menu, click Undo Check In to
reverse the Checked In status for the unregistered attendees/visitors. (The Check In
date and timestamp is removed from the unregistered visitors’ records and if needed,
you can check in the unregistered visitors again). Conversely, if an unregistered
visitor has been checked out, click Undo Check Out to reverse the Checked Out
status for the attendee/visitor.
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To print visitor badges

1. On the EMS menu bar, click Reservations > Other > Visitors.

The Visitors window opens.

2. Do one or both of the following:

• Locate and select the attendee as described in “To manage registered attendees and
visitors” on page 424.

• Create and select the attendee record as described in “To check in/check out
unregistered visitors for an event” on page 427.

3. Click Print Badge.

To import a list of attendees and visitors to an event

1. Create a tab-delimited file that contains the information (in the order listed) for the
attendees/visitors that are being imported.

2. Open the reservation for the event in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through the Reservation Book” on page 80.

• “Opening a reservation through a group” on page 80.

• “Search Tools,” on page 195.

3. In the left pane of the Navigator, select the reservation for which you are importing the
list of attendees/visitors.

Field Description Required/Optional

Name Text. 50 characters maximum. Required

Company Name Text. 50 characters maximum. Optional

Email Address Text. 255 characters maximum. Optional

Phone Text. 50 characters maximum. Optional

Notes Text. No maximum. Optional

Visitor True/False

Each attendee/visitor must be a separate line entry. You use the Add Booking 
Details Wizard to import this file. You can click Print Format on the second page 
of the Add Booking Details Wizard to see the required format for the tab-delimited 
file.
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4. In the Bookings pane, click Tools, and then Click Add Booking Details Wizard.

The Add Booking Details wizard opens.

Figure 11-13: Add Booking Details wizard

5. Select Visitors or Attendees, and then click Next.

The second page of the Add Booking Details Wizard opens with a blank row for adding
an attendee/visitor to the event.

Figure 11-14: Add Booking Details Wizard, Second page
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6. Click Import.

The Open File dialog box opens.

7. Browse to and select the attendee/visitor import file, and then click Open to import the
file.

The Add Booking Details Wizard is updated with the imported attendee/visitor
information. Each imported attendee/visitor is a separate line entry in the Wizard.

Figure 11-15: Add Booking Details wizard, Attendees/Visitors imported

Optionally, you can click Print Format to see the required format for the 
tab-delimited file.



433

 
Other Reservation Functions

8. Click Next.

The Select Bookings window opens. This window displays all the bookings for the
selected reservation with a date greater than or equal to the current day’s date, and that
do not already have the selected booking detail added.

Figure 11-16: Add Booking Details wizard, Select Bookings window

9. CTRL-click to select the bookings to which the details are being added, or click Select
All to select all the displayed bookings in a single step, and then click Finish.

A message opens asking you if you want to add more booking details.

10. Click No.

A message opens indicating that the changes were made successfully.

11. Click OK to close the message and return to the Navigator.

The booking detail (Attendees/Visitors) and its items (individual attendees/visitors) are
displayed as folders under the appropriate booking folders in the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings. 
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Organizations with a mobile workforce or flexible work arrangements often adopt a hoteling 
or hot-desking strategy—allotting workspace on an as-needed basis to accommodate more 
people in less space. EMS Workplace is a facility scheduling system for managing hoteling 
requirements, as well as the booking of meeting/event space and resources. 

This chapter covers the following topics:

• “Managing Groups’ Check In/Check Out Statuses” on page 437.
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Managing Groups’ Check In/Check Out 

Statuses

Employees (referred to as “groups” in this section) can check in using a variety of active and 
passive EMS Workplace methods including Virtual EMS (VEMS), the EMS Kiosk, and your 
security badge system. You use the Group Check In Status tool to view the status of all 
employees, with or without bookings, who have checked into your building. In addition, 
options are available to check in/check out an individual and to manually “no show” 
employees who either have not checked in or have checked into another building.

To manage groups’ check in/check out statuses

1. On the EMS Workplace menu bar, click Reservations > Hoteling > Check In Status.

The Group Check In Status window opens. If this is the first time that you have opened
this window, then go to Step 2 to set the default values for your building and home city;
otherwise, go to Step 3.

Figure 12-1: Group Check In Status window
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2. In the upper right hand corner of the window, click Options to open the Options dialog
box and specify the default values for your home building and home cities.

Figure 12-2: Options dialog box

3. Specify the search criteria to search for the groups that you are checking into or checking
out of a building.

The home building is the building that selected groups are checked in to. You must 
separate multiple cities by commas, for example, Denver, Chicago, Atlanta. If 
Visitors Only is checked as one of the search options, then when you search for 
groups to verify their check in/check out status, the groups that have an address 
using any of these home cities are not returned in the search results. Only groups 
that do not have an address using any of these home cities and that meet all the 
search criteria are returned in the search results. 

Option Description

Building The default value is (all), but you can select a specific building, an area, 

or a view.

Group Type The default value is (all), but you can select a specific group type.

Event Type The default value is (all), but you can select a specific event type.

Floor The default value is (all), but you can select a specific floor.

Room Type The default value is (all), but you can select a specific room type.

Visitors Only Select this option only if you are searching for groups that do not have 

an address using any of the home cities that you have defined.

Not Checked In Only Select this option to search only for groups that have not been checked 

into the building.

Multiple Bookings Only Select this option to search only for those groups that have multiple 

bookings on the selected date.

Find Name Optional field. Enter a search string by which to filter your search. The 

search is not case-sensitive, but the search is limited to the exact order 

of characters in the string and the string must begin with the information 

for which you are searching. For example, a search string of ed returns 

Ed, Edward, Eddie, and so on, but not Ted or Fred.

Date The default value is the current day’s date, but you can select a different 

value.
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4. Click Display.

All the groups that meet all the search criteria and that have a booking or bookings on the
selected date are displayed on the With Bookings tab.

Figure 12-3: Group Check In Status window with results

5. Optionally, do one or more of the following:

• To view all the bookings that a group has scheduled in the selected building, select
the group on the With Bookings tab. The bookings are displayed on the <Building>
Bookings tab in the bottom pane of the Group Check In Status window.

Figure 12-4: Viewing bookings for a selected group

All the groups that meet all the search criteria but that do not have a booking or 
bookings on the selected date are displayed on the Without Bookings tab. 
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• To check in a group, select the group, and then click Check In. “Checked In” is
displayed in the Status column for the group on the With Bookings tab, the Date/
Time column are updated with the date and time that you clicked Check In, and
“Client” is displayed in the Source column.

• To check out a group, select the group, and then click Check Out. “Checked Out” is
displayed in the Status column for the group on the With Bookings tab, the Date/
Time column are updated with the date and time that you clicked Check Out, and
“Client” is displayed in the Source column.

• To end a booking for a group, select the group, and then select the booking on the on
the <Building> Bookings tab and click End Now. Answer “Yes” at the prompt about
ending the booking immediately.

• To open an event in the Navigator, select the event entry on the <Building>
Bookings tab, and then click Go To.

• To manually “no show” a group of employees, continue to “To run the No Show
Wizard” on page 441.

Remember, the group is checked in to the building that you set as your Home 
building, and the name of this building is displayed in the Building column.

If your EMS client is integrated with VEMS or EMS Kiosk, then employees can be 
checked in/checked out through either of these applications as well, and the 
Source column indicates this accordingly. 
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To run the No Show Wizard

You use the No Show Wizard to email all groups that have not checked in to a specific 
building. It also provides options for changing the status of a group’s bookings so that the 
group’s workspace is released.

1. Select the group on the With Bookings tab, and then click No Show.

The No Show Wizard opens.

Figure 12-5: No Show Wizard

2. Do one or both of the following:

• To send an email to the group, select Send Email to open an email form. Complete
and send the email as normally would, and then click Finish.

• To change the status for the group’s booking, select Change Status, and then on the
Status dropdown list, select a new status, and then click Finish.

When you run the No Show Wizard from the Group Check In Status window, you 
must manually create and send the email, and you must manually change the 
status. Both of these processes can be automated by creating a No Show 
Notification rule. Contact your EMS administrator for assistance.

You can include variables in the subject line as described in the Legend. For 
example, %2% is the code for the group name, so “Notification for %2%” would 
result in “Notification for Academic Affairs” being displayed in the subject line.
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Academic Planning is an optional component of the EMS software that provides all the 
functionality that is necessary for Domain Schedulers to ensure that every class meets in a 
location and at a time that is acceptable to departments and instructors. The system provides 
automatic room assignment within user-supplied parameters, integration with your SIS/ERP 
software, and efficient online collaboration tools. It also simplifies final exam scheduling 
and offers a selection of reports to streamline and analyze the room scheduling process. 
When added to the functionality that meeting and event staff already have access to, it 
provides a complete campus-wide space management package referred to as EMS Campus.

This chapter covers the following topics:

• “Overview of the Academic Scheduling Process” on page 445.

• “Importing an Academic Term” on page 449.

• “Defining and Editing Courses” on page 455.

• “Specifying Room Preferences” on page 485.

• “Assigning Room Preferences and Optimizing” on page 503.

• “Publishing a Term” on page 529.

• “Post-Publishing Phase” on page 541.

• “Using the Academic Tools” on page 577.

• “Generating Academic Reports” on page 601.
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Overview of the Academic Scheduling Process

The academic scheduling process is a multi-step process for enabling online communication 
between the Domain Scheduler and academic units, optimizing academic space use, and 
creating reservations in EMS Campus for academic courses. To use the full functionality of 
EMS Campus, it is important that you understand the academic scheduling specific terms 
that are used in EMS Campus and that you have a high-level understanding of the academic 
scheduling configuration process. 

Academic scheduling specific terms used in EMS Campus

While meeting/event scheduling and academic scheduling have many features in common, 
EMS Campus uses terms that are specific to the academic scheduling configuration process.

Term Definition

SIS Generic acronym that is used in EMS Campus to represent a Student 

Information System. A system parameter controls the term “SIS,” and 

typically, your EMS administrator changes it to the system-specific term 

that your organization uses, for example, PeopleSoft, Banner, 

Colleague, and so on.

Academic Term Defines a set of courses that is taught for a specific time period and is 

synchronized from the SIS.

Instructors Instructors are imported from your SIS. Instructors determine who is 

teaching a course. They are also referred to as a “contact” after 

publishing.

Subject Subjects are imported from your SIS. Subjects describe the topic of the 

course offered, for example, Math or English. Subjects are assigned to 

domains and academic units to designate who manages the courses 

that are taught within a subject.

Course Type A course type is imported from your SIS. Course types categorize 

offerings, for example, a lecture or a lab. Course types are used for 

limiting the types of rooms in which a course can be taught and for 

reporting.

Domain A level of organization within the institution that defines scheduling 

responsibility. The subjects defined within a domain determine the 

courses that are listed for the domain. The rooms that are defined within 

a domain determine all spaces that are potentially available for the 

courses. Functions such as synchronizing, optimizing, and running 

reports are carried out on a per domain basis. (A user who has this type 

of access is referred to as a Domain Scheduler.) The term “domain” is 

controlled by a parameter, and in many cases it is changed to “Campus” 

or “School” to better describe how course scheduling is divided.
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Academic Unit A level of organization within the institution that defines responsibility for 

making schedule requests for a portion of a domain. The rooms that are 

defined within an academic unit give the unit the ability to require these 

spaces during optimization. The subjects that are defined within an 

academic unit determine the courses that are listed when filtering by the 

unit. Academic units are used when assigning permissions to Academic 

users and when filtering reports. The term “academic unit” is controlled 

by a parameter, and in many cases it is changed to “Department” or 

“Division” to better describe how course scheduling requests are 

divided.

Campus Planning 

Interface

The web-based interface that is typically used by academic units to 

review course schedule data and communicate changes to the domain 

scheduler. Any computer with a standard Internet browser can be used 

to access the Campus Planning Interface.

Course Equivalent to a section in the SIS. The high level descriptor of a class, 

such as “CHEM 101 - Introduction to Chemistry,” and other associated 

information such as instructor and estimated enrollment. After a course 

is published, it becomes the reservation-level information.

Course Date A unique meeting pattern that is associated with a course, such as 

Tuesday/Thursday, 8:00 am to 9:20 am. Courses can have multiple 

course dates, such as when a class has both a lecture and a lab 

component that meet on different days of the week and at different 

times. After a course date is published, it becomes the booking-level 

information.

Cross-listed Courses Courses are designated in the SIS as cross-listed for a variety of 

reasons; however, after such a designation is made, there are 

implications in how EMS handles the courses. If two or more courses 

are cross-listed and have identical course date records (meeting 

patterns), then these two courses are linked and they are assigned the 

same room during optimization and final exam scheduling. They, in 

essence, share space by default.

Shared Space If two courses that have identical course date records are to be 

scheduled in the same room at the same time, but they are not cross-

listed in the SIS, then they can be designated as Shared Space in EMS. 

This designation links the courses so that they are assigned to the same 

room during optimization and final exam scheduling. This designation 

does not affect the SIS.

Term Definition
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Academic scheduling configuration process

Before academic scheduling can even be carried out, the following must be in place in your 
EMS database:

• Core data—building, rooms, instructors, course types, and subjects—must be
synchronized with the Student Information System (SIS).

• Academic domains and academic units must be configured.

• Academic users must be configured with the appropriate security settings.

• Default values for academic parameters must be set.

Although the academic scheduling configuration process varies from one academic site to 
another, typically, the same two-phase process, the Academic Planning phase and the Post-
Publishing phase, is carried out, and each process typically has the same high-level steps.

Academic Planning phase

The Academic Planning Phase is the first phase carried out in the academic scheduling 
process. This phase typically has the following high-level steps:

1. Importing an Academic Term. See “Importing an Academic Term” on page 449.

2. Defining and Editing Courses. See “Defining and Editing Courses” on page 455.

3. Settings Preferences. See “Specifying Room Preferences” on page 485.

4. Assigning rooms and optimizing. See “Assigning Room Preferences and Optimizing” on
page 503.

5. Publishing terms in EMS. See “Publishing a Term” on page 529.

Post-Publishing phase

The Post-Publishing Phase is the second phase carried out in the academic scheduling 
process. This phase typically has the following high-level steps:

1. Reviewing reservations and resolving room assignments. See “Post-Publishing Phase”
on page 541.

2. Creating a synchronization schedule. See “Post-Publishing Phase” on page 541.

3. Creating and publishing a final exam session. See “Post-Publishing Phase” on page 541.

See the EMS Setup Guide for detailed instructions about configuring and 
synchronizing this needed academic data.

You can carry out Step 2 and Step 3 individually, or you can carry them out 
simultaneously using Dual Mode. Dual Mode is explained in detail later in this 
manual.
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Section Contents

• Overview of Importing an Academic Term on page 451

• Synchronizing an Academic Term on page 452

• Synchronizing Courses on page 453
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Overview of Importing an Academic Term

The first step in the academic planning phase is to import a term. Importing an academic 
term consists of the following three steps:

1. A new term is created in the Student Information System (SIS), either by rolling forward
a previous term, or by creating it from scratch. The term is then synchronized into EMS.
See “Synchronizing an Academic Term” on page 452.

2. The Domain Scheduler synchronizes course data from the SIS into EMS Campus. See
“Synchronizing Courses” on page 453.

3. Synchronized courses are reviewed before the term is made available to academic units.
See “Using the Academic Tools” on page 577.
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Synchronizing an Academic Term

When you synchronize your Student Information System (SIS) term data, all the SIS terms 
are flagged with a status of New. To create these terms in your EMS database, you select 
each term, click Create, and then Process.

To synchronize an academic term

1. On the EMS Campus menu bar, click Academic Planning > Configuration >
Synchronize Terms.

The EMS Campus Terms window opens.

Figure 13-1: EMS Campus Terms window

2. Select the SIS term, or CTRL-click to select the multiple SIS terms that you are creating
in your EMS database, click Create, and then click Process.

A message opens indicating that the terms were successfully processed.

3. Click OK to close the message and return to the EMS Campus Terms window.

The status of the terms is set to Synchronized to indicate that the SIS data has been
synchronized.

4. Click Cancel or Close (x) to close the window.

If you do not want to create an SIS term in your EMS database, select the term, 
and then click Do Not Import.
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Synchronizing Courses

After you synchronize terms, the term record that is created in EMS is initially empty. You 
must then synchronize the courses.

To synchronize courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-2: Terms window

2. On the Domain dropdown list, select the domain for which you are synchronizing the
term.

3. Select the term for which you are synchronizing the courses, and then click Sync.

Two results are possible:

• If the term contains edited courses, then a message that states the following opens:
WARNING: You have made changes to 'n' Course(s) in “Define & Edit Mode” that
will be overwritten. Is it OK to continue. You must click Yes to continue and then a
Synchronizing Courses dialog box opens that shows the progress of the course
synchronization. When the courses are synchronized, a dialog box opens with the
message that the courses were synchronized.

• If the term does not contain edited courses, then a Synchronizing Courses dialog box
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opens that shows the progress of the course synchronization. When the courses are 
synchronized, a dialog box opens with the message that the courses were 
synchronized.

4. Click OK to close the message and return to the Terms window.

After you synchronize the courses, you can review them in the Academic Browser. 
See “Searching with the Academic Browser” on page 579.
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• Reviewing and Editing Courses on page 461

• Working with Shared Space on page 475
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Overview of Defining and Editing Courses

After the Domain Scheduler has imported a term and synchronized the courses for the term, 
he/she has the option of selecting the mode for the term. Each mode is optional, but each 
mode provides mode-specific functionality so that the mode can be carried out. 
Organizations use the Define & Edit mode to solicit information about new, changed, or 
canceled courses, or course dates for a term. Additionally, courses that share space can be 
indicated. After the academic units enter this information, the Domain Scheduler can run 
reports and based on the information in the reports, make the selected modifications in the 
SIS.

1. The Domain Scheduler enables Define & Edit Mode. See “Enabling/Disabling a Term
for Define & Edit Mode” on page 458.

2. Academic units review the course schedule data, make change requests as appropriate
for new, edited, and/or canceled courses, and mark those courses that share space. See
“Reviewing and Editing Courses” on page 461 and “Working with Shared Space” on
page 475.

3. The Domain Scheduler generates and reviews the Course Change report, enters the
needed modifications into the SIS, and resynchronizes the courses. See “Synchronizing
Courses” on page 453.

4. The Domain Scheduler reviews and/or indicates the shared space settings. See “Working
with Shared Space” on page 475.

When you are defining and editing courses, you have the option of selecting 
Define and Edit mode, or Dual mode. Dual mode enables a term for both Define 
& Edit Mode and Set Preference mode at the same time. If you select Define and 
Edit mode, then the steps that you carry out during this mode are distinct and 
unique from the steps that you carry out in the next mode, which is the Set 
Preferences mode. Although these two modes are presented as distinct modes and 
discussed in two separate sections in this manual, if you select Dual mode, then 
the steps listed in both these sections are applicable at the same time.
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Enabling/Disabling a Term for Define & Edit 

Mode

After you have imported a term and synchronized the courses for the term, you can set the 
mode to Define & Edit and make the term available to the academic units.

To enable/disable a term for Define & Edit mode

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-3: Terms window

2. On the Domain dropdown list, select the appropriate domain.
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3. Select the term for which you are setting Define & Edit mode, and then click Edit.

The Term dialog box opens. The Term tab is the active tab.

Figure 13-4: Term dialog box

4. Optionally, in the Phase and Notes fields, enter information that indicates to the
academic units what part of the academic scheduling process is currently taking place,
for example, “Course Review,” or “Planning” along with any supporting information or
instructions.

5. Do one of the following:

• If academic unit-level users are to have access to the term, select Available to
Academic Units.

• To remove the users’ access to the term, clear Available to Academic Units.

6. Optionally, if you have configured time block templates, select the appropriate template
for this term.

If you are going to select Dual mode, then make sure to note that both course 
review/planning and setting preferences are currently taking place. Academic 
units can view this information in the Campus Planning Interface.

At this stage, the only active scenario that is available is SIS, and you cannot 
change this value.



460

 
Academic Planning (EMS Campus)

7. Select the enrollment that is to be compared to room capacity throughout the academic
planning process.

8. In the Mode section, do one of the following:

• To enable Define & Edit mode, select Define & Edit Courses.

• To disable Define & Edit mode, select Read Only or Set Preferences.

• To enable both Define & Edit mode and Set Preferences mode, select Dual.

9. Click OK to close the Term dialog box and return to the Terms window, with the term
still selected in the window.

10. On the Terms window, click Email to open an email that is pre-addressed to all academic
unit-level users that have been defined in your EMS database. Complete and send the
email as you normally would.

Figure 13-5: SMTP Email window
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Reviewing and Editing Courses

After a term has been made available to the academic units, the academic units can begin 
reviewing their courses and requesting additions, deletions, and modifications as appropriate 
using the Campus Planning Interface (typical) or the EMS Campus desktop client (if granted 
access). 

To review and edit courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-6: Academic Browser, Filter tab

3. Make sure that the Browse For option is set to Courses.

4. On the Domain dropdown list, select the appropriate domain and then on the Term
dropdown list, select the appropriate term.
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5. Continue to one of the following:

• “To add a new course in EMS Campus” below.

• “To add a new section for a course” on page 464.

• “To add a course date in EMS Campus” on page 465.

• “To edit a course in EMS Campus” on page 467.

• “To edit a course date in EMS Campus” on page 469.

• “To cancel a course date in EMS Campus” on page 471.

• “To cancel a course in EMS Campus” on page 473.

To add a new course in EMS Campus

1. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating an existing course, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

2. Click New Course.

The New Course dialog box opens. The Course tab is the active tab.

Figure 13-7: New Course dialog box

3. Complete the required information—title, course number, section, subject, instructor,
estimated enrollment, credit hours, course type—on the Course tab.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.
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4. For each course meeting pattern (days and times) that you are adding to the new course,
do the following:

• In the Course Dates section, click New to open the Course Dates dialog box and on
the Course Type dropdown list, select the course type.

• Do one of the following:

• Manually enter the meeting pattern information (start and end dates, start and
end times, and meeting days) for the course.

• Click Time Blocks to open the Time Blocks dialog box, and then select a time
block from a list of time blocks that have been made available for the term.

Figure 13-8: Course Dates dialog box

5. Optionally, in the Notes field, enter any information about the course that might be
relevant to the Domain Scheduler.

6. Open the User Defined Fields tab, and for any user-defined questions that are displayed
on the tab, do the following:

• Select the question, and then click Set Value to open a dialog box in which you can
enter the answer to the question.

• Click OK to close the dialog box and return to the User Defined Fields tab.

7. Click OK to close the New Course dialog box and return to the Academic Browser.

Make sure to select Room Not Required if the course does not require a room, for 
example, an independent study class, a research class, and so on.

Depending on how your EMS administrator has configured EMS Campus, only 
the Time Blocks option might be available to you.

User-defined fields, or UDFs, are typically used by a Domain Scheduler to solicit 
additional user-supplied information about a course. 
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8. Click Refresh.

“New” is displayed for the course state.

To add a new section for a course

To add a new section of an existing course, you must copy an existing course, and then edit 
the section number and any other pertinent information.

1. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating an existing course, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

2. Select the course that is to be copied, and then click New Section.

The New Section dialog box opens. The fields are automatically populated with the
information for the copied course.

Figure 13-9: New Section dialog box

3. Edit the section number and any other pertinent information as needed, and then click
OK.

A message opens indicating that the course was created successfully.

If you have selected Dual mode for the term, then you can set preferences during 
this step as well. See “To use the Course Navigator to set preferences and 
requirements” on page 498.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.

Depending on how your EMS administrator has configured EMS Campus, only 
the Time Blocks option might be available to you. 
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4. Click OK to close the message and return to the Academic Browser.

To add a course date in EMS Campus

To add a new date to a course in EMS Campus, you must find the course using the Academic 
Browser, and then edit the course date and other pertinent information in the Course 
Navigator.

1. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the course, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

2. In the search results, double-click the course to which you are adding a course date.

The course opens in the Course Navigator.

Figure 13-10: Course opened in the Course Navigator

If you have selected Dual mode for the term, then you can set preferences during 
this step as well. See “To use the Course Navigator to set preferences and 
requirements” on page 498.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.
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3. Click New.

The New Course Dates dialog box opens.

Figure 13-11: New Course Dates dialog box

4. For each new course meeting pattern (days and times) that you are adding to the course,
do the following:

• On the New Course Dates dialog box, click New to open the Course Dates dialog
box and on the Course Type dropdown list, select the course type.

• Do one of the following:

• Manually enter the meeting pattern information (start and end dates, start and
end times, and meeting days) for the course.

• Click Time Blocks to open the Time Blocks dialog box, and select a time block
from a list of time blocks that have been made available for the term.

Figure 13-12: Course Dates dialog box

Make sure to select Room Not Required if the course does not require a room, for 
example, an independent study class, a research class, and so on.
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5. Click OK to close the Course Dates dialog box, and then click OK to close the New
Course Dates dialog box and return to the Course Navigator.

The state for each newly added course date is set to “New” in the middle pane of the
Course Navigator.

To edit a course in EMS Campus

To edit a course in EMS Campus, you must find the course using the Academic Browser, and 
then edit the course information in the Course Navigator.

1. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the course, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

2. In the search results, double-click the course that you are editing.

The course opens in the Course Navigator. See Figure 13-13 on page 468.

Depending on how your EMS administrator has configured EMS Campus, only 
the Time Blocks option might be available to you. 

If you have selected Dual mode for the term, then you can set preferences during 
this step as well. See “To use the Course Navigator to set preferences and 
requirements” on page 498.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.
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Figure 13-13: Course opened in the Course Navigator

3. Click edit in the top pane of the Navigator.

The Course dialog box opens.

Figure 13-14: Course dialog box

4. Edit the course information as needed, and then click OK to close the Course dialog box
and return to the Course Navigator.

The course state is set to “Edited” in the top pane of the Course Navigator.
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To edit a course date in EMS Campus

To edit a course date in EMS Campus, you must find the course using the Academic 
Browser, and then edit the course date in the Course Navigator.

1. Set any other criteria (academic unit, subject and so on) as needed to provide assistance
in locating the course, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

2. In the search results, double-click the course for which you are editing the course date.

The course opens in the Course Navigator.

Figure 13-15: Course opened in the Course Navigator

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.
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3. In the middle pane of the Course Navigator, select the course date record that you are
editing, and then click Edit.

The Course Dates - (SIS) dialog box opens.

Figure 13-16: Course Dates - (SIS) dialog box

4. Edit the course dates as needed.

• To edit the course dates, do one of the following:

• Manually edit the start/end dates, start/end times, course type, and/or the days
that the course meets.

• Click Time Blocks to open the Time Blocks dialog box, and select a time block
from a list of time blocks that have been made available for the term.

• The room assigned to this course in the SIS is listed in the SIS Room text box. You
cannot edit this value; however, make sure to select Room Not Required if this
course date does not require a room (for example, independent study, research, and
so on).

Depending on how your EMS administrator has configured EMS Campus, only 
the Time Blocks option might be available to you. (You cannot manually edit the 
course days and times.)
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• The Seat Fill Percentage, in conjunction with the estimated enrollment, is used to
determine the size of the room needed for the class. For example, a Seat Fill
Percentage of 50% and an estimated enrollment of 100 means that the course should
be held in a room that can accommodate 200 people.

• If you are editing a course date for a course that is cross-listed or sharing space with
another course, you are provided with an option in the bottom pane of the Course
Dates dialog box to apply your changes to the related course dates. To apply changes
to the cross-listed courses, check the appropriate course date listings.

Figure 13-17: Applying changes to related course dates

5. Click OK to close the Course dialog box and return to the Course Navigator.

The course date state is set to “Edited” in the middle pane of the Course Navigator.

To cancel a course date in EMS Campus

To cancel a course date in EMS Campus, you must find the course using the Academic 
Browser, and then cancel the course date in the Course Navigator.

1. Set any other criteria (academic unit, subject and so on) as needed to provide assistance
in locating the course, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

The Seat Fill Percentage is initially set to the default value that is specified in 
EMS (Campus) system parameters, but you can update the value on a per course 
date basis. See System Parameters in the EMS Setup Guide.

If you have selected Dual mode for the term, then you can set preferences during 
this step as well. See “To use the Course Navigator to set preferences and 
requirements” on page 498.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.
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2. In the search results, double-click the course for which you are canceling a course date.

The course opens in the Course Navigator.

Figure 13-18: Course opened in the Course Navigator

3. In the middle pane of the Course Navigator, select the course date record that you are
canceling, and then in the top pane of the Navigator, click Cancel.

A dialog box opens, asking you if it is OK to cancel the selected course.

4. Click Yes to close the dialog box and return to the Course Navigator.

The course date state is set to “Cancelled” in the middle pane of the Course Navigator.

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.

To reverse a course date cancellation, select the canceled course date in the 
Course Navigator, and then click Uncancel.
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To cancel a course in EMS Campus

To cancel a course in EMS Campus, you must find the course using the Academic Browser, 
and then cancel the course in the Course Navigator.

1. Set any other criteria (academic unit, subject and so on) as needed to provide assistance
in locating the course, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

2. In the search results, double-click the course that you are canceling.

The course opens in the Course Navigator.

Figure 13-19: Course opened in the Course Navigator

3. In the top pane of the Navigator, click Cancel.

A dialog box opens, asking you if it is OK to cancel the selected course.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.
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4. Click Yes to close the dialog box and return to the Course Navigator.

The course state is set to “Cancelled” in the top pane of the Course Navigator. The state
for every course date that is displayed in the middle pane of the Course Navigator is also
set to “Cancelled.”

To reverse a course cancellation, open the canceled course in the Course 
Navigator, and then in the top pane of the Course Navigator, click Uncancel.
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Working with Shared Space

The shared space designation is used for two or more courses that are not cross-listed in the 
SIS, but that have matching patterns and are meant to be held in the same room. The shared 
space designation links the courses together for the set preferences, optimization, publishing, 
and final exam scheduling functions. Shared space is assigned in a parent-child relationship. 
If needed, you can change the parent designation. In addition, if a course that is cross-listed 
in the SIS is not meant to be held in the same room, or if courses that are marked as shared 
space are no longer meant to share space, then you can reverse the shared space designation. 
You can also review shared spaced designations.

To assign shared space to courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-20: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.

Academic units that have the appropriate permissions can indicate shared space 
using the Campus Planning Interface. You might want to review these shared 
space settings before working with shared space.
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4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the courses that are to share space, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

5. CTRL-click to select the courses that are to share space.

6. On the Tools menu, click Shares Space.

A message opens asking you if you are sure that the selected courses are to share space?

7. Click Yes.

The message closes and you return to the Academic Browser. The Shares Spaces
designation is indicated in the browser. The parent item is indicated with *Parent, and
the child item is indicated with the parent’s Course Number and Section Number.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.
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To change the parent designation for shared space/cross-listed 

spaces

When you set the shared space designation for courses, EMS Campus arbitrarily specifies 
one of the courses as the parent course. The academic unit that controls the parent course is 
the unit that sets the preferences for the shared courses in the Set Preferences mode. If the 
academic unit that you want to set the preferences in the Set Preferences mode is not 
currently the parent course, then you can change the parent designation for the courses. Also, 
after you publish courses, you can change the room only for the parent course and the child 
course “just follows along.” If the course on which you want to base the room change is not 
currently the parent course, then you can change the parent designation for the courses.

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-21: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the shared spaces courses, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.
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5. CTRL-click to select the parent course and the child courses.

6. On the Tools menu, click Change Shared Space parent.

The Shares Space Change Parent dialog box opens. This dialog box lists the parent class
and all its child classes that share space.

Figure 13-22: Shares Space Change Parent dialog box

7. Select the course that is to be the new parent, and then click Set Parent.

A Set Parent dialog box opens, indicating that the selected course will be set as the
parent for all the listed courses, and asking you if it is OK to continue.

8. Click Yes.

The Set Parent dialog box closes. You return to the Academic Browser with the new
parent designation indicated in the browser.
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To reverse the shared space designation

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-23: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the courses that are to no longer share space, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

5. CTRL-click to select the courses that are to no longer share space.

6. On the Tools menu, click Does Not Share Space.

A message opens asking you if you are sure that the selected courses are to no longer
share space.

7. Click Yes.

The message closes. You return to the Academic Browser, with the Shared Space
designation removed for the selected courses.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.



480

 
Academic Planning (EMS Campus)

To review shared space designations

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-24: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the courses that you are reviewing, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab. Use the
information in the Shared Space column to identify and review the courses that share
space. You can also click the column heading to sort by shared space. See Figure 13-25
on page 481.

Academic units might designate shared space that they can review in the Campus 
Planning Interface.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.
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Figure 13-25: Academic Browser search results showing Shared Space designation
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Identifying New/Edited/Canceled Courses

After the academic units have made their modifications to the course schedule, you must 
identify and compile a list of modifications and enter the approved changes in the Student 
Information System (SIS). EMS Campus flags course changes using a field named Course 
State. New, edited, and canceled courses are marked as “New,” “Edited,” and “Cancelled,” 
respectively. Typically, you generate the Course Changes report to view and identify the 
requested course changes; however, if further clarification is needed, then you can use the 
Academic Browser and/or Course Navigator.

To identify new/edited/canceled courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-26: Academic Browser, Filter tab

For detailed information about generating the Course Changes report, and the 
information that is contained in the report, see “Generating Academic Reports” 
on page 601.

Prior to reviewing the modifications, you can remove access to the term from your 
academic units. See “Enabling/Disabling a Term for Define & Edit Mode” on 
page 458.
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3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the courses that you are reviewing, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab. Use the
information in the State column to identify the change made to each course that is listed.

Figure 13-27: Academic Browser search results with State column shown

5. Optionally, double-click a course to open the course in the Course Navigator and view
more detailed information about the course. See “Using the Course Navigator” on page
594.

6. After generating the list of course modifications, you must manually enter the approved
course changes in the SIS. After data entry is complete, the scheduler must carry out the
Sync Courses process (see “Synchronizing Courses” on page 453) to ensure that EMS
Campus and the SIS are synchronized.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.
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Overview of Specifying Room Preferences

Set Preferences is an optional mode in which the Domain Scheduler can solicit preferences 
from academic units about the type of rooms that would be suitable for each course that they 
teach. These preferences can then be used to run an optimization, or to have EMS automate 
room scheduling based on preferences and additional user-specified criteria. To enable and 
use Set Preferences Mode, the following steps are carried out:

1. The Domain Scheduler enables Set Preferences mode. See “Enabling/Disabling a Term
for Set Preferences Mode” on page 488.

2. The academic units review courses and specify their room preferences and requirements
using the Campus Planning Interface (typical) or the EMS Campus desktop client (if
granted access). See “Specifying Room Preferences/Requirements” on page 491.

3. The Domain Scheduler verifies and reviews the room preferences and requirements that
the academic units have specified. See “Reviewing and Verifying Room Preferences” on
page 501.
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Enabling/Disabling a Term for Set Preferences 

Mode

To enter the academic units’ room preferences and requirements, you must enable Set 
Preferences mode. Additionally, if you want to solicit these preferences and requirements 
from the academic units, you must make the term available to the academic units. Likewise, 
after the deadline has been reached for expressing room preferences and requirements, you 
must make the term unavailable to the academic units.

To enable/disable a term for Set Preferences mode

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-28: Terms window

]

2. On the Domain dropdown list, select the appropriate domain.
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3. Select the term for which you are setting the Set Preferences mode, and then click Edit.

The Term dialog box opens. The Term tab is the active tab.

Figure 13-29: Term dialog box

4. Optionally, in the Phase and Notes fields, enter information that indicates to the Domain
Scheduler what part of the academic scheduling process is currently taking place, for
example, “Enter Preferences,” or “Room Information” along with any supporting
information or instructions.

5. Do one of the following:

• To give academic unit-level users access to the term, select Available to Academic
Units.

• To remove the users’ access to the term, clear Available to Academic Units

6. If you did not select Dual mode, then in the Mode section, select Set Preferences.

7. Click OK to close the Term dialog box and return to the Terms window, with the term
still selected in the window.

Remember, if you selected Dual mode, (see “Specifying Room Preferences” on 
page 485) then the Set Preferences mode has already been enabled for this term.

The Phase field and the Notes field are displayed in the Campus Planning 
Interface.
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8. On the Terms window, click Email to open an email that is pre-addressed to all academic
unit-level users that have been defined in your EMS database. Complete and send the
email as you normally would.

Figure 13-30: SMTP Email window
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Specifying Room Preferences/Requirements

After you place the term in Set Preferences mode, three options that can be used in 
conjunction with each other are available for completing the preferences and requirements 
phase. In addition, you can complete the phase independently, or you can solicit input from 
the academic units.

• You can use the Manage Terms Copy Preferences tool to copy the preferences and
requirements from a previous term. See “To use the Manage Terms Copy Preferences
tool” on page 493.

• You can use the Academic Browser Set Course Preferences tool to set preferences and
requirements for multiple courses in a single step. See “To use the Academic Browser Set
Course Preferences tool” on page 495.

• You can use the Course Navigator to set preferences and requirements on a course by
course basis. See “To use the Course Navigator to set preferences and requirements” on
page 498.

For any of these methods, the following caveats apply:

• An academic unit -level user can request any building, area, or view and up to three rooms 
that have been defined for the domain with which it is associated.

• An academic unit can require only those buildings and rooms that have been assigned to
its unit within the Academic Planning > Configuration > Academic Units area of EMS
Campus. If the academic units specify requirements, then only a single room can be
specified.

• Room types can be requested or required for all courses. By default the “limit by course
type” selection is designated, but you can change it to honor a specific room type.

If a course must take place in a specific room that you plan to exclude from 
optimization, you can pre-assign it to a specific room. This process is outlined 
during the Scenario phase. See “To create a pre-assignment scenario” on page 
513.

If needed, you can set the Lock Academic Unit Room Access system parameter to 
limit the users to their specific academic units. See System Parameters in the EMS 
Setup Guide.

Configuration of the Course Types/Room Types matches is carried out in the 
Academic Planning > Configuration > Match Course Types/Room Types area of 
EMS Campus. See the EMS Setup Guide for detailed information.
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• You can set features to Preferred or Required. The # of Rooms Available label that is
displayed above the Features pane is dynamically updated based on the building, room
type, and features selected.

• The Seat Fill Percentage, in conjunction with the estimated enrollment, is used to
determine the size of the room needed for the class. For example, a Seat Fill Percentage
of 50% and an estimated enrollment of 100 means that the course should be held in a room
that can accommodate 200 people.

• Ignore Term Excluded Dates schedules bookings on all dates that adhere to the meeting
pattern, regardless of the Excluded Dates that are marked on the term when the course
dates are published.

• Publish In SIS Room (No Optimization) allows the course dates to avoid the optimization
process. Bookings are published in the room that was carried over from the SIS.

• Require SIS Room flags buildings/rooms that come across from the SIS as Required.
Courses with requirements still go through the optimization process.

• Requires Different Room (For Courses That Share Space) identifies a meeting pattern that 
should be in its own room despite the cross-listed or shared space status. You can set
preferences for this room.

• Same Room (ALL Selected Course Dates are to be in the same Room) flags courses that
should be in the same room but at different times when optimized.

The Seat Fill Percentage is initially set to the default value that is specified in 
EMS (Campus) system parameters, but you can update the value on a per course 
date basis. See System Parameters in the EMS Setup Guide.
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To use the Manage Terms Copy Preferences tool

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-31: Terms window

2. Click Copy Prefs.

The Copy Preferences dialog box opens.

Figure 13-32: Copy Preferences dialog box
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3. In the Copy Preferences From pane, select the domain and term from which you want to
copy room preferences and requirements.

4. In the Copy Preferences To pane, do the following:

• Select the domain and term to which you want to copy your room preferences and
requirements.

• Indicate if the preferences are to be copied only if the instructors match.

5. Click OK.

A message opens, informing you that copying preferences will overwrite any existing
preferences, and asking you if it is OK to continue.

6. Click Yes.

The message closes. After the preferences are copied, you return to the Terms window.

A term can be displayed in the To pane only if it is in Set Preferences mode.

Preferences are copied based on the Course Section (Math 101 01) and Course 
Type information (lecture or lab). If you have added new sections or changed 
course type designations on course dates within a section, then even after you 
complete this procedure, some courses still will not have preferences. Be sure to 
review your list of courses and set preferences where applicable.
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To use the Academic Browser Set Course Preferences tool

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-33: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.

4. Set any other criteria (academic unit, subject and so on) as needed to provide assistance
in locating the courses for which you want to set preferences and requirements, and then
click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

5. CTRL-click to select the courses for which you are setting the room preferences and
requirements.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.
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6. On the Tools menu, click Set Course Preferences.

The Set Course Preferences dialog box opens.

Figure 13-34: Set Course Preferences dialog box

7. Indicate whether the preferences that you set are to override any existing preferences, or
whether they are to be added to existing preferences.

8. Set your preferences for the selected courses. See “Specifying Room Preferences/
Requirements” on page 491.

9. Optionally, do one or both of the following:

• In the Notes field, enter any pertinent or supporting information that substantiates or
explains your preferences.

• By default, the preferences/requirements that you specify are applied to all course
dates for all selected courses. If the preferences/requirements are applicable for only
specific course dates, open the Selected Course Dates tab, select the course dates for
which these preferences/requirements are not applicable and then click Remove.



497

 
Academic Planning (EMS Campus)

10. Click OK.

Two results are possible:

• If any of the selected courses are cross-listed and/or share space, and you did not
select the corresponding cross-listed/shared space courses, then a Related Course
Dates dialog box opens. This dialog box lists all the related courses that have not
been selected. Go to Step 11.

• If none of the selected courses are cross-listed and/or share space, then a message
opens indicating whether the selected preferences will override any existing
preferences, or be added to existing preferences and asking you if it is OK to
continue. Go to Step 12.

Figure 13-35: Related Courses Dates

11. Optionally, select any or all of the related courses for which you want to set the same
preferences/requirements, or do not select any of these related courses, and then click
OK.

A message opens indicating whether the selected preferences will override any existing
preferences, or be added to existing preferences and asking you if it is OK to continue.

12. Click Yes.

The message closes and another message opens indicating that the preferences were set
successfully.

13. Click OK to close the second message and return to the Academic Browser.
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To use the Course Navigator to set preferences and requirements

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-36: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the courses for which you want to set preferences and requirements, and then
click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

5. In the search results, double-click the course for which you are setting the preferences/
requirements.

The course opens in the Course Navigator. See Figure 13-3 on page 458.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.
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Figure 13-37: Course opened in the Course Navigator

6. In the middle pane of the Navigator, select the specific course date for which you are
setting preferences/requirements, and then click Edit.

The Course Dates dialog box opens.

Figure 13-38: Course Dates dialog box
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7. Set the preferences/requirements for the course as needed, and then click OK. See
“Specifying Room Preferences/Requirements” on page 491.

The Course Dates dialog box closes and you return to the Course Navigator. The
preferences/requirements that you set for the course date are displayed on the
Preferences tab in the lower pane of the Navigator.



501

 
Academic Planning (EMS Campus)

Reviewing and Verifying Room Preferences

After room preferences and requirements are set, you can review the individual course 
preferences, verify that the preferences are complete, and quantify these preferences. You 
can also run the Course Preferences report and the Course Preferences Summary report to 
assist in this task.

To review and verify room preferences

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-39: Academic Browser, Filter tab

For detailed information about generating the Course Preferences and Course 
Preferences Summary reports and the information that is contained in each report, 
see “Generating Academic Reports” on page 601.

Prior to reviewing or reporting on preferences, you can make the term unavailable 
to the academic units. See “Enabling/Disabling a Term for Set Preferences Mode” 
on page 488.
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3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the courses for which you want to review preferences and requirements, and
then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

5. In the search results, double-click the course for which you are reviewing the
preferences/requirements.

The course opens in the Course Navigator.

6. In the middle pane of the Course Navigator, select the course date for which you are
reviewing the preferences.

The preferences for the selected course date are displayed in the bottom pane of the
Course Navigator on the Preferences tab.

Figure 13-40: Course opened in the Course Navigator showing preferences

To identify preferences and requirements for a Basic search, you should set 
Preferences Exist to Yes. For an Advanced search, you should select the 
Preferences Exist field (a Course Dates level field), and set the Preferences Exist 
filter to Yes. For detailed information about searching with the Academic Browser, 
see “Searching with the Academic Browser” on page 579.

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.
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Overview of Room Assignments and 

Optimization

After the Domain Scheduler reviews and verifies the room preferences and requirements, 
room assignments must take place. If the room assignment process has already occurred 
outside of EMS within the SIS, the Domain Scheduler could simply publish the course 
schedule in EMS without any further effort. In most situations, however, courses will need to 
be assigned a room through the optimization process before the term can be published. To 
optimize the room assignments, and then assign rooms, the Domain Scheduler carries out the 
following steps either separately or in any combination as necessary to best suit their 
working needs: 

1. Pre-assignment—The Domain Scheduler manually assigns a selection of courses to
rooms. Typically, the manual assignment takes place if these rooms are to be excluded in
an optimization scenario after pre-assignment. For instance, if only a swimming course
should be assigned to “Pool,” then the Domain Scheduler could manually pre-assign
Swimming and then exclude the pool in the optimization scenario. See “About Creating
Scenarios and Optimization” on page 506 and “Creating Scenarios” on page 513.

2. Optimization—The EMS system automatically assigns rooms to courses based on
course preferences, requirements, and weighted criteria. See “About Creating Scenarios
and Optimization” on page 506 and “Creating Scenarios” on page 513.

3. Locking In Assignments—After carrying out an optimization scenario, the Domain
Scheduler locks in desired room assignments, and then re-optimizes the remaining
portion of the optimization scenario. See “Assigning Rooms” on page 522.

4. Evaluating Optimization Scenarios—The Domain Scheduler can test an unlimited
number of potential scenarios and compare results using various tools before choosing
the final scenario for publishing. See “Evaluating Optimization Scenarios” on page 527.

The information in this section is presented as an ordered series of standalone 
procedures; however, the Domain Scheduler can carry out any of the procedures 
either separately or in any combination as necessary to best suit his/her working 
needs. This allows the Domain Scheduler to test a number of potential scenarios 
and compare placement results using various tools before choosing the final 
scenario for publishing.
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About Creating Scenarios and Optimization

You create scenarios to test room assignments that have been given to courses for a term. In 
EMS, you can create two types of scenarios—a pre-assignment scenario and an optimization 
scenario. A pre-assignment scenario is a scenario in which a selection of courses are 
manually assigned to rooms, typically because the assigned rooms are to be excluded in an 
optimization scenario. In a pre-assignment scenario, the assignments are automatically 
considered “locked in.” An optimization scenario is a scenario in which EMS automatically 
assigns rooms to courses based on course preferences, requirements, and weighted criteria. 
The optimization process can support simultaneous optimization of all academic units, 
incremental optimization by academic unit, and/or a combination of pre-assignment and 
automated optimization. 

In the optimization process, a ranking is assigned to each course in a term. Rooms are 
assigned one course at a time based on the order of these rankings (from the most important 
ranking of one to the least important ranking of “n”). Throughout the optimization process, 
the Optimizer considers room capacity (the course’s adjusted enrollment must fit within a 
room’s capacity), looks for the best seat fill (a room with a capacity* that most closely 
accommodates the estimated enrollment), and the best room utilization (completely filling 
one room before moving on to another room with equal attributes) to achieve the best room 
optimization possible. You use the options that are available on the Scenario dialog box to 
create optimization scenarios.

*The room's capacity based on the setup type that has been defined for the Default
Setup Type parameter in the Campus area.
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Scenario dialog box

The Scenario dialog box has three tabs—Scenario, Excluded Rooms, and Audit. You use the 
options on the Scenario tab and Excluded Rooms tab when you are creating, evaluating, and 
testing scenarios.

Figure 13-41: Scenario dialog box, Scenario tab

The following options are available on the Scenario tab of the Scenario dialog box for 
creating a scale of weighed criteria for a scenario:

Option Description

Locked Locks the room assignments for the selected Optimization scenario. 

You can clear this option to unlock the scenario and carry out 

optimization.

Back to Back Gap Minutes Instructors are considered to be teaching Back to Back courses 

when their consecutive teaching assignments fall within the 

indicated time period. (The end time of one class and the start time 

of the next class fall within the indicated time period.) The default 

value is 15 minutes.

Boost Requirement Weights Select this option to increase the weights of preferences that are 

marked as requirements to 150% of their assigned weights. 
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Standard Weights All courses are assigned points in an optimization scenario based 

on factors and selected preferences. The sum total of these points 

determines the ranking for a course. Factors are always included in 

any optimization scenario; however, you can exclude the standard 

weight of a factor, which means that the factor does not contribute 

to the total number of points for a room assignment ranking for a 

course but it is still considered when searching for a room.

• Instructor Importance—Instructor Importance is assigned in the

Academic Planning (Configuration > Instructors) area of EMS

Campus. The indicated weight is given to any course that is

taught by an instructor who is marked as “High Importance.”

• Enrollment—Enrollment uses a combination of the assigned

weight and the following EMS Campus system parameters to

determine the courses that are assigned rooms first.

• Small Class Size (if less than xx students) - Determines what

constitutes a “small” class.

• Small Class Size Weight Adjustment - Subtracts this number

from the Enrollment weighting that is set in the optimization

scenario.

• Large Class Size (if more than xx students) - Determines what

constitutes a “large” class.

• Large Class Size Weight Adjustment - Adds this number to the

Enrollment weighting that is set in the optimization scenario.

• Time Block Conformance—Ranks those courses that conform to

the time block template for the term higher than those courses

that do not.

• Course Length—Course Length factors in the number of meeting

occurrences for a class. For example, a class that meets five

times per week might be given room assignment priority over a

class that only meets twice per week.

Preference Weights Preferences vary according to configuration but they include such 

things as building or room preferences, room type preferences, or 

feature preferences. 

• By default, all preferences are automatically included in an

optimization scenario. To exclude a preference completely from

an optimization scenario, clear the Include option for it.

• You can also simply exclude the weight of a preference, which

means that although the preference is not excluded from the

optimization logic, it does not contribute to the total number of

points for a room assignment ranking for a course.

• If a preference has been marked as a requirement during the Set

Preferences mode, you can select Ignore Requirements for it to

downgrade it to a preference only for the optimization scenario.

Option Description
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When you are creating a scenario, all the rooms in your domain are eligible to hold a course. 
If there are rooms offline for the term that you are scheduling, or there are rooms that should 
not be considered for the scenario, you can exclude them from the scenario on the Excluded 
Rooms tab of the Scenario dialog box.

Figure 13-42: Scenario dialog box, Excluded Rooms tab

Optimization logic

After you have set the weights for the Optimization scenario factors and preferences as well 
as all other needed options, you can run the Optimizer. The Optimizer works as follows:

1. Courses are ranked.

• If a course is identified as Publish in SIS Room (which means use the room to which
the course is already assigned in the SIS), then the course receives a “0” ranking.

• If a course is identified as Locked In, either from being locked in in a previous
scenario or from being pre-assigned in the current scenario, then the course receives
a “0” ranking.

• All other courses are ranked according to the sum of the weights that are assigned to
their factors and preferences on the Scenario tab. The larger the sum of the weights,
the higher the score that is assigned to a course and therefore, the more important the
room ranking, with the most important room ranking having a rank = 1.

• If Boost Requirements Weight is selected for a course, then 100% of the
indicated weight is assigned to each preference and 150% of the indicated
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weight is assigned to each preference that is marked as Required. If Boost 
Requirements Weight is not selected for a course, then 100% of the indicated 
weight is assigned to both the preferences and the preferences that are marked as 
Required.

• If a course is identified as “Same Room,” then the partners of the course are
elevated sequentially based on the ranking of the partner course with the most
important room assignment ranking. For example, with three total courses and
the most important course in this set having a rank = 3, then the other two
courses are set to rank = 4 and rank = 5.

• If a course is cross-listed, then the parent course is the course to which the most
important (lowest) room rank is assigned and the children courses adopt the
ranking of the parent course.

2. Rooms are assigned to courses one course at a time based on the order of the room
assignment rankings (from the most important ranking of rank = 1 to the least important
ranking of “n”).

• If the course is a single room without an Instructor Back to Back or Same Room
designation, then:

• The list of rooms that meet the course’s preferences and requirements criteria are
identified. Of the rooms that are identified, the subset of rooms that most closely
meet the course’s capacity are identified. The Optimizer then looks to maximize
seat fill. If multiple rooms all have the same capacity and all the rooms have the
same preferences and/or requirements, the Optimizer selects the room that has
already received course assignments, which increases the utilization of an
already-scheduled space before scheduling another.

• If no room meets all the requirements for a course, and no requirement has been
marked as Ignore, then the course is left unassigned.

• If no room meets all the preferences for a course, then the course preferences are
removed one at a time from least important to most important based on the
assigned weight until a room can be assigned to the course.

• If all preferences are removed and no room can be assigned to the course, then
the course is left unassigned and it is displayed on the Exceptions list on the
Resolve Room Assignments window.

Because the child course always follows the parent course, children course 
preferences are not factored when rooms are being assigned to courses. Only the 
parent course is relevant in assigning room rankings.



511

 
Academic Planning (EMS Campus)

• If the course has a Same Room designation, then each course is reviewed first to
determine if it has any Same Room partners before any attempt is made to assign a
room to the course.

• If all the courses in the set can be addressed with a single room that meets all the
preferences and requirements for the set, then the room is assigned to the courses
in the set.

• If all the courses in the set cannot be addressed with a single room that meets all
the preferences and requirements for the set, then the all the courses are left
unassigned and they are displayed on the Exceptions list on the Resolve Room
Assignments window.

• If the course has an Instructor Back to Back designation, then each course is
reviewed first to determine if it has any Back to Back partners before any attempt is
made to assign a room to the course. The partner courses are provisionally elevated
to the rank of the most importantly ranked course.

• If all the courses in the set can be addressed with a single room that meets all the
preferences and requirements for the set, then the room is assigned to the courses
in the set.

• If all the courses in the set cannot be addressed with a single room that meets all
the preferences and requirements for the set, then the course with the most
restrictive requirements is removed from the set and an attempt is made to assign
the same room to the remaining courses. (The course that is removed receives a
Back to Back exclusion note and its ranking is returned to its original ranking
and a room assignment is made based on this original ranking.) This process of
removing the course with the most restrictive requirements and then attempting
to assign the same room to the remaining courses is repeated until a single room
is found for the remaining courses or until the course that is being addressed is
alone. If the course that is being addressed becomes alone, then preferences are
removed one at a time, beginning with the least weighted preference, until a
room can be assigned to the course.

The following examples demonstrate how the Optimizer would ultimately assign rooms to 
courses based on this logic.

Class Size and Instructor Importance Examples - With all other weightings set to zero, 
consider the following configuration for these four settings:

• Weight assigned to Enrollment in scenario = 500

• Small Class Size (if less than xx students) = 10

• Large Class Size (if more than xx students) = 750

• Large Class Size Weight Adjustment = +100

• Instructor Importance = 400
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The figure below summarizes how these three courses would be scored and ranked for room 
assignment:

Back to Back Example - Four courses have been identified as Back to Back for a scenario 
based on the Back to Back default value of 15 minutes.

• The four courses receive an initial ranking of 2, 50, 75, and 100.

• When it is time for the course with rank = 2 to have a room assigned, the other three
courses are elevated provisionally to the same rank and a room search is carried out for a
room that can be assigned to all four courses.

• No single room can be assigned to all four courses. The course with rank = 100 has
the most restrictive requirements. It is removed from the set, returned to its original
rank (rank = 100) and receives a Back to Back Exclusion note.

• The courses with ranks of 2, 50, and 75 are re-validated as fitting the 15 minute Back to
Back criteria, and the room search is repeated for these courses.

• No single room can be assigned to all three courses. The course with rank = 50 has
the most restrictive requirements. It is removed from the set, returned to its original
rank (rank = 50) and receives a Back to Back Exclusion note.

• The courses with rank = 2 and rank = 75 are re-validated as fitting the 15 minute Back to
Back criteria, and the room search is repeated for these courses.

• A single room can be assigned to both these courses. The room rankings are reset to
rank = 2 and rank = 3.

• The assignment of rooms continues for courses with ranks 3 through 49.

• When it is time to assign a room to the course with rank = 50, is it re-validated as fitting
the 15 minute Back to Back criteria with the course with rank = 100. The course with
rank = 100 is elevated provisionally to the same rank as the course with rank = 50. A room
search is carried out for a single room that can be assigned to both courses.

• A single room cannot be assigned to both courses. The course with rank = 100 is
removed from the set, returned to its original rank (rank = 100) and receives a Back
to Back Exclusion note.

• If needed, preferences are removed one at a time, beginning with the least weighted
preference, until a room can be assigned to the course with rank = 50.

• The assignment of rooms continues for courses, up and to including the course with rank
= 100.
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Creating Scenarios

Although the process for your organization might vary, a typical approach for using 
scenarios to optimize room assignments is to first create a pre-assignment scenario to 
partially complete the assignment of rooms to courses for a term. You would then copy this 
pre-assignment scenario and edit it as needed to make an optimization scenario, and then run 
this optimization scenario to continue with the assignment of rooms to courses. You can 
create as many optimization scenarios as needed, either by copying an existing scenario or 
creating an entirely new scenario.

To create a pre-assignment scenario

1. On the EMS Campus menu bar, click Academic Planning > Courses > Optimization
Scenarios.

The Scenarios window opens. This window lists all the scenarios (pre-assignment and
optimization) that are currently configured in your EMS database.

Figure 13-43: Scenarios window

2. On the Domain dropdown list, select the domain for which you are creating the scenario,
and on the Term dropdown list, select the term.

3. Click New.

The Scenario dialog box opens. The Scenario tab is the active tab.

To review the different features on the Scenario dialog box, see “Scenario dialog 
box” on page 507.
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4. In the Description field, enter a name or description for the scenario, for example,
Pre-assignment.

5. Click OK.

The Scenario dialog box closes. You return to the Scenarios window with the newly
created scenario automatically selected.

6. Click Preassign.

A message opens informing you that preassigning will set this term to Read Only and
asking you if it is OK to continue.

7. Click Yes.

The message closes and an Initializing Scenario progress dialog box opens. After the
scenario is initialized, the progress dialog box closes, and the Preassign Rooms window
opens. This window lists all the courses for the selected term and domain. Any courses
that were previously pre-assigned are listed as Locked In.

Figure 13-44: Preassign Rooms window

The description can be a maximum of 30 characters, including spaces.

Because all assignments in a pre-assignment scenario are manual, you do not 
need to set any weighted criteria or exclude any rooms.
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8. Optionally, do one or both of the following; otherwise, go to Step 9.

• To view a course in the Course Navigator, double-click the course.

• To filter this list, do one or more of the following:

• On the Academic Unit dropdown list, select an academic unit.

• On the Subject Dropdown list, select a subject.

• At the bottom of the window, select Unassigned Only.

• Click on a column heading to sort by the heading.

9. If you do not want to copy pre-assignments that you have carried out in a previous
scenario, continue to “Assigning Rooms” on page 522; otherwise, do the following:

• Click Copy Locations to open the Import Room Assignments dialog box.

Figure 13-45: Import Room Assignments dialog box

• Select the appropriate Domain and Term from which you want to copy the pre-
assignments.

• Select the appropriate scenario to copy, and then click Select.

Where possible, the locations are copied for the courses that are displayed in the 
Preassign Rooms window. If a location was successfully copied for a course, then 
(unassigned) is no longer displayed in the Locations column. Instead, the copied room 
assignment is displayed. If a location could not be copied for a course, then (unassigned) 
is still displayed in the Locations column.

10. Continue to “Assigning Rooms” on page 522.

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.
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To create an optimization scenario

1. On the EMS Campus menu bar, click Academic Planning > Courses > Optimization
Scenarios.

The Scenarios window opens. This window lists all the scenarios (pre-assignment and
optimization) that are currently configured in your EMS database.

Figure 13-46: Scenarios window

2. On the Domain dropdown list, select the domain for which you are creating the scenario,
and on the Term dropdown list, select the term.

3. Do one of the following:

• To create a new optimization scenario, click New.

• To create an optimization scenario by copying an existing scenario, select the
scenario that you want to copy, and then click Copy

The Scenario dialog box opens. The Scenario tab is the active tab. 

4. In the Description field, enter a name or description for the scenario, for example,
Scenario A.

To review the different features on the Scenario dialog box, see “Scenario dialog 
box” on page 507.

The description can be a maximum of 30 characters, including spaces.
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5. Do one or more of the following to set the options and weighted criteria for the
optimization scenario:

• Modify the Back to Back Gap Minutes value. (The allowed value is 0-60.)

• Select the Boost Requirements Weight to increase the weights of preferences that are
marked as requirements to 150% of their assigned preference weights.

• Use the Weight slider bar or enter a number in the Weight field to modify the weight
as needed for a factor. If you do not want the factor to contribute to room assignment
ranking for a course, then select Exclude Weight for the factor. (The factor is still
considered when searching for a room.)

• By default, all preferences are included in an optimization scenario. For the
preferences that you are including, use the Weight slider bar to specify a weight for
each preference, or enter a number in the Weight field. If you do not want a
preference to contribute to room assignment ranking for a course, select Exclude
Weight for the preference. (The preference is still considered when searching for a
room.)

• Some preferences might have been marked as Required by some academic units
during the Set Preferences mode. Select Ignore Requirements to indicate that a
requirement should be ignored and treated only as a preference.

6. Open the Excluded Rooms tab, and do the following to specify the rooms that should not
be assigned to a course in this scenario (for example, rooms that have previously been
assigned using a pre-assignment scenario):

• On the Building dropdown list, select (all) buildings, or select a specific building.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

• In the Available list, select the room, or CTRL-click to select multiple rooms, and
then click the Move (>) button to move the rooms to the Selected list.

7. Repeat Step 6 as needed until you have selected all the rooms in specific buildings that
should be excluded

Weights are arbitrary numbers that simply indicate the relative importance of one 
criterion to another. The weights do not have to add up to a particular “whole,” 
for example, 100. 

Only the features that were selected during Set Preferences mode are displayed—
this is not an exhaustive list of all your features.

If a room assignment is already “locked in” for a course, then the room 
assignment is maintained for the course, even if the room is excluded from the 
scenario.
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8. Click OK.

The Scenario dialog box closes. You return to the Scenarios window with the newly
created scenario automatically selected.

9. Click Optimize.

The Run Scenario dialog box opens. This dialog box lists all the academic units that
have courses for the selected term and domain.

Figure 13-47: Run Scenario dialog box

10. In the Available list, select the academic unit that you want to run in the optimization
scenario, or CTRL-click to select multiple units, and then click the Move (>) button to
move the units to the Selected List.

11. Click Run.

Two results are possible:

• If the term contains edited courses, then a message that states the following opens:
WARNING: You have made changes to 'n' Course(s) in “Define & Edit Mode'” that
will be overwritten. Is it OK to continue. You must click Yes to continue and then a
message opens informing you that optimizing will set this term to Read Only for the
selected academic units and asking you if it is OK to continue.

• If the term does not contain edited courses, then a message opens informing you that
optimizing will set this term to Read Only for the selected academic units and asking
you if it is OK to continue.
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12. Click Yes.

The message closes and an Initializing Scenario progress dialog box opens. After the
scenario is initialized and the term is synchronized, the progress dialog box closes. An
Optimization Results dialog box opens on top of the Resolve Room Assignments
window. This dialog box indicates that the optimization was complete and it also
indicates the number of courses assigned, the percent of total courses assigned, and the
number of exceptions (the number of courses that could not be assigned).

13. Click OK.

The Optimization Results dialog box closes and the Resolve Room Assignments
window is now the active window. By default, this window lists only those courses for
which rooms could not be assigned.

Figure 13-48: Resolve Room Assignments window

14. If you are satisfied with the overall results of the Optimization scenario, then you can
continue to resolve any remaining room assignments. (See “To resolve room
assignments” on page 520.) Otherwise, you can test other potential scenarios and
compare results using various tools before you choose your final scenario for publishing.
See “Evaluating Optimization Scenarios” on page 527.

At any time, if you need to review this information, click Print > Scenario Results.
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To resolve room assignments

After an Optimization scenario, courses can remain unassigned for the following reasons:

• Conflicts with another course: A course or courses that were ranked higher in preference
criteria was assigned the room that this course required.

• No space can hold course: The course had requirements that were so specific, no room
was available that met the criteria either because the room does not exist, or it was
excluded from the scenario.

1. Optionally, you can do one or more of the following:

• To view all the courses that are in conflict with a course, select the course, and then
click Search to open the Search tool and carry out a filtered search of rooms that are
available for the course's meeting pattern. Rooms that meet all the search criteria and
that are available are displayed on an Available tab. The rooms that are already in
use during the selected course’s meeting time are displayed on a Conflicts tab.

• To view a course in the Course Navigator, double-click the course.

• Clear Exceptions Only to view a list of all courses (assigned and unassigned) for the
selected term and domain.

• To view the final room assignment ranking, scroll to the Ranking column.

• To filter the course list, do one or more of the following:

• On the Academic Unit dropdown list, select an academic unit.

• On the Subject Dropdown list, select a subject.

• Click on a column heading to sort by the heading.

• To view notes about the course, scroll to the Notes field. This field displays the
following information, if applicable, for a course:

• Back to Back with Grouping ID, indicating how courses were paired as a set.

• Back to Back Exclusion to indicate a course that was initially identified as Back
to Back, but returned to its original ranking because a single room could not be
assigned to the full set.

• Same Room with Grouping ID, indicating how courses were paired as a set.

• Publish in SIS Room.

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.

Remember, any room that was pre-assigned or was Publish to SIS has rank = 0.
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• Locked In status for the room.

2. Continue to “Assigning Rooms” on page 522.

If you are carrying out incremental optimization by academic unit, you must 
repeat this procedure for every academic unit that is to be optimized.
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Assigning Rooms

After you have completed pre-assignment of rooms and/or room optimization, four options 
are available to resolve room assignments for rooms that are not flagged as Publish in SIS or 
locked in to an assignment:

• Assign. The Assign option lists all rooms regardless of availability or preferences. It is
intended to provide a means for you to quickly assign a room without going through the
search process.

• Search. The Search option initially lists any preferences and requirements that were
specified during the Set Preferences mode. You can use these preferences as a basis for a
room search or you can specify and/or clear other criteria to complete the room search.

• Unassign. The Unassign option removes the Assigned status for a course. You can then
use the Assign option or the Search option to assign a different room to the course. The
Unassign option is available after you assign a room to a course, or search for a room, and
then assign it to a course.

• Swap. The Swap option allows you to swap the room assignments of two courses. The
swap option is only available after selecting two courses that have identical meeting
patterns and that have been assigned to rooms.

To assign rooms to courses

1. Select the course, or CTRL-click to select the multiple courses to which a room is to be
assigned.

2. On the Preassign Rooms window, or the Resolve Room Assignments window, click
Assign.

The Room Selector dialog box opens.

Figure 13-49: Room Selector dialog box
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3. On the Building dropdown list, select (all) buildings or select a specific building that
contains the rooms that you are considering for assignment.

The rooms are displayed in the dialog box. By default, only those rooms that can meet
the enrollment expectations, regardless of availability are displayed. Rooms that are
excluded from the scenario are marked with an asterisk (*), but, if necessary, you can
select an excluded room.

4. Optionally, to display all rooms in the Room Selector dialog box, clear the Limit to Est.
Enrollment option.

5. Select a room, and then click OK.

If the room could not be assigned to one or more courses because of a conflict, then a
message opens indicating this. Click OK to close the message, and repeat this step until
you successfully assign a room to the courses.

6. Repeat Step 2 through Step 5 until you have successfully assigned rooms to all courses
for the term. After you have assigned a room to a course, at any time, you can do any of
the following:

• To change a room assignment for a course, select a course for which a room has been
assigned, and then click Unassign. You can then repeat Step 2 through Step 5 to
assign a room to the course.

• Courses that were pre-assigned are listed as Locked In. To re-optimize any portion
of the course assignments, select one or more assigned courses (CTRL-click to
select multiple courses), and then click Lock In to lock in these additional courses,
and then rerun your optimization scenario.

• To swap the room assignments of two courses, CTRL-click to select two courses
with identical meeting patterns, and then click Swap.

You can open the Resolve Room Assignments window at any time by clicking 
Resolve on the Scenarios window. The system does not require all courses to be 
assigned to rooms. Those courses that are left unassigned are placed in a special 
TBD room when publishing and can be assigned post-publish.
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To search for rooms to assign to a course

1. Select the course to which a room is to be assigned.

2. On the Preassign Rooms window, or the Resolve Room Assignments window, click
Search.

The Room Search dialog box opens. The preferences or requirements that the academic
unit specified for the selected course during the Set Preferences mode are displayed at
the top of the dialog box. By default, these preferences are included in the search criteria.

Figure 13-50: Room Search dialog box

3. In the Search Preferences (lower) pane of the dialog box, edit the search criteria as
needed, and then click Next.

The Room Search dialog box is updated with a list of rooms that meet your search
criteria. Rooms that have been excluded from the scenario are marked with an asterisk
(*). See Figure 13-51 on page 525.



525

 
Academic Planning (EMS Campus)

Figure 13-51: Room Search dialog box

4. Optionally, to view information about a room, select the room, and then click Room
Info; otherwise, go to Step 5.

The Room Info dialog box opens. The dialog box displays information about the room,
including the room’s properties, the setup type, the room’s features, and so on. After you
are done viewing the room’s information, click Close to close the Room Info dialog box.

5. On the Room Search dialog box, select the room that is to be assigned to the course, and
then click Select.

The room is assigned to the course. You remain on the Preassignment window or the
Resolve Assignments window. If the room is assigned from the Preassigned window,
then it is also marked as Locked In.

If there are rooms that meet your search criteria, but they have already been 
scheduled by other courses, then a Conflicts tab opens. Open the tab to review a 
list of these rooms.
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6. Repeat this procedure as needed to assign rooms to courses. After you have assigned a
room to a course, at any time, you can do one or both of the following:

• If you want to change a room assignment for a course, select a course for which a
room has been assigned, and then click Unassign. You can then repeat Step 2
through Step 5 to assign a room to the course.

• Courses that were pre-assigned are listed as Locked In. If you would like to re-
optimize any portion of the course assignments, select one or more assigned courses
(CTRL-click to select multiple courses), and then click Lock In to lock in these
additional courses, and then rerun your optimization scenario.

• To swap the room assignments of two courses, CTRL-click to select two courses
with identical meeting patterns, and then click Swap.

You can open the Resolve Room Assignments window at any time by clicking 
Resolve on the Scenarios window. The system does not require all courses to be 
assigned to rooms. Those courses that are left unassigned are placed in a special 
TBD room when publishing and can be assigned post-publish.
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Evaluating Optimization Scenarios

You can test an unlimited number of potential scenarios and compare results using various 
tools before you choose your final scenario for publishing. Both the Academic Browser and 
the Academic Book contain a Scenario dropdown list from which a specific scenario can be 
selected for viewing and evaluation. (See “Searching with the Academic Browser” on page 
579 and “Using the Academic Book” on page 586.) The Scenarios window contains a Print 
option that provides access to the following reports that can be used to for evaluating 
scenarios—Scenario Results, Scenario Exceptions, Unmet Preferences, and Preferences 
Summary. Additional reports within the Academic Planning > Reports area are also 
available, including Classroom Optimization, Hourly Classroom Utilization, and Course 
Preferences. (See “Generating Academic Reports” on page 601.)
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Section Contents

• Overview of Publishing an Academic Term on page 531

• Publishing a Term on page 533

• Manually Updating Course Locations in the SIS on page 537

• Unpublishing a Previously Published Term on page 539
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Overview of Publishing an Academic Term

After the Domain Scheduler has finalized the assignment of courses to rooms, either with the 
help of the EMS room optimization process or by using the scenario that was pulled from the 
SIS, the next step is to publish the course schedule for the term in EMS Campus. Publishing 
the course schedule causes the system to book the space in EMS, creating reservations and 
bookings. If the EMS Campus system parameter Manually update SIS is set to “No,” then 
the publishing process also updates course location information directly in the SIS; 
otherwise, the Domain Scheduler must manually update the SIS. Publishing an academic 
term consists of the following steps:

1. The Domain Scheduler publishes the term, which includes specifying statuses for
courses in conflict and cross-listed courses. See “Publishing a Term” on page 533.

2. If needed, the Domain Scheduler manually updates the course locations in the SIS. See
“Manually Updating Course Locations in the SIS” on page 537.

3. If needed, the Domain Scheduler can unpublish a previously published term. See
“Unpublishing a Previously Published Term” on page 539.
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Publishing a Term

After you have finalized the assignment of courses to rooms, either with the help of the EMS 
room optimization process or by using the scenario that was pulled from the SIS, the next 
step is to publish the course schedule for the term in EMS Campus. Publishing the course 
schedule causes the system to book the space in EMS, creating reservations and bookings.

To publish a term

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-52: Terms window

2. On the Domain dropdown list, select the domain for which the term is being published.

3. Select the term that is being published, and then click Edit.

The Term dialog box opens. The Term tab is the active tab. See Figure 13-53 on page
534.
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Figure 13-53: Term dialog box, Term tab

4. Do the following:

• Make sure that the Mode is set to Read Only and if the academic unit-level users are
to have View access to the term, make sure that Available to Academic Units is
selected.

• On the Active Scenarios dropdown list, select the scenario that is being published.

5. Optionally, in the Phase field and the Notes field, enter any information that is pertinent
to the published schedules, for example, “Published” in the Phase field.

6. Open the Excluded Dates tab.

7. Select the dates that should be excluded during the publishing process.

The Term dialog box closes. You return to the Terms window with the term that is to be 
published automatically selected.

The SIS scenario publishes room assignments that were previously defined in the 
SIS.

This would include any dates where regularly scheduled classes do not take place, 
for example, breaks, holidays, and if applicable, final exams week.

Bookings are not created for excluded dates, which means that rooms can be 
scheduled for events and meetings, if needed.
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8. Click Publish.

The Publish Term dialog box opens. The Domain field, the Term field, and the Scenario
field are automatically populated with the values that you previously selected and you
cannot edit them.

Figure 13-54: Publish Term dialog box

9. Select the statuses required for publishing the term.

Status Description

Status The status that is used to book all rooms for course reservations and 

bookings that are created during the publishing process. 

Note: The status should be a Booked Space type.

Conflict Status If you are publishing course room placements that were assigned in 

your SIS (the SIS scenario), then potentially you could have room 

booking conflicts created. If a double booking is encountered during the 

publishing process, then the reservation and bookings for the conflicting 

course are published in this conflict status.

Note: The status should be an Info Only type.

Cross List Status The status that is used to book all cross-listed and shared space course 

reservations and bookings that are created during the publishing 

process. 

Note: The status should be an Info Only type.

Override Existing 

Bookings/Override 

Conflict Status

If another scheduling unit on campus, for example, the Student Union, is 

allowed to book events in academic space before the publishing 

process has taken place, then an event and course might be assigned 

to the same space. If Override Existing Bookings is selected and this 

situation is encountered during the publishing process, the event is 

“bumped” and its reservation and bookings are booked into this status. If 

Override Existing Bookings is not selected, then the conflicted bookings 

for the course are placed into the Override Conflict Status. 

Note: The Override Conflict Status should be an Info Only type.
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10. Specify the Domain Settings for the term.

11. Click Publish.

A message opens stating that publishing the term will set the term to Read Only and
asking you if it is OK to continue.

12. Click Yes.

A Publishing progress dialog box opens. After the term is published, the progress dialog
box closes, and a message opens indicating that the term was published successfully.

13. Click OK to close the message and return to the Terms window.

Setting Description

Reservation Source Select the reservation source that is used for the course reservations 

and bookings that are created during the publishing process.

Room for Unassigned 

Courses
Click the Search icon  to open the Room Selector dialog box and 

select the room in which to book the courses that have not been 

assigned in the SIS or in an optimization scenario.

Note: Unassigned courses are typically booked in a special To Be 

Determined (TBD) room. Some organizations create a specific 

TBD building and/or room to accommodate this situation. The 

room must be an override description room. See the EMS Setup 
Guide for information about configuring a TBD building and/or 

room.

If any errors are encountered during the publishing process, or if the EMS 
Campus system parameter Manually Update SIS/ERP System After Publishing is 
set to “Yes,” then you can access your course list and manually update the course 
locations in your SIS. See Manually Updating Course Locations in the SIS on 
page 537
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Manually Updating Course Locations in the SIS

If any errors are encountered during the publishing process, or if the EMS Campus system 
parameter Manually Update SIS/ERP System After Publishing is set to “Yes,” then you can 
access your course list and manually update the course locations in your SIS.

To manually update course locations in the SIS

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-55: Terms window

2. On the Domain dropdown list, select the domain for which you are manually updating
the course locations.

3. Select the term for which you are manually updating the course locations, and then click
Update SIS.

The Courses Not Updated in SIS window opens. This window lists all the courses that
were not updated in the SIS along with an accompanying reason. If the reason is an error,
you must resolve the error before you can continue with the manual publishing. If
“Manual Publish” required is listed, then you can continue with this procedure. See
Figure 13-56 on page 538.
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Figure 13-56: Courses Not Updated in the SIS window

4. Select the course record or CTRL-click to select multiple records that you are updating,
and then click Update, or click Update All to update all records in a single step.

A message opens indicating that the updates were successful.

5. Click OK to close the message and return to the Terms window.
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Unpublishing a Previously Published Term

For a variety of reasons, you might need to unpublish a previously published term, for 
example, you accidentally published the term using the wrong scenario, or you forgot to 
mark excluded dates before you published the term. 

To unpublish a term

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-57: Terms window

2. On the Domain dropdown list, select the domain for which you are unpublishing the
term.

3. Select the term that you are unpublishing, and then click Unpublish.

A message opens indicating that unpublishing will remove all reservations and bookings
for the selected term, and asking you if it is OK to continue.

Even though you might have a valid reason for unpublishing a term, do not do so 
without great consideration. Unpublishing a term deletes all reservations and 
bookings that are associated with the term.
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4. Click Yes.

The message closes. After the term is unpublished, a second message opens indicating
that the term was successfully unpublished.

5. Click OK to close the second message and return to the Terms window.
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Section Contents

• Reviewing Reservations and Resolving Room Assignments on page 543

• Post-Publish Processing of Courses on page 546

• Setting a Final Exam Schedule on page 562

• Publishing a Final Exam Session on page 572
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Reviewing Reservations and Resolving Room 

Assignments

After a course has been published, you can use the EMS Navigator (referred to simply as the 
Navigator) or the Reservation Book (referred to simply as the Book) to manage it just like 
any other EMS reservation and/or booking. The Course Info tab on the Navigator displays 
the course and the course date records for the course as it exists in your SIS. If you open a 
course in the Navigator that is cross-listed or shares space with another course, the Navigator 
displays both sets of reservations and bookings. You can review the reservations that have 
been made for a course and if needed, change the course room (location) for one or more of 
its bookings. If courses have an identical meeting pattern, you can also swap rooms 
(locations) between courses.

Figure 13-58: Navigator with reservation and bookings for a course

 If you select a course date record, on the Course Info tab, and then click Course, 
the course opens in the Course Navigator.

After a term has been published, you can continue using the Academic Browser, 
the Academic Book and/or the Course Navigator to locate courses; however, for 
automation reasons, after a term is published, you should make room changes in 
EMS Campus and not in your SIS.
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In a typical process, you would want to locate and review the following types of courses 
immediately after publishing:

• Courses in conflict—Use the Browser to search for bookings in the academic conflict
status that you designated, for example, Academic Conflict. (See “Searching with the
Browser or with the Web Reservation Tool” on page 197.) You can change the location
to resolve the conflict (see “To change the course rooms (locations) for one or more
bookings” below), or if the conflict was intentional, you can change the status to the
academic share status that you designated, for example, Academic Shared. (See “To edit
a booking in the Navigator” on page 110 or “To edit multiple bookings in the Navigator”
on page 112.)

• Courses or events that were overridden by publishing—Use the Browser to search for
bookings in the status that you designated for override bookings, for example, Academic
Bumped. (See “Searching with the Browser or with the Web Reservation Tool” on page
197.) You might want to move these bookings to another location. (See “To change the
course rooms (locations) for one or more bookings” below.)

• Courses that were left unassigned—Use the Browser to search for bookings in the TBD
room (See “Searching with the Browser or with the Web Reservation Tool” on page 197.)
You might want to move these courses to an actual room. (See “To change the course
rooms (locations) for one or more bookings” below.)

To change the course rooms (locations) for one or more bookings

1. Open the course reservation in the Navigator. See:

• “Viewing and Editing Reservations in the Reservation Book” on page 
62.

• “Opening a reservation directly in the Navigator” on page 79.

• “Opening a reservation through a group” on page 80.

•  “Search Tools,” on page 195.

When you manually update the status to Shared, the courses are not linked in the 
same way as when marking them as Shared Space prior to publishing; however, 
manually updating the status does not result in these course being “cleared” from 
your Conflict list.

You can also use the Advanced search features in the Academic Browser to locate 
and review the three types of courses that are listed above after publishing. See 
“Searching with the Academic Browser” on page 579.
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2. Do one of the following:

• To update a course location for a single booking, see “To edit a booking in the
Navigator” on page 110.

• To update course locations for multiple bookings, see “Editing Multiple Bookings in
the Navigator” on page 112.

To swap rooms between courses

If courses have an identical meeting pattern, you can also swap rooms between courses.

1. Open the Reservation Book. See “Viewing and Editing Reservations in the Reservation
Book” on page 62.

2. In the Reservation Book, locate your course bookings.

3. Right-click one of the two bookings that you want to swap, and on the context menu that
opens, click Swap Rooms With Another Course.

4. Select the second of your two bookings.

A message opens asking you if you are sure that you want to swap rooms for the two
courses.

5. Click Yes.

The message closes. After the locations are swapped, the Reservation Book is updated to
reflect the swap.

The course location in the SIS does not update automatically unless all bookings 
that are specific to a meeting pattern within a reservation are changed to an 
identical alternate location. If for some reason, you want to manually update the 
SIS with a new location that was not assigned to all bookings, select the course 
date record on the Navigator Course Info tab, and then click the Update button.



546

 
Academic Planning (EMS Campus)

Post-Publish Processing of Courses

In most cases, courses are added, changed, or canceled in the SIS after the course schedule 
has been published in EMS. You can manually resynchronize and process these courses, or 
you can set options in EMS Campus to automatically resynchronize these courses. After 
these course are automatically resynchronized, they can be automatically processed as well, 
or you can manually process them. Also, at the point that actual enrollment should determine 
room assignment (that is, can a room’s capacity handle the actual enrollment), you can 
process courses post-publish so that the courses are updated with the actual enrollment.

To manually process courses post-publish

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-59: Terms window

For automatic synchronizing to occur, the EMS Campus Auto Sync Service must 
be installed and configured. Refer to the EMS Installation manual for details.
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2. Select the term which requires post-publish processing, and then click Sync.

The Course Updates window opens. The Course tab is the active tab. This tab displays
all the new courses, new course dates, changed courses, or canceled courses from the
SIS. After processing, it also lists “Room Capacity Violations,” or courses in which the
designated enrollment (estimated or actual) has surpassed the capacity of the room. The
Course Updates window also has a Crosslist Validation tab. When EMS changes a
cross-list parent to accommodate a new course, course date, or change that is being
processed, the cross-listed courses are displayed on the Crosslist Validation tab. The
Crosslist Validation tab is for informational purposes only so that you are kept abreast of
parent changes. If you are satisfied with the parent assignments, you can simply click
Reviewed and the cross-listed courses are cleared from the tab; otherwise, a Set Parent
option is available.

Figure 13-60: Course Updates window, Courses tab

3. Continue to one of the following:

• “To process a canceled course post-publish” on page 548.

• “To process a changed course post-publish” on page 548.

• “To process a new course date post-publish” on page 550.

• “To process a new course post-publish” on page 553.

• “To process a Room Capacity Violation post-publish” on page 555.

The following procedures are presented in the order in which the post-publish 
processing should be carried out—cancellations, changes, new course dates, new 
courses, and then Room Capacity Violations.
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To process a canceled course post-publish

1. Select the canceled course, or CTRL-click to select multiple courses.

2. Click Process.

A message opens asking you if you are sure that you want to process the selected course
dates.

3. Click Yes.

After processing is complete, the message closes and the canceled courses are removed
from the Course Updates window. The bookings are canceled in EMS.

To process a changed course post-publish

A course is listed as changed if there has been a change to the start or end date, a day of the 
week, the start or end time, and/or the room in the SIS.

1. Select the changed course, or CTRL-click to select multiple courses.

The change history for the selected courses is displayed on the History tab in the lower
pane of the Course Updates window.

2. Click Process.

A message opens asking you if you are sure that you want to process the selected course
dates.

3. Click Yes.

Two results are possible:

• If the changes were successfully completed for the reservations and bookings, then
the courses are removed from the Course Updates window.

• If the changes resulted in a room conflict, Room Not Available is displayed in the
Notes column. Go to Step 4.

4. Click Conflicts to view the conflicts for the course.

The View Conflicts dialog box opens. Each course and/or event that is causing the
conflict is displayed.

5. If the conflict was caused by the switching of the rooms in the SIS, select the two course
dates that are in conflict, and then click Swap to swap and process the rooms in the same
step; otherwise, go to Step 6.
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6. Do one of the following:

• Click Process again to process the course with conflicts. A Warning message op ens
asking you if you are sure that you want to process with conflicts. Click Yes to close
the message and complete the processing.

• Click Assign to search for a new room. The Select a Room dialog box opens. Go to
Step 7.

Figure 13-61: Select A Room dialog box

7. Specify your search criteria, and then click Next.

A list of rooms that meets your search criteria is displayed.

8. Select the room that is to be assigned to the new courses, and then click Finish.

The Select a Room dialog box closes and you return to the Course Updates window with
the new courses still selected.

9. Click Process.

A message opens asking you if you are sure that you want to process the selected course
dates.

If needed, at a later date, you can use the Browser to manually search for these 
conflicts and resolve them. See Courses in Conflict on page 544.
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10. Click Yes.

After processing is complete, the message closes and the changed courses are removed
from the Course Updates window. If a Day of the Week change has been made, then
processing course changes deletes and recreates the bookings that were previously made
in EMS.

To process a new course date post-publish

1. Select the new course dates, or CTRL-click to select multiple new course dates.

2. If rooms have already been assigned to the course dates in the SIS and you want to keep
these rooms, then go to Step 5; otherwise, click Assign to open the Select A Room dialog
box, and then go to Step 3.

Figure 13-62: Select A Room dialog box

3. Specify your search criteria, and then click Next.

A list of rooms that meets your search criteria is displayed.

4. Select the room that is to be assigned to the new courses, and then click Finish.

The Select a Room dialog box closes and you return to the Course Updates window with
the new courses still selected.

If bookings are deleted and recreated, then any manual changes that have been 
made to these bookings and/or any services that have been added to the booking 
are lost.

Rooms can be processed without a room assignment. In this case, the course date 
is published in the TBD room that was specified when the term was published.
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5. Click Process.

A message opens asking you if you are sure that you want to process the selected course
dates.

6. Click Yes.

Two results are possible:

• If the changes were successfully completed for the reservations and bookings, then
the courses are removed from the Course Updates window.

• If the changes resulted in a room conflict, Room Not Available is displayed in the
Notes column. Go to Step 7.

7. Click Conflicts to view the conflicts for the course.

The View Conflicts dialog box opens. Each course and/or event that is causing the
conflict is displayed.

8. If the conflict was caused by the switching of the rooms in the SIS, select the two course
dates that are in conflict, and then click Swap to swap and process the rooms in the same
step; otherwise, go to Step 9.

9. Do one of the following:

• Click Process again to process the course with conflicts. A Warning message opens
asking you if you are sure that you want to process with conflicts. Click Yes to close
the message and complete the processing.

• Click Assign to search for a new room. The Select a Room dialog box opens. Go to
Step 10.

Figure 13-63: Select A Room dialog box

If needed, at a later date, you can use the Browser to manually search for these 
conflicts and resolve them. See Courses in Conflict on page 544.



552

 
Academic Planning (EMS Campus)

10. Specify your search criteria, and then click Next.

A list of rooms that meets your search criteria is displayed.

11. Select the room that is to be assigned to the new courses, and then click Finish.

The Select a Room dialog box closes and you return to the Course Updates window with
the new courses still selected.

12. Click Process.

A message opens asking you if you are sure that you want to process the selected course
dates.

13. Click Yes.

After processing is complete, the message closes and the changed courses are removed
from the Course Updates window. If a Day of the Week change has been made, then
processing course changes deletes and recreates the bookings that were previously made
in EMS.

If bookings are deleted and recreated, then any manual changes that have been 
made to these bookings and/or any services that have been added to the booking 
are lost.
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To process a new course post-publish

1. Select the new course, or CTRL-click to select multiple new courses.

2. Do one of the following:

• If rooms have already been assigned to the courses in the SIS and you want to keep
these rooms, then go to Step 6.

• If a room has already been assigned to the course (the first course) in the SIS, but it
is meant to share a room with another course (the second course), then click Share to
open the Course Selector dialog box, and then go to Step 5.

Figure 13-64: Course Selector dialog box

• If a room has not been assigned to the course in the SIS, and you want to search for a
room, then click Assign to open the Select A Room dialog box and then go to Step 3.
See Figure 13-65 on page 554.

Rooms can be processed without a room assignment. In this case, the course date 
is published in the TBD room that was specified when the term was published.
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Figure 13-65: Select A Room dialog box

3. Specify your search criteria, and then click Next.

A list of rooms that meets your search criteria is displayed.

4. Select the room that is to be assigned to the new course, and then click Finish.

The Select a Room dialog box closes and you return to the Course Updates window with
the new course still selected.

5. If the course is not meant to share a room with another course, go to Step 6; otherwise, if
the course is meant to share a room with another course, then do the following:

• Click Share to open the Course Selector dialog box.

Figure 13-66: Course Selector dialog box
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• Enter the appropriate search criteria (CRN, Course Title, Subject and/or Instructor)
to search for the second course.

• Select the second course, and then click OK.

You are returned to the Course Updates window.

6. Click Process.

A message opens asking you if you are sure that you want to process the selected course
dates.

7. Click Yes.

After processing is complete, the message closes and the new courses are removed from
the Course Updates window.

To process a Room Capacity Violation post-publish

If the enrollment for a class violates the minimum or maximum capacity for its assigned 
room, then the course is displayed on the Course Updates window with a change status of 
Room Capacity Violation.

1. Select the course, or CTRL-click to select multiple courses.

2. Do one of the following:

• To assign the course to a new room, click Assign to open the Select a Room dialog
box, then go to Step 3; otherwise, to leave the course in the same room, go Step 5.

Figure 13-67: Select A Room dialog box

3. Specify your search criteria, and then click Next.

A list of rooms that meets your search criteria is displayed.



556

 
Academic Planning (EMS Campus)

4. Select the room that is to be assigned to the new course, and then click Finish.

The Select a Room dialog box closes and you return to the Course Updates window with
the new course still selected.

5. Click Process.

A message opens asking you if you are sure that you want to process the selected course
dates.

6. Click Yes.

After processing is complete, the message closes and the new courses are removed from
the Course Updates window.

To automatically process courses post-publish

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-68: Terms window

2. Select the term which requires post-publish processing, and then click Edit.

The Term dialog box opens. The Term tab is the active tab.

If you did not assign a new room to the course, then clicking Process merely 
acknowledges the room violation. The course remains in its same room.



557

 
Academic Planning (EMS Campus)

3. Open the Auto Sync Settings tab.

Figure 13-69: Auto Sync Settings tab

4. Specify your auto sync settings.

Setting Description

Automatically Sync 

Courses

Select this option to automatically synchronize courses in your SIS.

Note: To automatically synchronize courses, a user who can carry out 

this function must be created, and this user must be specified for 

the Auto Sync User EMS (Campus) system parameter. See EMS 

system parameters (Campus) in the EMS Setup Guide.

Automatically Process 

Course Updates

Select this option if EMS is to automatically process new courses, 

changes, and cancellations if possible. Leave the option blank to 

manually process new courses, changes and cancellations from the 

EMS Dashboard. (See “To manually process courses post-publish” on 

page 546.)

Note: If this option is selected, and EMS cannot automatically process 

new courses, course dates and/or changes because of a conflict 

(for example, a room is not available), then you must manually 

process these courses. You must open the Course Updates tab 

on the EMS Dashboard, and then open the Courses sub-tab to 

view the courses in conflict that you must manually process. 

(See Figure 13-70 on page 558.) The Courses sub-tab is 

identical to the Course Updates window. See “EMS 

Dashboard,” on page 227 for information about working with tabs 

on the Dashboard window.

Note: In addition to this setting, three Campus system parameters 

determine the specific types of updates that you are 

auto-processing. See EMS system parameters (Campus) in the 

EMS Setup Guide.
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5. Click OK.

The Term dialog box closes. You return to the Terms window.

Figure 13-70: Dashboard window, Course Updates tab

Auto Sync Only Once 

Per Day

If you do not select this option, then EMS automatically synchronizes 

the courses in your SIS according to the settings for the EMS Campus 

Auto Sync service.

Last Date of Auto Sync Required value. Enabled after Automatically Synch Courses is selected. 

Select the last date on which synchronization is to be automatically 

carried out by EMS for this term, which typically corresponds to the last 

date of the term.

Setting Description
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To process courses post-publish for enrollment

Typically, you publish your term in EMS prior to registration beginning. As a result, 
estimated enrollment is the most relevant value for searching for rooms with appropriate 
capacities. Closer to the start of the term, however, actual enrollment might become more 
relevant and you might need to change the setting so that EMS uses this value when 
searching for new rooms in the Navigator wizards and Course Updates window.

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

Figure 13-71: Terms window
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2. Select the term which requires post-publish processing, and then click Edit.

The Term dialog box opens. The Term tab is the active tab.

Figure 13-72: Term dialog box, Term tab

3. On the Post Publish Enrollment dropdown list, select Actual, and then click OK.

The Term dialog box closes. You return to the Terms window with the term still selected.

4. Click Sync.

A Synchronizing progress dialog box opens. After the synchronization is complete, the
Course Updates window opens. If the actual enrollment for a class violates the minimum
or maximum capacity for its assigned room, then the course is displayed on the window
with a Change Status of Room Capacity Violation. See Figure 13-73 on page 561.
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Figure 13-73: Course Updates window showing rooms with capacity violations

5. To assign the course to a new room, click Assign; otherwise, go to Step 8.

The Select A Room dialog box opens.

6. Specify your search criteria, and then click Next.

A list of rooms that meets your search criteria is displayed. The list includes any TBD
rooms that have been configured.

7. Select the room that is to be assigned to the new courses, and then click Finish.

The Select a Room dialog box closes and you return to the Course Updates window with
the new courses still selected.

8. Click Process.

A message opens asking you if you are sure that you want to process the selected course
date.

9. Click Yes.

After processing is complete, the message closes and the courses are removed from the
Course Updates window.

If you did not assign a new room to the course, then clicking Process merely 
acknowledges the room violation. The course remains in its same room.
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Setting a Final Exam Schedule

At some point after a term has been published in EMS Campus, you must schedule the final 
exams for the term. EMS Campus provides the functionality to automate the final exam 
scheduling process using templates. You create a final exam schedule template based on all 
unique course schedule patterns (for example, MWF 9am-9:50am, TR 1pm-2:20pm, and so 
on), and their corresponding final exam days and times. In addition to creating a template, 
you have the flexibility to define common exams, specify the final exam schedules for 
specific courses, specify the final exam for multiple courses, and/or exclude certain courses 
from the final exam scheduling process. 

To create a final exam schedule template

1. On the EMS Campus menu bar, click Academic Planning > Courses > Final Exam
Schedule Templates.

The Final Exam Schedule Templates window opens. This window lists all the final exam
schedule templates that are currently configured in your EMS database.

Figure 13-74: Final Exam Schedule Templates window

Unless otherwise specified in Final Exam Settings, EMS Campus attempts to 
schedule the final exam for a course in the same room that the course has been 
using for the term. The final exam session publishing process adds the final exam 
as a separate booking in the course's reservation.
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2. Click New.

The Final Exam Schedule Template dialog box opens. The Final Exam Schedule
Template tab is the active tab.

Figure 13-75: Final Exam Schedule Template dialog box, Final Exam Schedule Template tab

3. In the Description field, enter a name or description for the final exam schedule
template, for example, Fall Finals.

4. Open the Schedule tab.

Figure 13-76: Final Exam Schedule Template dialog box, Schedule tab

The description can be a maximum of 50 characters, including spaces.
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5. Continue to one of the following to create a list of unique course schedule patterns:

• “To manually create a final exam schedule template” below.

• “To import a term to create a final exam schedule template” on page 565.

• “To import a file to create a final exam schedule template” on page 566.

To manually create a final exam schedule template

1. Click New.

The Final Exam Schedule Days dialog box opens.

2. Enter the information for a unique course schedule pattern and the corresponding final
exam day and time, and then click OK.

The Final Exam Schedule Days dialog box closes. You return to the Schedule tab with
the pattern displayed on the tab.

Figure 13-77: Final Exam Schedule Days dialog box (shown with information for a final exam 
schedule)

3. Repeat this procedure as many times as needed to create a final exam schedule template
for each unique course schedule pattern in the term.

4. Click OK on the Final Exam Schedule Template dialog box.

The dialog box closes. You return to the Final Exam Schedule Templates window with
the newly configured final exam schedule template automatically selected.

If any meeting patterns are left without a corresponding final exam time, then 
courses that fit that meeting pattern in the term will not have a final exam 
scheduled for them. 
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To import a term to create a final exam schedule template

1. Click Import, and on the dropdown list that opens, select Term.

The Term Picker dialog box opens. The dialog box lists all the terms that are currently
configured in your EMS database.

Figure 13-78: Term Picker dialog box

2. Select your Domain and Term for which you are creating the final exam schedule
template, and then click OK.

EMS scans the term and identifies unique meeting patterns to begin the template
building process. After the import is complete, a message opens indicating this.

3. Click OK to close the message and return to the Schedule tab.

The imported patterns are displayed on the Schedule tab.

4. Select an individual pattern, or CTRL-click to select multiple patterns, and then click
Edit to open the Final Exam Schedule Days dialog box and assign the final exam day of
the week and the final exam start and end times.

5. Click OK to close the Final Exam Schedule Days dialog box and return to the Schedule
tab.

6. Click OK on the Final Exam Schedule Template dialog box.

The dialog box closes. You return to the Final Exam Schedule Templates window with
the newly configured final exam schedule template automatically selected.

If any meeting patterns are left without a corresponding final exam time, then 
courses that fit that meeting pattern in the term will not have a final exam 
scheduled for them. 
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To import a file to create a final exam schedule template

You can import your course schedule patterns from a tab-delimited text file. To view the 
import file specifications, on the Final Exam Schedule Templates window, click Print > 
Import Format. 

Figure 13-79: Course Schedule Patterns import file format

1. Click Import, and then on the dropdown list that opens, click File.

The Open File dialog box opens.

2. Browse to and select the import file, and then click Open.

The Open dialog box closes and the course schedule patterns are imported. After the
import is complete, a message opens indicating this.

3. Click OK to close the message and return to the Schedule tab.

The imported patterns are displayed on the Schedule tab.

4. Select an individual pattern, or CTRL-click to select multiple patterns, and then click
Edit to open the Final Exam Schedule Days dialog box and assign the final exam day of
the week and the final exam start and end times.

5. Click OK to close the Final Exam Schedule Days dialog box and return to the Schedule
tab.

6. Click OK on the Final Exam Schedule Template dialog box.

The dialog box closes. You return to the Final Exam Schedule Templates window with
the newly configured final exam schedule template automatically selected.

See Appendix E, Import File Specifications in the EMS Setup Guide for a table 
that details the Course Schedule Patterns import file specifications.

If any meeting patterns are left without a corresponding final exam time, then 
courses that fit that meeting pattern in the term will not have a final exam 
scheduled for them. 
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To specify final exam settings for a specific course

1. Open the specific course in the Course Navigator through either the Academic Browser,
the Academic Book, or the Navigator.

Figure 13-80: Course opened in the Course Navigator

2. In the middle pane of the Navigator, select a course date record, and then click Edit.

The Course Dates dialog box opens. The Course Dates tab is the active tab.

3. Open the Final Exam Settings tab.

Figure 13-81: Course Dates dialog box, Final Exam Settings tab
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4. Do any of the following:

• If a final exam is not required for the course, then clear the Final Exam Required
option, and go to Step 5.

• If the course is having a final exam at a day/time other than what is specified by the
template (see “To create a final exam schedule template” on page 562), select
Special/Common Exam, and then enter the date, and start and end times for the
special/common exam.

• Optionally, if you would like the seat fill percentage to be a different value than the
default value, update the seat fill percentage for the exam.

• If the exam is to take place in a different room (not the same room that the course has

been using all semester), click the Search icon  next to Room Required to open

the Room Selector dialog box and select a different room for the exam.

• If the exam is to take place in the same room that the course has been using all
semester, then select Require Current Room.

5. Optionally, in the Notes field, enter any information that is pertinent to the course or
final exam.

6. Click OK.

The Course Dates dialog box closes. You return to the Course Navigator with the course
date still selected.

Typically, courses with multiple course dates, lab components, or short-term 
courses are marked as “No Exam Required.”

During publishing of the final exam session, if the same room is unavailable, EMS 
leaves the course unassigned for a manual search.
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To specify final exam settings for multiple courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic
Browser.

The Academic Browser opens.

2. If needed, open the Filter tab.

Figure 13-82: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance
in locating the courses for which you want to set preferences and requirements, and then
click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

5. In the search results, CTRL-click to select the multiple courses for which you are setting
the final exam schedule.

6. On the Tools menu, click Set Final Exam Settings.

The Set Course Final Exam Settings dialog opens. See Figure 13-83 on page 570.

For detailed information about searching with the Academic Browser, see 
“Searching with the Academic Browser” on page 579.
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Figure 13-83: Set Course Final Exam Settings dialog box

7. Do one of the following:

• If a final exam is not required for the courses, then select Final Exam Not Required,
and then go to Step 8.

• If the courses are having their final exams at a day/time other than what is specified
by the template (see “To create a final exam schedule template” on page 562), select
Special/Common Exam, and then enter the date, and start and end times for the
special/common exam.

• If the final exams for all the selected courses are to be in the same room, then select
Common Exam Room.

• If the exam/exams are to take place in a different room (not the same rooms that the

courses have been using all semester), click the Search icon  next to Room

Required to open the Room Selector dialog box and select a different room for the
exams.

Typically, courses with multiple course dates, lab components, or short-term 
courses are marked as “No Exam Required.”

All the selected courses will meet at the date/time specified

All courses will meet in this room for the final exams.
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• If the exams are to take place in the same rooms that the courses have been using all
semester, then select Require Current Room.

8. Optionally, do one or both of the following:

• If you want the seat fill percentage to be a different value than the default value,
update the seat fill percentage for the exam.

• In the Notes field, enter any information that is pertinent to the course or final exam.

9. Click OK.

The Related Courses Dates dialog box opens. This dialog box lists all the courses that
you selected on the Results tab of the Academic Browser.

Figure 13-84: Related Course Dates dialog box

10. Select the courses to which the final exam settings are to be applied, or click Select All
to select all the courses in a single step, and then click OK.

A message opens indicating that any final exam settings that exist for the selected
courses will be overwritten, and asking you if it is OK to continue.

11. Click Yes.

A second message opens indicating that the final exam settings were successfully set.

12. Click OK to close the second message and the Related Course Dates dialog box.

You return to the Results tab of the Academic Browser, with the courses still selected on
the tab.

 If no room is requested, or Require Current Room is selected, then each course 
will have the final exam in its own room. During publishing of the final exam 
session, if the same room is unavailable, EMS leaves the course unassigned for a 
manual search.
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Publishing a Final Exam Session

After you have created the final exam schedule template for the term, and updated any final 
exam settings, you must publish the final exam session. Publishing a final exam session is a 
two part process. First, you must create a final exam session and specify a start date for the 
session. Second, you must then apply a final exam schedule template to the final exam 
session and then you can publish the session.

To create a final exam session

1. On the EMS Campus menu bar, select Academic Planning > Courses > Final Exam
Sessions.

The Final Exam Sessions window opens. The window lists all the final exam sessions
that have been published in your EMS database.

Figure 13-85: Final Exam Sessions window

2. On the Domain dropdown list, select the campus for which you are publishing the final
exam session, and on the Term dropdown list, select the term.
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3. Click New.

The Final Exam Session dialog box opens. The Final Exam Session tab is the active tab.

Figure 13-86: Final Exam Session dialog box, Final Exam Session tab

4. In the Description field, enter a name or description for the session, for example, Fall
Finals 2011.

5. Select a start date for the final exam session.

6. Open the Rooms tab and select the rooms that are available to host final exams by doing
the following:

• On the Building dropdown list, select (all) buildings, or select a specific building,
area, or view.

• On the Room Type dropdown list, leave the default value of (all), or select a specific
room type.

• In the Available list, select the room, or CTRL-click to select multiple rooms, and
then click the Move (>) button to move the rooms to the Selected list.

The description can be a maximum of 30 characters, including spaces.

The final exam session will start on this date. Use the final exam template day of 
the week to schedule specific final exam dates. EMS can accommodate up to a two 
week final exam session.

If needed, you can repeat these steps for specific buildings until you have selected 
all the rooms in specific buildings that can host a final exam.
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7. Click OK.

The Final Exam Session dialog box closes. You return to the Final Exam Sessions
window with the newly configured session automatically selected.

8. Continue to “To publish the final exam session” below.

To publish the final exam session

1. If you have not already done so, open the Final Exam Session dialog box and select the
session that is to be published.

2. Click Publish.

The Final Exam Scheduling window opens. This window lists all the unique course
schedule patterns for the term for which you are publishing the final exam session.

Figure 13-87: Final Exam Scheduling window

3. On the Schedule Template dropdown list, select the final exam template that is to be used
for the term, and optionally select Ignore Room Capacity if you do not want EMS to
consider room capacity when assigning final exam sessions.

The Final Exam Date, Final Exam Start, and Final Exam End columns are automatically
populated based on the applied template.
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4. If necessary, do one or more of the following:

• Select a unique course schedule pattern and click Set Date to open the Final Exam
Date dialog box and edit a pattern setting, or create a course schedule pattern that
was not in the selected template.

• Select a unique course schedule pattern and click Clear to clear the pattern setting,
and then click Set Date to open the Final Exam Set dialog box and edit the pattern as
needed.

5. Click Next.

The Final Exam Scheduling window lists the summarizing information for any special/
common exams that have been set for specific courses.

6. Optionally, select a course, and then click Open to view the course in the Course
Navigator.

7. Click Finish.

A message opens, indicating that you are about to publish the final exam schedule, and
asking you if it is OK to continue.

8. Click Yes.

The message closes. After the final exam session is published, a second message opens
indicating this.

9. Click OK.

The second message closes and the View Bookings window opens. By default, the
window initially shows only those final exam bookings for which a room could not be
scheduled.

Figure 13-88: View Bookings window
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10. Optionally, do one or more or all of the following:

• To view all final exam bookings, clear the Show Unassigned Only option.

• To view a course in the Navigator, select the course, and then click Open.

• To export the course list to a Microsoft Excel spreadsheet, click Export.

11. Click Close to close the View Bookings window and return to the Final Exam Sessions
window.

The final exam session publishing process adds the final exam for each course as a separate 
booking in the course's reservation. After you publish a final exam session, you can find the 
final exam booking for a course by opening the course in the Navigator and expanding the 
reservation and scrolling to the bottom of the Reservation (left) pane, or to the bottom of the 
Bookings (lower right) pane. You can use the Final Exam Schedule report to review the final 
exam schedule or the Final Exam Settings report to view optional settings. (See “Generating 
Academic Reports” on page 601.) To open the View Bookings window again, click View on 
the Final Exam Sessions window. If you delete a final exam session, then all final exam 
bookings that are associated with the session are deleted.

Unless the option to require the same room was selected for a course, course 
preferences can be considered and the final exam for the course can be scheduled 
in another room through optimization. Courses can be assigned to TBD if no 
rooms were available. Those courses that are in a different room than they were 
all semester have the NO flag in the same room column.
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Searching with the Academic Browser

You can use the Academic Browser to search for courses or course dates. The results are 
displayed in a list view. When you carry out a search in the Academic Browser, you can 
carry out a basic search or an advanced search. A basic search is based on the basic 
information that you specify for a course when you first create it, such as the domain, the 
term, the academic unit, the subject, and so on. An advanced search is a field level search 
that is carried out at the course level, the course dates level, or the preference level or for 
published terms, at the reservation, booking or booking detail levels. For example, in an 
advanced search, you can specify criteria as granular as “courses with credit hours greater 
than 3.0.” After the search results are returned, you have a variety of options for working 
with the results, including sorting and grouping information or using the Tools menu to 
perform functions. The actions that you can carry out in the Academic Browser depend upon 
the mode (Read Only, Define and Edit Courses, or Set Preferences) that is enabled for the 
academic term with which you are working in EMS Campus.

To carry out a search in the Academic Browser

1. Do one of the following to open the Academic Browser:

• On the EMS Campus toolbar, click the Academic Browser icon.

• On the EMS Campus menu bar, click Academic Planning > Configuration >
Academic Browser.

The first time that the Academic Browser window opens, the Filter tab is set by default 
to a basic search; otherwise, the Filter tab is set to the search type (Basic or Advanced) 
that you last carried out. 

Figure 13-89: Academic Browser, Basic Search options 
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2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and
then continue to one of the following:

• “To carry out a basic search in the Academic Browser” below.

• “To carry out an advanced search in the Academic Browser” on page 582.

To carry out a basic search in the Academic Browser

1. On the Browse For dropdown list, select the item for which to search.

2. Enter the search criteria.

3. Optionally, click Options and edit the default value for the additional search option
Number of Records to Return.

4. Click Get Data or Refresh.

The search results are displayed on the Results tab. If you have searched for courses,
then the results include courses without course dates (meeting patterns). “Multiple” is
displayed for those courses with more than one course date. If you have searched for
course dates, courses without course dates are suppressed while courses with multiple
meeting patterns are expanded. EMS schedules rooms only for courses with course
dates. See Figure 13-91 on page 582.

Field Description

Domain The domain for the course or course date.

Term The term for the course or course date.

Scenario Displays results for the specific optimization scenario selected. The 

“SIS” scenario displays room assignment information from your SIS.

Academic Unit The academic unit for the course or course date.

Subject The subject for the course or course date.

Instructor The instructor for the course or course date.

Preferences Exist Used to identify the rooms for the courses/course dates that have/do not 

have room preferences/requirements specified.

edited Courses Only Used during the Define and Edit mode to identify courses or course 

dates that have changed (new, canceled, and/or edited courses/course 

dates).
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Figure 13-90: Academic Browser window, Results tab

5. Optionally, do one or more of the following:

• The Results tab is an EMS browser window. See “An EMS Browser Window” on
page 35 for all the features that are available for this tab.

• To open a course in the Course Navigator, double-click the course entry on the
Results tab.

• Click Print to print the search results.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• In Define & Edit mode or Dual mode, use the New Course and New Section options
as needed.

• Select a course, or CTRL-click to select multiple courses, and depending on the
mode, the following options are available on the Tools menu:

• Set Preferences mode—Set Course Preferences (see “Specifying Room
Preferences/Requirements” on page 491) and Clear Course Preferences. Click
Clear Course Preferences to clear all the current preferences/requirements for
the selected courses in a single step.

• All Modes (including Read Only)—Shares Space, Does Not Share Space,
Change Shares Space Parent (see “Working with Shared Space” on page 475)
and Set Final Exam Settings. (See “Setting a Final Exam Schedule” on page
562.)
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• All Modes (including Read Only)—Unsync Selected Courses, which deletes the
selected course records and the corresponding reservations and bookings from
EMS.

• In the Browse For field, select a different item for which to search. The Results tab is
refreshed with the search results based on the item that you selected and the search
criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria and repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position, width, and so on)
remain in effect for any other searches that you carry out. To reset the columns to their
default values, see “Resetting Column Settings” on page 408.

To carry out an advanced search in the Academic Browser

Figure 13-91: Browser window, Advanced search options

1. On the Browse For dropdown list, select the item for which to search.

2. Select a domain, term, and/or scenario to search.

You should use this option sparingly; however, it might be required post-publish if 
an error occurred in your SIS or during publish.
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3. For each field level option by which to carry out the search:

• Select the field level option, and then click the Move button (>).

• When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

Figure 13-92: Viewing a selected field option in the Filter Summary list

4. Optionally, click Options and edit the default value for the additional search option
Number of Records to Return.

5. Click Get Data or Refresh.

The search results are displayed on the Results tab. If you have searched for courses,
then the results include courses without course dates (meeting patterns). “Multiple” is
displayed for those courses with more than one course date. If you have searched for
course dates, courses without course dates are suppressed while courses with multiple
meeting patterns are expanded. EMS schedules rooms only for courses with course
dates. See Figure 13-93 on page 584.

To filter the list of available fields, in the Field Search field, enter a search string. 
Your search is limited to the exact order of the characters in the string, but the 
string is not case-sensitive and it can appear anywhere in the search results. For 
example, a search string of add returns Added by, Date Added, and Group 
Address Line 1. The list of fields that meets your search criteria is dynamically 
updated as you enter your search criteria.

If you have specific fields and/or values by which you always want to carry out a 
search, then you can set up these fields to be your Favorite fields. See “To set up 
favorite fields for an Academic Browser search” on page 585.

To view a selected field option in its entirety in the Filter Summary list, rest the 
mouse pointer on the entry. A tooltip showing the complete field option 
information opens. 
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Figure 13-93: Academic Browser window, Results tab

6. Optionally, do one or more of the following:

• The Results tab is an EMS browser window. See “An EMS Browser Window” on
page 35 for all the features that are available for this tab.

• To open a course in the Course Navigator, double-click the course entry on the
Results tab.

• Click Print to print the search results.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• In Define & Edit mode or Dual mode, use the New Course and New Section options
as needed.

• Select a course, or CTRL-click to select multiple courses, and depending on the
mode, the following options are available on the Tools menu:

• Set Preferences mode—Set Course Preferences (see “Specifying Room
Preferences/Requirements” on page 491) and Clear Course Preferences. Click
Clear Course Preferences to clear all the current preferences/requirements for
the selected courses in a single step.

• All Modes (including Read Only)—Shares Space, Does Not Share Space,
Change Shares Space Parent (see “Working with Shared Space” on page 475)
and Set Final Exam Settings. (See “Setting a Final Exam Schedule” on page
562.)
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• All Modes (including Read Only)—Unsync Selected Courses, which deletes the
selected course records and the corresponding reservations and bookings from
EMS.

• In the Browse for field, select a different item for which to search. The Results
tab is refreshed with the search results based on the item that you selected and
the search criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria and repeat the search.

• Click Refresh to requery the database based on the current search criteria.

7. Click Close.

Any changes that you made to the search results columns (position, width, and so on)
remain in effect for any other searches that you carry out. To reset the columns to their
default values, see “Resetting Column Settings” on page 408.

To set up favorite fields for an Academic Browser search

If you have specific fields and/or values by which you always want to carry out an Academic 
Browser search, you do not have to filter the list of fields on the All Fields tab for every 
search. Instead, you can set up each of these fields to be a favorite field with a specific value 
or limit if needed. 

1. Open the Academic Browser, and make sure that the Advanced search features are
displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields
tab, and then click Add to Favorites.

The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on
the Filter dialog box.

The next time that you carry out a search, you can simply open the Favorite Fields tab or
the Saved Values tab to carry out a search based on your customized list of search fields.

You should use this option sparingly; however, it might be required post-publish if 
an error occurred in your SIS or during publish.
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Using the Academic Book

The Academic Book provides a week-at-a glance graphical view of the courses that are 
assigned to a specific room or instructor. The view is for one room at a time as opposed to the 
Reservation Book, which shows all rooms one day at a time. The Academic Book shows 
only classes during the Planning phase of academic scheduling, but it shows both classes and 
events post-publish. To open the Academic Book, do one of the following:

• On the EMS Campus toolbar, click the Academic Book icon .

• On the EMS Campus menu bar, click Academic Planning > Courses > Academic Book.

Figure 13-94: Academic Book

When the Academic Book first opens, if you are working with a future term, then the date is 
set to the first Sunday or Monday of a full week of the term; otherwise, if you are working 
with a current term, then the date is set to the first Sunday or Monday of the current week. 

Whether the date is set to Sunday or Monday is determined by the setting for the 
Day Label - First Day of the Week EMS system parameter. See the EMS Setup 
Guide.
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In both cases, the display is filtered by Room and Building. You have many options for 
changing the view in the Academic Book to better meet your working needs, including:

• Changing the display date. See “To change the date display” below.

• Changing the view of courses by room. See “To change the view of courses by room” on
page 588.

• Changing the view of courses by instructor. See “To change the view of courses by
instructor” on page 589.

• Setting options that specify such things as what is displayed in the book when it first
opens, mouse actions in the book, what information is displayed in course tooltips, and so
on. See “To set options for the Academic Book” on page 590.

• Opening a course in the Course Navigator. See “To open a course in the Course
Navigator” on page 592.

• Displaying the details for a room. See To “To display the details for a room” on page 593.

To change the date display

• On the Date field, click the dropdown arrow to open the Calendar. Use the scroll features
(< and >) at the top of the calendar to change the month or year. To select a different date
for a month, click the date.

Figure 13-95: Academic Book calendar

• Use the scroll features at the top of the reservation book display to scroll to a different
day, week, month, year, or any different combination of these.

Figure 13-96: Academic Book calendar scroll features

You can also manually enter a new date into the field. In all cases, the date that 
you choose specifies the start of the week that you are viewing. To view a full week, 
always select a Sunday or a Monday.
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To change the view of courses by room

If the Academic Book is in the Room view, then the default minimum and/or maximum 
capacities that have been configured for a room are displayed next to the room. To change 
the view of courses by room, change any and all of the available display options—Domain, 
Term, Scenario (SIS by default or an Optimization scenario if optimization has taken place), 
the Building/Domain/View, and/or the Time Zone.

Figure 13-97: Academic Book, courses grouped by room
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To change the view of courses by instructor

To change the view of courses to that by Instructor, click Instructor, and then, change any and 
all of the available display options—Domain, Term, Subject, and/or Time Zone. To filter the 
list by a specific instructor, enter a search string in the Name field, and then click Go. Click 
the name of an instructor in the left pane to see a list of courses that are scheduled for the 
instructor.

Figure 13-98: Academic Book, courses grouped by instructor

Your search is limited to the exact order of the characters in the string, but the 
search is not case-sensitive and it can appear anywhere in the search results. For 
example, a search string of and returns Anderson, Scott, Sanders, Barry, and so 
on. 
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To set options for the Academic Book

Click Options in the upper right hand corner of the Academic Book to open the Academic 
Book options dialog box. You use the options on this dialog box to specify such things as 
what is to be displayed in the book when it first opens, mouse actions in the book, and so on.

Figure 13-99: Academic Book Options dialog box, General tab

Option Description

General tab

Start Hour The starting time for the Time grid that is displayed in the Academic 

Book.

Display • Event Name/Course—Display the event name/course in the course

entry.

• Setup Type—Show the setup type and count in the course entry.

• Group/Instructor—Show the group name/instructor name in the

course entry.

Published Booking 

Colors Based On

For published courses, whether the fill color for a course entry is to be 

based on the Status color palette or on the Event Type color palette that 

has been determined in Configuration.

Rooms Without 

Bookings

The color with which rooms without bookings are highlighted in the 

Academic Book.
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Figure 13-100: Tooltip for a course entry in the Academic Book

Room Display • Room Code—Show the room code in the Room list when the courses

are grouped by room.

• Room Description—Show the room description in the Room list when

the course are grouped by room.

Building Display • Building Code—Show the building code in the Rooms list when the

courses are grouped by room.

• Building Description—Show the building description in the Rooms list

when the coursed are grouped by room.

Go to Today on Startup Not applicable.

Always Prompt for 

Building on Startup

Opens the Building dropdown list when the Academic Book first opens, 

which requires that you select a building, domain, or view before you 

can continue, as opposed to simply opening the building that you last 

viewed in the Academic Book.

Show (all) in Building list Make (all) buildings an available option in the Building dropdown list, as 

opposed to having to choose a single building.

Show Building in 

Instructor Bookings

Show the Building Code in the course entry when courses are grouped 

by instructor (space permitting).

Show Room in 

Instructor Bookings

Show the Room Code in the course entry when courses are grouped by 

instructor (space permitting).

Tooltip Display (Unpublished)—Select the information that is to be displayed when the mouse 

pointer is placed on the entry for an unpublished course in the Academic Book. 

Tooltip Display (Published)—Select the information that is to be displayed when the mouse 

pointer is placed on the entry for a published course in the Academic Book. 

Option Description
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To open a course in the Course Navigator

• Double-click a course entry for a non-published course in the Academic Book to open the
course in the Course Navigator.

• Double-click a course entry for a published course in the Academic Book to open the
course in the Navigator, select the course on the Course Info tab, and then click Course to
open the course in the Course Navigator.

Figure 13-101: Course opened in the Course Navigator

For detailed information about working with the Course Navigator, see “Using 
the Course Navigator” on page 594.
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To display the details for a room

To display details about a room, make sure that the Academic Book is in the Rooms view, 
and then right-click on any room in the Rooms list to open a Room Info dialog box that 
provides the following information on the appropriate tabs—the bookings for the room, the 
properties for the room, the pricing for the room, any images of the room and any user 
defined fields (UDFs) that are associated with the room. 

Figure 13-102: Room Info dialog box
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Using the Course Navigator

The Course Navigator is a window in EMS Campus that you use to view and manage all 
aspects of a course. You can access the Course Navigator from the Academic Browser, the 
Academic Book, and the EMS Navigator. Different tabs and panes on the Course Navigator 
provide different information about a course and course dates. The actions that you can carry 
out in the Course Navigator depend upon the mode (Read Only, Define and Edit Courses, Set 
Preferences, or Dual) that is enabled for the academic term with which you are working in 
EMS Campus.

To access the Course Navigator

• To access the Course Navigator from the Academic Browser, for an unpublished course,
double-click the course in the search results to open the course in the Course Navigator.

• To access the Course Navigator from the Academic Book, for a published course, double-
click the course entry in the Academic Book to open the course in the Navigator, and then
click Course on the Course Info tab to open the course in the Course Navigator.

• To access the Course Navigator from the EMS Navigator, do the following in the order
indicated:

• On the toolbar, click the Navigator icon  to open the Open Navigator dialog 
box.

• On the Open dropdown list, select Course to open a Domain dropdown list and a
Term dropdown list.

Figure 13-103: Open Navigator dialog box

• Select a domain and a term.

• In the CRN field, enter the CRN (course reference number) for the course.
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• Click OK.

• If the course is a non-published course, then the course opens in the Course
Navigator.

• If the course is a published course, then the course opens in the Navigator. Select
the course on the Course Info tab, and then click Course to open the Course in
the Course Navigator.

Course Navigator window layout

Figure 13-104: Course Navigator

The top pane of the Course Navigator displays information about a selected course—the 
course title, the course term, the current course state (New, Edit, Unchanged, or Cancelled), 
and so on. The middle pane of the Course Navigator displays information about each of the 
course dates for the course. To view the indicated information for a course date, select a 
course date in the middle pane of the Course Navigator, and then open the appropriate tab 
(Dates, User Defined Fields, Shares Spaces, Preferences, or Final Exam Settings). The 
History tabs in the middle and lower pane provide audit information for course records and 

Top pane with course 
information.

Middle pane with course 
dates information and 
tabs with course-level 
information.

Bottom pane with course 
dates details and tabs 
with course dates 
information.
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course date records. To view changes made to course-level information, open the History tab 
in the middle pane of the Course Navigator. To view changes made to course date-level 
information, select a course date in the middle pane, and then open the History tab in the 
bottom pane of the Course Navigator. 
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Available Actions in the Course Navigator

The actions that you can carry out in the Course Navigator depend upon the mode (Read 
Only, Define and Edit Courses, Set Preferences) that is enabled for the academic term with 
which you are currently working with in EMS Campus.

Mode Available Actions

Read Only The default mode in which the Navigator is placed if you have not 

selected any other mode. No actions are available.

Define and Edit • Add course dates

• Edit a course

• Edit course dates

• Cancel course dates

• Cancel courses

Note: These changes require an update in the SIS. See “Enabling/

Disabling a Term for Define & Edit Mode” on page 458 for more 

information.

Set Preferences Set preferences for a course on a course date by course date basis.
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Using the Search for Rooms Tool

After you publish a term, there are times when you need to identify which rooms are 
available for a particular meeting pattern and set of criteria. For example, an academic unit 
might need to add a new section for a course or an instructor might be looking to change the 
times for a course. The Search for Rooms tool significantly simplifies the process of 
searching for classrooms in these situations.

To search for rooms using the Search for Rooms tool

1. On the EMS Campus menu bar, click Academic Planning > Courses > Search For
Rooms.

The Search For Rooms dialog box opens.

Figure 13-105: Search For Rooms dialog box

2. On the Domain dropdown list, select the appropriate domain and on the Term dropdown
list, select the appropriate term.
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3. Do one of the following:

• Manually enter the meeting pattern information (start and end dates, start and end
times, and meeting days) for the course.

• Click Time Blocks to open the Time Blocks dialog box, and then select a time block
from a list of time blocks that have been made available for the term.

4. Enter your search criteria.

5. In the Available list, select the feature, or CTRL-click to select the multiple features that
the rooms are to have, and then click the Move button (>) to move the selected features
to the Selected list.

6. Click Next.

The Search for Rooms dialog box opens with up to three tabs displayed:

• Available Rooms tab. By default, the Available tab is always displayed and it is
always the active tab.This tab displays all the rooms that meet all your search
criteria.

• Academic Conflicts tab. The Academic Conflicts tab is displayed only if there are
rooms that meet all your search criteria but they are in academic conflict (a course
has already been scheduled in a room for the selected day and time pattern).
Optionally, you can open the Academic Conflicts tab to view the list of rooms that
are in academic conflict.

• Event Conflicts tab. The Event Conflicts tab is displayed only if there are rooms that
meet all your search criteria but they are in event conflict (a non-academic event has
already been scheduled in a room for the selected day and time pattern). Optionally,
you can open the Event Conflicts tab to view the list of rooms that are in event
conflict.

See Figure 13-106 on page 600.

Option Description

Building The default value is (no preference). You can select a specific building, 

area, or view.

Room Type The default value is (no preference), but you can select from a list of 

pre-configured types.

Enrollment

Ignore Room Capacity

Available only if Ignore Room Capacity is not selected. You can enter a 

specific room capacity by which to search.

Ignore Term Excluded 

Dates

Not selected by default. Select this option to search for rooms that are 

available even on dates that have been marked as “Excluded” for the 

term.
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Figure 13-106: Search For Rooms dialog box, Available tab

7. Optionally, you can do one or more or all of the following on this tab:

• Use the Scroll feature to scroll the list of available rooms, and then click Close to
close the dialog box.

• Click Previous to return to the Search For Rooms dialog box, modify your search
criteria, and repeat the search.

• Click Print to open an onscreen preview of the list of available rooms. The preview
window contains options for printing a hard copy of the room list, emailing the list,
and so on.

Figure 13-107: Onscreen preview of the Available Rooms list
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Generating Academic Reports

For any academic report, you can specify the parameters, options, and format for the report, 
or you can generate the report according to memorized settings. (For detailed information 
about a memorized report, see “Working with Memorized Reports” on page 323.) Not all 
reports require the same parameters, nor do they all have the same options available. In 
addition, you can generate different reports in different formats.

To generate an academic report

1. On the EMS Campus menu bar, click Academic Planning > Reports to open the Reports
menu, and then click the option for the report that you are generating. For example, to
generate the Course List report, click Academic Planning > Reports > Course List.

2. On the Setup dropdown list, do one of the following:

• To generate the report according to the filter settings that you want (parameters,
options, and so on), leave user-specified selected, then go to Step 3.

• To run the report with filter settings that have been saved, or memorized, select the
memorized report, and then go to Step 4.

All subjects must belong to an academic unit to be displayed on an academic 
report. Refer to the EMS Setup Guide for detailed information about configuring 
academic units and synchronizing subjects.

All academic reports are also available under Reports >Academic Planning.

For brevity and ease, the parameters that are available for each report are not 
detailed in this section. If you need help with generating any of these reports, 
contact your EMS administrator.

For detailed information about memorized reports, see “Working with Memorized 
Reports” on page 323.
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3. Specify the report parameters, options, and format. See:

4. Optionally, do one or more or all of the following:

• In the Report Comment field, enter a comment that is to be printed on the report.

• Click Print Preview.

A preview of the report opens onscreen.

• To print a hard copy of the report, specify the number of copies that you are printing,
and then click Print.

5. Click Close.

Unless you change the setup, all subsequent reports will be generated and printed
according to the parameters and options that you have specified and in the format that
you specified. If you want to save certain settings so that you do not have to adjust the
filter settings every time you run the report, you can memorize the report. (See “Working
with Memorized Reports” on page 323.)

“Course List” on page 603. “Time Block Violations” on 

page 607.

“Academic Unit Statistics” on 

page 610.

“Course Changes” on page 

604.

“Time Block Room Availability/

Usage” on page 607.

“Course Type Analysis” on 

page 610.

“Course Preferences” on page 

605.

“Academic Class Meeting 

Utilization” on page 608.

“Final Exam Settings” on page 

611.

“Preferences Summary” on 

page 605.

“Classroom Utilization” on 

page 608.

“Final Exam Schedule” on 

page 611.

“Unmet Preferences” on page 

605.

“Hourly Classroom Utilization” 

on page 608.

“Trend Report” on page 612.

“Instructor Back to Back” on 

page 606.

“Over/Under Utilization” on 

page 609.

“Instructor Summary” on page 

606.

“Prime Time Usage” on page 

609.

The comment can be a maximum of 255 characters, including spaces.
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Course List

Description Options

Provides a list of courses and course dates. 

Note: This report is often sent out to academic units for 

review when the Domain Scheduler is finished with 

room assignments.

There are options to include courses without room assignments and to 

print User Defined Fields that are associated with courses. Formats 

include:

• By Course

• By Instructor

• By Academic Department By Course

• By Academic Department By Instructor

• By Day of Week

• By Location

• By Estimated Enrollment

• By Start Time

• By Subject

• By Course Type
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Course Changes

Description Options

Used during Define and Edit Mode to capture changes 

made by the academic units to courses and course dates 

so that the Domain Scheduler can data enter these 

changes into the SIS.

• Show Changes

• All Changes For Term—If selected, all changes for the term (even

changes that have possibly already been data-entered into the SIS)

are included in the report.

• *Changes Since Last Synchronization—If selected, the report

includes only changes that have been made since the last time that

the term was synchronized.

• Show Room Changes—If selected, the report includes changes to

rooms (post-publish only).

• Show Cancelled Courses Only—If selected, the report includes only

cancellations.

• Show New Courses Only—If selected, the report includes only new

courses.

• Show Edited Courses Only—If selected, the report includes only

changes.

• Show Latest Changes Only—If this option is selected, and a single

value has been changed multiple times, the report includes only the

most recent change for the field.

• Hide Change Details—If selected, audit trail details are hidden on the

report.

• Show All Courses—If selected, all courses, even those without changes,

are shown in the report.

• Show User Defined Fields—If selected, the report includes any user

defined fields that have been completed.

• *Show Notes—If selected, any user-supplied notes are shown in the

report.

Note: The options that are marked with an asterisk (*) are the 

recommended options for the most inclusive reports.



 
Academic Planning (EMS Campus)

605

Course Preferences

Preferences Summary

Unmet Preferences

Description Options

Used after Set Preferences mode to provide a list of 

courses and course dates with their preferences and 

requirements.

Format Choices:

• By Course

• By Academic Department By Course

• By Academic Department by Instructor

Description Options

After running an optimization scenario, this report is used 

to summarize the following information:

• The number of each type of preference or requirement.

• The number of the preferences that can be met from

the optimization process.

• The number of preferences that cannot be met from the

optimization process.

You can generate this report for each different scenario 

that was optimized. 

N/A

Description Options

After running an optimization scenario, this report is used 

to list the courses that had preferences or requirements 

that were not met during the optimization process. You 

can generate this report for each different scenario that 

was optimized. 

Format Choices:

• By Course

• By Academic Department By Course

• By Academic Department by Instructor
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Instructor Back to Back

Instructor Summary

Description Options

Lists the courses that have instructors who are scheduled 

to teach two courses at the same time (Conflicts) and 

instructors who are teaching back to back in different 

locations within the time gap that is specified in Options. 

• The days of the week that are to be included in the instructor’s schedule.

• The time gap (in minutes) between classes on the specified days that

determines “back to back.”

Description Options

This report includes the following values per instructor:

• Number of sections.

• Number of teaching hours.

• Number of credit hours.

• Total estimated enrollment.

• Total actual enrollment.

• Number of sections in Prime Time.

• Number of Time Block violations,.

N/A
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Time Block Violations

Time Block Room Availability/Usage

Description Options

Lists the courses that are in violation of the Time Block 

template. In the Summary format, the following values are 

included:

• Total number of course dates

• Total in violation

• Percent in violation

• Total that meet the Time Block template

• Percent that meet the Time Block template

• Percent of total violations per academic unit

• Format options:

• By Course

• By Instructor

• By Academic Unit By Course

• By Academic Unit By Instructor

• Summary

• Chart - Violation Count

• Chart - Violation Totals

• Show All Courses

• Include Courses Not Assigned To Rooms

• Show User Defined Fields

Description Options

Displays the number of rooms that are either available or 

in use for each room size (Small, Medium, or Large) for 

each time block.

Note: To generate this report, a Time Block template 

must be indicated on the term.

• Format options:

• Availability

• Usage

• Indicate Low Availability and High Availability Thresholds

• Include All Active Scenarios in other Domains
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Academic Class Meeting Utilization

Classroom Utilization

Hourly Classroom Utilization

Description Options

Used after publishing to view the percent utilization of 

your rooms based on the number of class meetings that 

you specify. For instance, if you hold 50 minute courses 

from 8:00 - 5:00 (9 meetings) and have one evening 

course from 6:00 - 9:00 (1 meeting) Monday through 

Friday (x5), you would have 50 class meetings per week.

N/A

Description Options

Used to analyze the percent that your rooms are utilized 

compared to a number of hours and the percentage of 

seats full (selected enrollment compared to room 

capacity). 

Note: In Manage Terms, you can specify either 

estimated enrollment or actual enrollment. The 

value that you selected is the value that is used to 

calculate the values for this report.

• Format Options:

• Detail

• Chart - By Building

• Chart - By Room Type

• Chart - By Room Size

• The days of the week that are to be included in the report

• The Hours Per Day that are to be considered

• Include All Active Scenarios in other Domains

Description Options

Calculates the percent that a room is used during each 

hour of the day. Formats include detailed (percent for 

each hour of each room specified) and chart (a chart of 

each hour for overall).

• Format Options:

• Detail

• Chart

• The days of week that are to be reviewed

• Include All Active Scenarios in other Domains
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Over/Under Utilization

Prime Time Usage

Description Options

Displays those courses that have an adjusted enrollment 

that is either over the maximum capacity for the room or 

under the minimum capacity for the room and seat fill.

Note: In Manage Terms, you can specify either 

estimated enrollment or actual enrollment. The 

value that you selected is the value that is used to 

calculate the values for this report.

To show or not to Show All Courses (regardless if they fall outside capacity 

thresholds)

Description Options

This report displays the number of sections (course dates) 

with room assignments that fall within the specified time 

range (Prime Time) or that have been indicated as Prime 

Time on the Time Block template. 

Note: In Manage Terms, you can specify either 

estimated enrollment or actual enrollment. The 

value that you selected is the value that is used to 

calculate the values for this report.

• Format options:

• Detail

• Chart - Sections

• Chart - Class Meetings

• Chart - Class Hours

• The days of the week that are to be included in the report

• Include courses that have not been assigned into a room



 
Academic Planning (EMS Campus)

610

Academic Unit Statistics

Course Type Analysis

Description Options

Displays the following statistics for course dates that have 

been scheduled into rooms:

• Number of sections per unit

• Percentage of the total sections

• Number of class meetings

• Percentage of the total class meetings

• Number of class hours

• Percentage of class hours

• Average estimated enrollment

• Average actual enrollment

• Average seat fill

Note: In Manage Terms, you can specify either

estimated enrollment or actual enrollment. The 

value that you selected is the value that is used to 

calculate the values for this report.

• Format options:

• By Academic Unit

• By Academic Time Block

• The days of the week that are to be included in the report

• Include course dates that have not been assigned into a room

Description Options

Displays the following statistics indicated by course type:

• Number of sections

• Percentage of the total sections

• Number of class meetings

• Percentage of the total class meetings

• Number of class hours

• Percentage of class hours

• Average estimated enrollment

• Average actual enrollment

• Format options:

• Detail

• Chart - Sections

• Chart - Class Meetings

• Chart - Class Hours

• Chart - Actual Enrollment

• The days of the week that are to be included in the report

• Include course dates that have not been assigned into a room
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Final Exam Settings

Final Exam Schedule

Description Options

Outlines any final exam settings that are marked on 

courses for preparation of publishing the final exam 

schedule.

• Show All Courses - Displays all courses and their corresponding

settings

• Show Final Exam Not Required - Limits the report to those courses that

had “No Exam Required” specified

• Show Special/Common Exams - Limits the report to only those courses

with special/common exams settings

Description Options

Displays a list of courses with the corresponding final 

exam date, time, and room as assigned by the final exam 

session.

• All Assigned - All courses that have been assigned to a room by the final

exam session

• Different Rooms - All courses that have been scheduled in room that

was not the same that was used all semester for the course for the final

exam

• Unassigned - All courses that have not been scheduled in a room for the

final exam

• Final Exam Not Scheduled - All courses for which no final exam was

scheduled
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Trend Report

Description Options

Shows how the following statistics are trending term by 

term:

• Percent utilization

• Percent estimated seat fill

• Percent actual seat fill

• Percent sections in Prime Time

• Percent sections over maximum capacity

• Percent sections under minimum capacity

• Percent Time Block violations

• Format options:

• By Term

• By Term By Academic Unit

• Chart

• The days of the week that are to be included in the report

• The number of hours per day that are to be used to calculate utilization

• Include course dates that have not been assigned into a room
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Introduction 

This document lists the steps you must take to install the EMS Web Client.  The EMS Web Client is an 
optional component that extends functionality currently available within the EMS desktop client to the 
web.   

Note:  The EMS Web Client is included with your existing licensing agreement.  An active EMS user 
account is required to log into the EMS Web Client.  Users logging into the EMS Web Client will count 
against the total EMS user count that your organization is registered for. 

Customer Support 

Unlimited toll-free customer support is available to EMS users who have a current Annual Service 
Agreement (ASA).  If you are unable to resolve a problem or answer a question by reading the EMS 
documentation, contact us at: 

Email: 
Web: 
Phone: 
Fax: 

support@emssoftware.com 
www.emssoftware.com 
(800) 288-4565 
(303) 796-7429

Hardware and Software Requirements 

System requirements can be found on our website.  Please see the IMPORTANT message above. 

Obtaining the Latest Release of the EMS Web Client 

The latest release of the EMS Web Client can be downloaded from the online Support Center. 

1. Go to www.emssoftware.com and enter your Email Address and Password in the Support 
Center area.

2. Click the Software downloads link.
3. Download EMS Web Client (EMSWebClient.msi).  Required for both first time installations and 

upgrades.

Installing/Upgrading the EMS Web Client 

Important:  Before beginning the installation process, please do the following: 

 Install or upgrade your EMS databases as outlined in the EMS Installation Instructions.

 Apply the latest EMS Patch against your EMS database.  Please see the EMS Release Notes for
details.

 Manually uninstall any previous versions of the EMS Web Client on your web server.

IMPORTANT:  With the EMS desktop client, processing is distributed across all client workstations.  
When planning your server infrastructure, please keep in mind that processing for all EMS Web Client 
sessions is concentrated on the web server.  Hardware and CPU requirements should be taken into 
account to address scalability demands.  System requirements can be found on our website. 

IMPORTANT:  Please see the What’s New document for important information regarding the Web 
Client.  Existing versions of the Web Client are not compatible with this release. 
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1. Verify that the prerequisite software has been installed.
2. Download the EMSWebClient.msi file onto the web server that will be running the EMS Web

Client.
3. Run EMSWebClient.msi.
4. The first screen welcomes you to the EMS Web Client Setup Wizard.  Click Next to begin the

installation process.  The Destination Folder screen will appear.

5. Select the destination folder.  The installation process will create a new physical directory on your
web server based on the destination folder path entered (“EMSWebClient” in the example above.)
Click Next.

Note:  The EMS Web Client should not be installed in the same physical directory as other EMS 
web-based products OR under a site running another version of the EMS Web Client. 

6. The SQL Server and database information screen will appear.

7. Enter your SQL Instance Name.
8. Enter your Database Name:
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 EMS Professional customers – enter “EMSData”

 EMS Workplace, EMS Campus, EMS Enterprise, EMS District, and EMS Legal customers -
typically named  “EMS”

9. Click Next.
10. The Virtual Directory information screen will appear.

11. The Virtual Directory Name will default to the destination folder specified in Step 5.  It is
recommended that you keep the default setting.  The installation process will create a virtual
directory on your web server based on the virtual directory entered (“EMSWebClient” in the
example above.)  Click Next.

Note:  The EMS Web Client should not be installed in the same virtual directory as other EMS
web-based products OR under a site running another version of the EMS Web Client.

12. The Ready to install EMS Web Client screen will appear.  Click  to install the 
EMS Web Client.

13. The Completed the EMS Web Client Setup Wizard screen will appear.  Click Finish.

Note:  The Web Client can export standard EMS reports into PDF, RTF, XLS, TXT and HTML formats.  If 
you’re planning on exporting EMS reports in HTML format, the NETWORK SERVICE account must have 
Read, Write and Modify permissions on the Export folder (e.g. 
\\[ServerName]\inetpub\wwwroot\EMSWebClient\Export). 

Starting the EMS Web Client 

After following the steps above, verify your EMS Web Client installation by opening a browser and 
entering the EMS Web Client address: 

http://[ServerName]/EMSWebClient/ (replace [ServerName] with the name of your web server) 

The first time you launch the EMS Web Client, it may take a few extra moments for the website to display. 
If you encounter any issues, please contact Customer Support for assistance. 
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For information on how to use the EMS Web Client, please refer to your EMS User Manual. 



EMS Web Client
User’s Manual

Version 2.0
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Preface

Welcome to the EMS Web Client User’s Manual. The purpose of the EMS Web Client User’s 
Manual is to answer your questions and guide you through the procedures necessary to use 
the EMS Web Client application efficiently and effectively.

Using the manual

You will find the EMS Web Client User’s Manual easy to use. You can simply look up the 
topic that you need in the table of contents or the index. Later, in this Preface, you will find a 
brief discussion of each chapter to further assist you in locating the information that you 
need.

Special information about the manual

The EMS Web Client User’s Manual has a dual purpose design. It can be distributed 
electronically and then printed on an as-needed basis, or it can be viewed online in its fully 
interactive capacity. If you print the document, for best results, it is recommended that you 
print it on a duplex printer; however, single-sided printing will also work. If you view the 
document online, a standard set of bookmarks appears in a frame on the left side of the 
document page for navigation through the document. For better viewing, decrease the size of 
the bookmark frame and use the magnification box to increase the magnification of the 
document to your viewing preference.

Conventions used in the manual

The EMS Web Client User’s Manual uses the following conventions:

• The EMS Web Client features that are described in this manual are described for the 
Enterprise version of the desktop client. Not all of these features are available in the 
Professional version.

• Information that can vary in a command—variable information—is indicated by 
alphanumeric characters enclosed in angle brackets; for example, <Location>. Do not 
type the angle brackets when you specify the variable information.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

If you do print the document using a single-sided printer, you might see a single 
blank page at the end of some chapters. This blank page has been added solely to 
ensure that the next chapter begins on an odd-numbered page. This blank page in 
no way indicates that your book is missing information.
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• Configuration of the necessary items for the EMS Web Client is identical to the
configuration that is carried out for the Enterprise version of the desktop client. Refer to
the EMS Setup Guide for further information.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the
cover and ending on the last page of the index.

• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries
are also hyperlinks. Click the hyperlink to advance to the referenced information.

Assumptions for the manual

The EMS Web Client User’s Manual assumes that:

• You are familiar with web-based applications and basic web functions and navigational
elements.

Organization of the manual

In addition to this Preface, the EMS Web Client User’s Manual contains the following 
chapters:

•  “Getting Started with EMS Web Client,” on page 21 details the procedures for opening 
and logging on to the EMS Web Client application.

•  “Reservations and Bookings,” on page 29 details the two essential EMS components 
for meeting and event scheduling—reservations and bookings. It explains the structure 
of a reservation in EMS, it explains the concept of an event timeline for a reservation 
booking, and it describes the different ways to make a reservation in EMS.

•  “The Navigator,” on page 65 details the Navigator, which is a page in EMS that you 
use to view and manage all aspects of a reservation including bookings and booking 
details. It also provides detailed procedures for using the Navigator to add one or more 
bookings to a reservation, edit and copy reservations, edit and copy one or more 
bookings, cancel one or more bookings, add comments to reservations and bookings, and 
to manage booking details and items.

•  “Search Tools,” on page 177 details the variety of options that are available to you for 
searching for reservations and bookings in your EMS database, including the Browser, 
the Navigator, Groups, and Web Requests.

Although numbering begins on the cover page, this number is not visible on the 
cover page or front matter pages. Page numbers are visible beginning with the 
first page of the table of contents.
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•  “EMS Dashboard,” on page 207 details the EMS Dashboard, which is a page that 
centralizes critical information about reservations and web requests in a single location. 
The information that is displayed on this page provides you with the necessary input to 
manage your work in the EMS application.

•  “Groups and Contacts,” on page 229 details the procedures for adding and editing 
groups and contacts in your EMS database. It also details the procedures for sending an 
email to a group or a contact, deleting a group or a contact, and printing and exporting 
group and contact information.

•   “Confirmations,” on page 279 details a confirmation, which is a document that details 
the critical information for a reservation—the date, the time, the location, the scheduled 
resources, and so on. The chapter describes how to specify the settings for confirmations 
and how to generate a confirmation.

•   “Reports,” on page 289 details the six different categories of general reports that are 
available to assist you in monitoring and maintaining your organization’s reservation 
records and associated transactions.

•   “Billing,” on page 319 details the variety of functions that are available for working 
with invoices and transactions for reservations and bookings as well as for reporting on 
this information.

•  “User Settings,” on page 357 describes how you can manage many aspects of your 
account to better suit your working needs.

•  “Other Reservation Functions,” on page 363 details the miscellaneous standalone 
functions that are available to assist you in managing and maintaining reservations and 
bookings in your system as well as managing your general work requirements.

• “EMS Workplace,” on page 389 details the EMS Workplace module, which is a facility 
scheduling system for managing hoteling requirements, as well as the booking of 
meeting/event space and resources.
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Getting Started with EMS Web 
Client

The EMS Web Client is the web-based version of the EMS Desktop client. Just like the EMS 
Desktop client, you can use the web client to manage the meetings and events that take place 
in your facility. Standard features, which you use to create, manage, and report on events, 
include the following:

• The Reservation Wizard room booking tool

• A graphical reservation book

• The Browser and month-at-a-glance Calendar Inquiry

• Numerous daily, sales, and statistical reports

This chapter covers the following topics:

• “Logging in to and out of the EMS Web Client” on page 23.

• “An EMS Browser Page” on page 25.
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Logging in to and out of the EMS Web Client

You can access EMS Web Client through any standard Internet browser. 

To log in to the EMS Web Client

1. Open an Internet browser session.

2. In the browser’s address field, enter the EMS Web Client URL.

The EMS Web Client Login dialog box opens. 

Figure 1-1:  EMS Web Client Login dialog box

3. In the User ID field, enter your User ID.

4. In the Password field, enter your password.

If you are using Internet Explorer 8, then to use the full functionality of the EMS 
Web Client, you must enable the following setting: Tools -> Internet Options -> 
Security -> Custom Level -> Downloads -> Automatic prompting for file 
downloads.

Contact your EMS administrator if you need assistance.

If you do not know your User ID or password, contact your EMS administrator. 
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5. Click OK.

The EMS Web Client Home page opens. Seven tabs are displayed at the top of the
page——File, Settings, Reservations, Reports, Billing, Configuration, and Help. The
toolbar contains at least nine icons—Book, Calendar, Wizard, Navigator, Browser, Web
Reservations, Groups, Dashboard, and Manage Services. If you open the web client for
EMS Workplace, then the toolbar also contains a Group Reservations icon and a Check
In Status icon.

Figure 1-2:  EMS Web Client Home page

To log out of the EMS Web Client

To log out of the EMS Web Client, click File > Logout.
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An EMS Browser Page

If a page in the EMS Web Client has the phrase “Drag a column header to group by that 
column” at the top of the page, this indicates that this page is a EMS Browser page. Several 
data sorting and grouping options are available on an EMS Browser page. You can:

• Group data by columns. See “Grouping data by columns on an EMS Browser page”
below.

• Rearrange columns on the page. See “Rearranging columns on an EMS Browser page”
on page 26.

• Change the width of data columns on the page. See “Changing the width of data columns
on an EMS Browser page” on page 26.

• Change the sort order of the data on the page. See “Changing the sort order of data on an
EMS Browser page” on page 27.

Grouping data by columns on an EMS Browser page

On an EMS Browser page, you can drag a column header to the indicated location and group 
the data by the selected column. 

Figure 1-3:  Grouping data by columns on an EMS Browser page
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Rearranging columns on an EMS Browser page

On an EMS Browser page, you rearrange the column order by dragging a column to a new 
location using the column heading.

Figure 1-4:  Rearranging columns on an EMS Browser page

Changing the width of data columns on an EMS Browser page

For almost all EMS Browser pages, you can change the width the columns on the page. To 
change the width of a column, rest the mouse pointer on the right side of a column heading 
until the pointer changes to a double-headed arrow, and then dragging the boundary until the 
column is the width that you want.

Figure 1-5:  Changing the width of a data column on an EMS Browser page

Changing the width of a data column
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Changing the sort order of data on an EMS Browser page

When an EMS Browser page first opens, data are sorted in ascending order based on the data 
in the first column of the page. For example, when the Groups page first opens, the group 
records are displayed on the Results tab alphabetically by Group name. To change the sort 
order of the data in a browser page, click in a column header to sort the display based on the 
descending order of data in the column. Click the column header again to sort based on the 
ascending order of data in the column.

Figure 1-6:  Changing the sort order of data on an EMS Browser page

Data initially sorted in ascending order based on data in 
the first column of the page.

Click to sort the data that is displayed in descending order.
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The two essential EMS components for meeting and event scheduling are reservations and 
bookings. To use the EMS Web Client efficiently and effectively, you must understand the 
structure of a reservation in EMS, you must understand the concept of an event timeline for a 
reservation booking, and you must know how to make a reservation.

This chapter covers the following topics:

• “Reservation Structure” on page 31.

• “Event Timeline” on page 32.

• “Making a Reservation Using the Reservation Wizard” on page 33.

• “Viewing and Editing Reservations in the Reservation Book” on page 50.



31

 
Reservations and Bookings

Reservation Structure

An event in EMS is comprised of the following:

• A reservation

• One or more bookings

• Booking details

These three components exist in a hierarchy—a reservation contains one or more bookings 
and each booking can have one or more details associated with it. 

Reservation and bookings

A reservation is the who and the what of an event. For example, Group X (the who) can 
reserve some space for an Event Y (the what). A booking is the where and the when of an 
event. For example, Group X can schedule the conference room (the where) for a staff 
meeting on the second Monday in January (the when). Group X now has a single reservation 
with a single booking in EMS. If, however, Group X schedules the conference room (the 
where) for a staff meeting on the second Monday of each month for a calendar year (the 
when), then Group X now has a single reservation with twelve bookings in EMS.

Booking details

A booking can have one or more booking details associated with it. Booking details are the 
resources or services that are needed for an event, the notes for the event, the activities for 
the event, the room charges for the event, or any combination of these. For example, for 
Group X’s staff meeting, the resources could include the requested catering (coffee service, 
bagels and muffins, and so on) and the A/V equipment (a projector, a speaker’s podium, and 
so on).
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Event Timeline

The following time designators are used for an event in EMS:

• Event Time: The time period during which the event actually takes place.

• Setup/Teardown Hours: The hours, or fractions of hours, that you add to the event time
to allow staff to prepare a room for the event or to clean up after the event.

• Reserved Time: The total time for which the space (the where) is reserved. This time is
the event time plus the setup/teardown time.

For example:

Variable Time 

Reserved Start Time 8:00 am

Setup Hours 1 hour

Event Start Time 9:00 am

Event End Time 4:00 pm

Teardown Hours 1.5 hours

Reserved End Time 5:30 pm

Reserved Time 9.5 hours
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Making a Reservation Using the Reservation 

Wizard

You use the Reservation Wizard to check for available space for an event and to make a 
reservation for the event. You can search for rooms that are available for a particular time on 
one day (a simple reservation with one booking) or on multiple days (a series reservation 
with multiple bookings). You can also create a series reservation by selecting one date and 
time, but multiple rooms. To make a reservation using the wizard, you must:

• Specify the event date and time information. See “To specify the event date” on page 34.

• Specify the event time and status. See “To specify the event time and status” on page 37.

• Select the event location. See “To select the event location” on page 38.

• Specify the event information. See “To specify the event information” on page 45.

The following procedure describes how to make a reservation by selecting values 
for the required and optional fields. 

• If your EMS administrator has configured reservation wizard templates, then a
Reservation Wizard Template dropdown list is displayed at the top of the
Reservation Wizard. You can facilitate the making of a reservation in the
Reservation Wizard by selecting the appropriate template from the list, which
automatically sets the default values for many of the fields in the Reservation
Wizard.

• If your job entails making multiple reservations that require the same
information, and you are not using reservation wizard templates, then you can
set your own default values for many of the fields in the Reservation Wizard. See
“Setting User Preferences and Default Values” on page 359.
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To specify the event date

1. On the EMS toolbar, click the Wizard icon .

The Reservation Wizard page opens.

Figure 2-1:  Reservation Wizard page

2. If needed, use the scroll features on the top of the Calendar to open the calendar for a
different month (< or >), or click a month at the top of the calendar to open a dropdown
list from which you can select a different month. You can also click a year at the top of
the calendar to open a dropdown list from which you can select a different year.

3. If the event dates do not follow a pattern, use one or more of the following options for
entering a date; otherwise, go to Step 4.

• Click on the dates on the calendar that the event is to take place.

• To select all five weekdays in a week, click in the blank space that is to the left of the
week.

• To select all seven days in a week, double-click in the blank space that is to the left
of the week.

Figure 2-2:  Example of selecting the days of the week

Click here to select the five weekdays for 
the week of 2/13/2011.

Double-click here to select all seven days 
of the week for the week of 2/13/2011.
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• To select every occurrence of a specific day of the week for the displayed month (for
example, all Sundays in February, 2011), click the heading (S, M, T, and so on) for
the day.

• To select every occurrence of a specific day of the week that is currently displayed
onscreen (regardless if the day falls within the same month), double-click the
heading (S, M, T, and so on) for the day.

4. If the event dates do follow a pattern, (for example, the third Friday of every month),
click Date Pattern to open the Date Pattern dialog box and enter your event date
information.

Figure 2-3:  Date Pattern dialog box

As you specify the event dates, the following occurs:

• The Selected Dates tab is automatically updated with the selected dates.

• If your EMS administrator has configured any of the dates as a holiday or closed,
then holiday dates are displayed in green on the Calendar tab and closed dates are
displayed in red.

For any date, after you select the date on the Calendar tab, you can:

• Toggle between the Calendar tab and the Selected Date tab. Open the Selected Dates
tab, select the date, and then click Go To Date.

• Remove the date from the list of selected dates. Open the Selected Dates tab, select
the date, or CTRL-click to select multiple dates, and then click Remove.

If you need to clear a single selected date, click the date again. To clear multiple 
selected dates in a single step, click Clear Month to clear all currently selected 
dates for the currently displayed month or click Clear All to clear all currently 
selected dates regardless of month or year. 

When you make a reservation for multiple dates, the process is easier if you first 
remove all holidays or closed dates from the list of selected dates; however, be 
very careful when selecting dates for removal as you are not prompted to confirm 
your selection before you click Remove.
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For dates that are configured as a holiday or as closed, you can:

• Place your cursor on a holiday date to open a tooltip that shows the name of the
holiday.

Figure 2-4:  Viewing information about a holiday from the Calendar tab

• View information about the date from the Selected Dates tab. Open the Selected
Dates tab, scroll to the date, and then click Holidays to open a Holidays dialog box
that displays information about the holiday.

Figure 2-5:  Holidays dialog box

• Place your cursor on a closed date to open a message that states that you cannot
select the date because the date is closed.

Figure 2-6:  Viewing information about a closed date from the Calendar tab
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5. Continue to “To specify the event time and status” below.

To specify the event time and status

1. Do one of the following to specify the start time and end time for the event:

• Click the Time Picker icon  to open a dropdown list from which you can select a 

time for each field.

• Manually enter the time in each field.

2. Do one of the following to specify the Setup and Teardown times.

• To use the default setup and teardown times that your EMS administrator has
assigned to the rooms in your system, leave Use Default selected.

• To override the default setup/teardown times, clear Use Default, select Minutes or
Hours, and then enter your own setup and teardown times.

3. Indicate the status for the event.

4. Continue to “To select the event location” on page 38.

When you manually enter the time, you can use a shortcut. For example, for 9:00 
am, you need to enter only “9a” and for 2:00 pm, you need to enter only “2p,” 
and so on. If you enter an end time that is earlier than the start time, then the 
system assumes that the end time is the next day and the phrase “Next Day” is 
displayed to the right of the End time field.

Time zone is discussed in “To select the event location” on page 38.

Remember, setup and teardown times are the hours, or fractions of hours, that you 
add to the event time to allow staff to prepare a room for the event or to clean up 
after the event. For example, for a 30 minute setup time, you can enter 30 minutes 
or 0.5 hours.

Depending on the status that you select, for example, Tentative or Hold, you might 
be required to enter a reconfirm date. You can monitor reservations that must be 
reconfirmed on the Reconfirm Dates tab on the EMS Dashboard. See “EMS 
Dashboard,” on page 207.

Time zone is discussed in “To select the event location” on page 38.
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To select the event location

You have three options for selecting the event location, which are indicated on the first page 
of the Reservation Wizard:

To search for a standard room

1. Select Standard.

2. Leave Building set to the default value of (all), or select a specific building, area, or view
in which to search for a standard room.

3. If applicable, select the appropriate time zone for the event.

Search Method Description

Standard Use this option to display a list of all the available rooms that meet all 

the requested dates. See “To search for a standard room” below.

Best Fit Use this option if no one room can meet all the requested dates. The 

system lists rooms along with the number of bookings for which you can 

reserve the room. You can piece together the entire reservation using 

Best Fit, or just part of it. See “To search for a best fit room” on page 40.

Specific Room Use this option to confirm the availability and reserve of one specific 

room for the scheduled event. See “To search for a specific room” on 

page 43.

By default, the EMS Web Client looks for an available room or rooms in only the 
first 1000 rooms that it finds in the pre-configured Rooms list. To search more than 
1000 rooms, before you begin any search, click Options > Max. Number of Rooms 
to Search, and then select a different number of rooms to search. 

By default, when you search for a standard room, rooms that are available all day 
are marked with an asterisk (*). To set or clear this option, click Options > 
Standard Search > Show Available All Day Indicator.

Your selection on the Building dropdown list determines the options that are 
available on the Time Zone dropdown list. If you select (all) buildings, then you 
can select a time zone. If you select a specific building, then by default, a time zone 
is selected for the building, and you cannot select a different value.
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4. Do one of the following for room specifications:

• Type is the class or category of the room, for example a meeting room, a workspace,
and so on. Leave Type set to the default of (all) to search for all pre-configured room
types or select a specific room type from the Type dropdown list.

• Floor is optional information when you are searching for a room. Leave Floor set to
the default value of (all) to search for all pre-configured floors or select the floor
from the Floor dropdown list.

• Setup Type is the physical layout or arrangement of a room, for example, rounds of 6
or theater-style. Leave Setup Type set to the default value of (all) to search for all
pre-configured setup types or select the setup type from the Setup Type dropdown
list.

• Setup count is the anticipated attendance for the event. If you selected a specific
setup type, then you must enter the setup count.

5. Optionally, open the Features tab, and then select the feature, or CTRL-click to select the
multiple features that the room must have.

6. Click Next.

Up to two tabs are displayed:

• The Available tab, which is the active tab and is always displayed, lists all the rooms
that meet all your event criteria.

• If you have elected to show the Available All Day Indicator, the rooms that are
available all day are marked with an asterisk (*).

• By default, the available rooms are sorted alphabetically by room code. If your
EMS administrator has configured the rooms for your EMS implementation
with a book sequence, then under Options, select Sort Rooms by Book Sequence
to sort the rooms from lowest to highest book sequence. (If two rooms have the
same sequence, then the rooms are sorted alphabetically by name within the
sequence.)

• The Conflicts tab is displayed only if there are rooms that are not available for the
requested dates/times. Optionally, you can open the Conflicts tab to view the list of
rooms that were not available for scheduling as well as list of the events that are
scheduled for each room.

See Figure 2-7 on page 40.

The selected setup type and setup count are applied to all the bookings that you 
add to this reservation. If any of the bookings require a different setup type or 
count, you can change this information after you complete the reservation. See 
“To edit a booking in the Navigator” on page 97 or “Editing Multiple Bookings in 
the Navigator” on page 99.
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Figure 2-7:  Example of standard room search results 

7. Select the room, or CTRL-click to select the multiple rooms that you are scheduling for
the event.

8. Optionally, do one or both of the following; otherwise, go to Step 9.

• Click Room Info to open the Room Info dialog box and view information about the
room properties, setup type, features, and pricing.

• Click Building Hours to open the Building Hours dialog box which displays the
hours that the selected room/building is open on the reserved date.

9. Click the Move button (>) to move the rooms to the Selected list.

10. Click Next to continue to “To specify the event information” on page 45.

To search for a best fit room

1. Select Best Fit.

2. Leave Building set to the default value of (all), or select a specific building, area, or view
in which to search for a standard room.

3. If applicable, select the appropriate time zone for the event.

If the reservation is for a video conferencing meeting, then you must select a 
minimum of two rooms. You must designate one of these rooms as the Host 
Location on the Video Conference tab on the last page of the Reservation Wizard.

If you select more than one room, all the selected rooms are booked for all the 
event dates.
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4. Do one of the following for room specifications:

• Type is the class or category of the room, for example a meeting room, a workspace,
and so on. Leave Type set to the default of (all) to search for all pre-configured room
types or select a specific room type from the Type dropdown list.

• Floor is optional information when you are searching for a room. Leave Floor set to
the default value of (all) to search for all pre-configured floors or select the floor
from the Floor dropdown list.

• Setup Type is the physical layout or arrangement of a room, for example, rounds of 6
or theater-style. Leave Setup Type set to the default value of (all) to search for all
pre-configured setup types or select the setup type from the Setup Type dropdown
list.

• Setup count is the anticipated attendance for the event. If you selected a specific
setup type, then you must enter the setup count.

5. Optionally, open the Features tab, and then select the feature, or CTRL-click to select the
multiple features that the room must have.

Your selection on the Building dropdown list determines the options that are 
available on the Time Zone dropdown list. If you select (all) buildings, then you 
can select a time zone. If you select a specific building, then by default, a time zone 
is selected for the building, and you cannot select a different value.

The selected setup type and setup count are applied to all the bookings that you 
add to this reservation. If any of the bookings require a different setup type or 
count, you can change this information after you complete the reservation. See 
“To edit a booking in the Navigator” on page 97 or “Editing Multiple Bookings in 
the Navigator” on page 99.
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6. Click Next.

Up to two tabs are displayed:

• The Available tab, which is the active tab and is always displayed, has two lists. The
list in the left pane is a list of all the rooms that meet some or all of your event
criteria. The list in the right pane is a list of all the event dates that must be fulfilled.

• The Conflicts tab is displayed only if there are rooms that are not available for the
requested dates. Optionally, you can open the Conflicts tab to view the list of rooms
that were not available for scheduling for the event as well as list of the events that
are scheduled for each room.

Figure 2-8:  Example of best fit room search results

7. Optionally, do one or both of the following; otherwise, go to Step 8.

• Click Room Info to open the Room Info dialog box and view information about the
room properties, setup type, features, and pricing.

• Click Building Hours to open the Building Hours dialog box which displays the
hours that the selected room/building is open on the reserved date.

By default, the available rooms are sorted alphabetically by room code. If your 
EMS administrator has configured the rooms for your EMS implementation with a 
book sequence, then under Options, select Sort Rooms by Book Sequence to sort 
the rooms from lowest to highest book sequence. (If two rooms have the same 
sequence, then the rooms are sorted alphabetically by name within the sequence.)
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8. Do one of the following:

• If one is available, select the single room that is available for all the requested dates,
and then click the Move button (>) to move the room to the Event Dates list.

• If a single room is not available, select a room that is available for some of your
requested dates, and then click the Move button (>) to move the room to the Event
Dates list. Repeat this step as needed to fulfill all the event dates.

9. Click Next to continue to “To specify the event information” on page 45.

To search for a specific room

You can use the specific room search to book a standard EMS room or a room or area that is 
not managed in EMS. An override room, or “override description,” is used to book an event 
in a space that has not been configured in your EMS system. For example, your EMS 
administrator might have configured an override room named “Other Area” in the 
Engineering building. To book an event in Dr. Wilson's office, which is a room that is not 
defined in EMS, in the Engineering building, you can select the “Other Area” room and 
specify “Dr. Wilson's Office” for the location. EMS does not track availability for events 
booked in override rooms; however, EMS reports on events that are scheduled in an override 
room just like any other event scheduled for any other room.

1. Select Specific Room.

The Room Selector dialog box opens. By default, (all) buildings is selected.

Figure 2-9:  Room Selector dialog box
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2. Do one of the following:

• To select a room from a list of all rooms in all available buildings:

• Leave (all) selected on the Buildings dropdown list.

• Click the Add icon  next to a room to select it. 

• If the room is configured as an override room, go to Step 3; otherwise, go to Step
4.

• To select a room from a list of rooms in a specific building, area, or view:

• Select a specific building, area, or view.

• Click the Add icon  next to a room to select it. 

• If the room is configured as an override room, go to Step 3; otherwise, go to Step
4.

3. In the Location field, enter the location of the override room, and then click Next to
continue to “To specify the event information” on page 45.

4. Click Next.

Two results are possible:

• If the event is scheduled for a single date and the room is available, then continue to
“To specify the event information” on page 45.

• In all other cases, (for example, the event is scheduled for a single date but the room
is not available or it is a multiple date event), the Available tab opens. This tab lists
all the event dates for which the specific room is available. Continue to Step 5.

5. Optionally, before you move a date to the Selected list, click Building Hours to open the
Building Hours dialog box which displays the hours that the selected room/building is
open on the selected date; otherwise, do one of the following:

6. Optionally, before you move a date to the Selected list, do one or both of the following;
otherwise, go to Step 7.

• Click Room Info to open the Room Info dialog box and view information about the
room properties, setup type, features, and pricing.

• Click Building Hours to open the Building Hours dialog box which displays the
hours that the selected room/building is open on the reserved date.

You can open the Conflicts tab to view the list of dates for which the specific room 
is not available as well as list of the events that are scheduled for the room.
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7. Do one of the following:

• If the specific room is available for all the event dates, then click the Move All
button (>>) to schedule the room for all the event dates.

• If the specific room is not available, try another approach such as reserving a
different specific room, or using the Standard or Best Fit search method.

8. Click Next to continue to continue to “To specify the event information” below.

To specify the event information

After you select an event location or locations, you must specify other information for the 
event. 

Figure 2-10: Event Information page

1. Enter the event information.

Field Description

Event

Event Name A name or description for the event.

Event Type The classification for the event.

VIP Select this option to mark the event as a Very Important event.

Source The reservation source.

Video Conference Select this option for a video conference event.
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Group/Contact

Group
Click the Search icon  to open a Lookup dialog box in which you search 

for and select a specific group from a list all groups that are available in your 

system for hosting/sponsoring an event.

• To search a list of all groups, leave the Find field in the Lookup dialog box

blank, and then click the Search icon .

• To search for a specific group, enter a search string in the Find field, and

then click Search icon . Your search is limited to the exact order of the 

characters in the string, but the string can appear anywhere in the search 

results and it is not case-sensitive. For example, the search string sim 

returns Paske, Simon and Simington, Chance.

• To select a group, click the Add icon  next to the group.

• If the group that you want to select for the reservation is not available on the

pre-configured list, then you can click the Group icon  to open the

Group dialog box and add the group. See “Searching for and Configuring

Groups” on page 231.

Note: After you select a group, you can click Group Info at the bottom of the 

Reservation Wizard page to open a <Group> dialog box that displays 

the properties for the group, any user-defined fields for the group, and 

any comments that are associated with the group.

1st Contact

Temp Contact

When you select a group, if a default contact has been defined for the group, 

then this field is automatically populated with the name of the contact; 

otherwise, the field is blank. You have several options for defining the 1st 

Contact for a reservation:

• If the field is blank, but contacts have been configured for the group, you

can select a contact from the pre-configured list.

• If the field is populated with a default value, but other contacts have been

configured for the group, you can select a different contact from the

pre-configured list.

• If you want to create a temporary contact just for this event, then select

(temporary contact), and in the Temp Contact field, enter the name for the

temporary contact.

Note: If a default contact has been configured for the group, then any 

modifications that you make for the contact apply to this reservation 

only. The next time you or anyone else creates a reservation for this 

group, the 1st Contact field is again automatically populated with the 

name of the default contact.

2nd Contact

Temp Contact

Define if necessary for the event. 

Field Description
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Phone

Fax

Email Address

One more of these fields might be automatically populated depending on how 

a selected contact has been configured. You can manually edit these values if 

needed. 

Note: The Phone and Fax fields have a dropdown list available on which you 

can select a different value (Fax, Mobile, Other, Phone) for the field 

label, or you can enter a user-defined value. To enter a user-defined 

value, double-click the current field label to select it, and then enter the 

user-defined value over the selected label. 

Note: If default values have been configured for a selected contact, then any 

modifications that you make apply to this reservation only. The next 

time you or anyone else creates a reservation for the same contact, 

these fields are again automatically populated with the default 

information.

Room Setup tab

Setup Type If you selected a specific value for the setup type when searching for an event 

location, this value is carried forward to this field; otherwise, the field is blank. 

You can select a setup type for this field, or if the field is already populated, 

you can select a different setup type.

Setup Count If you entered a specific value for the setup type when searching for an event 

location, this value is carried forward to this field; otherwise, the field is blank. 

You can enter a value in this field, or if the field is populated, modify the value.

Billing tab

Note: Depending on the group that you select, one or more of these fields might be automatically 

populated with default values. You can edit these default values but any modifications that 

you make apply to this reservation only. The next time you or anyone else creates a 

reservation for the same group, these fields are again automatically populated with the 

default billing information.

Pricing Plan Indicates what type of pricing is to be used for the event.

Billing Reference The internal alphanumeric billing code that is associated with the group. You 

can manually enter a value in this field, or if a master list of billing reference 

numbers has been configured for the group, you can click the Search icon 

 to open a Billing Reference Numbers dialog box, and select the 

appropriate value from this list. 

Note: To search for a specific billing reference number, enter a search string 

in the Find field, and then click the Search icon . The string is not 

case-sensitive, but your search is limited to the exact order of 

characters in the string and it must begin with the information for which 

you are searching. For example, a string of co returns CO-123, but not 

123-CO.

Sales Category How the group is sorted for purposes of tracking sales figures, for example, 

local, regional, national, and so on.

Payment Type Indicates how the group paid for the event (cash, check, charged, and so on).

Field Description
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PO Number The internal alphanumeric purchase order number that is associated with the 

group. You can manually enter a value in this field, or if a master list of 

purchase order numbers has been configured for the group, you can click the 

Search icon  to open a Purchase Order Numbers dialog box, and select 

the appropriate value from this list. 

Note: To search for a specific purchase number, enter a search string in the 

Find field, and then click the Search icon . The string is not case-

sensitive, but your search is limited to the exact order of characters in 

the string and it must begin with the information for which you are 

searching. For example, a string of co returns CO-123, but not 123-

CO.

Salesperson The user who “sold” the event to the group.

Other tab

Event Coordinator The Event Coordinator who is assigned to the event.

Estimated Event 

Attendance

The estimated number of people who are expected to attend the event.

Calendar Style Dropdown list of all the available formats for printing this event on the Event 

Calendar and Event Schedule reports. 

URL The event URL.

Virtual tab

Web User To specify the web users who can view/manage this reservation in VEMS, 

click the Search icon  to open the Web Users search dialog box and 

search from a list of registered web users. 

• You can search by User Name or Email Address.

• To search a list of all available web users, leave the Find field in the Lookup

dialog box blank, and then click the Search icon .

• To search for a specific web user, enter a search string in the Find field, and

then click Search icon . 

Note: The string is not case-sensitive, but your search is limited to the exact 

order of characters in the string and it must begin with the information 

for which you are searching. For example, if searching by Email 

Address, a search string of bb returns bbosworth@emssoftware.com 

but not dbobbett@emssoftware.com.

• To select a web user, click the Add icon  next to the user.

Note: To return this field to the (no change) value at any time, click Reset.

Web Process 

Template

The web process template that defines the functions that are available for the 

selected web user.

Note: A web user might be assigned to more than one web process 

template, so make sure to select the template that is applicable for this 

reservation.

Field Description
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2. Click Finish.

Two results are possible:

• If you did not enter information into required fields, then these fields are outlined in
red. You must enter values into these fields and then click Finish again to open the
Navigator page.

• The Navigator opens.

The reservation information is displayed in the Navigator. You use the Navigator to add 
booking details and to make any needed modifications to the reservation and its 
bookings. See “The Navigator,” on page 65.

User Defined Fields tab

User-defined fields are additional fields that store custom data for a 

reservation. Your EMS administrator configures the types of fields that are 

available as well as the allowed values for these fields. 

• To enter or modify a value for a field, select the field, and then click Set

Value.

• To clear a value for a field, select the field, and then click Clear Value.

Note: If a user-defined field is not required here, you can always supply a

value for it at a later date in the Navigator. See “Working with User 

Defined Fields in the Navigator” on page 167.

A reservation is not complete and rooms are not removed from the Available list 
until you click Finish. Although unlikely, it is possible for another user to select 
and reserve a room during the time period after you have selected the room but 
before you have finalized the reservation. If this occurs, after you click Finish, a 
message opens stating that your reservation conflicts with an existing reservation.

Depending on how your EMS administrator has configured your system, user 
defined questions (UDFs), comments, and/or reminders might be automatically 
displayed for the reservation in the Navigator. Contact your EMS administrator if 
you have any questions about this. 

Field Description
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Viewing and Editing Reservations in the 

Reservation Book

The Reservation Book provides a graphical view of all the confirmed reservations (the 
reserved time as well as the room for which the reservation is scheduled) for your 
organization. (Cancelled bookings are not shown.) You use the Reservation Book to the view 
information for a reservation, to edit an existing reservation, and to make a new reservation. 
In addition, when the Reservation Book first opens, before you edit or make a reservation, 
you can change the Reservation Book view so that it better suits your working needs.

Reservation Book

To open the Reservation Book, on the toolbar, click the Book icon . The first time 
that you open the Reservation Book for your EMS implementation, by default, the Filter 
dialog box opens on top of a blank Reservation Book. You can leave the room filtering 
criteria set to their default values, or you can select different values as needed, and then click 
OK. All reservations that meet the filtering criteria and that are scheduled for the current 
day’s date are displayed in the book in the Daily view. 

The Reservation Book has the following appearance:

• Minimum and maximum capacities are displayed next to room descriptions.

• The current time is shown by a vertical line in the grid, called the Current Time Indicator.

• If building hours have been configured for a building, then this information is displayed
for the building.

• The reservations are displayed with three components:

• A left bar that indicates the setup time.

• A middle bar that indicates, by default, the event name.

• A right bar that indicates the teardown time.

See Figure 2-11 on page 51.

You might need to use the book’s scroll features to scroll through all the 
reservations that are scheduled for the current day’s date.
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Figure 2-11: Reservation Book

If an event is scheduled for a room that is a component of a combination room, then the 
reservation text is displayed in black. A duplicate reservation is also shown for the 
combination room; however, the reservation text is displayed in gray to indicate that a 
component of the combination room is currently booked for the indicated time and therefore, 
the combination room is not available. 

Figure 2-12: Components booked and combination room unavailable

Conversely, if an event is scheduled for a combination room, then the reservation text for the 
combination room is displayed in black and the reservation text for each component is 
displayed in gray. This reversed color coding indicates that the component room is currently 
booked for the selected time and that none of the components is available.

Figure 2-13: Combination room booked and components unavailable
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You can carry out the following actions in the Reservation Book:

• Change the Reservation Book view. See “To change the Reservation Book display” on
page 52.

• View reservation information. See “To view reservation information” on page 58.

• Make a new reservation. See “To make a new reservation” on page 62.

• Edit an existing reservation. See “To edit an existing reservation” on page 63.

To change the Reservation Book display

1. On the EMS Web Client toolbar, click the Book icon .

The Reservation Book opens in the Daily view. See Figure 2-11 on page 51.

2. Optionally, you can do one or more of the following to change the Reservation Book
display:

• Change the list of rooms that are displayed in the Reservation Book based on room
properties. See “List of Rooms (Room Properties)” on page 53.

• Change the list of rooms that are displayed in the Reservation Book based on a
specific room or rooms. See “List of Rooms (Specific Rooms)” on page 54.

• Change the Reservation Book view. See “Reservation Book view” on page 54.

• Change multiple display options for a reservation. See “Display Options” on page
55.

• Select which items to include in the tooltip that opens when you place the cursor over
an event in the Reservation Book. See “Tooltips” on page 57.

• Change the display date using the calendar. See “Display Date (Calendar)” on page
57.

• Change the display date using the Reservation Book scroll features. See “Display
Date (Scroll Features)” on page 58.
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List of Rooms (Room Properties)

If the Filter dialog box is not already open, then above the Rooms list, do the following:

1. Click Filter.

The Filter dialog box opens.

Figure 2-14: Filter dialog box, Room Properties selected

2. Select Room Properties, and then do one or more of the following

• Leave the Building dropdown list set to the default value of (all) buildings, or select
a specific building, area, or view.

• Select a specific floor.

• Select a specific room type.

• Select Capacity and then enter a capacity.

• Select Academic to limit the search to academic rooms.

• Select a Room Availability option.

3. Click OK.

The Filter Rooms dialog box closes. The room display in the Reservation Book is
changed accordingly.

After you carry out a search, you can click Reset at the top of the Rooms list to 
reset all room filtering criteria (Filter Type, Room Type, and Room Availability) to 
their default values,
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List of Rooms (Specific Rooms)

If the Filter Rooms dialog box is not already open, then above the Rooms list, click Filter to 
open the dialog box and select Specific Room. Select the room, or CTRL-click to select 
multiple rooms on the Available list, and then click the Move (>) button to move the selected 
rooms to the Selected list. The Reservation Book is updated to show bookings only for the 
selected rooms.

Figure 2-15: Filter Rooms dialog box, Specific Room selected

Reservation Book view

On the View dropdown list, select Daily, Weekly, or Monthly.

Figure 2-16: View dropdown list

Although you can view currently scheduled reservations in either the daily, weekly, 
or monthly view, you can make a new reservation only in the daily view.
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Display Options

Click Options (upper right hand corner of Reservation Book) to open the Book Options 
dialog box (the General tab is the active tab) and change multiple display options not only 
for the Reservation Book, but also a reservation in the book.

Figure 2-17: Book Options dialog box, General tab

Option Description

Start Hour The daily start time for the Reservation Book display.

Display The information that is displayed in the middle bar for a reservation.

Time Display Interval Changes the granularity of the time display interval.

Maximum No. of Rooms The maximum number of rooms to display in the Reservation Book.

Booking Colors Based 

On

The color of the bookings in the reservation. Select one: Status, Event 

Type, or Check-in Status (for EMS Workplace only.)

Rooms Without 

Bookings

Whether to highlight rooms without bookings and if so, the highlight 

color. If both Highlight Rooms and Booked Space Status Only are 

selected, then only those rooms that do not have a Booked Space 

status are highlighted.

Room Display Display the room code or the room name for a reservation.

Building Display Display the building code or the building name for a reservation.

Go To Today on Startup If selected, the Reservation Book opens to the current day’s date; 

otherwise, it opens to the last date viewed.
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Always Prompt for 

Room Filter on Startup

If Show ‘(all)’ in Building List is also selected, then when you open the 

Reservation Book, the Filter dialog box opens on top of the Reservation 

Book. You can select different options on this dialog box to display only 

specific reservations in the book, for example, bookings only for 

selected rooms. If you do not select any options on this dialog box, but 

instead simply close it, then all reservations for all rooms in all buildings 

are displayed in the book.

Hide Current Time 

Indicator

Show or hide the vertical bar that indicates the current time for current 

day.

Note: The Current Time indicator is displayed only if the view is the 

Daily or Weekly view and the view includes the current day’s 

date.

Show ‘(all)’ in Building 

LIst

Show the “all” option on the Building dropdown list; otherwise, a user 

must select a specific building. If this option is selected in conjunction 

with Always Prompt for Room Filter on Startup, then when you open the 

Reservation Book, then the Filter dialog box always opens on top of the 

Reservation Book. If you are setting your Reservation Book options, and 

you do not want to the Filter dialog box to open on top of the 

Reservation Book when you open the book, then do the following:

• Clear Always Prompt for Room Filter on Startup.

• Clear Show (‘all’) in Building List.

• On the Building dropdown list in the Reservation Book, select any

building, area, or view.

Note: The building, area, or view that you select is not important. This 

last step just clears the “all” building option from the Reservation 

Book cache and ensures that the Filter dialog box does not open 

on top of the Reservation Book. Going forward, you can always 

select all buildings, or any specific building, area, or view as 

needed when you are working in the Reservation Book.

Show Capacity Show the minimum and maximum capacities next to the room 

description.

Hide Booking Shadow Hide the vertical shadow bar that highlights the reserved and/or event 

start times and end times when a user moves a booking in the 

Reservation Book.

Option Description
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Tooltips

Click Options (upper right hand corner of Reservation Book) to open the Book Options 
dialog box, and then open the Tooltip Display tab and select which items to include in the 
tooltip that opens when you rest the mouse pointer on an event in the Reservation Book.

Figure 2-18: Book Options dialog box, Tooltip Display tab

Display Date (Calendar)

On the Date field, click the dropdown arrow to open the Calendar. Use the (< and >) scroll 
features at the top of the calendar to change the month or use the (<< or >>) scroll features at 
the top of the calendar to change the year. To select a different date for a month, click the 
date.

Figure 2-19: Reservation Book calendar
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Display Date (Scroll Features)

Use the scroll features at the top of the reservation book display to scroll to a different day, 
week, month, or any different combination of these. To reset the display immediately to the 
current day’s date, click Today.

Figure 2-20: Reservation Book calendar scroll features

To view reservation information

1. On the EMS toolbar, click the Book icon .

The Reservation Book opens in the Daily view. See Figure 2-11 on page 51.

2. Optionally, you can do one or more of the following to view the reservation information:

• View the reservation in the Navigator by doing one of the following:

• Double-click the middle bar for the reservation entry.

• Right-click the reservation entry and on the context menu that opens, click
Open.

See  “The Navigator,” on page 65.

• View the bookings for a room. See “Room Bookings” on page 59.

• View the properties for a room. See “Room Properties” on page 60.

• View the pricing for a booked room. See “Room Pricing” on page 61.

• View the setup information, event information, or teardown information for a
reservation. See “Room Information” on page 61.

• Change the time zone in which to view all your bookings. See “Time Zone” on page
62.

Optionally, when the Reservation Book first opens, before you view, edit or make a 
reservation, you can change the Reservation Book view so that it better suits your 
working needs. See “To change the Reservation Book display” on page 52.
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Room Bookings

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info 
dialog box. The tab on this dialog box lists all the bookings for the selected room based on 
the current view (Daily, Weekly, Monthly) and on the date that is shown in the Date field. To 
view a booking in the Navigator, select the booking, and then click Open.

Figure 2-21: Room Info dialog box, Bookings tab
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Room Properties

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info 
dialog box, and then open the Room tab. The tab on this dialog box lists all the properties for 
the room, such as the room code, the room name, the room classification, and so on. It also 
lists the setup type and capacity for the room, and any notes that have been entered for the 
room.

Figure 2-22: Room Info dialog box, Room tab
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Room Pricing

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info 
dialog box, and then open the Pricing tab. This tab displays any pricing information that was 
defined for the room.

Figure 2-23: Room Info dialog box, Pricing tab

Room Information

Rest the mouse pointer on the left bar, middle bar, or right bar for the reservation entry. A 
tooltip showing the respective setup, event, or teardown information opens.

Figure 2-24: Viewing event information
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Time Zone

If buildings that are located in multiple time zones are currently displayed, you can specify 
the time zone in which to view all of your bookings.

Figure 2-25: Changing the time zone

To make a new reservation

1. On the EMS toolbar, click the Book icon .

The Reservation Book opens in the Daily view. See Figure 2-11 on page 51.

2. Change the display to show the room for which you are making the reservation.

3. Select the date for which you are making the reservation.

4. In the Time Grid for the room, click and hold the left mouse button, drag the mouse to
schedule the room and time, and then release the mouse button to open the Reservation
Wizard.

Figure 2-26: Making a new reservation in the Reservation Book

5. Continue to “Making a Reservation Using the Reservation Wizard” on page 33.

You must leave the Date view in the Daily display.

As you drag the mouse, a blue horizontal bar is displayed. 
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To edit an existing reservation

1. On the EMS toolbar, click the Book icon .

The Reservation Book opens in the Daily view. See Figure 2-11 on page 51.

2. Optionally, you can do one or more of the following to edit an existing reservation:

3. Optionally, you can right-click on a reservation in the Reservation Book, and on the
context menu that opens, select one of the following:

Optionally, when the Reservation Book first opens, before you view, edit or make a 
reservation, you can change the Reservation Book view so that it better suits your 
working needs. See “To change the Reservation Book display” on page 52.

Step Action

Change the setup time for a 

reservation

• Drag the left bar horizontally to a new time.

• Click Yes in the Confirm Change dialog box.

Change the event time • Drag the middle bar horizontally to a new time.

• Click Yes in the Confirm Change dialog box.

Change the teardown time for a 

reservation

• Drag the right bar horizontally to a new time.

• Click Yes in the Confirm Change dialog box.

Edit the reservation building, room, 

time, or both

• Drag and drop the reservation to a new room that is the

same building or in a different building, and/or to a new

time.

• Click Yes in the Confirm Change dialog box.

Option Description

Open Opens a reservation in the EMS Navigator.

Move Forward Move the reservation date forward by one day or one week. 

Move Backward Move the reservation date backward by one day or one week. 

Move to Specific Date Move the reservation to a specific date. 

Change Status Change the status of the reservation. 

Copy Bookings N/A.

Note: Although this option is available on the context menu 

for a reservation, its associated functionality is 

currently under development.

Swap Rooms with Another 

Booking

Swap the room assignments of two events. The swap option 

is applicable only for two events that have identical meeting 

patterns.

Highlight Related Reservations Highlights the bookings that belong to the same reservation.
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The Navigator is a page in EMS that you use to view and manage all aspects of a reservation 
including bookings and booking details. 

This chapter covers the following topics:

• “Navigator Overview” on page 67.

• “Adding Bookings to a Reservation in the Navigator” on page 85.

• “Editing a Reservation in the Navigator” on page 86.

• “Repricing Categories and Room Charges for a Reservation” on page 88.

• “Changing the Status for a Reservation from the Reservation Summary tab” on page 90.

• “Copying a Reservation in the Navigator” on page 93.

• “Editing a Booking in the Navigator” on page 96.

• “Editing Multiple Bookings in the Navigator” on page 99.

• “Moving Bookings to a Different Reservation” on page 114.

• “Copying Multiple Bookings in the Navigator” on page 116.

• “Booking Details and Items Overview” on page 120.

• “Adding Booking Details and Items to Individual Bookings” on page 125.

• “Adding Booking Details and Items to Multiple Bookings” on page 134.

• “Adding Booking Detail Items to Multiple Bookings” on page 141.

• “Editing Booking Detail Items for Individual Bookings” on page 143.

• “Editing Booking Detail Item Charges for Multiple Items” on page 147.

• “Editing Count Information for a Booking” on page 149.

• “Applying a Reservation Discount” on page 151.

• “Copying Booking Details between Bookings” on page 153.

• “Deleting Booking Detail Items from Multiple Bookings” on page 156.

• “Deleting Booking Details from Multiple Bookings” on page 159.

• “Working with Comments and Reminders in the Navigator” on page 161.

• “Adding Multiple Comments and Reminders to a Reservation” on page 165.



66

  The 

Navigator

• “Working with User Defined Fields in the Navigator” on page 167.

• “Working with Attachments in the Navigator” on page 170.

• “Running the Resource Utility Conflicts Tool” on page 176.



67

  The 

Navigator

Navigator Overview

This section provides an overview of opening a reservation the Navigator, the Navigator’s 
folder structure, and the commands that are available in the Navigator.

Opening a reservation in the Navigator

After you create a new reservation using the Reservation Wizard, the reservation opens 
automatically in the Navigator. You can also manually open the Navigator by:

• Selecting a reservation, booking, or service order to open directly in the Navigator. See
“Opening a reservation directly in the Navigator” below.

• Opening a reservation through the Reservation Book. See “Opening a reservation through
the Reservation Book” on page 68.

• Opening a reservation through a group. See “Opening a reservation through a group” on
page 68.

• Opening a reservation through a search. See “Opening a reservation through a search” on
page 68.

Opening a reservation directly in the Navigator

1. On the EMS toolbar, click the Navigator icon  to open the Open Navigator 

dialog box.

Figure 3-1:  Open Navigator dialog box

2. On the Open dropdown list, select the item that you are opening—Reservation, Booking,
or Service Order.
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3. Do one of the following:

• In the No. field, enter the number for the reservation, service order, or booking, and
then click OK.

• To enter the last reservation, booking, or service order, that you made during your
current or last EMS session, double-click in the field, and then click OK.

Opening a reservation through the Reservation Book

On the EMS Web Client toolbar, click the Book icon  to open the Reservation Book, 
and then in the Reservation Book, double-click a booking for the reservation to open the 
reservation in the Navigator. See “Viewing and Editing Reservations in the Reservation 
Book” on page 50.

Opening a reservation through a group

You can search for a reservation for a group and open the reservation in the Navigator from 
the group-specific page. See “Working with Reservations for a Group” below.

Opening a reservation through a search

You can search for a reservation using the Browser, the Web Reservation Tool, and/or the 
Calendar, and then double-clicking the search result entry to open the reservation in the 
Navigator. See “Search Tools,” on page 177.

If you do not know the reservation number, you can search for the reservation. On 
the Navigator, click Browse to open the Browser, and then continue to “Searching 
with the Browser or with the Web Reservation Tool” on page 179.

You can also click Browse on the Open Navigator dialog box to open the Browser 
search tool.
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Folder structure

The Navigator has three panes—a left pane, a top right pane, and a bottom left pane. The left 
pane displays a selected reservation, all the bookings for the reservation, and the details for 
each booking in a Windows Explorer-style folder structure. The top-level folder is the to 
reservation folder. The folders that are located beneath a reservation folder are the booking 
folders. The folders that are located beneath a booking folder are the booking detail folders. 
The top right pane of the Navigator displays different tabs and options depending on the 
folder or item that is selected in the left pane of the Navigator. The bottom right pane of the 
Navigator displays different information and options depending on the folder or item that is 
selected in the left pane.

Figure 3-2:  Navigator page with a reservation folder selected

Reservation folder

A reservation folder contains the who and the what information for the reservation. When 
you select a reservation folder in the left pane of the Navigator, the reservation number is 
displayed in the title bar of the Navigator, and the following tabs are displayed in the upper 
right pane of the Navigator:

• Reservation Summary tab—The Reservation Summary displays information about the
selected reservation, including the event name, the group for which the reservation was
made, the group contact name, the group contact phone number, and the reservation
number.

• Properties tab—The Properties tab displays not only the same information as the
Reservation Summary tab, but also, information such as the event type, the second group
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contact, the date that the reservation was added, the date that the reservation was changed, 
and so on. 

• Billing Reference Allocation tab—By default, the charge for a reservation can be
allocated to a single billing reference number. On the Billing Reference Allocation tab,
you can allocate the charge for a reservation to multiple billing reference numbers by
percentage. See “To allocate charges to multiple billing reference numbers and/or PO
numbers” on page 71.

• PO Number Allocation tab—By default, the charge for a reservation can be allocated to
a single purchase order (PO) number. On the PO Number Allocation tab, you can allocate
the charge for a reservation to multiple billing PO numbers by percentage. See “To
allocate charges to multiple billing reference numbers and/or PO numbers” on page 71.

• Reminders tab—The Reminders tab displays any reminders that were created for the 
selected reservation. See “Working with Comments and Reminders in the Navigator” on 
page 161.

• Comments—The Comments tab displays any text entries that were made for the selected 
reservation. See “Working with Comments and Reminders in the Navigator” on page 161.

• Attachments tab—The Attachments tab displays any attachments (files) that have been 
saved with the reservation. See “Working with Attachments in the Navigator” on page 
170.

• User Defined Fields—The User Defined Fields tab displays the additional fields that store 
custom data for a reservation. Your EMS Administrator configures the types of fields that 
are available as well as the allowed values for these fields. See “Working with User 
Defined Fields in the Navigator” on page 167.

• Transactions—The Transactions tab displays any invoices that were generated for the 
selected reservation or any payments that were applied to the selected reservation. See   
“Billing,” on page 319 for detailed information about invoices and other financial 
transactions in EMS Web Client.

• History tab—The History tab displays the history for the reservation—the date that a 
change was made to the reservation, the ID of the user who made the change, the field that 
was changed, the old field value, and the new field value.

• Emails tab—The Emails tab displays any summarizing information for any emails that 
were sent to the group for whom the reservation was made.

Your EMS administrator must enable the Use Billing Reference Allocation 
parameter for this tab to be displayed. See EMS System Parameters in the EMS 
Setup Guide.

Your EMS administrator must enable the Use PO Number Allocation parameter 
for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.
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The bookings for the selected reservation are displayed in the Bookings pane (the lower right 
pane) of the Navigator. The colored rectangle to the left of a booking indicates the booking’s 
status. If a booking has been canceled, a Canceled icon  is displayed on the booking 
folder in both the Reservation (left) pane and the Bookings pane.

To allocate charges to multiple billing reference numbers and/or PO numbers

1. For a selected reservation, open the Billing Reference Allocation tab, and then click
Edit.

The Billing Reference Allocation dialog box opens. By default, when this dialog box
first opens, it displays the charge for the reservation allocated 100% to a single billing
reference number placeholder.

Figure 3-3:  Billing Reference Allocation dialog box

2. Select the billing reference number placeholder, and then click Edit.

The Split Billing Add dialog box opens.

Figure 3-4:  Split Billing Add dialog box

The following procedure details how to allocate a reservation charge to multiple 
billing reference numbers; however, by analogy, you can follow this procedure to 
allocate booking charges or booking detail charges to multiple billing reference 
numbers and/or PO numbers.
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3. Do one of the following:

• Enter the billing reference number to which you are allocating the reservation
charges, and then click OK.

The Billing Reference dialog box closes. You return to the Billing Reference
Allocation dialog box with the newly added billing reference number allocated at
100%. Continue to Step 5.

• Click the Search icon  to open a Lookup dialog box, and then do one of the 

following:

• To search a list of all pre-configured billing reference numbers, leave the Find
field in the Lookup dialog box blank, and then click the Search icon. Click the

Add icon  next to the appropriate billing reference number to close the
Lookup dialog box and return to the Billing Reference dialog box. The Billing
Reference dialog box displays the selected billing reference number. Continue to
Step 4.

• To search for a specific billing reference number, enter a search string in the

Find field, and then click the Search icon. Click the Add icon  next to the
appropriate billing reference number to close the Lookup dialog box and return
to the Billing Reference dialog box. The Billing Reference dialog box displays
the selected billing reference number. Continue to Step 4.

4. Click OK.

The Billing Reference dialog box closes. You return to the Billing Reference Allocation
dialog box with the newly added billing reference number allocated at 100%.

5. Do one of the following:

• To allocate the reservation charges to only this single billing number, click OK.

The Billing Reference Allocation dialog box closes and you return to the Navigator.
The newly added billing reference number, allocated at 100%, is displayed on the
Billing Reference Allocation tab.

• To allocate the reservation charges to multiple billing reference numbers, continue to
Step 6.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, the search string 11 returns 117-3C, but not 3C-117. 
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6. Click New.

The Split Billing Add dialog box opens.

Figure 3-5:  Split Billing Add dialog box

7. Do one of the following:

• In the Billing Reference field, enter a billing reference number.

• Click the Search icon  to open a Lookup dialog box in which you can search for 

and select a billing reference number from a list of pre-configured numbers. 

• To search a list of all pre-configured billing reference numbers, leave the Find
field in the Lookup dialog box blank, and then click the Search icon. Click the

Add icon  next to the appropriate billing reference number to close the
Lookup dialog box and return to the Billing Reference dialog box. The Billing
Reference dialog box displays the selected billing reference number.

• To search for a specific billing reference number, enter a search string in the

Find field, and then click the Search icon. Click the Add icon  next to the
appropriate billing reference number to close the Lookup dialog box and return
to the Billing Reference dialog box. The Billing Reference dialog box displays
the selected billing reference number.

8. Click OK.

The Billing Reference dialog box closes. You return to the Billing Reference Allocation
tab with the newly added billing reference number displayed with a 0% allocation.

9. Repeat Step 6 through Step 8 until you have added all the needed billing reference
numbers.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, the search string 11 returns 117-3C, but not 3C-117. 
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10. For each new billing reference number, do the following:

• Double-click to select it.

• Change the percentage to the appropriate value.

• Click Update.

Figure 3-6:  Changing the percentage allocation for a billing reference number

11. Click OK to close the Billing Reference Allocation dialog box and return to the Billing
Reference Allocation tab.

All the billing reference numbers and their percent allocations are displayed on the tab.

Booking folder

Booking folders contain the where and when information for the reservation. If you can 
expand a booking folder, this indicates that details have been added to the booking. The 
booking details for the selected booking are displayed in the Booking Details pane (the lower 
right pane) of the Navigator. A green background for a booking detail folder indicates that 
one or more booking detail items have been invoiced for the booking.

Figure 3-7:  Navigator page with a booking folder selected

The percentages must add up to 100%.
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With a booking folder selected in the left pane of the Navigator, the following tabs are 
displayed in the upper right pane of the Navigator:

• Booking Summary tab—The Booking Summary displays information about the selected
booking, including the event date, the reserved time, the event time, and so on.

• Properties tab—The Properties tab displays not only the same information as the Booking
Summary tab, but also, information such as the event type, the setup count, the date that
the booking was added, the date that the booking was changed, and so on.

• Billing Reference Allocation tab—By default, the charge for a booking can be allocated
to a single billing reference number. On the Billing Reference Allocation tab, you can
allocate the charge for a booking to multiple billing reference numbers by percentage. See
“To allocate charges to multiple billing reference numbers and/or PO numbers” on page
71.

• PO Number Allocation tab—By default, the charge for a booking can be allocated to a
single purchase order (PO) number. On the PO Number Allocation tab, you can allocate
the charge for a reservation to multiple billing PO numbers by percentage. See “To
allocate charges to multiple billing reference numbers and/or PO numbers” on page 71.

• Reminders tab—The Reminders tab displays any reminders that were created for the
selected booking. See “Working with Comments and Reminders in the Navigator” on
page 161.

• Comments—The Comments tab displays any comments that were made for the selected
booking. See “Working with Comments and Reminders in the Navigator” on page 161.

• Attachments—The Attachments tab displays any attachments that were saved with the
booking. See “Working with Attachments in the Navigator” on page 170.

• History—The History tab displays a list of changes made for the selected booking—the
date the change was made to the booking, the user who made the change to the booking,
and information (field) that was changed for the booking.

Your EMS administrator must enable the Use Billing Reference Allocation 
parameter for this tab to be displayed. See EMS System Parameters in the EMS 
Setup Guide.

Your EMS administrator must enable the Use PO Number Allocation parameter 
for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.
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Booking Detail folder

If you can expand a booking folder, this indicates that details have been added to the 
booking. Booking details, which are also called categories, are the services (catering, A/V 
equipment, and so on), notes, attendees, activities, and room charges that you can assign to a 
booking. 

Figure 3-8:  Navigator page with a booking detail folder selected

Booking Detail folders are discussed in “Booking Details and Items Overview” on 
page 120.
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Navigator commands

The Navigator has one constant command in the upper left hand corner—View Alerts and 
three constant commands in the upper right hand corner—Print and Settings.

All other navigator commands are available as buttons in the upper right pane and lower 
right pane of the Navigator. 

Command Description

View Alerts Open and view any alerts that have been generated for the selected 

reservation, booking, or a booking detail that is a service order or 

catering category.

Print • Printing an invoice or a confirmation at the reservation level. See  
“Confirmations,” on page 279.

• Printing the Setup Worksheet for Reservation report, the Service 
Orders report, and the Banquet Event Order report, See  “Reports,” 

on page 289.

• Printing the Transaction report. See “Generating an EMS Billing 
Report” on page 350.

• Printing the history of a reservation, all its bookings, and all its 
booking detail items.

Refresh For refreshing the Navigator display based on the settings that you have 

specified in the Navigator Options dialog box. See “Navigator Options 

dialog box” on page 78.

Settings • Options—Opens the Navigator Options dialog box in which you can 
specify such things as what is to be displayed in the Navigator, 
mouse actions in the Navigator, and so on. See “Navigator Options 
dialog box” on page 78.

• Confirmation Settings—Opens the Confirmation Settings dialog box 
which provides a variety of options that you can specify for manual 
and automatic generation of a confirmation for a reservation or a 
booking. See “Confirmations,” on page 279.
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Navigator Options dialog box

The Navigator Options dialog box has three tabs—General, At A Glance, and Highlight 
Categories.

General tab

General tab—On the General tab, you select the options for such things as which types of 
bookings to show in the Navigator (old bookings and/or canceled bookings), the result of 
double-clicking a listed folder (opens the item or expands the folder), the booking time that 
is displayed (reserved time or event time), and the highlight color for invoiced items.

Figure 3-9:  Navigator Options dialog box, General tab

Field Description

General

Show Old Bookings Show bookings in the Navigator that occurred before the current 

day’s date.

Show Cancelled Bookings Selected, show bookings in the Navigator with a canceled status.

Show Wizards in Tools menu Show all on the Tools menu in the Bookings pane. If cleared, 

show only the “Wizards” option, which you must click to open a 

form from which you can select a tool. 
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Show Deleted Items Show all deleted items (bookings, deleted resource items, and so 

on) for a reservation in the Navigator.

Hide Empty Tabs Hide the tabs that do not have any data displayed on them for a 

selected reservation, booking, or booking detail.

Double-Clicking a Listed Folder

Opens the item Opens the item for editing. 

Expands folder Opens the next level of folders.

Wizard Results

Always Show Show a confirmation of all changes, regardless if they were 

successful, on a Wizard Results page.

Show Unchanged Only Show only those changes that were not successful on a Wizard 

Results page. 

Confirmation

Always prompt When you click Confirmation, opens a Confirmation filter which 

you can use to change the default filter options for a confirmation 

before generating it.

Print Preview When you click Confirmation, opens an onscreen preview of the 

confirmation.

Email When you click Confirmation, opens an email of the confirmation.

Print When you click Confirmation, prints an immediate confirmation.

Booking Display Time

Reserved Time Show the total time for which the space is reserved. This time is 

the event time plus the setup/teardown times.

Event Time Show only the event time for which the space is reserved.

Invoiced Items

Highlight Color The color with which invoiced items are highlighted in the 

Navigator page.

Service Orders

Show Pricing Show pricing on a service order.

Show Item Notes Show item notes on a service order.

Show Item Special Instructions Show special instructions for items on a service order.

Highlight Changes Made Within 

(days)

Highlight any changes that have been made to a service order 

within the specified number of days.

Footer Message Show reconfigured blocks of text that appear in footer of a 

service order (for example, a Cancellation policy).

Booking Edit

Auto Adjust Reserved Time 

When Event Time is Changed

If the reservation includes setup and/or teardown times, then 

automatically adjust the total time for the reservation (the event 

time plus the setup/teardown time) when the event time is 

changed.

Field Description



80

  The 

Navigator

At A Glance tab

On the At A Glance tab, you specify whether reminders, comments, attachments, and so on 
are to be displayed in the left pane of the Navigator when a reservation folder, booking 
folder, booking detail folder, and/or booking detail item is opened.

Figure 3-10: Navigator Options dialog box, At A Glance tab
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Highlight Categories

On the Highlight Categories tab, you indicate whether a checkmark is to be displayed on all 
booking detail item folders for the selected booking detail. The default is to Highlight All, 
which means every booking detail item folder for every booking detail is denoted with a 
checkmark.

Figure 3-11: Navigator Options dialog box, Highlight Categories tab
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Other Navigator commands

All other Navigator commands are available as buttons in the upper right pane and lower 
right pane of the Navigator. The buttons that are available are dynamically updated based not 
only on the folder or item that is currently selected in the left pane of the Navigator, but also 
on the tab that is open in the upper right pane of the Navigator. 

Figure 3-12: Buttons available on the Navigator page with a reservation folder selected

Figure 3-13: Buttons available on the Navigator page with a booking folder selected
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Figure 3-14: Buttons available on the Navigator page with a booking detail folder selected

Many of these same commands are also available on a context menu, which is a menu that 
opens when you right-click on a folder or item in the Navigator. All the context menus that 
are available in the Navigator offer a limited set of choices based on not only what is 
currently selected in the Navigator, but also, in what pane of the Navigator that it is selected. 
See Figure 3-15 below and Figure 3-16 on page 84.

Figure 3-15: Comparing context menus

Context menu for a reservation

Context menu for a booking
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Figure 3-16: Comparing context menus (need context menu for booking detail item)

The majority of the Navigator functions are accessible through the Tools command 
button in the Bookings pane. For consistency, this chapter references this 
approach whenever possible; however, you can use whatever approach best suits 
your working needs.

Context menu for a booking detail

Context menu for a booking detail item
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Adding Bookings to a Reservation in the 

Navigator

You can use the Navigator to add one or more bookings to an existing reservation.

To add bookings to a reservation

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation to which you are adding the 
bookings, and then in the Bookings pane, click New.

The Reservation Wizard opens. See “Making a Reservation Using the Reservation 
Wizard” on page 33.
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Editing a Reservation in the Navigator

When you edit a reservation in the Navigator, you are working with the who and the what 
information for the event—the event name, the group name, and so on. When you edit a 
reservation, you can edit the reservation information (event name, event coordinator, and so 
on), and you can edit the billing information (pricing plan, payment type, and so on).

To edit a reservation in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In left pane the Navigator, select the reservation that you are editing, and then on the 
Reservation Summary tab or on the Properties tab, click Edit.

The Reservation page opens. The Reservation tab is the active tab.

Figure 3-17: Reservation page, Reservation tab

When you edit a reservation, if you select a different pricing plan, then the pricing 
plan is applied at the reservation level only. Categories and room charges are not 
automatically repriced. To reprice your categories or room charges based on a 
new pricing plan, you must use the Update Pricing Plan wizard which is available 
in the EMS Desktop client.
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3. Do one or both of the following:

• On the Reservation tab, edit any and all the reservation information as needed.

• Open the Billing Information tab, and edit any and all the billing information as
needed.

Figure 3-18: Reservation page, Billing Information tab

4. Click OK.

The Reservation page closes and you return to the Navigator, which now shows the
updated information for the reservation.

A Search icon  next to a field indicates that you can open a Lookup dialog box 
to search for the indicated item, for example, a group on the Reservation tab, or a 

billing reference number on the Billing tab. An Information icon  next to a field 
indicates that you can open an Information dialog box that displays read-only 
information for the item, for example, a group.

If you select a different pricing plan, then the pricing plan is applied at the 
reservation level only. Categories and room charges are not automatically 
repriced. To reprice your categories or room charges based on a new pricing plan, 
you must use the Update Pricing Plan Wizard. See “Repricing Categories and 
Room Charges for a Reservation” on page 88.
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Repricing Categories and Room Charges for a 

Reservation

When you edit a reservation, if you select a different pricing plan, then the pricing plan is 
applied at the reservation level only. Categories and room charges are not automatically 
repriced. To reprice your categories or room charges based on a new pricing plan, then you 
must use the Update Pricing Plan Wizard.

To reprice categories and room charges for a reservation

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In left pane the Navigator, select the reservation that you are repricing, and then on the 
Reservation Summary tab, click Update Pricing.

The Update Pricing Plan Wizard opens. The current pricing plan for the reservation is 
displayed in the Pricing Plan field. The page displays all the categories, including room 
charges, that can be repriced in one or more of the reservation bookings.

Figure 3-19: Update Pricing Plan Wizard
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3. Select the category, or CTRL-click to select the multiple categories that you are repricing
for the reservation.

4. Click Next.

The Select Bookings page opens. This page lists all the bookings with one or more of the
selected categories that can be repriced.

Figure 3-20: Update Pricing Plan Wizard, Select Bookings page

5. Select the booking, or CTRL-click to select the multiple bookings for which you are
repricing the categories and/or room charges, or click Select All to select all the
displayed bookings in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

6. Click OK to close the message and return to the Navigator.

You can reprice a room charge for a booking only if the room charge has not been 
invoiced. To reprice a room charge that has been invoiced, you must first void the 
invoice. See “To void an invoice” on page 329.
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Changing the Status for a Reservation from the 

Reservation Summary tab

You have two options for changing the booking status for multiple bookings in a 
reservation—you can use the Change Status function that is available on the Reservation 
Summary tab in the Navigator or you can use the Change Booking Status Wizard. Even 
though the Change Booking Status Wizard is available for changing the status of multiple 
bookings in a reservation, most reservationists who approve reservations that are submitted 
from VEMS do so by using the Change Status function that is available on the Reservation 
Summary tab in the Navigator. This is because unlike the Change Booking Status Wizard, 
when you use the Change Status function in the Navigator to change the status of a 
reservation, an option is available for automatically generating and sending a confirmation to 
the group for whom the reservation was made.

To change the status for a reservation

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In left pane the Navigator, select the reservation that you are editing, and then on the 
Reservation Summary tab, click Change Status.

The Change Booking Status page opens. See Figure 3-21 on page 91.

Your EMS administrator must grant you the appropriate security access to change 
the status of a booking, which includes canceling a booking. If you want to change 
the status of a booking using the Change Booking Status Wizard, see “Editing 
Multiple Bookings in the Navigator” on page 99.

An email can be automatically generated and sent only if Email is selected for the 
Confirmation setting on the General tab of the Navigator Options dialog box, and 
if the group for which the reservation was made has an email address in its record. 
See “Navigator Options dialog box” on page 78 and “Searching for and 
Configuring Groups” on page 231.
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Figure 3-21: Change Booking Status page

3. On the Status dropdown list, select the new status for the bookings.

4. Enter a Reconfirm Date if it is required for the new status that you selected.

5. Optionally, do one or both of the following:

• Leave Update Reservation Status selected to have the reservation-level status
changed as well.

• Select Send Confirmation If Successful to have an email automatically generated
and sent to the group for whom the reservation was made.

6. Click Next.

The Select Booking page opens. This page displays all the bookings for the selected
reservation with a date greater than or equal to the current day’s date and that do not have
invoiced items. By default, all the bookings are selected.

Figure 3-22: Select Bookings page

If you select any type of Canceled status, then three additional fields—Reason, 
Who Cancelled and Notes—are displayed on the Change Booking Status page. 
You must enter data in all three of these fields before you can continue in the 
Wizard.

The confirmation is generated based on the system confirmation settings that you 
have specified. See “Specifying your Confirmation Settings” on page 281.
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7. Select the booking, or CTRL-click to select the multiple bookings for which you are
changing the status, and then click Finish.

The Change Booking Status Results page opens. This page displays a list of all the
selected bookings, whether the status was successfully changed or not.

Figure 3-23: Change Booking Status Results page

8. Click Close to close the Change Status Results page and return to the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
message opens onscreen. The message gives you the option to open the report 
onscreen or to save the report. If you cancel the message, then you can always 
manually run a Resource Inventory Conflict check. In the Bookings folder of the 
Navigator, select Tools > Resource Inventory Conflict.
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Copying a Reservation in the Navigator

An easy way for you to make a new reservation in the Navigator is to copy an existing 
reservation and then make any necessary changes to the reservation. When you copy an 
existing reservation, you must provide a new start date and a new status; however, you can 
copy the existing reservation reminders, comments, user-defined fields, and drawings as is, 
and you can copy one or more or all the existing booking details.

To copy a reservation in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation that you are copying, and then in 
the Bookings pane, click Tools, and then click Copy Reservation Wizard.

The Copy Reservation Wizard opens.

Figure 3-24: Copy Reservation Wizard
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2. Enter the information for the new reservation.

3. Click Next.

The Select Bookings page opens. This page displays all the bookings for the copied
reservation.

Figure 3-25: Copy Reservation Wizard, Select Bookings page

Information Description/Comments

New Start Date If you are copying a reservation with multiple bookings, then the start date 

should be the date of the earliest booking for the existing reservation.

New Status The status for the new reservation.

Reconfirm Date You must enter a date if it is required for the new status that you selected.

Conflict Status You must enter a conflict status in the event that the new bookings are in 

conflict with any existing bookings.

Reconfirm Date You must enter a date if it is required for the new conflict status that you 

selected.

• Copy Reminders

• Copy Comments

• Copy User Defined

Fields

• Copy Attachments

• Copy Drawings

Leave the appropriate options selected to copy the existing items as is, or 

clear the option for each item that is not to be copied to the new 

reservation.

Note: To view and work with any drawings for a reservation, you must 

open the reservation in the Navigator in the EMS Desktop client.

Copy Booking Details Select the booking details that are being copied (CTRL-click to select 

multiple details) or to select all the details for copying, click Select All.

Note: By default, only active booking details are displayed. To show 

inactive booking details for copying, click Show Inactive.

Copy Inactive 

Resources/Rooms

Selected by default. Copies the inactive resource and/or rooms from the 

existing reservation to the new reservation. Clear this option if you do not 

want to copy the inactive resources and rooms.
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4. CTRL-click to select the multiple bookings that you are recreating in the new
reservation, or click Select All to select all the displayed bookings in a single step, and
then click Finish.

A message opens indicating that the changes were made successfully.

5. Click OK to close the message and return to the Navigator.

The existing reservation and the new reservation are displayed in separate instances of
the Navigator. The new reservation is assigned a number based on the next available
reservation number in the database. If any of the new bookings are in conflict with
existing bookings, this conflict is indicated in the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.

The new reservation is assigned a number based on the next available reservation 
number in the database. The start date that you specified becomes the date of the 
first booking for the new reservation. In addition, the copied bookings are 
scheduled according to the same pattern as the existing reservation. For example, 
if the existing reservation has three bookings and each booking was scheduled 
every seven days (12/14, 12/21, and 12/28), and the start date for the new 
reservation is 12/15, then the new reservation has three bookings with dates of 12/
15, 12/22, and 12/29.

When you copy multiple bookings, the bookings are simply copied and pasted as 
is—the bookings are not moved to different location. If you need to move a 
booking to a different location, see “To change rooms for a booking” on page 105.
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Editing a Booking in the Navigator

When you edit a booking in the Navigator, you are working with the when and where 
information for the event—the event time, the event location, and so on. To edit a booking, 
you must have the appropriate security access. For example, you cannot move a booking to a 
room if your EMS administrator has not granted you access to the room. Likewise, you 
cannot change the status for a booking from tentative to confirmed if your EMS 
administrator has not granted you access to the confirmed status.

Under certain circumstances, bookings or booking details in EMS can become locked. 
Locked items are displayed in EMS, but you cannot edit or cancel the items. This locking 
can affect the basic booking information (date, time, room, and so on) or the details for the 
booking (catering, equipment, and so on). Locks are typically independent of one another. 
Just because one item is locked does not mean other items in the reservation are locked. 
Bookings can be locked in the following situations: 

• Insufficient security—To edit a booking, you must have access to the room and status and
as well as the correct security processes assigned to your user account.

• Old bookings—A booked event is locked a certain number of days after it has taken place.
Your EMS administrator sets the value for this system parameter. Old bookings are
locked to prevent you and other users from changing the facts for a past event, which
could cause discrepancies between documents printed for the event and the information
in EMS. When a booking is locked because it is old, all its details are also locked. You
cannot edit or delete existing details, and you cannot add new details.

• Invoiced bookings—When you create an invoice for a booking, you can bill for the entire
booking (the room fee plus all the fees for all the booking details) or for only certain items
that you choose (for example, the room fee and the equipment fees, but not the catering
fees). In either case, if a booking has one or more invoiced items, the booking is locked.
This means that you cannot edit or delete the booking, which includes changing the
booking status, and editing and deleting invoiced resources. You can, however, still add
more details to the bookings. For rooms, this means you cannot edit the room charge. You
also cannot move bookings that are invoiced to a new or existing reservation. You can,
however, still copy these bookings to a new or existing reservation.

Contact your EMS administrator for assistance.

To edit billable information for a booking, see “Editing Booking Detail Item 
Charges for Multiple Items” on page 147.

Remember, you can also edit certain booking information in the Reservation Book. 
See “To edit a reservation in the Navigator” on page 86.
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To edit a booking in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In left pane of the Navigator, expand the folder structure for the reservation until the 
appropriate booking folder is visible.

3. Select that booking that you are editing, and then on the Booking Summary tab or on the 
Properties tab, click Edit.

The Booking page opens. A message is displayed at the top of the dialog box that 
indicates the hours for the building that contains the selected room. If the booking has 
any type of booking detail assigned to it, then “This Booking has Service Orders” is 
displayed at the top of the page.

Figure 3-26: Booking page
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3. On the Booking tab, edit the information for the booking as needed, and then click OK.

Two results are possible:

• If you edited anything other than the date, time, or location for a booking, the
Booking page closes and you return to the Navigator, which now shows the updated
information for the booking.

• If you edited the date, time, or location for a booking, a dialog box opens, warning
you that critical booking information has changed. Click OK to close the message,
and then continue to Step 4.

4. Click Yes.

The Booking page closes and you return to the Navigator, which now shows the updated
information for the booking.

If you have been granted the appropriate security access, you change the status of 
a booking, which includes cancelling a booking. 

If you cancel a booking, a Cancel Status dialog box opens in which you must 
select a reason for canceling the booking, and you must identify the user who 
canceled the booking. You can also provide notes about the cancellation. If you 
change the status for a booking, you can select Update Reservation Status to have 
the reservation-level status changed as well.

If you edit a booking for a video conference event, then any date and time changes 
that you make to the booking automatically cascade to all related bookings.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
message opens onscreen. The message gives you the option to open the report 
onscreen or to save the report. If you cancel the message, then you can always 
manually run a Resource Inventory Conflict check. In the Bookings folder of the 
Navigator, select Tools > Resource Inventory Conflict.
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Editing Multiple Bookings in the Navigator

Four wizards are available for editing the when and where information for multiple bookings 
in a reservation:

• The Change Booking Date/Time Wizard

• The Change Booking Status Wizard (which includes canceling multiple bookings in a
single step)

• The Change Rooms Wizard

• The Change Miscellaneous Booking information Wizard (which includes type, setup
type, and setup count)

To edit multiple bookings in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation for which you are editing the 
bookings.

3. Continue to the following as appropriate:

• “To edit the booking date and/or time” on page 100.

• “To edit the booking status” on page 103.

• “To change rooms for a booking” on page 105.

• “To edit miscellaneous booking information” on page 112.

To edit billable information for a booking, see “Editing Booking Detail Item 
Charges for Multiple Items” on page 147.

Remember, you can also edit certain booking information in the Reservation Book. 
See “To edit an existing reservation” on page 63. 
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To edit the booking date and/or time

1. In the Bookings pane, click Tools > Change Booking Date/Time Wizard.

The Change Booking Date/Time Wizard opens.

Figure 3-27: Change Booking Date/Time Wizard

2. Change the value for the date, time, or both.

Value Description

Date

• No changes • The default value.

• Reschedule Booking Earlier • Reschedule the bookings to an earlier date that is based on

the number of days that you specify.

• Reschedule Booking Later • Reschedule the bookings to a later date based on the

number of days that you specify.

• Reschedule Booking to

Specific Date

• Reschedule the bookings to a new date that you specify.

Time

• No changes • The default value.

• End booking earlier • Resets the event end time and the reserved end time to an

earlier time, based on the number of hours that you specify.

• End booking later • Resets the event end time and the reserved end time to a

later time, based on the number of hours that you specify.

• Reschedule Booking Earlier • Resets both the event start and end times and the reserved

start and end times to an earlier time, based on the number

of hours that specify.

• Reschedule Booking Later • Resets both the event start and end times and the reserved

start and end times to a later time, based on the number of

hours that specify.
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3. Click Next.

The Select Bookings page opens. By default, this page displays all the bookings for the
selected reservation with a date greater than or equal to the current day’s date.

Figure 3-28: Change Booking Date/Time Wizard, Select Bookings page

• Reschedule Booking to

Specific Time

• Resets the following values based on the specific times that

you select:

• Reserved Start

• Event Start

• Event End

• Reserved End

• Set Setup/Teardown • Resets the setup or teardown times based on the hours or

minutes that you specify.

• Start Booking Earlier • Resets the event start time and the reserved start time to an

earlier time, based on the number of hours that you specify.

• Start Booking Later • Resets the event start time and the reserved start time to a

later time, based on the number of hours that you specify.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.

Value Description
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4. Select the booking, or CTRL-click to select the multiple bookings that you are editing, or
click Select All to select all the displayed bookings in a single step, and then click Finish.

The Change Booking Date/Time Results page opens. This page displays a list of all the
selected bookings, whether the date/time change was successful or not.

Figure 3-29: Change Booking Date/Time, Results page

5. Click Close to close the Change Booking Date/Time Results page and return to the
Navigator.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
message opens onscreen. The message gives you the option to open the report 
onscreen or to save the report. If you cancel the message, then you can always 
manually run a Resource Inventory Conflict check. In the Bookings folder of the 
Navigator, select Tools > Resource Inventory Conflict.
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To edit the booking status

1. In the Bookings pane, click Tools > Change Booking Status Wizard.

The Change Booking Status Wizard opens.

Figure 3-30: Change Booking Status Wizard

2. On the Status dropdown list, select the new status for the bookings.

3. Enter a Reconfirm Date if it is required for the new status that you selected.

4. Optionally, leave Update Reservation Status selected to have the reservation-level status
changed as well.

5. Click Next.

The Select Bookings page opens. This page displays all the bookings for the selected
reservation. See Figure 3-31 on page 104.

If your EMS administrator has granted you the appropriate security access, you 
can change the status of a booking, which includes canceling a booking. If you 
change the status for a booking, you can leave the option of Update Reservation 
Status selected to have the reservation-level status changed as well.

This is the same Wizard that opens if you select a reservation in the Navigator, and 
then on the Reservation Summary tab, click Change Status. See “Changing the 
Status for a Reservation from the Reservation Summary tab” on page 90.

If you select any type of Canceled status, then three additional fields—Reason, 
Who Cancelled and Notes—are displayed on the Change Booking Status page. 
You must enter data in all three of these fields before you can continue in the 
Wizard.
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Figure 3-31: Change Booking Status Wizard, Select Bookings page

6. Select the booking or CTRL-click to select multiple bookings for which you are
changing the status, and then click Finish.

The Change Booking Status Wizard Results page opens. This page displays a list of all
the selected bookings, whether the status change was successful or not.

Figure 3-32: Change Booking Status Wizard, Results page

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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7. Click Close to close the Change Booking Status Results page and return to the
Navigator.

To change rooms for a booking

1. In the Bookings pane, click Tools > Change Room Wizard.

The Change Room Wizard opens. Search for Rooms is selected by default.

Figure 3-33: Change Room Wizard

2. Do one of the following:

• To search for rooms, continue to “To search for rooms” on page 106.

• To select a specific room, select Specific Room, and then continue to “To select a
specific room” on page 110.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
message opens onscreen. The message gives you the option to open the report 
onscreen or to save the report. If you cancel the message, then you can always 
manually run a Resource Inventory Conflict check. In the Bookings folder of the 
Navigator, select Tools > Resource Inventory Conflict.
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To search for rooms

1. Click Next.

The Change Room Wizard Select Bookings page opens with a list of all the bookings for
the selected reservation with a date greater than or equal to the current day’s date.

Figure 3-34: Change Room Wizard, Select Bookings page

2. Select the time/room combination with which to work, and then click Next. (For
example, an 8 a.m. event and a 2 p.m. event in the same room are displayed as two
separate items; however, multiple 10 a.m. bookings in the same room on different dates
are displayed as a single item.)

The Change Room Wizard is refreshed with two panes:

• The left pane displays all the bookings for the selected time/room combinations.

• The right pane displays options for changing the building, the room specifications,
the booking status, or any combination of these. See Figure 3-35 on page 107.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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Figure 3-35: Change Room Wizard with location and status options

3. In the left pane of the Change Room Wizard, select the booking, or CTRL-click to select
the multiple bookings that you are moving to a new room, or click Select All to select all
the displayed bookings in a single step.

4. In the right pane, change the building, the room specifications, the status, the room
features, or any combination of these as needed for the selected bookings, and then click
Next.

5. If you did not select a specific Setup Type, then go Step 7; otherwise, in the Setup Count
field, enter a new setup count.

6. Optionally, select one or both of the following to update the selected bookings with the
following information for the new room:

• Update Setup Type on Selected Bookings.

• Update Setup Count On Selected Bookings (use Minimum).

7. Optionally, if you change the booking status, select Update Reservation Status to have
the reservation-level status changed as well.

Make sure that this count is the maximum that you expect the new room to hold.
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8. Click Next.

The Change Room Wizard is refreshed with an Available tab, and if applicable, a
Conflicts tab. The Available is always the active tab.

• The Available contains two panes. The left pane lists all the rooms that meet some or
all of your event criteria. The right pane lists all the event dates that must be
fulfilled.

• The Conflicts tab lists all the rooms that are not available for the requested dates.
Optionally, you can open the Conflicts tab to view the list of rooms that were not
available for scheduling for the event as well as list of the events that are scheduled
for each room.

Figure 3-36: Change Room Wizard, Available tab

9. Select the room that you are scheduling for the event.

10. Optionally, do one or both of the following; otherwise, go to Step 11.

• Click Room Info to open the Room Info dialog box and view information about the
room properties, setup type, features, and pricing.

• Click Building Hours to open the Building Hours dialog box which displays the
hours that the selected room/building is open on the reserved date.

The Conflicts tab is displayed only if there are any rooms that are not available for 
the requested dates based on your room search specifications. If no rooms are in 
conflict, then the tab is not displayed. 
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11. Click the Move button ( >) to move the room to the Selected list.

The selected room is displayed in the Rooms list in the right pane of the Available tab for
every event date for which the room is available.

12. If all the event dates are fulfilled, click Finish; otherwise, repeat Step 9 through Step 11
until all the event dates are fulfilled, and then click Finish.

A message opens, asking if you want to change any more rooms.

13. Click OK to repeat this procedure for any other bookings for the selected reservation;
otherwise, click Cancel to close the message.

The Change Room Wizard Results page opens. This page displays a list of all the
selected bookings, whether the room change was successful or not.

Figure 3-37: Change Room Wizard, Results page

14. Click Close to close the Change Room Wizard Results page and return to the Navigator.

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
message opens onscreen. The message gives you the option to open the report 
onscreen or to save the report. If you cancel the message, then you can always 
manually run a Resource Inventory Conflict check. In the Bookings folder of the 
Navigator, select Tools > Resource Inventory Conflict.



110

  The 

Navigator

To select a specific room

When you search for a specific room, you can search for a room within your facilities, or you 
can search for an override room, which is a room that is within your facilities but is not 
typically scheduled for events or it is outside of your facilities. If you specify an override 
room for an event, you must manually specify the location for the event.

1. Click the Search icon .

A Lookup dialog box opens. This dialog box lists all the available rooms in all the 
buildings to which you have been granted access.

Figure 3-38: Lookup dialog box

2. Do the following:

• Open the Building dropdown list and select (all) buildings, or a specific building,
area, or view.

• Click the Add icon  next to a room to select the room, and then click OK.

. 

• If you are selecting a standard room or a combo room, go to Step 4; otherwise, if you
are selecting an override room, go to Step 3.

3. In the Location field, enter the location of the override room.

Optionally, to view all rooms, whether available or unavailable, clear Show 
Available Rooms Only.

If you are selecting an override room, make sure to select the appropriate room, 
for example, one named OVR.
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4. Click Next.

The Select Bookings page opens with a list of all the bookings for the selected
reservation with a date greater than or equal to the current day’s date.

Figure 3-39: Change Room Wizard, Select Bookings page

5. Select the booking, or CTRL-click to select the multiple bookings that you are moving to
a new room, or click Select All to select all the displayed bookings in a single step, and
then click Finish.

The Change Room Wizard Results page opens with a list of all the selected bookings,
whether the room change was successful or not.

Figure 3-40: Change Room Wizard, Results page

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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6. Click Close to close the Change Room Wizard Results page and return to the Navigator.

To edit miscellaneous booking information

Miscellaneous information that you can change for multiple bookings includes the event 
name, the event type, the type, the setup type, the setup count, and the attendance.

1. In the Bookings pane, click Tools > Change Miscellaneous Booking Information
Wizard.

The Change Miscellaneous Booking Information Wizard opens.

Figure 3-41: Change Miscellaneous Booking Information Wizard

Optionally, to view only the bookings for the selected reservation that were NOT 
successfully changed, select Show Unchanged Only. To view the details for a 
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a 
booking, and there is a resource inventory conflict, a Resource Inventory Conflicts 
message opens onscreen. The message gives you the option to open the report 
onscreen or to save the report. If you cancel the message, then you can always 
manually run a Resource Inventory Conflict check. In the Bookings folder of the 
Navigator, select Tools > Resource Inventory Conflict.
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2. Select the information that you are changing, enter the new value for the selected
information, and then click Next.

The Select Bookings page opens. This page displays all the bookings for the selected
reservation with a date greater than or equal to the current day’s date.

Figure 3-42: Change Miscellaneous Booking Information Wizard, Select Bookings page

3. Select the booking, or CTRL-click to select the multiple bookings for which you are
changing the information, or click Select All to select all the displayed bookings in a
single step, and then click Finish.

A message opens, indicating that the changes were made successfully.

4. Click OK to close the message and return to the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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Moving Bookings to a Different Reservation

You use the Move Bookings reservation to move one or more bookings that do not have 
invoiced items from a selected reservation to an existing reservation or to an entirely new 
reservation. When you move a booking from a selected reservation, the booking and all its 
associated details are removed entirely from the selected reservation. 

To move bookings to a different reservation

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation from which you are moving the 
bookings.

3. In the Bookings pane, click Tools, and then click Move Bookings Wizard.

The Move Bookings Wizard opens. The option to move the bookings to an Existing 
Reservation is selected by default.

Figure 3-43: Move Bookings Wizard
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4. Do one of the following:

• In the Existing Reservation field, enter the reservation number for the existing
reservation to which the bookings are to be moved.

• Click New Reservation.

5. Click Next.

The Select Bookings page opens. This page lists all the bookings for the selected
reservation that do not have invoiced items.

Figure 3-44: Move Bookings Wizard, Select Bookings page

6. Select the booking, or CTRL-click to select the multiple bookings that you are moving to
the new or existing reservation, or click Select All to select all the displayed bookings in
a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

7. Click OK to close the message and return to the Navigator.

The reservation from which the bookings were moved and the reservation to which the
bookings were moved are displayed in separate instances of the Navigator. If you moved
the bookings to a new reservation, then the new reservation that is created is assigned the
next available reservation number in the database. If you moved the bookings to an
existing reservation and any of the moved bookings are in conflict with bookings in the
existing reservation, then this conflict is indicated in the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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Copying Multiple Bookings in the Navigator

You use the Copy Bookings Wizard to copy one or more bookings to a new date or to a set of 
dates, either within the same reservation or to a new reservation. 

To copy multiple bookings in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation from which you are copying the 
bookings.

3. In the Bookings pane, click Tools, and then click Copy Bookings Wizard.

The Copy Bookings Wizard opens. Existing Reservation is selected by default and the 
number for the reservation from which you are copying the bookings is displayed in the 
field.

Figure 3-45: Copy Bookings Wizard
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4. Do one of the following:

• To copy the bookings to an existing reservation, enter the reservation number in the
Existing Reservation field.

• To copy the bookings to a new reservation, click New Reservation.

5. Enter the information for the reservation to which you are copying the bookings.

6. Click Next.

The Select Bookings page opens. This page displays all the bookings for the copied
reservation, regardless of the date or status. See Figure 3-46 on page 118.

Information Description/Comments

Start Date If you are copying a reservation with multiple bookings, then the start 

date should be the date of the earliest booking for the existing 

reservation.

New Status The status for the new reservation.

Reconfirm Date Enter if required for the new status that you selected.

Conflict Status You must enter a conflict status in the event that the new bookings are in 

conflict with the existing bookings.

Reconfirm Date Enter if required for the new conflict status that you selected.

• Copy Reminders

• Copy Comments

• Copy User Defined

Fields

• Copy Attachments

• Copy Drawings

Leave the appropriate options selected to copy the existing items as is, 

or clear the option for each item that is not to be copied to the new 

reservation.

Note: To view and work with any drawings for a reservation, you must 

open the reservation in the Navigator in the EMS Desktop client.

Copy Booking Details Select the booking details that are being copied (CTRL-click to select 

multiple details) or to select all the details for copying, click Select All.

Note: By default, only active booking details are displayed. To show 

inactive booking details for copying, click Show Inactive.
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Figure 3-46: Copy Bookings Wizard, Select Bookings page

7. Select the booking, or CTRL-click to select the multiple bookings that you are recreating
in the existing or new reservation, or click Select All to select all the displayed bookings
in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.

The start date that you specified becomes the date of the first new booking. In 
addition, the copied bookings are scheduled according to the same pattern as the 
existing reservation. For example, if the existing reservation has three bookings 
and each booking was scheduled every seven days (12/14, 12/21, and 12/28), and 
the start date for the new reservation is 12/15, then the new reservation has three 
bookings with dates of 12/15, 12/22, and 12/29.

When you copy multiple bookings, the bookings are simply copied and pasted as 
is—the bookings are not moved to different location. If you need to move a 
booking to a different location, see “To change rooms for a booking” on page 105.
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8. Click OK to close the message and return to the Navigator.

The reservation from which you copied the bookings and the reservation to which you
copied the bookings are displayed in separate instances of the Navigator. If you copied
the bookings to a new reservation, then the new reservation that is created is assigned the
next available reservation number in the database. If any of the new bookings are in
conflict with bookings in the existing reservation, this conflict is indicated in the
Navigator.
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Booking Details and Items Overview

Booking details, which are also called categories, are the services (catering, A/V equipment, 
and so on), notes, attendees, activities, or room charges that you can assign to a booking. 
Booking detail items, also called resources, are the individual items (coffee, sandwich, 
projector, and so on) that you assign to a booking detail. When you add a resource to a 
booking, for example, coffee, various selections might be available or required, for example, 
regular, decaf, Italian roast, breakfast blend, and so on. Depending on how your EMS 
administrator has configured your categories, a resource might require service order times to 
be specified. 

The booking details for a selected booking are displayed in the Booking Details pane (the 
lower right pane) of the Navigator. 

Figure 3-47: The Navigator page with a booking folder selected

Your EMS Administrator can configure buildings and categories so that a 
particular category can be used only in a particular building or buildings. This 
means that when you are adding booking details to a reservation, some booking 
details (categories) might not be displayed as an option.

From this point on in the manual, categories that contain resources, but do not 
require service times are referred to as “resource categories.” Categories that 
contain resources and that require service times are referred to as “service order 
categories.” Categories that are used to manage food service are referred to as 
“catering categories.” Categories that are used to manage miscellaneous notes 
(setup notes), agenda items, attendees/visitors, or room charges are referred to as 
“non-resource categories.”
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If you select a booking detail folder that is for a Resource with Service Order category or a 
Catering category, then the service order number is displayed in the title bar of the Navigator. 

Figure 3-48: The Navigator page with a booking detail folder selected

When you select a booking detail folder in the left pane of the Navigator, the tabs that are 
displayed in the upper right pane of the Navigator depends on the type of booking detail that 
you selected:

• <Booking Detail> Summary tab—The Summary displays information about the selected
booking detail, including the event date, the event location, and the event status.

• Properties tab—The Properties tab also displays information about the booking detail,
including the date that it was added to the booking, who added the detail, and, if
applicable, the date that the detail was changed and who made the change.

If the booking detail has a price/charge associated with it, for example, a room charge, then 
the following two tabs are also displayed:

• Billing Reference Allocation tab—By default, the charge for a booking detail can be
allocated to a single billing reference number. On the Billing Reference Allocation tab,
you can allocate the charge for a reservation to multiple billing reference numbers by
percentage. See “To allocate charges to multiple billing reference numbers and/or PO
numbers” on page 71.

Your EMS administrator must enable the Use Billing Reference Allocation 
parameter for this tab to be displayed. See EMS System Parameters in the EMS 
Setup Guide.
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• PO Number Allocation tab—By default, the charge for a booking detail can be allocated
to a single purchase order (PO) number. On the PO Number Allocation tab, you can
allocate the charge for a reservation to multiple billing PO numbers by percentage. See
“To allocate charges to multiple billing reference numbers and/or PO numbers” on page
71.

If the selected booking detail requires a service order or catering category, then the following 
four tabs are also displayed:

• User Defined Fields—The User Defined Fields tab displays the additional fields that store 
custom data for the booking detail. Your EMS administrator configures the types of fields
that are available as well as the allowed values for these fields. See “Working with User
Defined Fields in the Navigator” on page 167.

• Reminders tab—The Reminders tab displays any reminders that were created for the
selected booking detail. See “Working with Comments and Reminders in the Navigator”
on page 161.

• Comments—The Comments tab displays any comments that were made for the selected
booking detail. See “Working with Comments and Reminders in the Navigator” on page
161.

• History—The History tab displays the history for the booking detail—the date that a
change was made to the detail, the ID of the user who made the change, the field that was
changed, the old field value, and the new field value.

Also, when you select a booking detail folder:

• On most of the tabs in the upper pane of the Navigator page, you can sort data columns
in either ascending or descending order. See “Changing the width of data columns on an
EMS Browser page” on page 26.

• The booking detail items for the selected booking detail are displayed in the Items pane
(the lower right pane) of the Navigator. A green check mark appears in front of each
individual item that has been added to a booking. If the item is a package, then a green
checkmark is displayed not only in front of the package, but also, in front of each
individual item in the package. A red “x” is displayed in front of any booking detail and/
or booking detail item that has been deleted from a booking. The Items pane has all the
features of an EMS Browser page. See “An EMS Browser Page” on page 25.

Your EMS administrator must enable the Use PO Number Allocation parameter 
for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.
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If you select a booking detail item in the left pane of the Navigator, then the entire right pane 
of the Navigator is refreshed with three tabs—a Properties that displays for the selected item, 
a Selections tab that displays the selections for the booking detail item, if applicable, and a 
History tab that details the history of the item.

Figure 3-49: The Navigator page with a booking detail item selected

Service order

A booking detail might include a service order. A service order is a request to use the 
resource for a specified time period as opposed to using the resource for the entire event. For 
example, an event that meets from 10:00 am to 2:00 pm, might have food service from 11:00 
am to noon. A service order consists of the service type, start and end times, and a unique, 
system-generated service order ID. For a catering booking detail, you can also indicate 
estimated count, guaranteed count, and actual count. You can create multiple service orders 
in the same booking. For example, you might have a number of catering services (breakfast, 
lunch, and afternoon refreshments) in the course of a one day training event. In this case, 
multiple folders are displayed under the booking folder on the left side of the Navigator 
page, with each folder representing a unique service order.

Figure 3-50: The Navigator page showing multiple service orders in the same booking
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If you reserve an item from a category that does not require a service order, your only 
choices are to reserve the item for the event time or for the entire reserved time.

Your EMS administrator might have configured a default service type for some or 
all of your system’s categories, but you can always select a different value. In 
addition, your EMS administrator might have configured states to manage your 
service order process. For detailed information about states, see Configuring 
Categories in the EMS Setup Guide.
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Adding Booking Details and Items to Individual 

Bookings 

The steps that you follow to add booking details and items to individual bookings depend on 
the category type. Also, you can add multiple occurrences of a booking detail to a booking 
only if the detail is a Resource with Service Order category or a Catering category. If the 
booking detail is not from is a Resource with Service Order category or a Catering category, 
and the detail is already added to a booking, you cannot add the detail again to the booking. 
You can, however, add more items to the booking detail.

To add booking details and items to individual bookings

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, expand the folder structure for the reservation until the 
appropriate booking folder is visible.

3. Select the booking folder, and then in the Booking Details pane, click New.

The Booking Details list opens.

Figure 3-51: Example of a Booking Details list

4. Select the booking detail that you are adding to the booking.

A dialog box opens.
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5. Continue to one of the following:

• “To add a booking detail from a non-resource category” below.

• “To add a booking detail from a resource, service order, or catering category” on
page 130.

To add a booking detail from a non-resource category

A booking detail that is from a non-resource category can be setup notes, attendees, agenda 
(activities), or a room charge. 

To add setup notes

Figure 3-52: Setup Notes dialog box

1. Enter the sequence number for the setup notes.

2. Enter the appropriate notes or comments.

3. Optionally, if these notes are to be printed on internal reports only (the notes would be
excluded from external reports like a confirmation), then select Internal.

4. Click OK

The Setup Notes dialog box closes. The booking detail and its items are displayed as
folders under the Booking folder in the Navigator page.

The sequence number determines the order in which the notes are displayed in the 
Items pane in the Navigator when the booking detail (Setup Notes) is selected for 
a booking.
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To add attendees

Figure 3-53: Attendees dialog box

1. Enter the information for the attendee. At a minimum, you must enter the attendee name.

2. If the attendee is a visitor (that is, not registered for the event), then select Visitor.

3. Click OK.

The Attendee dialog box remains open.

4. Repeat Step 1 through Step 3 until you have added all the needed attendees/visitors to
the booking.

5. Click Cancel.

The Attendees dialog box closes. The booking detail and its items are displayed as
folders under the Booking folder in the Navigator page.

After you add setup notes for the first time to a booking, Setup Notes is no longer 
an available option on the Booking Details dropdown list. To add more setup notes 
to the booking, select the Setup Notes folder for the booking or click a Setup Note 
in the Items pane, and then click New.

If you close the Attendees dialog box before you have added all the needed 
attendees/visitors to the booking, then Attendees is no longer an available option 
on the Booking Details dropdown list. To add more attendees/visitors to the 
booking, select the Attendees folder for the booking or click an attendee/visitor in 
the Items pane, and then click New.
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To add an agenda (activities)

Figure 3-54: Agenda dialog box

1. Enter the start time, the end time, and a description for the agenda.

2. Optionally, in the Description field, enter a description or name for the agenda.

3. Optionally, if these notes are to be printed on internal reports only (the notes would be
excluded from external reports like a confirmation), then select Internal.

4. Click OK.

The Agenda dialog box remains open.

5. Repeat Step 1 through Step 4 unit you have added all the needed agendas.

6. Click Cancel.

The Agenda dialog box closes. The booking detail and its items are displayed as folders
under the Booking folder in the Navigator page.

The description or name can be a maximum of 30 characters, including spaces.

If you close the Agenda dialog box before you have added all the needed agendas/
activities to the booking, then the Agenda is no longer an available option on the 
Booking Details dropdown list. To add more agenda/activities to the booking, 
select the Agenda folder for the booking or click an agenda in the Items pane, and 
then click New.
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To add a room charge

Figure 3-55: Room Charge dialog box

1. Enter the sequence number for the room charge.

2. Optionally, enter notes or comments about the room charge.

3. If needed, modify the quantity.

4. Select the appropriate pricing method, and then enter any other additional information as
needed after you select a pricing method.

The sequence number determines the order in which the charges are displayed in 
the Items pane in the Navigator when the booking detail (Room Charge) is 
selected for a booking.

Pricing Method Additional Fields

Half Day/Full Day (Event Time) • Half Day Price

• Full Day Price

• Hours

Half Day/Full Day (Reserved Time) • Half Day Price

• Full Day Price

• Hours

Hourly (Event Time) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge
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5. Optionally, enter a discount percent and/or a reservation discount.

6. Click OK.

The Room Charge dialog box closes. The booking detail and its items are displayed as
folders under the Booking folder in the Navigator page.

To add a booking detail from a resource, service order, or catering 

category

• If you select a service order or catering category, a Service Order dialog box opens with,
at a minimum, options for Service, Reviewed, Service Start Time, and End Time. If a
catering category is selected, additional fields for Estimated, Guaranteed and Actual
Counts are displayed. Go to Step 1.

Figure 3-56: Example of a Service Order dialog box for a catering category

Hourly (Reserved Time) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

Hourly (Specific) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

Unit • Unit Price

After you add charges for the first time to a booking, Room Charge is no longer an 
available option on the Booking Details dropdown list. To add more room charges 
to the booking, select the Room Charge folder for the booking or click a Room 
Charge in the Items pane, and then click New.

Pricing Method Additional Fields
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• If you select a resource category, then a Resource Selection dialog box opens. The
Resources tab is the active tab. Go to Step 4.

Figure 3-57: Example of a Resource Selection dialog box, Resources tab

1. Select the service type.

2. Enter the start time, and optionally, the end time, estimated count, guaranteed count, and
if applicable, select Reviewed and/or a state.

3. Click OK.

A Resource Selection dialog box opens. The Resources tab is the active tab.

4. Do one of the following

• To select one or more resources from the pre-configured list of resources, leave the
Resources tab open, and then go to Step 5.

• To add multiple resources to the booking in a single step, open the Packages tab, and
then go to Step 7.

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 203.
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5. Do one of the following on the Grouping dropdown list:

• Leave the default value of (all) as is to search for all items in all groupings.

• Select a specific grouping to search for only those items in the grouping. For
example, if the selected resource category is A/V Equipment, then available
groupings could include Computer, Phone, Video, and so on. To search only for the
available phones to add to a booking detail, select the Phones grouping.

6. Optionally, in the Filter field, enter a search string by which to filter your search.

7. In the Quantity field, leave the default value of 1.00; otherwise, enter a new value.

8. Do one of the following:

• For the Resources tab—On the Items list, select the resource item, or CTRL-click to
select the multiple resource items that you are adding to the booking.

• For the Package tab—Select the package that contains the multiple resources that
you are adding to the booking.

Your search is limited to the exact order of the characters in the string, but the 
search string is not case-sensitive and it can appear anywhere in the search 
results. For example, a search string of co returns coffee service, conference 
phone, and mini-copier.

If you change the quantity for a resource package, then the quantity for each 
individual resource that makes up the package is also changed.

Your EMS administrator might have configured an override resource (also known 
as an override description) so that you can book a resource that has not been 
configured in your EMS database. For example, the administrator might have 
configured an override resource named “Other.” If you select the “Other” 
resource, then a Description field is displayed on the Resource Selection dialog 
box. You must enter a description or name for the override resource before you 
can continue. EMS does not track availability of override resource items; however, 
EMS reports on override resource items just like any other resource item.
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9. Click Select.

• For items on the Resources tab—If your EMS administrator configured selections
for the resource, then either you might be required to make selections for the
resource, or you have the option to make selections for the resource (see Figure 3-58
below); otherwise, go to Step 10.

Figure 3-58: Example of a Resource Selections dialog box

• For packages on the Packages tab—The package is added to the booking. An entry
for the package as well as entry for each item in the package is displayed in the
Booking Detail Items pane of the Navigator.

10. Repeat Step 4 through Step 9 until you have added all the necessary booking detail items
for the selected booking.

11. Click Close.

The Resource Selection dialog box closes. The resource and its items are displayed as
folders under the Booking folder in the Navigator.

If you close the Resource Selection dialog box before you have added all the 
needed resource items to the booking, and the booking detail is not from a catering 
or service order category, then the booking detail is no longer an available option 
on the Booking Details dropdown list. To add more resource items to the booking, 
you can select the Booking Detail folder for the booking or you can click a 
booking detail item in the Items pane, and then click New.
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Adding Booking Details and Items to Multiple 

Bookings

You use the Add Booking Details Wizard to add booking details and items to multiple 
bookings in a single step. The steps that you follow depend on the category type. Also, you 
can add multiple occurrences of a booking detail to bookings only for catering and service 
order categories. If the booking detail is not from a catering or service order category, and the 
detail is already added to the bookings, you cannot add the detail again to the bookings. (You 
can, however, add more items to the bookings. See “Adding Booking Detail Items to 
Multiple Bookings” on page 141.)

To add booking details and items to multiple bookings

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation to which you are adding the 
booking details and items.

3. In the Bookings pane, click Tools, and then click Add Booking Details Wizard. 

The Add Booking Details Wizard opens.

Figure 3-59: Add Booking Details Wizard
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4. Select the booking detail that you are adding to one or more of the bookings for the
selected reservation, and then continue to one of the following:

• “To add a booking detail from a non-resource category.”

• “To add a booking detail from a resource, service order, or catering category” on
page 136.

To add a booking detail from a non-resource category

If you select a booking detail of any type other than resource or catering, (for example, 
attendees or setup notes), then to add the detail to the bookings, you follow the same general 
steps:

1. Select the booking detail.

2. Click Next, and then enter the information for the booking detail.

• If you are adding setup notes, see “To add setup notes” on page 126.

• If you are adding attendees/visitors, see “To add attendees” on page 127.

• If you are adding an agenda or activities, see “To add an agenda (activities)” on page
128.

• If you are adding room charges, see “To add a room charge” on page 129.

3. Click Next.

The Select Bookings page opens. This page displays all the bookings for the selected
reservation with a date greater than or equal to the current day’s date, and that do not
already have the selected booking detail added.

Figure 3-60: Add Booking Details Wizard, Select Bookings page
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4. Select the booking, or CTRL-click to select the multiple bookings to which you are
adding the details, or click Select All to select all the displayed bookings in a single step,
and then click Finish.

A message opens indicating that the changes were made successfully.

5. Click OK to close the message and return to the Navigator.

The booking detail and its items are displayed as folders under the Booking folder in the
Navigator page.

6. Repeat this procedure for every non-resource category that you are adding to the
bookings.

To add a booking detail from a resource, service order, or catering 

category

• If you select a catering or service order category, a Service Order dialog box opens with,
at a minimum, options for Service, Reviewed, Service Start Time, and End Time. If a
catering category is selected, additional fields for Estimated, Guaranteed and Actual
Counts are displayed. Go to Step 1.

Figure 3-61: Example of the Add Booking Details Wizard for a resource with a service order

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings. 
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• If you select a resource category, then two results are possible:

• The Add Booking Details Wizard is updated with options for Reviewed and/or State.
If applicable, select Reviewed and/or select a State, click Next to open the Add
Booking Details Wizard, and then go to Step 3.

• The Add Booking Details Wizard opens with two tabs—Resources and Packages.
The Resources tab is the active tab. This tab displays a pre-configured list from
which you can select one or more resources. Go to Step 3.

1. Select the service type.

2. Enter the start time, and optionally, the end time, estimated count, guaranteed count, and
select Reviewed and/or a state.

3. Do one of the following:

• To choose one or more resources from the pre-configured list of resources, leave the
Resources tab open, and then go to Step 4.

• To add multiple resources to the booking in a single step, open the Packages tab, and
then go to Step 6.

Figure 3-62: Add Booking Details Wizard, Resources tab

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 203.

For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 203.
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4. Do one of the following on the Grouping dropdown list:

• Leave the default value of (all) as is to search for all items in all groupings.

• Select a specific grouping to search for only those items in the grouping. (For
example, if the selected resource category is A/V Equipment, then available
groupings could include Computer, Phone, Video, and so on. To search only for the
available phones to add to a booking detail, select the Phones grouping.)

5. Optionally, in the Filter field, enter a search string by which to filter your search.

6. In the Quantity field, leave the default value of 1.00; otherwise, enter a new value.

7. Do one of the following:

• For the Resources tab—On the Items list, select the resource item, or CTRL-click to
select the multiple resource items that you are adding to the booking.

• For the Package tab—Select the package that contains the multiple resources that
you are adding to the booking.

Your search is limited to the exact order of the characters in the string, but the 
string can is not case-sensitive and it can appear anywhere in the search results. 
For example, a search string of co returns coffee service, conference phone, and 
mini-copier.

If you change the quantity for a resource package, then the quantity for each 
individual resource that makes up the package is also changed.

Your EMS administrator might have configured an override resource (also known 
as an override description) so that you can book a resource that has not been 
configured in your EMS database. For example, the administrator might have 
configured an override resource named “Other.” If you select the “Other” 
resource, then a Description field is displayed on the Resource Selection dialog 
box. You must enter a description or name for the override resource before you 
can continue. EMS does not track availability of override resource items; however, 
EMS reports on override resource items just like any other resource item.

Use the Move Up and Move Down options to order the selected items. To edit a 
selected item before you add it to multiple bookings, select the item, and then click 
Edit.
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8. Click Next.

• For items on the Resources tab—If your EMS administrator configured selections
for the resource, then either you might be required to make selections for the
resource, or you have the option to make selections for the resource (see Figure 3-63
below); otherwise, go to Step 9.

Figure 3-63: Example of a Resource Selections dialog box

• For packages on the Packages tab—The package is added to the booking. An entry
for the package as well as entry for each item in the package is displayed in the
Booking Detail Items pane of the Navigator.

9. Click Next.

The Select Bookings page opens. This page displays all the bookings for the selected
reservation with a date greater than or equal to the current day’s date, and that do not
already have the selected booking detail added. See Figure 3-64 on page 140.
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Figure 3-64: Add Booking Details Wizard, Select Bookings page

10. Select the booking, or CTRL-click to select the multiple bookings to which you are
adding the details, or click Select All to select all the displayed bookings in a single step,
and then click Finish.

A message opens asking you if you want to add more booking details.

11. Do one of the following:

• Click Yes to return to the Add Booking Details Wizard.

• Click No.

A message opens indicating that the changes were made successfully.

12. Click OK to close the message and return to the Navigator.

The booking detail and its items are displayed as folders under the Booking folder in the
Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings. 
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Adding Booking Detail Items to Multiple 

Bookings

You use the Add Item Wizard to add booking detail items to multiple bookings for categories 
that are already added to the bookings. For example, you can use this Wizard to add food 
service items only if any of the bookings already has food service added as a booking detail. 

To add booking detail items to multiple bookings

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation to which you are adding the 
booking detail items.

3. In the Bookings pane, click Tools, and then click Add Item Wizard.

The Add Item Wizard opens. The first page in this Wizard, the Select Category page, 
displays only those categories that are already in use for any of the bookings in the 
reservation.

Figure 3-65: Add Item Wizard, Select Category page

To add booking details and items for categories that are not already in use, see 
“Adding Booking Details and Items to Multiple Bookings” on page 134.
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4. Select the category to which you want to add items.

5. Click Next.

The steps that you now must follow depend on the category type. See:

• “To add a booking detail from a non-resource category” on page 135.

• “To add a booking detail from a resource, service order, or catering category” on
page 136.



143

  The 

Navigator

Editing Booking Detail Items for Individual 

Bookings

After you have added booking details and items to bookings for a reservation, you can edit 
any non-invoiced items on an individual basis.

To edit booking detail items for individual bookings

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, expand the folder structure for the reservation until the 
appropriate booking details item folder is visible, and then do the following:

• Select the booking detail folder that contains the items that you are editing.

• In the Items pane, select the item that you are editing.

3. Continue to one of the following:

• “To edit a booking detail item from a non-resource category” on page 144.

• “To edit a booking detail item from a resource, service order, or catering category”
on page 144.

To edit the pricing information for multiple non-invoiced items in a single 
booking, or for multiple non-invoiced items in multiple bookings, see “Editing 
Booking Detail Item Charges for Multiple Items” on page 147.

The item cannot be invoiced. If the item is invoiced, the Edit button is not 
available. To edit an invoiced item, you must first void the invoice. See “To void an 
invoice” on page 329.
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To edit a booking detail item from a non-resource category

1. Click Edit.

The <Booking Detail> dialog box opens.

2. Edit the item as necessary, and then click OK to close the <Booking Detail> dialog box
and return to the Navigator.

For detailed information about editing a booking detail item from a non-resource
category, see:

• “To add setup notes” on page 126.

• “To add attendees” on page 127.

• “To add an agenda (activities)” on page 128.

• “To add a room charge” on page 129.

To edit a booking detail item from a resource, service order, or 

catering category

1. Click Edit.

The <Resource> dialog box opens. The Resource tab is the active tab. If selections are
available for the resource, then the dialog box also has a Selections tab.

Figure 3-66: <Resource> dialog box, Resource tab
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2. On the Resource tab, edit the information as necessary.

• If applicable, select a completely different item for the resource.

• The sequence number determines the order in which the items (for example, juice,
muffins, and so on) are displayed in the list in the Items pane in the Navigator when
the booking detail (for example, Catering) is selected for a booking. If needed, edit
the sequence number.

• The Time in Use indicates the time that the resource is to be available for the
booking. If needed, edit the Time in Use.

• If the notes are to be printed on internal reports only (the notes would be excluded
from external reports like a Confirmation), then select Internal.

• If you edit the pricing method, then make sure to enter any other additional
information as needed.

For a definition of Event Time or Reserved Time, see “Event Timeline” on page 
32. You can edit the Time In Use only if the item is not from a resource from a
service order or catering category. (The Time in Use is applied at the category
level for these types of resources).

Pricing Method Additional Fields

Half Day/Full Day (Event Time) • Half Day Price

• Full Day Price

• Hours

Half Day/Full Day (Reserved Time) • Half Day Price

• Full Day Price

• Hours

Half Day/Full Day (Service Time)

Note: Available only for resources with a service order.

• Half Day Price

• Full Day Price

• Hours

Hourly (Event Time) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

Hourly (Reserved Time) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

Hourly (Service Time)

Note: Available only for resources with a service order.

• Half Day Price

• Full Day Price

• Hours



146

  The 

Navigator

• If applicable, open the Selection tab, and modify the resource selections as needed.

3. Click OK.

The <Resource> dialog box closes, and you return to the Navigator with the modified
item still selected in the Items pane.

Hourly (Specific) • Hourly Price

• Minimum Charge

• Maximum Charge

• Initial Flat Charge

Unit • Unit Price

If you need to modify counts and/or times for individual items in a resource, 
service order, or catering category, see “Editing Count Information for a 
Booking” on page 149.

Pricing Method Additional Fields
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Editing Booking Detail Item Charges for Multiple 

Items

You can edit resource quantities and billing information (price, pricing method, and so on) 
for individual items (see “Editing Booking Detail Items for Individual Bookings” on page 
143) or you can edit this information for multiple non-invoiced items using the Edit Charges
tool.

To edit booking detail item charges for multiple items

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In left pane of the Navigator, do one of the following:

• To edit all billable items in all the bookings for a reservation, select the reservation.

• To edit only the billable items in a selected booking, expand the reservation folder, 
and under the expanded reservation folder, select the booking that contains the items 
that you are editing.

3. In the Bookings/Booking Details pane, click Tools > Edit Charges.

The Edit Charges page opens. If you selected a reservation, then all non-invoiced 
billable items in all the bookings for the selected reservation are displayed on the page; 
otherwise, only the non-invoiced billable items for the selected booking are displayed. 
See Figure 3-67 on page 148.

To edit the billing information for invoiced items, you must first void the invoice. 
See “To void an invoice” on page 329.



148

  The 

Navigator

Figure 3-67: Edit Charges page

4. Optionally, on the Category dropdown list, select a category to narrow the list of items
that are displayed.

5. To edit the quantity, pricing method, price, or discount percentage for an item,
double-click in the appropriate field for the item.

An Edit Form dialog box opens.

Figure 3-68: Edit Form dialog box

6. Make the necessary edits for the selected field, and then click Update.

The Edit Form dialog box closes and you return to the Edit Charges page. Any resulting
recalculations are carried out automatically. The Edit Charges pages closes and you
return to the Navigator.
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Editing Count Information for a Booking

You use the Edit Counts tool to edit the count information for a booking, including the setup 
count and attendance count, the estimated count, guaranteed count, and actual count for a 
booking detail with a category type of catering, as well as the counts for non-invoiced 
booking detail items. You can edit the counts for all bookings in a reservation or for just a 
selected booking.

To edit count information for a booking

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, do one of the following:

• Select the reservation.

• Expand the reservation folder, and under the reservation folder, select a specific 
booking.

3. In the Bookings pane, click Tools, and then click Edit Counts.

The Edit Counts page opens. If you selected the reservation, then the Bookings (top) 
pane of the page lists all the bookings for the selected reservation; otherwise, the pane 
lists just the selected booking. See Figure 3-69 on page 150.

Much of the information that you can edit using the Edit Counts tool is also 
available for editing in other areas of the application. The purpose of this tool is 
simply to collate all the count information in a single location for editing.
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Figure 3-69: Edit Counts page

4. Select the booking for which you are editing the count information.

5. On the Category dropdown list, select the booking detail (category) for which you are
editing the count information.

The Booking Details (middle) pane is refreshed with the information for the selected
category. If the category is a resource with a service order, then the pane displays the
service type and the start and end times for the category. If the category is catering, then
the pane also displays the estimated count, guaranteed count, and actual count for the
booking detail.

6. In the Booking Details pane, select the booking detail that contains the items for which
you are editing the count information.

The Items (lower) pane is refreshed with a list of all the non-invoiced items for the
selected detail.

7. To modify the count information for any booking detail or detail item, click in the
appropriate field and make the necessary edits.

8. To edit the count information for multiple bookings, repeat Step 4 through Step 7 as
needed for each booking.

9. Click Close.

The edits are made. You return to the Navigator.
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Applying a Reservation Discount

You use Apply Reservation Discount Wizard to apply a reservation discount to non-invoiced 
details in a booking. The discount is applied as a percentage of the total charge for an item 
and it is added to any existing discounts that have already been applied to the item.

To apply a reservation discount

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation to which you are applying the 
discount.

3. In the Bookings pane, click Tools, and then click Apply Reservation Discount. The 

Apply Reservation Discount page opens. All the bookings for the selected 
reservation with their categories that have not been invoiced are displayed.

Figure 3-70: Apply Reservation Discount page

To apply a discount to invoiced items, you must first void the invoice. See “To void 
an invoice” on page 329.
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4. Leave the Category set to the default value of (all), or optionally, to apply a discount to
all the items in a specific category, on the Category dropdown list, select a category.

The Apply Reservation Discount page is updated with the bookings that have the
selected category.

5. Enter the discount percentage.

6. Optionally, enter any notes that are relevant about the discount.

7. Select the booking, or CTRL-click to select the multiple bookings to which you are
applying the discount, or click Select All to select all the displayed bookings in a single
step, and then click Finish.

A message opens indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.

After you apply a reservation discount, you can view it and/or edit it when you are 
editing the reservation on the Billing Information tab of the Reservation page in 
the Navigator. See “Editing a Reservation in the Navigator” on page 86.
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Copying Booking Details between Bookings

You use the Copy Booking Details Wizard to copy the details from one booking in a 
reservation and paste them into other bookings for the same reservation.

To copy booking details between bookings

1. Open the reservation to which the details are to be copied in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation from which you are copying the 
details.

3. In the Bookings pane, click Tools, and then click Copy Booking Details Wizard. The 

Copy Booking Details Wizard open. The first page in this Wizard, the Select Booking 

Details to Copy page, displays all the bookings for the selected reservation, regardless 

of date. By default, the Copy From Reservation No. field displays the reservation 

number for the selected reservation.

Figure 3-71: Copy Booking Details Wizard, Select Booking Details to copy page
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4. Optionally in the Copy From Reservation No. field, click the Search icon  to open
the Open Navigator dialog box and search for and select a different reservation from
which to copy the booking details.

The Select Booking Details to Copy page is refreshed with all the bookings details for
the selected reservation.

5. Optionally, do one or both of the following:

• On the Category dropdown list, select a specific category of booking details to
display on the Select Booking Details to Copy page.

• Leave Copy Inactive Resources/Rooms selected to copy this information for the
bookings. Clear this option if you do not want to copy this information.

6. Select the booking, or CTRL-click to select the multiple bookings from which you are
copying the booking details, and then click Next.

The Select Bookings page opens. This page displays all the bookings with a date greater
than or equal to the current day’s date to which you can copy the booking details.

Figure 3-72: Copy Booking Details Wizard, Select Bookings page

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings.
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7. Select the booking, or CTRL-click to select the multiple bookings to which you are
copying the booking details, or click Select All to select all the displayed bookings in a
single step, and then click Finish.

A message opens indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.
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Deleting Booking Detail Items from Multiple 

Bookings

If you add booking detail items to bookings for a reservation in error, or a booking item is no 
longer valid for one or more bookings, and the item has not been invoiced, you can use the 
Delete Item Wizard to delete the item. You can delete each item on an individual basis, or 
you can delete all the items for a booking detail in a single step. If you delete an item at the 
package level, then the deletion cascades down to all the items in the package. You can also 
delete individual items from a package.

To delete booking detail items from multiple bookings

1. Open the reservation for which you are deleting booking detail items in the Navigator. 
See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation from which you are deleting the 
booking detail items.

3. In the Bookings pane, click Tools, and then click Delete Item Wizard.

The Delete Item Wizard opens. The first page that opens is the Select Categories page.

Figure 3-73: Delete Item Wizard, Select Categories page
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4. Select the category (booking detail) from which you are deleting the items, and then
click Next.

The Select Categories/Items page opens.

Figure 3-74: Delete Item Wizard, Select Categories/Items page

5. Optionally, do one or both of the following:

• Select a specific grouping to limit the display to only those items in the grouping.

• Select Delete Empty Categories to also delete a category after the last item is deleted
from the category.

6. On the Resources list, select the resource item, or CTRL-click to select the multiple
resource items that you are deleting.

7. Click Next.

The Select Bookings page opens. This page lists all the bookings for the selected
reservation with a date greater than or equal to the current day’s date that have the
resource items that were selected for deletion. See Figure 3-75 on page 158.
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Figure 3-75: Delete Item Wizard, Select Bookings page

8. Select the booking, or CTRL-click to select the multiple bookings from which you are
deleting the resource items, or click Select All to select all the displayed bookings in a
single step, and then click Finish.

A message opens indicating that the changes were made successfully.

9. Click OK to close the message and return to the Navigator.
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Deleting Booking Details from Multiple Bookings

You use the Delete Booking Details Wizard to delete one or more booking details that do not 
have invoiced items from multiple bookings in a single step. When you delete a booking 
detail from a booking, any items that have been added for the detail are also deleted.

To delete booking details from multiple bookings

1. Open the reservation from which the booking details are to be deleted in the Navigator. 
See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation from which you are deleting the 
booking details.

3. In the Bookings pane, click Tools, and then click Delete Booking Details Wizard. The 

Delete Booking Details Wizard opens. The first page in this Wizard, the Select 
Categories page, displays all the categories (booking details) that are already in use for 
any of the bookings in the reservation.

Figure 3-76: Delete Booking Details Wizard, Select Categories page
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4. Select the category, or CTRL-click to select the multiple categories that you are deleting
from the reservation, or click Select All to select all categories in a single step.

5. Click Next.

The Select Booking Details page opens. This page lists all the bookings for the selected
reservation with a date greater than or equal to the current day’s date that have the
categories (booking details) that were selected for deletion and that do not have any
invoiced items.

Figure 3-77: Delete Booking Details Wizard, Select Booking Details page

6. Select the booking, or CTRL-click to select the multiple bookings from which you are
deleting the details, or click Select All to select all the displayed bookings in a single
step, and then click Finish.

A message opens indicating that the changes were made successfully.

7. Click OK to close the message and return to the Navigator.
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Working with Comments and Reminders in the 

Navigator

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a 
booking detail that is a service order. A reminder is a comment that has a due date associated 
with it. You can select from a pre-configured list of comment types and reminder types, or 
you can create a user-specified comment type or reminder type if none of the pre-configured 
types meets your working needs. You can add comments/reminders directly to a reservation, 
booking, or service order in the Navigator. You can also edit a comment/reminder, delete a 
comment/reminder, and view the history for a comment/reminder.

To work with a comment or reminder in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation, booking, or service order, and 
then in the top right pane of the Navigator, open the Comments tab.

3. Continue to one of the following:

• “To add a comment” on page 162.

• “To edit a comment” on page 163.

• “To delete a comment” on page 163.

• “To the view history for a comment” on page 163.

A reminder that you add to a reservation, booking, group, or booking details is 
called an attached reminder. To work with unattached reminders, see “Reminders 
Tab” in “Overview of the EMS Dashboard and Dashboard Options” on page 209.

The following procedures are written from the perspective of working with a single 
comment. By analogy, you can follow these procedures to work with a single 
attached reminder. To add multiple comments and/or reminders to a reservation in 
a single step, see “Adding Multiple Comments and Reminders to a Reservation” 
on page 165.



162

  The 

Navigator

To add a comment

1. Click New.

The Comment dialog box opens.

Figure 3-78: Comment dialog box

2. On the Comment Type dropdown list, select the type of comment that you are adding;
otherwise, if none of the pre-configured comment types meets your working needs,
select (user-specified comment), and then in the Description field, enter a description for
the comment type.

3. In the Notes field, enter the comment.

4. Optionally, to alert any EMS user that opens this reservation, booking, or service order
that this comment has been added, select Alert Users.

5. Click OK.

The Comment dialog box closes. The comment is added to the reservation, booking, or
service order. The Comments tab remains open.



163

  The 

Navigator

To edit a comment

1. Select that comment that you are editing, and then click Edit.

The Comment dialog box opens. The comment is displayed in the Notes field.

2. Modify the comment as needed, including its type, description, notes, and/or its Alert
User status.

3. Click OK.

The Comment dialog box closes. The modified comment is saved for the reservation,
booking, or service order. The Comments tab remains open.

To delete a comment

1. Select the comment that you are deleting, and then click Delete.

A message opens asking you if it is OK to delete the selected comment.

2. Click OK.

The selected comment is deleted from the reservation, booking, or service order. The
Comments tab remains open.

To the view history for a comment

1. Select the comment for which you viewing the history, and then click Edit.

The Comment dialog box opens. The comment is displayed in the Notes field.

2. Open the History tab.

The date that the change was made. the name/ID of the user who made the change, the
field that was changed, the old value for the changed field, and the new value for the
changed field. See Figure 3-79 on page 164.

You can use the scroll feature at the right of the dialog box to scroll through all the 
history for a selected change.
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Figure 3-79: Comment dialog box, History tab

3. Click OK.

The Comment dialog box closes. The Comments tab remains open.



165

  The 

Navigator

Adding Multiple Comments and Reminders to a 

Reservation

When you add a comment or a reminder to a reservation from the Comments tab or 
Reminders tab, respectively, then you can add only a single comment or reminder at a time. 
To add multiple comments or reminders to a reservation in a single step, you must use an 
option on the context menu for reservations in the Navigator. 

To add multiple comments and reminders to a reservation

1. Open the reservation to which you are adding multiple comments and/or reminders in 
the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, right-click the reservation, and on the context menu that 
opens, click Add Reminders and Comments.

The Add Reminders and Comments page opens. This page lists all the available

pre-configured reminder and comment types in the Available list.

Figure 3-80: Add Reminders and Comments page

When you add multiple reminders and comments to a reservation, your only 
option is to select from a pre-configured list of comment types and reminder types. 
To add a user-specified comment type or reminder type, you must add each 
comment or reminder individually. See “Working with Comments and Reminders 
in the Navigator” on page 161.
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3. In the Available list, select the comment/reminder type, or CTRL-click to select the
multiple comment/reminder types that you are adding to the reservation, and then click
the Move ( >) button to move the selected comment/reminder types to the Selected list.

4. To enter the text for the selected comment/reminder types, select a comment/reminder
type in the Selected list, and then click Edit.

A Notes dialog box opens in which you can enter the text for the selected comment/
reminder type.

5. After you have entered the text for a selected comment/reminder type, click OK to close
the Notes dialog box and return to the Add Reminders and Comments page.

6. Repeat Step 4 and Step 5 for each selected comment/reminder type.

7. Click Finish.

A message opens indicating that the comment/reminder types were added successfully.

8. Click OK to close the message and return to the Navigator.
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Working with User Defined Fields in the 

Navigator

The User Defined Fields tab displays the additional fields that store custom data for a 
reservation or a booking detail that is a service order. Your EMS administrator configures the 
types of fields that are available as well as the allowed values for these fields. You can add 
new fields to a reservation or booking detail, edit the value for a field, and delete fields. You 
can also view the history for a field.

To work with user-defined fields in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation or booking detail (remember, the 
booking detail must be a service order), and then in the right pane of the Navigator, open 
the User Defined Fields tab.

3. Continue to one of the following:

• “To add a user-defined field” on page 168.

• “To edit a user-defined field” on page 168.

• “To delete a user-defined field” on page 169.

• “To the view history for a user-defined field” on page 169.
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To add a user-defined field 

1. Click New.

The User Defined Field dialog box opens.

Figure 3-81: User Defined Field dialog box

2. On the Field dropdown list, select the type of field that you are adding.

3. In the Value field, if applicable, leave the default value as-is; otherwise, modify the
default value or enter a value for the field.

4. Click OK.

The User Defined Field dialog box closes. The field is added to the reservation and the
User Defined Fields tab remains open.

To edit a user-defined field

1. Select that user defined field that you are editing, and then click Edit.

The User Defined Field dialog box opens. The field type and field value are displayed in
the dialog box.

2. Modify the field type, field value, or both as needed.

3. Click OK.

The User Defined Field dialog box closes. The modified field is saved for the reservation
or booking detail and the User Defined Fields tab remains open.
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To delete a user-defined field

1. Select the user-defined field that you are deleting, and then click Delete.

A message opens asking you if it is OK to delete the selected field.

2. Click OK.

The selected field is deleted. The User Defined Fields tab remains open.

To the view history for a user-defined field

1. Select the user-defined field for which you viewing the history, and then click Edit.

The User Defined Field dialog box opens. The field type and field value are displayed in
the dialog box.

2. Open the History tab.

The tab displays the following information for each change that was made to the field—
the date of the change, the login ID for the user who made the change, and the old and
new values for the field.

Figure 3-82: User Defined Field dialog box, History tab

3. Click OK.

The User Defined Field dialog box closes. The User Defined Fields tab remains open.

You can use the scroll feature at the bottom on the right side of the dialog box to 
scroll through all the history for a selected change.
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Working with Attachments in the Navigator

The term attachment is used to describe any file that you can add to or store on a reservation 
or booking. (Unlike a drawing, which is simply referenced, an attachment is actually stored 
in the EMS database with the reservation or booking record.) You can also delete an 
attachment from a booking, and view and edit an attachment.

To work with attachments in the Navigator

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, select the reservation or expand the folder structure for 
the reservation until the appropriate booking folder is visible, and then select the 
booking folder.

3. In the right pane of the Navigator, open the Attachments tab.

4. Continue to one of the following:

• “To add an attachment to a reservation or booking” on page 171.

• “To delete an attachment from a reservation or booking” on page 173.

• “To edit an attachment for a reservation or booking” on page 173.

• “To view an attachment for a reservation or booking” on page 173.
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To add an attachment to a reservation or booking

1. Click New.

The Attachment dialog box opens.

Figure 3-83: Attachment dialog box

2. Optionally, in the Description field, enter a description for the attachment.

3. On the Type dropdown list, select the attachment type.

4. Click Upload to open the Attachments dialog box, and then click Attach Files to open
the Select File to Upload dialog box and browse to and select the attachment.

The Select File to Upload dialog box closes.

5. Optionally, do one or more of the following as needed:

• If the attachment is to be displayed in VEMS when it is attached to a reservation or
booking, then select Display on Web.

• If a VEMS user is to be able to delete this attachment when it is attached to a
reservation or booking, then select Allow Web Delete.

• Enter any pertinent notes for the attachment.

The description can be a maximum of 50 characters, including spaces. If you 
leave this field blank, then it is automatically populated with the name of the file 
after you attach it to the reservation or booking.
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6. Click OK.

The Attachment dialog box closes. The attachment is added to the booking. The
Attachments tab remains open.

To edit an attachment for a reservation or booking

1. Select the attachment that you are editing, and then click Edit.

The Attachment dialog box opens. The name/description of the attachment is displayed
in the Description field. Any notes that have been entered for the attachment are
displayed in the Notes field.

2. Do any of the following as needed:

• Edit the description as needed.

• Click Upload to open the Attachments dialog box, and then click Attach Files to open
the Select File to Upload dialog box and browse to and select a different attachment.

• Edit the notes and/or web options.

3. Click OK.

The Attachment dialog box closes. The Attachments tab remains open.

To delete an attachment from a reservation or booking

1. Select the attachment or CTRL-click to select the multiple attachments that you are
deleting from the reservation or booking.

2. Click Delete.

A message opens asking you if it is OK to delete the selected attachments.

3. Click OK.

The selected attachments are deleted from the reservation or booking. The Attachments
tab remains open.

To view an attachment for a reservation or booking

1. Select the attachment that you want to view.

The description can be a maximum of 50 characters, including spaces. If you 
leave this field blank, then it is automatically populated with the name of the file 
after you attach it to the reservation or booking.

Your computer must have the appropriate application installed to view 
attachments of a specific type. For example, to open a .docx that is attached to a 
booking, Microsoft Word must be installed on your computer. 
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2. Click View.

A File Download dialog box opens asking you if you want to open the file or save the
file.

3. Do one of the following:

• To open the file immediately, click Open.

• To save the file, and then open it at a later date, click Save, and the in the Save As
dialog box that opens, specify the file name and the location in which to save the
file.

4. Optionally, if the application in which you open the attachment allows it, edit the
attachment as needed, and then save the attachment.

The next time you open the attachment in the Navigator, you can see the changes that
you made.
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Running the Resource Utility Conflicts Tool

Resource conflicts can occur if bookings for the same date and time require the same 
resource, and insufficient quantities of the resource to accommodate all the bookings. When 
you reserve any resource for which the inventory is maintained (for example, equipment, 
personnel, and so on), EMS checks the available quantity and automatically notifies you in 
an Inventory Conflict message if there is insufficient quantities of the selected resource to 
accommodate your event. 

Figure 3-84: Inventory Conflict message

You have the option of dismissing this message and over-committing the resource; however, 
although you are aware that the resource has been over-committed, other users will not 
necessarily be aware of this fact. If you need to confirm that an over-commitment of 
resources does not exist for a single reservation, then you can manually run the Resource 
Inventory Conflicts tool from the Navigator to generate a report that lists the resources that 
are in conflict by booking for the reservation.

To run the Resource Utility Conflicts tool

1. Open the reservation in the Navigator. See “Opening a reservation directly in the
Navigator” on page 67.

2. In the Bookings pane, click Tools, and then click Resource Inventory Conflicts.

A message opens, asking you if you want to open or save the Resource Inventory
Conflict.pdf file.

3. Select the option that best fit your working needs.

• If you click Open, the Resource Inventory Conflict report opens onscreen. You can
always indicate a file name and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

4. Optionally, edit the booking details for the involved bookings to resolve the conflict.

To confirm that an over-commitment of resources does not exist across multiple 
reservations, run any of the various resource usage reports that are available. See 
“Statistics reports” in “Generating an EMS Report” on page 291.
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EMS Web Client has a variety of options available to you for searching for reservations, 
bookings, service orders, resources, and queries. These options include the Browser, the Web 
Reservation tool, the Calendar, the Navigator, a Group, the Web Request tool, the Resource 
Calendar, and the Service Order Management browser.

This chapter covers the following topics:

• “Searching with the Browser or with the Web Reservation Tool” on page 179.

• “Searching with the Calendar” on page 187.

• “Searching with the Resource Calendar” on page 196.

• “Searching with the Service Order Management Browser” on page 203.

Remember, a fast way to view and edit bookings is through the Reservation Book. 
See “Viewing and Editing Reservations in the Reservation Book” on page 50.

For information about searching with the Navigator, see  , “The Navigator,” 
on page 65. For information about searching for reservations by group, see 
“Working with Reservations for a Group” on page 271.For information 
about searching with the Web Request tool, see  , “EMS Dashboard,” on 
page 207.
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Searching with the Browser or with the Web 

Reservation Tool

You can use the Browser to search for reservations, bookings, service orders, resources, web 
and reservations. The results are displayed in a list view. When you carry out a search in the 
Browser, you can carry out a basic search or an advanced search. A basic search is based on 
the basic information that you specify for a reservation when you first create it, such as the 
starting date, the end date, the group for which the event was scheduled, the group contact 
name, and so on. An advanced search is a field level search that is carried out at the 
reservation level, the booking level, the booking detail level, the booking detail item level, 
the service order level, or any combination of these. For example, in an advanced search, you 
can specify criteria as granular as who added a specific booking detail item. 

To carry out a search in the Browser

1. On the EMS toolbar, click the Browser icon .

By default, the first time that the Browser page opens, the Filter tab is set to a Basic
search; otherwise, the Filter tab is set to the search type (Basic or Advanced) that you
last carried out. See Figure 4-1 on page 180.

A web reservation is any reservation that a user has submitted through VEMS. The 
Web Reservation searching tool is identical to the Browser searching tool with one 
exception—when the Browser opens for the first time, the Browse for function is 
set to Reservations whereas the Web Reservation tool is set to Web Reservations. 
As a result, although this section is written from the perspective of using the 
Browser, all the information can be applied when using the Web Reservation 
searching tool. To open the Web Reservation searching took, click the Web 

Reservations icon  on the EMS Web Client toolbar. 
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Figure 4-1:  Browser page, Basic search options

2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and
then continue to one of the following:

• “To carry out a basic search in the Browser” below.

• “To carry out an advanced search in the Browser” on page 183.

To carry out a basic search in the Browser

1. On the Browse For dropdown list, select the item for which to search.

2. Enter the search criteria.

Field Description

• Starting Time

• Ending Time

Both are optional. 

Use Specific Times Available only if the Starting Date is the same as the Ending Date.

Include Cancelled By default, search results are not set to show canceled reservations. 

Select this option to search for canceled reservations as well.

Group If the pre-defined list of groups is too extensive to scroll, then click the 

Search icon  to open the Groups page and search for a specific group. 

See “To search for a group and/or contact” on page 231.
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3. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, When Filtering By Specific
Room, and Show Service Order Items.

4. Click Get Data or Refresh.

The search results are displayed on the Results tab.

Figure 4-2:  Browser page, Results tab

• 1st Contact

• Event Name

Enter a search string by which to filter your search. The string is not 

case-sensitive, but your search is limited to the exact order of characters in 

the string and it must begin with the information for which you are 

searching. For example, a search string of ed returns Ed, Edward, Eddie, 

and so on, but not Ted or Fred.

Building The default value is set to (all). You can leave this value as is, or you can 

select a specific building, area, or view.

Building/Room • If you select a specific building, then (all) rooms in the building are

selected by default. You can select a specific room in the building.

• If you select an area, then you can select a specific building that is

contained in the area.

• If you select a view, then Room is left blank; however, you can select a

specific room to search.

Category The default value is set to (all). You can leave this value as is, or you can 

select a specific category (booking detail).

Resource Available only if you select a category that is a resource or service order. 

The default value is set to (all). You can leave this value as is, or you can 

select a specific resource item.

Booking Status The default value is set to (all). You can leave this value as is, or you can 

select a specific booking status.

Field Description
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5. Optionally, do one or more of the following:

• The Results tab is an EMS Browser page. See “An EMS Browser Page” on page 25
for all the features that are available for this tab.

• Double-click an event entry on the Results tab to open the event in the Navigator.

• Click Print to open a message that asks you if you want to open or save the .pdf file,
for example, Reservations.pdf for the Reservation view. Select the option that best
fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select a directory in which to save the file.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

A message opens, asking you if you want to print or save the .xls file, for example,
the Reservations.xls file for the Reservation view. Select the option that best fit your
working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

• In the Service Orders view, to mark a service order as Reviewed, select the service
order, or CTRL-click to select multiple service orders, and then click Review >
Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click
Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select
the appropriate booking in the Results list, or CTRL-click to select multiple service
orders of the same category, and then click Change State. A Change State dialog box
opens. The dialog box lists all the available states for the service order. Select the
new state for the service order on the State dropdown list.

• In the Browse For field, select a different item to search for. The Results tab is
refreshed with the search results based on the item that you selected and the search
criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

If the selected category does not use States, then a message opens indicating this. 
For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 203.
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6. Click Close.

Any changes that you made to the search results columns (position, sort order, and so on)
are reset to their default values after you click Refresh or carry out a new search.

To carry out an advanced search in the Browser

Figure 4-3:  Browser page, Advanced search options

1. On the Browse For dropdown list, select the item for which to search.

2. Optionally, enter a Starting Date, an Ending Date, or both.

3. Optionally, if the Starting Date and the Ending Date are the same, select Use Specific
Times and enter specific time periods to search.

Use Specific Times is available only if the Starting Date is the same as the Ending 
Date.
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4. For each field level option by which to carry out the search:

• Select the field level option, and then click the Move button (>).

• When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

5. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, When Filtering By Specific
Room, and Show Service Order Items.

6. Click Get Data or Refresh.

The search results are displayed on the Results tab.

Figure 4-4:  Browser page, Results tab

To filter the list of available fields, in the Level Search field and/or the Field 
Search field, enter a search string. Your search is limited to the exact order of the 
characters in the string, but the search string is not case-sensitive and it can 
appear anywhere in the search results. For example, a search string of add returns 
Added by, Date Added, and Group Address Line 1. The list of fields that meet all 
your search criteria is dynamically updated as you enter the criteria.

If you have specific fields and/or values by which you always want to carry out a 
search, then you can set up these fields to be your Favorite fields. See “To set up 
favorite fields for a Browser search” on page 186.
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7. Optionally, do one or more of the following:

• The Results tab is an EMS browser page. See “An EMS Browser Page” on page 25
for all the features that are available for this tab.

• Double-click an event entry on the Results tab to open the event in the Navigator.

• Click Print to open a message that asks you if you want to open or save the .pdf file,
for example, Reservations.pdf for the Reservation view. Select the option that best
fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select a directory in which to save the file.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

A message opens, asking you if you want to print or save the .xls file, for example,
the Reservations.xls file for the Reservation view. Select the option that best fit your
working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

• In the Service Orders view, to mark a service order as Reviewed, select the service
order, or CTRL-click to select multiple service orders, and then click Review >
Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click
Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select
the appropriate booking in the Results list, or CTRL-click to select multiple service
orders of the same category, and then click Change State. A Change State dialog box
opens. The dialog box lists all the available states for the service order. Select the
new state for the service order on the State dropdown list.

• In the Browse For field, select a different item to search for. The Results tab is
refreshed with the search results based on the item that you selected and the search
criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

If the selected category does not use States, then a message opens indicating this. 
For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 203.
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8. Click Close.

Any changes that you made to the search results columns (position, sort order, and so on)
are reset to their default values after you click Refresh or carry out a new search.

To set up favorite fields for a Browser search

If you have specific fields and/or values by which you always want to carry out a Browser 
search, you do not have to filter the list of fields on the All Fields tab for every search. 
Instead, you can set up each of these fields to be a favorite field with a specific value or limit 
if needed. 

1. Open the Browser, and make sure that the Advanced search features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields
tab, and then click Add to Favorites.

The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on
the Filter dialog box.

The next time that you carry out a search, you can simply open the Favorite Fields tab or
the Saved Values tab to carry out a search based on your customized list of search fields.
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Searching with the Calendar

You use the Calendar to search for reservations, bookings, and service orders in your EMS 
Web Client database. The results are displayed in a calendar view. When you carry out a 
search in the Calendar, you can carry out a basic search or an advanced search. A basic 
search is based on the basic information that you specify for a reservation when you first 
create it, such as the starting time, the end time, the group for which the event was scheduled, 
the group contact name, and so on. An advanced search is a field level search that is carried 
out at the reservation level, the booking level, the booking detail level, the booking detail 
item level, or any combination of these. For example, in an advanced search, you can specify 
criteria as granular as who added a specific booking detail item. 

To carry out a search in the Calendar

1. On the EMS toolbar, click the Calendar icon .

The Calendar page opens. By default, the first time that the Calendar page opens, the
Filter tab is set to a Basic search and the Month and Year fields are set to the current
month and year; otherwise, the Filter tab is set to the search type (Basic or Advanced)
that you last carried out.

Figure 4-5:  Calendar page, Filter tab
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2. Click the Basic/Advanced toggle to select the type of search that you want to carry out
and then continue to one of the following:

• “To carry out a basic search in the Calendar.”

• “To carry out an advanced search in the Calendar” on page 192.

To carry out a basic search in the Calendar

Figure 4-6:  Calendar page, Filter tab with Basic search options

1. On the Browse For dropdown list, select the item for which to search.

2. Enter the search criteria.

Field Description

Month

Year

The default value is the current month and year, but you can change 

one or both of these values if needed.

Include Cancelled By default, search results are not set to show canceled bookings. Select 

this option if you want to search for canceled bookings as well.

Group If the pre-defined list of groups is too extensive to scroll, then click the 

Search icon  to open the Groups page and search for a specific 

group. See “To search for a group and/or contact” on page 231.

• 1st Contact

• Event Name

Enter a search string by which to filter your search. The search is not 

case-sensitive, but your search is limited to the exact order of 

characters in the string and it must begin with the information for which 

you are searching. For example, a search string of ed returns include 

Ed, Edward, Eddie, and so on, but not Ted or Fred.
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3. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, Get Data When Calendar
Opens, When Filtering By Specific Room, and Change Calendar Day Count Color.

4. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The number of
bookings that meet the search criteria is indicated on the dates on which the events occur.
The current day’s date is outlined in black.

Figure 4-7:  Calendar page, Results tab

Building The default value is set to (all). You can leave this value as is, or you 

can select a specific building, area, or view.

Building/Room • If you select a specific building, then (all) rooms in the building are

selected by default. You can select a specific room in the building.

• If you select an area, then you can select a specific building that is

contained in the area.

• If you select a view, then Room is left blank; however, you can select

a specific room to search.

Category The default value is set to (all). You can leave this value as is, or you 

can select a specific category (booking detail).

Resource Available only if you select a category that is a resource or service order. 

The default value is set to (all). You can leave this value as is, or you 

can select a specific resource item.

Booking Status The default value is set to (all). You can leave this value as is, or you 

can select a specific booking status.

By default, the number of bookings is indicated in red unless you selected a 
different color for the Change Calendar Day Count Color. Any color that you pick 
here is carried over to the same option for the Resource Calendar.

Field Description
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5. Optionally, do one or more of the following:

• Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-8:  Calendar page, Results tab with list of events for selected dates

• The lower pane on the Results tab is an EMS Browser page. See “An EMS Browser
Page” on page 25 for all the features that are available for this tab.

• Double-click the event entry on the Results tab to open an event in the Navigator.

• Click Print to open a message that asks you if you want to open or save the .pdf file,
for example, Reservations.pdf for the Reservation view. Select the option that best
fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select a directory in which to save the file.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

A message opens, asking you if you want to print or save the .xls file, for example,
the Reservations.xls file for the Reservation view. Select the option that best fit your
working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.
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• In the Service Orders view, to mark a service order as Reviewed, select the service
order, or CTRL-click to select multiple service orders, and then click Review >
Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click
Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select
the appropriate booking in the Results list, or CTRL-click to select multiple service
orders of the same category, and then click Change State. A Change State dialog box
opens. The dialog box lists all the available states for the service order. Select the
new state for the service order on the State dropdown list.

• In the Browse For field, select a different item to search for. The Results tab is
refreshed with the search results based on the item that you selected and the search
criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position, sort order, and so on)
are reset to their default values after you click Refresh or carry out a new search.

If the selected category does not use States, then a message opens indicating this. 
For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 203.
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To carry out an advanced search in the Calendar

Figure 4-9:  Calendar page, Advanced search options

1. On the Browse For dropdown list, select the item for which to search.

2. Leave the Month and Year set to the default values (current month and year), or
optionally, enter different values as needed.

3. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, Get Data When Calendar
Opens, When Filtering By Specific Room, and Change Calendar Day Count Color.

4. For each field level option by which to carry out the search:

• Select the field level option, and then click the Move button (>).

• When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

To filter the list of available fields, in the Level Search field and/or the Field 
Search field, enter a search string. Your search is limited to the exact order of the 
characters in the string, but the search string is not case-sensitive and it can 
appear anywhere in the search results. For example, a search string of add returns 
Added by, Date Added, and Group Address Line 1. The list of fields that meet all 
your search criteria is dynamically updated as you enter the criteria.
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5. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The number of
bookings that meet the search criteria is indicated on the dates on which the events occur.
The current day’s date is outlined in black.

Figure 4-10: Calendar page, Results tab

If you have specific fields and/or values by which you always want to carry out a 
search, then you can set up these fields to be your Favorite fields. See “To set up 
favorite fields for a Calendar search” on page 195.

By default, the number of bookings is indicated in red unless you selected a 
different color for the Change Calendar Day Count Color.
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6. Optionally, do one or more of the following:

• Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-11: Calendar page, Results tab with list of events for selected dates

• The lower pane on the Results tab is an EMS Browser page. See “An EMS Browser
Page” on page 25 for all the features that are available for this tab.

• To open an event in the Navigator, double-click the event entry on the Results tab.

• Click Print to open a message that asks you if you want to open or save the .pdf file,
for example, Reservations.pdf for the Reservation view. Select the option that best
fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select a directory in which to save the file.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

A message opens, asking you if you want to print or save the .xls file, for example,
the Reservations.xls file for the Reservation view. Select the option that best fit your
working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.
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• In the Service Orders view, to mark a service order as Reviewed, select the service
order, or CTRL-click to select multiple service orders, and then click Review >
Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click
Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select
the appropriate booking in the Results list, or CTRL-click to select multiple service
orders of the same category, and then click Change State. A Change State dialog box
opens. The dialog box lists all the available states for the service order. Select the
new state for the service order on the State dropdown list.

• In the Browse For field, select a different item to search for. The Results tab is
refreshed with the search results based on the item that you selected and the search
criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

7. Click Close.

Any changes that you made to the search results columns (position, sort order, and so on)
are reset to their default values after you click Refresh or carry out a new search.

To set up favorite fields for a Calendar search

If you have specific fields and/or values by which you always want to carry out a Calendar 
search, you do not have to filter the list of fields on the All Fields tab for every search. 
Instead, you can set up each of these fields to be a favorite field with a specific value or limit 
if needed. 

1. Open the Calendar, and make sure that the Advanced search features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields
tab, and then click Add to Favorites.

The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on
the Filter dialog box.

The next time that you carry out a search, you can simply open the Favorite Fields tab or
the Saved Values tab to carry out a search based on your customized list of search fields.

If the selected category does not use States, then a message opens indicating this. 
For more information about reviewing service orders and selecting states, see 
“Searching with the Service Order Management Browser” on page 203.
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Searching with the Resource Calendar

You use the Resource Calendar to search for a particular resource and determine how much 
of the resource (that is, how many individual items) is needed for a specific day or month in 
a specific year. For example, how many slices of key lime pie are needed in November, 
2012? You can use the results of the search to assist you in managing the counts of the 
resources that your organization must ensure are available for scheduled events. When you 
carry out a search in the Resource Calendar, you can carry out a basic search or an advanced 
search. A basic search is based on the basic information that you specify for a resource item 
when you first create it, such as its category and status. An advanced search is a field level 
search that is carried out the booking level, the booking detail level, the booking detail item 
level, the reservation level, the service order level, or any combination of these. For example, 
in an advanced search, you can specify criteria as granular the date that the service order 
reminder was added. You can open a resource item that has been returned in the search 
results in the Navigator, and edit the item if needed.

To carry out a search in the Resource Calendar

1. On the EMS main menu, click Reservations > Reservations > Resource Calendar.

The first time that the Resource Calendar opens, the Filter tab is set by default to a Basic
search; otherwise, the Filter tab is set to the search type (Basic or Advanced) that you
last carried out.

Figure 4-12: Resource Calendar, Basic search
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2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and
then continue to one of the following:

• “To carry out a basic search in the Resource Calendar” below.

• “To carry out an advanced search in the Resource Calendar” on page 199.

To carry out a basic search in the Resource Calendar

1. Leave the Month and Year set to the default values (current month and year), or
optionally, enter different values as needed.

2. Enter the search criteria.

3. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, When Filtering By Specific
Room, and Change Calendar Day Count Color.

4. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The total number
of resources in all bookings that meet the search criteria is indicated on the dates on
which the events occur. The current day’s date is outlined in black. See Figure 4-13 on
page 198.

Field Description

Include Cancelled By default, search results are not set to show resource items for 

canceled reservations. Select this option to search for resource items in 

canceled reservations as well.

Category Select a specific category (booking detail).

Resource Available only if you select a category that is a resource or service order. 

Select a specific resource item.

Status The default value is set to (all). You can leave this value as is, or you 

can select a specific booking status.

By default, the number of resources is indicated in red unless you selected a 
different color for the Change Calendar Day Count Color. Any color that you pick 
here is carried over to the same option for the Calendar.
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Figure 4-13: Resource Calendar page, Results tab

5. Optionally, do one or more of the following:

• Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-14: Resource Calendar page, Results tab with list of events for selected dates

• The lower pane on the Results tab is an EMS Browser page. See “An EMS Browser
Page” on page 25 for all the features that are available for this tab.

• Double-click an event entry on the Results tab to open the event in the Navigator.

• Click Print to open a message that asks you if you want to open or save the
Resources.pdf file. Select the option that best fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select a directory in which to save the file.
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• Click Export to export the search results to a Microsoft Excel spreadsheet.

A message opens, asking you if you want to print or save the Resources.xls file.
Select the option that best fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position, sort order, and so on)
are reset to their default values after you click Refresh or carry out a new search.

To carry out an advanced search in the Resource Calendar

Figure 4-15: Resource Calendar, Advanced search
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1. Optionally, do one or both of the following:

• The default values for the month and year are the current month and year. You can
enter different values as needed.

• Click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, When Filtering By
Specific Room, and Change Calendar Day Count Color.

2. For each field level option by which to carry out the search:

• Select the field level option, and then click the Move button (>).

• When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

3. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The total number
of resources in all bookings that meet the search criteria is indicated on the dates on
which the events occur. The current day’s date is outlined in black. See Figure 4-16 on
page 201.

To filter the list of available fields, in the Field Search field, enter a search string. 
Your search is limited to the exact order of the characters in the string, but the 
search string is not case-sensitive and it can appear anywhere in the search 
results. For example, a search string of add returns Added by, Date Added, and 
Group Address Line 1. The list of fields that meet your search criteria is 
dynamically updated as you enter your search criteria.

If you have specific fields and/or values by which you always want to carry out a 
search, then you can set up these fields to be your Favorite fields. See “To set up 
favorite fields for a Resource Calendar search” on page 202.

By default, the number of resources is indicated in red unless you selected a 
different color for the Change Calendar Day Count Color.
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Figure 4-16: Resource Calendar, Results tab

4. Optionally, do one or more of the following:

• Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-17: Resource Calendar page, Results tab with list of events for selected dates

• The lower pane on the Results tab is an EMS Browser page. See “An EMS Browser
Page” on page 25 for all the features that are available for this tab.

• Double-click an event entry on the Results tab to open the event in the Navigator.

• Click Print to open a message that asks you if you want to open or save the
Resources.pdf file. Select the option that best fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select a directory in which to save the file.
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• Click Export to export the search results to a Microsoft Excel spreadsheet.

A message opens, asking you if you want to print or save the Resources.xls file.
Select the option that best fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

5. Click Close.

Any changes that you made to the search results columns (position, sort order, and so on)
are reset to their default values after you click Refresh or carry out a new search.

To set up favorite fields for a Resource Calendar search

If you have specific fields and/or values by which you always want to carry out a Resource 
Calendar search, you do not have to filter the list of fields on the All Fields tab for every 
search. Instead, you can set up each of these fields to be a favorite field with a specific value 
or limit if needed. 

1. Open the Resource Calendar, and make sure that the Advanced search features are
displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields
tab, and then click Add to Favorites.

The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on
the Filter dialog box.

The next time that you carry out a search, you can simply open the Favorite Fields tab or
the Saved Values tab to carry out a search based on your customized list of search fields.
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Searching with the Service Order Management 

Browser

You use the Service Order Management browser to search for and view the resources with 
and without service orders for all bookings on a particular day as well as the current state of 
the resources and their Reviewed status. After viewing a resource, if applicable, you can 
change the state for a resource. You can review a resource, or you can mark a resource as 
unreviewed. You can also open a resource in the Navigator, and edit it if necessary.

To search with the Service Order Management browser

1. On the EMS toolbar, click the Manage Services icon .

The Service Order Management page opens. When this page first opens, the display is
static and you must manually refresh it. To set options for automatically refreshing the
page’s display, go to Step 2; otherwise, go to Step 4.

Figure 4-18: Service Order Management page

A category state is a process phase, or state, that describes the movement of a 
resource in the category through your organization’s processes, for example, 
“Unassigned,” “Assigned,” “Out for Delivery,” “In Prep,” and so on. Your EMS 
administrator configures the states that are specific to your organization. Contact 
your EMS administrator for assistance with states.
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2. Click Options.

The Options dialog box opens.

Figure 4-19: Options dialog box

3. Edit the display options as needed for the Manage Services page, and then click OK to
apply these changes.

4. To filter the search results, do one or more of the following:

• Leave the Date set to the default value (the current day’s date), or select a different
date.

• On the Building dropdown list, leave the value set to the default value (all
buildings), or select a specific building, area, or view.

• On the Category dropdown list, select the category by which to search.

• In the Status pane, select one or more specific booking statuses, or select (all)
statuses.

5. Click Refresh.

A list of all bookings that meet your search criteria is displayed in the upper pane of the
page.

• If states are assigned to any of the resources in a booking, then the name of the state
and if applicable, its color, is displayed in the State column for the booking. If a
resource for a booking is of the type to which states can be assigned, but none has
been assigned, then (none) is displayed in the State column for the booking.

• If a resource has been reviewed for a booking, then “Yes” is displayed in the
Reviewed column for the booking.

• If your Options are set to show deleted service orders/items, then an “x” appears
next to the booking for which the orders/items were deleted and a single line through
the booking is displayed.

See Figure 4-20 on page 205.
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Figure 4-20: Service Order Management page with results

6. Optionally, do one or more of the following:

• The upper pane on the Service Order Management page is an EMS Browser page. 
See “An EMS Browser Page” on page 25 for all the features that are available for 
this pane.

• To view the resources (individual items) for a booking, select the booking. The 
resources are displayed on the Items tab in the lower pane of the page. See Figure 
4-20 above.

• To open an event in the Navigator and edit the resource item as needed, double-click 
the event entry on the Results tab. See  , “The Navigator,” on page 65.

Figure 4-21: Booking with Changed icon

• To mark a resource for a booking as reviewed, select the booking, or CTRL-click to
select multiple bookings, and then click Reviewed. A message opens asking you if
you are sure that you want to mark the resource as reviewed. Click Yes to close the
message. “Yes” is displayed in the Reviewed column for the booking.

• To reverse the Reviewed status for a resource in a booking, select the appropriate
booking, or CTRL-click to select multiple bookings, and then click Unreviewed. A
message opens asking you if you are sure that you want to mark the selected
resource as unreviewed. Click Yes to close the message. “Yes” is cleared from the
Reviewed column for the booking.

If you edit any information for a resource (quantity, notes, and so on) or the 
service order (service order time, estimated count, or so on) for a booking, then a 
Changed icon is displayed next to the booking.

Changed icon



206

 
Search Tools

• To change the state of the resources for a booking, select the booking, or
CTRL-click to select multiple service orders of the same category, and then click
Change State. A Change State dialog box opens. The dialog box lists all the
available states for the resource. Select the new state for the resource on the State
dropdown list.

• To view the changes made to the resources for a booking, select the booking, and
then open the Changes tab in the lower pane of the page.

Figure 4-22: Viewing changes to a resource in the Service Order Management page

• Click Print to open a message that asks you if you want to open or save the Service
Order Management.pdf file. Select the option that best fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different
file name and save the file after you view it.

• If you click Save, you must select a directory in which to save the file.

• The Items tab and the Changes tab in the lower pane of the Service Order
Management page have some of the same basic features as an EMS Browser page.
You can rearrange the column order by dragging a column to a new location using
the column heading, you can change the width of the data columns, and you can sort
the data columns on a tab in either ascending or descending sort order. See “An EMS
Browser Page” on page 25.

• Make any necessary changes to the search criteria, and then click Refresh to repeat
the search based on the new search criteria.

If the selected category does not use States, then a message opens indicating this. 
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The Dashboard is a page that centralizes critical information about reservations in a single 
location. The information that is displayed on this page, including notifications, reminders, 
web reservations and so on, provides you with the necessary input to manage your work in 
the EMS Web Client.

This chapter covers the following topics:

• “Overview of the EMS Dashboard and Dashboard Options” on page 209.

• “Notifications Tab” on page 212.

• “Reminders Tab” on page 214.

• “Web Reservations Tab” on page 221.

• “Web Requests Tab” on page 222.

• “Wait List Tab” on page 226.

• “Reconfirm Dates Tab” on page 227.

• “Building Hours Exceptions Tab” on page 228.
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Overview of the EMS Dashboard and 

Dashboard Options

The Dashboard is a page that centralizes critical information about reservations in a single 
location. The information that is displayed on this page provides you with the necessary 
input to manage your work in the EMS Web Client. By default, when the page first opens, 
seven tabs are available—Notifications, Reminders, Web Reservations, Web Requests, Wait 
List, Reconfirm Dates, and Building Hours Exceptions. If any tab on the page has at least 
one record displayed on it, then, by default, when you log into the EMS Web Client, the 
Dashboard page opens and the Dashboard icon on the main toolbar flashes briefly. An 
asterisk (*) is displayed to the right of the tab name. All the tabs in the upper pane of the page 
have some of the basic features of an EMS Web Client Browser page. You can rearrange the 
column order by dragging a column to a new location using the column heading, you can sort 
the data columns on a tab in either ascending or descending sort order, and you can change 
the width of the data columns. 

Figure 5-1:  Dashboard page

For information about working with data columns on a Dashboard tab, see “An 
EMS Browser Page” on page 25.

You can change the default behavior of the Dashboard in the Dashboard Options 
dialog box. See “Dashboard options” on page 210. You can also click the 
Dashboard icon  at any time to open the Dashboard page.
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Dashboard options

The appearance and functioning of your Dashboard page are determined by the values that 
you set for the Dashboard options. To view and if needed, modify these values, in the upper 
right corner of the Dashboard page, click Options to open the Dashboard Options dialog box.

Figure 5-2:  Dashboard options dialog box

Option Description

Open Dashboard At Startup 

If Items Exist

Selected by default. The Dashboard page opens automatically after 

you log into EMS if any tab displays at least one item.

• Show Reminders

• Show Web Reservations

• Show Web Requests

• Show Wait List

• Show Reconfirm Dates

• Show Building Hours

Exceptions

Selected by default. Indicates the tabs that are to be displayed on 

the Dashboard page. 

“Thru Today” includes xx 

Days Prior to Today

Indicates how far into the past that reminders are to be displayed in 

the “Thru Today” view. The default value is seven.
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Activate Indicator For:

• Notifications

• Reminders

• Web Reservations

• Web Requests

Set on a per tab basis. Indicates when the Dashboard icon on the 

toolbar is to flash if at least one item is displayed on any tab. Values 

are:

• Automatically—Immediately when there is at least one record

that is displayed on the indicated tab, even when you are

working in EMS.

• At Startup Only

• Never

Activate Flashing Indicator 

For:

• Wait List

• Reconfirm Date

Reminders

• Building Hours

Exceptions

Set on a per tab basis. Indicates when the Dashboard icon on the 

toolbar is to flash if tasks on the tab require your attention. Values 

are:

• At Startup Only

• Never

Option Description
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Notifications Tab

Your EMS administrator can configure notification rules to alert you or groups of which you 
are a member when additions or modifications have been carried out in the EMS database 
such as the creation or modification of a booking, the creation or modification of a service 
order, the creation of a new web account, and so on.

Figure 5-3:  Dashboard page, Notifications tab

When the Notifications tab first opens, all the notification rules that include you are listed in 
the Notification Rule pane (upper left pane) of the tab. Next to each rule, the number of new 
notifications (notifications with the current day’s date) is displayed. The tab is interactive. 
You can:

• Select a rule to view all unreviewed notifications for future bookings (the default view).

• Select a rule, and under Show, select Reviewed to view all reviewed notifications for
future bookings.

• Select a rule, and under Show, select Old to view all notifications for past bookings.

• Select a notification to view detailed information about the notification (such as new
bookings, the changes made to a booking, and the users who were notified of the changes)
in a pane at the bottom of the page.
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• Select Show New Only to show only new notifications (notifications with the current
day’s date) for the notification rules.

• Select a notification, and then click Reviewed to mark a notification as “Reviewed.”

• Select a notification and then click Go To to open the item to which the notification refers.

• If the notification is attached to a reservation, booking, or booking detail, then the
reservation opens in the Navigator, and the appropriate folder (Reservation, Booking,
or Booking Detail) is automatically selected.

• If the notification is attached to a group, then the Group page opens, with the group
information displayed in the page.

• Click Refresh to check for notifications that have been issued since you opened the
Dashboard.

• Select a notification, or CTRL-click to select multiple notifications, and then click Delete
to delete the notifications from the Notifications tab.
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Reminders Tab

A comment is a text entry that explains or clarifies a reservation, booking, group, or service 
order. A reminder is a comment that has a due date associated with it. The Reminders tab 
displays all the reminders for which you are the responsible user and that, by default, have a 
due date through the current day’s date. 

Figure 5-4:  Dashboard page, Reminders tab

The tab is interactive. You can:

• View a list of reminders for other responsible users and/or set the criteria for which
reminders that you want to view. See “To change the Reminders tab view” on page 215.

• Create an unattached reminder. “To create an unattached reminder” on page 216.

• Edit a reminder. “To edit a reminder” on page 217.

• Delete a reminder. “To delete a reminder” on page 217.

• Print a reminder. “To print a reminder” on page 218.

• Go to the item to which a reminder is attached. See “To go to the item to which a reminder
is attached” on page 218.

• Complete a reminder. See “To complete a reminder” on page 218.

• Reassign multiple reminders from one EMS user to another. See “To reassign multiple
reminders from one EMS user to another” on page 219.
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To change the Reminders tab view

By default, when the Dashboard page first opens, the Reminders tab displays all the 
reminders for which you are the responsible user and that, by default, have a due date 
through the current day’s date. You can do one or more of the following to change this view:

• To view the reminders for which other user’s are responsible, simply select the user or
users in the Responsible User pane.

• To view only a specific group of reminders for which you or others are the responsible
users, change the viewing criteria.

Option Description

View View reminders that have the indicated due date. The default value is 

Thru Today. If a value from the pre-configured list does not meet your 

needs, then select (user specified) and in the Date Due fields, enter at 

least a Starting due date. The Ending due date is optional.

Reminder Type The default value is (all). 

Attached To The default value is (all). To view reminders that are not attached to any 

item (reservation, booking, group, or service order), select (none). See 

“To create an unattached reminder” on page 216.

Search in Text Enter the string by which to search for specific reminders. (The search is 

carried out on the Notes field for the reminder.) The search is not-case 

sensitive and the search string can be found anywhere in the Notes. For 

example, “cat” returns reminders that have “catering” or “Mary’s 

catering” in the Notes field.

Date Completed Available only if Exclude Complete is not checked.

Exclude Completed Selected by default. Clear this option to display completed reminders in 

the Reminders list. To display completed reminders that meet the other 

viewing criteria, regardless of their completion dates, leave the Date 

Completed fields blank; otherwise, to view completed reminders that 

were completed by a specific date, you can enter a Starting date or a 

date range in the Date Completed fields. 

Hide Cancelled Not selected by default. Select this option to display canceled reminders 

in the Reminders list.
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To create an unattached reminder

When you create reminder on the Navigator, the reminder is attached to a specific 
reservation, booking, or booking detail. Similarly, when you create a reminder on the Groups 
page, the reminder is attached to a specific group. If needed, however, you can create a 
reminder that addresses just your general business needs and is not attached to any specific 
item. For example, you can create a reminder about “preparing for your organization’s yearly 
safety inspection.” Any reminder that you create from the Reminders tab on the Dashboard 
page is an unattached reminder.

1. Click New.

The Reminder dialog box opens.

Figure 5-5:  Reminder dialog box

2. Do one of the following:

• Select a Reminder Type.

• If none of the pre-configured Reminder Types meets your working needs, then select
(user-specified), and in the Description field, enter a description for the reminder
type.

The Responsible User field is populated with your User ID and the Date Due field is 
populated with the current day’s date.

3. Optionally, change the value for the Responsible User, the Date Due, or both.

4. If you are completing the reminder today, select a Date Completed; otherwise, leave this
field blank. (This field is populated automatically when you or another user completes
the reminder. See “To complete a reminder” on page 218.)

5. Optionally, in the Notes field, enter any further explanation or information about the
reminder.
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6. Click OK.

The Reminder dialog box closes. The newly created reminder is not attached to an item.
It might or might not be displayed in the Reminders list depending on the values that you
have set for filtering the display.

To edit a reminder

1. On the Reminders list, select the reminder that you are editing, and then click Edit.

The Reminder dialog box opens. The dialog box is populated with the current
information the reminder.

2. Edit the reminder as needed.

3. Click OK.

The Reminder dialog box closes. If the reminder is attached to an item such as a
reservation, then the reminder remains attached; otherwise, it is saved as an unattached
reminder.

To delete a reminder

You can delete any reminder (attached or unattached) regardless of its due date and 
regardless if it is completed.

1. On the Reminders list, select the reminder that you are deleting, and then click Delete.

A message opens asking you if it is OK to delete the reminder.

2. Click Yes.

The message closes and the reminder is deleted.
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To print a reminder

1. On the Reminders list, select the reminder that you are printing, and then click Print.

A message opens, asking you if you want to open the Reminders.pdf file or save the file?

Figure 5-6:  Reminders file message

2. Select the option that best fit your working needs.

• If you click Open, the reminder opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

To go to the item to which a reminder is attached

On the Reminders list, select a reminder, and then click Go To.

• If the reminder is attached to a reservation, booking, or booking detail, then the
reservation opens in the Navigator, and the appropriate folder (Reservation, Booking, or
Booking Detail) is automatically selected.

• If the reminder is attached to a group, then the Group page opens, with the group
information displayed in the page.

To complete a reminder

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple
reminders that you are completing.

2. Click Completed.

A message opens asking you if it is OK to set the selected reminders as completed.

3. Click Yes.

The message closes. The reminders are completed with a date equal to the current day’s
date. The reminders might or might not be displayed in the Reminders list depending on
the values that you have set for filtering the display.

The Attached To column for the reminder must state anything other than 
“Unattached.”
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To reassign multiple reminders from one EMS user to another

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple
reminders that you are reassigning.

2. Click Reassign.

A Find Users dialog box opens. You use the options on this dialog box to search for the
users to whom you are reassigning the reminders.

Figure 5-7:  Find Users dialog box

3. Do one of the following;

• To lists all the users for your EMS implementation, click the Search icon .

• To search for a specific user, enter a search string in the Find field, and then click the

Search icon .

The list of users that meet your search criteria is displayed in the dialog box.

4. Click the Add icon  next to the appropriate user.

A message opens, asking you if you are sure that you want to reassign the selected
reminders to the user.

The search string is limited to the exact order of the characters in the string, but 
the search string is not case-sensitive and it can appear anywhere in the search 
results. For example, a search string of Admin returns both Admin users and 
SysAdmin.
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5. Click OK.

The Find User dialog box and message close and the reminder is reassigned.
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Web Reservations Tab

The Web Reservation tab displays any reservation that was submitted through VEMS for 
web process templates that are set to Self Serve mode. 

Figure 5-8:  Web Reservations tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You
can view reservations for the indicated due date. The default value is Thru Today. If
a value from the pre-configured list does not meet your needs, then select (user
specified) and in the Date Due fields, enter at least a Starting due date. The Ending
due date is optional.

• Select the reservation in the Reservations list, and then click Go To to open the
reservation in the Navigator.
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Web Requests Tab

The Web Requests tab displays any reservation that was submitted through VEMS for web 
process templates that are set to Request mode. A request that has not yet been processed has 
a status of Pending.

Figure 5-9:  Dashboard page, Web Requests tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Room options are displayed on the Room list at the top of the right pane of the tab.
To enable the Room list, you must select a specific building.

• Edit a web request, including processing it. See “To edit a web request” on page 223.

• Delete a web request. See “To delete a web request” on page 224.

• Print a web request. See “To print a web request” on page 225.
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To edit a web request

1. Select the web request that is you are editing, and then click Edit.

The Web Request dialog box opens. All of the information that was submitted for the
request through VEMS is displayed in the dialog box. The dialog box always has a
Description tab, a Web Questions tab, and an Audit tab. If the request included resources
or setup notes, it also has a Services tab.

Figure 5-10: Web Request dialog box

2. Do one of the following:

• Edit the request as necessary without processing it, and then click OK. When editing
the request without processing it, optionally, you can do one or more of the
following:

• If you have questions about the request or want to confirm some information
(for example, “Will alcohol be served at the event?”) before you process the
request, you can enter these questions or comments in the Notes field on the
Description tab. A web user can see these notes when viewing the request in
VEMS and you can wait for a response before deciding whether to process the
request.

• In addition, to indicate that you are reviewing the request before you process it,
you can set the status of the request to In Progress on the Description tab. A web
user can see this status when viewing the request in VEMS.

• If the request required questions to be answered on the web, open the Web
Questions tab to see the questions and the user’s answers.

• If the request includes resources, open the Services tab to see what the request
includes. To view the details for each category, double-click a category to
display its associated details in the right pane.
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• To process the request and create a true reservation for the request in your EMS
database, on the Description tab, click Process.

The reservation opens in the Reservation Wizard. Continue to “Making a
Reservation Using the Reservation Wizard” on page 33.

Figure 5-11: Process Web Request Details page

To delete a web request

1. Select the web request, or CTRL-click to select the multiple web requests that you are
deleting, and then click Delete.

A message opens asking you if it is OK to delete the selected web requests.

2. Click Yes.

The message closes. The selected web requests are deleted.

After you create a true reservation using the wizard and the reservation includes a 
request for services, the Process Web Request Details page opens. (See Figure 5-
11 below.) You can process the services immediately using the options on this 
page, or to process the services at a later date, click Cancel to close the page. You 
can then open the reservation on the Web Requests tab, and on the Services tab, 
click Process. 
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To print a web request

1. Select the web request, or CTRL-click to select the multiple web requests that you are
printing, and then click Print.

A Web Requests message opens, asking you if you want to open the Web Requests.pdf
file or save the file?

2. Select the option that best fit your working needs.

• If you click Open, the reminder opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.
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Wait List Tab

The Wait List tab provides you a way of monitoring wait-listed reservations. It also provides 
an indicator when the requested room becomes available.

Figure 5-12: Wait List tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You
can view reservations for the indicated due date. The default value is Thru Today. If
a value from the pre-configured list does not meet your needs, then select (user
specified) and in the Date Due fields, enter at least a Starting due date. The Ending
due date is optional.

• Select the reservation in the Reservations list, and then click Go To open the reservation
in the Navigator.
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Reconfirm Dates Tab

The Reconfirm Dates tab displays reservations that have been booked in a status that 
requires the Reconfirm Date option (for example, a Tentative or Hold status). You use this 
tab as a reminder to reconfirm such reservations.

Figure 5-13: Reconfirm Dates tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You
can view reservations for the indicated due date. The default value is Thru Today. If
a value from the pre-configured list does not meet your needs, then select (user
specified) and in the Date Due fields, enter at least a Starting due date. The Ending
due date is optional.

• Select the reservation in the Reservations list, and then click Go To open the reservation
in the Navigator.
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Building Hours Exceptions Tab

The Building Hours Exceptions tab displays reservations that occur outside configured 
building hours.

Figure 5-14: Building Hours Exceptions tab

The tab is interactive. You can: 

• Select options to filter the reservations that are displayed on the tab. After you select or
edit the filtering options, click Refresh.

• Status and Building/Area/View options are displayed on the left pane of the tab. You
can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and
views in a single step.

• Date options are displayed on the View list at the top of the right pane of the tab. You
can view reservations for the indicated due date. The default value is Thru Today. If
a value from the pre-configured list does not meet your needs, then select (user
specified) and in the Date Due fields, enter at least a Starting due date. The Ending
due date is optional.

• Select the reservation in the Reservations list, and then click Go To open the reservation
in the Navigator.
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A group is an entity for which reservations are made at your facilities. A group is one of the 
four core data items that your EMS administrator must configure so that you can make 
reservations. A group can be an internal or external entity and it can be an organization or an 
individual. A contact is a person who serves as the coordinator or focal point for a group. 

This chapter covers the following topics:

• “Searching for and Configuring Groups” on page 231.

• “Configuring Additional Information for a Group” on page 238.

• “Configuring Contacts for a Group” on page 254.

• “Editing Group Information” on page 262.

• “Importing Groups” on page 270.

• “Working with Reservations for a Group” on page 271.

• “Printing and Exporting Group Information” on page 277.
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Searching for and Configuring Groups

A group is an entity for which reservations are made at your facilities. A group can be an 
internal or external entity and it can be an organization or an individual. A group must be 
configured before you can make reservations for it in EMS. Optionally, if you want to first 
confirm that a group has not already been configured, then you can search for the group.

To search for a group and/or contact

1. On theEMS toolbar, click the Groups icon .

The Groups page opens. The Filter tab is the active tab.

Figure 6-1:  Groups page, Filter tab

Typically, your EMS administrator carries out basic configuration of the groups 
for which you need to make reservations. You always have the option of modifying 
any group that your EMS administrator has configured and you always have the 
option of configuring new groups when needed.

Your organization might use a different term (such as client, customer, and so on) 
to identify the entities for which reservations are made at your facilities. Contact 
your EMS administrator if you need assistance in clarifying this term. 
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2. By default, when the Results tab opens after you carry out your first search, it lists the
first 1000 groups that are currently configured in your EMS database and that have a
status of Active. Optionally, to change the number of records that are displayed in the
Groups page before you carry out your first search, click Options, and then on the Group
Options dialog box, select a different number of records to return.

Figure 6-2:  Group Options dialog box

3. Enter your search criteria.

4. Click Get Data.

The Results tab opens with a list of search results that meet all your search criteria.

Option Description

Display • Groups—Display all groups that meet your search criteria on the Results tab.

• Contacts—Display all contacts that meet your search criteria on the Results

tab.

Note: When a list of contacts is displayed, the contact’s group is also displayed.

Search Fields • Starts with—The string is not case-sensitive, but your search is limited to the

exact order of the characters in the string, and the string must begin with the

information for which you are searching. For example, Assoc returns

Association of Broadcasters but not Biomedical Student Association.

• Contains—Your search is limited to the exact order of the characters in the

string, but the string is not case-sensitive, and the string can be found

anywhere in your search results. For example, Assoc returns both Association

of Broadcasters and Biomedical Student Association.

Group Fields are available if you select Groups for Display. Enter values as needed in 

any or all fields.

Contact Fields are available only if you select Contacts for Display. Leave all fields set to 

their default search values to search for all active contacts that are currently 

configured in your EMS database, or enter values as needed in any or all fields.

Note: If you select Contact, then both the Group fields and the Contact fields are 

available for searching. If you enter data in both sets of fields when you are 

searching for a contact, then your search criteria must be met for both the 

contact and the contact’s group to be displayed on the Results tab.

Note: To reset the Filter at any time to its default settings, click Reset Filter.
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5. To further filter the display on the Results tab, in the Search field, enter a search string,
and then click anywhere on the Groups page

The list of groups that meet your search criteria is displayed on the Results tab.

To configure groups

Typically, your EMS administrator carries out basic configuration of the groups for which 
you need to make reservations. You always have the option of modifying any group that your 
EMS administrator has configured and you always have the option of configuring new 
groups when needed.

1. On the EMS toolbar, click the Groups icon .

The Groups page opens. The Filter tab is the active tab.

Figure 6-3:  Groups page, Filter tab

Your search is limited to the exact order of the characters in the string, but the 
search string is not case-sensitive and it can appear anywhere in the search 
results. For example, a search string of Assoc returns both Association of 
Broadcasters and Biomedical Student Association.

Remember that before you configure a group, you might want to search for the 
group to verify that it has not already been configured. See “To search for a group 
and/or contact” on page 231.
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2. Open the Results tab, and then click New.

The Group dialog box opens. The Group tab is the active tab.

Figure 6-4:  Group dialog box, Group tab

3. Enter the summary information for the new group.

The only required information is the group name. All other information on all tabs 
is optional and can be added at a later date when needed.

Field Description

Name Required field. The name of the group.

Note: The name can be a maximum of 50 characters, including spaces.

Address

City

ST

Country

Zip

The street or mailing address for the group.

International Select this option to drop the State and Zip fields for an international group.

Group Type Pick a group type.

Note: If calculations have been assigned to a group type, then these 

calculations are applied only to new groups of this type.

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a dropdown list available on which 

you can select a different value (Fax, Mobile, Other, or Phone) for the 

field label, or you can enter a user-defined value. To enter a 

user-defined value, double-click the current field label to select it, and 

then enter the user-defined value over the selected label. 
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4. Optionally, do one or both of the following; otherwise, go to Step 5.

• Open the Billing Information tab and add the default billing information for the
group.

Figure 6-5:  Group dialog box, Billing Information tab

Email Address The email address for the group.

Note: If your computer is connected to a network, click the Search icon 

to open a Global Address Lookup dialog box and search for the email 

address.

URL The URL for the group’s website.

Note: Web users can link to this group's web site on VEMS.

Default Contact Populated with the name of the default contact for the group after you have 

defined default contacts for the group.

Require Contacts Select this option if the group is to always require a contact when a 

reservation is being made for the group.

VIP Select this option if the group is to be designated as a VIP group.

Display on Web Select this option if users are to be able to select the group on the Group 

Lookup page in VEMS.

Inactive Leave this option blank to add the group as an active group. Select this 

option to inactivate the group.

The values that you specify here are the default values that are applied when a 
new reservation is made for the group. Any EMS user can change these values if 
needed.

Option Description

Pricing Plan Pick a pricing plan.

Payment Type Pick a payment type.

Salesperson Pick a salesperson.

Event Coordinator Pick an event coordinator. 

Sales Category Pick a sales category.

Field Description
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• Open the Other tab and add any other identifying information for the group as
needed.

Figure 6-6:  Group dialog box, Other tab

Status The status is a way to indicate the standing or ranking of the group. The 

default values are the following:

• OK—A reservation can be made for the group. (In your organization,

this status could indicate that the group is current in payments due.)

• Warning—If a group status is set to Warning, then a Warning

message opens when you make a reservation for the group. It does

not, however, prevent a reservation from being made for the group.

• Bad—If a group status is set to Bad, then reservations cannot be

made for the group.

Billing Reference 

Number

You can manually enter data into the field, or you can click the Search 

icon  to open a master list of billing reference numbers and select a 

reference.

Note: To define a list of eligible billing references that are specific to the 

group, see “Configuring Additional Information for a Group” on 

page 238.

PO Number You can manually enter data into the field, or you can click the Search 

icon  to open a master list of PO Numbers and select a PO number.

Note: To define a list of eligible PO numbers that are specific to the 

group, see “Configuring Additional Information for a Group” on 

page 238.

External Reference Links the group to a web user record and/or HR Toolkit.

Account Pick an account.

Option Description

Network ID The Windows login for the group.

Personnel Number Organization number for the group.

Badge Number Badge number for the group.

Other ID Any secondary ID for the group.

Option Description
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5. Click OK.

The Group dialog box closes and you return to the Groups page with the newly
configured group automatically selected in the page.

6. Optionally, double-click this group to open a group-specific page.

You can use the options on this page to configure additional information for the group.
See “Configuring Additional Information for a Group” on page 238.

Figure 6-7:  Example of a group-specific page
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Configuring Additional Information for a Group

After you have configured a new group in your EMS database with the basic group 
information (group identifying information, billing information and/or other information), 
you have the option of configuring additional information for the group. You can:

• Create a web user from the group. See “To create a web user from a group” on page 238.

• Assign the group to a web user. See “To assign the group to a web user” on page 241.

• Add reminders to the group. See “To add a reminder to a group” on page 243.

• Add comments to the group. See “To add a comment to a group” on page 244.

• Add attachments to the group. See “To add attachments to a group” on page 246.

• Add user defined fields to the group. See “To add user defined fields to a group” on page
248.

• Assign calculations to the group. See “To assign calculations to a group” on page 249.

• Configure a master list of group-specific billing reference numbers. See “To configure a
list of billing reference numbers” on page 251.

• Configure a master list of group-specific PO numbers. See “To configure a list of PO
numbers” on page 252.

To create a web user from a group

A web user is a registered user who can submit requests for reservations or schedule 
reservations in VEMS. When you add a new group in your EMS database, you decide the 
“level” of the group that you are adding. For a group that is added at the individual 
(personnel/employee) level, you might also need to create a web user from the group. This 
user can then create and view reservations on behalf of a group or groups in VEMS. You can 
create only one web user from a group. When you create a web user, you can also specify one 
or more delegates for the web user. A delegate is a web user who can create and view 
reservations on behalf of another web user. 

1. Open the Groups page and search for the group for which you are creating the web user.
See “To search for a group and/or contact” on page 231.

When you select a configuration item (contacts, reminders, and so on) in the left 
pane in a group-specific page, the right pane for the page is an EMS Web Client 
Browser page. See “An EMS Browser Page” on page 25.

For information about adding a contact to a group, see “Configuring Contacts for 
a Group” on page 254. For information about editing a contact for a group, see 
“Editing Group Information” on page 262. For information about emailing a 
group, see “Sending Email from EMS” on page 367.
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2. On the Groups page, select the group, and then click Tools > Create Web User.

A group-specific page opens. The Web User tab is the active tab. See Figure 6-8 on page
239.

Figure 6-8:  Group-specific page, Web User tab

3. Enter the information for the web user.

The User Defined Fields tab displays the questions that a web user was required 
to answer when the user requested to create an account through VEMS and it is 
not relevant to the procedure that is described below.

Ideally, you should enter all the necessary information for your web user before 
you save the web user; however, at any time if you need to access your web user, 
on the EMS main menu, click Configuration > Web > Web Users.

Field Description

Name Automatically populated after you select the group from the Groups 

page.

Password The password that a web user must enter to log in to VEMS.

Email address If this information has been entered in the Groups page for the group, 

then this field is automatically populated after you select the group from 

the Groups page. If the field is blank, you must enter the full email 

address for the user. (The user must enter this address to log in to 

VEMS.)

Phone/Fax Optional fields. If this information has been entered for the group, then 

these fields are automatically populated after you select the group from 

the Groups page. If the fields are blank, you can enter values if needed.
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4. Open the Process Templates tab and on the Available list, select the web process
template, or CTRL-click to select the multiple templates to which you are assigning this
user, and then click the Move button (>) to move the selected templates to the Selected
list.

5. Open the Groups tab and do one of the following to specify the groups on whose behalf
the web user can view and make reservations in VEMS.

• The group (web user) is selected by default. You can leave this group in the Selected
list, or you can select the group and click the Remove button (<).

• Specify any combination of search criteria for the Find field and Group Type, and
then click Display to produce a list of all groups that meet the criteria. In the
Available list, select a group, or CTRL-click to select multiple groups, and then click
the Move button (>) to move the selected groups to the Selected list.

Notes Optional field.

External Reference Optional field. Links the web user to a group and/or HR Toolkit.

Network ID Optional field. The web user’s network ID.

Email Opt Out Select this option if the web user is not to receive automatic emails 

(such as reservation summary emails) from VEMS. The user will still 

receive manually sent emails.

Status Required field. Select the status for the web user:

• Active—The web user can log in to VEMS.

• Inactive—The user cannot log in to VEMS and is instructed to contact

the EMS administrator.

• Pending—The web user cannot log in to VEMS and is informed that

he/she must check back at a later time.

Security Template Required field. This determines the web user's access to the system—

the menu items that the user can see and the information that the user 

can view in a tooltip when 'rolling-over' an event in VEMS.

Time Zone Required field. Select the time zone for the user.

A web process template defines the functions that are available to each type of web 
user in VEMS when the user is submitting a request for a reservation. 

If you leave the Find field blank, then a list of all currently active groups for the 
selected group type is displayed. If you enter a search string in the Find field, the 
string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, And returns Anderson, Scott, but not Cooper, Anderson. 

Field Description
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6. Open the Delegates tab, and on the Search by dropdown list, do one of the following to
specify the delegates for the web user:

• Leave the Find field blank, and then click Display to open a list of all currently
available web users. Select a user, or CTRL-click to select multiple web users, and
then click the Move button (>) to move the selected web users to the Selected list.

• On the Search By dropdown list, select the option by which to search (Email
Address or User Name), and in the Find field, enter the string by which to filter your
search, and then click Display. Select a web user, or CTRL-click to select web
multiple users, and then click the Move button (>) to move the selected users to the
Selected list.

7. Click OK.

The dialog box for creating a web user closes and a message opens indicating that the
web user was created successfully.

8. Click OK to close the message and return to the Groups page.

To assign the group to a web user

When you add a new group in your EMS database, you should also assign the group to a web 
user. This web user can then create and view reservations on behalf of the group in VEMS. 
You can assign a group to one or more web users.

1. Open the Groups page and search for the group to which you are assigning the web user.
See “To search for a group and/or contact” on page 231.

2. On the Groups page, select the group, and then click Tools > Assign to Web Users.

The Assign Group dialog box opens. See Figure 6-9 on page 242.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, if searching by Email Address, a search string of bob 
returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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Figure 6-9:  Assign Group dialog box

3. Do one of the following to select the web users that are being assigned to the group:

• Leave the Find field blank, and then click Display to open a list of all currently
active web users. Select the web user, or CTRL-click to select multiple web users,
and then click the Move button (>) to move the selected web users to the Selected
list.

• In the Search By dropdown list, select the option by which to search (Email Address
or User Name) and then in the Find field, enter the string by which to filter your
search, and then click Display. Select the web user, or CTRL-click to select multiple
web users, and then click the Move button (>) to move the selected users to the
Selected list.

4. Click Finish.

A message opens indicating that the group was assigned successfully.

5. Click OK to close the message and return to the Groups page.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and it must begin with the information for which you are 
searching. For example, if searching by Email Address, a search string of bob 
returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.



243

 
Groups and Contacts

To add a reminder to a group

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a 
booking detail that is a service order. A reminder is a comment that has a due date associated 
with it.

1. Open the Groups page and search for the group to which you are adding the reminder.
See “To search for a group and/or contact” on page 231.

2. On the Groups page, select the group, and then click Open.

A group-specific page opens. The group is automatically selected in the page.

3. In the left pane of the group-specific page, select Reminders.

A list of all reminders that are currently configured for the group is displayed in the right
pane of the page.

4. Click New.

The Reminder dialog box opens. The Responsible User field is populated with the your
User ID.

Figure 6-10: Reminder dialog box

5. On the Reminder Type dropdown list, select the type of reminder that you are adding;
otherwise, if none of the pre-configured reminder types meets your working needs,
select (user specified comment), and then in the Description field, enter a description for
the reminder type.

The Date Due field is populated with the current day’s date.

For an example of a group-specific page, see Figure 6-7 on page 237.

The description can be a maximum of 30 characters, including spaces.
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6. Optionally, change the value for the Responsible User, the Date Due, or both.

7. If you are completing the reminder today, select a Date Completed; otherwise, leave this
field blank.

8. Optionally, in the Notes field, enter any further explanation or information about the
reminder.

9. Click OK.

The Reminder dialog box closes. The newly added reminder is automatically selected in
the group-specific page.

To add a comment to a group

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a 
booking detail that is a service order.

1. Open the Groups page and search for the group to which you are adding the comment.
See “To search for a group and/or contact” on page 231.

2. On the Groups page, select the group, and then click Open.

A group-specific page opens. The group is automatically selected in the page.

3. In the left pane of the group-specific page, select Comments.

A list of all comments that are currently configured for the group is displayed in the right
pane of the page.

If you leave this field blank, then it is automatically populated when you or 
another user completes the reminder on the Reminders tab of the Dashboard page. 
See “To complete a reminder” on page 218.

For an example of a group-specific page, see Figure 6-7 on page 237.
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4. Click New.

The Comment dialog box opens.

Figure 6-11: Comment dialog box

5. On the Comment Type dropdown list, select the type of comment that you are adding;
otherwise, if none of the pre-configured comment types meets your working needs,
select (user specified comment), and then in the Description field, enter a description for
the comment type.

6. In the Notes field, enter the comment.

7. Optionally, to alert any EMS user who opens this group or a reservation that is assigned
to this group that this comment has been added to the group, select Alert Users.

8. Click OK.

The Comment dialog box closes. The newly added comment is automatically selected in
the group-specific page.

The description can be a maximum of 30 characters, including spaces.
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To add attachments to a group

An attachment is used to describe any file that you can add to or store on a reservation, a 
booking, or a group. 

1. Open the Groups page and search for the group to which you are adding the attachment.
See “To search for a group and/or contact” on page 231.

2. On the Groups page, select the group, and then click Open.

A group-specific page opens. The group is automatically selected in the page.

3. In the left pane of the group-specific page, select Attachments.

A list of all attachments that have already been added to the group is displayed in the
right pane of the page.

4. Click New.

The Attachment dialog box opens.

Figure 6-12: Attachment dialog box

5. In the Description field, enter a name or description for the attachment.

6. On the Type dropdown list, select the attachment type.

For an example of a group-specific page, see Figure 6-7 on page 237.

To view any attachment in this list, select it, and then click View.

The description can be a maximum of 50 characters, including spaces. If you 
leave this field blank, then it is automatically populated with the name of the file 
after you attach it to the Group.
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7. Click Upload to open the Attachments dialog box, and then click Attach Files to open
the Select File to Upload dialog box and browse to and select the attachment.

The Select File to Upload dialog box closes.

8. Optionally, in the Notes field, enter any pertinent notes for the attachment.

9. Click OK.

The Attachment dialog box closes. The newly added attachment is automatically
selected in the group-specific page.

To add user defined fields to a group

A user defined field (UDF) is a custom field that stores additional data for a group. Typically, 
your EMS administrator configures the types of fields that are available as well as the 
allowed values (text, numeric, and so on) for the fields. When you add a user defined field to 
a group, you must specify a value for the field.

1. Open the Groups page and search for the group to which you are adding the UDF. See
“To search for a group and/or contact” on page 231.

2. On the Groups page, select the group, and then click Open.

A group-specific page opens. The group is automatically selected in the page.

3. In the left pane of the group-specific page, select User Defined Fields.

A list of all UDFs that have already been added to the group is displayed in the right
pane of the page.

4. Click New.

The User Defined Field dialog box opens. See Figure 6-13 on page 249.

For an example of a group-specific page, see Figure 6-7 on page 237.
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Figure 6-13: User Defined Field dialog box

5. On the Field dropdown list, select the UDF that you are adding to the group.

6. In the Value field, enter a value for the UDF.

7. Click OK.

The User Defined Field dialog box closes. The newly added UDF is automatically
selected in the group-specific page.

To assign calculations to a group

Calculations are additional charges that can be applied to billable items (a category, a group, 
a group type, a resource, or a room) such as gratuity or sales tax. When you configure a 
group, you can assign the calculations that are to always apply to the group.

1. Open the Groups page and search for the group to which you are assigning the
calculations. See “To search for a group and/or contact” on page 231.

2. On the Groups page, select the group, and then click Open.

A group-specific page opens. The group is automatically selected in the page.

3. In the left pane of the group-specific page, select Calculations.

The right pane of the group-specific page displays any calculations that have already
been assigned to the group.

For an example of a group-specific page, see Figure 6-7 on page 237.
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4. Click Edit.

The Calculations dialog box opens. The group name is displayed at the top of the dialog
box.

Figure 6-14: Calculations dialog box

5. On the Available list, select the calculation, or CTRL-click to select the multiple
calculations that are to always apply to this group, and then click the Move button (>) to
move the selected calculations to the Selected list.

6. Continue with any other optional configuration for the group as needed; otherwise, click
OK to close the Calculations dialog box and return to the group-specific page.

Your EMS administrator can also assign calculations to a group type. If your EMS 
administrator has already assigned calculations for this group’s type, then these 
calculations are automatically applied to the group. The calculations are 
displayed in the Selected list after you click OK and save the group; however, you 
can always edit these calculations.
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To configure a list of billing reference numbers

You can configure a list of billing reference numbers that are specific to the group.

1. Open the Groups page and search for the group for which you are configuring the master
billing reference numbers list. See “To search for a group and/or contact” on page 231.

2. On the Groups page, select the group, and then click Open.

A group-specific page open. The group is automatically selected in the page.

3. In the left pane of the group-specific page, select Billing Reference.

A list of all currently active billing reference numbers for the group is displayed in the
right pane of the group-specific page.

4. Optionally, to display all billing reference numbers regardless of status, click Show
Inactive.

Any inactive billing reference numbers are displayed in red italics in the right pane.

5. Click New.

The Billing Reference dialog box opens.

Figure 6-15: Billing Reference dialog box

For an example of a group-specific page, see Figure 6-7 on page 237.
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6. Enter the information for the new billing reference number.

7. Continue with any other optional configuration for the group as needed; otherwise, click
OK to close the Billing Reference Number dialog box and return to the group-specific
page.

To configure a list of PO numbers

You can configure a list of PO numbers that are specific to the group. 

1. Open the Groups page and search for the group for which you are configuring the master
PO numbers list. See “To search for a group and/or contact” on page 231.

2. On the Groups page, select the group, and then click Open.

A group-specific page open. The group is automatically selected in the page.

3. In the left pane of the group-specific page, select PO Numbers.

A list of all currently active PO numbers for the group is displayed in the right pane of
the group-specific page.

4. Optionally, to display all PO numbers regardless of status, click Show Inactive.

Any inactive PO numbers are displayed in red italics in the right pane.

Option Description

Billing Reference 

Number

The billing reference number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the billing reference number.

Notes Any other comments or statements that are applicable for the billing 

reference number.

Inactive Leave this option blank to add the reference as an active reference (the 

billing reference number is to be available when a reservation is made 

for the group). Select this option to inactivate the billing reference 

number.

For an example of a group-specific page, see Figure 6-7 on page 237.
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5. Click New.

The PO Number dialog box opens.

Figure 6-16: PO Number dialog box

6. Enter the information for the new PO number.

7. Continue with any other optional configuration for the group as needed; otherwise, click
OK to close the PO Number dialog box and return to the group-specific page.

Option Description

PO Number The PO number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the PO number.

Notes Any other comments or statements that are applicable for the PO 

number.

Inactive Leave this option blank to add the PO number as an active number (the 

PO number is to be available when a reservation is made for the group). 

Select this option to inactivate the PO number.
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Configuring Contacts for a Group

A contact is a person who serves as the coordinator or focal point for a group. You have two 
options for configuring a contact for a group. You can configure a” free form” contact, which 
requires you to manually enter the contact information, or you can configure a contact from 
another group, which means that you do not have to manually enter the contact information. 
Instead, the group information is automatically used for the contact. 

To configure contacts

1. Open the Groups page and search for the group for which you are configuring the
contact. See “To search for a group and/or contact” on page 231.

2. Select the group, and then click Open.

A group-specific page opens. The group is automatically selected in the page.

Figure 6-17: Group-specific page

3. In the left pane of the group-specific page, select Contacts.

A list of all currently active contacts for the group is displayed in the right pane of the
group-specific page.

You can also configure and edit a contact “on the fly” during the reservation 
process. See “Making a Reservation Using the Reservation Wizard” on page 33 
for details.
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4. Continue to one of the following:

• “To configure a contact manually” below.

• “To configure a contact from a group” on page 257.

To configure a contact manually

1. Click New.

The Contact dialog box opens.

Figure 6-18: Contact dialog box

2. Enter the information for the new contact.

Optionally, to display all group contacts regardless of status, click Show Inactive. 
Any inactive contacts are displayed in red italics in the right pane.

Field Description

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including 

spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected. You cannot 

change this value.

Address Populated with the address of the group that you selected. If the contact 

address is not the same as the group address, then clear Use Group 

Address and enter the appropriate values in the Address fields.

International Select this option to drop the State and Zip fields for an international 

group.
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3. Optionally, make sure that the newly created contact is selected so that you can create a
web user from the contact. See “To create a web user from a contact” on page 259.

4. Click OK.

The Contact dialog box closes. The contact is added to the group. The group-specific
page remains open.

Phone 

Fax

The phone number and fax number for the contact. By default, they are 

set to the phone number and fax number for the group, but you can 

always edit these values. 

Note: The Phone and Fax fields have a dropdown list available on 

which you can select a different value (Fax, Mobile, Other, or 

Phone) for the field label, or you can enter a user-defined value. 

To enter a user-defined value, double-click the current field label 

to select it, and then enter the user-defined value over the 

selected label. 

Email Address The email address for the contact.

Note: If your computer is connected to a network, click the Search icon 

 to open a Global Address Lookup dialog box and search for 

the email address.

External Reference Links the contact to an outside program, for example, HR Toolkit, if 

needed.

Notes Any other information that is pertinent for the contact.

Set as Default Select this option if the contact is to be the default contact for the 

selected group. 

Note: If a default contact has been defined for a group, then when you 

specify the group information for a reservation, the Contact field 

is automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a 

selected group at a later date. To do so, select the contact in the 

right pane of the group-specific page, click Set Default, and then 

click Yes at the prompt to set the selected user as the default 

contact. 

Inactive Leave this option blank to add the contact as an active contact. Select 

this option to inactivate the contact.

Field Description
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To configure a contact from a group

1. Click Tools > Click Create Contact from Another Group.

A Lookup dialog box opens.

2. Do one of the following to search for the group that is to be the source of the contact:

• Leave the Find field blank, and then click the Search icon  to open a list of all 
currently active groups in your EMS database.

• In the Find field enter a search string, and then click the Search icon  to return a 
list of groups that meet your search criteria.

• Starts with—The string is not case-sensitive, but your search is limited to the
exact order of the characters in the string, and the string must begin with the
information for which you are searching. For example, Assoc returns
Association of Broadcasters but not Biomedical Student Association.

• Contains—Your search is limited to the exact order of the characters in the
string, but the string is not case-sensitive, and the string can be found anywhere
in your search results. For example, Assoc returns both Association of
Broadcasters and Biomedical Student Association.

3. Click the Add icon  next to the appropriate group to select it.

The Lookup dialog box closes and the Contact dialog box opens. The name of the group
(contact source) is displayed in the Group field and you cannot edit this value. The
remainder of the fields (Contact Name, Address, Phone, and so on) display the
information for the group that you selected in Step 2 of “To configure contacts” on page
254.

Figure 6-19: Contact dialog box
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4. If needed, edit the information for the contact.

5. Optionally, make sure that the newly created contact is selected so that you can create a
web user from the contact. See “To create a web user from a contact” on page 259.

Field Description

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including 

spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected first (the group 

for which you are configuring the contact). You cannot change this 

value.

Address Populated with the address of the contact. If the contact address is the 

same as the group address, then select Use Group Address to 

populated the address fields with the group address; otherwise, you can 

edit these values.

International Not applicable if Use Group Address is selected. Select this option to 

drop the State and Zip fields from the address for an international 

contact.

Phone 

Fax

The phone number and fax number for the group. 

Note: The Phone and Fax fields have a dropdown list available on 

which you can select a different value (Fax, Mobile, Other, or 

Phone) for the field label, or you can enter a user-defined value. 

To enter a user-defined value, double-click the current field label 

to select it, and then enter the user-defined value over the 

selected label. 

Email Address The email address for the contact.

Note: If your computer is connected to a network, click the Search icon 

 to open a Global Address Lookup dialog box and search for 

the email address.

External Reference Links the contact to an outside program, for example, HR Toolkit, if 

needed.

Notes Any other information that is pertinent for the contact.

Set as Default Select this option if the contact is to be the default contact for the 

selected group. 

Note: If a default contact has been defined for a group, then when you 

specify the group information for a reservation, the Contact field 

is automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a 

selected group at a later date. See “To edit the contacts for a 

group” on page 263.

Inactive Leave this option blank to add the contact as an active contact. Select 

this option to inactivate the contact.
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6. Click OK.

The Contact dialog box closes. The contact is added to the group. The group-specific
page remains open.

To create a web user from a contact

A web user is a registered user who can submit requests for reservations or schedule 
reservations in VEMS. When you add a contact to a group in your EMS database, you might 
also need to create a web user from the contact. This web user can then create and view 
reservations on behalf of the contact’s group in VEMS. You can create only one web user 
from a contact. When you create a web user, you can also specify one or more delegates for 
the web user. A delegate is a web user who can create and view reservations on behalf of 
another web user. 

1. If needed, open the group that contains the contact from which you are creating the web
user in the group-specific page. See “To configure contacts” on page 254.

2. In the left pane of the group-specific page, make sure that Contacts is selected.

3. In the right pane of the page, select the contact from which you are creating the web user.

4. Click Tools > Create Web User from Contact.

A contact-specific dialog box opens. The Web User tab is the active tab.

5. Enter the information for the web user.

The User Defined Fields tab displays the questions that a web user was required 
to answer when the user requested to create an account through VEMS and it is 
not relevant to the procedure that is described below.

Field Description

Name Automatically populated after you select the contact. You can edit this 

information.

Password The password that a web user must enter to log in to VEMS.

Email address If this information has been entered for the contact, then this field is 

automatically populated after you select the contact. If the field is blank, 

you must enter the full email address for the user. (The user must enter 

this address to log in to VEMS.)

Phone/Fax Optional fields. If this information has been entered for the contact, then 

these fields are automatically populated after you select the contact. If 

the fields are blank, you can enter values if needed.

Notes Optional field.

External Reference Optional field. Links the web user to an outside program if needed.

Network ID Optional field. The web user’s network ID.

Email Opt Out Select this option if the web user is not to receive automatic emails 

(such as reservation summary emails) from VEMS. The user will still 

receive manually sent emails.
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6. Open the Process Templates tab and on the Available list, select the web process
template or CTRL-click to select the multiple templates to which this user is to be
assigned, and then click the Move button (>) to move the selected templates to the
Selected list.

7. Open the Groups tab and do one of the following to specify the groups on whose behalf
the web user can view and make reservations in VEMS.

• The contact’s group is selected by default. You can leave this group in the Selected
list, or you can select the group and click the Remove button (<).

• Specify any combination of search criteria for the Find field and Group Type, and
then click Display to produce a list of all groups that meets the criteria. In the
Available list, select a group, or CTRL-click to select multiple groups, and then click
the Move button (>) to move the selected groups to the Selected list.

Status Required field. Select the status for the web user:

• Active—The web user can log in to VEMS.

• Inactive—The user cannot log in to VEMS and is instructed to contact

the EMS administrator.

• Pending—The web user cannot log in to VEMS and is informed that

he/she must check back at a later time.

Security Template Required field. This determines the web user's access to the system—

the menu items that the user can see and the information that the user 

can view in a tooltip when 'rolling-over' an event in VEMS.

Time Zone Required field. Select the time zone for the user.

A web process template defines the functions that are available to each type of web 
user in VEMS when the user is submitting a request for a reservation.

If you leave the Find field blank, then a list of all currently active groups for the 
selected group type is displayed. If you enter a search string in the Find field, the 
string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and the string must begin with the information for which 
you are searching. For example, AAA returns AAA Colorado, but not Colorado 
AAA.

Field Description
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8. Open the Delegates tab, and on the Search by dropdown list, do one of the following to
specify the delegates for the web user:

• Leave the Find field blank, and then click Display to open a list of all currently
available web users. Select a web user, or CTRL-click to select multiple web users,
and then click the Move button (>) to move the selected web users to the Selected
list.

• On the Search By dropdown list, select the option by which to search (Email
Address or User Name), and in the Find field, enter the string by which to filter your
search, and then click Display. Select a web user, or CTRL-click to select multiple
web users, and then click the Move button (>) to move the selected web users to the
Selected list.

9. Optionally, click Spelling to spell check any information that you manually entered for
the user.

10. Click OK.

The dialog box for creating a web user closes and a message opens indicating that the
web user was created successfully.

11. Click OK to close the message and return to the group-specific page.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and the string must begin with the information for which 
you are searching. For example, if searching by Email Address, a search string 
of bob returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.
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Editing Group Information

You can edit any and all information for a group. The way that you edit the information 
depends on the information itself. You can edit the Summary information, the Billing 
information, and the Other information through the Edit function on the group-specific page. 
You must edit the group’s contacts, reminders, comments, attachments, UDFs, calculations, 
billing reference numbers, PO numbers, and web users on the group-specific page.

To edit group information

1. Open the Groups page and search for the group for which you are editing the
information. See “To search for a group and/or contact” on page 231.

2. Select the group, and then click Open to open the group in the group-specific page.

The group is selected by default. The Summary tab is the active tab.

Figure 6-20: Group-specific page

3. Continue to one of the following:

• “To edit summary, billing, and/or other group information” on page 263.

• “To edit the contacts for a group” on page 263.

• “To edit the reminders for a group” on page 264.

• “To edit the comments for a group” on page 264.

• “To edit the attachments for a group” on page 265.

• “To the edit user defined fields (UDFs) for a group” on page 266.
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• “To edit the calculations for a group” on page 266.

• “To edit the billing reference numbers for a group” on page 267.

• “To edit the PO numbers for a group” on page 267.

• “To edit the web users for a group” on page 268.

To edit summary, billing, and/or other group information

1. To edit the summary information, billing information, and/or other information for the
group, click Edit.

The group-specific page opens.

2. Open the appropriate tab, and then edit the information as needed.

See Step 3 and Step 4 of “To configure groups” on page 233.

3. After you edit the information, click OK.

The group-specific page closes. You return to the group-specific page with the group still
selected.

To edit the contacts for a group

1. In the left pane of the group-specific page, select Contacts.

A list of all contacts that are currently configured for the group is displayed in the right
pane of the page.

2. In the right pane of the page, select the contact that you are editing, and then do one of
the following:

• To set the selected contact as the default contact for the group, click Set Default, and
then click OK at the prompt.

• To edit the information for the contact, click Edit.

The Contact dialog box opens. The dialog box displays the information for the
selected contact.

3. Edit the information for the contact as needed. See “To configure a contact manually” on
page 255.

4. Click OK.

The Contact dialog box closes. You return to the group-specific page with Contacts still
selected.
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To edit the reminders for a group

1. In the left pane of the group-specific page, select Reminders.

A list of all reminders that are currently configured for the group is displayed in the right
pane of the page.

2. In the right pane of the groups-specific page, select the reminder that you are editing, and
then click Edit.

The Reminder dialog box opens. The Reminder tab is the active tab.

3. Do any or all of the following to edit the reminder as needed:

• On the Reminder Type dropdown list, select a different reminder type.

• Optionally, change the value for the Responsible User, the Date Due, or both.

• If you are completing the reminder today, select a Date Completed; otherwise, leave
this field blank.

• In the Notes field, enter any further explanation or information about the reminder.

4. Optionally, click Spelling to spell check the edited reminder before you save it.

5. Click OK.

The Reminder dialog box closes. The newly edited reminder is automatically selected in
the group-specific page.

To edit the comments for a group

1. In the left pane of the group-specific page, select Comments.

A list of all comments that are currently configured for the group is displayed in the right
pane of the page.

2. In the right pane of the group-specific page, select the comment that you are editing, and
then click Edit.

The Comment dialog box opens. The Comment tab is the active tab.

If you leave this field blank, then it is automatically populated when you or 
another user completes the reminder on the Reminders tab of the Dashboard page. 
See “To complete a reminder” on page 218.)



265

 
Groups and Contacts

3. Do any or all of the following to edit the comment as needed:

• On the Comment Type dropdown list, select a different comment type.

• In the Notes field, enter or modify the comment.

• To alert any EMS user that opens this group that this comment has been added to the
group, select Alert Users.

4. Optionally, click Spelling to spell check the edited comment before you save it.

5. Click OK.

The Comment dialog box closes. The newly edited comment is automatically selected in
the group-specific page.

To edit the attachments for a group

1. In the left pane of the group-specific page, select Attachments.

A list of all attachments that have been added for the group is displayed in the right pane
of the page.

2. In the right pane of the group-specific page, select the attachment that you are editing,
and then click Edit.

The Attachment dialog box opens.

3. Do any or all of the following to edit the attachment as needed:

• Edit the description for the attachment.

• On the Type dropdown list, select a different attachment type.

• Click Upload to open the Attachments dialog box, and then click Attach Files to open
the Select File to Upload dialog box and browse to and select a different attachment.

4. Click OK.

The Attachment dialog box closes. The newly edited attachment is automatically
selected in the group-specific page.

If none of the pre-configured comment types meets your working needs, select 
(user specified comment), and then in the Description field, enter a description for 
the comment type.The description can be a maximum of 30 characters, including 
spaces.

The description can be a maximum of 50 characters, including spaces. If you 
leave this field blank, then it is automatically populated with the name of the file 
after you attach it to the Group.
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To the edit user defined fields (UDFs) for a group

1. In the left pane of the group-specific page, select User Defined Fields.

All user defined fields that are currently configured for the group are displayed in the
right pane of the group-specific page.

2. In the right pane of the group-specific page, select the UDF that you are editing, and then
click Edit.

The User Defined Field dialog box opens. The User Defined Field tab is the active tab.

3. Do one or both of the following to edit the UDF:

• On the Field dropdown list, select a different UDF.

• In the value field, edit the value for the UDF.

4. Click OK.

The User Defined Field dialog box closes. The newly edited UDF is automatically
selected in the group-specific page.

To edit the calculations for a group

1. In the left pane of the group-specific page, select Calculations, and then click Edit.

The Calculations dialog box opens.

2. Do one or both of the following:

• On the Available list, select the calculation, or CTRL-click to select the multiple
calculations that are to always apply to this group, and then click the Move button
(>) to move the selected calculations to the Selected list.

• On the Selected list, select the calculation, or CTRL-click to select the multiple
calculations that are not to apply to this group, and then click the Remove button (<)
to move the selected calculations to the Available list.

3. Click OK.

The Calculations dialog box closes. You return to the group-specific page with
Calculations still selected.
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To edit the billing reference numbers for a group

1. In the left pane of the group-specific page, select Billing References.

2. In the right pane of the page, select the billing reference number that you are editing, and
then click Edit.

The Billing Reference dialog box opens. The dialog box displays the information for the
selected billing reference number.

3. Edit the information for the billing reference number as needed.

4. Click OK.

The Billing Reference dialog box closes. You return to the group-specific page with
Billing References still selected.

To edit the PO numbers for a group

1. In the left pane of the group-specific page, select PO Numbers.

2. In the right pane of the page, select the PO number that you are editing, and then click
Edit.

The PO Number dialog box opens. The dialog box displays the information for the
selected PO number.

3. Edit the information for the PO number as needed.

Option Description

Billing Reference The billing reference number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the billing reference number.

Notes Any other comments or statements that are applicable for the billing 

reference number.

Inactive Leave this option blank to add the reference as an active reference (the 

billing reference number is to be available when a reservation is made 

for the group). Select this option to inactivate the billing reference 

number.

Option Description

PO Number The PO number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 

100 characters, including spaces.

Description A description of the PO number.

Notes Any other comments or statements that are applicable for the PO 

number.
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4. Click OK.

The PO Number dialog box closes. You return to the group-specific page with PO
Numbers still selected.

To edit the web users for a group

When you edit the web users for a group, you can select additional web users for the group, 
or you can remove web users for the group. You cannot edit the web user itself, nor can you 
edit the delegates for a web user. 

1. In the left pane of the group-specific page, select Web Users.

2. In the right pane of the group-specific page, select the web user whom you are editing,
and then click Edit.

The Web Users dialog box opens.

3. Do one or both of the following:

• To add a new web user for the group:

• Leave the Find field blank, and then click Display to open a list of all currently
active web users. Select the web user, or CTRL-click to select multiple web
users, and then click the Move button (>) to move the selected web users to the
Selected list.

• In the Search By dropdown list, select the option by which to search (Email
Address or User Name) and then in the Find field, enter the string by which to
filter your search, and then click Display. Select the web user, or CTRL-click to
select multiple web users, and then click the Move button (>) to move the
selected users to the Selected list.

• To remove a web user from a group, in the Selected field, select the user, or
CTRL-click to select the multiple web users that you are removing from the group,
and then click the Remove button (<) to move the selected web users to the
Available list.

Inactive Leave this option blank to add the PO number as an active number (the 

PO number is to be available when a reservation is made for the group). 

Select this option to inactivate the PO number.

The string is not case-sensitive, but your search is limited to the exact order of the 
characters in the string and the string must begin with the information for which 
you are searching. For example, if searching by Email Address, a search string 
of bob returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.

Option Description
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4. After you edit the information, click OK.

The Web Users dialog box closes. You return to the group-specific page with Web Users
still selected.
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Importing Groups

You can import groups into your EMS database from a tab-delimited text file. (See Import 
File Specifications in the EMS Setup Guide for the file specifications.)

To import groups

1. On the EMS toolbar, click the Groups icon .

The Groups page opens. The Filter tab is the active tab.

Figure 6-21: Groups page, Filter tab

2. Click Import.

The Open File dialog box opens.

3. Browse to and select the text file that lists the groups that you are importing.

A dialog box opens, indicating the number of groups that you are about to import, and
asking you if you want to continue.

4. Click Yes.

A message opens indicating that the import was successful.

5. Click OK to close the message and return to the Groups page.
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Working with Reservations for a Group

You have a variety of options for working with the reservations for a group. You can:

• Search for and make a reservation for a group from the Groups page.

• Search for and make a reservation for a group from the group-specific page.

• Search for reservations by group, and then open and view any existing reservations in the
Navigator for a group from the group-specific page.

• Reassign the reservations for a group or contact from the group-specific page.

In EMS Workplace, you can also make a group reservation from the Group Reservation 
page.

To work with reservations for a group

1. Open the Groups page and search for the appropriate group. See “To search for a group
and/or contact” on page 231.

2. On the Groups page, select the group, and then do one of the following:

• Click New Reservation at the top of the page to open the Reservation Wizard, and
then continue to “Making a Reservation Using the Reservation Wizard” on page 33.

• Click Open to open the group-specific page (the group is automatically selected in
the page), and then continue to one of the following:

• “To search for and view reservations by group from the  group-specific page”
below.

• “To search for and make a reservation for a group from the  group-specific page”
on page 272.

• “To reassign a reservation for a group from the group-specific page” on page
272.

To search for and view reservations by group from the 

group-specific page

1. In the left pane of the group-specific page, select Reservations.

All reservations that have been made for the group in your EMS database and that have a
date greater than or equal to the current day’s date are displayed in the right pane of the
group-specific page.

Optionally, to show all reservations that have been made for the group, click Show 
Old Reservations. 
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2. In the right pane of the group-specific page, select the appropriate reservation, and then 
click Open.

The reservation opens in the Navigator.

3. Continue to  , “The Navigator,” on page 65.

To search for and make a reservation for a group from the 

group-specific page

1. In the left pane of the group-specific page, select Reservations.

All reservations that have been made for the group in your EMS database and that have a
date greater than or equal to the current day’s date are displayed in the right pane of the
group-specific page.

2. Click New.

The Reservation Wizard opens.

3. Continue to “Making a Reservation Using the Reservation Wizard” on page 33.

To reassign a reservation for a group from the group-specific page

1. In the left pane of the group-specific page, select Reservations.

All reservations that have been made for the group in your EMS database and that have a
date greater than or equal to the current day’s date are displayed in the right pane of the
group-specific page.

2. In the right-pane of the group-specific page, select the appropriate reservation, or
CTRL-click to select multiple reservations, and then click Reassign.

The Reassign Group/Contact on Reservations dialog box opens. See Figure 6-22 on page
273.

Optionally, to show all reservations that have been made for the group, click Show 
Old Reservations. 

Optionally, to show all reservations that have been made for the group, click Show 
Old Reservations. 
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Figure 6-22: Reassign Group/Contact on Reservations dialog box

3. On the Group dropdown list, select the group to which you are reassigning the

reservation, or click the Search icon  to open a Lookup dialog box and do one of the
following to search for a group:

• Leave the Find field blank, and then click the Search icon  to open a list of all 

currently active groups in your EMS database, and then click the Add icon  next 
to the appropriate group to select it.

• In the Find field enter a search string, click the Search icon  to return a list of 

groups that meet your search criteria, and then click the Add icon  next to the 
appropriate group to select it.

• Starts with—The string is not case-sensitive, but your search is limited to the
exact order of the characters in the string, and the string must begin with the
information for which you are searching. For example, Assoc returns
Association of Broadcasters but not Biomedical Student Association.

• Contains—Your search is limited to the exact order of the characters in the
string, but the string is not case-sensitive, and the string can be found anywhere
in your search results. For example, Assoc returns both Association of
Broadcasters and Biomedical Student Association.
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4. Optionally, edit any and/or all of the group information as needed.

5. Click OK.

A Reassign Reservations message opens, asking you if it is OK to reassign the selected
reservations to the group.

6. Click Yes.

The Reassign Reservations message closes and a second Reassign Reservations message
opens, indicating the reservations were successfully reassigned.

7. Click OK.

The message closes, and the reassigned reservations are no longer displayed in the
group-specific page.

Option Description

1st Contact

2nd Contact

The contact for the group to which you are reassigning the reservation.

Note: If none of the pre-configured contacts is appropriate, then select 

(temporary contact) and in the Temp Contact field, enter the name of the 

temporary contact.

Phone

Fax

Email Address

The phone, fax, and email address for the contacts for the group to which the 

reservation is being reassigned. If you selected from the list of the pre-configured 

contacts, then some or all of this information might be automatically populated, 

but you can still edit the values. If you selected a (temporary contact), then you 

must enter this information for the contact.

Web User The web user for the group. Initially, this field is set to (no change) which means 

that the web user for the group to which you are reassigning the reservation is to 

remain as is; however, if needed, you can click the Search icon  to open the <

> dialog box and select a different web user.

• You can search by User Name or Email Address.

• To search a list of all available web users, leave the Search field in the < > s

dialog box blank, and then click Display.

• To search for a specific web user, enter a search string in the Search field, and

then click Display.

Note: The string is not case-sensitive, but your search is limited to the exact 

order of characters in the string and the string must begin with the 

information for which you are searching. For example, if searching by 

Email Address, a search string of bob returns 

bobworth@emssoftware.com but not dbobbett@demssoftware.com.

Note: To return this field to the (no change) value at any time, click Reset.

You might have to click Reservations in the left-pane of the group-specific page to 
refresh the display.
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To make a group reservation from the Group Reservation page 

(EMS Workplace only)

1. On the EMS Workplace toolbar, click the Group Reservation icon .

The Group Reservation page opens. The Filter tab is the active tab.

Figure 6-23: Group Reservation page, Filter tab

2. Search for the group for which you are making a reservation. See “To search for a group
and/or contact” on page 231.

3. Select the group for which you are making the reservation, and then click Reservation.

A dropdown list of the available Reservation Wizard templates opens.

4. Select the appropriate template.

The Reservation Wizard opens. The name of the group for which you are making the
reservation is displayed in the title bar of the Reservation Wizard. The Reservation
Wizard template that you selected is displayed on the Wizard Template dropdown list at
the top of the Reservation Wizard. (You can always select a different template if needed.)
See Figure 6-24 on page 276.

Depending on how your EMS administrator has configured the template that you 
selected, you might be prompted to select a reservation start date before the 
Reservation Wizard opens. 
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Figure 6-24: Reservation Wizard with Wizard Template option

5. Continue making the reservation as you normally would. See “Making a Reservation
Using the Reservation Wizard” on page 33.
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Printing and Exporting Group Information

You can print a variety of information for selected groups such as contact summary 
information, status exceptions, group import format information, and billing information, 
and you can also export a list of selected groups and the summary information for each group 
(type, name, address, and so on) to an Excel spreadsheet. 

To print group information

1. Search for the groups for which you are printing the information. See “To search for a
group and/or contact” on page 231.

2. On the Groups page, click Print.

A list with a variety of options for printing information for the groups that are currently
displayed in the Groups page opens.

Figure 6-25: Group print options

3. Select the information that you want to print for the displayed groups.

Option Description

List A message opens asking you if you want to print or save the Groups.pdf 

file. This file lists all the groups (group name, address, phone number, 

email address, pricing plan, and status) that are currently displayed in 

the Groups page. The groups are sorted by group type.

Contact Summary A message opens asking you if you want to print or save the Groups 

(Contact Summary).pdf file. This file lists all the contacts (group name, 

group phone number, contact name, and contact phone number) that 

have been configured for all the groups that are currently displayed in 

the Groups page.

Status Exceptions A message opens asking you if you want to print or save the Group. 

Status Exceptions.pdf file.groups. This file is derived from all the groups 

that are currently displayed in the Groups page that have any status 

other than OK. The groups are sorted by group type.
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To export a list of groups to an Excel spreadsheet

1. Search for the groups that are you exporting to an Excel spreadsheet. See “To search for
a group and/or contact” on page 231.

2. On the Groups page, click Export.

A message opens asking you if want to open the Groups.xls file or save it.

3. Select the option that best fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different file
name and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

For any of the above three files, select the option that best fit your working needs.

• If you click Open, the file opens onscreen. You can always specify a different file name and save

the file after you view it.

• If you click Save, you must select the directory in which to save the file.

Import Format Opens an onscreen preview of the required format for the tab-delimited 

file that is to be used when importing groups.

Transaction Report See “Generating an EMS Billing Report” on page 350.

Statements See “Generating an EMS Billing Report” on page 350.

Voided Transaction 

Report

See “Generating an EMS Billing Report” on page 350.

Ageing Report See “Generating an EMS Billing Report” on page 350.

General Ledger 

Distribution

See “Generating an EMS Billing Report” on page 350.

Option Description

To preview the file, Microsoft Excel must be installed on your EMS client.
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In EMS, a confirmation is a document that details the critical information for a reservation—
the date, the time, the location, the scheduled resources, and so on. You send a confirmation 
to the group who is sponsoring or hosting the event as verification that the reservation has 
been correctly set up—the time and location are correct, all the necessary resources have 
been scheduled, and so on. You can also use the confirmation to inform the group of any 
outstanding issues related to the reservation (such as a balance due) and to provide other 
information that is not necessarily reservation-specific such as your organization’s 
cancellation policies, your organization’s alcohol policies, and so on. You can generate a 
confirmation for all the bookings in a reservation, or just for a selected booking in a 
reservation. 

This chapter covers the following topics:

• “Specifying your Confirmation Settings” on page 281.

• “Generating a Single Confirmation at a Time” on page 284.

Remember, a fast way to view reservations is through the Reservation Book. See 
“Viewing and Editing Reservations in the Reservation Book” on page 50.

This chapter details the generation of a single confirmation at a time. To generate 
confirmations for multiple reservations in a single step, see “Generating Multiple 
Confirmations” on page 375.
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Specifying your Confirmation Settings

The Confirmation Settings dialog box provides a variety of options that you can specify for 
manual and automatic generation of a confirmation for a reservation or a booking. You can 
specify your confirmation settings one time and use these settings for all confirmations that 
you generate, or you can change the settings on as-needed basis and tailor them for each 
confirmation that you generate.

To specify your confirmation settings

1. Open a reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the upper right hand corner of the Navigator, click Settings > Confirmation Settings. 

The Confirmation Settings dialog box opens.

Figure 7-1:  Confirmation Settings dialog box

3. Specify the settings for your system’s confirmations.

Field Description

Date Range tab—The department name that appears at the top of a printed confirmation.

Buildings tab—Select the specific buildings that are to be included in the confirmation. 
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Categories tab—Select the specific booking details that are to be included in the confirmation.

Statuses tab—Select the specific statuses that are to be included in the confirmation. 

Options tab—Format settings for a printed confirmation.

Confirmation Title Appears bold and centered at the top of the printed confirmation.

Header Message

Footer Message

Pre-configured blocks of text that appear in the header and footer of the 

printed confirmation. 

Paper Size The size of the paper on which the confirmation is printed. Values are 

Letter, Legal, and A4.

Print Comments Include the comments for the reservation in the printed confirmation.

Print Reminders Include the reminders for the reservation in the printed confirmation.

Print Cancel Reasons Include the reasons for cancellation in the printed confirmation.

Print User Defined 

Fields

Include user-defined fields and their values in the printed confirmation. 

Print Room Phone Include the phone number for the room in which the event is being held 

in the printed confirmation.

Print Room Notes Include any notes for the room in which the event is being held in the 

printed confirmation.

Print Building Notes Include any notes about the building in the printed confirmation.

Print Billing Reference 

Allocation

Include the billing reference numbers for the event as well as the 

percentage of charges that is allocated to each number in the printed 

confirmation.

Print PO Allocation Include the PO numbers for the event as well as the percentage of 

charges that is allocated to each number in the printed confirmation.

Print Category 

Subtotals

Include the subtotal charges by category in the printed confirmation.

Print Room Type Include the room type for the event in the printed confirmation.

Print Item Selection 

Notes

Include the notes for each resource selection item for the event in the 

printed confirmation.

Suppress Reserved 

Time

Do not show the reserved time for the event in the printed confirmation.

Suppress Location Do not show the location for the reservation in the printed confirmation. 

Suppress Pricing Do not show the reservation’s room charges or resource charges in the 

printed confirmation.

Suppress Logo Do no show your organization’s logo in the printed confirmation.

Suppress Item Notes Do not show notes for any booking items in the printed confirmation.

Suppress Item Special 

Instructions

Do not show special instructions for any booking items in the printed 

confirmation.

Suppress Item 

Selections

Do not show any resource item selections in the printed confirmation.

Always Display Time 

Zone

Always show the time zone for the event in the printed confirmation.

Field Description
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4. You can now generate a confirmation (manually or automatically) based on the settings
that you have specified. See “Generating a Single Confirmation at a Time” on page 284.

Display Messages as 

HTML

If you have defined any HTML messages, then select this option to 

display the HTML version of these messages in the printed 

confirmation; otherwise, the message is displayed in plain text.

Limit Bookings to Those 

With Details in Selected 

Categories

Show only those bookings in the printed confirmation that contain details 

for the categories that are selected on the Categories tab.

Email Options tab—Format settings for the body of an emailed confirmation.

Header Message

Footer Message

Pre-configured blocks of text that appear in the body of the emailed 

confirmation. 

Note: Your EMS administrator configures these values. Contact your 

administrator if you need assistance with adding or editing a 

value.

Email Format • None—Opens a blank email form.

• Detail—The confirmation appears in its entirety in the email body.

• Mobile Friendly—The confirmation appears in a condensed version

that is viewable on a mobile device.

• Summary—Only the booking information appears in the email body.

Attached Detailed 

Confirmation

The entire confirmation is provided as an attachment to the email.

Attach .ics file An .ics file is a file that a recipient can save to create an entry in his/her 

personal calendar. Select this option to attach an .ics file to the email.

Prompt for Res. 

Attachments

Select from a list of reservation-level attachments that you are including 

in the email.

Email To

Email CC

Select the users associated with the reservation who should receive the 

email confirmation.

Field Description
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Generating a Single Confirmation at a Time

You can generate a confirmation for all the bookings in a reservation, or just for a selected 
booking in a reservation. In the default implementation of EMS, when you request to 
generate a confirmation for a reservation or a booking, the Confirmation dialog box opens. 
The Confirmation dialog box has the same tabs as the Confirmation Settings dialog box. 
(Remember, the values that you specified on the Confirmation Settings dialog box determine 
the information that is included in a confirmation. See “Specifying your Confirmation 
Settings” on page 281.) It also contains options for generating a print preview of the 
confirmation and for manually printing or emailing the confirmation. If you want to 
automatically generate a printed or emailed confirmation according to your confirmation 
settings, then you must edit the Confirmation setting on the General tab of the Navigator 
Options dialog box.

To manually generate a single confirmation at a time

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the left pane of the Navigator, do one of the following:

• Select the reservation for which you are generating the confirmation.

• Select the reservation for which you are generating the confirmation, and then in the 
Bookings (lower right) pane, select the booking for which you are generating the 
confirmation.

3. Do one of the following:

• If you are generating a confirmation for a reservation, then open the Reservation 
Summary tab or Properties tab in the upper right pane of the Navigator, and then 
click Confirmation.

• If you are generating a confirmation for a selected booking, then open the Booking 
Summary tab in the upper right pane of the Navigator, and then click Confirmation.

The Confirmation dialog box opens. The Date Range tab is the active tab. The dialog 
box has the same tabs as the Confirmation Settings dialog box with one exception, the 
Date Range tab. (Additional options are available on the Date Range tab that you can use 
to limit the confirmation to specific bookings and/or specific booking times.) It also has 
options for saving, or memorizing, the displayed confirmation settings so that you do not 
have to adjust the settings every time you generate the confirmation. When the dialog 
box first opens, the Setup is set to (user-specified).
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4. Do one of the following:

• Review the selections on this dialog box, and optionally, make any needed
modifications.

• On the Setup dropdown list, select a saved, or memorized, confirmation.

5. Do one of the following:

• To manually generate a confirmation that you can print, select the output format for
the confirmation, and then click Generate Report.

If you selected the default format of HTML, then the confirmation is displayed
onscreen in its own page. You can use your browser options to view the confirmation
prior to printing, set your printing options, print the confirmation, and so on. For all
other confirmation formats, you must indicate whether to open the confirmation, or
to save the confirmation. To open a confirmation in any format other than HTML,
you must have the correct application installed on your client:

Unless you change the filter settings, all subsequent confirmations are generated and 
printed according to the parameters and options that you have specified and in the 
format that you specified. 

• To manually generate an emailed confirmation, click Email to open an onscreen
preview of the email, and then complete and send the email as you normally would.
See “Sending Email from EMS” on page 367.

If you use specific times, then you must also click Options and indicate how the 
confirmation is to be limited—to bookings that start within the range or to 
bookings that occur within the time range. 

If needed, you can always save, or memorize, these settings. See “Working with 
Memorized Reports” on page 293.

If you select a memorized confirmation, then the only changes that you can make 
are to the dates and/or times on the Date Range tab.

Output Format Required Application

PDF Adobe Reader or Adobe Acrobat

RTF Microsoft Word

XLS Microsoft Excel

HTML Web Browser

TEXT Notepad or Textpad

TIFF Any graphics application including 

Microsoft Paint and Microsoft Office 

Picture Manager.
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To automatically generate a confirmation

If you want to always automatically generate a printed or emailed confirmation based on 
your confirmation settings, then you must edit the Confirmation setting on the General tab of 
the Navigator Options dialog box.

1. Open the reservation in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

•  “Search Tools,” on page 177.

2. In the upper corner of the Navigator page, click Settings > Options.

The Navigator Options dialog box opens. The General tab is the active tab.

Figure 7-2:  Navigator Options dialog box, General tab
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3. Under Confirmation, select one of the following:

• Email—To always automatically generate a confirmation that you can email based
on your confirmation settings.

• Print—To always automatically generate a confirmation that you can print based on
your confirmation settings.

4. Click OK to close the dialog box and return to the Navigator.

The next time you select any reservation or booking in the Navigator and click
Confirmation, the following happens:

• If your Navigator Options are set to Email, then see “Sending Email from EMS” on
page 367.

• If your Navigator Options are set to Print, then an onscreen preview of the
confirmation opens. The onscreen preview contains options for printing a hard copy
of the email, and so on.

If the emailed confirmation includes an attachment, then the Confirmation name is 
also used for the Confirmation Attachment name.
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EMS contains six different categories of general reports to assist you in monitoring and 
maintaining your organization’s reservation records and associated transactions. 

This chapter covers the following topics:

• “Generating an EMS Report” on page 291.

• “Working with Memorized Reports” on page 293.

• “Report Descriptions and Options” on page 298.

Reports that are specific for the Billing function in EMS are detailed in   
“Billing,” on page 319.
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Generating an EMS Report

All EMS reports are available under the Reports option on the main menu. For any EMS 
report, you can specify the parameters, options, and format for the report, or you can 
generate the report according to memorized settings. Not all reports require the same 
parameters, nor do they all have the same options available.

To generate a report

1. On the EMS main menu, click Reports to open the Reports menu, and then click the
option for the report that you are generating. For example, to generate the Event
Schedule report, click Reports > Daily > Event Schedule.

2. On the Setup dropdown list, do one of the following:

• To generate the report according to the filter settings that you specify (parameters,
options, and so on), leave (user specified) selected on the Report Setup list, and then
go to Step 3.

• To run the report with filter settings that have been saved, or memorized, select the
memorized report on the Report Setup list, and then go to Step 5.

3. On the Options list, select the Date/Time filter by which to generate the report.

4. Specify the report parameters, options, and format. See:

• “Daily reports” on page 299.

• “Sales reports” on page 304.

• “Statistics reports” on page 307.

• “Other reports” on page 310.

• “Exceptions reports” on page 312.

• “Hoteling reports (EMS Workplace only)” on page 315.

If you run the EMS Web Client in Internet Explorer 8, to generate reports, you 
must enable the following setting: Tools -> Internet Options -> Security -> 
Custom Level -> Downloads -> Automatic prompting for file downloads.

For detailed information about memorized reports, see “Working with Memorized 
Reports” on page 293.

Report parameters and options are discussed in “Report Descriptions and 
Options” on page 298. Billing reports are discussed in  ,“Billing,” on page 
319. Contact your EMS administrator if you need assistance in generating any 
of these reports.
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5. In the Report Comment field, enter a comment that is to be printed on the report.

6. Select the output format for the report, and then click Generate Report.

If you selected the default format of HTML, then the report is displayed onscreen in its
own page. You can use your browser options to view the report prior to printing, set your
printing options, print the report, and so on. For all other report formats, you must
indicate whether to open the report, or to save the report. To open a report in any format
other than HTML, you must have the correct application installed on your client:

7. Click Close.

Unless you change the filter settings, all subsequent reports are generated and printed
according to the parameters and options that you have specified and in the format that
you specified. If you want to save certain settings so that you do not have to adjust the
filter settings every time you run the report, you can memorize the report. See “Working
with Memorized Reports” on page 293.

The comment can be a maximum of 255 characters, including spaces.

Report Format Required Application

PDF Adobe Reader or Adobe Acrobat

RTF Microsoft Word

XLS Microsoft Excel

HTML Web Browser

TEXT Notepad or Textpad

TIFF Any graphics application including 

Microsoft Paint and Microsoft Office 

Picture Manager.



293

 
Reports

Working with Memorized Reports

A memorized report is a report for which the filter settings have been saved, or memorized, 
so that you do not have to adjust the filter settings every time you run the report. You can 
create a new memorized report, or you can copy an existing memorized report, and edit the 
filter settings as needed to create a new memorized report. If you are the owner of a 
memorized report, you can also edit the name of an existing memorized report and you can 
delete a memorized report.

To create a new memorized report

1. On the EMS main menu, click Reports to open the Reports menu, and then click the
option for the report that you are memorizing. For example, to memorize the Event
Schedule report, click Reports > Daily > Event Schedule to open the Event Schedule
dialog box.

Figure 8-1:  Event Schedule report dialog box

2. On the <Report> dialog box, click Options, and then select the Date/Time filter by which
to generate the report.

3. Specify the report parameters, options, and format.

Although this topic is written from the perspective of reports, it is also applicable 
for working with memorized confirmations and invoices.
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4. On the <Report> dialog box, click Memorize.

The Memorize Report Setup dialog box opens.

Figure 8-2:  Memorize Report Setup dialog box

5. In the Description field, enter a name or description for the report.

6. If you are an administrative user, and the report is to be available to all users, then select
Public (Available to All Users); otherwise, if the report is to be available only to you (the
owner), then leave this option blank.

7. Click OK.

The Memorize Report Setup dialog box closes. You return to the <Report> dialog box.
The memorized report is now an option on the Setup dropdown list.

The description can be a maximum of 50 characters, including spaces.

If you are not an administrative user, then only your EMS administrator can make 
your memorized reports available to all users. Contact your EMS administrator 
for assistance.
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To create a memorized report by copying

1. On the EMS main menu, click Reports to open the Reports menu, and then click the
option for the report that you are memorizing. For example, to memorize the Event
Schedule report, click Reports > Daily > Event Schedule to open the Event Schedule
dialog box.

Figure 8-3:  Event Schedule report dialog box

2. On the Setup dropdown list, select the memorized report from which you are copying the
filter settings, and then click Copy.

The Memorize Report Setup dialog box opens. By default, the Description field
indicates that you are naming a copy of a memorized report.

Figure 8-4:  Memorize Report Setup dialog box

3. In the Description field, enter a name or description for the new memorized report.

The description can be a maximum of 50 characters, including spaces.
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4. If you are an administrative user, and the report is to be available to all users, then select
Public (Available to All Users); otherwise, if the report is to be available only to you (the
owner), then leave this option blank.

5. Click OK.

The Memorize Report Setup dialog box closes. You return to the <Report> dialog box.
The filter settings are populated with the settings for the memorized report.

6. Click Edit, and then edit the filter settings for the report as needed.

7. Click Memorize.

The memorized report is now an option on the Setup dropdown list.

To edit or delete a memorized report

1. On the EMS main menu, click Reports to open the Reports menu, and then click the
option for the memorized report that you are editing. For example, to edit a memorized
Event Schedule report, click Reports > Daily > Event Schedule to open the Event
Schedule dialog box.

Figure 8-5:  Event Schedule report dialog box

If you are not an administrative user, then only your EMS administrator can make 
your memorized reports available to all users. Contact your EMS administrator 
for assistance.
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2. On the <Report> Setup dialog box, click Setups.

The Memorized Report Setups dialog box opens. This dialog box lists all the memorized
report setups for which you are the owner, and therefore, can edit the name and/or delete
the report.

Figure 8-6:  Memorized Report Setups dialog box

3. Select a memorized report setup, and then do one of the following:

• To edit the name of the report, click Edit to open the Memorize Report Name dialog
box, and edit the name of the report in the Description field.

• To delete the report, click Delete, and then click Yes in the message that asks you if
you are sure that you want to delete the selected report.

Administrative users can edit and delete all memorized reports in the system. See 
Managing Memorized Reports in the EMS Setup Guide.

The description can be a maximum of 50 characters, including spaces.
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Report Descriptions and Options

This section provides a description of every EMS report in the categories listed below and it 
also defines the options that are available for each report.

See:

• “Daily reports” on page 299.

• “Sales reports” on page 304.

• “Statistics reports” on page 307.

• “Other reports” on page 310.

• “Exceptions reports” on page 312.

• “Hoteling reports (EMS Workplace only)” on page 315.
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Daily reports

Report Description Options

Event Schedule A summary of the events that are scheduled at 

your facility, sorted by date and event start time. 

The report shows event start and end time, group 

name, event name, and location. You typically 

print and post the Event Schedule in a lobby or 

entry way to help visitors find their events.

• Use Page Breaks - If the report is run across multiple days, then

each day starts on a new page.

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

• Show Holidays—Displays any holidays that are configured in the

EMS database on the report.

• Show Building Hours—Displays building hours on the report.

• VIP Events Only—Only the events that are marked as a “VIP” are

displayed in the report.

• Use Calendar Styles: Events are displayed in the font/color of the

Calendar Style that is associated with each event.

Event Calendar A chronological list of scheduled events in a wall 

calendar format. 

• Use Calendar Styles—Events are displayed in the font/color of the

Calendar Style that is associated with each event.

• Weekly Calendar—One week per page is displayed in the report.

• Show Adjacent Calendar Days—Works in conjunction with the

Weekly Calendar option to display events that occur on Saturday and

Sunday in the report.

• Grey Out Adjacent Calendar Days—Works in conjunction with The

“Show Adjacent Calendar Days” option to display events that occur

on adjacent days in gray instead of in black.

• Hide Holidays—By default, holidays are displayed on the Daily

Calendar Report. Select this option to hide holidays in the report.

• By Room—Displays events one room at a time in a calendar view.
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Room Cards A list of events that is designed to be posted 

outside a room or event space. The report notes 

the date, event time, and location for events, as 

well as the group sponsoring each event. The 

report can be a single list of all events that are 

scheduled for the room on a particular date, or it 

can be a single page per event. 

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

• Print Blank Room Cards—Prints a room card for a space that does

not have any events scheduled.

• Print Logo—Prints the facility logo on each room card. You can

specify the logo location on the right or left side of the room card.

• Sort Room Cards By Book Sequence—If Book Sequencing is being

used on Room Configuration, then a facility can print room cards in

the Book Sequence order.

• Print Combo Room Components—Prints an individual room card for

each component of a combo room.

• Suppress End Time—Do not show the end times for bookings in the

report.

Activity Schedule A list of bookings in all rooms in a building, or just 

in a specific room in the building. The report, 

which shows event start and end times, event 

name, group name and room, can be generated 

for a range of dates. The report can generated in 

one of two formats—by Date or by Building.

• Use Page Breaks—A new page is generated for each date or for

each building.

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

Report Description Options
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Setup Worksheet An internal report that setup crews, custodial, or 

operations personnel use to ensure that each 

room is arranged properly for each event. The 

report displays detailed information about each 

booking, including setup type, setup notes, 

required resources, user defined fields, special 

instructions and resource item notes.

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

• Limit Bookings To Those With Details In Selected Categories—Only

bookings with a booking detail from the specified categories are

displayed in the report.

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

• Keep Detail Together—If an event has booking details, the details are

kept together on one page instead of being split across two pages.

• Show Holidays—Holidays are displayed in the report.

• Show Building Hours—Building hours that are associated with each

building are displayed in the report.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

• Show User Defined Fields—Any user defined fields and their

answers for a reservation are displayed in the report.

• Show Booking Changes Only—Bookings that have been edited

within the specified number of days are displayed in the report.

Report Description Options
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Service Order Schedule Lists the service orders that are scheduled for a 

date or date range. Produced by category. 

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

• Show Details—Booking item details that associated with each event

are displayed in the report.

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report

• Show Pricing—Any pricing that is associated with an item is

displayed in the report.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

Service Orders Separate pages for each service order in a date 

range. The report provides information on the 

event and the items or services needed. 

Produced by category. 

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

• Footer Message—Used to specify the Footer message that is

displayed on each page of the report.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

Report Description Options
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Banquet Event Order Separate pages for each booking that occurs on 

a date or within a date range that has the 

“Primary Category” specified. Service orders, 

resource information, notes, and information for 

resource with order type categories are included 

in the report. 

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

• Show Pricing—Any pricing that is associated with an item is

displayed in the report.

• Limit Bookings To Those With Details In Selected Categories—Only

bookings with a booking detail from the specified categories are

displayed in the report.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

• Show Item Selection Notes—Any notes that have been entered for a

booking detail item selection are displayed in the report.

• Show Service User Defined Fields—Any user defined questions and

their answers for any listed category are displayed in the report.

• Set Page Numbers By Booking—Resets page number for every

unique booking.

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

Resource Schedule Lists by category and date, how many of each 

resource item is needed, as well as the event 

time, event name, location, and group. 

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

• Show Overbooked Resources Only—Only those bookings where the

selected resource exceeds the number available in inventory at that

time are displayed in the report.

Report Description Options
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Sales reports

Service Order Change 

Report

List the service orders to which a change has 

been made by Booking/Service Order ID. 

Includes the service order category, a description 

of the change, the old value for the service order, 

the new value for the service order, the date of 

the change, and the ID for the user who made the 

change.

N/A

Attendee Visitor Report Lists the attendees for an event by date or date 

range, and indicates whether they are visitors 

and shows their group name, phone number, 

event name, the room they will be in, and the 

start and end times for their event.

• Use Page Breaks—If this report is run across multiple days, then

each day starts on a new page.

Production Report Lists production items and their quantities 

grouped by production area.

• Show Item Notes—Any notes that have been entered for a booking

detail item are displayed in the report.

• Show Item Special Instructions—Any special instructions that have

been entered in VEMS for a booking detail item are displayed in the

report.

• Show Item Selections—Any selections that have been entered for a

booking detail item are displayed in the report.

Report Description Options

Report Description Options

Sales by Group Type Lists the sales for each group type for a date or 

date range.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.
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Sales by Group Lists the sales for each group, divided by group 

type, for a date or date range.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Sales by Category Lists the revenue generated by each resource 

category for a date or date range.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Sales by Resources Lists the sales for each resource item for a date 

or date range.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Sales by Reservation Lists the reservations that have bookings for a 

specified date or date range and shows the 

charges, by category, for the reservation. Also 

gives a grand total for all reservations. If a 

reservation also has bookings that fall outside the 

specified date or date range, these figures are 

not included in the report.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Sales by Billing 

Reference

Lists the total sales for a date or date range, 

based on the billing reference number on the 

reservations that have bookings in the specified 

range. Sales that are associated with 

reservations that have no billing reference 

number are not included in the report.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Report Description Options
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Sales by Booking Lists the sales for a particular date or for each 

date in a date range, broken down by booking. 

This report displays the following information—

Start/End Times, Group, Event Name, Location, 

Billing Reference#, PO Number, Payment Type, 

Status, Reservation ID, Booking ID, and Sales 

amount.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Status Changes by 

Reservation

Lists the sales that are associated with a 

reservation where the reservation or booking 

status was changed.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Status Changes by 

Booking

Lists the sales that are associated with bookings 

where the bookings status was changed.

• Display Amount—Select from Net Sales, Gross Sales, or Discounts.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Amounts—Group Types with zero sales/discounts are

displayed in the report.

Report Description Options
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Statistics reports

All Statistics reports, except Hourly Room Utilization and Hourly Resource Inventory Utilization, provide an “Analyze” 
feature to view data. Click Analyze to open a Browser page that displays the queried data. You can group the information by 
column, you can export the raw data to an Excel file, and you can click Details to provide more detailed information about the 
queried data. 

The Room Utilization report, the Hourly Room Utilization report, and the Hourly Room Utilization report are 
available only in EMS Enterprise. They are not available in EMS Professional.

Report Description Options

Room Statistics Lists all rooms by building and for each room, 

indicates the following information—the number 

of bookings for the date range selected, the 

reserved hours, the event hours, the estimated 

attendance (i.e., setup count), and the actual 

attendance.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

Room Utilization Lists the number of bookings, hours used, hours 

available, percent utilization, and hours vacant 

for rooms, by building, for the date range 

specified.

• Day Selection—Specify which day(s) of the week to include in the

report.

• Group By Utilization Category—Groups rooms by utilization (low,

high, unused).

• Include Cost—The cost for vacancies is displayed in the report.

• Include Unused—Include rooms that contain no bookings in the

report.

• Cap Utilization at 100%?—Percent utilization cannot exceed 100%.

• Low Utilization—Specify what percentage equals “Low” utilization.

• High Utilization—Specify what percentage equals “High” utilization.

• Availability Based On—Select to base availability on one of the

following - Building Hours, Hours per Day, or Specific Hours.

• Include Report Criteria—The filter settings for the report are

displayed in the report.
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Hourly Room Utilization Displays room utilization broken down by hours in 

the day, by percentage utilized. 

• Day Selection—Specify which day(s) of the week to include in the

report.

• Display Chart—Includes a chart on the final page of the report that

summarizes the reported data.

Hourly Resource 

Inventory Utilization

Displays resources, and the number of items 

used on an hourly basis for a specified date 

range.

• Day Selection—Specify which day(s) of the week to include in the

report.

• Display Chart—Includes a chart on the final page of the report that

summarizes the reported data.

Group Statistics Displays Number of Bookings, Reserved Hours, 

Event Hours, Estimated Attendance, and Actual 

Attendance by Group Type for a given date or 

date range. The format can be set to “Detail” to 

provide statistics for each specific group.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

Event Type Analysis Provides information by event type on the 

following—the number of reservations, the 

number of bookings, the percentage of total 

reserved hours, the percentage of total event 

hours, the percentage of total estimated 

attendance, the percentage of total attendance, 

the actual attendance, and the percentage of 

total.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Display Chart—Includes a chart on the final page of the report that

summarizes the reported data.

Reservation Source 

Analysis

Displays the number of reservations, the number 

of bookings with percentage, reserved hours with 

percentage, event hours with percentage, 

estimated attendance with percentage, and 

actual attendance with percentage by reservation 

source.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Display Chart—Includes a chart on the final page of the report that

summarizes the reported data.

Resource Statistics Lists the quantity and the hours used by category 

and by resource item.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

• Show Zero Quantities—Includes all resources even if the resource is

not used during the date range specified.

• Show Inactive Resources—Includes all inactive resources used

during the date range specified.

Report Description Options
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Room Availability Provides a count of room availability by room 

type for a given date range.

N/A

Setup Count Analysis Lists the total number of bookings by setup count. N/A

Seat Occupancy Displays the capacity for each room, the number 

of bookings for the date range, the seats 

available for the bookings, the total estimated 

attendance based on setup count on each 

booking, the average estimated attendance, and 

the estimated percentage of seats filled for the 

specified date range.Figures are also provided 

for total actual attendance, average actual 

attendance, and actual percentage of seats filled.

• Include Report Criteria—The filter settings for the report are

displayed in the report.

Benchmark Metrics 

Report

Compiles metrics for a number of different areas 

within EMS, for example, Rooms By Number of 

Bookings, Reservations By Source, and so on.

• Days Open Per Week—Indicates the number of days per week your

facility is open per week. The default value is 7.

• Hours Open Per Day—Indicates the number of hours per day that

your facility is open. The default value is 10.

Report Description Options
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Other reports

Report Description Options

Cancellation Report Lists the bookings that have a status that was 

changed to “Cancelled” on the date or dates 

specified, or lists the bookings on the date or 

dates specified that have a status type of 

“Cancelled.” The report also lists the date that the 

booking status was changed, the date the 

bookings were to have taken place, and the 

location of the event, the name of the person who 

canceled the booking, the reason for the 

cancellation, and the booking ID. You can run the 

report in one of two formats—by Booking Date 

(the date that the bookings were to occur) or by 

Cancel Date (the date that the bookings were 

canceled).

N/A

Cancellation Summary Summarizes, by reservation, all charges for 

bookings on a date or in a date range. The report 

shows the first and last bookings canceled within 

the reservation, the Group, the reservation 

number, the group contact, the event name, the 

event type, the total charges, and the reason for 

cancellation of the most recently canceled 

booking.   Reservations that do not have charges 

associated with the bookings are not displayed 

on this report. You can select Use Specific times 

and then enter a range of times to limit the report 

to bookings that occurred within this specified 

time range.

N/A
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Reservation Summary A summary of reservations that occurred within a 

specific date range. The report also lists 

complete reservation information (reservation 

number, event name, group, contact person, and 

so on) and booking dates. User defined fields can 

also be printed in this report. You can select Use 

Specific times and then enter a range of times to 

limit the report to reservations that occurred 

within this specified time range.

N/A

Report Description Options
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Exceptions reports

Report Description Options

Undefined Setups Lists the bookings on the selected date or date 

range for which no setup count has been 

entered. The report lists the following information 

for the bookings—the event name, time and 

location, contact name and phone number, 

booking status, and ID number. You can select 

Use Specific times and then enter a range of 

times to limit the report to bookings that occurred 

within this specified time range. You can enter 

information about the report, or a name or 

description for the report in the Report Comment 

field.

• Show Bookings on Start Date Only—If a booking is scheduled

overnight, then only the start date of the booking is displayed in the

report. For example, a booking exists for 3P Thursday through 10A

Friday. If this option is selected, then the booking is displayed only for

Thursday in the report.

Status Reminder Report Lists the bookings that have a status with a 

reconfirm date that falls within the selected date 

range. You typically use the information in this 

report to review tentative bookings. The report 

can be run in one of two formats—by Status Date 

(the date that the event was put in a “Tentative” 

status) or by Booking Date (the actual date of the 

event). You can select Use Specific times and 

then enter a range of times to limit the report to 

bookings that occurred within this specified time 

range. You can enter a report name or 

description or any pertinent information about the 

report in the Comment field.

N/A
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Wait List Report Lists all the bookings with a Wait status for the 

time period that you have requested. Detects 

situations where a booking has been canceled 

and there are one or more bookings with a Wait 

status that can now be changed to Confirmed, 

and indicates if the room is available. You can 

select Use Specific times and then enter a range 

of times to limit the report to bookings that 

occurred within this specified time range. 

N/A

Booking Conflict 

Analysis

Reviews information on all bookings for a date or 

date range and lists any conflicts 

Note: EMS does not allow double-bookings, but 

they might exist because conversion of 

data from systems that do allow them, or 

the result of users failing to restart EMS 

after encountering error messages.

N/A

Building Hours 

Exceptions

Lists events for a date or date range that fall 

outside of the configured building hours. Either 

event time or reserved time is checked based on 

the “Validate Building Hours on Event Time” 

parameter. The report also shows the start and 

end times, group, event name, location, 

reservation number, and booking number. You 

can select Use Specific times and then enter a 

range of times to limit the report to bookings that 

occurred within this specified time range. You can 

enter information about the report, or a name or 

description for the report in the Report Comment 

field.

N/A

Report Description Options
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Inactive Room With 

Bookings

Lists the bookings for a specified date or date 

range that are scheduled in inactive rooms. You 

can select Use Specific times and then enter a 

range of times to limit the report to bookings that 

occurred within this specified time range. You can 

enter information about the report, or a name or 

description for the report in the Report Comment 

field. You can click View to open the booking for 

viewing and editing, changing the status of the 

booking and/or emailing the group.

N/A

Inactive Groups With 

Reservations

Lists the reservations for a specified date or date 

range that are scheduled for inactive groups. You 

can click View to go to the reservation for viewing 

and editing, including changing the status of the 

reservation and/or its bookings.

N/A

Invalid Service Orders Lists the service orders that have a start time 

and/or end time that fall outside the reserved time 

for the room. Lists the category, date, reserved 

and event start and end times, location, group, 

reservation number, booking number, service 

order number and a description of the invalid 

order. You can select Use Specific times and then 

enter a range of times to limit the report to 

bookings that occurred within this specified time 

range. You can enter information about the 

report, or a name or description for the report in 

the Report Comment field.

Note: Service orders that fall outside the 

reserved time are considered invalid even 

if the Validate Service Order Times 

Against Booking parameter is set to “No.”)

N/A

Report Description Options
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Hoteling reports (EMS Workplace only)

Invalid Billing 

References

Lists the bookings for a particular date or date 

range that are in reservations that have invalid 

billing reference numbers. You can select Use 

Specific times and then enter a range of times to 

limit the report to bookings that occurred within 

this specified time range. You can enter 

information about the report, or a name or 

description for the report in the Report Comment 

field.

Note: A billing reference number is considered 

invalid if it has not been defined in the 

Billing Reference Configuration area but 

the Validate Billing Reference parameter 

is set to “Valid Only.”

N/A

Inactive Web Process 

Templates

Displays the inactive web process templates that 

are attached to reservations.

N/A

Report Description Options

Report Description Options

Room Occupancy 

Summary

Displays, by building and room type, the number 

and percentage of rooms occupied. 

N/A

No Show Lists the bookings for which the reservation 

holder did not check in. 

Note: A customer can be checked in via the 

EMS Kiosk, the EMS desktop client, or 

VEMS.

N/A
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Early Checkout Lists the bookings for which the reservation 

holder checked out before the end of the 

reserved time. 

Note: A customer can be checked out via the 

EMS Kiosk, the EMS desktop client, or 

VEMS.

N/A

Visitor Lists events for groups that have cities on their 

group record, other than what is specified in the 

Exclude Locations field. If multiple locations are 

to be listed, they should be entered with a comma 

between them (for example, Denver, Houston, 

Tampa, and so on).

N/A

Booking Notice 

Statistics

Lists the total bookings for a date or date range, 

divided into three “Amount of Notice” categories, 

where the Amount of Notice is the time between 

when the booking was scheduled and the date/

time for which it was scheduled. The report can 

be generated in one of two formats— “standard” 

or by room type.

N/A

Transition Tracks the occupants of hoteling spaces during a 

specified date range. Lists by floor and room 

where the occupant was last, what room the 

occupant is moving to, and who was in the space 

the previous day. Typically this report is run for a 

two day range and the days of the week must be 

checked. This report can be used by personnel 

who are responsible for preparing hoteling 

spaces for each occupant. 

• Show Details—Prints the categories that are associated with the

bookings.

• Highlight Changes Made Within:(days)—Changes that have been

made within the specified number of days are highlighted in the

report.

Arrivals and Departures Lists the departures and arrivals for a particular 

room by building and floor. The report shows the 

time of the departure if the customer is a 

departure and the time of the arrival if the 

customer is an arrival.   Typically, this report is 

run for a two day timespan listing the departure 

date first and the arrival date second. 

N/A

Report Description Options
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Groups With Multiple 

Bookings

Lists groups that have multiple bookings for the 

date or date range specified. The information is 

organized by date, and lists the start and end 

times, the room, the room type, and the booking 

status for each booking.

N/A

Check In Statistics Lists the percentage of customers who have 

checked in by building, building-room type, or 

room type.    

Note: A customer can be checked in via the 

EMS Kiosk, the EMS desktop client, or 

VEMS.

N/A

Report Description Options
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Accurate and timely billing is critical to ensuring a successful experience for organizations 
that schedule events at your facilities. EMS provides a variety of functions for working with 
invoices and transactions for reservations and bookings as well as for reporting on this 
information. 

This chapter covers the following topics:

• “Overview of Billing in EMS” on page 321.

• “Working with Invoices” on page 322.

• “Searching for Transactions” on page 335.

• “Working with Transactions” on page 341.

• “Generating an EMS Billing Report” on page 350.

• “Report Descriptions and Options” on page 352.
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Overview of Billing in EMS

In EMS, at a high-level, billing is a two-step process:

• The first step is to generate invoices. (See “Working with Invoices” on page 322.) You
can generate invoices based on reservation number, date range, or both. For example, you
could generate invoices for all bookings in Reservation 1829 that occurred last month.
After you have generated the invoices, EMS tracks the amount due and the age of the
invoices.

• The second step to is process received payments using the Payment Entry function. (See
“Searching for Transactions” on page 335.) You can also use this function to enter
deposits made against a reservation before invoicing or booking and to enter adjustments.

Financial transactions in EMS are batched by department. For example, if a user who is a 
member of the Scheduling department applies a deposit to a reservation, then the deposit is 
shown on a confirmation only if the user who applied the deposit or other users in the 
Scheduling department print the confirmation. If a user in another department, for example, 
the Catering department, prints the confirmation, then the deposit is not shown on the 
confirmation. Similarly, invoices that are generated by a department are printed on the 
Ageing report only if the report is generated for the same department. If you invoice a 
reservation or one of its bookings, any deposit that was previously made on the reservation is 
then applied and is no longer shown on the confirmation. If you invoice an event, the event is 
locked and cannot be edited. You can edit the event only after you void the invoice. You 
cannot void an invoice if payments have been made against it. You must first void the 
payments. You can use an adjustment with a negative dollar amount to clean up your 
financial records. For example, you generate an invoice for $102 for a group and the group 
returns a check for $100. If you do not want to ask the group for a $2.00 check, an 
adjustment of “$2.00-” balances your books.

As part of this process, you can generate the Billing Worksheet report. (See 
“Generating an EMS Billing Report” on page 350.) You use this report to review 
the dollar amounts for the bookings for which you intend to create invoices. You 
can correct any discrepancies that you note in the report by editing the bookings 
or booking items in question.
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Working with Invoices

You can generate an invoice in EMS based on a specific booking date or date range, a 
reservation number, or both. For example, you can generate invoices for all bookings from 
May 1 through May 14, for all bookings in reservation number 22, or for all bookings in 
reservation number 22 that occurred between May 1 and May 14. You can generate multiple 
invoices for the same booking, with each invoice showing the charges for a different 
category (such as room charges on one invoice, catering charges on another invoice, and so 
on). This might be necessary in situations in which you must produce multiple invoices for 
the same booking if the departments within your organization bill separately for the services 
they provide. You can also reprint an invoice and void an invoice.

You can work with invoices for a single reservation, or you can batch process multiple 
invoices. If you want to work with invoices for a single reservation, you do so through the 
Transactions tab in the Navigator. If you want to work with a batch of invoices, you do so 
through the EMS Billing menu: Billing > Invoices > Invoicing.

To generate an invoice

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 67), and on the Transactions tab, click New > Invoice.

• On the EMS main menu, click Billing > Invoices > Invoicing.

The Invoicing page opens.

Figure 9-1:  Invoicing page

Before you generate an invoice, you should generate the Billing Worksheet report. 
See “Generating an EMS Billing Report” on page 350.
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2. Do one of the following:

• Review the selections on this page, and optionally, make any needed modifications.

Field Description

Date Range tab

Department Select the department that is creating the invoices. The department 

name and address is printed at the top of the invoice. 

Note: This field is automatically populated if you have a default 

department assigned to your user account but you can select a 

different value if needed.

Reservation Number Automatically populated if you are generating an invoice from the 

Transaction tab; otherwise, enter a reservation number.

Starting Date

Ending Date

Automatically populated with the first (starting) booking date and the last 

(ending) booking date for the selected reservation when you are 

generating an invoice from the Transaction tab; otherwise, enter the 

date range of the bookings for which you are generating the invoice.

Use Specific Times If only a specific time for the bookings is to be invoiced (for example, the 

bookings are from 8 am to 5 pm and you want to invoice the booking 

from only 8 am to noon), then click Use Specific Times, and then enter a 

specific time period.

Invoice Date The default value is the current day’s date. You can leave this value as 

is, or enter a different date.

Due Date The system default value is 30 days from the current day’s date. (Your 

EMS administrator might have configured a different default value for 

this field.) You can leave in the field as is, or you can enter a different 

date.

Buildings tab/Categories tab/Statuses tab/Group Types tab

Open the appropriate tab on the page and select the buildings, resource categories, booking 

statuses, and group types that are to be invoiced. This information is displayed on the invoice.

Note: A Show Inactive option is available for both categories and statuses. Select this option to 

show inactive categories and statuses. You can select these inactive items as part of your 

filtering criteria.

Note: To select a building, category, and so on, select the item in the Available list (CTRL-click to 

select multiple items), and then click the Move button (>) to move the items to the Selected 

list. 

Options tab—Format settings for a printed confirmation

Header Message

Footer Message

Select the header message and footer message that is to be printed on 

the invoice. By default, the header and footer messages are printed on 

every page of the invoice. To print the header only on the first page of 

the invoice, clear the Print Header on Each Page option.

Currency Select the currency that indicates how a room or resources in a 

category should be charged.

Print Comments Include the comments for the reservation in the printed invoice.

Print Reminders Include the reminders for the reservation in the printed invoice.

Print User Defined 

Fields

Include user-defined fields and their values in the printed invoice. 
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• On the Setup dropdown list, select a saved, or memorized, invoice.

3. Select the output format for the invoice, and then click Generate Report.

The generated invoices are displayed in the Invoicing dialog box. By default, invoices
with a zero balance are not shown. See Figure 9-2 on page 325.

Suppress Reserved 

Time

Do not show the reserved time on the printed invoice. (Instead, only the 

event time is included on the printed invoice.)

Print Item Notes Include the notes for any booking items in the printed invoice.

Print Zero Priced Items Include resources for which there was no charge in the printed invoice.

Print Item Selections Include any resource item selections in the printed invoice.

Print Header On Each 

Page

Include the selected Header message on each page of the printed 

invoice.

Suppress Logo Do not show your department’s/organization’s logo on the printed 

invoice.

Print Billing Reference 

Allocation

Include the billing reference numbers for the event as well as the 

percentage of charges that is allocated to each number in the printed 

invoice.

Print Category 

Subtotals

Include the subtotal charges by category in the printed invoice.

Display Messages as 

HTML

If you have defined any HTML messages, then select this option to 

display the HTML version of these messages in the printed invoice; 

otherwise, the message is displayed in plain text.

If needed, you can always save, or memorize, these settings. See “Working with 
Memorized Reports” on page 293.

If you select a memorized confirmation, then the only changes that you can make 
are to the dates and/or times on the Date Range tab.

Field Description
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Figure 9-2:  Invoicing dialog box with generated invoices

4. Optionally, you can do one or more of the following to work with the invoices that are
displayed; otherwise, if you are satisfied with the invoices, you can go to Step 5 to post
the invoice.

• To show zero balance invoices in the window, clear the Hide Zero Balances option.

• To preview an invoice, select the invoice, or CTRL-click to select multiple invoices,
and then click Preview.

If you selected the default format of HTML on the Invoicing dialog box, then the invoice 
is displayed onscreen in its own page. The preview is titled “Invoice Preview” to 
distinguish the invoices from invoices that have been posted. You can use your browser 
options to view the invoice prior to printing, set your printing options, print the invoice, 
and so on. For all other invoice formats, you must indicate whether to open the invoice, 
or to save the invoice. To open an invoice in any format other than HTML, you must 
have the correct application installed on your client:

Output Format Required Application

PDF Adobe Reader or Adobe Acrobat

RTF Microsoft Word

XLS Microsoft Excel

HTML Web Browser

TEXT Notepad or Textpad

TIFF Any graphics application including 

Microsoft Paint and Microsoft Office 

Picture Manager.
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• To change the criteria for the invoices, click Filter to return to the Invoicing window
After changing the criteria, you can generate the invoices again.

5. To post an invoice, select the invoice, or CTRL-click to select multiple invoices, and
then click Final.

A message opens warning you that you are about to post and print (#) invoices, and
asking you if want to continue.

6. Click Yes.

The message closes and an onscreen preview of the final invoices opens. The preview is
titled “Invoices” and each invoice has been issued an invoice number. The preview page
contains options for printing a hard copy of the invoices, and so on. Select the option or
options that best fit your working needs.

After you generate and post an invoice, the message “Items have been invoiced” is displayed 
in red text on the Reservation Summary tab, the Booking Summary tab, and the <Booking 
Detail> Summary tab in the Navigator. The booking detail folder in which the invoiced items 
reside now has a green background in the Booking Details pane and the icon for each 
invoiced item also has a green background in the Items pane. Also, the invoice is 
permanently saved, and you cannot edit it. You can make changes to the balance due for a 
reservation only by creating an adjustment or by voiding the invoice and regenerating it after 
you edit the booking information. (Because invoiced bookings are locked and cannot be 
edited, you must void the invoice before you can edit the bookings.) 

To reprint an invoice

You can reprint both non-voided and voided invoices. You can reprint invoices for only one 
department at a time from the Billing area of EMS. Reprinting an invoice does not 
recalculate the invoice. The invoice is simply printed as it appeared when it was first 
generated. You can specify the invoices that you are reprinting, or you can search for 
invoices that meet specific criteria, and then select specific invoices to reprint from the list of 
search results. 

To specify invoices for reprinting

1. On the EMS main menu, click Billing > Other > Reprint Invoices.

The Reprint Invoices page opens. See Figure 9-3 on page 327.

To reprint invoices for one or more departments, you must select the reservation in 
the Navigator, open the Transactions tab and CTRL-click to select the multiple 
invoices that you are reprinting, and then use the Reprint option on the 
Transactions tab.
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Figure 9-3:  Reprint Invoices page

2. In the Department field, select the department that generated the invoices.

3. In the Invoice No. field, enter the number of the invoice that you are reprinting, and then
click Add.

The invoice is displayed (by number) in the lower right Invoice pane.

4. Repeat Step 3 until you have added all the invoices that you are reprinting.

5. Leave the reprinting criteria set to their default values, or optionally, edit them as needed.

6. Click OK.

A message opens, asking if you want to open or save the Invoice.pdf.

This field is automatically populated if you have a default department assigned to 
your user account but you can select a different value if needed.

Option Description

Invoices The invoice type that you are reprinting—Non Voided (the default value) 

or Voided.

Format Select the sort order for the reprinted invoices. The default value is By 

Reservation.

First Transaction Date

Last Transaction Date

Leave these values blank to reprint the invoice for all bookings; 

otherwise, enter the date range of the bookings for which you are 

reprinting the invoice.

Print Header on Each 

Page

Leave this option selected to print the invoice header on every page of 

the invoice.

Print Transactions Select this option to include any associated transactions (deposits, 

payments, and so on) in the reprinted invoice.
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7. Select the option that best fit your working needs.

• If you click Open, the Invoice opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

To search for invoices to reprint

1. On the EMS main menu, click Billing > Other > Reprint Invoices.

The Reprint Invoices page opens.

Figure 9-4:  Reprint Invoices page

2. Enter the criteria to search for the invoices that you are reprinting.

As you enter the search criteria, the lower left Invoice pane is dynamically updated with
the invoices that meet the criteria. The Note column in this pane indicates if payments
have been made against the invoice.

Field Description

Department The department that generated the invoice. You can search for invoices 

for reprinting as long as the invoices were generated by the same 

department. 

Note: This field is automatically populated if you have a default 

department assigned to your user account but you can select a 

different value if needed.

Invoices Select the type of invoice for which to search—Non Voided or Voided.

First Transaction Date

Last Transaction Date

You must enter at least a First Transaction date. By default, the Last 

Transaction date is set to the same date. You can change the Last 

Transaction date if needed.

Show Paid Invoices Leave this option selected to include paid invoices in the search.



329

 
Billing

3. Leave the reprinting criteria set to their default values, or optionally, edit them as needed.

4. In the lower left Invoice pane, select the invoice, or CTRL-click to select the multiple
invoices that you are reprinting, and then click the Move button (>) to move the selected
invoices to the lower right Invoice pane.

5. Click OK.

A message opens, asking if you want to open or save the Invoice.pdf.

6. Select the option that best fit your working needs.

• If you click Open, the Invoice opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

To void an invoice

You can void an invoice only if the invoice has not been paid. If payments have been made 
against an invoice, you must first void the payments.You can void invoices for only one 
department at a time. When you void an invoice, the invoice is removed from the Ageing 
report and its associated bookings are unlocked. You can specify the invoices that you are 
voiding, or you can search for invoices that meet specific criteria, and then select specific 
invoices to void from the list of search results. 

To specify invoices to void

1. On the EMS main menu, click Billing > Other > Void Invoices.

The Void Invoices page opens. See Figure 9-5 on page 330.

Option Description

Format Select the sort order for the reprinted invoices. The default value is By 

Reservation.

Print Header on Each 

Page

Select this option to print the invoice header on every page of the 

reprinted invoice.

Print Transactions Select this option to include any associated transactions (deposits, 

payments, and so on) in the reprinted invoice.

You can also void an invoice from the Transactions tab when a reservation is 
selected in the Navigator. 
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Figure 9-5:  Void Invoices page

2. In the Department field, select the department that generated the invoices.

3. In the Invoice No. field, enter the number of the invoice that you are voiding, and then
click Add.

A Void Reason dialog box opens.

Figure 9-6:  Void Reason 



331

 
Billing

4. Enter a reason for voiding the invoice, and then click Close.

Two results are possible:

• If payments have not been applied to the invoice, then Void Reason dialog box
closes and the invoice is displayed (by number) in the lower right Invoice pane.
Repeat Step 3 through Step 4 until you have selected all the invoices from the same
department that you are voiding, and then continue to Step 5.

• If payments have been applied to the invoice, then an error message opens indicating
that payments have been applied to the invoice and it cannot be voided. You must
void the payments first before you can continue with voiding the invoice. See “To
void a transaction” on page 347.

5. Do one of the following:

• To review an invoice before you void it, go Step 6.

• To void an invoice without reviewing it, go to Step 8.

6. Optionally, before you void a selected invoice, you can review it to ensure that it is
indeed an invoice that you want to void. In the lower right Invoice pane, select the
invoice, or CTRL-click to select multiple invoices, and then click Preview.

A message opens, asking if you want to open or save the Invoice.pdf.

7. Select the option that best fit your working needs.

• If you click Open, the Invoice opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

8. In the lower right Invoice pane, select the invoice, or CTRL-click to select the multiple
invoices that you are voiding, and then click OK.

A message opens asking you if you are sure that you want to void the selected invoices.

9. Click Yes.

A message opens indicating that the invoices have been voided.

10. Click OK

The message and the Void Invoices dialog box close. The Void column is set to Yes on
the Transactions tab for each of the voided invoices in the Navigator.
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To search for invoices to void

1. On the EMS main menu, click Billing > Other > Void Invoices.

The Void Invoices page opens.

Figure 9-7:  Void Invoices page

2. Enter the criteria to search for the invoices that you are voiding.

As you enter the search criteria, the lower left Invoice pane is dynamically updated with
the invoices that meet the criteria. The Note column in the pane indicates if payments
have been made against the invoice.

Field Description

Department The department that generated the invoice. You can search for invoices 

for voiding as long as the invoices were generated for the same 

department. You cannot void invoices from different departments.

First Transaction Date

Last Transaction Date

You must enter at least a First transaction date. The Last transaction 

date is optional.

Show Paid Invoices Leave this option selected to include paid invoices in the search. If you 

want to void an invoice against which payments have been made, then 

this reminder serves to prompt to you to first void the payments before 

you void the invoice. See “To void a transaction” on page 347.

As you enter the search criteria, the lower left Invoice pane is dynamically 
updated with the invoices that meet the criteria. The Note column in this pane 
indicates if payments have been made against the invoice.
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3. Select the invoice, or CTRL-click to select the multiple invoices that you are voiding,
and then click the Move button (>).

A Void Reason dialog box opens.

Figure 9-8:  Void Reason 

4. Enter a reason for voiding the invoice, and then click Close.

The Void Reason dialog box closes. The invoices are displayed (by number) in the lower
right Invoice pane.

5. Do one of the following:

• To review an invoice before you void it, go Step 6.

• To void an invoice without reviewing it, go to Step 8.

6. Optionally, before you void a selected invoice, you can review it to ensure that it is
indeed an invoice that you want to void. In the lower right Invoice pane, select the
invoice, or CTRL-click to select multiple invoices, and then click Preview.

A message opens, asking if you want to open or save the Invoice.pdf.

7. Select the option that best fit your working needs.

• If you click Open, the Invoice opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

8. In the lower right Invoice pane, select the invoice, or CTRL-click to select the multiple
invoices that you are voiding, and then click OK.

A message opens asking you if you are sure that you want to void the selected invoices.

Remember, you can select an invoice for voiding only if payments have not been 
applied to the invoice. 
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9. Click Yes.

A message opens indicating that the invoices have been voided.

10. Click OK

The message and the Void Invoices dialog box close. The Void column is set to Yes on
the Transactions tab for each of the voided invoices in the Navigator.
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Searching for Transactions

A transaction in EMS can be one of four types—a deposit (deposit and damage deposit), a 
payment, an adjustment, or a refund. 

You can use the Browse Transaction function to search for any of these transaction types. 
The results are displayed in a list view. When you carry out a search in the for a transaction, 
you can carry out a basic search or an advanced search. A basic search is based on the basic 
information that you specify for a transaction when you first create it, such as the group to 
which the transaction applies, the department that generated the transaction, and so on. An 
advanced search is a field level search that is carried out the reservation level, the transaction 
level, or a combination of these. For example, in an advanced search, you can specify criteria 
as granular as the Bill To Contact at the reservation level. 

Transaction 

Type

Description

Deposit A deposit is the dollar amount paid in advance of a meeting or event before 

invoicing occurs. 

• A deposit is added to a reservation. After you invoice the reservation, all

outstanding deposits are applied to the invoice to reduce the balance due.

• A damage deposit is used to a collect a deposit that is not applied to an

invoice and therefore, does not reduce the balance due. Instead, if the

customer does not damage the room, any reserved equipment, and so on,

then you must return the damage deposit to the customer by voiding the

damage deposit transaction.

Payment A payment is the dollar amount that is applied to an invoice to reduce the 

balance due. A pre-payment is similar to a deposit and is applied to a 

reservation. 

Adjustment An adjustment is a modification that is made to the amount due on an existing 

invoice. For example, if you send out an invoice to a group for $202.00 and the 

group sends you a check for $200.00, you can make an adjustment of “$2.00-” 

to close out the invoice. 

Refund A refund is the return of funds that have been applied to an invoiced 

reservation. 

You can find all transactions for a reservation on the Transactions tab in the 
Navigator. See “Reservation folder” in  ,“The Navigator,” on page 65.
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To search for a transaction

1. On the EMS main menu, click Billing > Other > Browse Transactions.

The Browse Transactions page opens. The first time that the Browse Transaction page
opens, the Filter tab is set by default to a basic search; otherwise, the Filter tab is set to
the search type (Basic or Advanced) that you last carried out.

Figure 9-9:  Browse Transactions page, Basic search options

2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and
then continue to one of the following:

• “To carry out a basic transaction search.”

• “To carry out an advanced transaction search” on page 338.

To carry out a basic transaction search

1. Enter the search criteria.

Field Description

• Starting Time

• Ending Time

The date range during which the transactions were carried out. Both are 

optional. 

Group
Click the Search icon  to open the Groups page and search for a for 

the group for which the transactions apply. See “To search for a group 

and/or contact” on page 231.
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2. Optionally, click Options and edit the default value the Number of Records to Return
search option.

3. Click Get Data or Refresh.

The search results are displayed on the Results tab.

Figure 9-10: Browse Transactions page, Results tab

Department Leave the default value set to (all) or select a specific department that 

generated/issued the transaction.

Transaction Type Leave the default value set to (all), or select a specific transaction type 

for which to search.

Invoice Number If you are searching for a specific invoice or invoices, enter a search 

string.

Note: The search is not case-sensitive, but your search is limited to the 

exact order of characters in the string and it must begin with the 

information for which you are searching. For example, a search 

string of 10 returns 1000, 1017, but not 910.

Reservation ID Leave the default value set to 0 to search for a transaction regardless of 

reservation ID; otherwise, enter the exact value of the reservation ID.

Amount Leave the default value set to 0.00 to search for transactions regardless 

of the transaction amount; otherwise, enter the exact amount of the 

transaction.

Field Description
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4. Optionally, do one or more of the following:

• The lower pane on the Results tab is an EMS Browser window. See “An EMS
Browser Page” on page 25 for all the features that are available for this pane.

• Click Print to print the search results.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

5. Click Close.

To carry out an advanced transaction search

Figure 9-11: Browse Transaction page, Advanced search options

1. Optionally, enter a Starting Date, an Ending Date, or both.

2. Optionally, if the Starting Date and the Ending Date are the same, select Use Specific
Times and enter specific time periods to search.

Use Specific Times is available only if the Starting Date is the same as the Ending 
Date.
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3. For each field level option by which to carry out the search:

• Select the field level option, and then click the Move button (>).

• When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

4. Optionally, click Options and edit the default values for one or more additional search
options—Date/Time Filter, Number of Records to Return, and Specific Room Filters.

5. Optionally, click Options and edit the default value the Number of Records to Return
search option.

6. Click Get Data or Refresh.

The search results are displayed on the Results tab.

Figure 9-12: Browse Transactions page, Results tab

To filter the list of available fields, in the Level Search field and/or the Field 
Search field, enter a search string. Your search is limited to the exact order of the 
characters in the string, but the search string is not case-sensitive and it can 
appear anywhere in the search results. For example, a search string of type 
returns Type, Payment Type, and so on. 

If you have specific fields and/or values by which you always want to carry out a 
search, then you can set up these fields to be your Favorite fields. See “To set up 
favorite fields for a Transaction search” on page 340.
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7. Optionally, do one or more of the following:

• The lower pane on the Results tab is an EMS Browser window. See “An EMS
Browser Page” on page 25 for all the features that are available for this pane.

• Click Print to print the search results.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• Click Filter to return to the Filter tab, make any necessary changes to the search
criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

8. Click Close.

To set up favorite fields for a Transaction search

If you have specific fields and/or values by which you always want to carry out a Transaction 
search, you do not have to filter the list of fields on the All Fields tab for every search. 
Instead, you can set up each of these fields to be a favorite field with a specific value or limit 
if needed. 

1. Open the Browse Transactions page, and make sure that the Advanced search features
are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields
tab, and then click Add to Favorites.

The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on
the Filter dialog box.

The next time that you carry out a search, you can simply open the Favorite Fields tab or
the Saved Values tab to carry out a search based on your customized list of search fields.
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Working with Transactions

Working with transactions in EMS consists of entering the transaction correctly, and if 
needed voiding a transaction. You can:

• Enter a deposit and void a deposit.

• Enter a payment and void a payment.

• Enter an adjustment and void an adjustment.

• Enter a refund and void a refund.

The steps for entering the different types of transactions are specific to the transaction. The 
steps for voiding a transaction are identical, regardless of the transaction type.

To enter a deposit or damage deposit for a reservation

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 67), and on the Transactions tab, click New > Payment.

• On the EMS main menu, click Billing > Payments > Payment Entry, and then on the
Payment Entries page, click New.

The Payment Entry dialog box opens.

Figure 9-13: Payment Entry dialog box

If needed, you can first search for a transaction to ensure that it has not already 
entered or voided. See “To search for a transaction” on page 336.
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2. Enter the deposit information.

3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the
Transactions tab for the reservation.

Field Description

Transaction Date The default value is the current day’s date. You can edit this value if 

needed.

Department Select the department.

Transaction Type Select the transaction type—Damage Deposit, Deposit (Reservation), or 

Deposit (Bookings).

• A Deposit (Reservation) is best suited for reservations with one or

more bookings that are to be invoiced in their entirety upon

completion of the event.

• A Deposit (Bookings) is best suited for reservations with multiple

bookings, for example, an event with multiple occurrences spanning

several months, that is to be billed monthly. A Deposit (Bookings)

allows you to spread the deposit across multiple months so that only

a portion of the deposit is consumed and applied to the invoice that is

generated monthly. In this scenario, a large deposit that is entered as

Deposit (Reservation) would be consumed in its entirety by the first

invoice that is generated.

Payment Type Select the payment type.

Check No. Enter a check number if you selected “Check” as the payment Type.

Amount Enter the amount of the deposit.

Currency Select the currency for the deposit.

Reservation No. Automatically populated if you opened the Payment Entry dialog box 

from the Transaction tab in the Navigator; otherwise, enter a reservation 

number or click the Search icon  to open the Reservations page and 

search for a reservation.

Invoice No. N/A as deposits are applied before an invoice is generated. The 

invoicing process totals the charges for the specified date range, 

consumes any applied reservation deposits, and results in a net balance 

due for the invoice. The invoicing process does not consume any 

Damage deposits. 

Notes Optional. Enter any other comments or statements that explain or clarify 

the deposit.
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To enter a payment or pre-payment

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 67), and on the Transactions tab, click New > Payment.

• On the EMS main menu, click Billing > Payments > Payment Entry, and then on the
Payment Entries page, click New.

The Payment Entry dialog box opens.

Figure 9-14: Payment Entry dialog box

2. Enter the payment information.

Field Description

Transaction Date The default value is the current day’s date. You can edit this value if 

needed.

Department Select the department.

Transaction Type Select the transaction type—Payment or Pre-payment.

Note: Remember that pre-payments act just like deposits in that they 

are applied to a reservation and are applied to an invoice 

reducing the balance due. Payments are applied to an invoice.

Payment Type Select the payment type.

Check No. Enter a check number if you selected “Check” as the payment Type.

Amount Enter the amount of the payment.

Currency Select the currency for the payment.



344

 
Billing

3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the
Transactions tab for the reservation.

Reservation No. • If you selected Payment as the Transaction Type, then this field is not

available as payments are applied against invoices, not reservations.

• If you selected Pre-payment as the transaction type, then the field is

automatically populated if you opened the Payment Entry dialog box

from the Transaction tab in the Navigator; otherwise, you must enter

a reservation number or click the Search icon  to open the

Reservations page and search for a reservation.

Invoice No. • If you selected Pre-payment as the Transaction Type, then this field is

not available as pre-payments are applied before an invoice is

generated.

• If you selected Payment as the Transaction Type, then you must

enter an invoice number in this field, or click the Search icon  to 

open the Invoices page and search for an invoice.

Notes Optional. Enter any other comments or statements that explain or clarify 

the payment.

Field Description
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To enter an adjustment for an invoice

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 67), and on the Transactions tab, click New > Payment.

• On the EMS main menu, click Billing > Payments > Payment Entry, and then on the
Payment Entries page, click New.

The Payment Entry dialog box opens.

Figure 9-15: Payment Entry dialog box

2. Enter the adjustment information.

Field Description

Transaction Date The default value is the current day’s date. You can edit this value if 

needed.

Department Select the department.

Transaction Type Select the transaction type—Adjustment.

Payment Type Select the payment type.

Check No. Enter a check number if you selected “Check” for the payment type.

Amount Enter the amount of the adjustment. To decrease the invoice by the 

indicated amount, enter a minus sign (-) before or after the amount.

Currency Select the currency for the adjustment.

Reservation No. N/A as adjustments are applied to invoices.

Invoice No.
You must enter an invoice number or click the Search icon  to open 

the Invoices page and search for an invoice
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3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the
Transactions tab for the reservation.

To enter a refund

1. Do one of the following:

• Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
on page 67), and on the Transactions tab, click New > Payment.

• On the EMS main menu, click Billing > Payments > Payment Entry, and then on the
Payment Entries page, click New.

The Payment Entry dialog box opens.

Figure 9-16: Payment Entry dialog box

Notes Optional. Enter any other comments or statements that explain or clarify 

the adjustment.

Field Description
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2. Enter the refund information.

3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the
Transactions tab for the reservation.

To void a transaction

You can void a transaction for a reservation from the Transactions tab, or you can void a 
transaction from the Payment Entries page.

To void a transaction from the Transactions tab

1. Open the reservation in the Navigator. (See “Opening a reservation in the Navigator” on
page 67.)

2. Open the Transactions tab, and on the Transactions tab, select the transaction, or CTRL-
click to select the multiple transactions that you are voiding, and then click Void.

A Void Reason dialog box opens. See Figure 9-17 on page 348.

Field Description

Transaction Date The default value is the current day’s date. You can edit this value if 

needed.

Department Select the department.

Transaction Type Select the transaction type—Refund.

Payment Type Select the payment type.

Check No. Enter a check number if you selected “Check” as the payment type.

Amount Enter the amount of the refund.

Currency Select the currency for the refund.

Reservation No. N/A as refunds are applied to invoices.

Invoice No.
You must enter an invoice number or click the Search icon  to open 

the Invoices page and search for an invoice

Notes Optional. Enter any other comments or statements that explain or clarify 

the refund.
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Figure 9-17: Void Reason dialog box

3. Enter the reason for voiding the transactions, and then click Close.

The Void Reason dialog box closes and a message opens indicating that the transaction
has been voided.

4. Click OK.

The Void Transaction message closes. The Void column is set to Yes for each of the
voided transactions in the Navigator.

To void a transaction from the Payment Entries page

1. On the EMS main menu, click Billing > Payments > Payment Entry.

The Payment Entries page opens. This page lists all transactions (voided and
non-voided) that were ever made in your EMS system for a selected department on a
selected date.

Figure 9-18: Payment Entries page
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2. Select the date (the default value is the current day’s date) and the department for which
you are voiding the transaction.

The Payment Entries page is updated with the list of payments that meet the date and
department criteria.

3. Select the transaction that is to be voided, and then click Edit.

The Payment Entry dialog box opens. This page details specific information for the
selected transaction. (See Figure 9-13 on page 341.)

4. Click Void, and then in the Void Comment field, enter a reason for voiding the
transaction.

5. Click OK.

The Payment Entry dialog box closes. You return to the Payment Entries page. The Void
column is set to Yes for the voided transaction.
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Generating an EMS Billing Report

All EMS Billing reports are available under the Billing option on the main menu. For any 
EMS report, you can specify the parameters, options, and format for the report, or you can 
generate the report according to memorized settings. (For detailed information about a 
memorized report, see “Working with Memorized Reports” on page 293.) Not all reports 
require the same parameters, nor do they all have the same options available. In addition, you 
can generate different reports in different formats.

To generate a report

1. On the EMS main menu, click Billing to open the Billing menu, and then do one of the
following:

• To generate the Billing Worksheet report, click Billing > Invoices > Billing
Worksheet.

• To generate any other Billing report, click Billing > Reports, and then click the
option for the report that you are generating. For example, to generate the Ageing
report, click Billing > Reports > Ageing.

2. On the Setup dropdown list, do one of the following:

• To generate the report according to the filter settings that you want (parameters,
options, and so on), leave user-specified selected, then go to Step 3.

• To run the report with filter settings that have been saved, or memorized, select the
memorized report, and then go to Step 4.

3. Specify the report parameters, options, and format. See:

• “Invoice reports” on page 353.

• “Reports” on page 353.

The parameters and options that are available for each report are discussed in 
“Report Descriptions and Options” on page 352. Contact your EMS 
administrator if you need assistance in generating any of these report.

All Billing reports other than the Billing Worksheet report are also available from 
Reports > Billing.

For detailed information about memorized reports, see “Working with Memorized 
Reports” on page 293.
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4. Click Generate Report.

If you selected the default format of HTML, then the report is displayed onscreen in its
own page. You can use your browser options to view the report prior to printing, set your
printing options, print the report, and so on. For all other report formats, you must
indicate whether to open the report, or to save the report. To open a report in any format
other than HTML, you must have the correct application installed on your client:

Unless you change the setup, all subsequent reports will be generated and printed 
according to the parameters and options that you have specified and in the format that 
you specified. If you want to save certain settings so that you do not have to adjust the 
filter settings every time you run the report, you can memorize the report. See “Working 
with Memorized Reports” on page 293.

Output Format Required Application

PDF Adobe Reader or Adobe Acrobat

RTF Microsoft Word

XLS Microsoft Excel

HTML Web Browser

TEXT Notepad or Textpad

TIFF Any graphics application including 

Microsoft Paint and Microsoft Office 

Picture Manager.
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Report Descriptions and Options

This section provides a description of every EMS report in the categories listed below and it 
also defines the options that are available for each report.

See:

• “Invoice reports” on page 353.

• “Reports” on page 353.
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Invoice reports

Reports

Report Description Options

Billing Worksheet Provides information on how bookings are to be 

invoiced. The report can include bookings within 

a date range, bookings within a reservation, or 

bookings within a date range inside a reservation. 

The report breaks down the charges in the same 

way as an invoice. The report also provides 

options for printing heading/footer messages and 

the detail for zero-dollar items.

See “Options tab—Format settings for a printed confirmation” in “To 

generate an invoice” on page 322.

Report Description Options

Ageing Report A list of outstanding invoices. Current invoices 

are listed first, followed by past due invoices 

organized by age. Ageing Reports are based on 

department. 

• Currency—Select the currency for the invoices.

• Show Unapplied Deposits—Deposits that are applied to reservations

that have not been invoiced are displayed on the report.
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Statements A list of outstanding invoices for a selected group. 

Current invoices are listed first, followed by past 

due invoices organized by age.

• Currency—Select the currency for the invoices.

• Report Title—Can create a title that is displayed at the top of the

statement.

• Header Message—Select a message from the pre-configured

messages that is displayed at the top of every page of the statement.

• Include Transactions On Zero Balance Invoices Within [ ]days—

Statements that have a zero balance within the specified number of

days are displayed.

• Show Billing Reference Number—The billing reference number is

displayed under the invoice information.

• Show Purchase Order Number—The purchase order number is

displayed under the invoice information.

• Show Transaction Notes—Any notes entered for the transaction are

displayed under the invoice information.

• Use Current group Address - The current address of the group is

displayed on the statement. (This address might or might not be the

address for the group when the reservation was made.)

Report Description Options
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Transaction Report Shows all the billing transactions during a 

specified period if you generate the report in the 

By Transaction Type by Date format. Simply 

enter the date or date range and click Print. The 

report lists the group, event name, reservation ID, 

transaction date, transaction type, invoice 

number, check number, and amount. 

Note: If the report is generated in Standard 

format, deposits are not shown as 

transactions if they have been absorbed 

by the generation of an invoice. 

Note: You can also generate the Transaction 

Report from within a reservation to see 

only transactions for the selected event 

and you can generate the Transaction 

Report from the Print option on the 

Payment Entries page. Click Billing > 

Payments > Payment Entry, and then on 

the Payment Entries page, click Print.

Currency—Select the currency for the billing transactions.

Voided Transaction 

Report

Lists the payments, deposits, or adjustments that 

were voided on a specific date or within a date 

range. Lists the group, event name, reservation 

ID, transaction date and type, invoice number (if 

applicable), check number, and amount.

Currency—Select the currency for the voided transactions.

Invoice Detail Report Provides detail for all invoices that were 

generated within a given date range.

Note: See “To reprint an invoice” on page 326 

for detailed instructions about the options 

that are available for the Print Invoice 

Detail dialog box.

N/A

Report Description Options
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General Ledger 

Distribution

Shows the totals for invoices that were generated 

within a given date range. Entries are broken 

down by account, invoice, rate plan, or invoice. 

You can also generate this report in a Summary 

format.

• Currency—Select the currency for the invoices.

• Invoices With Payments Only—Only invoices where payment has

been received are posted on the report.

• Show Applied Deposits/Prepayments—Applied deposits and

prepayments are posted on the report. (An applied deposit is a

deposit on a reservation that has been invoiced.)

Report Description Options
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As an EMS user, you can manage many aspects of your account to better suit your working 
needs.

This chapter covers the following topics:

• “Setting User Preferences and Default Values” on page 359.

• “Changing your Password” on page 362.
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Setting User Preferences and Default Values

Preferences, like system parameters, are settings that affect the basic functioning of your 
EMS system. The difference is that system parameters are global settings that affect all users 
on the system, whereas preferences are applicable only to your user account. You can set the 
values for many preferences for your EMS instance to better suit your working needs. These 
preferences include the time interval for Time dropdown fields, the size of the paper on 
which reports, confirmations, and invoices are to be printed, the format in which to send 
emails from your computer, and the default values for specific fields in the Reservation 
Wizard and other EMS client windows.

To set user preferences and default values

1. On the EMS main menu, click Settings > Preferences.

The Preferences dialog box opens. The Preferences tab is the active tab.

Figure 10-1: Preferences dialog box, Preferences tab

2. Edit your user preferences as needed.

Field Description

Time Drop Down 

Interval

The time interval displayed on a Time dropdown list—i.e., if you select 

30 minutes, then options on the dropdown list are displayed as 1:00 

1:30, 2:00 and so on. All Time dropdown lists are 24 hour lists.

Paper Size The size of the paper on which reports, confirmations, and invoices are 

printed. Values are Letter, Legal, and A4.



360

 
User Settings

3. Open the Defaults tab, and set the default values for the indicated items.

Figure 10-2: Preferences dialog box, Defaults tab

Review Notifications 

When Navigator Opens

If this option is selected, then a notification in the Dashboard is 

automatically marked as “Reviewed” if you select the notification, and 

then click Go To. If this option is not selected, then you must select a 

notification, and then click Reviewed to manually mark the notification 

as “Reviewed.”

Email Format The format in which your emails are sent—HTML or Plain Text.

Send Emails Using 

Department Email 

Address

Select this option if you want the From email address for all the emails 

that you send from EMS to be the email address of the department that 

is associated with your user account.

Use Global Email 

Settings

If you want to use the global email settings that your EMS administrator 

has defined, then select this option.

SMTP Email Contact your EMS administrator with assistance in specifying these 

values.

Note: If you are using SMTP Email settings that are specific to your 

account, then you also have the option of creating a signature 

that is to be included in all the emails that you send from EMS. 

You can design the signature in plain text on the Design tab or in 

HTML format on the HTML tab. You can always preview the 

signature on the Preview tab.

Field Description

Building You can select all buildings, a specific building, or a specific view or 

area. The value that you select here automatically populates the 

Building dropdown list in the Reservation Wizard and other EMS client 

pages, for example, the Visitors page. 

Field Description



361

 
User Settings

4. Click OK to close the Preferences dialog box and apply your edited preferences and
default values.

Status

Event Type

Event Name

Event Time

Reservation Source

Time Zone/ Display 

Audit Times in This 

Time Zone

Currency

The values that you select here automatically populate the appropriate 

fields in the Reservation Wizard, and other EMS client pages.

Note: The event name can be a maximum of 30 characters, including 

spaces.

Field Description
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Changing your Password

When your EMS administrator first sets up your user account, your password is predefined 
for you. You can change this password if you want.

To change your password

1. On the EMS main menu, click Settings > Change Password.

The Change Password dialog box opens.

Figure 10-3: Change Password dialog box

2. Do the following:

• In the Old Password field, enter your current EMS password.

• In the New Password field, enter the new password.

• In the Re-enter New Password field, enter your new password again, exactly as you
entered it in the New Password field.

3. Click OK to close the Change Password dialog box.

The next time that you log in to EMS, you must use your new password.
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EMS contains several miscellaneous standalone functions to assist you in managing and 
maintaining reservations and bookings in your system as well as managing your general 
work requirements. 

This chapter covers the following topics:

• “Recording Actual Attendance Numbers for Bookings” on page 365.

• “Sending Email from EMS” on page 367.

• “Viewing a History of Sent Emails” on page 373.

• “Generating Multiple Confirmations” on page 375.

• “Managing Attendees and Visitors” on page 379.
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Recording Actual Attendance Numbers for 

Bookings

You use the Attendance Entry tool to view and record the actual attendance for bookings. 
(The tool does not address reservation-level attendance.) The actual attendance numbers that 
you enter do not replace the setup count (i.e., the estimated attendance) that you entered prior 
to an event. Reports that provide attendance information typically provide both the estimated 
attendance and the actual attendance.

To record actual attendance numbers for bookings

1. On the EMS main menu, click Reservations > Other > Attendance Entry.

The Attendance Entry page opens.

Figure 11-1: Attendance Entry page

2. In the Date field, select a date for which you are recording the booking attendance.

3. Optionally, specify a building and/or a booking status to filter the list of booking results.

The date must occur on or before the current day’s date. 
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4. For each booking as needed, scroll to the Actual Attendance column, double-click in the
column to select the currently displayed value, and then enter the actual attendance
number in the column.

5. Click Update.
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Sending Email from EMS

You use SMTP email to send the following emails from the EMS Web Client:

• Individual emails to EMS groups/contact or users. See “To send an email to an EMS
group/contact or user” below.

• Confirmations to EMS groups/contact or users. See “To send a confirmation” on page
369.

EMS also provides an SMTP emailing function that you can use to send generic emails 
(emails that are not “tied” to a confirmation, reminder, and so on) to any recipient of your 
choice. You can also use this function to send invoices to any recipient of your choice.

To send an email to an EMS group/contact or user

1. Search for the group that you are emailing. See “To search for a group and/or contact” on
page 231.

2. Do one of the following:

• On the Groups page, select the group and then click Email.

A pre-addressed SMTP email form opens. The From field is populated with the
email address for your user account, but you can edit this value. The To field is
populated with the email address that is defined for the group, but you can edit this
value. Go to Step 4.

• On the Groups page, select the group, and then click Open.

The group-specific page opens. Go to Step 3.

3. On the group-specific page, make sure that the group is selected in the left pane, and then
click Email.

A pre-addressed SMTP email form opens. The From field is populated with the email
address for your user account, but you can edit this value. The To field is populated with
the email address that is defined for the group, but you can edit this value.

To send any email, your user account must be configured with an email address. 
To send generic emails, your user email preferences must also be configured. 
Contact your EMS administrator if you need assistance with this. See your EMS 
administrator or internal IT staff for information on how to enable SMTP email.
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Figure 11-2: SMTP Email form for a group

4. Enter the necessary information in the Subject and Message fields.

5. Optionally, do one or both of the following:

• To attach a file, click Attachments at the top of the window.

• To format the body of the email message, use one of the following options:

• Design is selected by default. Use the standard Windows plain text formatting
options to format the message (spacing, number of lines, capitalization, and so
on) so that it is displayed the way that you want in the headers and footers.

• Select HTML and enter the necessary HTML code to format the message
(spacing, number of lines, capitalization, and so on) so that it is displayed the
way that you want in the headers and footers. You can click Preview to view
how your HTML-formatted message will look before you send the email.
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To send a confirmation

1. On the Confirmation dialog box, click Email.

An Email page that displays the confirmation in the body opens in Preview mode.

Figure 11-3: SMTP email page for a confirmation

2. Indicate the email address from which the confirmation is to be sent.

3. Select the recipients for the email.

You can select User, which is the email address that is associated with your User 
account, or you can select Department, which is the email address of the 
department that is associated with your user account. See “Setting User 
Preferences and Default Values” on page 359.
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4. Optionally, do one or both of the following:

• To add attachments to the file, click Attachments.

• To change the formatting of the message, do one of the following:

• Open the Design tab and use the standard Windows plain text formatting options
to format the message (spacing, number of lines, capitalization, and so on) so
that it is displayed the way that you want in the headers and footers. You can
click Preview to view how your plain text-formatted message will look before
you send the email.

• Open the HTML tab and enter the necessary HTML code to format the message
(spacing, number of lines, capitalization, and so on) so that it is displayed the
way that you want in the headers and footers. You can click Preview to view
how your HTML-formatted message will look before you send the email.

5. Click Send.

If the emailed confirmation includes one or more attachments, then the 
Confirmation Title is also used for the name for all attachments other than an .ics 
file. If the confirmation includes an .ics file, then the .ics file is always named 
Confirmation.ics. To include the entire confirmation as an attachment, or an .ics 
file in a confirmation, see “Specifying your Confirmation Settings” on page 281.
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To send a generic email

A generic is an email that is not “tied” to a confirmation, reminder, and so on. You can send 
a generic email to any recipient of your choice. If your organization does not use an email 
client such as Microsoft Outlook, you can also use this function to send invoices to any 
recipient of your choice.

1. On the EMS toolbar, click the Email icon .

A generic email form opens. Depending on your preferences, the From field is
automatically populated either with the email address that is specified for your user
account, or the email address of the department that is associated with your user account,
but you can change this value. (See “Setting User Preferences and Default Values” on
page 359.)

Figure 11-4: Generic email form

To send an invoice, you must have previously generated and saved the invoice or 
you must reprint the invoice so that you can send it as an attachment in the email. 
See “Working with Invoices” on page 322.
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2. Enter the necessary information in the Subject and Message fields.

3. Optionally, do one or both of the following:

• To attach a file, click Attachments at the top of the window.

• To format the body of the email message, use one of the following options:

• Design is selected by default. Use the standard Windows plain text formatting
options to format the message (spacing, number of lines, capitalization, and so
on) so that it is displayed the way that you want in the headers and footers.

• Select HTML and enter the necessary HTML code to format the message
(spacing, number of lines, capitalization, and so on) so that it is displayed the
way that you want in the headers and footers. You can click Preview to view
how your HTML-formatted message will look before you send the email.

4. Click Send.

To send an invoice, you must have previously generated and saved the invoice or 
you must reprint the invoice so that you can send it as an attachment in the email. 
See “Working with Invoices” on page 322.
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Viewing a History of Sent Emails

You can use the Email History function to review a list of all emails that have been sent from 
within your organization’s EMS system via SMTP (not via Microsoft Outlook), including 
confirmation emails, report emails (which includes invoices, reminders, queries, web 
requests, and group and contact information), and generic emails. You can also view the 
contents of sent emails and print sent emails

To view a history of sent emails

1. On the EMS main menu, click Reservations > Other > Email History.

The Emails page opens.

Figure 11-5: Emails page

2. Enter the search criteria for the emails, and then click Display.

All of the emails that meet the search criteria are displayed in the bottom pane of the 
Emails page.

Under Source, the Report option collectively refers to confirmations, invoices, 
reminders, queries, web requests, and group and contact information.
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3. Optionally, do one or more of the following:

• To view an email, select the mail in the search results list, and then click View.

• To print the complete email results list, click View > Print List.

A message opens, asking you if you want to open or save the Email History.pdf file.

• If you click Open, the file opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

• To print the contents of one or more emails in the results list, select the mail, or
CTRL-click to select multiple emails, and then click View > Print Emails.

An onscreen preview of the selected emails opens. Options are available at the top of
the preview for searching the onscreen preview, printing the onscreen preview, and
exporting and saving the onscreen preview to a file format of your choice (.pdf, .xls,
.xlsx, HTML, text, .csv, and as an image.)
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Generating Multiple Confirmations

A confirmation is a document that details the critical information for a reservation—the date, 
the time, the location, the scheduled resources, and so on. Through the Navigator, you have 
the option of generating a single confirmation, either manually or automatically. (See   
“Confirmations,” on page 279.) A miscellaneous reservation function is also available for 
manually generating multiple confirmations at the same time. When you generate multiple 
confirmations, all the confirmations are contained in a single file, but each confirmation 
begins at the top of a new page. All the confirmations are “sent” by the same office, all the 
confirmations use the same format (By Booking Date, By Date Added, or By Date 
Changed) and all the confirmations use the same print options (Confirmation Title, Header 
Message, and so on); however, each confirmation can contain unique information for the 
buildings, statuses, and/or categories that are detailed in the confirmation. Because multiple 
confirmations are for multiple recipients, you cannot mass email these confirmations. 
Instead, you can only print them, and then manually mail them. You can specify the settings 
for multiple confirmations “from scratch,” or you can copy an existing confirmation format, 
and then edit it as needed.

To generate multiple confirmations

1. On the EMS main menu, click Reservations > Other > Confirmations.

The Confirmation page opens. The Date Range tab is the active tab.

Figure 11-6: Confirmation page, Date Range tab
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2. Do one of the following:

• Review the selections on this dialog box, and optionally, make any needed
modifications.

Field Description

Date Range tab

Department The department name that appears at the top the printed confirmation.

Starting Date

Ending Date

The range of dates for which you are generating the confirmations.

Use Specific Times Available only if the Starting Date is the same as the Ending Date. If this 

option is selected, then two fields are displayed on the Date Range tab 

in which you must specify the time range. After you specify the time 

range, click Options > Date/Time Filter, and then indicate how the 

confirmation is to be limited—by bookings that start within the time 

range, or by bookings that occur within the time range.

Format The format/organization of the confirmation—By Booking Date, By Date 

Added, or By Date Changed.

Buildings tab—Select the specific buildings that are to be included in the confirmation. 

Categories tab—Select the specific booking details that are to be included in the confirmation.

Statuses tab—Select the specific statuses that are to be included in the confirmation. 

Options tab—Format settings for a printed confirmation.

Confirmation Title Appears bold and centered at the top of the confirmation.

Header Message

Footer Message

Pre-configured blocks of text that appear in the header and footer of the 

printed confirmation. 

Note: Your EMS administrator configures these values. Contact your 

administrator if you need assistance with adding or editing a 

value.

Paper Size The size of the paper on which the confirmation is printed. Values are 

Letter, Legal, and A4.

Print Comments Include the comments for the reservation in the printed confirmation.

Print Reminders Include the reminders for the reservation in the printed confirmation.

Print Cancel Reasons Include the reasons for cancellation in the printed confirmation.

Print User Defined 

Fields

Include user-defined fields and their values in the printed confirmation. 

Print Room Phone Include the phone number for the room in which the event is being held 

in the printed confirmation.

Print Room Notes Include any notes for the room in which the event is being held in the 

printed confirmation.

Print Building Notes Include any notes about the building in the printed confirmation.

Print Billing Reference 

Allocation

Include the billing reference numbers for the event as well as the 

percentage of charges that is allocated to each number in the printed 

confirmation.
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• On the Setup dropdown list, select a saved, or memorized, confirmation.

Print PO Number 

Allocation

Include the PO numbers for the event as well as the percentage of 

charges that is allocated to each number in the printed confirmation.

Print Category 

Subtotals

Include the subtotal charges by category in the printed confirmation.

Print Room Type Include the room type for the event in the printed confirmation.

Print Item Selection 

Notes

Include the notes for each resource selection item for the event in the 

printed confirmation.

Suppress Reserved 

Time

Do not show the reserved time for the event in the printed confirmation.

Suppress Location Do not show the location for the reservation in the printed confirmation. 

Suppress Pricing Do not show the reservation’s room charges or resource charges in the 

printed confirmation.

Suppress Logo Do no show your organization’s logo in the printed confirmation.

Suppress Item Notes Do not show notes for any booking items in the printed confirmation.

Suppress Item Special 

Instructions

Do not show special instructions for any booking items in the printed 

confirmation.

Suppress Item 

Selections

Do not show any resource item selections in the printed confirmation.

Always Display Time 

Zone

Always show the time zone for the event in the printed confirmation.

Display Messages as 

HTML

If you have defined any HTML messages, then select this option to 

display the HTML version of these messages in the printed 

confirmation; otherwise, the message is displayed in plain text.

Limit Bookings to Those 

With Details in Selected 

Categories

Show only those bookings in the printed confirmation that contain details 

for the categories that are selected on the Categories tab.

If needed, you can always save, or memorize, these settings. See “Working with 
Memorized Reports” on page 293.

If you select a memorized confirmation, then the only changes that you can make 
are to the dates and/or times on the Date Range tab.

Field Description
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3. Click Generate Report.

If you selected the default format of HTML, then the confirmation is displayed onscreen
in its own page. You can use your browser options to view the confirmation prior to
printing, set your printing options, print the confirmation, and so on. For all other
confirmation formats, you must indicate whether to open the confirmation, or to save the
confirmation. To open and print a confirmation in any format other than HTML, you
must have the correct application installed on your client:

Unless you change the filter settings, all subsequent confirmations are generated and 
printed according to the parameters and options that you have specified. 

Output Format Required Application

PDF Adobe Reader or Adobe Acrobat

RTF Microsoft Word

XLS Microsoft Excel

HTML Web Browser

TEXT Notepad or Textpad

TIFF Any graphics application including 

Microsoft Paint and Microsoft Office 

Picture Manager.

To email the confirmation report, you can attach the saved confirmation report to 
an email. If needed, you can use the generic email function to send the email. See 
“To send a generic email” on page 371.
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Managing Attendees and Visitors

EMS provides standard functionality for managing registered attendees and visitors, which 
are attendees and visitors who have been added as an attendee type category to a booking. 
You can search for registered attendees and visitors, and you can check in and check out 
registered attendees and visitors. The optional Visitor Management module provides 
functionality for managing unregistered attendees and visitors. If your organization has 
purchased and installed this module, you can also check in unregistered visitors to an event, 
check out unregistered visitors from an event, and import a list of attendees using the Add 
Booking Details Wizard in the Navigator.

To manage registered attendees and visitors

1. On the EMS main menu, click Reservations > Other > Visitors.

The Visitors page opens. By default, the Visitors tab is the active tab.

Figure 11-7: Visitors page, Visitors tab
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2. Specify one or more of the following for your search criteria:

• Start Date/End Date—The default value is the current day’s date.

• Building—Select (all) buildings, a specific building, an area, or a view to search.

• Show Cancelled—Select this option to search for registered attendees or visitors for
canceled events.

• Group—To search for registered attendees or visitors regardless of group, leave this
field blank; otherwise, to search based on a specific group, enter a search string in
the field.

• Visitor—To search for a specific attendee or visitor, enter a search string in the field.

• Include Checked In—Selected by default. Clear this option to search only for
registered attendees and/or visitors who have not yet been checked in to their events.

3. Click Display.

The list of registered attendees and/or visitors who meet the search criteria are displayed
in the bottom pane of the Visitors page.

4. Optionally, do one or more of the following:

• Select an attendee or visitor from the search results, and then click open to open the
reservation in the Navigator that contains the booking that the attendee/visitor is
attending.

• Select an attendee or visitor from the search results, or CTRL-click to select multiple
attendees/visitors, and then click Check In to “check in” the attendees/visitors to the
event. A date and timestamp is added to each attendee’s/visitor’s record.

• Select an attendee or visitor from the search results, or CTRL-click to select multiple
attendees/visitors, and then click Check Out to “check out” the attendees/visitors
from the event. A date and timestamp is added to each attendee’s/visitor’s record.

For both search fields, your search is limited to the exact order of the characters 
in the string, but the string is not case-sensitive and it can appear anywhere in the 
search results. For example, a search string of aca returns Academic Affairs 
Office, Department of Academic Affairs, and so on.

Check Out is available only if the selected attendees/visitors have been checked 
into the event.
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• Select an attendee or visitor from the search results, or CTRL-click to select multiple
attendees/visitors, and then on the Tools menu, click Undo Check In to reverse the
Checked In status for the attendees/visitors. (The Check In date and timestamp is
removed from each attendee’s/visitor’s record and if needed, you can check in the
attendees/visitors again). Conversely, if an attendee or visitor has been checked out,
click Undo Check Out to reverse the Checked Out status for the attendee/visitor.

• On the Tools menu, click Export to export the list of registered attendees/visitors and
unregistered visitors to a Microsoft Excel spreadsheet.

A message opens asking you if want to open or save the Visitors.xls file. Select the
option that best fit your working needs.

• If you click Open, the file opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

• On the Tools menu, or from the Visitors page, click Print to generate a file of the list
of registered attendees/visitors and unregistered visitors.

A variety message opens, asking you if you want to open or save the Visitors.pdf
file. Select the option that best fits your working needs.

• If you click Open, the file opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

To preview the file, Microsoft Excel must be installed on your EMS client.
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To check in/check out unregistered visitors for an event

1. On the EMS main menu, click Reservations > Other > Visitors.

The Visitors page opens.

2. Open the Groups tab.

Figure 11-8: Visitors page, Groups tab

3. Specify one or more of the following for your search criteria:

• Start Date/End Date—The default value is the current day’s date.

• Building—Select (all) buildings, a specific building, an area, or a view to search.

• Group—Enter some or all of the hosting group’s name.

4. Click Display.

The groups that meet your search criteria are displayed in the middle pane of the Visitors
page.

Your search is limited to the exact order of the characters in the string, but the 
string is not case-sensitive and it can appear anywhere in the search results. For 
example, a search string of aca returns Academic Affairs Office, Department of 
Academic Affairs, and so on.
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5. Select the hosting group from the search results, and then click New Visitor.

The New Visitor dialog box opens.

Figure 11-9: New Visitor dialog box

6. Enter the information for the unregistered visitor, and then click OK.

The Visitor dialog box closes. You return to the Visitors page with the group and newly
configured visitor automatically selected.

7. Repeat Step 5 and Step 6 as needed to add all the unregistered visitors to the event.

The information that is displayed in the Event column for each unregistered visitor that
is added to an event is determined by the settings that your EMS administrator specified
when configuring the event building. For example, “Unregistered Visitor” might be
displayed. The date and time that you add an unregistered visitor to an event is used as
the Check In date and time for the visitor.

Building and Name are required fields. Depending on how your EMS 
administrator configured your system, Company Name, Email Address and/or 
Phone might be required. Notes are always optional. If you selected a specific 
building in Step 3, then the Building field should be automatically populated with 
the name of the building in which the event is scheduled and you cannot edit this 
value; however, if you have set your preferences for buildings such that this 
building is not available to you, then the Building field cannot be populated with 
the correct value, and you cannot add the new visitor. See “Setting User 
Preferences and Default Values” on page 359.
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8. Optionally, before you check out or check in an unregistered visitor, do one or more of
the following:

• Select the unregistered visitor in the lower pane of the Visitors page, and then click
Open to open the reservation in the Navigator that contains the booking that the
unregistered visitor is attending.

• On the Tools menu, click Export to export the list of registered attendees/visitors and
unregistered visitors to a Microsoft Excel spreadsheet.

A message opens asking you if want to open or save the Visitors.xls file. Select the
option that best fit your working needs.

• If you click Open, the file opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

• On the Tools menu, or from the Visitors page, click Print to generate a file of the list
of registered attendees/visitors and unregistered visitors.

A variety message opens, asking you if you want to open or save the Visitors.pdf
file. Select the option that best fits your working needs.

• If you click Open, the file opens onscreen. You can always indicate a file name
and save the file after you view it.

• If you click Save, you must select the directory in which to save the file.

9. To check out/check in an unregistered visitor, do one of the following:

• Select the unregistered attendee/visitor, or CTRL-click to select multiple
unregistered attendees/visitors, and then click Check Out to “check out” the
attendees/visitors from the event. A date and timestamp is added to the unregistered
visitors’ records.

• Select the unregistered attendee/visitor, or CTRL-click to select multiple
unregistered attendees/visitors, and then on the Tools menu, click Undo Check In to
reverse the Checked In status for the unregistered attendees/visitors. (The Check In
date and timestamp is removed from the unregistered visitors’ records and if needed,
you can check in the unregistered visitors again). Conversely, if an unregistered
visitor has been checked out, click Undo Check Out to reverse the Checked Out
status for the attendee/visitor.

To preview the file, Microsoft Excel must be installed on your EMS client.
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To import a list of attendees and visitors to an event

1. Create a tab-delimited file that contains the information (in the order listed) for the
attendees/visitors that are being imported.

2. Open the reservation for the event in the Navigator. See:

• “Opening a reservation directly in the Navigator” on page 67.

• “Opening a reservation through the Reservation Book” on page 68.

• “Opening a reservation through a group” on page 68.

• ,“Search Tools,” on page 177.

3. In the left pane of the Navigator, select the reservation for which you are importing the
list of attendees/visitors.

4. In the Bookings pane, click Tools, and then Click Add Booking Details Wizard.

The Add Booking Details wizard opens.

Figure 11-10: Add Booking Details wizard

Field Description Required/Optional

Name Text. 50 characters maximum. Required

Company Name Text. 50 characters maximum. Optional

Email Address Text. 255 characters maximum. Optional

Phone Text. 50 characters maximum. Optional

Notes Text. No maximum. Optional

Visitor True/False

Each attendee/visitor must be a separate line entry. You use the Add Booking 
Details Wizard to import this file. You can click Print Format on the second page 
of the Add Booking Details Wizard to see the required format for the tab-delimited 
file.
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5. Select Visitors or Attendees, and then click Next.

The second page of the Add Booking Details Wizard opens with a blank row for adding
an attendee/visitor to the event.

Figure 11-11: Add Booking Details Wizard, Second page

6. Click Import.

The Import dialog box opens.

7. Click Attach Files to browse to and select the attendee/visitor import file, and then click
Open to import the file.

The Add Booking Details Wizard is updated with the imported attendee/visitor
information. Each imported attendee/visitor is a separate line entry in the Wizard.

Figure 11-12: Add Booking Details Wizard, Imported Attendee/Visitor List displayed

Optionally, you can click Print Format to see the required format for the 
tab-delimited file.
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8. Click Next.

The Select Bookings page opens. This page displays all the bookings for the selected
reservation with a date greater than or equal to the current day’s date, and that do not
already have the selected booking detail added.

Figure 11-13: Add Booking Details wizard, Select Bookings page

9. CTRL-click to select the bookings to which the details are being added, or click Select
All to select all the displayed bookings in a single step, and then click Finish.

A message opens asking you if you want to add more booking details.

10. Click No.

A message opens indicating that the changes were made successfully.

11. Click OK to close the message and return to the Navigator.

The booking detail (Attendees/Visitors) and its items (individual attendees/visitors) are
displayed as folders under the appropriate booking folders in the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide 
canceled bookings, select Hide Cancelled Bookings. To show all bookings 
regardless of date, clear Hide Old Bookings. 
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Organizations with a mobile workforce or flexible work arrangements often adopt a hoteling 
or hot-desking strategy—allotting workspace on an as-needed basis to accommodate more 
people in less space. EMS Workplace is a facility scheduling system for managing hoteling 
requirements, as well as the booking of meeting/event space and resources. 

This chapter covers the following topics:

• “Managing Groups’ Check In/Check Out Statuses” on page 391.
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Managing Groups’ Check In/Check Out 

Statuses

Employees (referred to as “groups” in this section) can check-in using a variety of active and 
passive EMS Workplace methods including Virtual EMS (VEMS), the EMS Kiosk, and your 
security badge system. You use the Group Check In Status function to view the status of all 
employees, with or without bookings, that have checked into your building. In addition, 
options are available to check in/check out an individual and to manually “no show” 
employees that either have not checked-in or have checked into another building.

To manage groups’ check in/check out statuses

1. On the EMS toolbar, click the Check In Status icon .

The Group Check In Status page opens. If this is the first time that you have opened this
page, then go to Step 2 to set the default values for your building and home city;
otherwise, go to Step 3.

Figure 12-1: Group Check In Status page
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2. In the upper right hand corner of the page, click Options to open the Options dialog box
and select the default values for your home building and home cities.

Figure 12-2: Options dialog box

3. Specify the search criteria to search for the groups that are to be checked in to/checked
out of a building.

The home building is the building that selected groups are checked in to. You must 
separate multiple cities by commas, for example, Denver, Chicago, Atlanta. If 
Visitors Only is checked as one of the search options, then when you search for 
groups to verify their check in/check out status, the groups that have an address 
using any of these home cities are not returned in the search results. Only groups 
that do not have an address using any of these home cities and that meet all the 
search criteria are returned in the search results. 

Option Description

Building The default value is (all), but you can select a specific building, an area, 

or a view.

Group Type The default value is (all), but you can select a specific group type.

Event Type The default value is (all), but you can select a specific event type.

Floor The default value is (all), but you can select a specific floor.

Room Type The default value is (all), but you can select a specific room type.

Visitors Only Select this option only if you are searching for groups that do not have 

an address using any of the home cities that you have defined.

Not Checked In Only Select this option to search only for groups that have not been checked 

into the building.

Multiple Bookings Only Select this option to search only for those groups that have multiple 

bookings on the selected date.

Find Name Optional field. Enter a search string by which to filter your search. The 

search is not case-sensitive, but it is limited to the exact order of 

characters in the string and the string must begin with the information for 

which you are searching. For example, if you enter “ed” as the search 

string, results can include Ed, Edward, Eddie, and so on, but not Ted or 

Fred.

Date The default value is the current day’s date, but you can select a different 

value.
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4. Click Display.

All the groups that meet all the search criteria and that have a booking or bookings on the
selected date are displayed on the With Bookings tab.

Figure 12-3: Group Check In Status page with results

5. Optionally, do one or more of the following:

• To view all the bookings that a group has scheduled in the selected building, select
the group on the With Bookings tab. The bookings are displayed on the <Building>
Bookings tab.

Figure 12-4: Viewing bookings for a selected group

• To check in a group, select the group, and then click Check In. “Checked In” is
displayed in the Status column for the group on the With Bookings tab, the Date/
Time column are updated with the date and time that you clicked Check In, and
“Client” is displayed in the Source column.

All the groups that meet all the search criteria but that do not have a booking or 
bookings on the selected date are displayed on the Without Bookings tab. 

Remember, the group is checked in to the building that you set as your Home 
building, and the name of this building is displayed in the Building column.
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• To check out a group, select the group, and then click Check Out. “Checked Out” is
displayed in the Status column for the group on the With Bookings tab, the Date/
Time column are updated with the date and time that you clicked Check Out, and
“Client” is displayed in the Source column.

• To end a booking for a group, select the group, and then select the booking on the on
the <Building> Bookings tab and click End Now. Answer “Yes” at the prompt about
ending the booking immediately.

• To open an event in the Navigator, select the event entry on the <Building>
Bookings tab, and then click Go To.

• To manually “no show” a group of employees, continue to “To run the No Show
wizard” on page 395.

If your EMS client is integrated with VEMS or EMS Kiosk, then employees can 
also be checked in/checked out through either of these applications as well, and 
the Source column indicates this accordingly. 
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To run the No Show wizard

You use the No Show Wizard to email all groups that have not checked in to a specific 
building. It also provides options for changing the status of a group’s bookings so that the 
group’s workspace is released.

1. Select the group on the With Bookings tab, and then click No Show.

The No Show Wizard opens.

Figure 12-5: No Show Wizard

2. Do one or both of the following:

• To send an email to the group, select Send Email to open an email form. Complete
and send the email as normally would, and then click Finish.

• To change the status for the group’s booking, select Change Status, and then on the
Status dropdown list, select a new status, and then click Finish.

When you run the No Show wizard from the Group Check In Status page, you must 
manually create and send the email, and you must manually change the status. 
Both of these processes can be automated by creating a No Show Notification 
rule.Contact your EMS administrator for assistance.

You can include variables in the subject line as described in the Legend. For 
example, %2% is the code for the group name, so “Notification for %2%” would 
result in “Notification for Academic Affairs” being displayed in the subject line.
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A Mobile EMS option is displayed on the Login page for the EMS Web Client. This option 
essentially provides a portal for Service Providers to access the Setup Worksheet report in a 
format that is optimized for a Tablet display.

This chapter covers the following topics:

• “Working with the Mobile Version of the EMS Web Client” on page 399.
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Working with the Mobile Version of the EMS 

Web Client

A Mobile EMS option is displayed on the Login page for the EMS Web Client. This option 
essentially provides a portal for Service Providers to access the Setup Worksheet report in a 
format that is optimized for a Tablet display.

To work with the mobile version of the EMS Web Client

1. Open an Internet browser session.

2. In the browser’s address field, enter the EMS Web Client URL.

The EMS Web Client Login dialog box opens. 

Figure 13-1: EMS Web Client Login dialog box

3. In the User ID field, enter your User ID.

4. In the Password field, enter your password.

Contact your EMS administrator if you need assistance.

If you do not know your User ID or password, contact your EMS administrator. 



400

Mobile EMS Web Client

5. Click Mobile EMS.

The Setup Worksheet report opens in a format that is optimized for Tablet display.

Figure 13-2: Setup Worksheet report (optimized for Tablet display)

6. Do one of the following:

• To generate the report according to the filter settings that you specify leave (user
specified) selected and then specify the necessary report parameters (Buildings,
Categories, Statuses, and/or Event Types).

• To generate the report according to predetermined filters, open the (user specified)
dropdown list and select any publicly available memorized report.

The Bookings tab is dynamically updated with the results that meet all your report 
criteria.

7. Click Bookings to open the Bookings tab and view the report results.

You can click Go To Full Site at any time to open the full EMS Web Client in your 
default browser.

For detailed information about the Setup Worksheet report, see “Daily reports” 
on page 299.
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